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Introduction

Excel All-in-One For Dummies brings together plain and simple information on 
using all aspects of Microsoft Excel. It’s designed to be of help no matter how 
much or how little experience you have with the program. As the preeminent 

spreadsheet and data analysis software for all sorts of computing devices run-
ning Windows (desktops, laptops, tablets, and even smartphones), Excel offers 
its users seemingly unlimited capabilities too often masked in technical jargon 
and obscured by explanations only a software engineer could love. On top of that, 
many of the publications that purport to give you the lowdown on using Excel are 
quite clear on how to use particular features without giving you a clue as to why 
you would want to go to all the trouble.

The truth is that understanding how to use the abundance of features offered by 
Excel is only half the battle, at best. The other half of the battle is to understand 
how these features can benefit you in your work; in other words, “what’s in it for 
you.” I have endeavored to cover both the “how to” and “so what” aspects in all 
my discussions of Excel features, being as clear as possible and using a minimum 
of tech-speak.

Fortunately, Excel is well worth the effort to get to know because it’s definitely 
one of the best data-processing and analysis tools that has ever come along. 
From let-Excel-do-all-the-work features such as Flash Fill and Analyze Data to  
eyebrow-raisingly powerful tools such as PivotTables and Solver, Excel has what-
ever you need to get your numbers crunched. Excel is a blast to use when you 
know what you’re doing, and my great hope is that this “fun” aspect of using the 
program comes through on every page (or, at least, every other page).

About This Book
As the name states, Excel All-in-One For Dummies is a reference (whether you keep 
it on your desk or use it to prop up your desk is your business). This means that 
although the chapters in each book are laid out in a logical order, each stands on 
its own, ready for you to dig into the information at any point.
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As much as possible, I have endeavored to make the topics within each book and 
chapter stand on their own. When there’s just no way around relying on some 
information that’s discussed elsewhere, I include a cross-reference that gives you 
the chapter and verse (actually the book and chapter) for where you can find that 
related information if you’re of a mind to.

Use the full Table of Contents and Index to look up the topic of the hour and find 
out exactly where it is in this compilation of Excel information. You’ll find that 
although most topics are introduced in a conversational manner, I don’t waste 
much time cutting to the chase by laying down the main principles at work (usu-
ally in bulleted form) followed by the hard reality of how you do the deed (as 
numbered steps).

Foolish Assumptions
I’m only going to make one foolish assumption about you, and that is that you 
have some need to use Microsoft Excel under Windows in your work or studies. If 
pushed, I further guess that you aren’t particularly interested in knowing Excel at 
an expert level but are terribly motivated to find out how to do the stuff you need 
to get done. If that’s the case, this is definitely the book for you. Fortunately, even 
if you happen to be one of those newcomers who’s highly motivated to become the 
company’s resident spreadsheet guru, you’ve still come to the right place.

As far as your hardware and software go, I’m assuming that you already have 
Excel installed on your computing device running under Windows. And it doesn’t 
matter whether you obtained Excel with a Microsoft 365 subscription or an Office 
2021 purchase; this book covers the core functionality of both flavors of Excel.

I’m not assuming, however, that when you’re using Excel that you’re sitting in 
front of a large screen monitor and making cell entries and command selections 
with a physical keyboard or connected mouse. With the introduction of Micro-
soft’s Surface 4 tablet and the support for a whole slew of different Windows 
tablets, you may well be entering data and selecting commands with your finger 
or stylus using the Windows Touch keyboard and Touch pointer.

To deal with the differences between using Excel on a standard desktop or lap-
top computer with access only to a physical keyboard and mouse and a touch-
screen tablet or smartphone environment with access only to the virtual Touch 
keyboard, I’ve outlined the touchscreen equivalents to common commands you 
find throughout the text, such as “click,” “double-click,” “drag,” and so forth, in 
the section that explains selecting by touch in Book 1, Chapter 1.
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Warning: Because of the diversity of the devices that Excel runs on and the places 
where its files can be saved and used, if you’re using Excel 2007 or Excel 2010 for 
Windows, much of the file-related information in this book may only confuse and 
confound you. If you’re still using a version prior to Excel 2007, which introduced 
the Ribbon interface, this edition will be of no use to you because your version of 
the program works nothing like what this book describes.

Conventions Used in This Book
This book follows a number of different conventions modeled primarily after 
those used by Microsoft in its various online articles and help materials. These 
conventions deal primarily with Ribbon command sequences and shortcut or hot 
key sequences that you encounter.

Excel is a sophisticated program that uses the Ribbon interface first introduced in 
Excel 2007. In Chapter 1, I explain all about this Ribbon interface and how to get 
comfortable with its command structure. Throughout the book, you may find Rib-
bon command sequences using the shorthand developed by Microsoft whereby the 
name on the tab on the Ribbon and the command button you select are separated 
by arrows, as in

Home ➪ Copy

This is shorthand for the Ribbon command that copies whatever cells or graphics 
are currently selected to the Windows Clipboard. It means that you click the Home 
tab on the Ribbon (if it’s not already displayed) and then click the Copy button, 
which sports the traditional side-by-side page icon.

Some of the Ribbon command sequences involve not only selecting a command 
button on a tab but then also selecting an item on a drop-down menu. In this case, 
the drop-down menu command follows the name of the tab and command button, 
all separated by arrows, as in

Formulas ➪ Calculation Options ➪ Manual

This is shorthand for the Ribbon command sequence that turns on manual recal-
culation in Excel. It says that you click the Formulas tab (if it’s not already dis-
played) and then click the Calculation Options command button followed by the 
Manual drop-down menu option.

The book occasionally encourages you to type something specific into a specific 
cell in the worksheet. When I tell you to enter a specific function, the part you 
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should type generally appears in bold type. For example, =SUM(A2:B2) means 
that you should type exactly what you see: an equal sign, the word SUM, a left 
parenthesis, the text A2:B2 (complete with a colon between the letter-number 
combos), and a right parenthesis. You then, of course, still have to press the Enter 
key or click the Enter button on the Formula bar to make the entry stick.

When Excel isn’t talking to you by popping up message boxes, it displays highly 
informative messages in the Status bar at the bottom of the screen. This book 
renders messages that you see onscreen like this:

CALCULATE

This is the message that tells you that Excel is in manual recalculation mode (after 
using the earlier Ribbon command sequence) and that one or more of the formulas 
in your worksheet are not up to date and are in sore need of recalculation.

Occasionally I give you a shortcut key combination that you can press to choose a 
command from the keyboard rather than clicking buttons on the Ribbon with the 
mouse. Shortcut key combinations are written like this: Alt+FS or Ctrl+S. (Both of 
these shortcut key combos save workbook changes.)

With the Alt key combos, you press the Alt key until the shortcut key letters appear 
in little squares all along the Ribbon. At that point, you can release the Alt key and 
start pressing the shortcut key letters. (By the way, these are all lowercase short-
cut key letters — I only put them in caps to make them stand out in the text.)

Shortcut key combos that use the Ctrl key are of an older vintage, and they work 
a little bit differently because, on a physical keyboard, you have to hold down the 
Ctrl key as you press the shortcut key letter. (Again, unless you see the Shift key in 
the sequence as in Ctrl+Shift+C, don’t worry about uppercase letters.)

Finally, if you’re really observant, you may notice a discrepancy between the cap-
italization of the names of dialog box options (such as headings, option buttons, 
and check boxes) as they appear in the book and how they actually appear in Excel 
on your computer screen. I intentionally use the convention of capitalizing the 
initial letters of all the main words of a dialog box option to help you differentiate 
the name of the option from the rest of the text describing its use.
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Icons Used in This Book
The following icons are strategically placed in the margins throughout all eight 
books in this volume. Their purpose is to get your attention, and each has its own 
way of doing that.

This icon denotes some really cool information (in my humble opinion) that will 
pay off by making your work a lot more enjoyable or productive (or both).

This icon denotes a tidbit that you ought to pay extra attention to; otherwise, you 
may end up taking a detour that wastes valuable time.

This icon denotes a tidbit that you ought to pay extra attention to; otherwise, 
you’ll be sorry. I reserve this icon for those times when you can lose data and oth-
erwise screw up your spreadsheet.

This icon denotes a tidbit that makes free use of (oh no!) technical jargon. You may 
want to skip these sections (or, at least, read them when no one else is around).

Beyond the Book
 » Examples: This book’s sample Excel workbooks can be found at www.wiley.
com/go/excel2022aiofd or at my website (www.paulmcfedries.com). The 
filenames of the workbooks used in the book’s examples are given in the text.

 » Cheat Sheet: To locate this book’s Cheat Sheet, go to www.dummies.com and 
search for Excel All-in-One For Dummies. See the Cheat Sheet for info on Excel 
shortcut keys, keyboard cell-selection techniques, setting regional dates, and 
sharing workbooks from OneDrive.

Where to Go from Here
The question of where to go from here couldn’t be simpler: Go to Book 1, Chapter 1 
and find out what you’re dealing with. Which book you go to after that is a matter 
of personal interest and need. Just go for the gold and don’t forget to have some 
fun while you’re digging!

http://www.wiley.com/go/excel2022aiofd
http://www.wiley.com/go/excel2022aiofd
https://www.paulmcfedries.com/
http://www.dummies.com
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Excel: The 50-Cent Tour

If you’re new to Excel, launching the program for the first time can be headache-
inducing. So many icons! So many lines! So little guidance! The problem is that 
you’ve been catapulted into what appears to be a strange and exotic landscape 

without a map, a guidebook, or even a “You are here” sign. You wouldn’t travel to 
Upper Volta or lower Manhattan without these tools in your travel kit, so why are 
you visiting Excel that way?

Ah, but your purchase of this book shows that you are, indeed, a savvy and sophis-
ticated traveler. Now you’ve got the guidebook you need to learn the language, 
customs, and tourist hotspots of Excel. And the map? That’s what this chapter 
is all about. Here you take a guided tour that points out the main features of the 
Excel landscape; shows you the best ways to navigate from the spreadsheet equiv-
alent of Point A to Point B; and tells you how to call for help should the need arise.

Oh, and by the way: You are here. Let’s go!

Chapter 1

IN THIS CHAPTER

 » Getting to know Excel’s Start screen 
and program window

 » Selecting commands from the Ribbon

 » Unpinning the Ribbon

 » Using Excel on a touchscreen device

 » Getting around the worksheet  
and workbook

 » Using Excel’s Tell Me feature when 
you need help

 » Launching and quitting Excel
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A Bird’s-Eye View of Excel
Excel relies primarily on the onscreen element called the Ribbon, which is how 
you select the vast majority of Excel commands. In addition, Excel offers a single 
toolbar (the Quick Access toolbar, which is hidden by default), some context- 
sensitive buttons and command bars in the form of the Quick Analysis tool and 
mini-bar, contextual tabs that only appear on the Ribbon when you select cer-
tain Excel elements (such as a table or image), along with a number of task panes 
(such as Clipboard, Research, Thesaurus, and Selection to name a few).

Among the features supported when selecting certain style and formatting com-
mands is the Live Preview, which shows you how your actual worksheet data will 
appear in a particular font, table formatting, and so on before you actually apply 
it. Excel also supports an honest-to-goodness Page Layout view that displays rul-
ers and margins along with headers and footers for every worksheet. Page Layout 
view has a zoom slider at the bottom of the screen that enables you to zoom in 
and out on the spreadsheet data instantly. The Backstage view attached to the 
File tab on the Excel Ribbon enables you to get at-a-glance information about 
your spreadsheet files as well as save, share, preview, and print them. Last but 
not least, Excel is full of pop-up galleries that make spreadsheet formatting and 
charting a real breeze, especially with the program’s Live Preview.

Before moving on, take a second to understand the difference between two terms 
that you see over and over in this book:

 » Worksheet: This is Excel’s work area. That is, it’s the part of the Excel window 
where you enter text and data, create formulas, and much more. Note that, in 
this book, the words worksheet, spreadsheet, and sheet are synonymous.

 » Workbook: This is an Excel file and it’s a collection of one or more work-
sheets. Each worksheet appears separately in its own tab, as you discover a 
bit later in the “Surfing the sheets in a workbook” section.

Checking Out Excel’s Start Screen
When you first launch Excel, the program welcomes you with an Excel Start screen 
similar to the one shown in Figure 1-1. This screen is divided into two panes.

The left green navigation pane with the Home icon selected contains New and 
Open items at the top and Account, Feedback, and Options at the bottom.
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The right pane displays a single row of thumbnails showing some of the different 
templates you can use to create a new workbook at the top with a list of some of 
the most recently opened workbooks shown below. To see more templates to use 
in creating a new workbook, you can click either the More Templates link on the 
right side of the Home screen or the New icon in the navigation pane on the left.

If none of the Excel templates shown in the Home screen fit the bill, click More 
Templates (or click New in the Navigation pane) to open the New screen display-
ing a whole host of standard templates that you can select to use as the basis for 
new workbooks. These templates enable you to create a budget, track a project, 
create an invoice, and more. (See Book 2, Chapter  1 for more on creating new 
workbooks from ready-made and custom templates.)

To open an existing Excel workbook not displayed in the Recent list, click either 
the More Workbooks link on the lower-right side of the Home screen or the Open 
icon in the navigation pane on the left.

The first template thumbnail displayed on the top row of the Home tab on the 
Start screen is called Blank Workbook, and you select this thumbnail to start a new 
workbook of your own design.

FIGURE 1-1:  
The Excel Start 

screen with 
the Home 

tab selected 
that appears 

 immediately after 
launching the 

program.
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Getting Comfy with the Excel  
User Interface

When you first open a new, blank workbook by clicking the Blank Workbook 
thumbnail in the Home screen, Excel opens a single worksheet (with the generic 
name, Sheet1) in a new workbook file (with the generic filename, Book1) inside a 
program window such as the one shown in Figure 1-2.

The Excel program window is made up of the following components:

 » File menu button: When clicked, Excel opens the Backstage view, which 
contains a bunch of file-related commands: Home, New, Open, Save, Save  
As (or Save a Copy), Print, Share, Export, Publish, Close. You also see Account, 
which gives you information and tasks related to your Microsoft account; as 
well as Options, which enables you to change Excel’s default settings.

FIGURE 1-2:  
The Excel 

 program window 
as it appears after 

first opening a 
blank workbook.
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 » Ribbon: Most Excel commands are contained on the Ribbon. They’re 
arranged into a series of tabs ranging from Home through Help.

 » Formula bar: This displays the address of the active cell along with the 
contents of that cell. You can also use it to enter and edit cell data and 
formulas.

 » Worksheet: This is your Excel work area, which consists of a series of columns 
(identified by the letters along the top: A, B, C, and so on) and a series of rows 
(identified by the numbers running down the left: 1, 2, 3, and so on). The 
intersection of each column and row is called a cell and you enter your Excel 
data and formulas into these cells. You also see a tab for each worksheet 
(although the default new workbook comes with just one worksheet). You use 
a horizontal scroll bar on the bottom to move left and right through the sheet 
and a vertical scroll bar on the right edge to move up and down through  
the sheet.

 » Status bar: This bar keeps you informed of the program’s current mode and 
any special keys you engage, and it enables you to select a new worksheet 
view and to zoom in and out on the worksheet.

When using Excel on a touchscreen device, the Ribbon Display Options are auto-
matically set to Show Tabs Only (so that associated commands appear only when 
you tap a tab). To make it easier to select Ribbon commands with your finger or 
a stylus, click Ribbon Display Options (pointed out later in Figure 1-4) and then 
click Touch Spacing. With touch spacing engaged, Excel spreads out the tabs and 
their command buttons on the Ribbon. That way you have a fighting chance of 
correctly selecting them with your finger or stylus. On a touchscreen tablet, Excel 
automatically adds a Draw tab to the Ribbon containing loads of inking options 
that enable you to modify settings for drawing with your finger, a stylus, or a 
digital pen.

Going behind the scenes to Excel’s  
Backstage view
In the upper-left corner of the Excel program window, you find the File menu 
button, pointed out in Figure 1-2. When you click the File menu button or press 
Alt+F, the Excel Backstage view appears with the Home command selected. Back-
stage view contains a menu of file-related commands running down a column on 
the left side and, depending upon which option is selected, some panels contain-
ing both at-a-glance information and further command options.
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At first glance, the File menu button may appear to you like a Ribbon tab  —  
especially in light of its location immediately left of the Ribbon’s initial Home tab. 
However, this important file control is technically a command button that, when 
clicked, leads directly to a totally different screen: the Backstage view. This screen 
has its own menu options but contains no Ribbon command buttons whatsoever.

After you click the File menu button to switch to the Backstage view, you can then 
click the Back button (with the left-pointing arrow; see Figure 1-3) or press the 
Esc key to return to the normal worksheet view.

Getting the lowdown on the Info screen
When you choose File ➪ Info to select the Backstage view’s Info command, an Info 
screen similar to the one shown in Figure 1-3 appears.

On the left side of this Info screen, you find the following five command buttons:

 » Protect Workbook: Encrypt the Excel workbook file with a password, protect 
its contents, or verify the contents of the file with a digital signature (see Book 4, 
Chapters 1 and 2 for more on protecting and signing your workbooks).

FIGURE 1-3:  
The Excel 

Backstage view 
displaying the 

Info screen with 
permissions,  
distribution,  

version 
 commands,  

and more.
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 » Inspect Workbook: Inspect the document for hidden metadata (data about 
the file) and check the file’s accessibility for folks with disabilities and compat-
ibility with earlier versions of Excel (see Book 4, Chapter 3 for details on using 
this feature).

 » Version History: View previous versions of the workbook and restore an 
older version.

 » Manage Workbook: Recover or delete draft versions saved with Excel’s 
AutoRecover feature. (See Book 2, Chapter 1 for more on using AutoRecover.)

 » Browser View Options: Control what parts of the Excel workbook can be 
viewed and edited by users who view it online.

On the right side of the Info screen, you see a list of various and sundry bits of 
information about the file. although most of these bits don’t get filled in until you 
save the workbook (see Book 2, Chapter 1). Here’s a summary:

 » Properties lists the Size of the file as well as any Title, Tags, and Categories (to 
help identify the file when doing a search for the workbook) assigned to it. To 
edit or add to the Title, Tags, or Categories properties, click the appropriate 
text box and begin typing. To add or change additional file properties, 
including the Company, Comments, and Status properties, click the Properties 
drop-down button and then click Advanced Properties from its drop-down 
menu. Excel opens the workbook’s Properties dialog box (with its General, 
Summary, Statistics, Contents, and Custom tabs) to change and review a ton 
of file properties. If the workbook file is new and you’ve never saved it on disk, 
the words “Not Saved Yet” appear after Size.

 » Related Dates lists the date the file was Last Modified, Created, and Last 
Printed.

 » Related People lists the name of the workbook’s author as well as the name 
of the person who last modified the file. To add an author to the workbook 
file, click the Add an Author link that appears beneath the name of the current 
author.

 » The Show All Properties link, when clicked, expands the list of Properties to 
include text fields for Comments, Template, Status, Categories, Subject, 
Hyperlink Base, Company, and Manager that you can edit.

Sizing up other File menu commands
Above the Info command at the very top of the File menu, you find the commands 
you commonly need for working with Excel workbook files, such as creating new 
workbook files as well as opening an existing workbook for editing. The New com-
mand displays a thumbnail list of all the available worksheet templates you can 
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use to create a workbook. (See Book 2, Chapter 1 for more on creating and using 
workbook templates.)

Immediately below the Info command, you find a Save and Save As (or Save a 
Copy) commands. You generally use the Save command to manually save the 
changes you make to a workbook. You generally use the Save As (or, Save a Copy, 
if your workbook is on OneDrive) command to saves changes in your workbook 
with a new filename and/or in a new location on your computer or in the cloud 
(See Book 2, Chapter 1 for more on saving and closing files and Book 2, Chapter 3 
for more on opening them.)

Beneath the Save As (or Save a Copy) command you find the Print option that, 
when selected, displays a Print screen. This screen contains the document’s cur-
rent print settings (that you can modify) on the left side and a preview area that 
shows you the pages of the printed worksheet report. (See Book 2, Chapter 5 for 
more on printing worksheets using the Print Settings panel in the Backstage view.)

Below the Print command you find the Share option, which displays a list of com-
mands for sharing your workbook files online. Beneath this, you find an Export 
option used to open the Export screen, where you find options for converting 
your workbooks to other file types, such as PDF or XPS. (See Book 4, Chapter 3 for 
more about sharing workbook files online as well as converting them to other file 
formats.)

The Publish option enables you to save your Excel workbooks to a folder on your 
OneDrive for Business account and then publish it to Microsoft’s Power BI (Busi-
ness Intelligence) stand-alone application that enables you to create visual dash-
boards that highlight and help explain the story behind the worksheet data.

Checking user and product information  
on the Account screen
At the top of the section below the Close command that’s used to close a workbook 
file (hopefully, after saving all your edits) on the File menu, you find the Account 
command. You can use this option to review account-related information on the 
Backstage view’s Account screen. When displayed, the Account screen gives you 
both user and product information.

On the left side of the Account screen, your user information appears, including 
all the online services to which you’re currently connected. These services include 
social media sites such as Facebook, Twitter, and LinkedIn, as well as the more 
corporate services such as your OneDrive, SharePoint team site, and Microsoft 365 
account.
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To add an online service to this list, click the Add a Service button at the bottom 
and select the service to add on the Images & Videos, Storage, and Sharing contin-
uation menus. To manage which accounts appear on the list, highlight the name 
and click the Remove button to take it off the list. To manage the settings for a 
particular service, click the Manage button and then edit the settings online.

Use the Office Background drop-down list box that appears between your user 
information and the Connected Services list on the Account screen to change the 
pattern that appears in the background of the title bar of all your Office programs. 
By default, Office uses no background. You can change the background by click-
ing a new pattern from the Office Background drop-down menu on the Account 
screen (and you can always switch back to have no pattern displayed by click-
ing No Background from the menu). Below this option, you see the Office Theme 
selection (Colorful by default) that sets the overall color pattern you use. Just be 
aware that any change you make here affects the title areas of all the Office pro-
grams you run on your device (not just the Excel program window).

On the right side of the Account screen, you find the Subscription Product infor-
mation. Here you can see the type of Microsoft 365 installation as well as review 
the version number of Excel that is installed on your device. Because many Micro-
soft 365 licenses allow up to five installations of Office on different devices (desk-
top computer, laptop, Windows tablet, and smartphone, for example), you can 
click the Manage Account link to go online. There, you can check how many Office 
installations you still have available and, if need be, manage the devices on which 
Office is activated. If you need more installations for your company, you can use 
the Change License button to upgrade to another subscription plan that better fits 
your needs.

Ripping through the Ribbon
The Ribbon (shown in Figure  1-4) groups related commands together with the 
goal of showing you all the most commonly used options needed to perform a 
particular Excel task.

FIGURE 1-4:  
Excel’s  Ribbon 

consists of a 
series of tabs 

 containing 
 command 

 buttons arranged 
into different 

groups.
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The Ribbon is made up of the following components:

 » Tabs: Represent Excel’s main tasks. Each tab displays all the commands 
commonly needed to perform that core task. (No, “Home” isn’t a task! Think of 
the Home tab as your go-to place for the most common Excel commands.)

 » Groups: Related command buttons that appear together, separated by 
vertical lines. Think of each group as a collection of commands related to 
some subtask of the tab’s larger core task. On the Home tab, for example, the 
first few groups are Undo, Clipboard, Font, and Alignment.

 » Command buttons: Group items that you click to perform a particular action 
or to open a list or gallery. Note that many command buttons on certain tabs 
of the Excel Ribbon are organized into mini-toolbars with related settings.

 » Dialog box launcher: A button that opens a dialog box containing a bunch of 
additional commands and settings related to the group where the dialog box 
is located. Not all groups come with a dialog box launcher.

To get more of the Worksheet area displayed in the program window, you can min-
imize the Ribbon so that only its tabs are displayed. (In fact, this Show Tabs Only 
display option is the default setting for Excel running on a touchscreen device.)

When the Ribbon is pinned to the Excel program screen, you can minimize it by 
doing any of the following:

 » Click the Ribbon Display Options button (pointed out in Figure 1-4) and then 
click Show Tabs Only.

 » Double-click a Ribbon tab.

 » Press Ctrl+F1.

 » Right-click a Ribbon tab and then click Collapse the Ribbon.

To redisplay the entire Ribbon and keep all the command buttons on the selected 
tab displayed in the program window, click the tab and then choose Ribbon Dis-
play Options ➪ Always Show Ribbon. You can also do this by double-clicking one 
of the tabs or pressing Ctrl+F1 a second time.

When you work in Excel with the Ribbon minimized, the Ribbon expands each 
time you click one of its tabs to show its command buttons, but that tab stays 
open only until you click one of its command buttons. The moment you click a 
command button, Excel immediately minimizes the Ribbon again so that only the 
tabs display.
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Note, however, that when Excel expands a tab on the collapsed Ribbon, the Ribbon 
tab overlaps the top of the worksheet, obscuring the header with the column let-
ters as well as the first couple of rows of the worksheet itself. This setup can make 
it a little harder to work when the Ribbon commands you’re selecting pertain to 
data in these first rows of the worksheet.

Keeping tabs on the Excel Ribbon
The very first time you launch Excel and open a new workbook, the Ribbon con-
tains the following eight tabs, proceeding from left to right:

 » Home: Use this tab when creating, formatting, and editing a worksheet. This 
tab is arranged into the Clipboard, Font, Alignment, Number, Styles, Cells, 
Editing, and Analysis groups.

 » Insert: Use this tab when adding particular elements (including graphics, 
PivotTables, charts, hyperlinks, and headers and footers) to a worksheet. This 
tab is arranged into the Tables, Illustrations, Add-ins, Charts, Tours, Sparklines, 
Filters, Links, Comments, Text, and Symbols groups.

 » Page Layout: Use this tab when preparing a worksheet for printing or 
reordering graphics on the sheet. This tab is arranged into the Themes, Page 
Setup, Scale to Fit, Sheet Options, and Arrange groups.

 » Formulas: Use this tab when adding formulas and functions to a worksheet 
or checking a worksheet for formula errors. This tab is arranged into the 
Function Library, Defined Names, Formula Auditing, and Calculation groups. 
Note that this tab also contains a Solutions group when you activate certain 
add-in programs, such as Conditional Sum and Euro Currency Tools — see 
Book 1, Chapter 2 for more on Excel Add-ins.

 » Data: Use this tab when importing, querying, outlining, and subtotaling the 
data placed into a worksheet’s data list. This tab is arranged into the Get & 
Transform Data, Queries & Connections, Data Types, Sort & Filter, Data Tools, 
Forecast, and Outline groups. Note that this tab also contains an Analyze 
group if you activate add-ins, such as the Analysis ToolPak and Solver 
Add-In — see Book 1, Chapter 2 for more on Excel Add-ins.

 » Review: Use this tab when proofing, protecting, and marking up a worksheet 
for review by others. This tab is arranged into the Proofing, Accessibility, 
Insights, Language, Comments, Notes, and Protect groups. Note that this tab 
also contains an Ink group with a sole Hide Ink button if you’re running Excel 
on a Windows tablet or smartphone or on a laptop or desktop computer 
that’s equipped with some sort of electronic input tablet.
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 » View: Use this tab when changing the display of the Worksheet area and the 
data it contains. This tab is arranged into the Sheet View, Workbook Views, 
Show, Zoom, Window, and Macros groups.

 » Help: Use this tab to get online help and training on using Excel as well as give 
feedback on the program. (See “Getting Help” later in this chapter for details.)

Note that if you’re using Excel on a touchscreen device, you also have a Draw tab 
on your Ribbon that enables you to modify inking options when using a drawing 
device such as Surface Pen.

Although these tabs are the standard ones on the Ribbon, they’re not the only tabs 
that can appear in this area. Excel displays one or more contextual tabs as long as 
you’re working on a particular object selected in the worksheet, such as a graphic 
image you’ve added or a chart or PivotTable you’ve created.

The moment you deselect the object (usually by clicking somewhere on the sheet 
outside of its boundaries), the object’s contextual tabs immediately disappear 
from the Ribbon, leaving only the regular tabs displayed.

Adding the Developer tab to the Ribbon
If you do a lot of work with macros (see Book 8, Chapter 1) and XML files in Excel, 
you should add the Developer tab to the Ribbon. This tab contains all the command 
buttons normally needed to create, run, and edit macros as well as to import and 
map XML files. To add the Developer tab to the Excel Ribbon, follow these steps:

1. Choose File ➪ Options to open the Excel Options dialog box, then click 
Customize Ribbon.

Alternatively, you can press Alt+FTC or right-click one of the Ribbon tabs and 
then select Customize the Ribbon.

The Customize the Ribbon options appear.

2. Select the Developer check box under Main Tabs in the Customize the 
Ribbon list box on the right.

3. Click OK to finish.

Excel now displays the Developer tab in the Ribbon.

Selecting with mouse and keyboard
Because Excel runs on many different types of devices, the most efficient means 
of selecting Ribbon commands depends not only on the device on which you’re 
running the program, but on the way that device is equipped as well.
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For example, when I use Excel on my touchscreen notebook computer with the 
keyboard and touchpad connected, I select commands from the Excel Ribbon the 
same way I do when running Excel on my Windows desktop computer equipped 
with a standalone physical keyboard and mouse or on my Windows laptop com-
puter with its built-in physical keyboard and trackpad.

However, when I run Excel on my touchscreen device in tablet mode when the 
touchscreen is disconnected from the keyboard, I’m limited to selecting Ribbon 
commands directly on the touchscreen with my finger or digital pen.

When you’re rocking Excel with a mouse and keyboard, the most common method 
for selecting Ribbon commands is to click the tab that contains the command 
button you want and then click that button in its group. For example, to insert 
an online image into your worksheet, you click the Insert tab and then click the 
Online Pictures button to open the Online Pictures dialog box.

An alternative method for selecting commands on the Ribbon — useful if you’re 
not that dexterous with your mouse — is to press the keyboard’s Alt key and then 
press the letter of the KeyTip that appears on the tab you want to select. Excel then 
displays all the command button KeysTips next to their buttons, along with the 
KeyTips for the Dialog Box launchers in any group on that tab. (See Figure 1-5.) To 
select a command button or Dialog Box launcher, press its KeyTip letter.

If you know the old Excel shortcut keys from versions prior to Excel 2007, you can 
still use them. For example, instead of going through the rigmarole of pressing 
Alt+HCC to copy a cell selection to the Windows Clipboard and then Alt+HVP to 
paste it elsewhere in the sheet, you can still press Ctrl+C to copy the selection and 
then press Ctrl+V when you’re ready to paste it.

Selecting Ribbon commands by touch
When selecting Ribbon commands on a touchscreen device without access to a 
physical keyboard and mouse or touchpad, you’re limited to selecting commands 
directly by touch.

FIGURE 1-5:  
When you select 
a Ribbon tab by 
pressing Alt and 
the KeyTip letter 
assigned to that 

tab, Excel displays 
the KeyTips for 

its command 
buttons.
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Before trying to select Ribbon commands by touch, however, you definitely want 
to turn on touch spacing in Excel. You can do this by choosing Ribbon Display 
Options ➪ Touch Spacing. With touch spacing engaged, Excel spreads out the com-
mand buttons on the Ribbon tabs by putting more space around them, making it 
more likely that you’ll actually select the command button you’re tapping with 
your finger (or even a more slender stylus or pen tip) instead of the one right next 
to it. (This is a particular problem with the command buttons in the Font group 
on the Home tab that enable you to add different attributes to cell entries such as 
bold, italic, or underlining: They’re so close together when touch spacing is not on 
that they’re almost impossible to correctly select by touch.)

Working with the Quick Access toolbar
As its name implies, the purpose of the Quick Access toolbar is to give you speedy 
access to a few Excel tools. That sounds great, so why is the Quick Access toolbar 
hidden by default in the latest versions of Excel? Good question. The Quick Access 

WHAT “CLICK AND DRAG” MEANS  
ON YOUR DEVICE
Given all the different choices for selecting stuff in Excel, you need to be aware of a few 
click-and-drag conventions used throughout this book:

• When I say, “click”, this means press and release the primary mouse button (the 
left one unless you change it) on a physical mouse or tap the object directly with 
your finger or stylus.

• When I say, “double-click,” this means press and release the primary button twice 
in rapid succession on a physical mouse or double-tap the object with your finger 
or stylus.

• When I say, “right-click,” this means click the secondary button (the right button 
unless you change it) on a physical mouse or tap the item and keep your finger or 
stylus on the touchscreen until the context menu, pop-up gallery, or whatever 
appears. When using a digital pen, you need to click the button on the side of the 
pen as you tap the item.

• When I say, “drag through a cell selection,” with a physical mouse this means 
click the first cell and hold down the primary mouse button as you move the mouse 
pointer through the cells, and then release the button when the selection is com-
plete. On a touchscreen, you tap the first cell and then drag one of the selection 
handles (the circle that appears in the upper-left or lower-right corner of the 
selected cell) to make the selection.
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toolbar used to appear in the Excel title bar (although you could change that posi-
tion), so perhaps Microsoft figured the title bar was getting a tad overcrowded. 
Microsoft did keep the AutoSave switch and the Save button in the title bar, but 
these are no longer part of the Quick Access toolbar. (Also, Microsoft moved the 
Undo and Redo buttons to the Home tab.)

If you want to use the Quick Access toolbar, your first chore is to display it. To get 
the Quick Access toolbar onscreen, use any one of the following methods:

 » Right-click any part of the Ribbon and then click Show Quick Access Toolbar.

 » Choose Ribbon Display Options ➪ Show Quick Access Toolbar.

 » Choose File ➪ Options (or press Alt+FT) to open the Excel Options dialog box, 
click Quick Access Toolbar, select the Show Quick Access Toolbar check box, 
and then click OK.

The Quick Access toolbar is very customizable because you can easily add any Rib-
bon command to it. Moreover, you’re not restricted to adding buttons for just the 
commands on the Ribbon; you can add any Excel command you want to the tool-
bar, even the obscure ones that don’t rate an appearance on any of its tabs. (See 
Book 1, Chapter 2 for details on customizing the Quick Access toolbar.)

By default, the Quick Access toolbar appears below the Ribbon tabs. To display the 
toolbar above the Ribbon, click the Customize Quick Access Toolbar button (the 
drop-down button to the direct right of the toolbar with a horizontal bar above a 
down-pointing triangle) and then select Show Above the Ribbon from its drop-
down menu. Doing this give you a bit more vertical worksheet real estate, but at 
the cost of minimizing the Search box to an icon and having less overall room to 
add Quick Access toolbar buttons.

Fooling around with the Formula bar
The Formula bar displays the cell address and the contents of the active cell. The 
address of this cell is determined by its column letter(s) followed immediately by 
its row number, as in cell A1, the very first cell of each worksheet at the inter-
section of column A and row 1, or cell XFD1048576, the very last cell of each 
Excel worksheet at the intersection of column XFD and row 1048576. The con-
tents of the active cell are determined by the type of entry you make there: text or 
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numbers, if you just enter a heading or value, and the nuts and bolts of a formula, 
if you enter a calculation there.

The Formula bar is divided into three sections:

 » Name box: The leftmost section displays the address of the active cell or the 
cell’s defined range name, if it has one. (See Book 2, Chapter 2 to find out how 
to define range names.)

 » Formula bar buttons: The second, middle section usually has only the Insert 
Function button (labeled fx) enabled. When you start making or editing a cell 
entry, the Cancel (an X) and Enter (a check mark) buttons are also enabled.

 » Cell contents: The third white area to the immediate right of the Insert 
Function button takes up the rest of the bar and expands as necessary to 
display really, really long cell entries that won’t fit in the normal area. This area 
contains a Formula Bar button on the far right that enables you to expand its 
display to show really long formulas that span more than a single row and 
then to contract the Cell contents area back to its normal single row.

The Cell contents section of the Formula bar is important because it always shows 
you the contents of the cell even when the worksheet does not. (When you’re 
dealing with a formula, Excel displays only the formula result in the cell and not 
the formula itself.) You can edit the contents of the cell in this area at any time. 
By the same token, when the Cell contents area is blank, you know that the cell is 
empty as well.

ASSIGNING 26 LETTERS TO  
16,384 COLUMNS
When it comes to labeling the 16,384 columns of an Excel worksheet, our alphabet with 
its measly 26 letters is simply not up to the task. To make up the difference, Excel first 
doubles the letters in the cell’s column reference so that column AA follows column Z 
(after which you find column AB, AC, and so on) and then triples them so that column 
AAA follows column ZZ (after which you get column AAB, AAC, and the like). At the end 
of this letter tripling, the 16,384th and last column of the worksheet ends up being XFD, 
so that the last cell in the 1,048,576th row has the cell address XFD1048576.
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What’s up with the Worksheet area?
The Worksheet area is where most of the Excel spreadsheet action takes place 
because it displays the cells of the current worksheet. Also, inside the cells is 
where you do all of your spreadsheet data entry and formatting, not to mention 
the majority of your editing. (Yes, that’s right: You can enter or edit cell data using 
either the formula bar or the cell directly. Most people prefer the latter.)

Keep in mind that to enter or edit data in a cell, that cell must be the active cell. 
Excel indicates the active cell in three ways:

 » The cell pointer — the dark green border surrounding the cell’s entire 
perimeter — appears in the cell.

 » The address of the cell appears in the Name box of the Formula bar.

 » The cell’s column letter(s) and row number are shaded (in an green color on 
most monitors) in the column headings and row headings that appear at the 
top and left of the Worksheet area, respectively.

Moving around the worksheet
Excel offers many methods for moving the cell pointer around the worksheet to 
the cell where you want to enter new data or edit existing data:

 » Click the desired cell — assuming that the cell is displayed within the section 
of the sheet currently visible in the Worksheet area.

 » Click the Name box, type the address of the desired cell directly into this box, 
and then press Enter.

 » Press F5, Ctrl+G, or Alt+HFDG to open the Go To dialog box, type the address 
of the desired cell into its Reference text box, and then click OK.

 » Use the cursor keys, as shown in Table 1-1, to move the cell pointer to the 
desired cell.

 » Use the horizontal and vertical scroll bars at the bottom and right edges of the 
Worksheet area to move the part of the worksheet that contains the desired 
cell. Then click the cell to put the cell pointer in it.
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Keystroke shortcuts for moving the cell pointer
Excel offers a wide variety of keystrokes for moving the cell pointer to a new 
cell. When you use one of these keystrokes, the program automatically scrolls a 
new part of the worksheet into view, if this is required to move the cell pointer. 
In Table 1-1, I summarize these keystrokes and how far each one moves the cell 
pointer from its starting position.

TABLE 1-1 Keystrokes for Moving the Cell Pointer
Keystroke Where the Cell Pointer Moves

→ or Tab Cell to the immediate right.

← or Shift+Tab Cell to the immediate left.

↑ Cell up one row.

↓ Cell down one row.

Home Cell in column A of the current row.

Ctrl+Home First cell (A1) of the worksheet.

Ctrl+End or  
End, Home

Cell in the worksheet at the intersection of the last column that has 
any data in it and the last row that has any data in it. (That is, the 
last cell of the so-called active area of the worksheet.)

PgUp Cell one screenful up in the same column.

PgDn Cell one screenful down in the same column.

Ctrl+→ or End, → First occupied cell to the right in the same row that is either 
preceded or followed by a blank cell. If no cell is occupied, the 
pointer goes to the cell at the very end of the row.

Ctrl+← or End, ← First occupied cell to the left in the same row that is either 
preceded or followed by a blank cell. If no cell is occupied, the 
pointer goes to the cell at the very beginning of the row.

Ctrl+↑ or End, ↑ First occupied cell above in the same column that is either 
preceded or followed by a blank cell. If no cell is occupied, the 
pointer goes to the cell at the very top of the column.

Ctrl+↓ or End, ↓ First occupied cell below in the same column that is either 
preceded or followed by a blank cell. If no cell is occupied, the 
pointer goes to the cell at the very bottom of the column.

Ctrl+Page Down Last occupied cell in the next worksheet of that workbook.

Ctrl+Page Up Last occupied cell in the previous worksheet of that workbook.

Note: In the case of those keystrokes that use arrow keys, you must either use the arrows 
on the cursor keypad or have the Num Lock key disengaged on the numeric keypad of your 
keyboard.
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The keystrokes that combine the Ctrl or End key with an arrow key (listed in 
Table 1-1) are among the most helpful for moving quickly from one edge to the 
other in large tables of cell entries. Moving from table to table in a section of the 
worksheet that contains many blocks of cells is also much easier.

When you use Ctrl and an arrow key to move from edge to edge in a table or 
between tables in a worksheet on a physical keyboard, you hold down Ctrl while 
you press one of the four arrow keys (indicated by the + symbol in keystrokes, 
such as Ctrl+→). On the Touch keyboard, you tap Ctrl and then tap the appropriate 
arrow key to accomplish the same thing.

When you use End and an arrow-key alternative, you must press and then release 
the End key before you press the arrow key (indicated by the comma in keystrokes, 
such as End, →). Pressing and releasing the End key causes the END MODE indica-
tor to appear onscreen in the Status bar. This is your sign that Excel is ready for 
you to press one of the four arrow keys.

Because you can keep the Ctrl key depressed as you press the different arrow 
keys that you need to use, the Ctrl-plus-arrow key method provides a more 
fluid method for navigating blocks of cells on a physical keyboard than the End- 
then-arrow key method. On the Touch keyboard, there is essentially no difference 
in technique.

You can use the Scroll Lock key to “freeze” the position of the cell pointer in the 
worksheet so that you can scroll new areas of the worksheet in view with key-
strokes such as PgUp (Page Up) and PgDn (Page Down) without changing the cell 
pointer’s original position (in essence, making these keystrokes work in the same 
manner as the scroll bars).

After engaging Scroll Lock (often abbreviated ScrLk), when you scroll the work-
sheet with the keyboard, Excel doesn’t select a new cell while it brings a new sec-
tion of the worksheet into view. To “unfreeze” the cell pointer when scrolling the 
worksheet via the keyboard, you just press the Scroll Lock key again.

Tips on using the scroll bars
To understand how scrolling works in Excel, imagine the worksheet is a humon-
gous papyrus scroll attached to rollers on the left and right. To bring into view 
a new section of a papyrus worksheet that is hidden on the right, you crank the 
left roller until the section with the cells that you want to see appears. Likewise, 
to scroll into view a new section of the worksheet that is hidden on the left, you 
crank the right roller until that section of cells appears.
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You can use the horizontal scroll bar at the bottom of the Worksheet area to scroll 
back and forth through the columns of a worksheet. Likewise, you can use the 
vertical scroll bar to scroll up and down through its rows. To scroll one column or 
a row at a time in a particular direction, click the appropriate scroll arrow at the 
ends of the scroll bar. To jump immediately back to the originally displayed area of 
the worksheet after scrolling through single columns or rows in this fashion, click 
the darker area in the scroll bar that now appears in front of or after the scroll 
button within the scroll bar.

You can resize the horizontal scroll bar, making it wider or narrower, by drag-
ging the button that appears to the immediate left of its left scroll arrow. When 
working in a workbook that contains a whole bunch of worksheets, in widening 
the horizontal scroll bar you can end up hiding the display of the workbook’s later 
sheet tabs.

To scroll very quickly through columns or rows of the worksheet, hold down the 
Shift key and then drag the mouse pointer in the appropriate direction within the 
scroll bar until the columns or rows that you want to see appear on the screen in 
the Worksheet area. When you hold down the Shift key as you scroll, the scroll 
button within the scroll bar becomes really narrow, and a ScreenTip appears next 
to the scroll bar, keeping you informed of the letter(s) of the columns or the num-
bers of the rows that you’re currently whizzing through.

If your mouse has a wheel, you can use it to scroll directly through the columns 
and rows of the worksheet without using the horizontal or vertical scroll bars. 
Position the white-cross mouse pointer in the center of the Worksheet area and 
then hold down the wheel button of the mouse. When the mouse pointer changes 
to a four-point arrow, drag the mouse pointer in the appropriate direction (left 
and right to scroll through columns or up and down to scroll through rows) until 
the desired column or row comes into view in the Worksheet area.

On a touchscreen, you can scroll the worksheet by swiping the screen with your 
finger. (Don’t use your stylus because pressing it in the worksheet area only 
results in selecting the cell you touch.) You swipe upward to scroll worksheet 
rows down and swipe down to scroll the rows up. Likewise, you swipe left to scroll 
columns right and swipe right to scroll columns left.

The only disadvantage to using the scroll bars to move around is that the scroll 
bars bring only new sections of the worksheet into view — they don’t actually 
change the position of the cell pointer. If you want to start making entries in the 
cells in a new area of the worksheet, you still have to remember to select the cell 
(by clicking it) or the group of cells (by dragging through them) where you want 
the data to appear before you begin entering the data.
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Surfing the sheets in a workbook
Each new workbook you open in Excel contains a single blank worksheet, aptly 
named Sheet1, with 16,384 columns and 1,048,576 rows (giving you a truly stag-
gering total of 17,179,869,184 blank cells!). Should you still need more worksheets 
in your workbook, you can add them by clicking the New Sheet button (the circle 
with the plus sign in it) that appears to the immediate right of Sheet1 tab.

On the left side of the bottom of the Worksheet area, the Sheet tab scroll buttons 
appear, followed by the actual tabs for the worksheets in your workbook and the 
New Sheet button. To activate a worksheet for editing, you select it by clicking its 
sheet tab. Excel lets you know what sheet is active by displaying the sheet name 
on its tab in green, boldface type as well as underlining the tab and making the tab 
appear to be connected to the current worksheet above.

Don’t forget the Ctrl+Page Down and Ctrl+Page Up shortcut keys for selecting the 
next and previous sheets, respectively, in your workbook. When the tab bar is full, 
you can also click the following buttons:

 » Next Sheet: The ellipsis (. . .) button on the right side of the sheet tabs 
immediately left of the New Sheet button. Clicking this button selects the first 
non-visible tab to the right.

 » Previous Sheet: The ellipsis (. . .) button on the left side of the sheet tabs to 
the immediate left of the first visible sheet tab. Clicking this button selects the 
first non-visible tab to the left.

ONE GOOD REASON FOR ADDING EXTRA 
SHEETS TO A WORKBOOK
You may wonder why on earth anyone would ever need more than one worksheet, 
given just how many cells each sheet contains. The simple truth is that it’s all about how 
you choose to structure a particular workbook rather than running out of places to put 
the data. For example, say you need to create a workbook that contains budgets for all 
the various departments in your corporation; you may decide to devote an individual 
worksheet to each department (with the actual budget worksheet tables laid out in the 
same manner on each sheet) rather than placing all the tables in different sections of 
the same sheet. Using this kind of one-sheet-per-budget layout makes it much easier 
for you to find each budget, print each one as a separate page of a report, and, if ever 
necessary, consolidate their data in a separate summary worksheet.
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If your workbook contains too many sheets for all their tabs to be displayed at the 
bottom of the Worksheet area, use the Sheet tab scroll buttons to bring new tabs 
into view (so that you can then click them to activate them). You click the Next 
Scroll button (the one with the triangle pointing right) to scroll the next hidden 
sheet tab into view on the right and the Previous Scroll button (the one with the 
triangle pointing left) to scroll the next hidden sheet into view on the left. You 
Ctrl+click the Next Scroll button to scroll the last sheet into view and Ctrl+click the 
Previous Scroll button to scroll the first sheet into view.

Right-click either Sheet tab scroll button to display the Activate dialog box listing 
the names of all the worksheets in the workbook in their order from first to last. 
Then, to scroll to and select a worksheet, double-click its name or click the name 
followed by OK.

Taking a tour of the Status bar
The Status bar is the last component at the very bottom of the Excel program win-
dow. (See Figure 1-6.) The Status bar contains the following items:

 » Mode indicator: Indicates the current state of the Excel program (READY, 
ENTER, EDIT, and so on).

 » AutoCalculate results: Displays the AVERAGE, COUNT, and SUM of all the 
numerical entries in the active cell selection.

 » Workbook views: Enables you to select between three views for the 
Worksheet area: Normal, the default view that shows only the worksheet cells 
with the column and row headings; Page Layout view, which adds rulers and 
page margins and shows page breaks for the worksheet; and Page Break 
Preview, which enables you to adjust the paging of a report.

 » Zoom: Enables you to zoom in and out on the cells in the Worksheet area by 
dragging the slider to the right or left, respectively.

You can customize the Status bar by right-clicking it and then activating or deac-
tivating the commands in the shortcut menu that appears.
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Getting Help
In Excel, help is always available to you in two forms:

 » A Search feature that not only shows you the command sequence for the help 
topic you enter but at times actually initiates and completes the command 
sequence for you

 » Online Help that contains various help topics that explain Excel’s many 
features

Show-and-tell help with the Search feature
Excel’s Search feature must be from Missouri because it doesn’t just tell you what 
to do; it actually shows you by performing the task for you. This handy little fea-
ture is available from the Search text box located at the top of the Excel window, 
to the right of the filename. As you enter a help topic into this text box, Excel 
displays a list of related Excel commands in a drop-down list.

FIGURE 1-6:  
The Excel  

Status bar.
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When you then select one of the items displayed on this list, Excel either selects 
the associated Ribbon command (no matter which Ribbon tab is currently selected) 
and waits for you to make a selection from the command’s submenu or, in some 
case, just goes ahead and completes the associated command sequence for you.

For example, if you type print into the Search text box, Excel displays a list with 
the following items:

 » Print

 » Print Preview and Print

 » Set Print Area

 » Preview and Print with a continuation menu that contains Print Preview and 
Print, Quick Print, and Print Preview Full Screen options

 » Get Help on “Print”

If you select Quick Print on the Preview and Print continuation menu or Print 
item, Excel immediately sends the current worksheet to the printer. If, however, 
you select Preview and Print on the continuation menu or on the drop-down list, 
Excel displays a preview of the printout on the Print Screen in the Backstage view 
that you can print. If you select the Quick Print item, the program sends the work-
sheet directly to the printer. But if you select the Print Preview Full Screen item, 
Excel replaces the Worksheet view with a full screen print preview page from 
which you can print the worksheet. (See Book 2, Chapter 5 for complete details on 
previewing and printing your worksheets.)

If you would rather learn how to complete a task in Excel rather than have the 
program do it for you, select the Get Help on “xyz” item at the end of the list 
below the Search text box. This opens an Excel Help window with loads of infor-
mation about using the commands to accomplish that task (as described in the 
very next section).

Getting Help from the Help tab  
on the Ribbon
Excel offers extensive online help in the Help taskbar that you can make use of 
anytime while using the program. To display the Excel Help taskbar, click the Help 
button on the Help tab of the Ribbon (Alt+Y2H) or press F1. A Help task pane sim-
ilar to the one shown in Figure 1-7 appears.
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On a device without any access to the function keys, you can display the online 
Excel Help window by tapping the Help button on the Help tab of the Ribbon or by 
using the Touch keyboard to enter help into the Search text box and then tapping 
the Get Help on “help” option in the drop-down list.

At the very top of the Help task pane, you find a search text box with a Search 
button to the left (the spyglass icon). To display a list of related help topics in the 
Help task pane, type a keyword or name of a category (such as printing, formulas, 
and so on) and then click the Search button or press Enter. The Help task pane 
then displays a list of help topics for that category. To display detailed information 
about a particular help topic in this list, click its link.

In addition to the Help button, the Ribbon’s Help tab contains these “help”ful 
command buttons:

 » Contact Support to open a Help task pane containing a text box where you 
can enter a description of your problem with Excel before clicking its Get Help 
button to display articles that may help you resolve your issue as well as a Talk 
to Agent button that enables you to get an agent’s help with a Live Chat.

 » Feedback to open the Feedback screen in the File menu’s Backstage view 
where you can send feedback to Microsoft using the I Like Something, I Don’t 
Like Something, and the I Have a Suggestion Option.

FIGURE 1-7:  
The Excel Help 

task pane.
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 » Show Training to open the Help task pane with video tutorials that you can 
run to learn about features such as designing workbooks, using tables and 
charts, and using formulas and functions.

 » What’s New to open the Help task pane with a list of new features in the 
version of Excel you’re running.

 » Community to open the Microsoft Excel Community page in your default 
browser with discussions on all sorts of Excel topics where you can post your 
questions and concerns to the entire Excel Online community.

 » Excel Blog to open the Excel Blog page in your default Web browser where 
articles about all sorts of Excel applications.

 » Suggest a Feature to open the Excel Suggestion Box page with your default 
browser where you can give Microsoft your feedback on Excel as well as 
suggest new features to be added to future versions.

When you get familiar enough with Excel features that you rarely, if ever, consult 
help, you can remove the Help tab from the Ribbon. Open the Excel Options dia-
log box (File ➪  Options), click the Customize Ribbon button on the left, and then 
click the Help check box under Main Tabs on the right to remove its check mark 
before you click OK. Note that after removing the Help tab from the Ribbon, you 
can still open the Help task pane and get all the Excel help you need by pressing 
F1 or typing help in the Search text box and then clicking the Get Help option on 
its drop-down menu.

Launching and Quitting Excel
This chapter closes by looking at the myriad ways you can start and stop Excel on 
your device.

Starting Excel from the Windows 
Start menu
The most straightforward way to launch Excel is via the Windows Start menu. To 
get started, click the Windows icon on the taskbar or press the Windows key on 
your keyboard.

Scroll down the alphabetical list of apps installed on your device until you get to 
the Es, and then click the Excel icon, shown in Figure 1-8.
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You can pin the Excel program button to the pinned section of the Windows Start 
menu so that it’s always displayed whenever you open the Windows Start menu. 
To pin the Excel program button, right-click the Excel icon in the Start menu and 
then click the Pin to Start item in the context menu. Windows then adds a large 
Excel program icon to the bottom of the first column of pinned icons. You can then 
resize the icon (right-click and select Resize followed by Small or Medium) and 
move it to a more desirable location in pinned section by dragging and dropping it.

After launching Excel from the Start menu, you can pin the program icon to the 
Windows taskbar by right-clicking the Excel icon on the taskbar and selecting the 
Pin to Taskbar item. Thereafter, you can launch Excel from the Windows taskbar 
by clicking the pinned program icon without having to bother opening the Win-
dows Start menu.

Starting Excel from the Windows  
Search text box
Instead of opening the Windows Start menu and locating the Excel item there, you 
can launch the program using the Windows Search text box (the one that contains 
the text “Type here to search" to the immediate right of the Windows button). 
Start typing excel into this text box until the Excel app appears at the top of its 
result list and then click the Excel result to launch the program.

FIGURE 1-8:  
Launching 

Excel from the 
Windows Start 

screen.
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Telling Cortana to Start Excel for you
If you want Cortana, the voice-activated online Windows assistant, to launch 
Excel for you, click the microphone icon in the Type Here to Search text box and 
then when she displays the listening prompt, say “Hey Cortana, start Excel.” You 
can also do this by telling her to “launch, Excel” or “open Excel” after getting her 
attention.

Starting Excel from the Windows Metro 
view in Tablet mode
When running Excel in tablet mode under Windows, your Start screen uses tiles 
in the Metro view first introduced in Windows 8. To start Excel from this Start 
screen, select the Excel program tile either by clicking it if you have a mouse 
available or tapping it with your finger or stylus.

If you can’t locate the Excel program tile among the pinned tiles in the Metro 
view, you can use the Search feature to find the application and pin it to this Start 
screen:

1. From the Start screen, click the Search button on the Windows taskbar 
(the one with the spyglass icon between the Back and Task View buttons) 
and then begin typing excel on your physical or virtual keyboard.

Windows displays the Excel app in the list under Best Match in the search list.

If you don’t have access to a physical or virtual keyboard, you can locate the 
Excel app by switching the Start screen from the default of displaying just  
the pinned tiles to all the applications installed on your device. To do this, tap 
the All Apps button immediately beneath the Pinned Tiles button, the third 
icon from the top in the upper-left of the Start screen. When you do this, you 
should see the Excel app button in the E alphabetical listing of all installed 
applications.

2. Right-click the Excel app button in the search list to open its pop-up 
menu.

On a touchscreen device, the equivalent to the right-click of the mouse is to tap 
and hold the Excel menu item with your finger or stylus until the popup menu 
appears. (With the Microsoft Pen, you hold down the button on the pen’s side 
as you tap the Excel app button with the pen tip.)
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3. Click the Pin to Start option in the pop-up menu.

After pinning an Excel program tile to the Start screen, you can resize it and then 
move it by dragging and dropping it in your desired block. If you switched to all 
apps to find the Excel app, you first need to switch the Metro view back to pinned 
apps by tapping the Pinned Tiles button before you can do this.

When it’s quitting time
When you’re ready to call it a day and quit Excel, you have several choices for 
shutting down the program:

 » Press Alt+FX or Alt+F4 on your physical or Touch keyboard.

 » Select the Close button (the one with the x) in the upper-right corner of the 
Excel program window to close each workbook file you have open.

 » Right-click the Excel program icon on the Windows taskbar and then click the 
Close Window(s) option on its pop-up menu.

If you try to exit Excel after working on a workbook and you haven’t saved your 
latest changes, the program beeps at you and displays an alert box querying 
whether you want to save your changes. To save your changes before exiting, 
click the Yes command button. (For detailed information on saving documents, 
see Book 1, Chapter 2.) If you’ve just been playing around in the worksheet and 
don’t want to save your changes, you can abandon the document by clicking the 
No button.

QUITTING EXCEL ON A TOUCHSCREEN 
DEVICE
If you’re running Excel on a touchscreen device without a physical keyboard (even one 
with a relatively large screen), for heaven’s sake, don’t forget to engage the touch spac-
ing on the Quick Launch toolbar as described earlier in this chapter. Turning on touch 
spacing sufficiently separates the Close button in the very upper-right corner of the 
Excel screen from the Restore Down button to its immediate left, so that when you tap 
the Close button, you end up actually exiting Excel rather than just shrinking the Excel 
program window on the Windows desktop!
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Customizing Excel

Chances are good that Excel, as it comes when first installed, is not always 
the best fit for the way you use the program. For that reason, Excel offers a 
variety of ways to customize and configure the program’s settings so that 

they better suit your needs and the way you like to work.

This chapter covers the most important methods for customizing Excel settings 
and features. The chapter looks at three basic areas where you can tailor the pro-
gram to your individual needs:

 » The first place ripe for customization is the Quick Access toolbar (assuming 
you elected to unhide it, as I describe in Book 1, Chapter 1). Not only can you 
control which Excel command buttons appear on this toolbar, but you can 
also assign macros you create to this toolbar, making those macros instantly 
accessible.

 » The second place where you may want to make extensive modifications is to 
the default settings (also referred to as options) that control any number of 
program assumptions and basic behaviors.

 » The third place where you can customize Excel is in the world of add-ins, those 
small, specialized utilities that extend the built-in Excel features by attaching 
themselves to the main Excel program. Excel Add-ins provide a wide variety of 
functions and are available from a wide variety of sources, including the 
original Excel program, the Microsoft Office website, and third-party vendors.

Chapter 2

IN THIS CHAPTER

 » Customizing the Quick Access toolbar 
and Ribbon

 » Changing various and sundry Excel 
program settings

 » Extending Excel’s capabilities with 
add-in programs
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Tailoring the Quick Access Toolbar  
to Your Tastes

Excel enables you to easily make modifications to the Quick Access toolbar, the 
sole toolbar of the program. When you unhide the Quick Access toolbar (by, for 
example, right-clicking the Ribbon and then clicking Show Quick Access Toolbar), 
it appears right below the Ribbon.

To add some commonly used commands to the Quick Access toolbar, such as New, 
Open, Email, Quick Print, and the like, click the Customize Quick Access Tool-
bar button (pointed out in Figure 2-1) and click the command to be added from 
the drop-down menu. Notice that Excel adds a check mark to the left of each 
command that’s been added to the Quick Access Toolbar. To remove one of these 
commands, click Customize Quick Access Toolbar and then click the command to 
remove its check mark.

If you use Excel on a touchscreen device, you’ll want to add the Touch/Mouse Mode 
button to the Quick Access toolbar by selecting the Touch/Mouse Mode option on 
the Customize Quick Access Toolbar menu. Touch/Mouse Mode enables you to 
switch Excel in and out of touch spacing (engaged by default). Touch spacing puts 

FIGURE 2-1:  
Click Customize 

Quick Access 
Toolbar to see 

a few useful 
 commands that 
you can tack on 

to the toolbar.
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more space between the command buttons on each tab of the Excel Ribbon, thus 
making it a whole lot easier to select the correct command with either your finger 
or stylus. Even when running Excel on a computer without any touch capabilities, 
you can still add the Touch/Mouse Mode button to the Quick Access toolbar and 
use touch spacing to make it easier to select Tab commands with your mouse.

Adding Ribbon commands to the Quick 
Access toolbar
Excel makes it super-easy to add a command from any tab on the Ribbon to the 
Quick Access toolbar. To add a Ribbon command, right-click its command button 
on the Ribbon and then click Add to Quick Access Toolbar. Excel adds the com-
mand button to the very end of the Quick Access toolbar, immediately to the left 
of the Customize Quick Access Toolbar button.

If you want to move the command button to a new location on the Quick Access 
toolbar or group it with other buttons on the toolbar, you need to click the Cus-
tomize Quick Access Toolbar button and then click More Commands.

Excel then opens the Excel Options dialog box with the Quick Access Toolbar tab 
selected (similar to the one shown in Figure 2-2). Here, Excel shows all the but-
tons currently added to the Quick Access toolbar in the order in which they appear 
from left to right on the toolbar corresponding to their top-down order in the list 
box on the right side of the dialog box.

To reposition a particular button on the bar, click it in the list box on the right 
and then click either the Move Up button or the Move Down button (pointed out 
in Figure 2-2) until the button is promoted or demoted to the desired position on 
the toolbar.

You can add separators to the toolbar to group related buttons. To do this, click the 
<Separator> selection at the top of the list box on the left and then click the Add 
button twice to add two. Then, click the Move Up or Move Down button to position 
one of the two separators at the beginning of the group and the other at the end. 
You can always return the Quick Access toolbar to its default button-free state by 
choosing Reset ➪ Reset Only Quick Access Toolbar.

If you’ve added too many buttons to the Quick Access toolbar and can no longer 
read the workbook name, you can reposition the Quick Access toolbar so that it 
appears beneath the Ribbon immediately on top of the Formula bar. To do this, 
click the Customize Quick Access Toolbar button at the end of the toolbar and then 
click Show Below the Ribbon.
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Adding non-Ribbon commands  
to the Quick Access toolbar
You can also use the options on the Quick Access Toolbar tab of the Excel Options 
dialog box (refer to Figure 2-2) to add a button for any Excel command even if it’s 
not one of those displayed on the tabs of the Ribbon:

1. Select the type of command you want to add to the Quick Access toolbar 
from the Choose Commands From drop-down list box.

The types of commands include the default Popular Commands, Commands 
Not in the Ribbon, All Commands, and Macros, as well as each of the standard 
and contextual tabs that can appear on the Ribbon. To display only the 
commands not displayed on the Ribbon, click Commands Not in the Ribbon 
near the top of the drop-down list. To display a complete list of all the Excel 
commands, click All Commands.

2. Click the command whose button you want to add to the Quick Access 
toolbar in the Choose Commands From list box on the left.

3. Click the Add button to add the command button to the bottom of the 
list box on the right.

FIGURE 2-2:  
Use the buttons 

on the Quick 
Access Toolbar 
tab of the Excel 
Options dialog 

box to customize 
the appearance 

of the Quick 
Access toolbar.
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4. (Optional) To reposition the newly added command button so that it’s 
not the last one on the toolbar, click the Move Up button until it’s in the 
desired position.

5. (Optional) Repeat Steps 1 through 4 to add as many commands to the 
Quick Access toolbar as you feel like.

6. Click OK to close the Excel Options dialog box.

Exercising Your Options
Each time you open a new workbook, Excel makes a whole bunch of assump-
tions about how you want to interact with the program, how your worksheet data 
appears, how Excel calculates formula results, and much more. These assump-
tions may or may not fit the way you work and the kinds of worksheets you need 
to create.

In the following five sections, you get a quick rundown on how to change the most 
important default or preference settings in the Excel Options dialog box. This dia-
log box is the biggest Excel has, with a billion tabs (12 actually). From the Excel 
Options dialog box, you can control what things appear onscreen and how they 
appear, as well as when and how Excel calculates worksheets.

Nothing discussed in the following five sections is critical to your being able to 
operate Excel. Just remember the Excel Options dialog box if you find yourself 
futzing with the same setting over and over again in most of the workbooks you 
create. In such a situation, it’s high time to get into the Excel Options dialog box 
and modify that setting so that you won’t waste any more time tinkering with the 
same setting in future workbooks.

ADDING COMMANDS LOST FROM  
EARLIER EXCEL VERSIONS TO THE  
QUICK ACCESS TOOLBAR
Although certain commands from earlier versions of Excel, such as Data ➪ Form and 
View ➪ Web Page Preview, did not make it to the Ribbon in Excel, this does not mean 
that they were entirely eliminated from the program. The only way, however, to revive 
these commands is to add their buttons to either the Quick Access toolbar or to the 
Ribbon after clicking the Commands Not in the Ribbon category from the Choose 
Commands From drop-down list on the Customization tab of the Excel Options dia-
log box.
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Changing some of the more universal  
settings on the General tab
The General tab (shown in Figure 2-3) is the first tab in the Excel Options dialog 
box. This tab is automatically selected whenever you first open this dialog box by 
choosing File ➪  Options or by pressing Alt+FT.

The options on the General tab are arranged into six groups: User Interface 
Options, When Creating New Workbooks, Personalize Your Copy of Microsoft 
Office, Privacy Settings, LinkedIn Features, and Start Up Options.

The User Interface Options group
The User Interface Options group contains the following check boxes and buttons:

 » When Using Multiple Displays: Select the Optimize for Best Appearance 
setting to have the Excel program window plus whatever other windows you 
have open on the connected display screens look their very best. If you find 
that your Excel windows lose elements (such as scroll bars) when you drag 
them from one display to another, select the Optimize for Compatibility 
setting instead.

FIGURE 2-3:  
The General tab’s 

options enable 
you to change 

many global Excel 
settings.
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 » Show Mini Toolbar on Selection: Toggles the display of the mini-toolbar, 
which contains essential formatting buttons from the Home tab, above a cell 
selection or other object’s shortcut menu when you right-click it.

 » Show Quick Analysis Options on Selection: Toggles the appearance of the 
Quick Access toolbar in the lower-right corner of a cell selection. The Quick 
Analysis toolbar contains options for applying formatting to the selection as 
well as creating new charts and PivotTables using its data.

 » Show Convert to Data Types When Typing: Toggles the display of the 
Convert to Data Type option when you’re entering worksheet items that Excel 
thinks may match a data type category, such as Stocks or Geography.

 » Enable Live Preview: Toggles the Live Preview feature where Excel previews 
the data in the current cell selection using the font or style you highlight in a 
drop-down list or gallery before you actually apply the formatting.

 » Collapse the Ribbon Automatically: When selected, configures Excel to 
automatically show only the Ribbon’s tab names when you reduce the Excel 
window below a certain size. Restart Excel to put this setting into effect.

 » Collapse the Microsoft Search Box by Default: When selected, replaces the 
Search text box that appears in the Excel title bar with the Search icon (a 
magnifying glass).

 » ScreenTip Style: Changes the way ScreenTips (which display information about 
the command buttons you highlight with the mouse) are displayed onscreen. 
Click Don’t Show Feature Descriptions in ScreenTips from the ScreenTip Style 
drop-down list to display a minimum amount of description in the ScreenTip 
and eliminate all links to online help, or click Don’t Show ScreenTips to com-
pletely remove the display of ScreenTips from the screen (potentially confusing 
if you add macros to the toolbar that all use the same icon).

The When Creating New Workbooks group
The options in the When Creating New Workbooks group of the Popular tab of the 
Excel Options dialog box include only these four combo and text boxes:

 » Use This as the Default Font: Select a new default font to use in all cells of 
new worksheets by entering the font name in the combo box or clicking its 
name in the drop-down list (Body Font, which is actually Microsoft’s 
Calibri font).

 » Font Size: Select a new default size to use in all cells of new worksheets (11 
points is the default size) by entering the value in the box or by clicking this 
new point value in the drop-down list.
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 » Default View for New Sheets: Select either Page Break Preview (displaying 
page breaks that you can adjust) or Page Layout (displaying page breaks, 
rulers, and margins) as the default view (rather than Normal) for all new 
worksheets.

 » Include This Many Sheets: Change the default number of worksheets in 
each new workbook (1 being the default) by entering a number between  
2 and 255 or select this new number by clicking the spinner buttons.

The Personalize Your Copy of Microsoft  
Office group
The Personalize Your Copy of Microsoft Office group contains the following three 
options:

 » User Name: This text box enables you to change the username that’s used as 
the default author for new workbooks created with Excel.

 » Office Background: This drop-down list enables you to select a faint back-
ground pattern to be displayed on the right side of the Excel program window 
where your name, the Ribbon Display Options, and Minimize, Restore, and 
Close buttons all appear. To switch back to the default of no pattern in this 
area of the screen after selecting one of the available background patterns, 
click the No Background option at the top of this drop-down list.

 » Office Theme: This drop-down list enables you to select between a half dozen 
tint options — Black, Colorful, Dark Gray, Light Gray, Use System Setting, and 
White — that are applied to the borders of the Excel screen, creating a kind of 
background color for the Ribbon tabs, column letter and row number 
indicators on the worksheet frame, and the Status bar.

When you select the Always Use These Values Regardless of Sign In to Office check 
box in the Personalize Your Copy of Microsoft Office group, the username, back-
ground pattern, and theme you select for the User Name, Office Background, and 
Office Theme options are applied to all the Office application programs that you 
use, such as Word, PowerPoint, and so on.

The Privacy Settings group
This group includes just a single button named Privacy Settings. Clicking this but-
ton opens the Privacy Settings dialog box, which contains a series of check boxes 
that control the types of Office data that are shared with Microsoft. For greater 
privacy, deselect more of the check boxes, although know that some Excel features 
may no longer work as advertised or at all.
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The LinkedIn Features group
The Enable LinkedIn Features In My Office Application check box is enabled by 
default. The Office LinkedIn features are really used more in Office programs such 
as Outlook and Word to keep you better connected to the people in your network.

The Start Up Options group
The final group, Start Up Options, contains the following three settings:

 » Choose the Extensions You Want Excel to Open by Default: The Default 
Programs button, when clicked, displays a dialog box telling you to open 
Windows’ Settings app and then choose Apps ➪ Default Apps. In the Default 
Apps screen, click Choose Default Apps by File Type, which enables you to 
select all the types of application files that you want associated with Excel. 
Once associated with Excel, double-clicking any file carrying its extension 
automatically launches Excel for viewing and editing.

 » Tell Me if Microsoft Excel Isn’t the Default Program for Viewing and 
Editing Spreadsheets: This check box determines whether you’re informed 
should another spreadsheet program or viewer on your computer other than 
Excel be associated with opening Excel workbook files.

 » Show the Start Screen When This Application Starts: This check box 
determines whether the Start screen (described in detail in Book 1, Chapter 1) 
appears when you launch Excel.

If you always choose the Blank Workbook template when you start Excel, deselect 
the Show the Start Screen When This Application Starts check box. Now, whenever 
you launch Excel, the program immediately opens a new, blank workbook file in 
the worksheet view, skipping entirely the Excel Backstage view. You’re welcome.

Changing common calculation options  
on the Formulas tab
The options on the Formulas tab (see Figure 2-4) of the Excel Options dialog box 
(File ➪ Options ➪ Formulas or Alt+FTF) are divided into Calculation Options, Work-
ing with Formulas, Error Checking, and Error Checking Rules.
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The Calculation Options group
The Calculation Options enable you to change when formulas in your workbook 
are recalculated and how a formula that Excel can’t solve on the first try (such as 
one with a circular reference) is recalculated. Choose from the following items:

 » Automatic: Excel recalculates all formulas immediately after you modify any 
of the values on which their calculation depends (this is the default).

 » Automatic Except for Data Tables: Excel automatically recalculates all 
formulas except for those entered into what-if data tables you create. (See 
Book 7, Chapter 1.) To update these formulas, you must click the Calculate 
Now (F9) or the Calculate Sheet (Shift+F9) command button on the Formulas 
tab of the Ribbon.

 » Manual: Excel doesn’t recalculate formulas automatically. Instead, you now 
use manual recalculation, where formulas that need updating get recalculated 
only when you click the Calculate Now (F9) or the Calculate Sheet (Shift+F9) 
command button on the Formulas tab of the Ribbon. If you leave the 
Recalculate Workbook Before Saving check box selected, Excel recalculates 
the workbook’s formulas each time you save the file.

FIGURE 2-4:  
The Formulas 
tab’s options 

 enable you to 
change how 

Excel works with 
formulas.
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 » Enable Iterative Calculation: Toggles iterative calculations for formulas that 
Excel can’t solve on the first try. (See Book 3, Chapter 1.) If you select this 
check box, then you can also modify the following two related options:

• Maximum Iterations: Sets the number of times (100 is the default) that Excel 
iteratively recalculates a seemingly insolvable formula. Enter a number 
between 1 and 32767 in the text box or click the spinner buttons.

• Maximum Change: Sets the amount by which Excel increments the guess 
value it applies each time the program iteratively recalculates the formula 
in an attempt to solve it by entering the new increment value in the 
text box.

The Working with Formulas options group
The Working with Formulas group contains four check boxes that determine a 
variety of formula-related options:

 » R1C1 Reference Style: Toggles the R1C1 cell reference style, which uses 
numbers for both rows and columns, preceded by R and C, respectively. Row 
1 is R1, row 2 is R2, and so on; similarly, column A is C1, column B is C2, and so 
on. For example, R45C2 refers to cell B45. (Just so you know, Excel’s default 
cell referencing — letters for columns and numbers for rows — is called the 
A1 cell reference style.)

 » Formula AutoComplete: Toggles the Formula AutoComplete feature where 
Excel attempts to complete the formula or function you’re manually building 
in the current cell.

 » Use Table Names in Formulas: Toggles the feature where Excel automati-
cally applies all range names you’ve created in a table of data to all formulas 
that refer to their cells. (See Book 3, Chapter 1.)

 » Use GetPivotData Functions for PivotTable References: Toggles the 
GetPivotTable function that Excel uses to extract data from specified fields in a 
data source when placing them in a PivotTable summary report you’re 
creating. (See Book 7, Chapter 2 for details.)

 » Suggest Formula Variations That Are Supported by Older Versions of 
Excel: Toggles the Excel feature that suggests alternative formulas that are 
compatible with older versions of Excel. This option mostly deals with Excel’s 
dynamic arrays, which are not supported in Excel 2019 and earlier. (See Book 3, 
Chapter 1.)
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The Error Checking and Error Checking  
Rules groups
The remaining options on the Formulas tab of the Excel Options dialog box enable 
you to control error-checking for formulas.

In the Error Checking group, the sole check box, Enable Background Error Check-
ing, which enables error-checking in the background while you’re working in 
Excel, is checked.

In the Error Checking Rules, all the check boxes are checked, with the exception of 
the Formulas Referring to Empty Cells check box, which indicates a formula error 
when a formula refers to a blank cell.

To disable background error checking, click the Enable Background Error Check-
ing check box in the Error Checking group to remove its check mark. To change the 
color used to indicate formula errors in cells of the worksheet (when background 
error checking is engaged), click the Indicate Errors Using This Color drop-down 
button and click a new color square on its drop-down color palette. To remove the 
color from all cells in the worksheet where formula errors are currently indicated, 
click the Reset Ignore Errors button. To disable other error-checking rules, click 
their check boxes to remove the check marks.

Digging the options on the Data tab
The Data Options group on the Data tab of the Excel Options dialog box contains 
four check boxes. These options control the way that Excel handles huge amounts 
of data that you can access in Excel through external data queries discussed in 
Book 6, Chapter 2 or through Excel’s PivotTable feature (especially when using 
the Power Pivot add-in) discussed in Book 7, Chapter 2.

By default, Excel disables the undo feature when refreshing data in a PivotTable 
created from external data that has more than 300,000 source rows (also called 
records) to significantly reduce the data refresh time. To modify the minimum 
number of source rows at which the Undo Refresh feature is disabled, enter a 
new number (representing thousands of records) in the text box containing the 
default value of 300 under the Disable Undo for Large PivotTable Refresh Opera-
tions check box or select the new value with the spinner buttons. To enable the 
undo feature for all refresh operations in your large PivotTables (regardless of 
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how long the refresh operation takes), deselect the Disable Undo for Large Pivot-
Table Refresh Operations check box.

Excel also automatically disables the Undo feature for Excel tables that are created 
from related external database tables (referred to in Excel as a data model) that 
exceed 8MB in size. To change the minimum size at which the Undo feature is 
disabled, enter a new number (representing megabytes) in the text box contain-
ing the default value of 8 under the Disable Undo for Large Data Model Operations 
check box or select this new value with the spinner buttons. To enable the Undo 
feature for all operations involving tables created from an external data model 
(regardless of how long the undo operation takes), deselect the Disable Undo for 
Large Data Model Operations check box.

If you want Excel to automatically assume that any external data used in creating 
new PivotTables or imported into tables from external data queries involve a data 
model so that Excel automatically looks for the fields that are related in the files 
you designate, select the Prefer the Excel Data Model When Creating PivotTables, 
QueryTables, and Data Connections check box.

In addition to Data Options, the Data tab contains a Show Legacy Data Import 
Wizards group with a number of unselected check boxes for each of the wizards 
that earlier versions of Excel used to import particular types of data, such as tables 
from Microsoft Access databases, web page queries, or text files.

As Excel has greatly improved its data import capabilities for automatically rec-
ognizing and parsing data imported into one of its worksheets, selecting any of 
these so-called Legacy Import Wizards is unnecessary unless you have extensive 
experience with these older import engines and find that Excel’s data intelligence 
capabilities are having trouble properly importing data from one of these external 
sources on which your work depends.

Changing correction options on  
the Proofing tab
The options on the Proofing tab (see Figure 2-5) of the Excel Options dialog box 
(File ➪ Options ➪ Proofing or Alt+FTP) are divided into two groups: AutoCorrect 
Options and When Correcting Spelling in Microsoft Office Programs.
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The AutoCorrect Options group
Click the AutoCorrect Options button to open the AutoCorrect dialog box for the 
primary language used in Microsoft Office. This dialog box contains the following 
four tabs:

 » AutoCorrect: Offers options that control what corrections Excel automatically 
makes, an Exceptions button that enables you to indicate what words or 
abbreviations are not to be capitalized in the AutoCorrect Exceptions dialog 
box, and text boxes where you can define custom replacements that Excel 
makes as you type.

 » AutoFormat As You Type: Comes with options that control whether to 
replace Internet addresses and network paths with hyperlinks, and to 
automatically insert new rows and columns to cell ranges defined as tables 
and copy formulas in calculated fields to new rows of a table.

 » Actions: Includes an Enable Additional Actions in the Right-Click Menu check 
box and Available Actions list box that let you activate a date or financial 
symbol context menu that appears when you enter certain date and financial 
text in cells.

 » Math AutoCorrect: Includes Replace and With text boxes that enable you to 
replace certain text with math symbols that are needed in your worksheets.

FIGURE 2-5:  
The Proofing tab’s 

options enable 
you to change 

AutoCorrect and 
spell-checking 

options.



Cu
st

om
iz

in
g 

Ex
ce

l

CHAPTER 2  Customizing Excel      53

The When Correcting Spelling in Microsoft Office 
Programs group
The options in the When Correcting Spelling in Microsoft Office Programs group 
of the Proofing tab control what types of errors Excel flags as possible misspell-
ings when you use the Spell Check feature. (See Book 2, Chapter 3.) This group also 
contains the following buttons:

 » Custom Dictionaries: Opens the Custom Dictionaries dialog box, where you 
can specify a new custom dictionary to use in spell checking the worksheet, 
define a new dictionary, and edit its word list.

 » French Modes or Spanish Modes: Specify which forms of the respective 
language to use in proofing worksheet text.

 » Dictionary Language: Specifies by language and country which dictionary to 
use in proofing worksheet text.

Changing save options on the Save tab
The options on the Save tab (see Figure  2-6) of the Excel Options dialog box 
(File ➪ Options ➪ Save or Alt+FTS) are divided into five groups: Save Workbooks, 
AutoRecover Exceptions for the current workbook (such as Book1), Offline Editing 
Options for Document Management Server Files, Preserve Visual Appearance of 
the Workbook, and Cache Settings.

Here are the options in the Save Workbooks group:

 » AutoSave OneDrive and SharePoint Online Files by Default on Excel: With 
this option selected, Excel automatically saves all editing changes in all 
workbook files that you initially save in the cloud in a folder on your OneDrive 
or SharePoint site. Note that using the AutoSave feature gives you the benefit 
of seeing the editing changes made by others who are also working on the 
same workbook saved in the cloud in real time.

 » Save Files in This Format: The default setting for this drop-down list is Excel 
Workbook, the XML-based file format first introduced in Excel 2007 that 
appends the .xlsx suffix to the filename. If you want Excel to automatically 
save your new workbook files in another file format (such as the old Excel 
workbook file format that uses the *.xls suffix), select that format (such as the 
Excel 97-2003 menu option in this drop-down list).
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 » Save AutoRecover Information Every X Minutes: Toggles AutoRecover and 
specifies the time interval that Excel uses to save workbook copies to use with 
the AutoRecover feature. With AutoRecover on the job, Excel saves copies of 
your entire Excel workbook at the interval displayed in the Minutes text box. 
The default is 10 minutes, but you can get a ton of work done in 10 minutes, 
so I suggest an AutoRecover interval of 1 or 2 minutes.

If your computer should crash or you suddenly lose power, the next time you 
start Excel, the program automatically displays an AutoRecover pane on the left 
side of the worksheet area. From this pane, you can open a copy of the work-
book file that you were working on when this crash or power loss occurred.  
If this recovered workbook (saved at the time of the last AutoRecover) contains 
information that isn’t saved in the original copy (the copy you saved the last time 
you used the Save command before the crash or power loss), you can then use 
the recovered copy rather than manually reconstructing and re-entering the 
otherwise lost information. You may also use the recovered copy of a workbook 
should the original copy of the workbook file become corrupted in such a way 
that Excel can no longer open it. (This happens very rarely, but it does happen.)

FIGURE 2-6:  
The Save tab’s 

options enable 
you to change  
the automatic 

save and backup 
and recovery 

options.
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 » Keep the Last AutoRecovered Version If I Close without Saving: Toggles 
the feature where Excel retains the most recent AutoRecover copy if you click 
Don’t Save when you close a workbook. If you realize that was a mistake, you 
can at least use AutoRecover to open that saved copy and perhaps salvage 
some of your lost work.

 » AutoRecover File Location: Specifies the drive and folder location that Excel 
uses to store its AutoRecover copies.

Don’t disable the AutoRecover feature even if you have a battery backup 
system for your computer that gives you plenty of time to manually save your 
Excel workbook during any power outage. Disabling AutoRecover in no way 
protects you from data loss if your workbook file becomes corrupted or you 
hit the computer’s power switch by mistake.

 » Don’t Show the Backstage when Opening or Saving Files with Keyboard 
Shortcuts: Normally, Excel shows the Open screen in the Backstage view 
whenever you press Ctrl+O to open a file for editing and the Save As screen 
when you press Ctrl+S or click the Save button on the Quick Access toolbar to 
save a new workbook. Select this check box if you want Excel to display the 
Open and Save dialog box in the Worksheet area (as was the case in previous 
versions of Excel) instead.

 » Show Additional Places for Saving, Even If Sign-in May Be Required: When 
Excel opens the Save As screen in the Backstage view, the program automati-
cally displays the buttons for signing into online services, such as your 
OneDrive or the SharePoint team site, on this screen. If you don’t save your 
files to the cloud or don’t have access to OneDrive, you can deselect this check 
box to remove such sign-in options from the Save As screen.

 » Save to Computer by Default: If you prefer to save your workbook files 
locally on your computer’s hard drive or a virtual drive on a local area network 
to which you have access, select this check box.

 » Default Local File Location: This text box contains the path to the local folder 
where Excel saves new workbook files by default when you click the Save to 
Computer by Default check box as described in the preceding bullet item.

 » Default Personal Templates Location: If the templates that you commonly 
use in creating new Excel workbooks are located in a local folder on your 
computer’s hard drive or a network drive to which you have access, enter the 
folder’s entire pathname in this text box after clicking the Save to Computer 
by Default check box as described earlier.
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 » Show Data Loss Warning When Editing Comma Delimited Files (*.csv): 
When this option is selected, if you try to save a workbook using the CSV 
(comma-delimited) file format, Excel displays the Possible Data Loss informa-
tion bar when it detects that workbook features may be lost during the save. It 
doesn’t say which features may be lost, so if you’re worried, you can always 
click Save As in the information bar to save the workbook in an Excel file 
format. However, most of the itme you’re fine to save the workbook as a 
comma-delimited file.

In the AutoRecover Exception For group, you can turn off AutoRecover for a sin-
gle workbook. (This is opposed to deselecting the Save AutoRecover Information 
Every X Minutes check box, which disables AutoRecover globally.) Use the drop-
down list to select the workbook you want to use, and then select the Disable 
AutoRecover for This Workbook Only check box.

If your company enables you to share the editing of certain Excel workbooks 
through the Excel Services offered as part of SharePoint Services software, you 
can change the location where Excel saves drafts of the workbook files you check 
out for editing. By default, Excel saves the drafts of these checked-out workbook 
files locally on your computer’s hard drive inside a SharePoint Drafts folder in the 
Documents folder. If your company or IT department prefers that you save these 
draft files on the web server that contains the SharePoint software, enter the net-
work path in the Server Drafts Location text box.

If you share your Excel workbooks with workers who are still using older versions 
(97–2003) of Excel, use the Colors command button to determine which color in 
the Excel worksheet to preserve in formatted tables and other graphics when you 
save the workbook file for them using the Excel 97–2003 file format option. (See 
Book 2, Chapter 1.)

Changing the Office language preferences
The options on the Language tab of the Excel Options dialog box enable you to 
change the languages that Excel uses.

The Office Display Language group controls the language used for the Excel  
display — that is, the interface: tabs, buttons, the Ribbon, and so on. You can  
perform the following tasks in the Office Display Language group:

 » Add more display languages. Click the Install Additional Display Languages 
from Office.com link. You go to a web page where you can download a 
language pack accessory for Office.
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 » Change the display language priority order. In the Office Display Language 
list, click the language you want to work with, and then click Move Up (higher 
priority) or Move Down (lower priority) to set the preferred position of the 
language within the list.

 » Set the preferred display language. In the Office Display Language list, click 
the language you want to work with, and then click the Set as Preferred button.

The Office Authoring Languages and Proofing group controls the languages used 
for authoring and proofing worksheet data. You can perform the following tasks 
in the Office Authoring Languages and Proofing group:

 » Add an authoring language. Click the Add a Language button, use the Add 
an Authoring Language list to select the language you want to add, and then 
click Add. Excel adds the language to the Office Authoring Languages and 
Proofing list.

After you add the language, you may see the Proofing Available link to the 
right of the language. That link tells you that your work is not done because 
now you also need to install the associated language pack from the Office.
com website. Click the Proofing Available link to display the language pack 
page, click Download, and then install the downloaded file.

 » Set the preferred authoring language. In the Office Authoring Language 
and Proofing list, click the language you want to work with, then click the Set 
Preferred button.

 » Remove an authoring language. In the Office Authoring Language and 
Proofing list, click the language you want to delete and then click Remove. 
Restart Excel to put the change into effect.

Setting some accessibility options
The settings in the Ease of Access tab (File ➪ Options ➪ Ease of Access or Alt+FTE) 
offer several ways to make Excel more accessible for people with visual, hearing, 
or mobility challenges. I talk more about using these options to enhance Excel 
accessibility in Book 4, Chapter 3. So, for now, here’s a quick look at the settings 
in the Ease of Access tab:

 » Keep Accessibility Checker Running While I Work: When selected, runs 
Excel’s Accessibility Checker in the background as you work. This is useful 
because the Accessibility Checker alerts you right away if any accessibility 
issues come up while you’re working. If you leave this check box deselected, 
you can run the Accessibility Checker manually by selecting the Check 
Accessibility command on the Review tab.
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 » Provide Feedback with Sound: When selected, adds audio cues to many 
Excel actions, including screen changes and completed tasks (such as copying, 
pasting, or deleting data). If you select this check box, Excel enables the Sound 
Screen drop-down list, from which you can choose the sound effects you 
want: Modern or Classic. This option applies to all Office applications that 
support audio cues.

 » Provide Feedback with Animation: When selected, adds animation effects 
to many Excel actions.

 » ScreenTip Style: Sets the content of the ScreenTips that appear when you 
hover the mouse pointer over an Excel feature. By default, each ScreenTip 
shows the feature name and its description. Choose Don’t Show Feature 
Descriptions in ScreenTips to see only the feature name in each ScreenTips. If 
you find that ScreenTips just get in your way, choose Don’t Show ScreenTips 
to turn them off.

 » Show Function ScreenTips: When selected, displays a ScreenTip showing a 
function’s syntax while you enter that function into a cell. Deselect this option 
if function ScreenTips are a problem for you.

 » Show the Start Screen When this Application Starts: Toggles the display of 
the Start screen when you launch Excel. If you have trouble negotiating this 
screen and prefer to start directly into Excel, deselect this check box.

 » Font size: Sets the default font size that Excel uses for worksheet text.

Changing a whole lot of other common 
options on the Advanced tab
The options on the Advanced tab (see Figure  2-7) of the Excel Options dialog 
box (File ➪ Options ➪ Advanced or Alt+FTA) are divided into the 15 groups listed in 
Table 2-1.

The options in these 15 groups of the Advanced tab actually fall into four some-
what distinct areas: options for editing in the worksheet; options for control-
ling the screen display; and a potpourri area of formula, calculating, and general 
options.
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FIGURE 2-7:  
The Editing and 
Cut, Copy, and 

Paste options on 
the Advanced tab 
control how Excel 

behaves during 
editing.

TABLE 2-1	 Advanced Excel Options
Option What It Does

Editing Options Changes the way you edit the worksheets you create

Cut, Copy, and Paste Changes the way worksheet editing that involves cutting, copying, and pasting to 
and from the Clipboard works

Link Handling When selected, configures the Office applications to open links to Office 
documents in the respective Office desktop apps; if you leave this check 
deselected, the same links open in the respective Office web apps, instead.

Pen If you’re using Excel on a tablet or other touchscreen device, this option makes  
digital ink (as when making entries with the Windows 10 touch keyboard) the default

Image Size and Quality Controls how an image’s data is used in a worksheet

Print Controls whether high or regular quality is used for the graphic images in the 
printed worksheet

Chart Controls how Excel deals with the charts you add to a worksheet

Display Determines how elements (from recently used workbooks in the Backstage view 
to ruler units, the presence of the Formula bar, ScreenTips, and comments in the 
worksheet) appear onscreen

Display Options for 
This Workbook

Sets display options for the current workbook open in Excel

(continued)
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Working the worksheet editing options
As you can see in Figure 2-7, the settings in the Editing Options and Cut, Copy, 
and Paste groups on the Advanced tab control what happens when you edit the 
contents of an Excel worksheet.

When you first open the Advanced tab of the Excel Options dialog box, all the 
check boxes in the Editing Options and Cut, Copy, and Paste groups are checked 
with the exception of these three:

 » Automatically Insert a Decimal Point: When selected, automatically adds a 
decimal point to numeric worksheet entries using the number of decimal 
places in the Places text box. For example, if Places is 2 (the default value), 
entering 12345 into a cell converts to 123.45 when you confirm the entry. (See 
Book 2, Chapter 1 for details.)

 » Zoom on Roll with IntelliMouse: When selected, increases or decreases the 
screen magnification percentage by 15 percent on each roll forward and back 
of the center wheel of a mouse that supports Microsoft’s IntelliMouse 
technology. When this option isn’t checked, Excel scrolls the worksheet up and 
down on each roll forward and back of the center wheel.

 » Do Not Automatically Hyperlink Screenshot: When selected, prevents Excel 
from automatically creating hyperlinks to any screenshots that you take of the 
Windows desktop using the Screen Clipping option on the Take a Screenshot 
button in the Illustrations group on the Insert tab of the Ribbon. (See Book 5, 
Chapter 2 for details.)

Option What It Does

Display Options for 
This Worksheet

Sets display options for the currently selected worksheet in the workbook 
open in Excel

Formulas Determines how Excel deals with calculating sophisticated formulas in the 
worksheets in your workbook

When Calculating 
This Workbook

Sets calculation parameters for the workbook open in Excel

General Controls all-purpose options, including such diverse options as the workbook files 
that you want opened when Excel launches, how your workbooks appear on the 
web, and the creation of custom AutoFill lists

Lotus Compatibility Sets general Lotus 1-2-3 compatibility in Excel

Lotus Compatibility 
Settings For

Sets Lotus 1-2-3 compatibility for a particular worksheet in the workbook 
open in Excel

TABLE	2-1	(continued)
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Most of the time, you’ll want to keep all the other check boxes in the Editing 
Options and Cut, Copy, and Paste groups selected. The only one of these you may 
want to disengage is the Use System Separators check box when you routinely cre-
ate worksheets with financial figures expressed in foreign currencies that don’t 
use the period (.) as the decimal point and the comma (,) as the thousands sepa-
rator. After you deselect the Use System Separators check box, the Decimal Sepa-
rator and Thousands Separator text boxes become active, and you can then enter 
the appropriate punctuation into these two boxes.

By default, Excel selects Down as the Direction setting when the After Pressing 
Enter, Move Selection check box is checked. If you want Excel to automatically 
advance the cell cursor in another direction (Right, Up, or Left), select the direc-
tion from its drop-down list. If you don’t want Excel to move the cell cursor out-
side of the active cell upon completion of the entry (the same as clicking the Enter 
button on the Formula bar), deselect the After Pressing Enter, Move Selection 
check box.

Playing around with the display options
The display options in the middle of the Advanced tab of the Excel Options dia-
log box (see Figure 2-8) fall into three categories: general Display options that 
affect the Excel program; Display Options for This Workbook that affect the cur-
rent workbook; and Display Options for This Worksheet that affect the active sheet 
in the workbook.

FIGURE 2-8:  
The display 

options in the 
center of the 

Advanced tab 
control what’s 
shown on the 

screen.
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Most of the options in these three categories are self-explanatory as they either 
turn off or on the display of particular screen elements, such as the Formula bar, 
ScreenTips, scroll bars, sheet tabs, column and row headers, page breaks, (cell) 
gridlines, and the like.

When using these display options to control the display of Excel’s screen ele-
ments, keep the following things in mind:

 » The Ruler Units drop-down list box automatically uses the Default Units for 
your version of Microsoft Office (Inches in the U.S. and Centimeters in Canada 
and Europe). These default units (or those you specifically select from the 
drop-down list: Inches, Centimeters, or Millimeters) are then displayed on 
both the horizontal and vertical rulers that appear above and to the left of the 
column and row headings only when you put the Worksheet area display into 
Page Layout view (Alt+WP).

 » Select the Indicators and Notes, and Comments on Hover option button 
under the For Cells with Comments, Show heading when you want Excel to 
always display the text boxes with the notes you add to cells. (For notes, see 
Book 4, Chapter 2; for comments, see Book 4, Chapter 3.)

 » Select the Nothing (Hide Objects) option button under the For Objects, Show 
heading when you want Excel to hide the display of all graphic objects in the 
worksheet, including embedded charts, clip art, imported pictures, and all 
graphics that you generate in the worksheet. (See Book 5, Chapters 1 and 2 
for details.)

 » Deselect the Show Page Breaks check box to remove the dotted lines 
indicating page breaks in Normal (Alt+WN) view after viewing the Worksheet 
area in either Page Break Preview (Alt+WI) or Page Layout view (Alt+WP).

 » Instead of going to the trouble of selecting the Show Formulas in Cells Instead 
of Their Calculated Results check box to display formulas in the cells of the 
worksheet, press Ctrl+’ (apostrophe) or click the Show Formulas button on the 
Formulas tab of the Ribbon. Both the keystroke shortcut and the button are 
toggles so that you can return the Worksheet area to its normal display 
showing the calculated results rather than the formulas by pressing the Ctrl+’ 
shortcut keys again or clicking the Show Formulas button.

 » Instead of going to the trouble of deselecting the Show Gridlines check box 
whenever you want to remove the column and row lines that define the cells 
in the Worksheet area, click the Gridlines check box in the Show/Hide group 
on the View tab or the View check box in the Gridlines column of the Sheet 
Options group on the Page Layout tab to remove their check marks.
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Use the Gridline Color drop-down list button immediately below the Show Grid-
lines check box to change the color of the Worksheet gridlines (when they’re dis-
played, of course) by clicking a new color on the color palette that appears when 
you click its drop-down list button.

Caring about the Formulas, Calculating,  
and General options
At the bottom of the Advanced tab of the Excel Options dialog box (see Figure 2-9), 
you find a regular mix of options in five groups. The first three groups, Formulas, 
When Calculating This Workbook, and General, contain a veritable potpourri of 
options.

Most of the settings in these three groups won’t need changing. In rare cases, you 
may find that you have to activate the following options or make modifications to 
some of their settings:

 » Set Precision as Displayed: Select this check box only when you want to 
permanently change the calculated values in the worksheet to the number of 
places currently shown in their cells as the result of the number format 
applied to them.

 » Use 1904 Date System: Select this check box when you’re dealing with a 
worksheet created with an earlier Macintosh version of Excel that used 1904 
rather than 1900 as date serial number 1. (If all this is gibberish to you, see 
Book 3, Chapter 3 for enlightenment.)

 » Web Options: Click this command button to display the Web Options dialog 
box, where you can modify the options that control how your Excel data 
appears when viewed with a web browser, such as Microsoft Edge.

 » Edit Custom Lists: Click this command button to create or edit custom lists 
that you enter into the worksheet by using the Fill handle. (See Book 2, 
Chapter 1.)

Customizing the Excel Ribbon
The options on the Customize Ribbon tab (see Figure 2-10) of the Excel Options 
dialog box (File ➪ Options ➪ Customize Ribbon or Alt+FTC) enable you to modify 
which tabs appear on the Excel Ribbon and the order in which they appear, as well 
as to change which groups of command buttons appear on each of these displayed 
tabs. You can even use its options to create brand-new tabs for the Ribbon as well 
as create custom groups of command buttons within any of the displayed tabs.



64      BOOK 1  Excel Basics

Customizing the Ribbon’s tabs
If you find that the default arrangement of main tabs and groups on the Excel Rib-
bon is not entirely to your liking, you can simplify or rearrange them to suit the 
way you routinely work:

 » Hide a tab. Deselect the tab’s check box in the Main Tabs list box on the right 
side of the Excel Options dialog box. (To later redisplay the hidden tab, select 
its check box.)

 » Change a tab’s position on the Ribbon. In the Main Tabs list, select the tab 
to move and then click either the Move Up button or Move Down button 
(refer to Figure 2-10) until the name of the tab appears in the desired position 
in the Main Tabs list. (Note that moving a tab up in the list means the tab is 
shifted left on the Ribbon; similarly, moving a tab down in the list means the 
tab is shifted right on the Ribbon.)

 » Change a group’s position within a tab. In the Main Tabs list, for the tab 
that contains the group you want to work with, click the tab’s Expand button 
(the plus sign) to display the tab’s groups. Next click the name of the group 
you want to reposition and click either the Move Up or Move Down button 
until it appears in the desired position in the list.

 » Remove a group from a tab. In the Main Tabs list, for the tab that contains the 
group you want to remove, click the tab’s Expand button (the plus sign) to display 
the tab’s groups. Select the tab and then click the Remove command button.

FIGURE 2-9:  
The Advanced tab 

options control 
calculation, 

general, and 1-2-3 
compatibility 

settings.
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In addition to the main tabs of the Ribbon, you can control which groups of com-
mand buttons appear on its contextual tabs (such as the Table Design or Chart 
Design contextual tabs that automatically appear when you’re working on an 
Excel table or chart):

 » Display the contextual tab groups you want to work with. Use the 
Customize the Ribbon list to select Tool Tabs, which displays a list of all the 
contextual tabs. Click the Expand button (+) beside the contextual tab whose 
groups you want to work with.

 » Change a group’s position within a contextual tab. Click the group name 
and then click the Move Up or Move Down buttons to move the group into its 
new position.

 » Remove a group from a contextual tab. Click the group and then click 
Remove.

To restore the original groups to a particular tab or contextual tab you’ve modi-
fied, click the tab in the Customize the Ribbon list, click the Reset drop-down but-
ton beneath this list box, and then click Reset Only Selected Ribbon Tab.

FIGURE 2-10:  
The Customize  

Ribbon tab 
options enable 
you to control 

which tabs are 
displayed on the 

Ribbon and which 
groups of  
command 

 buttons they 
contain.
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If you want to restore all the tabs and groups on the Ribbon to their original 
default arrangement, you can click the Reset drop-down button and then click the 
Reset All Customizations option. Just be aware that clicking this option not only 
restores the Ribbon’s default settings but also negates all changes you’ve made 
to the Quick Access toolbar at the same time. If you don’t want this to happen, 
restore the tabs of the Ribbon individually by using the Reset Only Selected Ribbon 
tab option described in the preceding tip.

Adding custom tabs to the Ribbon
The Customize Ribbon tab of the Excel Options dialog box not only lets you cus-
tomize the existing Ribbon tabs but also lets you add tabs of your own. This is 
great news if you want Ribbon access to Excel commands you routinely rely on 
that didn’t make it to the default Ribbon or if you want to cram all your most-used 
commands into a single custom tab.

To add a brand-new tab to the Ribbon, follow these steps:

1. Open the Customize Ribbon tab of the Excel Options dialog box 
(File ➪ Options ➪ Customize Ribbon or Alt+FTC).

Excel opens the Customize Ribbon tab with the Main Tabs selected in the 
Customize the Ribbon list box on the right.

2. Under Main Tabs in this list box, click the tab that you want to come 
before the new tab you’re about to insert.

Excel inserts the new tab after the one that’s currently selected in the 
Customize the Ribbon list box. This means that if you want your new custom 
tab to appear at the beginning of the Ribbon, choose the Background Removal 
tab, which means Excel positions your custom tab just before the Home tab.

3. Click New Tab.

Excel inserts a tab called New Tab (custom) with the single group called New 
Group (Custom) displayed and selected. This New Tab (Custom) is placed 
immediately after the currently selected tab.

4. Add a command to this group on the custom tab by clicking the com-
mand in the Choose Commands From list and then clicking Add.

When adding commands, you can select them from any of the following 
categories available in the Choose Commands From drop-down list: Popular 
Commands, Commands Not in the Ribbon, All Commands, Macros, File Tab, All 
Tabs, Main Tabs, Tool Tabs, and Custom Tabs and Groups (which lists all 
custom tabs and groups you’ve previously created).

Repeat Step 4 as needed to populate your custom tab with the commands you 
want.
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As you add each command from these categories, Excel displays the button’s 
icon and name in the list beneath New Group (Custom) in the left-to-right 
order in which they’ll appear. To change the order of these command buttons 
in the new group on the custom tab, click the Move Up and/or Move Down 
buttons.

5. Rename the new group by clicking Rename to open the Rename dialog 
box, typing the new name in the Display Name text box, and then 
clicking OK.

6. (Optional) To add another group to the same custom tab, click New 
Group and then repeat Steps 4 and 5 to populate and rename the group.

Repeat Step 6 as often as you like to add additional groups of commands to 
the new custom tab. Use the Move Up and Move Down buttons if you need to 
reposition any groups on the custom tab.

7. Rename the custom tab by clicking New Tab (Custom), clicking Rename 
to open the Rename dialog box, typing the new name in the Display 
Name text box, and then clicking OK.

To add additional custom tabs to the Ribbon, repeat Steps 2 through 7. After 
you finish all your custom tabs to the Ribbon, you’re ready to close the Excel 
Options dialog box and return to the worksheet.

8. Click OK.

When Excel closes this dialog box and returns you to the worksheet, the new 
custom tab appears in the Ribbon at the position where you placed it.

If you use shortcut keys to access Ribbon commands, keep in mind that Excel 
automatically assigns hot-key letters to each of the custom tabs and commands 
you add to the Ribbon. To display the custom tabs’ hot keys, press the Alt key (or 
the / key). To display the hot keys assigned to the commands on a particular cus-
tom tab, type its specific hot-key letter.

If after all your hard work customizing the Ribbon to make it just so, do you now 
have to repeat everything on your other PCs? Nope. In the Customize Ribbon tab 
of the Excel Options dialog box, click Import/Export, click Export All Customiza-
tions, enter the customization filename, then click Save. On your other PC, display 
the Customize Ribbon tab of the Excel Options dialog box, click Import/Export, 
click Import All Customizations, select your saved customization file, and then 
click Open.
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Using Office Add-ins
Excel supports the use of Office Add-ins to help you build your worksheets. Office 
Add-ins are small application programs that run within specific Office programs, 
such as Excel, and increase functionality to promote greater productivity.

There are Office Add-ins to help you learn about Excel’s features, look up words 
in the Merriam-Webster dictionary, and even enter dates into your worksheet by 
clicking them on a calendar. Many of the Office Add-ins for Excel are available 
free of charge, whereas others are offered for a trial period after which you may 
purchase them from the Office Store for a small price.

To use any of these Office Add-ins in Excel, you first need to install them by fol-
lowing these steps:

1. On the Insert tab of the Ribbon, click My Add-ins (you may have to first 
click the Add-ins button).

Excel opens the Office Add-ins dialog box containing the My Add-ins and Store 
buttons, along with thumbnails of all the Office Add-ins already installed and 
ready to insert into the current Excel workbook (see Figure 2-11).

FIGURE 2-11:  
Inserting the 

Excel Mini 
 Calendar and 

Date Picker 
 add-in into an 

Excel worksheet.
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2. To install new Office Add-ins, click the Store button.

Excel connects to the Office Store. Your Office Add-ins dialog box displays a list 
of add-ins for Excel along with a brief description of each add-in’s functionality, 
its current rating by users (one to five stars), and price if it’s not free (these 
usually have Free Trial Available) or May Require Additional Purchase alert if a 
limited version of the add-in is downloadable for free but a more complete and 
robust version requires a purchase. These add-ins are organized by categories 
ranging from All (the default) to Visualization that you can select in a column on 
the left side of the dialog box.

To display more information about a particular add-in of interest, click its 
description. Excel then displays thumbnails of an Excel worksheet using the 
add-in, a more extensive description of its operation, a few sample reviews and 
stats on its current version, when it was first released, and whether or not the 
add-in can make changes to your worksheet and send data over the Internet.

3. (Optional) To restrict the display of Office Add-ins to a particular cate-
gory, such as Visualization, Document Review, or Editor’s Picks, click its 
category in the column on the left side of the Office Add-ins dialog box.

4. When you find an add-in that you may want to install in any one of the 
categories, click its green Add button.

After you click the Add button for a free Office Add-in, Excel closes the Office 
Add-ins dialog box and downloads the add-in in the current worksheet for you 
to use while usually opening a taskbar for the new add-in in the current 
worksheet that enables you to start using it right away.

It also adds the Office Add-in to the list of installed Office Add-ins on the My Add-
ins tab of the Office Add-ins dialog box. After initially installing an add-in, you 
can thereafter insert the Office Add-in you want to use into any open worksheet 
that you’re working on by following these steps:

1. If the Office Add-ins dialog box is not currently open in Excel, open it by 
clicking Insert, then the Add-ins button, if you see one, and then My 
Add-ins.

Excel displays all the Office Add-ins currently installed in Excel in the My 
Add-ins tab of the Office Add-ins dialog box.

2. Click the Office Add-in you want to use in your worksheet to select it and 
then click the Add button or press Enter.

Excel then inserts the Office Add-in into your current worksheet so that you 
can start using its features.
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Many Office Add-ins, such as Merriam-Webster Dictionary and Wikipedia, open in 
task panes docked on the right side of the worksheet window. Others, such as 
Bing Maps and the Mini Calendar, open as graphic objects that float above the 
worksheet.

To close Office Add-ins that open in docked task panes, you click the pane’s Close 
button (X). To close Office Add-ins that open as floating graphic objects, you need 
to select the graphic and then press the Delete key (don’t worry — doing this only 
closes the app without uninstalling it).

Note that after you start using Office Add-ins in Excel, they’re added to the 
Recently Used Add-ins group of the My Add-ins button’s drop-down menu. You 
can then quickly re-open any closed Office add-in that appears on this menu by 
clicking it.

If an Office Add-in you’ve installed doesn’t appear on the My Add-in tab of the 
Office Add-ins dialog box, click the Refresh link to refresh the list. Use the Man-
age My Apps link in this dialog box to keep tabs on all the Office Add-ins you’ve 
installed for Office and SharePoint. If you want to delete an Office Add-in you’re 
no longer using, right-click its icon on the My Add-ins tab and then click Remove 
on its pop-up menu.

Using Excel’s Own Add-ins
Office Add-ins aren’t the only ones that you can use to extend Excel’s features. 
You can also use built-in add-ins created by Microsoft or add-ins that you can 
purchase from third-party vendors. Before you can use any Excel Add-in pro-
gram, the add-in must be installed in the proper folder on your hard drive, and 
then you must click the add-in in the Add-Ins dialog box.

You can immediately use two different types of Excel Add-in programs to extend 
the features in Excel:

 » Excel Add-ins: This group of add-ins (also known as automation add-ins) is 
designed to extend the data analysis capabilities of Excel. These include 
Analysis ToolPak, Euro Currency Tools, and Solver.

 » COM Add-ins: COM (Component Object Model) add-ins are designed to 
extend Excel’s capability to deal with and analyze large amounts of data in 
data models (collections of related database tables). These include Microsoft 
Data Streamer for Excel, Microsoft Power Pivot for Excel, and Microsoft Power 
Map for Excel.
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When you first install Excel, the add-in programs included with Excel are not 
loaded and therefore are not yet ready to use. To load any of these add-in pro-
grams, you follow these steps:

1. Choose File ➪ Excel Options (or press Alt+FTV) to open the Excel Options 
dialog box, and then click the Add-Ins tab.

The Add-Ins tab lists all the names, locations, and types of the add-ins to which 
you have access.

2. (Optional) In the Manage drop-down list, Excel Add-Ins is selected by 
default. If you want to activate one or more of your COM add-ins, click 
COM Add-Ins from the Manage drop-down list.

3. Click the Go button.

If Excel Add-Ins was selected in the Manage drop-down list, Excel opens the 
Add-Ins dialog box (similar to the one shown in Figure 2-12), showing all the 
names of the built-in add-in programs you can load. If COM Add-Ins was 
clicked, the COM Add-Ins dialog box appears instead.

4. Select the check box for each add-in program that you want loaded in the 
Add-Ins or COM Add-Ins dialog box.

Click the name of the add-in in the Add-Ins Available list to display a brief 
description of its function at the bottom of this dialog box.

5. Click OK.

FIGURE 2-12:  
Activating built-in 

Excel Add-ins 
in the Add-Ins 

 dialog box.
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When you first install Excel, all four add-ins (Analysis ToolPak, Analysis Tool-
Pak - VBA, Euro Currency Tools, and Solver Add-In) are available in the Add-Ins 
dialog box. (For more about these add-ins, see the following section, “Manag-
ing Excel Add-ins.”) The tools in the two Analysis ToolPaks are added as special 
functions to the Function Library group and the Euro Currency tools to a Solutions 
group on the Formulas tab. The Solver add-in appears in the Analysis group on 
the Data tab.

Managing the standard Excel Add-ins
Whether you know it or not, you already have a group of Excel Add-in programs 
included when you install Excel:

 » Analysis ToolPak: Adds a Data Analysis command to the Data tab, which 
gives you access to a set of sophisticated statistical analysis tools.

 » Analysis ToolPak - VBA: Enables VBA programmers to publish their own 
financial, statistical, and engineering functions for Excel.

 » Euro Currency Tools: Enables you to format worksheet values as euro 
currency and adds a EUROCONVERT function for converting other currencies 
into euros. To use these tools, click the Euro Conversion or Euro Formatting 
buttons that appear on the Ribbon in the Solutions group at the end of the 
Formulas tab.

 » Solver Add-In: Calculates solutions to what-if scenarios based on cells that 
both adjust and constrain the range of values. (See Book 7, Chapter 1.) To use 
the Solver add-in, click the Solver button that appears on the Ribbon in the 
Analysis group at the end of the Data tab.

Managing Excel COM add-ins
The following COM add-in programs are included when you install Excel:

 » Microsoft Data Streamer for Excel: Enables you to connect Excel to live, 
streaming data from sensor devices.

 » Microsoft Power Map for Excel: Enables you to map geographic data on an 
interactive 3D globe. (See Book 7, Chapter 2.)

 » Microsoft Power Pivot for Excel: Enables you to build complex data models 
using large amounts of data. It also facilitates data queries using DAX (Data 
Analysis Expressions) functions. (See Book 7, Chapter 2.)
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You can readily manage your COM add-ins using the COM Add-Ins button in 
the Add-Ins group on the Developer tab. (To display the Developer tab in Excel, 
choose File ➪ Options ➪ Customize Ribbon [Alt+FTC], select the check box in front 
of Developer in the Main Tabs list box, then click OK.) When you click the COM 
Add-Ins button, Excel opens the COM Add-Ins dialog box that shows all the COM 
add-ins that are installed and activated. Here, you can activate and deactivate 
individual add-ins as needed.

Purchasing third-party add-ins
The add-ins included with Excel are not the only Excel Add-ins that you can lay 
your hands on. Many third-party vendors sell Excel Add-ins that you can often 
purchase online and then immediately download onto your hard drive.

To find third-party vendors and get information on their add-ins, open your web 
browser and search for Excel Add-ins.

Even before you do a web search, you may want to visit the Add-Ins.com website 
at www.add-ins.com.

This online outfit offers a wide variety of useful Excel Add-ins. One example is the 
Spreadsheet Assistant (its most popular Excel Add-in) that adds an Assistants tab 
to your Excel Ribbon with a whole lot of assistant command buttons designed to 
streamline working with Excel worksheets.

Note that you can expect to pay Add-Ins.com between $25 and $50 for add-in 
programs such as these (really reasonably priced if you consider how many hours 
it would take to split up names into separate cells in huge worksheets).

http://www.add-ins.com/
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Building Worksheets

Before you start building a new worksheet in Excel, it helps to have an  
overall design in mind. Fortunately, the design aspect of worksheet- 
building is often the easiest part because you can borrow the design either 

from another workbook you’ve created or from a special workbook file — called a  
template — that provides you with the new worksheet’s structure along with some 
predefined text and data.

After you’ve settled upon the design of your new worksheet, you’re ready to begin 
entering its data. For your data entry chores, you can use several methods. This 
chapter not only covers all the methods for entering data — from the most basic 
to the most sophisticated — but also includes hints on when each method is the 
most appropriate. Note, however, that this chapter doesn’t include information 
on building formulas, which is a major part of creating a new worksheet. Because 
formula-building is so extensive and so crucial to Excel success, I’ve devoted an 
entire book to it: see Book 3.

Chapter 1

IN THIS CHAPTER

 » Creating a workbook from a template

 » Designing a worksheet from scratch

 » Understanding the different types of 
cell entries

 » Knowing the different ways of 
entering data in the worksheet

 » Using Data Validation to restrict the 
data entries in cells

 » Linking your worksheet to other Excel 
workbooks, Office documents, and 
web pages

 » Saving worksheets
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Creating Fresh Workbooks
When you launch Excel (without also opening an existing workbook file), the Start 
screen presents you with two choices for creating a new workbook:

 » Open a new workbook (with the generic filename, Book1), consisting of a 
single, totally blank worksheet (with the generic worksheet name, Sheet1) by 
clicking the Blank Workbook template.

 » Open a new workbook based on the design in one of the other templates 
displayed in the Start screen or available in the New screen (click the More 
Templates link or click the New button in the navigation pane).

If you select the Blank Workbook template, you can start laying out and building 
your new worksheet in the Sheet1 tab. If you select one of the other designed tem-
plates, you can start by customizing the workbook file’s design as well as entering 
the data for your new worksheet.

Take it from a template
Spreadsheet templates are the way to go if you can find one that uses the design 
of the worksheet that you want to build (or is close to it, anyway). There are many 
templates to choose from when you initially launch Excel and then click the New 
option in the navigation pane. (See Figure 1-1.) The templates displayed on the 
New screen run the gamut from budgets and schedules to profit and loss state-
ments, invoices, sales reports, and calendars.

If none of the templates displayed on the New screen fit the bill, you can search for 
templates. This screen contains links to common suggested searches: Business, 
Personal, Planners and Trackers, Lists, Budgets, Charts, and Calendar. When you 
click one of these links, the New screen displays your choices in that particular 
category.

If the type of template you’re looking for doesn’t fit any of the categories listed in 
the Suggested Searches, you can run your own template search. Click the Search 
for Online Templates text box, type one or more keywords describing the type 
of template (such as finance), and then press Enter or click the Start Searching 
button (the magnifying glass icon). Excel displays the search results as shown in 
Figure 1-2, which displays the templates that Excel uncovers based on a search 
for finance.
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FIGURE 1-1:  
The New screen is 

home to a  fistful 
of templates you 

can use to get 
a head start on 
building a new 

workbook.

FIGURE 1-2:  
Searching for 

finance-related 
templates.
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Instead of using ready-made templates, you can create your own templates from 
your favorite Excel workbooks. After you save a copy of a workbook as a template 
file, Excel automatically generates a copy of the workbook whenever you open the 
template file. This way, you can safely customize the contents of the new work-
book without any danger of inadvertently modifying the original template.

Downloading the template to use
When you locate a template with a design that you can adapt to your worksheet 
needs, you can download the template. Click the template’s thumbnail on the New 
screen. Excel then opens a dialog box similar to the one shown in Figure 1-3, con-
taining a more extensive description of the template and its download file size. To 
download the template and create a new Excel workbook from it, click the Create 
button. Excel creates the new workbook and gives it the same name as the tem-
plate, but with a “1” tacked on to the end (for example, Family Budget Planner1).

If you return to the New screen (by choosing File ➪ New or by pressing Alt+FN, 
you see the template you downloaded, as shown in Figure 1-4. You can click the 
downloaded template to create another new workbook based on that file (which 
will have a “2” tacked on to the filename).

To customize a worksheet generated from one of the installed templates, you 
replace the placeholder entries in the new worksheet with your own data. For 
strategies on entering your labels and values into the cells of a worksheet, see 
“Getting to Know Excel’s Data Types” later in this chapter.

FIGURE 1-3:  
When you click 

a template 
thumbnail, Excel 

displays more 
details about the 

template.
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Note that when filling in or replacing the data in a worksheet generated from one 
of these ready-made templates, you have access to all the cells in the worksheet: 
those that contain standard headings as well as those that require personalized 
data entry.

After you finish filling in the personalized data, save the workbook just as you 
would a workbook that you had created from scratch. (See the “Saving the Data” 
section at the end of this chapter for details on saving workbook files.)

Saving changes to your customized templates
You can save the customization you do to the templates you download to make the 
workbooks you create from them easier to use and quicker to fill out. To save your 
changes as a new template file, follow these steps:

1. Choose File ➪ Save As, or press Alt+FA.

The Save As screen opens where you select the location where the customized 
template file is to be saved.

2. Select This PC.

Excel selects the Documents folder, which is the place you want to be.

If you really want to store your personal templates elsewhere (say, on your 
OneDrive), you’re free to do so. Just note that you’ll have to jump through a few 
extra hoops to tell Excel where you store your custom templates. I show you 
how to navigate those hoops right after these steps. For now, just remember 
the location you select because you’ll need it later.

3. Use the Enter File Name Here text box to type the filename you want 
to use.

FIGURE 1-4:  
The downloaded 

template now 
appears in the 

New screen.
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4. In the Save as Type list (which appears just below the Enter File Name 
Here text box), select Excel Template (*.xltx).

If you need your new template file to be compatible with earlier versions of 
Excel (versions 97 through 2003), click Excel 97–2003 Template (*.xlt) rather 
than Excel Template (*.xltx). When you do this, Excel saves the new template 
file in the older binary file format (rather than the newer XML file format) with 
the old .xlt filename extension instead of the newer .xltx filename exten-
sion. If your template contains macros that you want the user to be able to run 
when creating the worksheet, click Excel Macro-Enabled Template (*.xltm).

If you’re using the default Documents folder as the save location, Excel changes 
the selected folder to a subfolder of Documents named Custom Office 
Templates as soon as you change the file type from Excel Workbook to Excel 
Template.

5. Click Save.

Excel saves your custom template in the location you selected.

After the Save As dialog box closes, you still need to close the customized 
workbook file in the Excel work area.

6. Choose File ➪ Close, or press either Alt+FC or Ctrl+W to close the custom-
ized workbook file.

If you saved your customized template file in any folder other than the one cur-
rently listed as the Default Personal Template Location in the Excel Options dia-
log box, you need to tell Excel about this folder and where it is by following these 
steps:

1. Choose File ➪ Options ➪ Save (Alt+FTS).

Excel opens the Excel Options dialog box and selects the Save tab.

2. Click the Default Personal Templates Location text box and enter the 
complete filename path for the folder where you saved your initial 
personal template file.

For example, if I created a Templates subfolder within the Documents folder 
on my personal OneDrive to store all my personal Excel template files, I’d enter 
the following pathname in the Default Personal Templates Location text box:

C:\Users\Paul\OneDrive\Documents\Templates

3. Click OK to put the new setting into effect.
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After designating the location of your personal templates folder as described in 
the preceding steps, the next time you open the New screen (choose File ➪ New), 
you see two new headings below the Blank Workbook template (and above the 
Search box):

 » Office: Click this heading to view and search for Office Excel templates.

 » Personal: Click this heading to view your custom templates.

To generate a new workbook from one of your custom templates, click the Per-
sonal heading to display thumbnails for all the templates you’ve saved in the des-
ignated personal templates folder. To open a new Excel workbook from one of 
your custom templates, click the template’s thumbnail.

Creating your own workbook templates
You certainly don’t have to rely on workbook templates created by other people. 
Indeed, often you can’t do this because, even though other people may generate 
the type of template that you need, their design doesn’t incorporate and represent 
the data in the manner that you prefer or that your company or clients require.

When you can’t find a ready-made template that fits the bill or that you can eas-
ily customize to suit your needs, create your own templates from workbooks that 
you’ve created or that your company has on hand. The easiest way to create your 
own template is to first create an actual workbook prototype, complete with all the 
worksheets, text, data, formulas, graphics, and macros that it requires to function.

When readying the prototype workbook, make sure that you remove all headings, 
miscellaneous text, and numbers that are specific to the prototype and not generic 
enough to appear in the new template. You may also want to protect all generic 
data, including the formulas that calculate the values that you or your users input 
into the worksheets generated from the template and headings that never require 
editing. (See Book 4, Chapter 1 for information on how to protect certain parts of 
a worksheet from changes.)

After making sure that both the layout and content of the boilerplate data are 
hunky-dory, use the Save As command to save the workbook in the Excel Tem-
plate (.xltx) file format in your personal templates folder so that you can then 
generate new workbooks from it. (For details on how to save a workbook as a 
template, refer to the steps in the previous section, “Saving changes to your cus-
tomized templates.”)
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As you may have noticed when looking through the sample templates included 
in Excel (refer to Figure  1-4, for example) or browsing through the templates 
that you can download from the Microsoft Office.com website found at http://
office.microsoft.com, many worksheet templates hide the familiar worksheet 
grid of cells, preferring a look very close to that of a paper form instead. When 
converting a sample workbook into a template, you can also hide the grid, use cell 
borders to underscore or outline key groups of cells, and color different cell groups 
to make them stand out. (For information on how to do this kind of stuff, refer to 
Book 2, Chapter 2.)

You can add inline notes to parts of the template that instruct coworkers on how 
to properly fill in and save the data. These notes are helpful if your coworkers are 
unfamiliar with the template and may be less skilled in using Excel. (See Book 4, 
Chapter 3 for details about adding notes to worksheets.)

Designing a workbook from scratch
Not all worksheets come from templates. Often, you need to create unique work-
sheets that aren’t intended to function as standard models from which certain 
types of workbooks are generated. In fact, most of the worksheets that you create 
in Excel may be of this kind, especially if your business doesn’t rely on the use of 
highly standardized financial statements and forms.

Planning your workbook
When creating a new workbook from scratch, you need to start by considering the 
layout and design of the data. When doing this mental planning, you may want to 
ask yourself some of the following questions:

 » How many worksheets do you need to handle the different components or 
aspects of the model you want to build?

 » Does the layout of the worksheet require the use of data tables (with both 
column and row headings) or tables (with column headings only)?

 » Do these data tables and tables need to be laid out on a single worksheet, or 
can they be placed in the same relative position on multiple worksheets of the 
workbook (like pages of a book)?

 » Do the data tables in the workbook use the same type of formulas?

 » Do some of the columns in the workbook tables get their input from formula 
calculations, or do they get their input from other tables (called lookup tables) 
in the workbook?

http://office.microsoft.com
http://office.microsoft.com
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 » Will any of the data in the workbook be graphed, and will these charts appear 
in the same worksheet (referred to as embedded charts), or will they appear on 
separate worksheets in the workbook (called chart sheets)?

 » Does any of the data in the workbook come from worksheets in separate 
workbook files?

 » How often will the data in the workbook be updated or added to?

 » How much data will the workbook ultimately hold?

 » Will the data in the workbook be shared primarily in printed or online form?

All these questions are an attempt to get you to consider the basic purpose and 
function of the new workbook before you start building it, so that you can come 
up with a design that is both economical and fully functional.

Planning for economy
Economy is an important consideration because when you open a workbook, all 
its data is loaded into your computer’s memory. This may not pose any problems 
if you’re running Excel on one of the latest generation of PCs with more memory 
than you can conceive of using at one time. However, memory usage can pose 
quite a problem if you’re running Excel on a small Windows tablet with a mini-
mum of memory or on a smartphone with limited resources. Similarly, you may 
share the workbook file with someone whose device is not so well equipped as 
yours. Also, depending on just how much data you cram into the workbook, you 
may even come to see Excel creep and crawl the more you work with it.

To help guard against these problems, make sure that you don’t pad the data 
tables and lists in your workbook with extra empty “spacer” cells. Keep the tables 
as close together as possible on the same worksheet (with no more than a single 
blank column or row as a separator, which you can adjust to make as wide or high 
as you like) or — if the design allows — keep them in the same region of consec-
utive worksheets.

Planning for functionality
Along with economy, you should pay attention to the functionality of the work-
sheet. This means that you need to allow for future growth when selecting the 
placement of its data tables, tables, and charts. This is especially important in 
the case of tables because they have a tendency to grow longer and longer as you 
continue to add data, requiring more and more rows of the same few columns in 
the worksheet. This means that you should usually consider all the rows of the 
columns used in a table as “off limits.” In fact, always position charts and other 
supporting tables to the right of the list rather than somewhere below the last 
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used row. This way, you can continue to add data to your list without ever having 
to stop and first move some unrelated element out of the way.

This spatial concern is not the same when placing a data table that will total the 
values both down the rows and across the columns table — for example, a sales 
table that sums your monthly sales by item with formulas that calculate monthly 
totals in the last row of the table and formulas that calculate item totals in the last 
column. In this table, you don’t worry about having to move other elements, such 
as embedded charts or other supporting or unrelated data tables, because you use 
Excel’s capability of expanding the rows and columns of the table from within. 
As the table expands or contracts, surrounding elements move in relation to and 
with the table expansion and contraction. You do this kind of editing to the table 
because inserting new table rows and columns ahead of the formulas ensures that 
they can be included in the totaling calculations. In this way, the row and column 
of formulas in the data table act as a boundary that floats with the expansion or 
contraction of its data but that keeps all other elements at bay.

Opening new blank workbooks
Although you can open a new workbook when you first start Excel, you’ll often need 
to open a blank workbook after you’ve started working with Excel. The easiest way 
to open a blank workbook is to press Ctrl+N. Excel responds by opening a new work-
book, which is given a generic Book name with the next unused number (Book2, if 
you opened Excel with a blank Book1). You can also do the same thing in Backstage 
view by clicking File ➪ New and then selecting the Blank Workbook thumbnail.

As soon as you open a blank workbook, Excel makes its document window active. 
To then return to another workbook that you have open (which you would do if 
you wanted to copy and paste some of its data into one of the blank worksheets), 
move the mouse pointer over the Excel button on the Windows taskbar and then 
click the workbook thumbnail or press Alt+Tab until its file icon is selected in the 
dialog box that appears in the middle of the screen.

If you ever open a blank workbook by mistake, you can just close it right away by 
pressing Ctrl+W, choosing File ➪ Close, or pressing Alt+FC. Excel then closes its 
document window and automatically returns you to the workbook window that 
was originally open at the time you mistakenly opened the blank workbook.

Getting to Know Excel’s Data Types
Before covering the many methods for getting data into the cells of your new 
worksheet, you need to understand which types of data you can enter. To Excel, 
everything that you enter in any worksheet cell is either one of two types of data: 
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text (also known as a label) or a number (also known as a value or numeric entry). 
(When you enter a formula, as I describe in Book 3, the result that appears in the 
cell is either text or a number.)

The reason that you should care about what type of data you enter into your work-
sheet cells is that Excel treats your entry differently, depending on what type of 
data it thinks you’ve entered.

 » Text entries are automatically left-aligned in their cells, and if they consist of 
more characters than fit within the column’s current width, the extra charac-
ters spill over and are displayed in blank cells in columns on the right. (If these 
cells are not blank, Excel cuts off the display of any characters that don’t fit 
within the cell borders until you widen its column.)

 » Numbers are automatically right-aligned in their cells, and if they consist of 
more characters (including numbers and any formatting characters that you 
add) than fit within the column’s current width, Excel displays a string of 
number signs across the cell (######), telling you to widen the column. (In 
some cases, such as decimal numbers, Excel truncates the decimal places 
shown in the cell instead of displaying the number-sign overflow indicators.)

So, now you need to know how Excel differentiates between text and numbers.

What’s in a label?
Here’s the deal with text entries:

 » Excel treats all data entries beginning with a letter or a punctuation 
mark as text.

 » Excel treats all data entries that mix letters (A–Z) and numbers as text, even 
when the entry begins with a number.

 » Excel treats all data entries that mix numbers with punctuation other than 
commas (,), periods (.), and forward slashes (/) as text, even when they begin 
with a number.

So, in addition to letter-only entries, such as First Quarter Earnings and John Smith, 
many mixed data entries, including C123, 666-45-0034, and 123C, are also consid-
ered text entries.

However, a problem exists with numbers that are separated by dashes (-): If the 
numbers separated by dashes correspond to a valid date, Excel converts the entry 
into a date (which, believe it or not, is a type of numeric entry — see the “Dates 
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and times” section in this chapter for details). For example, if you enter 1-6-22 
in a cell, Excel thinks that you want to enter the date January 6, 2022, in the cell, 
and the program automatically converts the entry into a date number (displayed 
as 1/6/2022 in the cell).

If you want to enter a number as text in a cell, you can either format the cell as 
Text (see Book 2, Chapter 2) or preface its first digit with an apostrophe (’). For 
example, if you’re entering a part number that consists of all numbers, such as 
12-30-22, and you don’t want Excel to convert it into the date December 30, 2022, 
you need to begin the entry with an apostrophe, like so:

'12-30-19

Likewise, if you want to enter 3/4 in a cell, meaning three out of four rather than 
the date March 4, you enter

'3/4

(Note that if you want to designate the fraction, three-fourths, you need to input 
=3/4, in which case Excel displays the value 0.75 in the cell display.)

When you complete an entry with an initial apostrophe that Excel would normally 
consider a value, such as the 12-30-22 date example, the apostrophe is not dis-
played in the cell. (The apostrophe does appear in the Formula bar and when you 
open the cell for editing.)

Suppose you enter a numeric value, preceded by an apostrophe, like so:

'12345

In this case, a tiny green triangle — the Excel error indicator — appears in the 
upper-left corner of the cell, and an alert symbol appears to the immediate left (as 
long as the active cell is in this cell). When you click this alert indicator, a menu 
similar to the one shown in Figure 1-5 appears. The “error” that Excel is alerting 
you to appears on the first line of the menu: Number Stored as Text, in this exam-
ple. You can click the Convert command (Convert to Number, in this example) to 
convert the entry to a true number (by removing the apostrophe).

If you start a cell entry with the equal sign (=) followed by other characters that 
aren’t part of a formula, Excel displays an error dialog box as soon as you try to 
complete the data entry. Excel uses the equal sign to indicate the use of a formula, 
and what you have entered is not a valid formula. The program knows that Lotus 
1-2-3 used the @ symbol to indicate the use of a built-in function, and what you 
have entered is not a valid built-in function. This means that you must preface 
any data entry beginning with the equal sign and @ symbol that isn’t a valid for-
mula with an apostrophe to get it into the cell.
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What’s the value?
Spreadsheets were developed to deal with financial records and calculations, 
which included plenty of extended item totals, subtotals, averages, percent-
ages, and grand totals. This numeric focus is still true today, and in a typical  
worksheet, the numeric data entries often outnumber (pun very much intended) 
the text entries. Of course, you can create worksheets that are full of numbers 
that have nothing to do with debits, credits, income statements, invoices, quar-
terly sales, and dollars and cents. (And your Excel work will also certainly include 
worksheets where there are far more text entries than numeric entries, especially 
when you get into storing data in tables, as described in Book 6.)

Number entries that you make in your worksheet can be divided into three 
categories:

 » Numbers that you input directly into a cell. (You can do this with the 
keyboard, your voice if you use the Speech Recognition feature, or even by 
handwriting if your PC is equipped with a writing tablet.)

 » Date and time numbers that are also input directly into a cell but are 
automatically displayed with the default Date and Time number formats and 
are stored behind the scenes as special date serial and hour decimal 
numbers.

 » Numbers calculated by formulas that you build yourself by using simple 
arithmetical operators and/or Excel’s sophisticated built-in functions.

FIGURE 1-5:  
Click the alert 

indicator to 
open the menu 
attached to the 
Number Stored 

as Text alert.
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Inputting numbers
Numbers that you input directly into the cells of the worksheet can be positive or 
negative, integers, percentages, or decimal values. Numbers can represent a wide 
variety of values, including dollars and cents, widgets in stock, workers in the 
Human Resources department, or potential clients.

When inputting numbers, you can mix the digits 0–9 with the following characters:

– () + $ . , %

You use these characters in the numbers you input as follows:

 » Preface the digits of the number with – or enclose them in a pair of parenthe-
ses to indicate that the number is a negative number, as in –53 or (53).

 » Preface the digits of the number with a plus sign (+) when you want to 
explicitly designate the number as positive, as in +(53) to convert negative 53 
into positive 53. Excel considers all numbers to be positive unless you 
designate them as negative.

 » Preface the digits of the number with a dollar sign ($), as in $500, to format 
the cell with the Currency style format as you enter the number. (You can also 
apply this format before or after you enter the number.)

 » Input a period (.) in the digits of the number to indicate the position of the 
decimal point in the number, as in 500.25. (Note that you don’t have to bother 
entering trailing zeros after the decimal point because the General number 
format automatically drops them, even if you type them.)

 » Input commas (,) between the digits of a number to indicate the position of 
thousands, hundred thousands, millions, billions, and the like, and to assign 
the Comma style number format to the cell, as in 642,153. (You can also have 
Excel add the commas by assigning the Comma format to the cell before or 
after you input the number.)

 » Append the percent sign (%) to the digits of a number to convert the number 
into a percentage and assign the Percent number style to the cell, as in 12%.

The most important thing to remember about a number that you input is that how 
it appears depends on the type of number formatting currently assigned to the cell 
in which the number is entered. When you first open a blank workbook, the num-
ber format appropriately called General (which some have called the equivalent 
of no number formatting because it doesn’t add any special format characters, 
such as a constant number of decimal places or thousands separators) is applied 
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to each cell of the worksheet. You can override the General format by adding your 
own formatting characters as you input the number in a cell or, before or after 
you input the number, by selecting the cell and then assigning a different number 
format to it. (See Book 2, Chapter 2 for details.)

Dates and times
Excel stores dates and times that you input into a worksheet as special values. 
Dates are stored as serial numbers, and times are stored as decimal fractions. 
Excel supports two date systems: the 1900 date system used by Excel for Windows 
(also used by Lotus 1-2-3), which uses January 1, 1900, as serial number 1, and 
the 1904 system used by Excel for the Macintosh, which uses January 2, 1904, as 
serial number 1.

If you use Excel on a Windows PC or a Mac in your office, you can switch from the 
default 1900 date system to the 1904 date system for those worksheets that you 
create in the Windows version and then transfer to the Mac. To switch to the 1904 
date system, click the Advanced tab of the Excel Options dialog box (File ➪ Excel 
Options or Alt+FT) and then select the Use 1904 Date System check box in the 
When Calculating This Workbook section.

By storing dates as serial numbers representing the number of days that have 
elapsed from first system date (January 1, 1900, or January 2, 1904), Excel can per-
form arithmetic with dates. For example, you can find out how many days there 
are between February 15, 1949, and February 15, 2022, by entering 2/15/2022 in 
one cell and 2/15/1949 in the cell below, and then creating a formula in the cell 
below that one that subtracts the cell with 2/15/1949 from the one containing 
2/15/2022. Because Excel stores the date 2/15/2022 as the serial number 44607 
and the date 2/15/1949 as the serial number 17944, it can calculate the difference 
and return the result of 26663 (days, which is equal to 73 years).

When you type a date directly into a formula that performs date arithmetic (as 
opposed to constructing a formula using references to cells that contain date 
entries), you must enclose the date in quotation marks. So, for example, if you type 
the dates in a formula that calculates the number of days between February 15, 
1949, and February 15, 2022, in the cell you have to type the following formula:

="2/15/2022"–"2/15/1949"

Times of the day are stored as decimal numbers that represent the fraction of the 
24-hour period starting with 0.0 for 12:00 midnight through 0.999 for 11:59:59 
p.m. By storing times as decimal fractions, Excel enables you to perform time 
calculations such as those that return the elapsed time (in minutes) between any 
two times of the day.
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Inputting dates and times using  
recognized formats
Although Excel stores dates as serial numbers and times as decimal fractions, 
luckily you don’t have to use these numbers to enter dates or times of the day 
into cells of the worksheet. You enter dates by using any of the recognized Date 
number formats that are used by Excel, and you enter times by using any of the 
recognized Time number formats. Excel then assigns and stores the appropriate 
serial number or decimal fraction at the same time the program assigns the date 
or time format that you used for this value. Table 1-1 shows you typical date and 
time entries that you can use as examples when entering dates and times in the 
cells of a worksheet.

Understanding how Excel treats two-digit years
The only thing that’s a tad bit tricky about inputting dates in a worksheet comes 
in knowing when you have to input all four digits of the year and when you can get 
away with entering only two. As Table 1-1 shows, if you input the date 1/6/22 in 
a cell, Excel recognizes the date as 1/6/2022 and not as 1/6/1922. In fact, if you 
enter the date January 6, 1922, in a worksheet, you must enter all four digits of 
the year (1922).

TABLE 1-1 Common Ways to Enter Dates and Times
What You Enter in the Cell Date or Time Recognized by Excel (As 

Displayed on the Formula Bar)

1/6/2022 January 6, 2022

1/6/22 January 6, 2022

1-6-2022 January 6, 2022

6-Jan-2022 January 6, 2022

6-Jan January 6, 2022 (assuming the current year is 2022)

Jan-16 January 2022 (assuming the current year is 2022)

1/6/2022 5:25 1/6/2022 5:25 a.m.

5:25 5:25:00 AM

5:25 P 5:25:00 PM

17:25 5:25:00 PM

17:25:33 5:25:33 PM
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Here’s how Excel decides whether a year for which you enter only the last two 
digits belongs to the 20th or 21st century:

 » 00 through 29 belong to the 21st century, so Excel interprets 7/30/29 as July 30, 2029.

 » 30 through 99 belong to the 20th century, so Excel interprets 7/30/30 as July 
30, 1930.

This means that you don’t have to enter the four digits of the year for dates in the 
years 2000 through 2029, or for dates in the years 1930 through 1999.

If you can’t remember these cutoffs and are just generally confused about when 
to enter two digits versus four digits, just go ahead and enter all four digits of the 
year. Excel never misunderstands which century the date belongs to when you 
spell out all four digits of the year.

Numeric formulas
Many numeric entries in a typical worksheet are not input directly but are returned 
as the result of a calculation by a formula. The numeric formulas that you build can 
do anything from simple arithmetic calculations to complex statistical analyses. (See 
Book 3 for complete coverage of all types of numeric formulas.) Most worksheet for-
mulas use numbers that are input into other cells of the worksheet in their calcula-
tions. Because these formulas refer to the address of the cell containing the input 
number rather than the number itself, Excel can automatically recalculate the for-
mula and return a new result whenever you change the values in the original cell.

The most important thing to remember about numeric formulas is that a cell that 
contains a formula displays the formula’s result (its calculated value). If you make the 
cell active, the formula’s contents (which indicate how the calculation is performed) 
are displayed on the Formula bar. A number returned by a formula is displayed using 
the nondescript General number format. To get this calculated number to appear the 
way you want in the worksheet, select the cell that contains the formula and apply a 
more appropriate number format to the cell. (See Book 2, Chapter 2 for details.)

Data Entry 101
I want to pass on a few basic rules of data entry:

 » You must first select the cell where you want to make the data entry.

 » Any entry that you make in a cell that already contains data replaces the 
existing entry.
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 » Every data entry that you make in a cell must be completed with some sort of 
action, such as clicking the Enter button on the Formula bar (pointed out in 
Figure 1-6; note that this button is only enabled when you’re entering data); 
pressing the Enter key, the Tab key, or one of the arrow keys; or clicking a 
different cell.

The first rule sounds so obvious that it should go without saying, but you’d be 
surprised how many times you look at the cell where you intend to add new data 
and then just start entering that data without realizing that you haven’t yet moved 
the active cell to that cell. As a result, the data entry that you’re making is not des-
tined to go into the cell that you intended. In fact, you’re in the process of making 
the entry in whatever cell currently contains the active cell, and if that cell already 
contains data, you’re in the process of replacing its entry with the one you meant 
to go somewhere else!

This is why the third rule is so important: Even if you’re in the process of messing 
up your worksheet by entering data in the wrong cell (and, if that cell has data, by 
also destroying a perfectly good entry), you haven’t messed anything up until you 
complete the entry (by, for example, pressing Enter). That reprieve means you can 
avoid the data entry error by clicking the Cancel button on the Formula bar (see 
Figure 1-6) or by pressing Escape. The erroneous data entry then disappears from 
the Formula bar (and the original data entry — if it exists — remains intact), and 
you’re then free to move the active cell to the desired cell and redo the entry there.

Data entry keyboard style
The only trick to entering data from the keyboard is to figure out the most efficient 
way to complete the entry in the active cell (and Excel gives you many choices in 
this regard).

FIGURE 1-6:  
One way to 
 complete a 

cell entry is to 
click the Enter 
button in the 
Formula bar.
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One possibility is to complete any data entry by pressing the Enter key. Pressing 
Enter not only completes the entry in the cell, but also moves the active cell down 
to the cell in the next row. Pressing the Enter key is the efficient choice when 
you’re entering data in a single column because it means that Excel automatically 
selects the cell in the next row for you. Sweet!

Another way to move the active cell down is to complete the cell entry by pressing 
the ↓ key. Note, however, that this only works for new entries, not when you’re 
editing an existing entry.

A third possibility is to press the → key. Pressing → both completes the entry and 
moves the active cell to the next cell to the right. (Again, this only works for new 
entries.) Pressing → is the efficient option when you want to enter the data in a 
single row because it means that Excel automatically selects the cell in the next 
column for you. Thanks! (To be nerdily complete here, note that you can achieve 
the same effect by pressing the Tab key.)

Take a look at Table 1-2 to get an idea of the keys that you commonly use to com-
plete data entries. Keep in mind, however, that any key combination that moves 
the active cell (see Table 1-1 in Book 1, Chapter 1, for a review of these keystrokes) 
also completes the data entry that you’re making, as does clicking another cell in 
the worksheet.

What if you want to complete the data entry and stay in the same cell? Alas, you 
can’t do that from the keyboard. Instead, you need to click the Enter button on the 
Formula bar (presumably this is what Microsoft intended; otherwise, why have 
the button?). Clicking Enter leaves the active cell on the cell in which you entered 
the data. Clicking Enter is the efficient move when you want to keep working on 

TABLE 1-2 Keys Used in Completing Data Entry
Press To Have the Cell Pointer Move

Enter Down one row

↓ Down one row

→ Right one column

Tab Right one column

Shift+Tab Left one column

← Left one column

Shift+Enter Up one row

↑ Up one row
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the same cell, say, by applying some text or numeric formatting. However, click-
ing Enter is not at all efficient when the mouse pointer isn’t close to it or when 
you prefer to move the active cell to a different cell for your next entry.

If you have more than one cell selected (see Book 2, Chapter 2 for more on this) 
and then press Ctrl+Enter to complete the data entry that you’re making in the 
active cell of this selected range, Excel simultaneously enters that data entry into 
all the cells in the selection. You can use this technique to enter a single label, 
value, or formula in many places in a worksheet at one time.

If you have more than one worksheet selected (see Book 2, Chapter 4) at the time 
that you make an entry in the active cell, Excel makes that entry in the correspond-
ing cells of all the selected worksheets. For example, if you enter the heading Wild 
Budget Guesses in cell C3 of Sheet1 when Sheet1 through Sheet3 are selected, Excel 
enters Wild Budget Guesses in cell C3 of Sheet2 and Sheet3 as well.

Doing data entry with the Touch keyboard
If you’re running Excel on a touchscreen device that lacks a physical keyboard, 
you need to open the Windows Touch keyboard and use it to input your worksheet 
data. To open the Touch keyboard, tap the Touch Keyboard button on the right 
side of the Windows taskbar (see Figure 1-7; this is the Windows 10 touch key-
board; the Windows 11 version is slightly different). Windows displays the stan-
dard Touch keyboard docked at the bottom of the Excel program window.

To undock the standard Touch keyboard beneath the Excel program window or 
select one of the other styles of Touch keyboard, tap the Keyboard Settings but-
ton (see Figure 1-7) and then tap the Float Keyboard button (also pointed out in 
Figure 1-7). Figure 1-7 shows you how your touchscreen looks after undocking 
the Windows standard Touch keyboard and dragging it up away from the Excel 
Status bar.

As shown in this figure, when undocked, the Windows standard Touch keyboard 
remains completely separate from the Excel program window so that you can 
reposition it to access most of the cells in the current worksheet when doing your 
data entry. The standard Touch keyboard is limited mostly to letter keys above a 
spacebar with a few punctuation symbols (apostrophe, comma, period, and ques-
tion mark). This standard keyboard also sports the following special keys:

 » Backspace (pointed out in Figure 1-7): Deletes the character to the immediate 
left of the insertion point cursor when entering or editing a cell entry. When a 
cell is selected (but you’re not entering or editing data in that cell), tapping 
Backspace deletes the entire cell entry.
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 » Enter (see Figure 1-7): Completes an entry in the active cell and moves the 
cursor down one row in the same column.

 » Shift (see Figure 1-7): Toggles the letter keys between uppercase and 
lowercase.

 » Numeric (&123): Displays the numeric keypad, the Tab key, and several 
punctuation keys. (Tap the &123 key again to return to the standard QWERTY 
letter arrangement.)

 » Ctrl: Enables you to enter Excel keyboard shortcuts that include Ctrl, such as 
Ctrl+C (copy), Ctrl+V (paste), and Ctrl+S (save). Tap Ctrl and then tap the other 
key in the key combo you want to perform.

 » Emoticons: Displays a bunch of emoticons that you can enter into a cell entry. 
Tap the ABC key to return to the standard QWERTY keyboard.

 » Left (<): Moves the active cell one cell to the left and completes any cell entry 
in progress.

 » Right (>): Moves the active cell one cell to the right and completes any cell 
entry in progress.

FIGURE 1-7:  
A Windows 

touchscreen 
after displaying 
and undocking 

the standard 
Touch keyboard 
so it floats in the 

middle of the 
Excel program 

window.



98      BOOK 2  Worksheet Design

Windows also supports a much smaller version (called a mobile Touch keyboard) 
of the standard Touch keyboard. This is ideal when running Excel on a smaller 
tablet. To switch from the standard to the mobile Touch keyboard, tap the Key-
board Settings button followed by the Mobile Keyboard button (see Figure 1-7).

If you want to have access to a fully functional Touch keyboard when working in 
Excel, you need to switch to the expanded Touch keyboard by tapping the Key-
board Settings button followed by the Expanded Keyboard button (pointed out in 
Figure 1-7). The expanded version of the Windows Touch keyboard includes these 
special keys in addition all to those listed earlier for the standard Touch keyboard:

 » Esc: Abandons incorrect cell entries and closes dialog boxes without making 
any changes.

 » Tab: Moves the active cell one cell to the right like the → key.

 » Caps: Turns on Caps Lock, which changes all the letter keys to uppercase and 
leaves them in that state so that you can make a cell entry that requires an 
extended run of uppercase letters. When you’re done, tap Caps again to 
return the letter keys to lowercase.

 » Del: Deletes the character to the immediate right of the insertion point cursor 
when entering or editing a cell entry. When a cell is selected (but you’re not 
entering or editing data in that cell), tapping Delete clears the entire cell entry.

 » Windows: Opens the Windows Start screen.

 » Fn: Replaces the top row of numbers, as well as the minus and equals keys, 
with the function keys F1 through F12.

 » Alt: Enables you to enter Excel keyboard shortcuts that include Alt, such as 
Alt+FT (Excel Options) and Alt+HX (cut). Tap Alt and then tap each of the other 
keys in the key combination.

 » Up: Moves the active cell one row up in the current column.

 » Down: Moves the active cell one row down in the current column.

Windows supports a split-keyboard arrangement of the Touch keyboard that enables 
you to see more of the cells in your worksheet as you enter your text and numbers 
in the worksheet from the separated banks of keys on the left and right side of the 
worksheet area. To switch to this arrangement, tap the Keyboard Settings button 
followed by the Split Keyboard button (see Figure 1-7). Excel then displays the split 
keyboard with the QWERTY letter keys separated into a left and right bank.

You can also switch to an Inking keyboard (pointed out in Figure 1-7) where you 
can make cell entries by writing your entries in the keyboard area with your fin-
ger, stylus, or digital pen and then inserting them into the worksheet by tapping 
its Insert button.
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If you’ve enabled Windows speech services on your device, you can just dictate 
your entry for the active cell in your worksheet. You do this by tapping the Micro-
phone button (to the immediate right of the Keyboard Settings button in what-
ever style of touch keyboard you’re using) and then dictate the text or value you 
wanted entered when the Listening prompt appears. Excel then enters what you 
dictated into the current worksheet cell when you pause and promptly turns the 
microphone off.

When you finish entering your worksheet data with your Windows Touch key-
board, you can close it and return to the normal full screen view of the Excel pro-
gram window by tapping the Close button (X).

You AutoComplete me
Excel automatically makes use of a feature called AutoComplete, which attempts 
to automatically complete textual data entries (that is, entries that don’t mix text 
and numbers). AutoComplete works this way: If you start a new text entry that 
begins with the same letter or letters as an entry that you’ve made recently in the 
same region of the worksheet, Excel completes the new text entry with the char-
acters from the previous text entry that began with those letters.

For example, if you type the worksheet title Sales Invoice in cell A1 of a new work-
sheet and then, after completing the entry by pressing Enter, start entering the 
table title Summary in cell A2, as soon as you type S in cell A2, Excel completes the 
new text entry so that it also states Sales Invoice by adding the letters ales Invoice.

When the AutoComplete feature completes the new text entry, the letters that it 
adds to the initial letter or letters that you type are automatically selected (indi-
cated by highlighting). This way, if you don’t want to repeat the original text entry 
in the new cell, you can replace the characters that Excel adds just by typing the 
next letter in the new (and different) entry. In the previous example, in which 
Sales Invoice was repeated in the cell where you want to input Summary, the ales 
Invoice text appended to the S that you type disappears the moment you type u in 
Summary.

Note that when you have two different entries that begin with the same first let-
ter but have different second letters, typing the second letter of one entry causes 
Excel to complete the typing of that entry, leaving you free to insert its text in the 
cell by pressing the Enter key or using any of the other methods for completing 
a cell entry.

To make use of automatic text completion rather than override it as in the previ-
ous example, complete the cell entry in your preferred way (that is, by pressing 
a key — such as Enter, Tab, or an arrow —), clicking the Enter button on the 
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Formula bar, or clicking another cell). For example, say you’re building a sales 
table in which you’re inputting sales for three different account representatives — 
George, Jean, and Alice. After entering each name manually in the appropriate row 
of the Account Representative column, you need to type in only their first initial  
(G to get George, J to get Jean, and A to get Alice) in subsequent cells and then 
press the ↓ or Enter key to move down to the next row of that column. In a case 
like this, AutoComplete is more like automatic typing, and it makes filling in the 
Account Representative names for this table extremely quick and easy.

If the AutoComplete feature starts to bug you when building a particular worksheet, 
you can temporarily turn it off. Open the Excel Options dialog box (File ➪ Options 
or Alt+FTA); click the Advanced tab, and then deselect the Enable AutoComplete 
for Cell Values check box in the Editing Options section. Note that disabling Auto-
Complete in this manner also disables the Flash Fill feature as well. (See “Flash 
Fill to the rescue” later in this chapter for details.)

You AutoCorrect me
Along with AutoComplete, Excel has an AutoCorrect feature that automatically 
fixes certain typos that you make in the text entries as soon as you complete them. 
For example, if you forget to capitalize a day of the week, AutoCorrect does this for 
you (turning friday into Friday in a cell as soon as you complete the entry). Like-
wise, if you mistakenly enter a word with two initial capital letters, AutoCorrect 
automatically lowercases the second capital letter (so that QUarter typed into a cell 
becomes Quarter upon completion of the cell entry).

In addition to these types of obvious capitalization errors, AutoCorrect also auto-
matically takes care of common typos, such as changing reserach to research (an 
obvious transposition of two letters) or percentof to percent of (an obvious case of 
a missing space between letters). In addition to the errors already recognized by 
AutoCorrect, you can add your own common typos to the list of automatic replace-
ments. Here’s how:

1. Choose File ➪ Options and then click the Proofing tab (Alt+FTP) followed 
by the AutoCorrect Options button.

The AutoCorrect dialog box opens for your language, such as English (U.S.), as 
shown in Figure 1-8.

2. If the AutoCorrect options aren’t already displayed in the dialog box, click 
the AutoCorrect tab to display them.

3. Click the Replace text box and then enter the typo exactly as you usually 
make it.
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4. Click the With text box and enter the replacement that AutoCorrect 
should make (with no typos in it, please!).

Check the typo that you’ve entered in the Replace text box and the replace-
ment that you’ve entered in the With text box.

5. Click the Add button to add your new AutoCorrect replacement to the list 
of automated replacements.

6. Click OK.

You can use the AutoCorrect feature to automatically replace favorite abbrevia-
tions with full text, as well as to clean up all your personal typing gaffes. For 
example, if you have a client with the name Great Lakes Securities, and you enter 
this client’s name in countless worksheets that you create, you can make an Auto-
Correct entry so that Excel automatically replaces the abbreviation gls with Great 
Lakes Securities. After you use AutoCorrect to enter Great Lakes Securities in your 
first cell by typing gls, the AutoComplete feature kicks in, so the next time you type 
the g of gls to enter the client’s name in another cell on the same column, it fills 
in the rest of the name, leaving you with nothing to do but complete the entry.

AutoCorrect is not a replacement for Excel’s spelling checker. You should still 
spell check your worksheet before sending it because the spelling checker finds 
all those uncommon typos that haven’t been automatically corrected for you. (See 
Book 2, Chapter 3 for details.)

FIGURE 1-8:  
You can add  

your own  
automated 

replacements  
to the  

AutoCorrect tab.
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Constraining data entry to a cell range
One of the most efficient ways to enter data into a new table in your worksheet is 
to preselect the empty cells where the data entries need to be made and then enter 
the data into the selected range. This trick only works if you know ahead of time 
how many columns and rows the new table requires.

The reason that preselecting the cells works so well is that doing this constrains 
the active cell to that range, provided that you press only the keystrokes shown in 
Table 1-3. This means that if you’re using the Enter key to move down the column 
as you enter data, Excel automatically positions the active cell at the beginning of 
the next column as soon as you complete the last entry in that column. Likewise, 
when using the Tab key to move the active cell across a row as you enter data, 
Excel automatically positions the active cell at the beginning of the next row in the 
table as soon as you complete the last entry in that row.

Now you don’t have to worry about repositioning the active cell at all when enter-
ing the table data; you can keep your attention on the printed copy from which 
you’re taking the data.

You can’t very well use this preselection method on tables because they’re usually 
open-ended affairs to which you continually append new rows of data. The most 
efficient way to add new data to a new or existing table is to format it as a table. 
(See Book 2, Chapter 2.)

TABLE 1-3 Keystrokes for Moving Within a Selection
Pressing Moves the Cell Pointer

Enter Down one cell in the selection (moves one cell to the right when the 
selection consists of a single row)

Shift+Enter Up one cell in the selection (moves one cell to the left when the 
selection consists of a single row)

Tab One cell to the right in the selection (moves one cell down when the 
selection consists of a single column)

Shift+Tab One cell to the left in the selection (moves one cell up when the 
selection consists of a single column)

Ctrl+period (.) From corner to corner of the cell selection
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Getting Excel to put in the decimal point
If your keyboard has a ten-key entry pad, you’ll want to use it rather than the 
numbers on the top row of the keyboard to make your numeric entries in the 
worksheet. (Make sure that the Num Lock key is engaged, or you’ll end up moving 
the active cell rather than entering numbers.) If you have a lot of decimal numbers 
(suppose that you’re building a financial worksheet with loads of dollars and cents 
entries), you may also want to use Excel’s Fixed Decimal Places feature so that 
Excel places a decimal point in all the numbers that you enter in the worksheet.

To turn on this feature, choose File ➪ Options to open the Excel Options dialog 
box and then click the Advanced tab (or press Alt+FTA). Select the Automatically 
Insert a Decimal Point check box in the Editing Options section. You can then use 
the Places text box to specify the number of decimal places (2 is the default) that 
you want Excel to add to each number entry.

After turning on the Automatically Insert a Decimal Point option, Excel adds a 
decimal point to the number of places that you specified to every numeric data 
entry that you make at the time you complete its entry. For example, if you type 
the digits 56789 in a cell, Excel changes this to 567.89 when you complete the 
entry.

Note that when this feature is turned on and you want to enter a number without 
a decimal point, you need to type a period at the end of the value. For example, 
if you want to enter the number 56789 in a cell and not have Excel change it to 
567.89, you need to type

56789.

You AutoFill me
Few Excel features are more helpful than the AutoFill feature, which enables you 
to fill in a series of entries in a row or column — all by entering only the first item 
(or, in some cases, the first two or three items) in the series. You can sometimes 
use the AutoFill feature to quickly input row and column headings for a new data 
table or to number the records in a table. For example, when you need a row of 
column headings that list the 12 months for a sales table, you can enter January or 
Jan. in the first column and then have AutoFill input the other 11 months for you 
in the cells in columns to the right. Likewise, when you need to create a column 
of row headings at the start of a table with successive part numbers that start at 
L505-120 and proceed to L505-128, you enter L505-120 in the first row and then 
use AutoFill to copy the part numbers down to L505-128 in the cells below.
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The key to using AutoFill is the Fill handle, which is the small black square that 
appears in the lower-right corner of whatever cell contains the active cell. When 
you position the mouse or Touch pointer on the Fill handle, it changes from the 
normal thick, white-cross pointer to a thin, black-cross pointer. This change in 
shape is your signal that when you drag the Fill handle in a single direction, either 
down or to the right, Excel either copies the active cell entry to all the cells that 
you select or uses it as the first entry in a consecutive series, whose successive 
entries are then automatically entered in the selected cells.

Note that you can immediately tell whether Excel copied the cell entry or used it as 
the first in a series to fill in by the ScreenTips that appear to the right of the mouse 
pointer. As you drag through subsequent cells, the ScreenTip indicates which 
entry will be made if you release the mouse button (or remove your finger or sty-
lus from a touchscreen) at that point. If the ScreenTip shows the same entry as 
you drag, you know Excel didn’t recognize the entry as part of a consecutive series 
and is copying the entry verbatim. If, instead, the ScreenTips continue to change 
as you drag through cells showing you successive entries for the series, you know 
that Excel has recognized the original entry as part of a consecutive series.

Figures 1-9 and 1-10 illustrate how AutoFill works. In Figure 1-9, I entered Janu-
ary as the first column heading in cell B2 (using the Enter button on the Formula 
bar to keep the active cell in B2, ready for AutoFill). Next, I positioned the mouse 
pointer on the AutoFill handle in the lower-right corner of B2, then I dragged the 
Fill handle to the right until I reached cell M2 (and the ScreenTip stated December).

Figure  1-10 shows the series that was entered in the cell range B2:M2 when I 
released the mouse button with cell M2 selected. For this figure, I also clicked 
the drop-down button attached to the Auto Fill Options button that automatically 
appears whenever you use the Fill handle to copy entries or fill in a series to show 
you the items on this drop-down menu. This menu contains a Copy Cells option 
button that enables you to override Excel’s decision to fill in the series and have it 
copy the original entry (January, in this case) to all the selected cells.

Note that you can also override Excel’s natural decision to fill in a series or copy an 
entry before you drag the Fill handle. To do so, hold down the Ctrl key (which adds 
a tiny plus sign to the upper-right corner of the Fill handle). Continue to hold down 
the Ctrl key as you drag the Fill handle and notice that the ScreenTip now shows 
that Excel is no longer filling in the series, but copying the entry as expected.

FIGURE 1-9:  
Dragging the Fill 

handle to fill in 
a series with the 

twelve months of 
the year.
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When you need to consecutively number the cells in a range, use the Ctrl key to 
override Excel’s natural tendency to copy the number to all the cells you select. 
For example, if you want to number rows of a list, enter the starting number (1 or 
100, it doesn’t matter) in the first row and then press Ctrl to have Excel fill in the 
rest of the numbers for successive rows in the list (2, 3, 4, and the like, or 102, 103, 
104, and so on). If you forget to hold down the Ctrl key and end up with a whole 
range of cells with the same starting number, click the Auto Fill Options drop-
down button and then click the Fill Series option button to rectify the mistake by 
converting the copied numbers to a consecutively numbered series.

You can also use AutoFill to copy an original formula across rows and down col-
umns of data tables and lists. When you drag the Fill handle in a cell that contains 
a formula, Excel automatically adjusts its cell references to suit the new row or 
column position of each copy. (See Book 3, Chapter 1 for details on copying for-
mulas with AutoFill.)

AutoFill on a Touchscreen
To fill out a data series using your finger or stylus when using Excel on a touch-
screen tablet without access to a mouse or touchpad, you use the AutoFill button 
that appears on the touchscreen mini-toolbar as follows:

1. Tap the cell containing the initial value in the series you want AutoFill to 
extend.

Excel selects the cell and displays selection handles (circles) in the upper-left 
and lower-right corners of the cell.

2. Tap and hold the cell until the mini-toolbar appears.

When summoned by touch, the mini-toolbar appears as a single row of 
command buttons, Paste to AutoFill, terminated by a Show Context Menu 
button (with a black triangle pointing downward).

3. Tap the AutoFill button on the mini-toolbar.

Excel closes the mini-toolbar and adds an AutoFill button to the currently 
selected cell (with a blue downward-pointing arrow in the square).

FIGURE 1-10:  
The series of 

monthly column 
headings with the 

AutoFill Options 
drop-down menu.
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4. Drag the AutoFill button through the blank cells in the same column or 
row into which the data series sequence is to be filled.

When you release your finger or stylus after selecting the last blank cell to be 
filled, Excel fills out the data series in the selected range.

AutoFill via the Fill button on the Ribbon
Instead of using the Fill handle or AutoFill button on the mini-toolbar, you can 
also fill in a series using the Fill button on the Excel Ribbon. To use the Fill but-
ton on the Home tab of the Ribbon to accomplish your AutoFill operations, follow 
these steps:

1. Enter the first entry (or entries) upon which the series is to be based in 
the first cell(s) to hold the new data series in your worksheet.

2. Select the cell range where the series is to be created, across a row or 
down a column, being sure to include the cell with the initial entry or 
entries in this range.

3. Click the Fill button on the Home tab and then tap Series on its drop-
down menu.

The Fill button is located in the Editing group right below the AutoSum button 
(the one with the Greek sigma). When you click the Series option, Excel opens 
the Series dialog box.

4. Click the AutoFill option button in the Type column followed by the OK 
button in the Series dialog box.

Excel enters a series of data based on the initial value(s) in your selected cell 
range just as though you’d selected the range with the fill handle.

Note that the Series dialog box contains a bunch of options that you can use to 
further refine and control the data series that Excel creates. In a linear data series, 
if you want the series to increment more than one step value at a time, you can 
increase it in the Step Value text box. Likewise, if you want your linear or AutoFill 
series to stop when it reaches a particular value, you enter that into the Stop Value 
text box.

When you’re entering a series of dates with AutoFill that increment on anything 
other than the day, remember the Date Unit options in the Series dialog box ena-
ble you to specify other parts of the initial date to increment in the series. Your 
choices include Weekday, Month, or Year.
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AutoFill series with custom increments
Normally, when you drag the Fill handle to fill in a series of data entries, Excel 
increases or decreases each entry in the series by a single unit (a day, month, 
hour, or whatever). You can, however, get AutoFill to fill in a series of data entries 
that uses a custom increment, such as every two days, every third month, or every 
hour-and-a-half.

Figure  1-11 illustrates several series all created with AutoFill that use custom 
increments:

 » The first example in row 2 shows a series of times with 45-minute increments, 
starting with 8:00 a.m. in cell A3 and extending to 2:00 p.m. in cell I3.

 » The second example in row 4 contains a series of weekdays with two-day 
increments, starting on Monday in cell A4 and extending to Saturday in 
cell G4.

 » The third example in row 6 shows a series of numbers created with a custom 
increment of 15, starting with 35 in cell A6 and increasing to 155 in cell I6.

 » The fourth example in row 8 shows a series of months created with a custom 
increment of 2, starting with Jan in cell A8 and ending with Nov in cell F8.

 » The final example in row 10 shows a series of numbers created with a custom 
increment of -25 (so, really, a decrement), starting with 100 in cell A10 and 
decreasing to -100 in cell I10.

FIGURE 1-11:  
Some series 
 created with 

AutoFill by 
using custom 

increments.
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To create a series that uses a custom increment, follow these four general steps:

1. Enter the first two entries in the series in consecutive cells above one 
another in a column or side by side in a row.

Enter the entries one above the other when you intend to drag the Fill handle 
down the column to extend the series. Enter them side by side when you 
intend to drag the Fill handle to the right across the row.

2. Position the cell pointer in the cell with the first entry in the series and 
drag through the second entry.

Both entries must be selected (indicated by being enclosed within the 
expanded active cell) before you use the Fill handle to extend the series. Excel 
analyzes the difference between the two entries and uses this difference as its 
increment in filling in the data series.

3. Drag the Fill handle down the column or across the row to extend the 
series.

In this case, Excel fills the series by using the increment value. Check the 
ScreenTips to make sure that Excel is using the correct increment in filling out 
your data series.

4. Release the mouse button when you reach the desired end of the series 
(indicated by the entry shown in the ScreenTip appearing next to the 
black-cross mouse pointer).

Creating custom AutoFill lists
Just as you can use AutoFill to create a series with a custom increment, you can 
also cajole AutoFill into creating a custom list using items that you specify. For 
example, suppose that you often enter a standard series of city locations as the 
column or row headings in new worksheets. Instead of copying the list of cities 
from one workbook to another, you can create a custom list containing all the 
cities in the order in which they normally appear in your worksheets. After you 
create a custom list in Excel, you can then enter the first item in a cell and use the 
Fill handle to extend the series either down a column or across a row.

To create a custom series, you can either enter the list of entries in the custom 
series in successive cells of a worksheet before you open the Custom Lists dia-
log box, or you can type the sequence of entries for the custom series in the List 
Entries list box located on the right side of the Custom Lists tab in this dialog box, 
as shown in Figure 1-12.
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If you already have the data series for your custom list entered in a range of cells 
somewhere in a worksheet, follow these steps to create the custom list:

1. Click the cell with the first entry in the custom series and then drag the 
mouse or Touch pointer through the range until all the cells with entries 
are selected.

The expanded active cell should now include all the cells with entries for the 
custom list.

2. Choose File ➪ Options ➪ Advanced (Alt+FTA) and then scroll down and 
click the Edit Custom Lists button located in the General section.

The Custom Lists dialog box opens with its Custom Lists tab, where you now 
should check the accuracy of the cell range listed in the Import List from Cells 
text box. (The range in this box lists the first cell and last cell in the current 
selected range separated by a colon — you can ignore the dollar signs 
following each part of the cell address.)

3. Click the Import button to add the entries in the selected cell range to 
the List Entries box on the right and to the Custom Lists box on the left 
side of the Custom Lists tab.

Excel adds the data entries in the selected cell range to both the List Entries 
and the Custom Lists boxes.

4. Click OK to close the Custom Lists dialog box, and then click OK to close 
the Excel Options dialog box.

FIGURE 1-12:  
Creating a 

 custom list of 
 cities for AutoFill.
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If you don’t have the entries for your custom list entered anywhere in the work-
sheet, you must follow the second and third steps listed previously and then take 
these three additional steps instead:

1. Click the List Entries box and then type each of the entries for the custom 
list in the order in which they are to be entered in successive cells of a 
worksheet.

Press the Enter key after typing each entry for the custom list so that each 
entry appears on its own line in the List Entries box or separate each entry with 
a comma.

2. Click the Add button to add the entries that you’ve typed to the Custom 
Lists box.

Note that when Excel adds the custom list that you just typed to the Custom 
Lists box, it automatically adds commas between each entry in the list — even 
if you pressed the Enter key after making each entry. It also automatically 
separates each entry on a separate line in the List Entries box — even if you 
separated them with commas instead of carriage returns.

3. Click OK to close the Custom Lists dialog box, and then click OK to close 
the Excel Options dialog box.

After you’ve created a custom list by using one of these two methods, you can fill 
in the entire data series by entering the first entry of the list in a cell and then 
dragging the Fill handle to fill in the rest of the entries. If you ever decide that you 
no longer need a custom list that you’ve created, you can delete it by clicking the 
list in the Custom Lists box in the Custom Lists dialog box and then clicking the 
Delete button. Excel then displays an alert box indicating that the list will be per-
manently deleted when you click OK. Note that you can’t delete any of the built-in 
lists that appear in this list box when you first open the Custom Lists dialog box.

You can also fill in any part of the series by entering any one of the entries in the 
custom list and then dragging the Fill handle in the appropriate direction (down 
and to the right to enter succeeding entries in the list or up and to the left to enter 
preceding entries).

Flash Fill to the rescue
Excel’s handy Flash Fill feature gives you the ability to take a part of the data 
entered into one column of a worksheet table and enter just that data in a new 
table column using only a few keystrokes. The series of entries appear in the new 
column the moment Excel detects a pattern in your initial data entry that enables 
it to figure out the data you want to copy. The beauty is that all this happens with-
out the need for you to construct or copy any kind of formula.
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The best way to understand Flash Fill is to see it in action. Figure 1-13 (sample 
workbook: Full Names.xlsx) contains a new data table consisting of four columns. 
The first column already contains the full names of clients (first, middle, and 
last). The second, third, and fourth columns need to have just the first, middle, 
and surnames, respectively, entered (so that particular parts of the clients’ names 
can be used in the greetings of form e-mails and letters as in, “Hello Keith,” or 
“Dear Mr. Harper,”).

Rather than manually entering the first, middle, or last names in the respective 
columns (or attempting to copy the entire client name from column A and then 
editing the parts not needed in the First Name, Middle Name, and Last Name 
columns), you can use Flash Fill to quickly and effectively do the job. And here’s 
how you do it:

1. Type Keith in cell B2 and complete the entry with the ↓ or Enter key.

When you complete this entry with the ↓ key or Enter key on your keyboard, 
Excel moves the cell pointer to cell B3, where you have to type only the first 
letter of the next name for Flash Fill to get the picture.

2. In Cell B3, type only J, the first letter of Jonas, the second client’s first 
name.

Flash Fill immediately does an AutoFill type maneuver by suggesting the rest of 
the second client’s first name, Jonas, as the text to enter in this cell. At the same 
time, Flash Fill suggests entering all the remaining first names from the full 
names in column A in column B. (See Figure 1-13.)

3. Complete the entry of Jonas in cell B3 by clicking the Enter button or 
pressing an arrow key.

The moment you complete the data entry in cell B3, the First Name column is 
done: Excel enters all the other first names in column B at the same time!

FIGURE 1-13:  
New data table 
containing full 

names that 
need to be split 
up in separate 
columns with 

Flash Fill. (Sample 
 workbook: Full 

Names.xlsx).
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To complete this example name table by entering the middle and last names in 
columns C and D, respectively, you repeat these steps in those columns. You enter 
the first middle name, Austen, from cell A2 in cell C2 and then type W in cell C3. 
Complete the entry in cell C3 and the middle name entries in that column are 
done. Likewise, you enter the first last name, Harper, from cell A2 in cell D2 and 
then type S in cell D3. Complete the entry in cell D3, and the last name entries for 
column D are done, finishing the entire data table.

Flash Fill works perfectly at extracting parts of longer data entries in a column 
provided that all the entries follow the same pattern and use same type of separa-
tors (spaces, commas, dashes, and the like). For example, in Figure 1-13, there’s 
an anomaly in the full name entries in cell A9 where only the middle initial with 
a period is entered instead of the full middle. In this case, Flash Fill enters M in 
cell C9, and you have to manually edit its entry to add the necessary period. Also, 
remember that Flash Fill’s usefulness isn’t restricted to all-text entries as in my 
example Client Name table. It can also extract parts of entries that mix text and 
numbers, such as ID numbers (AJ-1234, RW-8007, and so forth).

Limiting data entry with Data Validation
The Data Validation feature in Excel can be a real timesaver when you’re doing 
repetitive data entry and can also go a long way in preventing incorrect entries in 
your worksheets. When you use Data Validation in a cell, you indicate what type 
of data entry is allowed in the cell. As part of restricting a data entry to a number 
(which can be a whole number, decimal, date, or time), you also specify the per-
missible values for that type of number (a whole number between 10 and 100 or a 
date between January 1, 2022, and December 31, 2022, for example).

When you restrict the data entry to text, you can specify the range of the mini-
mum and maximum text length (in characters) or, even better, a list of permis-
sible text entries that you can choose from a pop-up menu (opened by clicking a 
pop-up button that appears to the right of the cell whenever it’s active).

When using Data Validation to restrict the type of data entry and its range of 
acceptable values in a cell, you can also specify an input message that is automati-
cally displayed next to the cell when you select it and/or an error alert message 
that is displayed if you try to input the wrong type of entry or a number outside 
the permissible range.

To use the Data Validation feature, select the cell or range where you want to 
restrict the type of data entry that you can make there and then click the Data 
Validation button on the Data tab of the Ribbon (or press Alt+AVV). The Data Vali-
dation dialog box opens with the Settings tab selected (similar to the one shown 
in Figure 1-14).
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You then click the drop-down button attached to the Allow drop-down list box 
and select among the following items:

 » Any Value: Removes any previous restrictions thereby canceling data 
validation and once again enabling the user to enter anything into the cell.

 » Whole Number: Restricts the entry to a whole number that falls within a 
certain range or satisfies the parameters you specify.

 » Decimal: Restricts the entry to a decimal number that falls within a certain 
range or satisfies the parameters you specify.

 » List: Restricts the entry to one of several text items that you specify in a list. 
The user displays the list by clicking a pop-up button that appears to the right 
of the cell whenever it contains the active cell.

 » Date: Restricts the entry to a date that falls within a certain range or on or 
before a particular date.

 » Time: Restricts the entry to a time that falls within a certain range or on or 
before a particular time of the day.

 » Text Length: Restricts a text entry so that its length in characters falls within a 
range that you specify.

 » Custom: Restricts the entry to the parameters specified by a particular 
formula entered in another cell of the worksheet.

To specify an input message after selecting all the items on the Settings tab, click 
the Input Message tab of the Data Validation dialog box, where you enter a short 
title for the input message (such as List Entry) in the Title text box, and then enter 
the text of your message in the Input Message list box below.

FIGURE 1-14:  
Creating a  custom 
 drop-down list in 

the Data  
Validation  

dialog box.
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To specify an alert message, click the Error Alert tab of the Data Validation dialog 
box. First, make sure the Show Error Alert After Invalid Data Is Entered check box 
is selected. Now you can select the kind of warning from the Style drop-down list: 
Stop (the default, which uses a red button with a cross in it), Warning (which uses 
a yellow triangle with an exclamation point in it), or Information (which uses a 
balloon with a blue I in it). After selecting the type of alert, you then enter the title 
for its dialog box in its Title text box and enter the text of the alert message in the 
Error Message list box.

To apply the restriction you’re defining in the Data Validation dialog box to all 
the other cells that are formatted the same way as in a cell range formatted as a 
table (see Book 2, Chapter 2 for details), return to the Settings tab, select the Apply 
These Changes to All Other Cells with the Same Settings check box, and then click 
OK. To copy the restriction to a range that is not formatted as a table, use the Data 
Validation feature to set up the type of entry and permitted range in the first cell 
and then use the Fill handle to copy that cell’s Data Validation settings to subse-
quent cells in the same column or row.

By far, the most popular use of the Data Validation feature is to create a drop-
down menu from which you or someone who uses your worksheet can select the 
appropriate data entry. Figures 1-14 and 1-15 illustrate this type of usage.

As Figure  1-14 shows, on the Settings tab of the Data Validation dialog box, I 
chose List from the Allow drop-down list box and then in the Source text box, I 
designated the cell range A2:A6, which just happens to contain the list of allowa-
ble entries. (You can type them in the Source text box separated by commas if the 
list doesn’t already exist someplace on the worksheet.) Notice in this figure that 
when you select List in the Allow combo box, the In-Cell Dropdown check box 
appears. Keep this check box selected because it tells Excel to create a drop-down 
list (or pop-up menu, as it’s also called) containing only the entries specified in 
the Source text box.

Figure 1-15 shows you what happens in the worksheet after you close the Data 
Validation dialog box and then select a cell (C2 in Figure 1-15) in your data valida-
tion range. Here, you see the pop-up menu (with a list of cities taken from the cell 
range A2:A6) as it appears when you click the cell’s new pop-up button. In this 
figure, you can also see the input List Entry message box that I created for this cell 
by using the options on the Input Message tab of the Data Validation dialog box. 
Note that you can reposition this message box (officially known as a Comment box) 
so that it’s close to the cell but doesn’t get in the way of selecting an entry — drag 
the Comment box with the mouse pointer.
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Figure 1-16 demonstrates what happens if you try to input an entry that isn’t on 
the drop-down list. For this figure, I deliberately disregarded the input instruc-
tions and typed Buffalo as the location. As soon as I clicked the Enter button on the 
Formula bar, the custom alert dialog box (which I named Invalid City) appears. I 
created this alert dialog box by using the options located on the Error Alert tab of 
the Data Validation dialog box.

To find cells to which Data Validation has been applied, open the Go To dialog box 
(Ctrl+G or F5), click Special to open the Go To Special dialog box, and then select 
the Data Validation option button. Click the Same option button under Data Vali-
dation to have Excel go to the next cell that uses the same Data Validation settings 
as the active cell. Leave the All option button under Data Validation selected to go 
to the next cell that uses any kind of Data Validation setting.

To get rid of Data Validation settings assigned to a particular cell or cell range, 
select the cell or range, open the Data Validation dialog box (Alt+AVV), click Clear 
All, and then click OK.

Although Data Validation is most often used to restrict new data entries in a work-
sheet, you can also use it to quickly identify values that are outside desired param-
eters in ranges of existing numeric data entries. See Book 2, Chapter 3 for details.

FIGURE 1-15:  
Selecting a city 

from the custom 
drop-down list.

FIGURE 1-16:  
Getting an error 

message after 
trying to input a 
city that’s not on 

the list.
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Linking to Other Documents
The subject of this section is connecting a worksheet to other documents using 
links. A link (sometimes called a hyperlink) is a bit of worksheet text — or perhaps 
a worksheet object such as a button or image — that, when clicked, takes you to 
another document. Here, “document” is defined broadly as any of the following:

 » A separate file, such as a different Excel workbook, a Word document, a 
PowerPoint presentation, or a text file.

 » A different place in the same workbook, such as another tab or a specific cell 
reference or range name.

 » A web page on your company’s network or on the web.

Hyperlinks: the basics
To add links in an Excel worksheet, you must define two things:

 » The text or object to which you want to attach the link. This text or object is 
what you’ll click to activate the link.

 » The destination to which the link takes you when you click the link.

The objects to which you can attach links include any text that you enter into a 
cell or any graphic object that you draw or import into the worksheet. (See Book 5,  
Chapter 2, for details on adding graphics to your worksheet.) The destinations 
that you can specify for links can be a new cell or range, the same workbook file, 
or another file outside the workbook.

The destinations that you can specify for links that take you to another place in 
the same workbook file include

 » The cell reference of a cell on any of the worksheets in the workbook that 
you want to go to when you click the link.

 » The range name of the cell or group of cells that you want to select when you 
click the link. The range name must already exist at the time you create the 
link. (See Book 3, Chapter 1 to find out how to create and use range names.)

The destinations that you can specify for links that take you outside the current 
workbook include
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 » The location and filename of an existing file that you want to open when 
you click the link. This file can be another workbook file or any other type of 
document that your computer can open.

 » The address of a web page that you want to visit when you click the link. This 
page can be on your company’s network or on the web and is opened in your 
web browser.

 » An email address for a new message that you want to create in your email 
program when you click the link. You must specify the recipient’s email 
address and the subject of the new message when you create the link.

Inserting links
Before getting down to the business of inserting a link, you need to add to your 
worksheet either the text or the graphic object to which you want to attach the 
link. With the text or image added, you can now insert the link the easy way or the 
not-quite-as-easy way.

The easy way is to first click the cell containing your text or click the image you want 
to use for the link. Now click the Ribbon’s Insert tab and then click the lower half 
of the Link button. Excel displays a menu that includes a Recent Items list similar 
to the one shown in Figure 1-17. If the document to which you want to link appears 
in that list, say “Yes!!” and click the document. Excel creates the link just like that.

FIGURE 1-17:  
Click the lower 
half of the Link 

button to see 
a list of recent 

documents you 
can link to.
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For the not-quite-as-easy-way, follow these steps:

1. Position the cell pointer in the cell containing the text or click the graphic 
object to which you want to attach the link.

2. Click the Ribbon’s Insert tab and then either click the top half of the Link 
button, or click the lower half of the Link button and then click Insert 
Link. (You can also press either Alt+NI2I or Ctrl+K.)

The Insert Hyperlink dialog box opens (similar to the one shown in Figure 1-18). 
If you selected a graphic object or a cell that contains some entry besides text 
before opening this dialog box, you notice that the Text to Display text box 
contains <<Selection in Document>> and that this box is grayed out (because 
there isn’t any text to edit when anchoring a link to a graphic). If you selected a 
cell with a text entry, that entry appears in the Text to Display text box. You can 
edit this text in this box; however, be aware that any change that you make to 
it here is reflected in the active cell when you close the Insert Hyperlink 
dialog box.

The ScreenTip button located to the immediate right of the Text to Display text 
box enables you to add text describing the function of the link when you 
position the mouse pointer over the cell or graphic object to which the link is 
attached. To add a ScreenTip for your link, follow Step 3. Note that if you don’t 
add your own ScreenTip, Excel automatically creates its own ScreenTip that 
lists the destination of the new link when you position the mouse pointer on its 
anchor.

3. (Optional) Click the ScreenTip button to open the Set Hyperlink ScreenTip 
dialog box, type the text you want to appear when the mouse pointer 
hovers over the link, and then click OK.

By default, Excel selects the Existing File or Web Page button in the Link To area 
on the left side of the Insert Hyperlink dialog box, which enables you to assign 
the link destination to a file on your hard drive or to a web page. The Place in 
This Document button enables you to link to a cell or cell range in the current 
workbook; the Create New Document button enables you to link to a new 
document; and the E-Mail Address button enables you to create a link that 
launches a new email.

4. Select the type of destination for the new link by clicking its button in the 
Link To panel on the left side of the Insert Hyperlink dialog box.

Now you need to specify the destination for your link. How you do this 
depends on which type of link you’re adding:
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• Linking to an existing file: Click the Existing File or Web Page button, and 
then use the Link To list to select the location of the file. Click Current 
Folder (it’s selected by default) and then click the file. Excel adds the file 
location to the Address text box. (An alternative method is to click the 
Recent Files button and then click the file in the list that appears.)

• Linking to a web page: Click the Existing File or Web Page button, and then 
type or paste the web address in the Address text box. (An alternative 
method is to click the Browsed Pages button and then click the web page 
address in the list that appears.)

• Linking to a cell in the current workbook: Click the Place in This Document 
button, and then use the Type the Cell Reference text box to enter the 
address of the cell. In the Or Select a Place in This Document list, click the 
name of the worksheet where the cell resides.

• Linking to a worksheet in the current workbook: Click the Place in This 
Document button, and then use the Or Select a Place in This Document list 
to click the name of the worksheet.

• Linking to a range name in the current workbook: Click the Place in This 
Document button, and then use the Or Select a Place in This Document list 
to click the range name under the Defined Names heading.

• Linking to a new email: Click the E-Mail Address button, and then use the 
E-Mail Address text box to type the email address. (Or click the address in 
the Recently Used E-Mail Addresses section, if it appears there.) Use the 
Subject text box to type the subject line of the new email message.

5. Click OK.

Excel inserts the link.

If you attached your new link to a graphic object, that object is still selected in 
the worksheet. (To deselect the object, click a cell outside its boundaries.) If you 
attached your link to text in the active cell, the text now appears in blue and is 
underlined. (You may not be able to see the underlining until you move the active 
cell out of the cell.)

When you position the mouse pointer over the link, the mouse or Touch pointer 
changes from a thick, white cross to a hand with the index finger pointing upward. 
The ScreenTip that you assigned appears below and to the right of the hand mouse 
pointer.
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If you didn’t assign your own ScreenTip to the link when creating it, Excel adds 
its own message that shows the destination address of the link. If the link is text, 
the message in the ScreenTip also adds the following message:

Click once to follow. Click and hold to select this cell.

Follow that link!
To follow a link, click the link text or graphic object with the mouse or Touch 
pointer. Excel then takes you to the destination. If the destination is a cell in the 
workbook, Excel makes that cell current. If the destination is a cell range, Excel 
selects the range and makes the first cell of the range current. If this destina-
tion is a document created with another application program, Excel launches the 
application program (assuming that it’s available on the current computer). If this 
destination is a web page, Excel opens the page in your browser.

After you follow a text link to its destination, the color of its text changes from 
the traditional blue to a dark shade of purple (without affecting its underlining). 
This color change indicates that the link has been followed. (Note, however, that 
graphic links don’t show any change in color after you follow them.) Followed text 
links regain their original blue color when you reopen their workbooks in Excel.

Editing links
Excel makes it easy to edit any link that you’ve added to your worksheet. The only 
trick to editing a link is that you must be careful not to activate the link during 
the editing process. This means that you must always remember to right-click the 
link’s text or graphic because clicking results only in activating the link.

When you right-click a link, Excel displays its shortcut menu. If you want to mod-
ify the link’s destination or ScreenTip, click Edit Hyperlink on this shortcut menu. 
This action opens the Edit Hyperlink dialog box with the same options as the 
Insert Hyperlink dialog box (shown previously in Figure 1-18).

Removing a link
If you want to remove the link without getting rid of the link’s text entry or graphic, 
right-click the cell or graphic and then click the Remove Hyperlink command.
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If you want to clear the cell of both its link and text entry, right-click the cell and 
then click Delete. To get rid of a graphic object along with its link, right-click the 
object (this action opens its shortcut menu) and then immediately click the object 
to remove the shortcut menu without either deselecting the graphic or activating 
the link. At this point, you can press the Delete key to delete both the graphic and 
the associated link.

Selecting a link without activating it
When you need to perform some action on a link — such as formatting the link’s 
text or graphic or moving the link to a new location — you first need to select 
the text or graphic. The challenge here is to select the link without activating it 
because clicking the cell or graphic object containing the link results in catapult-
ing you over to the link’s destination point.

To select a cell that contains a text link, click and hold on that cell for a couple of 
seconds. Alternatively, use the arrow keys to position the active cell in that cell or 
use the Go To feature (F5 or Ctrl+G) and enter the cell’s address in the Go To dialog 
box to move the active cell there. To select a graphic object that contains a link, 
right-click the graphic to select it as well as to display its shortcut menu and then 
immediately click the graphic (with the left mouse button) to remove the shortcut 
menu while keeping the object selected.

Using the HYPERLINK Function
Instead of using the Link command button on the Insert tab of the Ribbon, you 
can use Excel’s HYPERLINK function to create a hypertext link. (You can’t use this 
function to attach a link to a graphic object.) The HYPERLINK function uses the 
following syntax:

HYPERLINK(link_location,[friendly_name])

FIGURE 1-18:  
Use the Insert 

Hyperlink 
dialog box to 

insert a link in a 
worksheet.
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HOW TO TELL A UNC FROM A URL ADDRESS 
AND WHEN TO CARE
The address that you use to specify a remote link destination comes in two basic 
flavors: UNC (Universal Naming Convention) and the more familiar URL (Universal 
Resource Locator). The type of address that you use depends on whether the destina-
tion file resides on a server on a local network (in which case, you use a UNC address) or 
on a corporate intranet or the Internet (in which case, you use a URL address). Note that 
URLs also appear in many flavors, the most popular being those that use the Hypertext 
Transfer Protocol (HTTP) and begin with htt p://  and those that use the Hypertext 
Transfer Protocol Secure (HTTPS) and start with https://.

The UNC address for destination files on network servers start with two backslash char-
acters (\\), following this format:

\\server\share\path\filename

In this format, the name of the file server containing the file replaces server, the name 
of the shared folder replaces share, the directory path specifying any subfolders of the 
shared folder replaces path, and the file’s complete filename (including any filename 
extension, such as .xlsx for Excel worksheet) replaces filename.

The URL address for files published on websites follows this format:

internet service//internet address/path/filename

In this format, internet service is replaced with the Internet protocol to be used 
(either HTTP or HTTPS in most cases), internet service is replaced with the domain 
name (such as www.dummies.com) or the number assigned to the internet server, path 
is the directory path of the file, and filename is the complete name (including filename 
extensions such as .htm or .html for web pages).

When specifying the arguments for a HYPERLINK function that you type on the Formula 
bar (as opposed to one that you create by using the Insert Function feature by filling in 
the text boxes in the Function Arguments dialog box), you must remember to enclose 
both the link_location and friendly_name arguments in double-quotes. For example, 
to enter a HYPERLINK function in a cell that takes you to the home page of the For 
Dummies website and displays the text “Dummies Home Page” in the cell, enter the fol-
lowing in the cell:

=HYPERLINK("http://www.dummies.com","Dummies Home Page")

http://www.dummies.com


Bu
ild

in
g 

W
or

ks
he

et
s

CHAPTER 1  Building Worksheets      123

The link_location argument specifies the name of the document to open on your 
local hard drive, on a network server (designated by a UNC address), or on the 
company’s intranet or the web (designated by the URL address — see the side-
bar “How to tell a UNC from a URL address and when to care” for details). The 
optional friendly_name argument is the link text that appears in the cell where you 
enter the HYPERLINK function. If you omit this argument, Excel displays the text 
specified as the link_location argument in the cell.

Saving the Data
One of the most important tasks you ever perform when building your worksheet 
is saving your work! Excel offers three different ways to invoke the Save command:

 » Click the Save button on the Excel title bar, pointed out in Figure 1-19. (Unless 
you were born well before the year 2000, you may not have any idea what this 
icon represents. It is, in fact, an icon of an old storage medium called a 
3.5-inch floppy disk. Google it if you’re curious about this now ancient 
technology.)

 » Press Ctrl+S or F12.

 » Choose File ➪ Save.

Use any of these methods (frequently!) when you’ve stored your workbook on 
your computer’s hard drive. If, instead, you stored your workbook file in an online 
location such as a folder on your OneDrive or SharePoint site, these methods are 
unnecessary. Why? Because for online files, Excel activates its AutoSave feature, 
which automatically saves any changes you make to the workbook without you 
having to bother with any of the Save methods. Woot!

FIGURE 1-19:  
The Excel title 

bar comes with a 
Save icon.
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After you create a new workbook, when you click the Save button or press Ctrl+S 
for the first time, Excel displays the Save This File dialog box. Use the File Name 
text box to name your workbook, use the Choose a Location list to select where you 
want the workbook saved, and then click Save.

Alternatively, if you want more choices for saving, click the More Options link (or 
choose File ➪ Save), which opens the Save As screen in the Backstage view similar 
to the one shown in Figure 1-20.

To save the file locally instead  — that is, on your computer’s hard drive or a 
virtual drive on your company’s local area network — select the Browse button. 
The Save As dialog box opens with the default location for saving workbook files 
from which you can select the drive and folder where the new workbook should 
be stored (see Figure 1-21). Use this dialog box to replace the temporary document 

FIGURE 1-20:  
Use the Save As 

screen to specify 
where you want 

to save a new 
workbook.

WHAT’S UP WITH THE OneDrive?
You’ve undoubtedly heard of the cloud, but your understanding of it may yet be as neb-
ulous as its name. OneDrive is the current name of Microsoft’s storage space in the 
cloud that it lends to its users with a Windows account The great thing about saving a 
workbook file in a folder on your OneDrive is that you then can open it for further edit-
ing and printing from any device running Excel that has Internet access. For example, if 
you save a workbook file that you create in Excel on your office desktop computer, you 
can then open it for more editing on your laptop at home or even your Windows tablet 
or smartphone at the local coffee shop.
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name (Book1, Book2, and so forth) with a more descriptive filename in the File 
Name text box; to select a new file format from the Save As Type drop-down list 
box; and, if necessary, to select a new folder where it’s to be stored before you 
save the workbook.

When you finish making changes in the Save As dialog box, click the Save button 
or press Enter to have Excel save your work. When Excel saves your workbook 
file, the program saves all the information in every worksheet in your workbook 
(including the last position of the active cell) in the designated folder and drive.

You don’t have to fool with the Save As dialog box ever again after initially saving 
a workbook unless you want to save a copy of the workbook under a new filename 
and/or in a new folder. If you want to do either of these things, you must choose 
File ➪ Save As or press Alt+FA to select the Save As command rather than click the 
Save button on the Excel title bar or press Ctrl+S. Then, select the folder where 
you want the new version of the file saved if it’s different from the current folder, 
and you can edit the workbook’s filename if you also want to rename the work-
book file.

The Save As dialog box enables you to change the author or add a title and/or tags 
to the new workbook file by clicking the Authors or Add a Tag link. You can then 
use any or all of these pieces of information you add to the file when later search-
ing for the workbook. Click the Save Thumbnail check box to have Excel save a 
preview of the workbook’s initial worksheet that can be displayed in the Preview 

FIGURE 1-21:  
Specifying the 

folder and 
filename prior to 

saving the new 
workbook file.
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pane of the Open dialog box or when viewing the workbook files with the Large 
Icons or Extra Large Icons settings. (See Book 2, Chapter 3 for details.)

Saving workbooks in other commonly  
used file formats
When you click the Save As Type drop-down button in the Save As dialog box, 
Excel displays a long laundry list of file formats that you can choose from when 
saving the workbook file. You can use these file format options to instantly con-
vert your worksheet data into another file format for use with Excel or some other 
application.

Before saving a new workbook file in a non-Excel file format for use with another 
type of program (such as Web Page for the Internet, or PDF for Adobe Reader), 
be sure that you’ve first saved the worksheet data in a regular Excel Workbook 
file. That way, you continue to have ready access to the data in Excel for further 
editing, printing, and so forth without having to convert the new file back into a 
native Excel Workbook file format.

The most commonly used file format options include the following:

 » Excel Workbook: Saves the workbook in the default Excel .xlsx file format.

 » Excel Macro-Enabled Workbook: Saves the workbook in the default .xlsm 
file format with all macros (see Book 8, Chapter 1) it contains enabled.

 » Excel 97–2003 Workbook: Saves the workbook in the .xls file format used 
by earlier versions of Excel 97 through Excel 2003. Note that an alert dialog 
box appears if Excel finds any features used in the workbook that aren’t 
supported in this file format.

 » XML Data: Saves the workbook in an XML (Extensible Markup Language) 
format (using the .xml filename extension) often used to exchange lists of 
data over the Internet.

 » Web Page: Saves the workbook in an HTML (Hypertext Markup Language) 
used to render all the data on all worksheets in the workbook in a single 
continuous web page with the .htm or .html filename extension.

 » Excel Template: Saves the workbook in the .xltx file format as an Excel 
template file that you can use to generate new workbooks containing the 
same layout and content as the template.
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 » Excel Macro-Enabled Template: Saves the workbook in the .xltm template 
file format with all the macros (see Book 8, Chapter 1) it contains enabled.

 » PDF: Saves the workbook in an Adobe PDF (Portable Document File) format 
with the .pdf filename extension that can be opened with Adobe Reader.

 » OpenDocument Spreadsheet: Saves the workbook in ODF (OpenDocument 
Format) with an .ods filename extension that’s used by other Office suites of 
programs, such as LibreOffice.

Although less frequently needed, don’t forget that the Save As options include a 
number of text file conversions that you can use when your worksheet contains 
lists of data that you need to make available to programs that can deal with strings 
of text data. The major difference between the text file formats is what character 
they use to separate the data in each worksheet cell. So, the Text (Tab Delimited) 
formats use tabs, the CSV (Comma Delimited) formats use commas, and the Text 
formats use spaces.

Changing the default file location
Whenever you click the This PC button under Locations on the Save As screen in 
the Backstage view to save a new workbook file locally (as opposed to in the cloud 
on a SharePoint site or your OneDrive), Excel automatically selects the folder 
listed in the Default File Location text box on the Save tab of the Excel Options 
dialog box (File ➪ Options ➪ Save or Alt+FTS).

If you don’t have a OneDrive or don’t ever save workbook files in the cloud, you 
can prevent Excel from asking you to sign into your OneDrive location when sav-
ing a new workbook by deselecting the Show Additional Places for Saving, Even 
If Sign-In May Be Required check box on the Save tab of the Excel Options dia-
log box. Also, if you prefer selecting the drive and folder into which to save your 
workbook files directly in the Save As dialog box, you can prevent Excel from 
initially displaying the Save As screen by selecting the Don’t Show the Backstage 
When Opening or Saving Files check box on this same tab of the Excel Options 
dialog box.

The very generic Documents folder may not be the place on your hard drive where 
you want all the new workbooks you create automatically saved. To change the 
default local file location to another folder on your computer, follow these steps:

1. Choose File ➪ Options ➪ Save or press Alt+FTS to open the Save tab of the 
Excel Options dialog box.

The Default Local File Location text box displays the directory path to the 
current default folder.
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2. Double-click the Default File Location text box to select the current 
directory path.

When you double-click the Default File Location text box, Excel selects the 
entire directory path so that if you begin typing, the characters you type 
replace the entire path. To edit part of the path (such as the Documents folder 
name after your username), click the mouse or Touch pointer at that place in 
the path to set the insertion point.

3. Edit the existing path or replace it with the path to another existing 
folder in which you want all future workbooks to automatically be saved.

4. Click OK to close the Excel Options dialog box.

Saving a new workbook in the  
old file format
Excel automatically saves each new workbook file in a Microsoft version of the 
XML-based file format, which carries the filename extension .xlsx. The problem 
with this XML file format is that it’s not one that versions of Excel prior to Excel 
2007 can open. This means that if everybody who needs to work with the work-
book you’ve just created hasn’t yet upgraded to Excel 2007 or 2010, you need to 
save the new workbook in the earlier file format used in versions 97 through 2003 
with the old .xls filename extension.

To save a new workbook in the old binary Excel file format for back compatibility, 
be sure to click the Save as Type drop-down button and then select Excel 97-2003 
Workbook from the drop-down list.

Excel automatically displays the Excel Compatibility Checker dialog box whenever 
you try to save a workbook file containing Excel features that aren’t supported in 
earlier versions of the program from Excel 97–2003. This dialog box lists each 
incompatible feature in the workbook and gives you details on what will happen 
to the feature if you go ahead and save the workbook file in the older file format. 
To ignore these warnings and go ahead and save your workbook in the 97–2003 
binary format, click the Continue button in the Excel Compatibility Checker dia-
log box.

If you still want to have access to all the features in the Excel workbook but you 
still need to create a backwardly compatible version of the workbook file (even if 
it has less fidelity), first save the workbook in the XML file format with the .xlsx 
file extension. Then, save a copy in old 97-2003 binary file format with the .xls 
file extension by opening the Save As dialog box (File ➪ Save As or Alt+FA) and 
then selecting Excel 97-2003 from the Save as Type drop-down list before click-
ing the Save button.
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Keep in mind that filename extensions such as .xlsx and .xls do not appear as 
part of the filename (even though they are appended) in the File Name text box in 
the Save As dialog box unless you click the File Name Extensions check box found 
on the View tab in the Windows File Explorer window to select it.

Document Recovery to the Rescue
Excel offers a document recovery feature that can help you in the event of a com-
puter crash because of a power failure or some sort of operating system freeze or 
shutdown. The AutoRecover feature saves your workbooks at regular intervals. In 
the event of an Excel or computer crash, Excel displays a Document Recovery task 
pane the next time you start Excel after rebooting the computer.

When you first start using Excel, the AutoRecover feature is set to automatically 
save changes to your workbook (provided that the file has already been saved) 
every ten minutes. You can shorten or lengthen this interval as you see fit. Choose 
File ➪ Options ➪ Save or press Alt+FTS to open the Excel Options dialog box with 
the Save tab selected. Use the spinner buttons or enter a new automatic save 
interval into the Save AutoRecover Information Every 10 Minutes text box before 
clicking OK.

The Document Recovery Task pane shows the available versions of the workbook 
files that were open at the time of the computer crash. It identifies the original 
version of the workbook file and when it was saved, along with the recovered ver-
sion of the file and when it was saved. To open the recovered version of a work-
book (to see how much of the work it contains that was unsaved at the time of the 
crash), position the mouse pointer over the AutoRecover version. Then click its 
drop-down menu button and click Open on its pop-up menu. After you open the 
recovered version, you can (if you choose) then save its changes by clicking the 
Save button on the Excel title bar or by choosing File ➪ Save.

You then have these choices:

 » To save the recovered version of a workbook without bothering to first open 
it, place your mouse over the recovered version, click its drop-down button, 
and click the Save As option on the pop-up menu.

 » To permanently abandon the recovered version (leaving you with only the 
data in the original version), click the Close button at the bottom of the 
Document Recovery Task pane. When you click the Close button, an alert 
dialog box appears, giving you the chance to retain the recovered versions of 
the file for later viewing.
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 » To retain the files for later viewing, select the Yes (I Want to View These Files 
Later) radio button before clicking OK.

 » To retain only the original versions of the files shown in the Task pane, select 
the No (Remove These Files. I Have Saved the Files I Need) radio button 
instead.

The AutoRecover feature only works on Excel workbooks that have been saved at 
least one time (as explained in the earlier section “Saving the Data”). In other 
words, if you build a new workbook and don’t bother to save and rename it prior 
to experiencing a computer crash, the AutoRecover feature will not bring back any 
part of it. For this reason, it’s really important that you get into the habit of sav-
ing new workbooks with the Save button on the Excel title bar immediately after 
creating a workbook. Or you can use the trusty keyboard shortcut Ctrl+S whenever 
you make a significant change to the file.
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Formatting Worksheets

When it comes to populating a worksheet with data, Excel doesn’t put a 
lot of hurdles in your path. Most of the time, you click the cell you want 
to use, type your label or data, press Enter, and — voilà! — you’ve got 

yourself a cell entry. Repeat as needed and soon enough your worksheet is done.

Or is it? The problem with Excel’s data entry process is that it tends to produce 
worksheets that are, well, unattractive: All the text is the same size and the same 
color; some longer cell entries appear truncated; columns of data and labels are 
misaligned. It’s a mess! So, sure, Excel makes it easy to add data, but to make that 
data look presentable requires more work.

Why should you care about how your worksheets look? After all, most of the time 
you’re the only person who’ll seem them, right? Perhaps. But even if your eyeballs 
are the only ones that will grace your worksheets, there are lots of advantages to 
taking a bit of extra time to make things look nice. Formatting a worksheet — the 
process of adding fonts and colors, adjusting column widths and row heights, 
aligning data, adding borders, and much more — makes the worksheet easier to 

Chapter 2

IN THIS CHAPTER

 » Selecting cell ranges and adjusting 
column widths and row heights

 » Formatting cell ranges as tables

 » Assigning number formats

 » Making alignment, font, border, and 
pattern changes

 » Using the Format Painter to quickly 
copy formatting

 » Formatting cell ranges with Cell 
Styles

 » Applying conditional formatting
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read, helps you find errors, and gives you a hand spotting trends and performing 
other types of data analysis. And all those advantages are doubled if you plan to 
share your workbooks with colleagues and co-workers.

In this chapter, you explore Excel’s extensive worksheet formatting options. After 
a brief foray into selecting cells, you dive into the deep end of formatting cells, 
rows, columns, ranges, tables, and more. Your worksheets are going to look so 
good by the time you’re done with this chapter.

Selecting Cells and Ranges
Before you can modify the appearance of anything in a worksheet, you must first 
select the cells you want to work with.

In Excel, you can select a single cell, a block of cells (known as a cell range), or var-
ious discontinuous cell ranges (also known as a nonadjacent selection). Figure 2-1 
shows a nonadjacent selection that consists of several different cell ranges (the 
smallest range is the single cell I9).

Note that a simple cell selection consisting of a single cell range is denoted in the 
worksheet both by highlighting the selected cells in a light gray color as well as by 
extending the border of the cell cursor so that it encompasses all the highlighted 
cells. In a nonadjacent cell selection, however, all selected cells are highlighted 
but only the active cell (the one whose address is displayed in the Name Box on 

FIGURE 2-1:  
Worksheet with a 
nonadjacent cell 

selection made 
up of several 

different sized 
ranges.
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the Formula bar) contains the cell cursor (whose borders are quite thin when 
compared to the regular cell cursor).

Cell ranges are always noted in formulas by the upper-left and lower-right cells 
that you select, separated by a colon (:); therefore, if you select cell A1 as the first 
cell and cell H10 as the last cell and then use the range in a formula, the cell range 
appears as A1:H10.

Selecting cells with the mouse
Excel offers several methods for selecting cells with the mouse. With each method, 
you start by selecting one of the cells that occupies the corner of the range that 
you want to select. The first corner cell that you click becomes the active cell (indi-
cated by its cell reference in the Formula bar’s Name box), and the cell range that 
you then select becomes anchored on this cell.

After you select the active cell in the range, drag the pointer to extend the selec-
tion until you have highlighted all the cells that you want to include. Here are 
some tips:

 » To extend a range in a block that spans several columns, drag right or left 
from the active cell.

 » To extend a range in a block that spans several rows, drag down or up from 
the active cell.

 » To extend a range in a block that spans several columns and rows, drag 
diagonally from the active cell in the most logical directions (up and to the 
right, down and to the right, up and to the left, or down and to the left).

If you ever extend the range too far in one direction, you can always reduce it by 
dragging in the other direction. If you’ve already released the mouse button and 
you find that the range is incorrect, click the active cell again. (Clicking any cell 
in the worksheet deselects a selected range and activates the cell that you click.) 
Then select the range of cells again.

You can always tell the active cell that forms the anchor point of a range because 
it’s the only cell within the range that you’ve selected that isn’t highlighted and 
is the only cell reference listed in the Formula bar’s Name box. As you extend the 
range by dragging the thick white-cross mouse pointer, Excel indicates the cur-
rent size of the range in columns and rows in the Name box (as in 5R x 2C when 
you’ve highlighted a range of five rows long and two columns wide). However, as 
soon as you release the mouse button, Excel replaces this row and column nota-
tion with the address of the active cell.
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You can also use the following shortcuts when selecting cells with the mouse:

 » To select a single-cell range, click the cell.

 » To select all cells in an entire column, position the mouse pointer on the 
column letter in the column header and then click. To select several adjacent 
columns, drag through their column letters in the column header.

 » To select all cells in an entire row, position the mouse pointer on the row 
number in the row header and then click. To select several adjacent rows, 
drag through the row numbers in the row header.

 » To select all the cells in the worksheet, click the box in the upper-left corner of 
the worksheet at the intersection of row and column headers with the triangle 
in the lower-right corner that makes it look like the corner of a dog-eared or 
folded down book page. (You can also do this from the keyboard by pressing 
Ctrl+A.)

 » To select a cell range composed of partial columns and rows without drag-
ging, click the cell where you want to anchor the range, hold down the Shift 
key, and then click the last cell in the range and release the Shift key. (Excel 
selects all the cells in between the first and the last cell that you click.) If the 
range that you want to mark is a block that spans several columns and rows, 
the last cell is the one diagonally opposite the active cell. When using this 
Shift+click technique to mark a range that extends beyond the screen, use the 
scroll bars to display the last cell in the range. (Just make sure that you don’t 
release the Shift key until after you’ve clicked this last cell.)

 » To select a nonadjacent selection consisting of several discontinuous cell 
ranges, drag through the first cell range and then hold down the Ctrl key as 
you drag through the other ranges. After you have marked all the cell ranges 
to be included in the nonadjacent selection, you can release the Ctrl key.

The Ctrl key can work with the mouse like an add or subtract key in Excel. As an 
add key, you use it to include non-neighboring objects in the current worksheet. 
See the section “Selecting cells with the keyboard,” later in this chapter. By using 
the Ctrl key, you can add to the selection of cells in a worksheet without having 
to deselect those already selected. To use the Ctrl key to deselect a range of cells 
within the current cell selection, hold down Ctrl and drag through the range that 
you want to deselect (subtract from the selected range) before releasing the mouse 
button and Ctrl key.
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Selecting cells by touch
If you’re running Excel on a touchscreen device without the benefit of a mouse or 
physical keyboard, you can use your finger or stylus to make your cell selections:

 » Tap the first cell in the selection (the equivalent of clicking with a mouse). 
Selection handles (with the circle icons) appear in the upper-left and lower-
right corner of the selected cell. Drag or swipe one of the selection handles 
through the rest of the adjacent cells to extend the cell selection and select 
the entire range.

 » Tap the first cell and then drag the white-cross pointer to the last cell in the 
selection.

Selecting cells with the keyboard
Excel also makes it easy for you to select cell ranges with a physical or Touch key-
board by using a technique known as extending a selection. To use this technique, 
you move the cell cursor to the active cell of the range; then press F8 to turn on 
Extend Selection mode (indicated by Extend Selection on the Status bar) and use 
the direction keys to move the pointer to the last cell in the range. Excel selects 
all the cells that the cell cursor moves through until you turn off Extend Selection 
mode (by pressing F8 again).

You can use the mouse as well as the keyboard to extend a selection when Excel 
is in Extend Selection mode: Click the active cell, press F8, and then click the last 
cell to mark the range.

You can also select a cell range with the keyboard without turning on Extend 
Selection mode. Here, you use a variation of the Shift+click method by moving the 
cell pointer to the active cell in the range, holding down the Shift key, and then 
using the direction keys to extend the range. After you’ve highlighted all the cells 
that you want to include, release the Shift key.

To mark a nonadjacent selection of cells with the keyboard, you need to combine 
the use of Extend Selection mode with that of Add to Selection mode. To turn on 
Add to Selection mode (indicated by Add to Selection on the status bar), you press 
Shift+F8. To mark a nonadjacent selection by using Extend Selection and Add to 
Selection modes, follow these steps:

1. Move the cell cursor to the first cell of the first range you want to select.

2. Press F8 to turn on Extend Selection mode.
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3. Use the arrow keys to extend the cell range until you’ve highlighted all its 
cells.

4. Press Shift+F8 to turn off Extend Selection mode and turn on Add to 
Selection mode instead.

5. Move the cell cursor to the first cell of the next cell range you want to 
add to the selection.

6. Press F8 to turn off Add to Selection mode and turn Extend Selection 
mode back on.

7. Use the arrow keys to extend the range until all cells are highlighted.

8. Repeat Steps 4 through 7 until you’ve selected all the ranges that you 
want included in the nonadjacent selection.

9. Press F8 to turn off Extend Selection mode.

Selecting cells with AutoSelect
Excel’s AutoSelect feature provides a particularly efficient way to select all or part 
of the cells in a large table of data. AutoSelect automatically extends a selection in 
a single direction from the active cell to the first nonblank cell that Excel encoun-
ters in that direction.

You can use the AutoSelect feature with the mouse and a physical keyboard. The 
general steps for using AutoSelect to select a table of data with the mouse are as 
follows:

1. Click the first cell to which you want to anchor the range that you are 
about to select.

In a typical table, this cell may be the blank cell at the intersection of the row of 
column headings and the column of row headings.

2. Position the mouse pointer on the edge of the cell in the direction you 
want to extend the range.

To extend the range up to the first blank cell to the right, position the mouse or 
Touch pointer on the right edge of the cell. To extend the range left to the first 
blank cell, position the pointer on the left edge of the cell. To extend the range 
down to the first blank cell, position the pointer on the bottom edge of the cell. 
And to extend the range up to the first blank cell, position the pointer on the 
top edge of the cell.
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3. When the pointer changes shape from a cross to a four-headed arrow, 
hold down the Shift key and then double-click the mouse.

As soon as you double-click the mouse or Touch pointer, Excel extends the 
selection to the first occupied cell that is adjacent to a blank cell in the direction 
of the edge that you double-clicked.

To get an idea of how AutoSelect works, consider how you use it to select all the 
data in the table (cell range A3:J8) shown in Figures 2-2 and 2-3 (sample work-
book: Production Schedule 2022.xlsx for both). You can use the AutoSelect feature 
to select all the cells in the table in two operations:

 » In the first operation, select cell A2, hold down the Shift key, and then 
double-click the bottom edge of cell A2 to highlight the cells down to A6, 
selecting the range A2:A6. (See Figure 2-2.)

 » In the second operation, hold down the Shift key and then double-click the 
right edge of cell range A2:A6 to extend the selection to the last column in the 
table (selecting the entire table with the cell range A2:J6, as shown in 
Figure 2-3).

FIGURE 2-2:  
Selecting the cells 

in the first  
column of 

the table with 
 AutoSelect.  

(Sample 
 workbook: 
 Production 

 Schedule  
2022.xlsx)

FIGURE 2-3:  
Selecting all 

the  remaining 
 columns of 

the table with 
 AutoSelect.  

(Sample 
 workbook:  
Production 

Schedule  
2022.xlsx)
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If you select the cells in the first row of the table (range A2:J2) in the first operation, 
you can then extend this range down the remaining rows of the table by double-
clicking the bottom edge of one of the selected cells. (It doesn’t matter which one.)

To use the AutoSelect feature with the keyboard, press the End key and one of the 
four arrow keys as you hold down the Shift key. When you hold down Shift and 
press End and an arrow key, Excel extends the selection in the direction of the 
arrow key to the first cell containing a value that is bordered by a blank cell.

In terms of selecting the table of data shown in Figures 2-2 and 2-3, this means 
that you would have to complete the following steps to select all of its cells:

1. With A2 as the active cell, hold down Shift and press End+↓ to select the 
range A2:A6.

Excel stops at A6 because this is the last occupied cell in that column. At this 
point, the cell range A2:A6 is selected.

2. Hold down Shift and then press End+ →.

Excel extends the range all the way to column J (because the cells in column J 
contain entries bordered by blank cells). Now all the cells in the table (the cell 
range A2:J6) are selected.

Selecting cells with Go To
Although you usually use the Go To feature to move the cell cursor to a new cell 
in the worksheet, you can also use this feature to select a range of cells. On the 
Ribbon’s Home tab, click the Find & Select button’s drop-down menu and then 
click Go To (or press Ctrl+G or F5). Excel displays a Go To dialog box similar to 
the one shown in Figure 2-4. To move the cell cursor to a particular cell, enter the 
cell address in the Reference text box and click OK. (Excel automatically lists the 
addresses of the last four cells or cell ranges that you specified in the Go To list box.)

FIGURE 2-4:  
Selecting a cell 

range with the Go 
To dialog box.
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Instead of just moving to a new section of the worksheet with the Go To feature, 
you can select a range of cells by taking these steps:

1. Select the first cell of the range.

This becomes the active cell to which the cell range is anchored.

2. On the Ribbon’s Home tab, in the Editing group, click the Find & Select 
command and then click Go To from its drop-down menu or press 
Alt+HFDG, Ctrl+G, or F5.

The Go To dialog box opens.

3. Type the cell address of the last cell in the range in the Reference 
text box.

If this address is already listed in the Go To list box, you can enter this address 
in the text box by clicking it in the list box.

4. Hold down the Shift key as you click OK or press Enter to close the Go To 
dialog box.

By holding down Shift as you click OK or press Enter, you select the range 
between the active cell and the cell whose address you specified in the 
Reference text box.

Instead of selecting the anchor cell and then specifying the last cell of a range in 
the Reference text box of the Go To dialog box, you can also select a range by typ-
ing the address of the cell range in the Reference text box. Remember that when 
you type a range address, you enter the cell reference of the first (active) cell 
and the last cell in the range separated by a colon. For example, to select the cell 
range that extends from cell B2 to G10 in the worksheet, you would type the range 
address B2:G10 in the Reference text box before clicking OK or pressing Enter.

Name that range!
One of the easiest ways to select a range of data is to assign a name to it and then 
click that name on the pop-up menu attached to the Name box on the Formula bar 
or in the Go To list box in the Go To dialog box. Of course, you reserve this tech-
nique for cell ranges that you work with on a somewhat regular basis; for exam-
ple, ranges with data that you print regularly, consult often, or have to refer to in 
formula calculations. It’s probably not worth your while to name a range of data 
that doesn’t carry any special importance in the worksheet.
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To name a cell range, follow three simple steps:

1. Select all the cells in the range that you intend to name.

You can use any of the cell selection techniques that you prefer. When 
selecting the cells for the named range, be sure to include all the cells that you 
want selected each time you select its range name.

2. Click the Name box on the Formula bar.

Excel automatically highlights the address of the active cell in the selected 
range.

3. Type the range name in the Name box and then press Enter.

As soon as you start typing, Excel replaces the address of the active cell with 
the range name that you’re assigning. As soon as you press the Enter key, the 
name appears in the Name box instead of the cell address of the active cell in 
the range.

When naming a cell range, however, you must observe the following naming 
conventions:

 » Begin the range name with a letter of the alphabet rather than a number or 
punctuation mark.

 » Don’t use spaces in the range name; instead, use an underscore between 
words in a range name (as in Qtr_1).

 » Make sure that the range name doesn’t duplicate any cell reference in the 
worksheet by using either the standard A1 or R1C1 notation system.

 » Make sure that the range name is unique in the workbook.

The beauty of this method is that you can use it from anywhere in the same sheet 
or a different worksheet in the workbook because as soon as you click its name 
on the Name box pop-up menu, Excel takes you directly to the range, while at the 
same time automatically selecting all its cells.

Range names are also very useful when building formulas in your worksheet. For 
more on creating and using range names, see Book 3, Chapter 1.

If you’re using a touchscreen device without access to a mouse or physical key-
board, I can’t recommend highly enough naming cell ranges that you regularly 
select for editing or printing in Excel. Tapping the range name on the Name box’s 
drop-down menu to select a large and distant cell range in a worksheet on the 
normally very small and cramped screen of a Windows tablet is so far superior to 
futzing with the cell’s selection handles to select the range that it’s just not funny!
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Adjusting Columns and Rows
Along with knowing how to select cells for formatting, you really also have to 
know how to adjust the width of your columns and the heights of your rows. Why? 
Because often in the course of assigning different formatting to certain cell ranges 
(such as new font and font size in boldface type), you may find that data entries 
that previously fit within the original widths of their column no longer do and that 
the rows that they occupy seem to have changed height all on their own.

In a blank worksheet, all the columns and rows are the same standard width and 
height. The actual number of characters or pixels depends upon the aspect ratio 
of the device upon which you’re running Excel. On most computer monitors, all 
Excel worksheet columns start out 8.47 characters wide (or 136 pixels at a 3240 x 
2160 display resolution), and all rows start out 14.30 points high (or 38 pixels). On 
a smaller touchscreen, Excel worksheet columns start out at 8.09 characters wide 
(or 96 pixels, given their distinctive aspect ratio) with rows at 13.50 characters or 
27 pixels high.

As you build your worksheet, you end up with all sorts of data entries that can’t fit 
within these default settings. This is especially true as you start adding formatting 
to their cells to enhance and clarify their contents.

Most of the time, you don’t need to be concerned with the heights of the rows in 
your worksheet because Excel automatically adjusts them up or down to accom-
modate the largest font size used in a cell in the row and the number of text lines 
(in some cells, you may wrap their text on several lines). Instead, you’ll spend a 
lot more time adjusting the column widths to suit the entries for the formatting 
that you assign to them.

Remember what happens when you put a text entry in a cell whose current width 
isn’t long enough to accommodate all its characters. If the cells in columns to the 
right are empty, Excel lets the display of the extra characters spill over into the 
empty cells. If these cells are already occupied, however, Excel cuts off the display 
of the extra characters until you widen the column sufficiently. Likewise, remem-
ber that if you add formatting to a number so that its value and formatting can’t 
both be displayed in the cell, those nasty overflow indicators appear in the cell as 
a string of pound signs (#####) until you widen the column adequately.

Fitting the column to its contents 
automatically
The easiest way to adjust the width of a column to suit its longest entry is to 
use the AutoFit feature. AutoFit examines the content in the selected column or 
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columns and then adjusts the width of each column so that it’s just a bit wider 
than the column’s longest entry.

 » To use AutoFit on a single column: Position the mouse pointer on the right 
edge of that column in the column header and then, when the pointer 
changes to a double-headed arrow, double-click the mouse or double-tap 
your finger or stylus.

 » To use AutoFit on multiple columns at one time: Select the columns by 
dragging through them in the column header or by Ctrl+clicking the column 
letters and then double-clicking the right edge of one of the selected columns 
when the pointer changes to a double-headed arrow.

These AutoFit techniques work well for adjusting all columns except for those that 
contain really long headings (such as the worksheet title that often spills over 
several blank columns in row 1), in which case AutoFit makes the columns far too 
wide for the bulk of the cell entries.

For those situations, use the AutoFit Column Width command, which adjusts the 
column width to suit only the entries in the cells of the column that you have 
selected. This way, you can select all the cells except for any really long ones in the 
column that purposely spill over to empty cells on the right, and then have Excel 
adjust the width to suit. Select the cells in the column that you want the new width 
to fit, click the Home tab, click the Format button in the Cells group, and then click 
AutoFit Column Width (or press Alt+HOI).

Adjusting columns the old-fashioned way
AutoFit is nothing if not quick and easy. If you need more precision in adjusting 
your column widths, you have to do this manually either by dragging its border 
with the mouse or by entering new values in the Column Width dialog box.

 » To manually adjust a column width with the mouse: Drag the right edge of 
that column onto the Column header to the left (to narrow) or to the right (to 
widen) as required. As you drag the column border, a ScreenTip appears 
above the mouse pointer indicating the current width in both characters and 
pixels. When you have the column adjusted to the desired width, release the 
mouse button to set it.

 » To manually adjust a column width by touch: Tap the right edge of the 
column header with your finger or stylus to select the column and make the 
black, double-header pointer appear. Then swipe the pointer left or right as 
needed. As you swipe, the Name box on the Formula bar indicates the current 
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width in characters and pixels. When you have the column adjusted to the 
desired width, remove your finger or stylus from the touchscreen.

To make this operation easier, remember that you can instantly zoom in  
on the column border by stretching your forefinger and thumb on the 
touchscreen — doing this makes the column letter area larger, making it a lot 
easier to tap and swipe the border left and right with your finger or stylus.

 » To adjust a column width in the Column Width dialog box: Position the cell 
pointer in any one of the cells in the column that you want to adjust, click the 
Home tab, click the Format button in the Cells group, and then click Column 
Width to open the Column Width dialog box (or press Alt+HOW). Enter the 
new width (in the number of characters between 0 and 255) in the Column 
Width text box and then click OK.

You can apply a new column width that you set in the Column Width dialog box to 
more than a single column by selecting the columns (either by dragging through 
their letters on the Column header or holding down Ctrl as you click them) before 
you open the Column Width dialog box.

Setting a new standard width
You can use the Default Standard Width command to set all the columns in a 
worksheet to a new uniform width (other than the default 8.43 or 8.09 charac-
ters). To do so, click the Home tab, click the Format button in the Cells group, and 
then click Default Width (or press Alt+HOD). Doing this opens the Standard Width 
dialog box where you can replace the default value in the Standard Column Width 
text box with your new width (in characters) and then click OK or press Enter.

Note that when you set a new standard width for the columns of your work-
sheet, this new width doesn’t affect any columns whose width you’ve previously 
adjusted either with AutoFit or in the Column Width dialog box.

Hiding out a column or two
You can use the Hide command to temporarily remove columns of data from the 
worksheet display. When you hide a column, you’re essentially setting the column 
width to 0. Hiding columns enables you to remove the display of sensitive or sup-
porting data that needs to be in the worksheet but may not be appropriate when 
you share your screen with others.

To hide a column, put the cell pointer in a cell in that column; to hide more than 
one column at a time, select the columns either by dragging through their let-
ters on the Column header or by holding down Ctrl as you click them. Click the 
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Home tab, click the Format button in the Cells group, and then choose Hide & 
Unhide ➪ Hide Columns (or you can just press Alt+HOUC).

Excel lets you know that certain columns are missing from the worksheet by 
removing their column letters from the Column header so that if, for example, 
you hide columns D and E in the worksheet, column C is followed by column F on 
the Column header.

To restore hidden columns to view, select the visible columns on either side of the 
hidden one(s) — indicated by the missing letter(s) on the column headings — and 
then click the Home tab, click the Format button in the Cells group, and then click 
Hide & Unhide ➪ Unhide Columns (or press Alt+HOUL).

Because Excel also automatically selects all the redisplayed columns, you need to 
deselect these columns before you do any formatting or editing that will affect all 
their cells. To deselect the columns, click a single cell anywhere in the worksheet 
or select whatever cell range that you want to work with.

When you hide a column, the data in the cells in all its rows (1 through 1,048,576) 
are hidden (not just the ones you can see on your computer screen). This means 
that if you have some data in rows of a column that need printing and some in 
other rows of that same column that need concealing, you can’t use the Hide 
command to remove their display until you’ve moved the cells with the data to be 
printed into a different column. (See Book 2, Chapter 5 for details.)

Rambling rows
The controls for adjusting the height of the rows in your worksheet parallel those 
that you use to adjust its columns. The big difference is that Excel always applies 
AutoFit to the height of each row so that even though you find an AutoFit Row 
Height option under Cell size on the Format button’s drop-down menu, you won’t 
find much use for it.

Instead, you’ll probably end up manually adjusting the heights of rows with the 
mouse or by entering new height values and occasionally hiding rows with sen-
sitive or potentially confusing data. Follow these instructions for each type of 
action:

 » To adjust the height of a row with the mouse: Position the mouse on the 
lower edge of the row’s border in the Row header and then drag up or down 
when the mouse pointer changes to a double-headed, vertical arrow. As you 
drag, a ScreenTip appears to the side of the pointer, keeping you informed of 
the height in characters and also in pixels. (Remember that 14.3 points or 38 
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pixels is the default height of all rows in a new worksheet at a 3240 x 2160 
display resolution.)

 » To manually adjust the height of a row by touch: Tap the lower edge of the 
row border with your finger or stylus to select the row and make the black, 
double-header pointer appear. Then swipe the pointer up or down as needed. 
As you swipe, the Name box on the Formula bar indicates the current row 
height in characters and pixels. When you have the row adjusted to the 
desired height, remove your finger or stylus from the touchscreen.

To make this operation easier, remember that you can instantly zoom in on 
the row border by stretching your forefinger and thumb on the touchscreen — 
doing this makes the row number area larger, making it a lot easier to tap and 
swipe the border up and down with your finger or stylus.

 » To change the height of a row in the Row Height dialog box: Click the 
Home tab, click the Format button in the Cells group, and then click Row 
Height (or press Alt+HOH). Enter the value for the new row height in the Row 
Height text box and then click OK.

 » To hide a row: Position the cell cursor in any one of the cells in that row and 
then click the Home tab, click the Format button in the Cells group, and then 
click Hide & Unhide ➪ Hide Rows from the drop-down menu (or press 
Alt+HOUR). To then restore the rows that you currently have hidden in the 
worksheet, select the rows above and below the hidden rows, click the Home 
tab, click the Format button, and then click Hide & Unhide ➪ Unhide Rows (or 
press Alt+HOUO, instead).

As with adjusting columns, you can change the height of more than one row and 
hide multiple rows at the same time by selecting the rows before you drag one of 
their lower borders, open the Row Height dialog box, or choose Format ➪ Hide & 
Unhide ➪ Hide Rows on the Home tab, or press Alt+HOUR.

Formatting Tables from the Ribbon
Excel’s Format as Table feature enables you to both define an entire range of 
data as a table and format all its data all in one operation. After you define a cell 
range as a table, you can completely modify its formatting by clicking a new style 
thumbnail in the Table Styles gallery. Excel also automatically extends this table 
definition — and consequently its table formatting — to all the new rows you 
insert within the table and add at the bottom as well as any new columns you 
insert within the table or add to either the table’s left or right end.
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The Format as Table feature is so automatic that, to use it, you position the cell 
pointer somewhere within the range of data, and then click the Home tab’s For-
mat as Table command. Excel opens its rather extensive Table Styles gallery with 
the formatting thumbnails divided into three sections  — Light, Medium, and 
Dark — each of which describes the intensity of the colors used by its various 
formats. (See Figure 2-5.)

When you click one of the table formatting thumbnails in the Table Styles gallery, 
Excel makes its best guess as to the cell range of the table to apply it to (indicated 
by the marquee around its perimeter), and the Create Table dialog box similar to 
the one shown in Figure 2-6 appears.

FIGURE 2-5:  
Selecting a  format 
for the new table 

in the Table Styles 
gallery.

FIGURE 2-6:  
Indicating the 

range of the table 
in the Create 

Table dialog box 
after selecting 

the style of table 
format.
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This dialog box contains a Where Is the Data for Your Table? text box that shows 
the address of the cell range currently selected by the marquee and a My Table Has 
Headers check box (selected by default).

If Excel does not correctly guess the range of the data you want to format, drag 
through the cell range to adjust the marquee and the range address in the Where 
Is the Data for Your Table? text box. If your data doesn’t use column headers, 
deselect the My Table Has Headers check box. When you click OK, Excel adds its 
own column headings (Column1, Column2, Column3, and so forth) as the top row 
of the new table.

The table formats in the Table Styles gallery aren’t available if you select multiple 
nonadjacent cells before you click the Format as Table command. You can convert 
only one range of cell data into a table at a time.

After you click OK in the Create Table dialog box, Excel applies the format of the 
thumbnail you clicked in the gallery to the range, and the command buttons on 
the Table Design tab appear on the Ribbon. (See Figure 2-7; sample workbook: 
Production Schedule 2022.xlsx.)

As you can see in Figure 2-7, when Excel defines a range as a table, it automati-
cally adds AutoFilter drop-down buttons to each of the column headings (the little 
buttons with a triangle pointing downward in the lower-right corner of the cells 
with the column labels). To hide these AutoFilter buttons, click the Data tab’s 
Filter button or press Alt+AT. (You can always redisplay them by clicking the Data 
tab’s Filter button or by pressing Alt+AT a second time.)

FIGURE 2-7:  
After you select 

an initial table 
format, the 

Table Design tab 
appears. (Sample 

 workbook: 
 Production 

Schedule  
2022.xlsx)
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The Table Design contextual tab enables you to use the Live Preview feature to 
see how your table data would appear in other table styles. Click the Quick Styles 
button and then highlight any of the format thumbnails in the gallery with the 
mouse or Touch pointer to see the data in your table appear temporarily in that 
table format.

The Table Design tab also contains a Table Style Options group you can use to 
further customize the look of the selected format. The Table Style Options group 
contains the following check boxes:

 » Header Row: Toggles the header row of the table.

 » Total Row: Add a Total row to the bottom of the table that displays the sum 
of the last column of the table (assuming that it contains values). To apply a 
Statistical function other than Sum to the values in a particular column of the 
new Total row, click the cell in that column’s Total row. Doing this displays a 
drop-down list — None, Average, Count, Count Numbers, Max, Min, Sum, 
StdDev (Standard Deviation), Var (Variance), or More Functions — on which 
you click the new function to use.

 » Banded Rows: Apply shading to every other row in the table.

 » First Column: Display the row headings in the first row of the table in bold.

 » Last Column: Display the row headings in the last row of the table in bold.

 » Banded Columns: Apply shading to every other column in the table.

Whenever you assign a format in the Table Styles gallery to one of the tables 
in your workbook, Excel automatically assigns that table a generic range name 
(Table1, Table2, and so on). You can use the Table Design tab’s Table Name text 
box (it’s in the Properties group) to rename the table with a more descriptive 
name.

When you finish selecting and/or customizing the formatting of your table, click 
a cell outside of the table to remove the Table Design contextual tab from the 
Ribbon. If you later decide that you want to further experiment with the table’s 
formatting, click any of the table’s cells to redisplay the Table Design contextual 
tab at the end of the Ribbon.
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Formatting Tables with the Quick 
Analysis Tool

You can use Excel’s handy Quick Analysis tool to quickly format a range of data 
as a new table. Select all the cells in the range, including the cells in the first row 
with the column headings. The Quick Analysis tool appears in the lower-right 
corner of the cell selection (the outlined button with the lightning bolt striking 
the selected data icon). Click this tool to open the Quick Analysis options palette, 
which displays five tabs (Formatting, Charts, Totals, Tables, and Sparklines).

Click the Tables tab in the Quick Analysis tool’s option palette to display its Table 
and PivotTable buttons. When you move the mouse pointer over the Table but-
ton on the Tables tab, Excel’s Live Preview shows you how the selected data will 
appear formatted as a table. Figure  2-8 shows an example (sample workbook: 
MGE Q1 Sector Sales.xlsx). To apply this previewed formatting and format the 
selected cell range as a table, you only have to click the Table button.

When you click the Table button, the Quick Analysis options palette disappears, 
Excel converts the range to a table, and the Table Design contextual tab appears on 
the Ribbon. You can then use its Quick Styles drop-down gallery to select a differ-
ent formatting style for your table. (The Tables button on the Quick Analysis tool’s 
Tables tab offers only the one blue medium style shown in the Live Preview.)

FIGURE 2-8:  
Previewing the 

selected data 
formatted as a 
table with the 

Quick Analysis 
tool. (Sample 

workbook: MGE 
Q1 Sector Sales.

xlsx)
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Formatting Cells from the Ribbon
Some worksheet data require a lighter touch than formatting as a table offers. For 
example, you may have a range where the only emphasis you want to add is to 
apply bold to a row of headings at the top of the range and to underline a row of 
totals at the bottom (done by drawing a borderline along the bottom of the cells).

In the Ribbon’s Home tab, the formatting buttons that appear in the Font, Align-
ment, and Number groups enable you to accomplish just this kind of targeted 
cell formatting. See Table 2-1 for a complete rundown on the use of each of these 
formatting buttons.

TABLE 2-1 The Formatting Command Buttons in the Home Tab’s Font,  
Alignment, and Number Groups

Group Button Name Function Hot Keys

Font

Font Displays a Font drop-down menu from which you 
can assign a new font for the entries in your cell 
selection.

Alt+HFF

Font Size Displays a Font Size drop-down menu from which 
you can assign a new font size to the entries in 
your cell selection. Click the Font Size text box and 
enter the desired point size if it doesn’t appear on 
the drop-down menu.

Alt+HFS

Increase Font Size Increases the font size of the entries in your cell 
selection.

Alt+HFG

Decrease Font Size Decreases the font size of the entries in your cell 
selection.

Alt+HFK

Bold Applies and removes boldface in the entries in 
your cell selection.

Alt+H1

Italic Applies and removes italics in the entries in your 
cell selection.

Alt+H2

Underline Applies and removes underlining in the entries in 
your cell selection.

Alt+H3U (single) 
or Alt+H3D 
(for double)

Borders Opens a Borders drop-down menu from which 
you can assign a new border style to or remove 
an existing border style from your cell selection.

Alt+HB

Fill Color Opens a drop-down Color palette from which you 
can assign a new background color for your cell 
selection.

Alt+HH
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Group Button Name Function Hot Keys

Font Color Opens a drop-down Color palette from which you 
can assign a new font color for the entries in your 
cell selection.

Alt+HFC

Alignment

Top Align Aligns the entries in your cell selection with the 
top border of their cells.

Alt+HAT

Middle Align Vertically centers the entries in your cell selection 
between the top and bottom borders of 
their cells.

Alt+HAM

Bottom Align Aligns the entries in your cell selection with the 
bottom border of their cells.

Alt+HAB

Orientation Opens a drop-down menu with options for 
changing the angle and direction of the entries in 
your cell selection.

Alt+HFQ

Wrap Text Wraps all entries in your cell selection that spill 
over their right borders onto multiple lines within 
the current column width.

Alt+HW

Align Left Aligns all the entries in your cell selection with the 
left edge of their cells.

Alt+HAL

Center Centers all the entries in your cell selection within 
their cells.

Alt+HAC

Align Right Aligns all the entries in your cell selection with the 
right edge of their cells.

Alt+HAR

Decrease Indent Decreases the margin between entries in your 
cell selection and their left cell borders by one 
character.

Alt+H5 or 
Ctrl+Alt+Shift+Tab

Increase Indent Increases the margin between the entries in your 
cell selection and their left cell borders by one 
character.

Alt+H6 or 
Ctrl+Alt+Tab

Merge & Center Merges your cell selection into a single cell and 
then centers the combined entry in the first cell 
between its new left and right borders. Click the 
Merge and Center drop-down button to display a 
menu of options that enable you to merge the cell 
selection into a single cell without centering the 
entries, as well as to split up a merged cell back 
into its original individual cells.

Alt+HMC

(continued)
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Don’t forget the shortcut keys: Ctrl+B for toggling bold in the cell selection, Ctrl+I 
for toggling italics, and Ctrl+U for toggling underlining.

Formatting Cell Ranges with the 
Mini-Toolbar

Excel makes it easy to apply common formatting changes to a cell selection right 
within the Worksheet area thanks to its mini-toolbar feature. To display the mini-
toolbar, select the cells that need formatting and then right-click somewhere in 

TABLE 2-1 (continued)

Group Button Name Function Hot Keys

Number

Number Format Displays the number format applied to the active 
cell in your cell selection. Click its drop-down 
button to open a drop-down menu where you can 
assign one of Excel’s major Number formats to 
the cell selection.

Alt+HN

Accounting 
Number Format

Opens a drop-down menu from which you can 
select the currency symbol to be used in the 
Accounting number format. When you select 
the $ English (United States) option, this format 
adds a dollar sign, uses commas to separate 
thousands, displays two decimal places, and 
encloses negative values in a closed pair of 
parentheses. Click More Accounting Formats to 
open the Number tab of the Format Cells dialog 
box where you can customize the number of 
decimal places and/or currency symbol used.

Alt+HAN

Percent Style Formats your cell selection using the Percent 
Style number format, which multiplies the values 
by 100 (for display purposes only) and adds a 
percent sign with no decimal places.

Alt+HP

Comma Style Formats your cell selection with the Comma Style 
Number format, which uses commas to separate 
thousands, displays two decimal places, and 
encloses negative values in a pair of parentheses.

Alt+HK

Increase Decimal Adds a decimal place to the values in your cell 
selection.

Alt+H0 (zero)

Decrease Decimal Removes a decimal place from the values in your 
cell selection.

Alt+H9
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the cell selection. The mini-toolbar then appears immediately below or above the 
cell selection’s shortcut menu. (See Figure 2-9.)

The mini-toolbar contains most of the buttons from the Home tab’s Font group 
(with the exception of the Underline button). It also contains the Center but-
ton and the Merge & Center button from the Alignment group (see “Altering the 
alignment” later in this chapter), and the Accounting Number Format, Percent 
Style, Comma Style, Increase Decimal, and Decrease Decimal buttons from the 
Number group. Click these buttons to apply their formatting to the current cell 
selection.

The mini-toolbar also contains the Format Painter button from the Clipboard 
group of the Home tab, which you can use to copy the formatting in the active cell 
to a cell selection you make. (See “Hiring Out the Format Painter” later in this 
chapter for details.)

To display the mini-toolbar on a touchscreen device, tap and hold any cell in the 
selected range with your finger. Note that the mini-toolbar that appears is dif-
ferent than the one you see when you right-click a cell selection with a physical 
mouse. The touchscreen mini-toolbar contains a single row of command but-
tons that combine editing and formatting functions — Paste, Cut, Copy, Clear, Fill 
Color, Font Color, and AutoFill followed by a Show Context Menu button (with a 

FIGURE 2-9:  
Right-click your 

cell selection 
to display its 

 shortcut menu 
along with the 

mini-bar, which 
you can use 

to format the 
selection.
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black triangle pointing downward). Tap the Show Context Menu button to display 
a pop-up menu of other editing and formatting options. Tap the Format Cells but-
ton on this menu to get access to all sorts of formatting options (see the section 
that follows for details).

Note that if your device has a stylus, tapping and holding a cell in the selected cell 
range displays the standard mini-toolbar just as though you were using a mouse.

Using the Format Cells Dialog Box
Although the command buttons in the Home tab’s Font, Alignment, and Number 
groups give you immediate access to the most commonly used formatting com-
mands, they don’t represent all of Excel’s formatting commands by any stretch 
of the imagination.

To access all the formatting commands, you need to open the Format Cells dialog 
box using any of the following methods:

 » Click the dialog box launcher that appears in the lower-right corner of the 
Home tab’s Font, Alignment, or Number tab.

 » In the Home tab’s Cells group, choose Format ➪ Format Cells.

 » Press Ctrl+1 or Alt+HOE.

The Format Cells dialog box contains six tabs: Number, Alignment, Font, Border, 
Fill, and Protection. (In this chapter, I show you how to use them all except the 
Protection tab; for information on that tab, see Book 4, Chapter 1.)

Assigning number formats
When you enter numbers in a cell or a formula that returns a number, Excel  
doesn’t change whatever number format is already applied to the cell. If no num-
ber format is applied, then Excel uses the General number format. The General 
format displays numeric entries more or less as you enter them. However, the 
General format does make the following changes to your numeric entries:

 » Drops any trailing zeros from decimal fractions so that 4.5 appears when you 
enter 4.50 in a cell.

 » Drops any leading zeros in whole numbers so that 7 appears when you enter 
007 in a cell.
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 » Inserts a zero before the decimal point in any decimal fraction without a 
whole number so that 0.123 appears when you enter .123 in a cell.

 » Truncates decimal places in a number to display the whole numbers in a cell 
when the number contains too many digits to be displayed in the current 
column width. It also converts the number to scientific notation when the 
column width is too narrow to display all integers in the whole number.

Remember that you can always override the General number format when you 
enter a number by entering the characters used in recognized number formats. 
For example, to enter the value 2500 and assign it the Currency number format 
that displays two decimal places, you enter $2,500.00 in the cell.

Note that although you can override the General number format and assign one of 
the others to any numeric value that you enter into a cell, you can’t do this when 
you enter a formula into a cell. To apply another format to a calculated result, 
select a format using the buttons in the Home tab’s Number group, or use the 
Number tab of the Format Cells dialog box. I discuss the latter in more detail in 
the sections that follow.

Using one of the predefined number formats
When you first open the Format Cells dialog box with a range of newly entered 
data selected, the General category of number formats is highlighted in the Cat-
egory list box with the words “General format cells have no specific number for-
mat” showing in the area to the right. Directly above this cryptic message (which 
is Excel-speak for “We don’t care what you’ve put in your cell; we’re not changing 
it!”) is the Sample area. This area shows how the number in the active cell appears 
in whatever format you choose. (This is blank if the active cell is blank or if it con-
tains text instead of a number.)

WHAT YOU SEE IS NOT ALWAYS  
WHAT YOU GET
The number format that you assign to cells with numeric entries in the worksheet 
affects only the way they are displayed in their cells and not their underlying values. For 
example, if a formula returns the value 3.456789 in a cell and you apply a number for-
mat that displays only two decimal places, Excel displays the value 3.46 in the cell. If you 
then refer to the cell in a formula that multiplies its value by 2, Excel returns the result 
6.913578 instead of the result 6.92, which would be the result if Excel was actually mul-
tiplying 3.46 by 2. If you want to modify the rounded value in a cell, you use the ROUND 
function. (See Book 3, Chapter 5 for details.)
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When you click the Number, Currency, Accounting, or Percentage category in the 
Category list box, more options appear in the area just to the right of the Cate-
gory list box in the form of different check boxes, list boxes, and spinner buttons.  
(Figure 2-10 shows the Format Cells dialog box when Currency is selected in the 
Category list.) These options determine how you want items such as decimal 
places, dollar signs, comma separators, and negative numbers to be used in the 
format category that you’ve chosen.

When you choose the Date, Time, Fraction, Special, or Custom category, a large 
Type list box appears that contains handfuls of predefined category types, which 
you can apply to your value to change its appearance. Just like when you’re select-
ing different formatting categories, the Sample area of the Format Cells dialog box 
shows you how the various category types will affect your selection.

I should note here that Excel always tries to choose an appropriate format cat-
egory in the Category list box based on the way you entered your value in the 
selected cell. If you enter 3:00 in a cell and then open the Number tab of the For-
mat Cells dialog box (Ctrl+1), Excel highlights the h:mm time format in the Cus-
tom category in the Type list box.

Deciphering the Custom number formats
You probably noticed while playing around selecting different formats in the Cat-
egory list box that, for the most part, the different categories and their types 
are straightforward. For most people, that self-assured feeling goes right out the 

FIGURE 2-10:  
Options for 

customizing 
the formatting 

assigned by the 
Currency number 

format.
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window as soon as they click the Custom category and get a load of its accompa-
nying Type list box, shown in Figure 2-11. It starts off with the nice word General, 
then 0, then 0.00, and after that, things get very weird. Codes with 0s and #s (and 
other junk) start to appear, and it only goes downhill from there.

As you move down the list, the longer codes are divided into sections separated 
by semicolons and enclosed within square brackets. Although at first glance these 
codes appear as gibberish, you’ll actually find that they’re quite understandable. 
(Well, would you believe useful, then?)

And these codes can be useful, especially after you understand them. You can use 
them to create number formats of your own design. The basic keys to understand-
ing number format codes are as follows:

 » Excel number formats use a combination of the 0, ?, and # symbols (along 
with punctuation such as dollar signs, percent signs, and commas) to stand 
for the formatted digits in the numbers that you format.

 » The 0 is a placeholder for a digit that tells Excel to display the digit exactly as it 
appears in the cell; if no digit appears for a particular 0 placeholder, Excel 
displays 0. For example, if the number format is 000.0 and the cell contains 
12.3, you see 012.3 in the cell.

FIGURE 2-11:  
You can create 

your own number 
format using the 
Custom category 

in the Format 
Cells dialog box.
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 » The ? is used like the 0 except that it inserts spaces at the end as needed to 
make sure that values line up on the decimal point. For example, by entering 
the number format 0.??, such values as 10.5 and 24.71 line up with each other 
in their cells because Excel adds an extra space after the 5 to push it over to 
the left so that it’s in line with the 7 of 71. If you used the number format 0.00 
instead, these two values would not line up on the decimal point when they 
are right-aligned in their cells.

 » The # symbol is a placeholder for a digit that tells Excel to display the digit 
exactly as it appears in the cell; if no digit appears for a particular # place-
holder, Excel displays nothing. For example, if the number format is ###.## 
and the cell contains 12.3, you see 12.3 in the cell.

 » The $ (dollar sign) symbol is added to the beginning of a number format if you 
want dollar signs to appear at the beginning of every formatted number.

 » The % (percent sign) symbol is added to the end of the number format if you 
want Excel to actually transform the value into a percentage (multiplying it by 
100 and adding a percent sign).

Number formats can specify one format for positive values, another for negative 
values, a third for zero values, and even a fourth format for text in the cells. In 
such complex formats, the format codes for positive values come first, followed 
by the codes for negative values, and a semicolon separates each group of codes. 
Any format codes for how to handle zeros and text in a cell come third and fourth, 
respectively, in the number format, again separated by semicolons. If the number 
format doesn’t specify special formatting for negative or zero values, these values 
are automatically formatted like positive values. If the number format doesn’t 
specify what to do with text, text is formatted according to Excel’s default values. 
For example, look at the following number format:

#,##0_);(#,##0)

This particular number format specifies how to format positive values (the codes 
in front of the semicolon) and negative values (the codes after the semicolon). 
Because no further groups of codes exist, zeros are formatted like positive values, 
and no special formatting is applied to text.

If a number format puts negative values inside parentheses, the positive num-
ber format portion often pads the positive values with a space that is the same 
width as a right parenthesis. To indicate this, you add an underscore (by pressing 
Shift and the hyphen key) followed immediately by a closed parenthesis symbol. 
By padding positive numbers with a space equivalent to a right parenthesis, you 
ensure that digits of both positive and negative values line up in a column of cells.
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You can assign different colors to a number format. For example, you can create a 
format that displays the values in green (the color of money!) by adding the code 
[GREEN] at the beginning of the format. A more common use of color is to display 
just the negative numbers in red (ergo the saying “in the red”) by inserting the 
code [RED] right after the semicolon separating the format for positive numbers 
from the one for negative numbers. Color codes include [BLACK], [BLUE], [CYAN], 
[GREEN], [MAGENTA], [RED], [WHITE], and [YELLOW].

Date number formats use a series of abbreviations for month, day, and year that 
are separated by characters, such as a dash (—) or a slash (/). The code m inserts 
the month as a number; mmm inserts the month as a three-letter abbreviation, 
such as Apr or Oct; and mmmm spells out the entire month, such as April or  
October. The code d inserts the date as a number; dd inserts the date as a number 
with a leading zero, such as 04 or 07; ddd inserts the date as a three-letter abbre-
viation of the day of the week, such as Mon or Tue; and dddd inserts the full name 
of the day of the week, such as Monday or Tuesday. The code yy inserts the last 
two digits of the year, such as 22 or 23; yyyy inserts all four digits of the year, such 
as 2022, 2023, and so on.

Time number formats use a series of abbreviations for the hour, minutes, and 
seconds. The code h inserts the number of the hour; hh inserts the number of 
the hour with leading zeros, such as 02 or 06. The code m inserts the minutes; 
the code mm inserts the minutes with leading zeros, such as 01 or 09. The code s 
inserts the number of seconds; ss inserts the seconds with leading zeros, such as 
03 or 08. Add AM/PM or am/pm to have Excel tell time on a 12-hour clock, and add 
either AM (or am) or PM (or pm) to the time number depending on whether the 
date is before or after noon. Without these AM/PM codes, Excel displays the time 
number on a 24-hour clock, just like the military does. (For example, 2:00 PM on 
a 12-hour clock is expressed as 14:00 on a 24-hour clock.)

So that’s all you really need to know about making some sense of all those strange 
format codes that you see when you select the Custom category on the Number tab 
of the Format Cells dialog box.

Designing your own number formats
Armed with a little knowledge on the whys and wherefores of interpreting Excel 
number format codes, you’re ready to see how to use these codes to create your 
own custom number formats. The reason for going through all that code business 
is that, to create a custom number format, you have to type your own codes.
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To create a custom format, follow this series of steps:

1. Open a worksheet and enter a sample of the values or text to which you 
will be applying the custom format.

If possible, apply the closest existing format to the sample value as you enter it 
in its cell. (For example, if you’re creating a derivative of a Currency format, 
enter it with the dollar sign, commas, and decimal points that you know you’ll 
want in the custom format.)

2. Open the Format Cells dialog box and use its categories to apply the 
closest existing number format to the sample cell.

3. Click Custom in the Category list box and then edit the codes applied by 
the existing number format that you chose in the Type list box until the 
value in the Sample section appears exactly as you want it.

What could be simpler? Ah, but Step 3, there’s the rub: editing weird format codes 
and getting them just right so that they produce exactly the kind of number for-
matting that you’re looking for!

Actually, creating your own number format isn’t as bad as it first sounds, because 
you “cheat” by selecting a number format that uses as many of the codes as pos-
sible that you need in the new custom number that you’re creating. Then you use 
the Sample area to keep a careful eye on the results as you edit the codes in the 
existing number format. For example, suppose that you want to create a custom 
date format to use on the current date that you enter with Excel’s built-in NOW() 
function. (See Book 3, Chapter 3 for details.) You want this date format to display 
the full name of the current month (January, February, and so on), followed by 
two digits for the date and four digits for the year, such as November 06, 2022.

To do this, use the Insert Function button on the Formula bar to insert the NOW() 
function into a blank worksheet cell; then with this cell selected, open the Format 
Cells dialog box and scroll down through the Custom category Type list box on the 
Number tab until you see the date codes m/d/yyyy h:mm. Highlight these codes 
and then edit them as follows in the Type text box directly above:

mmmm dd, yyyy

The mmmm format code inserts the full name of the month in the custom for-
mat; dd inserts two digits for the day (including a leading zero, like 02 and 03); 
the yyyy code inserts the year. The other elements in this custom format are the 
space between the mmmm and dd codes and a comma and a space between the dd 
and yyyy codes (these being purely “punctuational” considerations in the custom 
format).
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What if you want to do something even fancier and create a custom format that 
tells you something like “Today is Sunday, November 06, 2022” when you format 
a cell containing the NOW function? Well, you select your first custom format and 
add a little bit to the front of it, as follows:

"Today is" dddd, mmmm dd, yyyy

In this custom format, you’ve added two more elements: Today is and dddd. The 
Today is code tells Excel to enter the text between the quotation marks verbatim; 
the dddd code tells the program to insert the whole name of the day of the week. 
And you thought this was going to be a hard section!

Next, suppose that you want to create a really colorful number format — one that 
displays positive values in blue, negative values in red (what else?), zero values 
in green, and text in cyan. Further suppose that you want commas to separate 
groups of thousands in the values, no decimal places to appear (whole numbers 
only, please), and negative values to appear inside parentheses (instead of using 
that tiny little minus sign at the start). Sound complex? Hah, this is a piece of 
cake.

1. In four blank cells in a new worksheet, enter 1200 in the first cell, -8000  
in the second cell, 0 in the third cell, and the text Hello There! in the  
fourth cell.

2. Select all four cells as a range (starting with the one containing 1200 as 
the first cell of the range).

3. Open the Format Cells dialog box and select the Number tab and Number 
in the Category list.

4. Click the #,##0_);[Red](#,##0) code in the Custom category Type list box 
(it’s the seventh set down from the top of the list box) and then edit it as 
follows: [Blue]#,##0_);[Red](#,##0);[Green];[Cyan].

5. Click OK.

That’s all there is to that. When you return to the worksheet, the cell with 1200 
appears in blue as 1,200, the -8000 appears in red as (8,000), the 0 appears in 
green, and the text “Hello There!” appears in a lovely cyan.

Before you move on, you should know about a particular custom format because 
it can come in really handy from time to time. I’m referring to the custom format 
that hides whatever has been entered in the cells. You can use this custom format 
to temporarily mask the display of confidential information used in calculating 
the worksheet before you print and distribute the worksheet. This custom format 
provides an easy way to avoid distributing confidential and sensitive information 
while protecting the integrity of the worksheet calculations at the same time.
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To create a custom format that masks the display of the data in a cell selection, you 
create an “empty” format that contains just the semicolon separators in a row:

;;;

This is one custom format that you can probably type by yourself!

After creating this format, you can blank out a range of cells by selecting them and 
then selecting this three-semicolon custom format in the Format Cells dialog box. 
To bring back a cell range that’s been blanked out with this custom format, select 
what now looks like blank cells and then select one of the other (visible) formats 
that are available. If the cell range contains text and values that normally should 
use a variety of different formats, first use General to make them visible. After the 
contents are back on display, format the cells in smaller groups or individually, 
as required.

Altering the alignment
You can access Excel’s Alignment options in two ways:

 » Using the buttons in the Home tab’s Alignment group

 » Using the options on the Alignment tab of the Format Cells dialog box

Alignment refers to both the horizontal and vertical placement of the characters in 
an entry in relation to its cell boundaries as well as the orientation of the characters 
and how they are read. Horizontally, Excel automatically right-aligns all numeric 
entries and left-aligns all text entries in their cells (referred to as General align-
ment). Vertically, Excel aligns all types of cell entries with the bottom of their cells.

On the Alignment tab of the Format Cells dialog box, the Horizontal drop-down 
list offers you the following horizontal text alignment choices:

 » General (the default) right-aligns a numeric entry and left-aligns a text entry 
in its cell.

 » Left (Indent) left-aligns the entry in its cell and indents the characters from 
the left edge of the cell by the number of characters entered in the Indent 
combo box (which is 0 by default).

 » Center centers any type of cell entry in its cell.
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 » Right (Indent) right-aligns the entry in its cell and indents the characters from 
the right edge of the cell by the number of characters entered in the Indent 
combo box (which is 0 by default).

 » Fill repeats the entry until its characters fill the entire cell display. When you 
use this option, Excel automatically increases or decreases the repetitions of 
the characters in the cell as you adjust the width of its column. Fill is useful for 
creating dot leaders (that is, a series of dots that connect one cell with 
another).

 » Justify spreads out a text entry with spaces so that the text is aligned with the 
left and right edges of its cell. If necessary to justify the text, Excel automati-
cally wraps the text onto more than one line in the cell and increases the 
height of its row. If you use the Justify option on numbers, Excel left-aligns the 
values in their cells just as if you had selected the Left align option.

 » Center Across Selection centers a text entry over selected blank cells in 
columns to the right of the cell entry.

 » Distributed (Indent) indents the text in from the left and right cell margins by 
the amount you enter in the Indent text box or select with its spinner buttons 
(which appear when you select this option from the Horizontal drop-down list) 
and then distributes the text evenly in the space in between.

For text entries in the worksheet, you can also add the Wrap Text check box option 
to any of the horizontal alignment choices. (Note that you can also access this 
option in the Home tab’s Alignment group by clicking the Wrap Text button.) 
When you select the Wrap Text option, Excel configures the text entry to display 
on multiple lines within its cell while maintaining the type of alignment that 
you’ve selected (something that automatically happens when you select the Jus-
tify alignment option).

Instead of wrapping text that naturally increases the row height to accommodate 
the additional lines, you can use the Shrink to Fit check box option on the Align-
ment tab of the Format Cells dialog box to have Excel reduce the size of the text 
in the cell sufficiently so that all its characters fit within their current column 
widths.

In addition, Excel offers the following vertical text alignment options from the 
Vertical drop-down list:

 » Top aligns any type of cell entry with the top edge of its cell.

 » Center centers any type of cell entry between the top and bottom edges  
of its cell.
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 » Bottom (the default) aligns any type of cell entry with the bottom edge of its 
cell.

 » Justify wraps the text of a cell entry on different lines spread out with blank 
space so that they are vertically aligned between the top and bottom edges of 
the cell.

 » Distributed wraps the text of the cell entry on different lines distributed 
evenly between the top and bottom edges of its cell.

Finally, as part of its alignment options, Excel lets you alter the orientation (the 
angle of the characters in a cell entry) and text direction (the way the characters are 
read). The direction is left-to-right for European languages and right-to-left for 
some languages, such as Hebrew and Arabic. (Chinese characters can also some-
times be read from right to left, as well.)

Wrapping text entries to new lines in their cells
You can use the Wrap Text button on the Ribbon’s Home tab or the Wrap Text 
check box in the Text Control section of the Alignment tab to have Excel create a 
multi-line entry from a long text entry that would otherwise spill over to blank 
cells to the right. In creating a multi-line entry in a cell, the program also auto-
matically increases the height of its row if that’s required to display all the text.

To get an idea of how text wrap works in cells, compare Figures 2-12 and 2-13 
(sample workbook: MGE Q1 Sector Sales.xlsx for both). Figure 2-12 shows you a row 
of long text entries that spill over to succeeding blank cells in columns to the right. 
Figure 2-13 shows you these same entries after they have been formatted with the 
Wrap Text option. The first long text entry is in cell A2 and the last in cell I2. They 
all use General alignment (same as Left for text) with the Wrap Text option.

When you create multi-line text entries with the Wrap Text option, you can decide 
where each line breaks by inserting a new paragraph. To do this, you put Excel in 
Edit mode by clicking the insertion point in the Formula bar at the place where a new 
line should start and pressing Alt+Enter. When you press the Enter key to return to 
Ready mode, Excel inserts an invisible paragraph marker at the insertion point that 
starts a new line both on the Formula bar and within the cell with the wrapped text.

FIGURE 2-12:  
Worksheet with 

long text entries 
that spill over into 
blank cells on the 

right. (Sample 
workbook: MGE 

Q1 Sector  
Sales.xlsx)
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If you ever want to remove the paragraph marker and rejoin text split on different 
lines, click the insertion point at the beginning of the line that you want to join on 
the Formula bar and press the Backspace key.

Reorienting your entries
You can change the orientation (that is, the angle of the baseline on which the 
characters rest) of the characters in a cell entry by rotating up or down the base-
line of the characters.

On the Home tab, the Alignment group’s Orientation command button contains 
the following options on its drop-down menu:

 » Angle Counterclockwise rotates the text in the cell selection up 45 degrees 
from the baseline.

 » Angle Clockwise rotates the text in the cell selection down 45 degrees from 
the baseline.

 » Vertical Text aligns the text in the cell selection in a column where one letter 
appears over the other.

 » Rotate Text Up rotates the text in the cell selection up 90 degrees from the 
baseline.

 » Rotate Text Down rotates the text in the cell selection down 90 degrees from 
the baseline.

 » Format Cell Alignment opens the Alignment tab on the Format Cells 
dialog box.

FIGURE 2-13:  
Worksheet after 

wrapping long 
text entries 

in their cells, 
increasing the 
height of their 
rows. (Sample 

workbook: MGE 
Q1 Sector  
Sales.xlsx)
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You can also alter the orientation of text in the cell selection on the Alignment tab 
of the Format Cells dialog box (Ctrl+1) using the following options in its Orienta-
tion area:

 » Enter the value of the angle of rotation for the new orientation in the Degrees 
text box or click the spinner buttons to select this angle. Enter a positive value 
(such as 45) to have the characters angled above the normal 90-degree line of 
orientation and a negative value (such as –45) to have them angled above 
this line.

 » Click the point on the sample Text box on the right side of the Orientation 
area that corresponds to the angle of rotation that you want for the charac-
ters in the selected cells.

 » Click the sample Text box on the left side of the Orientation area to have the 
characters stacked one on top of the other (as shown in the orientation of the 
word “Text” in this sample box).

After changing the orientation of entries in a selection, Excel automatically 
adjusts the height of the rows in the cell selection to accommodate the rotation up 
or down of the cell entries. Figure 2-14 (sample workbook: MGE Q1 Sector Sales.
xlsx) shows the top part of a worksheet after rotating the column headings for a 
new table up 90 degrees. Note how Excel increased the height of row 10 to accom-
modate this change.

Fancy fonts and colors
You can assign any of the fonts that are installed on your computer to cells in a 
worksheet. Along with selecting a new font (also known as a typeface), you can 
choose a new font size (in points), assign a font style (such as bold, italic, under-
line, or strikethrough), as well as change the color of the font.

FIGURE 2-14:  
Worksheet 

after rotating a 
table’s column 

headings up 90 
degrees. (Sample 

 workbook: MGE 
Q1 Sector  
Sales.xlsx)
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On the Home tab, the Font group enables you to tell the font and font size of 
the cell entry in the active cell by looking at the font name displayed in the Font 
combo box and the point size displayed in the Font Size combo box. You can also 
tell which, if any, text attributes are assigned to the entry by looking at the Bold, 
Italic, and Underline buttons in this group. Excel indicates which of these attri-
butes have been assigned to the cell by highlighting the B, I, or U button in the 
standard highlight color.

Selecting fonts and colors from the Ribbon
You can change the font, font size, font style, and font color using the command 
buttons in the Home tab’s Font group. The only aspects you can’t change or assign 
are the type of the underlining (besides single or double) and special font styles 
including strikethrough, superscript, and subscript.

To change the font with the command buttons in the Home tab’s Font group, 
select the cell, cell range, or nonadjacent selection to which you want to assign the 
new font, size, style, or color, and then do one of the following:

 » To assign a new font to the selection, click the Font drop-down button and 
then select the font from the drop-down list.

 » To assign a new point size to the selection, click the Font Size drop-down 
button and then select the size from the drop-down list. (You can also do this 
by clicking the Font text box, typing the point size, and pressing Enter.)

 » To increase the font size, click the Increase Font Size button. Note that Excel 
increases the font size based on the entries in the Font Size drop-down list. 
For example, if the current font size is 11 points, clicking Increase Font Size 
changes the size to 12 points. Clicking the button a second time sets the font 
size to 14 points, and so on.

 » To decrease the font size, click the Decrease Font Size button. Similarly, Excel 
decreases the font size based on the entries in the Font Size drop-down list. 
For example, if the current font size is 18 points, clicking Decrease Font Size 
changes the size to 16 points. Clicking the button a second time sets the font 
size to 14 points, and so on.

 » To assign a new font style to a selection, click the appropriate tool in the 
Formatting toolbar: Click the Bold button (the one with B) to bold the selection, 
the Italic button (the one with I) to italicize the selection, and the Underline 
button (the one with the U) to underline the selection. To assign double 
underlining to the cell selection, click the drop-down button attached to the 
Underline button and then click Double Underline from its drop-down menu.

 » To assign a new font color, click the Font Color pop-up button and then click 
the new color in the drop-down palette.
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Live Preview enables you to see how the cell selection looks in a font or font size 
that you highlight on the Font or Font Size drop-down list — provided, of course, 
that the selection in the columns and rows is not obscured when these drop-down 
lists are displayed.

Note that you can immediately remove any font change that you make by clicking 
the Undo button on the Quick Access toolbar (or by pressing Ctrl+Z). You can also 
remove boldface, italics, and underlining assigned to a cell selection by clicking 
the appropriate button (Bold, Italic, and Underline) on the Formatting toolbar. 
This action removes the darker shading that outlines the button’s B, I, or U icon.

Selecting fonts and colors in the Format  
Cells dialog box
You can also select a new font, font size, font style, and font color for your selec-
tion on the Font tab of the Format Cells dialog box (Ctrl+1). Figure 2-15 shows the 
Font tab of the Format Cells dialog box that appears when an empty cell that uses 
the Normal style is active. In this figure, the current Font is Calibri (Body), the 
Font Style is Regular, the Font Size is 11 (points), the Underline is None, and the 
Color is Automatic.

To select a new font color from the Font Color drop-down palette in the Font 
group on the Ribbon’s Home tab or from the Color drop-down palette on the Font 
tab of the Format Cells dialog box, click its drop-down button. Both drop-down 
palettes contain color swatches arranged in two groups: Theme colors to select 

FIGURE 2-15:  
You can assign 
new fonts, font 

sizes, attributes, 
and colors on the 

Font tab of the 
Format Cells  

dialog box.
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one of the colors used in Excel’s themes (see Book 5, Chapter 2) and Standard col-
ors to select one of the primary Windows colors. To select a font color from either 
of these two groups, click its color swatch.

If none of the preset colors appeal, click the More Colors option at the bottom of 
the drop-down palette to open the Colors dialog box. This dialog box contains a 
Standard tab where you can select a new color by clicking its hexagram swatch in 
the color honeycomb or shade of gray hexagram below. The Custom tab enables 
you to select a custom color by changing the RGB (Red, Green, and Blue) or HSL 
(Hue, Saturation, and Luminosity) values. You can do this either by dragging 
through the color grid and tint slider at the top of the Custom tab or by entering 
new values in the Red, Green, and Blue (when the RGB Color Model is selected) or 
the Hue, Sat, and Lum (when the HSL Color Model is selected) text boxes below or 
by selecting them with their spinner buttons.

Excel adds a swatch for each custom color you select or define to a Recent Colors 
section that then appears on both the Font Color and Fill Color buttons’ drop-
down palettes, making it easy to apply these custom colors to the text and fills of 
other cells in the worksheet.

Basic borders, fills, and patterns
You can add borders as well as to assign new background fill colors, gradients, 
and shading patterns to cells in the worksheet. You can use the borders to outline 
tables of data — particularly important cells — or to underscore rows of key data. 
You can also apply various color gradients and shading patterns to cells to draw 
attention to significant aspects of the worksheet.

When adding borders and shading, you can make your job a great deal easier by 
removing the gridlines used in the Worksheet area to indicate the borders of the 
cells in the worksheet. To remove these gridlines, deselect the View tab’s Gridlines 
check box (or press Alt+WVG). After you’ve dispensed with a worksheet’s grid-
lines, you can immediately tell whether you’ve added the kind of borders that you 
want and better judge the effect of the color and shading changes that you make.

Right on the borderline
When applying borders to a cell selection, you have a choice of methods:

 » In the Home tab’s Font group or on the mini-toolbar, use the options on the 
Borders drop-down menu.

 » In the Format Cells dialog box, use the options on the Border tab.
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You can compare the options offered by each in Figures 2-16 and 2-17. Figure 2-16 
shows the border options on the drop-down menu, and Figure 2-17 shows the 
options on the Border tab of the Format Cells dialog box.

FIGURE 2-16:  
The border 

options  available 
on the Home 
tab’s Borders 

 button’s  
drop-down menu.

FIGURE 2-17:  
The border 

options available 
on the Border 

tab of the Format 
Cells dialog box.
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To apply borders to the cell selection by using the options on the Borders button’s 
drop-down menu, choose the option on the menu with the type of border you want 
drawn. To remove a borderline that you select in error, click the No Border option.

While defining the borderlines to apply in the Border tab, you can select a new style 
for the borderlines by clicking the Line style in the Style sample area. To select a 
new color (besides boring old black) for the borderlines that you’re about to apply, 
click the swatch of the new color you want to use in the Color drop-down palette.

When using the Borders palettes to assign borderlines to a cell selection, your 
options are limited to just the Border buttons displayed on the palette. This means 
that you don’t have as much choice in terms of line style and type of borderlines. 
(In other words, you can’t be applying any dashed diagonal borderlines from this 
palette.) You also can’t change the color of the borderlines from the Borders palette.

The Borders button’s drop-down menu includes a couple of options that enable 
you to literally draw borders around a cell selection in your worksheet by dragging 
the mouse pointer through the cells. Click the Draw Border option to draw a bor-
der just outlining the cells you select or Draw Border Grid to draw borders around 
each and every cell you select with the mouse.

To get rid of borderlines that you’ve added to a cell range, no matter which method 
you used to add them, select the range and then click the No Border option from 
the Borders button’s drop-down menu.

Fun fills, great-looking gradients,  
and pretty patterns
In Excel, you can not only select new background colors (referred to as fill colors) 
for the cell selection, but you can also assign gradients (fills that gradually go 
from one color to another) and new dotted and crosshatched patterns to them.

When assigning a new fill color to the current cell selection, you can do this 
either by clicking a new color swatch on the Fill Color button’s drop-down palette 
(located in the Font group on the Ribbon’s Home tab) or by clicking the swatch 
in the Background Color area of the Fill tab in the Format Cells dialog box (Ctrl+1) 
shown in Figure 2-18.

 » To assign a gradient to the cell selection, click the Fill Effects button to open 
the Fill Effects dialog box. (See Figure 2-19.) Select the beginning gradient color 
by clicking its swatch on the Color 1 drop-down color palette and the ending 
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gradient color by clicking its swatch on the Color 2 drop-down palette. Note 
that you can then further refine the gradient by selecting a new shading style 
option button that determines the direction of the gradient pattern before 
you click OK.

 » To add a dotted or crosshatched shading pattern to the cell selection (instead 
of a gradient — they don’t go together), click the pattern square on the Pattern 
Style’s drop-down palette. To change the color of the shading pattern (which is 
by default the black Automatic color), click a color swatch on the Pattern 
Color’s drop-down palette.

Check the Sample area at the bottom of the Fill tab of the Format Cells dialog box 
to check out the shading pattern and make sure that it’s the one you want to use 
before you click OK to apply it to the cell selection. If you don’t like the effect after 
you’ve applied it to the cell selection, click the Undo button on the Quick Access 
toolbar or press Ctrl+Z immediately to remove it.

To get rid of all fill colors, gradients, and shading patterns used in a cell selection, 
display the Home tab, click the Fill Color drop-down list, and then click the No 
Fill option.

FIGURE 2-18:  
Using the options 

on the Fill tab to 
select a new fill 

color, gradient, or 
shading  

pattern for your 
cell selection.
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Hiring Out the Format Painter
The Home tab’s Clipboard group includes the Format Painter button (with paint-
brush icon), which copies formatting from the current cell and applies it to cells 
that you “paint” by dragging its special thick-white cross-plus-paintbrush 
mouse pointer through them. Format Painter provides a quick-and-easy way to 
take a bunch of different formats (such as a new font, font size, bold, and italics) 
that you applied individually to a cell in the worksheet and then apply them in one 
fell swoop to a new range of cells.

To use the Format Painter, follow these steps:

1. Position the cell cursor in a cell that contains the formatting that you 
want copied to another range of cells in the worksheet.

The selected cell becomes the sample cell whose formatting is taken up by Format 
Painter and copied in the cells that you “paint” with its special mouse pointer.

2. In the Home tab’s Clipboard group, click the Format Painter button (with 
the paintbrush icon) or press Alt+HFP.

Excel adds a paintbrush icon to the standard thick white-cross mouse pointer, 
indicating that the Format Painter is ready to copy the formatting from the 
sample cell.

3. Click the cell or drag the mouse pointer through the range of cells that 
you want formatted identically to the sample cell.

FIGURE 2-19:  
Selecting a new 

gradient for your 
cell selection in 

the Fill Effects 
dialog box.



174      BOOK 2  Worksheet Design

When you release the mouse button, the cells in the range that you just selected 
with the Format Painter become formatted the same way as the sample cell.

Normally, using the Format Painter is a one-shot deal because as soon as you 
release the mouse button after selecting a range of cells with the Format Painter, 
it turns off, and the mouse pointer reverts to its normal function of just selecting 
cells in the worksheet (indicated by the return of the regular thick white-cross 
icon). If you ever want to keep the Format Painter turned on so that you can use it 
to format more than one range of cells in the worksheet, you need to double-click 
the Format Painter button. The Format Painter button remains selected (indicated 
by the shading) until you click its command button again. During this time, you 
can “paint” as many different cells or ranges in the worksheet as you desire.

Easier Formatting with Cell Styles
Cell styles combine a number of different formatting aspects that can include 
number format, text alignment, font and font size, borders, fills, and protection 
status. (See Book 4, Chapter 1.)

In Excel, cell styles really come alive in the form of the Cell Styles gallery that you 
open by clicking the Home tab’s Cell Styles button (it’s in the Styles group).

The Cell Styles gallery contains loads of ready-made styles you can immediately 
apply to the current cell selection. These predefined cell styles are arranged into 
various sections: Good, Bad, and Neutral; Data and Model; Titles and Headings; 
Themed Cell Styles; and Number Format. (See Figure 2-20.)

Hover the mouse or Touch pointer over the thumbnail styles to use Live Preview 
feature to view the effect of each style on your selected cell. Once you’ve deter-
mined which style looks best on your data, click the thumbnail of the desired style 
in the gallery.

Using the Number Format cell styles
The Number Format section near the bottom of the Cell Styles gallery (see 
 Figure 2-20) contains the following five predefined styles that you can use to for-
mat the values entered into the cell selection as follows:

 » Comma sets the number format to the Comma Style (same as clicking the 
Home tab’s Comma Style button in the Number group).
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 » Comma (0) sets the number format to the Comma Style format without any 
decimal places.

 » Currency sets the number format to the Currency style format (same as 
clicking the Home tab’s Accounting Number Format button in the Number 
group).

 » Currency (0) sets the number format to the Currency style format without 
any decimal places (making your financial figures all dollars and no cents).

 » Percent sets the number format to Percent style (same as clicking the Home 
tab’s Percent Style button in the Number group).

You can combine the number formatting assigned from one of the Number Format 
cell styles with the other cell formatting assigned by the cell styles in the other 
three cell style groups: Good, Bad, and Neutral (except for Normal, which applies 
the General number format); Data and Model; and Themed Cell Styles. To do this, 
first assign the number formatting by clicking its style in the Number Format sec-
tion of the Cell Styles gallery, and then assign the other formatting by clicking its 
style in one of the other three sections of the Cell Styles gallery.

Click Normal, the first style in the Good, Bad, and Neutral section, in the Cell Styles 
gallery to return the formatting in the cell selection to its original state: General 
number format, left or right (depending on the contents), horizontal and bottom 
vertical alignment, Calibri (body), 11-point font size (unless you’ve changed the 
default font and size), no borders, no fill, and locked protection status.

FIGURE 2-20:  
You can apply 

multiple styles to 
a cell selection 

using the Cell 
Styles gallery.
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Defining a custom cell style by example
You don’t have to live with just the predefined styles that Excel gives you on the 
Cell Styles gallery because you can create custom cell styles of your own.

By far the easiest way to create a new custom cell style is by example. When you 
create a cell style by example, you choose a cell that already displays all the for-
matting attributes (applied separately using the techniques discussed previously 
in this chapter) that you want included in the new cell style. Then, you follow 
these steps to create the new style by using the formatting in the sample cell:

1. Position the cell pointer in the cell with the formatting that you want in 
the new style.

2. In the Home tab’s Styles group, choose Cell Styles ➪ New Cell Style.

Excel opens the Style dialog box with a generic style name (Style 1, Style 2, and 
so on), and the formatting attributes applied to the cell are listed in the Style 
Includes (By Example) section of the dialog box.

3. Type the name for the new style in the Style Name text box.

4. (Optional) Deselect the check box for any attribute (Number, Alignment, 
Font, Border, Fill, or Protection) that you don’t want included in the  
new style.

5. Click OK to create your new style.

When defining a style by example, select only one cell that you know contains all 
the formatting characteristics that you want in the new style. This way, you avoid 
the potential problem of selecting cells that don’t share the same formatting. If 
you select cells that use different formatting when defining a style by example, 
the new style will contain only the formatting that all cells share in common.

After you create your first custom style, Excel creates a Custom section at the top 
of the Cell Styles gallery. For each custom style you create, Excel adds a thumb-
nail for the new style to the Custom section. To apply this new custom cell style 
to other cell selections in the worksheet, click its thumbnail in the Custom section 
of the gallery.

Creating a new cell style from scratch
You can also create a custom cell style from scratch by defining each of its format-
ting characteristics in the Style dialog box as follows:
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1. Position the cell pointer in the cell you want to format with your  
custom style.

It’s best if this cell has no formatting applied. To ensure this, in the Home tab’s 
Editing group, choose Clear ➪ Clear Formats (or press Alt+HEF).

2. In the Home tab’s Styles group, choose Cell Styles ➪ New Cell Style.

3. Type a name for the new style that you’re defining in the Style Name text 
box (replacing Style 1, Style 2, generic style name).

4. Click the Format button in the Style dialog box.

Excel opens the standard Format Cells dialog box, where you can use the 
options on its six tabs (Number, Alignment, Font, Border, Fill, and Protection) to 
select all the formatting attributes that you do want used when you apply the 
new style to a cell selection.

5. Click OK to return to the Style dialog box.

The Style Includes (By Example) section now lists all the attributes that you 
assigned in the Format Cells dialog box.

6. Click OK to create your custom style.

Excel applies the formatting in your newly defined custom style to the current 
cell and adds the new style to the Custom section of the Cell Styles gallery. To 
apply this new custom cell style to other cell selections in the worksheet, click its 
thumbnail in the Custom section of the gallery.

To remove a custom style from the Cell Styles gallery that you’ve defined by 
example or from scratch, you have to right-click its thumbnail in the gallery and 
then click Delete on its shortcut menu.

Merging styles into other workbooks
All custom cell styles that you create are saved, along with the data and formatting 
in the workbook, when you save the file. The only styles, however, that are availa-
ble when you begin a new workbook are those predefined styles provided by Excel.

If you’ve created custom styles in another workbook that you want to use in a new 
workbook or in an existing one that you’ve opened for editing, you have to merge 
them into that workbook as follows:

1. Open the workbook file containing the custom styles that you want to 
copy and use.

You must have the workbook containing the custom styles to merge open, 
along with the workbook into which these custom styles will be copied.
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2. Switch to the workbook file into which you want to merge the custom 
styles.

3. In the Home tab’s Styles group, choose Cell Styles ➪ Merge Styles.

Excel opens the Merge Styles dialog box with a list box that displays the 
filenames of all the workbooks that are currently open in the program.

4. Click the name of the workbook that contains the custom styles you 
want merged into the active workbook and then click OK.

If the workbook file that you selected contains custom styles with the same 
names as the custom styles defined in the active workbook, Excel displays an 
alert box that asks whether you want to merge the styles that have the same 
names. Click Yes to replace all styles in the active workbook with those that 
have the same name in the workbook file that you’re copying from. Click No if 
you don’t want the styles in the active workbook to be overwritten, in which 
case Excel merges the styles with unique names from the other workbook.

After merging styles from another open workbook, you can apply the merged cus-
tom styles, which now appear in the Custom section at the top of the Cell Styles 
gallery.

Analyzing Data with Conditional 
Formatting

Excel’s Conditional Formatting feature enables you to format a range of values so 
that unusual or unwanted values, or values outside certain limits, are automati-
cally formatted in such a way as to call attention to them.

In the Home tab’s Styles group, clicking the Conditional Formatting button dis-
plays a drop-down menu with the following options:

 » Highlight Cells Rules opens a continuation menu with options for defining 
formatting rules that highlight the cells in the cell selection that contain certain 
values, text, or dates, or that have values greater or less than a particular 
value, or that fall within a specified range of values.

 » Top/Bottom Rules opens a continuation menu with options for defining 
formatting rules that highlight the top and bottom values, percentages, and 
above and below average values in the cell selection.
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 » Data Bars opens a palette with different color data bars that you can apply to 
the cell selection to indicate their values relative to each other using bars that 
appear within each cell.

 » Color Scales opens a palette with different three- and two-colored scales that 
you can apply to the cell selection to indicate their values relative to each 
other using colors.

 » Icon Sets opens a palette with different sets of icons that you can apply to the 
cell selection to indicate their values relative to each other using icons.

 » New Rule opens the New Formatting Rule dialog box, where you define a 
custom conditional formatting rule to apply to the cell selection.

 » Clear Rules opens a continuation menu, where you can remove conditional 
formatting rules for the cell selection by clicking the Clear Rules from Selected 
Cells option; for the entire worksheet by clicking the Clear Rules from Entire 
Sheet option; for just the current table by clicking the Clear Rules from This 
Table option; or for just the current PivotTable by clicking the Clear Rules from 
This PivotTable option.

 » Manage Rules opens the Conditional Formatting Rules Manager dialog box, 
where you edit and delete particular rules as well as adjust their rule prece-
dence by moving them up or down in the Rules list box.

Graphical conditional formatting
If you’re a visual person, then you may find the most useful conditional format-
ting you can apply to a cell range is with the sets of graphical markers that enable 
you to see at a glance the values in your range relative to each other. Excel offers 
three such graphical markers on the Conditional Formatting button’s drop-down 
menu:

 » Data Bars represents the relative values in the cell selection by the length of 
the color bar in each cell. Data bars are a great way to quickly pinpoint the 
lower and higher values within a large range of data.

 » Color Scales classify the relative values in a cell selection with a color grada-
tion using a one-, two-, or three-color scale. Color scales are great for identify-
ing the distribution of values across a large range of data.

 » Icon Sets classify the values in the cell selection into three to five categories, 
and each icon within the set represents a range of values that go from high to 
low. Icon sets are useful for quickly identifying the different ranges of values in 
your data.
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Figure 2-21 (sample workbook: Production Schedule 2022.xlsx) shows how the 
initial Data Bars gradient fill appears when applied to the range B2:J6 (partially 
obscured by the menu in Figure 2-21). As you can see, the larger the value in a cell, 
the longer the data bar.

If you want to hide the values in a cell range and only display a type of graphi-
cal conditional formatting, apply the desired graphical conditional formatting 
to the range of numeric entries and then hide the underlying values by format-
ting the same cell range with the custom numeric format that masks the numeric 
entries (;;;), as described in “Designing your own number formats,” earlier in this 
chapter.

Conditional formatting with the  
Quick Analysis tool
Excel’s Quick Analysis tool enables you to apply various types of conditional for-
matting to selected cell ranges. Figure 2-22 (sample workbook: Production Sched-
ule 2022.xlsx) illustrates how this works. For this figure, I selected the cell range 
B3:J6, clicked the Quick Analysis tool that appears in the lower-right below the 
last selected cell, and then hovered the mouse pointer over the Icon Set option.

The Formatting tab is automatically selected with its conditional formatting 
option buttons (Data Bars, Color Scale, Icon Set, Greater Than, Top 10%, and Clear 
Format) displayed. You can then use Live Preview to sample how the selected data 
would appear in different conditional formats. When you see one you like, you 
can then apply it by clicking the particular conditional formatting option button.

FIGURE 2-21:  
The initial Data 

Bars gradient 
fill applied to 

some worksheet 
data. (Sample 

 workbook:  
Production 

Schedule  
2022.xlsx)
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Identifying particular values or text  
entries in a cell range
The options attached to the Highlight Cell Rules and Top/Bottom Rules items on 
the Conditional Formatting button’s drop-down menu enable you to specify a 
particular type of formatting when certain conditions are met.

The rules that you set up for meeting these formatting conditions can vary widely. 
You can set up a rule whereby a particular type of formatting is applied when a cell 
in the range contains a certain text entry (such as Fixed or Variable). You set up a 
rule whereby a particular type of formatting is applied when a cell in the range is 
exactly a particular value or exceeds or falls below a particular value. So too, you 
can set up a rule whereby a particular type of formatting is applied when the value 
is one of the top ten in the range, is below the average value in the range, or falls 
into the lower ten percent.

For example, to set up the rule where Excel formats any cell within a range with 
a light red fill color and dark red font color whenever it contains the word Fixed, 
you follow these steps:

1. Select the range of cells in the worksheet to which this conditional 
formatting rule is to be applied.

2. In the Home tab, click the Conditional Formatting button and then 
choose Highlight Cell Rules ➪ Text That Contains from the drop-down 
menu.

Excel opens the Text That Contains dialog box with a text box on the left where 
you enter or select in the worksheet the text that tells Excel when to apply the 
conditional formatting and a drop-down list box on the right where you select 
or define the conditional formatting the program is to apply.

FIGURE 2-22:  
You can use the 

Quick Analysis 
tool’s  Formatting 

option to apply 
conditional 

formatting to a 
cell selection. 

(Sample  
workbook: 
 Production 

Schedule  
2022.xlsx)
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3. Type Fixed in the Format Cells That Contain the Text box.

In this case, you don’t have to change the formatting in the drop-down list box, 
as Light Red Fill with Dark Red Text is the default formatting.

4. Click OK to apply the conditional formatting rule to the selected cell 
range.

Say you wanted to apply three different types of conditional formatting to the 
cells in a single range of the worksheet: one type of formatting whenever a cell in 
the range contains a target value, another when it exceeds this target value, and a 
third when it falls below the target value.

Here are the steps for setting up the rules to apply a yellow fill with a dark yellow 
font to cells in a range when they contain 100,000, a green fill with dark green 
text when they’re greater than 100,000, and a light red fill with dark red text when 
they’re less than 100,000:

1. Select the range of cells in the worksheet to which the three conditional 
formatting rules are to be applied.

Start by defining the rule that applies yellow fill with dark yellow font to all 
values in the range that are equal to 100,000.

2. In the Home tab, click the Conditional Formatting and then choose 
Highlight Cell Rules ➪ Equal To from the drop-down menu.

Excel opens the Equal To dialog box, where you define the formatting rule 
when a cell contains 100,000.

3. Type 100,000 in the Format Cells That Are EQUAL TO text box and then 
select Yellow Fill with Dark Yellow Text from the drop-down list box to 
the right before you click OK.

Next, you define the rule that applies green fill with dark green font to all 
values that are greater than 100,000.

4. In the Home tab, click the Conditional Formatting button and then 
choose Highlight Cell Rules ➪ Greater Than from the drop-down menu.

Excel opens the Greater Than dialog box, where you define the formatting rule 
when a cell contains a value higher than 100,000.

5. Type 100,000 in the Format Cells That Are GREATER THAN text box and 
then click Green Fill with Dark Green Text in the drop-down list box to the 
right before you click OK.

Finally, you define the rule that applies red fill with dark red font to all values 
that are less than 100,000.
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6. In the Home tab, click the Conditional Formatting button and then 
choose Highlight Cell Rules ➪ Less Than from the drop-down menu.

Excel opens the Less Than dialog box, where you define the formatting rule 
when a cell contains a value below 100,000.

7. Type 100,000 in the Format Cells That Are LESS THAN text box and then 
leave the default Light Red Fill with Dark Red Text selected in the 
drop-down list box to the right when you click OK.

As you define the three rules, Excel applies them to the range selected in the 
worksheet. If the cell range is blank at the time you set up these three rules, all the 
blank cells in the range are given a red fill. As you enter values into the cells, their 
text takes on the color assigned to their values: dark red font for values below 
100,000, dark yellow for all values of 100,000, and dark green for all values above 
100,000. In addition, when the values are equal to 100,000, Excel fills the cell with 
a light yellow background color and when values are above 100,000, a light green 
background color.

Finally, here are the steps you’d follow to create a rule that formats all values in a 
cell range that are below the average value in the range with a custom conditional 
format that applies bold italic to the font and a bright yellow fill color:

1. Select the range of cells in the worksheet to which this conditional 
formatting rule is to be applied.

2. In the Home tab, click the Conditional Formatting button and then 
choose Top/Bottom Rules ➪ Below Average from the drop-down menu.

Excel opens the Below Average dialog box that contains a single drop-down list 
box where you define the formatting to be used when a value is below the 
calculated average for the cell range.

3. Select Custom Format at the bottom of the Format Cells That Are BELOW 
AVERAGE drop-down list box.

Excel opens the Format Cells dialog box where you define all the attributes to 
be part of the custom conditional formatting.

4. Click the Font tab in the Format Cells dialog box and then click Bold Italic 
in the Font Style list box.

5. Click the Fill tab in the Format Cells dialog box and then click the bright 
yellow swatch in the Background Color section before you click OK.

Excel closes the Format Cells dialog box, returning you to the Below Average 
dialog box, which now displays Custom Format in the Format Cells That Are 
BELOW AVERAGE drop-down list box.

6. Click OK to close the Below Average dialog box.
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Excel then applies the custom formatting of bold italic text with bright yellow 
fill color to all values in the cell selection that are below the calculated average 
(displayed after the Average heading on the status bar at the bottom of the Excel 
program window).

Highlighting duplicate values in a cell range
The Duplicate Values option on the Highlight Cell Rules continuation menu 
enables you to highlight duplicate values within a selected cell range.

To highlight duplicate values in a cell range, follow these steps:

1. Select the range of cells in the worksheet where you want duplicates 
formatted in a special way.

2. In the Home tab, click the Conditional Formatting button and then 
choose Highlight Cell Rules ➪ Duplicate Values from the drop-down menu.

Excel opens the Duplicate Values Columns dialog box containing two drop-
down lists: the first where you indicate whether Excel is to format identical 
values (Duplicate, the default) in the range or the standalone values (Unique) in 
the range, and the second where you indicate the type of formatting applied to 
either the duplicates or one-of-a-kind values.

3. Click the type of preset formatting (Red Fill with Dark Red Text, Yellow Fill 
with Dark Yellow Text, Green Fill with Dark Green Text, and so forth) or 
click the Custom Format option and select the custom formatting in the 
Format Cells dialog box.

If you define a custom format rather than select one of the preset formats, use 
the options on the Number, Font, Border, and Fill tabs of the Format Cells 
dialog box to designate all the formatting to be applied, and then click OK to 
close the Format Cells dialog box and return to the Compare Columns dialog 
box (where Custom Format appears in the third drop-down list box).

4. Click OK to close the Duplicate Values dialog box.

Excel then formats all the cells in the selected cell range whose values are exact 
duplicates with the conditional formatting you selected.

Creating your own conditional  
formatting rules
Although Excel gives you a ton of ready-made conditional formatting rules to 
apply, you may still find that you need to create your own rules for conditional 
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formatting. To do this, you choose the New Rule option near the bottom of the 
Conditional Formatting button’s drop-down menu or you click the New Rule but-
ton in the Conditional Formatting Rules Manager dialog box. (See the “Managing 
conditional formatting rules” section that immediately follows.)

Figure 2-23 shows the New Formatting Rule dialog box as it first appears after 
you click the New Rule option or button. To create a new conditional formatting 
rule, you first click the type of rule to create in the Select a Rule Type list box and 
then specify the criteria and define the formatting using the various options that 
appear in the Edit the Rule Description section below — note that these options 
vary greatly depending on the type of rule you select from the Select a Rule Type 
list box above.

Select the Use a Formula to Determine Which Cells to Format rule type when you 
want to build a formula as the rule that determines when a particular type of con-
ditional formatting is applied. Note that this formula can refer to cells outside 
the current cell selection to which the conditional formatting is applied, but it 
must be a logical formula, meaning that it uses comparison operators (see Book 3, 
 Chapter 1) and/or Logical functions (see Book 3, Chapter 2) that when calculated 
return either a logical TRUE or FALSE value.

FIGURE 2-23:  
Define a new 

 conditional 
formatting rule 

using the options 
in the New 

Formatting Rule 
dialog box.
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Managing conditional formatting rules
The Conditional Formatting Rules Manager dialog box, which you open by choos-
ing the Manage Rules option at the very bottom of the Conditional Formatting 
button’s drop-down menu, enables you to do all the following:

 » Create new rules by clicking the New Rule button to open the New Formatting 
Rule dialog box. (See the “Creating your own conditional formatting rules” 
section immediately preceding.)

 » Edit existing rules by selecting the rule in the Rule list box and clicking the Edit 
Rule button in the Editing Formatting Rule dialog box (which looks just like the 
New Formatting Rule dialog box except it contains the rule type, criteria, and 
formatting for the particular rule you selected).

 » Delete rules by clicking the rule in the Rule list box and then clicking the Delete 
Rule button — click the Apply button to remove formatting from the work-
sheet that was applied to the rule you just deleted.

 » Change the order of precedence in which multiple conditional formatting 
rules assigned to the same cell selection or table are applied by promoting or 
demoting individual rules in the Rule list box by clicking the rules and then 
clicking either the Move Up button (with the thick arrow pointing upward) or 
Move Down button (with the thick arrow pointing downward) until the rules 
appear in the desired order of precedence.

By default, the Conditional Formatting Rules Manager dialog box shows all the 
rules assigned only to the current cell selection or table. To see all the condi-
tional formatting rules in a particular worksheet or table, use the Show Format-
ting Rules For drop-down list to either select This Worksheet (to see the rules in 
the active sheet) or select the worksheet name.

A rule that appears higher in the Rule list box of the Conditional Formatting Rules 
Manager dialog box has a higher precedence and is therefore applied before one 
lower in the list. When more than one rule is true, what happens depends on 
whether the formatting applied by those rules conflict. When they don’t conflict 
(as when one rule formats the cells in bold italic and the other formats the cells 
with a light red fill), both formats are applied. However, when the formats conflict 
(as when one rule formats the cells with black fill and bright yellow text and the 
other formats the cells with yellow fill and black text), the rule with the higher 
precedence wins, and only its conditional formatting is applied.
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Editing and Proofing 
Worksheets

Creating a worksheet is seldom a one-time experience. In fact, some of the 
worksheets that you create with Excel require routine changes on a regular 
basis, whereas others require more radical changes only once in a while. 

Regardless of the extent of the changes and their frequency, you can be sure that 
sooner or later, most of the worksheets you create in Excel will require editing.

In this chapter, you find out how to make basic editing changes in a worksheet 
by modifying the contents of a cell as well as how to do more complex editing in 
your worksheets. These techniques include how to use the Undo and Redo fea-
tures, zoom in and out on data, move and copy data, delete data entries and insert 
new ones, search and replace data entries, and proof the contents of the final 
worksheet.

Chapter 3

IN THIS CHAPTER

 » Opening workbooks for editing

 » Using basic cell-editing techniques

 » Zooming in and out on the worksheet

 » Freezing columns and rows on the 
screen

 » Copying and moving data entries

 » Finding and replacing data entries

 » Proofing the worksheet

 » Using data validation to circle invalid 
data entries in the worksheet
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However, before you can use any of these fine editing techniques, you have to 
open the workbook whose contents require editing. So, with that in mind, this 
chapter starts out by giving you the lowdown on finding and opening workbooks 
in Excel.

Opening a Workbook
One way to open a workbook for editing in Excel is to navigate to the workbook’s 
folder using File Explorer and then double-click the workbook file icon. If Excel 
isn’t running, Windows launches Excel and then opens the file.

Excel automatically saves workbook files in your Documents folder on your One-
Drive unless you select another folder or you save your workbooks locally on a 
hard drive or network drive connected to your device. You can type the name of 
the workbook file in the taskbar’s Type Here to Search text box, or you can use 
Cortana to locate the file by saying to her “Find . . .” followed by the name of the 
workbook file.

Using the Open screen in the  
Backstage view
If Excel is already running and you want to open a workbook file for editing from 
within Excel, you can choose File ➪ Open or press Alt+FO or Ctrl+O to launch the 
Open screen in the Backstage view and locate and open the file.

When Excel displays the Open screen (similar to the one shown in Figure 3-1), 
the program selects the Recent option on the left, while listing recently opened 
files under the Workbooks tab on the right. If the workbook file you want to edit is 
listed there, you can open the file by clicking its name in the list. If the Excel file 
you want to edit isn’t in the list of workbooks but in one of the folders in which 
you routinely save your workbooks, click the Folders tab to the immediate right 
of the Workbooks tab to switch to a list of folders from which you’ve recently 
retrieved workbooks. When you locate the folder with the file you need, double-
click it and then double-click its file icon to open the workbook in Excel.
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If the workbook file isn’t among those in the Recent list, you need to select its 
location from another location:

 » Shared with Me: Displays a list of workbooks that your coworkers or clients 
have shared with you. (See Book 4, Chapter 3 for more on sharing Excel 
workbooks.)

 » OneDrive: Displays your OneDrive folders.

 » This PC: Displays your PC’s folders, which includes removable storage devices 
connected to your computer or tablet PC.

 » Add a Place: Enables you to add a folder on your OneDrive or SharePoint 
website to the list of places in the Open screen for easy access.

 » Browse: Displays the Open dialog box where you can search for misplaced 
workbook files or open a folder not listed in the Open screen.

If your company maintains a SharePoint Team website where you save Excel 
workbook files and you’ve added it as a place (with the Add a Place link), its name 
will also appear under the Places heading on the Excel Open screen.

FIGURE 3-1:  
Use the Open 

screen to find and 
open a  workbook 

for editing.
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Click the Recover Unsaved Workbooks button at the bottom of the Recent screen 
if you ever need to open a workbook that you inadvertently didn’t save on one of 
your computer’s local drives before you closed the file. Excel displays the Open 
dialog box showing the contents of the UnsavedFiles folder, containing a list 
of any workbook files that the program automatically saved there before clos-
ing the Excel program window. Unfortunately, the filenames in this list, as in 
Book1((Unsaved 30683148768452)), are pretty nondescript, and there are no 
worksheet previews available (because the files never got saved, so no previews 
got created). This means that you need to rely on the date and time listed in 
the Date Modified column of the Open dialog box to help you identify the file 
you want to open for editing. When you click the filename of the unsaved file to 
open followed by the Open button, Excel opens it in the program window in Read 
Only mode with an alert appearing beneath the Ribbon indicating that this is a 
recovered file. You can then click the Save As button at the end of the alert text to 
open the Save As dialog box where you can properly name and save the file, thus 
enabling you to edit it contents.

When you select the location containing your workbook file, the Open screen dis-
plays links to that location’s folders. (See Figure 3-2.) You can click one of these 
links to select its folder and display its files. If you can’t find the workbook you 
want to open, you can select the Browse button to peruse the folders and files on 
the selected location in the ensuing Open dialog box.

FIGURE 3-2:  
Select a location 

to see its folders.
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When the Open dialog box is displayed, the contents of the selected location or 
recently visited folder are listed in its main pane. (See Figure 3-3.) If you see the 
name of the workbook you want to edit in this list, double-click the file, or click 
the file and then click Open to load the workbook into Excel.

If you open a new folder and it appears empty of all files (and you know that it’s 
not an empty folder), this just means the folder doesn’t contain any of the types 
of files that Excel can open directly, such as workbooks, template files, and macro 
sheets. To display all the files, whether Excel can open them directly (meaning 
without some sort of conversion), click the drop-down button that says All Excel 
Files and then select the All Files option at the top of its drop-down menu.

Note that you can change the way folder and file icons appear in the dialog box. 
To do so, use the slider attached to the Change Your View drop-down list button 
located on the right side of the toolbar at the top of the Open dialog box. When you 
select Large Icons or Extra Large Icons on this slider (or anywhere in between), 
the Excel workbook icons actually show data in the upper-left corner of the first 
worksheet. This applies to all Excel workbooks saved with the Save Thumbnail 
check box selected and Excel 97 through 2003 workbooks saved with the Save Pre-
view Picture check box on the Summary tab of the workbook’s Properties dialog 
box selected. This preview of part of the first sheet helps you quickly identify the 
workbook you want to open for editing or printing.

FIGURE 3-3:  
You can use the 

Open dialog box 
to select the 

workbook file you 
want to open.
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If you’re comfortable opening workbook files directly from the Open dialog box, 
you can completely bypass the Open screen by selecting the Don’t Show the Back-
stage When Opening or Saving Files check box on the Save tab of the Excel Options 
dialog box (Alt+FTS). Just be aware that when you select this check box, Excel not 
only immediately displays the Open dialog box when you choose File ➪ Open to 
open a workbook file for editing but also displays the Save As dialog box when you 
choose File ➪ Save option (or any of its equivalents) to save a new workbook file. 
This means that you must be as comfortable using the Save As dialog box to select 
the place to save a new file as you are using the Open dialog box to select the place 
containing the file to edit.

Opening more than one  
workbook at a time
If you know that you need to edit worksheets saved in multiple workbook files, 
you can open them all in Excel at the same time by selecting all their files in the 
Folder and File List in the Open dialog box before you select the Open button.

To select multiple files that appear sequentially in the Open dialog box, click the 
first file and then hold down the Shift key while you click the last file. To select 
files that aren’t listed sequentially, click the first file and then hold down the Ctrl 
key while you click the other files.

After the workbook files are open in Excel, you can then switch documents by 
selecting their filename buttons on the Windows taskbar or by using the Flip fea-
ture (Alt+Tab) to select the workbook’s thumbnail. (See Book 2, Chapter  4 for 
more information on working on more than one worksheet at a time.)

Finding misplaced workbooks
Everything’s hunky-dory as long as you correctly remember the folder containing 
the workbook file or files you need to edit. But what about those times when they 
seem to have mysteriously migrated and are now nowhere to be found? For those 
rare occasions, use the Search Documents text box in the Open dialog box (see 
Figure 3-3) that enables you to search for missing notebooks right from within 
the dialog box.

To use this search feature to find a workbook, click the Search Documents text 
box in the upper-right corner of the Open dialog box and then begin typing search 
characters used in the workbook’s filename or contained in the workbook itself.
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As Windows finds any matches for the characters you type, the names of the 
workbook files (and other Excel files such as templates and macro sheets as well) 
appear in the Open dialog box. As soon as the workbook you want to open is listed, 
you can open it by clicking its icon and filename followed by the Open button or 
by double-clicking it.

Using the other Open options
The drop-down menu attached to the Open button in the Open dialog box enables 
you to open the selected workbook file(s) in special ways. These ways include

 » Open Read-Only: Opens the files you select in the Open dialog box’s list box 
in a read-only state, which means that you can look but you can’t touch. 
(Actually, you can touch; you just can’t save your changes.) To save changes in 
a read-only file, you must choose File ➪ Save As from the Excel menu bar and 
give the workbook file a new filename, a new location, or both.

 » Open as Copy: Opens a copy of the files you select in the Open dialog box. 
Use this method of file opening as a safety net: If you mess up the copies, you 
always have the originals to fall back on.

 » Open in Browser: Opens workbook files you save as web pages in your 
default web browser. Note that this command isn’t available unless the 
program identifies that the selected file or files were saved as web pages 
rather than plain, old Excel worksheet files.

 » Open in Protected View: Opens the selected workbook in Protected View, 
which prevents you from making any editing changes to its worksheets until 
you click the Enable Editing button that appears in the red Protected View 
panel at the top of the worksheet area.

 » Open and Repair: Attempts to repair corrupted workbook files before 
opening them in Excel. When you select this command, a dialog box appears, 
giving you a choice between attempting to repair the corrupted file or opening 
the recovered version, extracting the data out of the corrupted file, and 
placing it in a new workbook (which you can save with the Save command). 
Click the Repair button to attempt to recover and open the file. Click the 
Extract Data button if you previously tried unsuccessfully to have Excel repair 
the file.

 » Show Previous Versions: Displays a list of various versions of the workbook 
file automatically saved by Excel’s AutoRecover feature and given filenames 
that describe when the file and under what circumstances the version was 
saved.
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Editing a Cell
The biggest thing to remember about basic cell editing is that you have to put the 
cell pointer (also known as the cell cursor) on the cell you want to modify. When 
modifying a cell’s contents, you can replace the entry entirely, delete characters 
from the entry, and/or insert new characters into the entry:

 » Replacing a cell’s contents: Select the cell, type your new entry, and then 
press Enter (or use whatever completion technique you prefer). Excel replaces 
the existing data entry with your typing. While you’re typing the new entry, 
you can cancel the replacement and restore the original cell entry by clicking 
the Formula bar’s Cancel button or by pressing Escape.

 » Deleting characters in a cell entry: Open the cell for editing by selecting the 
cell and pressing F2 or by double-clicking the cell. Either technique puts Excel 
into Edit mode (indicated by Edit on the status bar). Alternatively, select the 
cell and click inside the Formula bar. You now have an insertion point cursor 
either inside the cell or in the Formula bar. Use the Home, End, or ← and → 
keys to move the insertion point to the right of the first character you want to 
delete, and press Backspace until you’ve removed all the unnecessary or 
incorrect characters. (Alternatively, move the insertion point to the left of the 
first character you want to delete, and then press Delete until you’ve removed 
all the characters you no longer need.)

 » Inserting new characters in a cell entry: Open the cell for editing by 
selecting the cell and pressing F2 or by double-clicking the cell. Either  
technique puts Excel into Edit mode (indicated by Edit on the status bar). 
Alternatively, select the cell and click inside the Formula bar. You now have  
an insertion point cursor either inside the cell or in the Formula bar. Use the 
Home, End, or ← and → keys to move the insertion point to the location in the 
entry where you want to insert the new characters and then start typing.

When you edit the contents of a cell by inserting and/or deleting characters in 
it, you need to remember to click the Enter button on the Formula bar or press 
the Enter key to complete the editing change and switch the program from Edit 
back to Ready mode (indicated by the reappearance of Ready on the status bar). 
If you’re editing a cell with a simple text or number entry, you can also complete 
your edits by clicking another cell. (However, clicking another cell doesn’t work 
when you’re editing a formula because Excel just includes the address of the cell 
that you click as part of the edited formula.) Also, you can’t use any of the key-
strokes that normally complete a new cell entry except for the Tab and Shift+Tab 
keystrokes for moving to the next and previous columns in the worksheet. (All 
the rest, including the arrow keys, Home, and End, just move the insertion point 
within the cell entry.)
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Changing your mind with Undo and Redo
Excel supports multiple levels of undo that you can use to recover from poten-
tially costly editing mistakes that would require data re-entry or extensive repair 
operations. The most important thing to remember about the Undo command is 
that it is cumulative, meaning that you may have to select it multiple times to 
reverse several actions that you’ve taken before you get to the one that sets your 
worksheet right again.

You can select the Undo command either by clicking the Undo button on the Quick 
Access toolbar or by pressing Alt+Backspace or Ctrl+Z. Excel then reverses the last 
edit you made in the worksheet. For example, if you edit a cell entry and erase 
some of its text in error, clicking Undo restores the characters that you just erased 
to the entry. Likewise, if you delete a group of cells by mistake, clicking Undo 
restores the cells — including both the cell contents and the cell formatting — to 
the worksheet.

On the Quick Access toolbar, you can click the drop-down button attached to 
the Undo command button (or press Alt+3) to display a menu of the actions that 
you’ve recently taken in the worksheet. Instead of undoing one action at a time, 
you undo multiple actions by clicking the last of the actions you want to undo 
in the drop-down menu. As soon as you release the mouse button, Excel then 
restores the worksheet to the state that it was in before you took all the actions 
that you chose from this drop-down menu.

When you make an editing change in a worksheet, the Undo item on the Undo  
button’s drop-down menu actually changes to reflect the action that you just 
took. For example, if you clear a group of cells by pressing the Delete key and 
then open the Undo button’s drop-down menu, the first item on the Undo menu 
appears as follows:

Clear

If you then apply new formatting to a cell selection, such as assigning a new cen-
ter alignment, and then open the Undo drop-down menu, the first item on the 
Undo menu now appears as follows:

Center Alignment

The Undo feature works by storing a “snapshot” of the worksheet in the memory 
of your computer at each stage in its editing. Sometimes, if you attempt a large-
scale edit in a worksheet, Excel determines that sufficient free memory doesn’t 
exist to hold a snapshot of the worksheet in its current state and complete the 
planned editing change as well. For example, this can happen if you try to cut 
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and paste a really large range in a big worksheet. In such a case, Excel displays 
an Alert dialog box that indicates a lack of enough memory and asks whether you 
want to continue without Undo. If you then select the Yes option, Excel completes 
the planned edit but without the possibility of you being able to reverse its effects 
with Undo. Before you take such an action, consider how much time and effort 
would be required to manually restore the worksheet to its previous state if you 
make a mistake in carrying out your editing change.

After you use the Undo feature to reverse an editing change, the Redo button on 
the Quick Access toolbar becomes active. The Redo command item on the Redo 
button’s drop-down menu has the name of the latest type of editing that you just 
reversed with the Undo button, such as Redo Clear when the last action you took 
was to restore a cell entry that you just deleted.

You use the Redo command to restore the worksheet to the condition that it was in 
before you last clicked the Undo command. As with using the Undo button on the 
Quick Access toolbar, when you click the drop-down button attached to the Redo 
button, you can repeat multiple actions by clicking the last of the actions you want 
repeated (assuming that you used the Undo command multiple times). You can 
also restore edits that you’ve undone one at a time by pressing Ctrl+Y.

EDITING IN THE CELL VERSUS ON THE 
FORMULA BAR
When doing simple editing to a cell’s contents, you may wonder whether it’s better to 
edit the contents in the cell directly or edit the contents in the Formula bar. When edit-
ing short entries that fit entirely within the current column width, it really is a matter of 
personal choice. Some people prefer editing on the Formula bar because it’s out of the 
way of other cells in the same region of the worksheet. Other people prefer editing on 
the Formula bar because they find it easier to click the insertion point with the I-beam 
mouse pointer at precisely the place in the entry that needs editing. (When you press F2 
to edit in the cell, Excel always positions the insertion point at the very end of the entry, 
and when you double-click in the cell, you really can’t tell exactly where you’re putting 
the insertion point until you finish double-clicking, at which time you see the flashing 
insertion point.)

When it comes to editing longer cell entries (that is, text entries that spill over into 
empty neighboring cells, and numbers that, if their digits weren’t truncated by the num-
ber format assigned, wouldn’t fit within the current cell width), you probably will want to 
edit their contents on the Formula bar. You can click the Formula Bar button (the carat 
symbol turned downward) to display the entire contents of the cell without obscuring 
any of the cells of the worksheet.
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You can use Undo and Redo to toggle between a Before and After view of your 
worksheet. For example, suppose that you update an entry in a cell that was used 
in formulas throughout a data table. As soon as you enter the new number in this 
cell, Excel recalculates the table and displays the new results. To once again view 
the original version of the table before you make this latest change, you use Undo 
(Ctrl+Z). After checking some values in the original table, you then restore the 
latest change to its numbers by clicking the Redo command (Ctrl+Y). You can then 
continue in this manner as long as you want, switching between Before and After 
versions by holding down the Ctrl key as you press Z and then press Y, alternating 
between Undo and then Redo.

Clearing cells
Sometimes you need to delete an entry that you made in a cell of the worksheet 
without replacing it with any other contents. Excel refers to this kind of deletion 
as clearing the cell. This is actually more correct than referring to it as “emptying” 
the cell because although the cell may appear empty when you delete its contents, 
it may still retain the formatting assigned to it, and therefore it isn’t truly empty.

For this reason, clicking the Home tab’s Clear button (the one with the eraser icon 
in the Editing group) or pressing Alt+HE opens a drop-down menu with these 
options:

 » Clear All: Gets rid of both the contents and the formatting assigned to the 
current cell selection.

 » Clear Formats: Removes only the formatting assigned to the current cell 
selection without getting rid of the contents.

 » Clear Contents: Gets rid of only the contents in the current cell selection 
without getting rid of the formatting assigned to it. (This is the equivalent of 
pressing the Delete key.)

 » Clear Comments: Removes only the comments assigned to the cells in the 
selection without touching either the contents or the formatting.

 » Clear Hyperlinks: Displays the Clear Hyperlinks button below and to the right 
of the selection. Click that button and then click either Clear Hyperlinks Only 
(which removes the hyperlinks without also removing the hyperlink format-
ting) or Clear Hyperlinks and Formats (which removes both the hyperlinks and 
the hyperlink formatting).

 » Remove Hyperlinks: Removes the hyperlink and its formatting.

The Clear All option is great when you need to truly empty a cell of all formatting 
and contents while at the same time retaining that empty cell in the worksheet. 
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However, what about when you need to get rid of the cell as well as all its con-
tents? For example, suppose that you entered a column of numbers that you’ve 
totaled with a summing formula only to discover that midway in the list, you 
entered the same number twice, in one cell above the other. You don’t want to just 
clear the duplicate number in one of the two cells, thus leaving a single empty cell 
in the middle of your list of values. Having an empty cell in the middle of the list 
won’t skew the total, but it won’t look professional!

In this case, you want to both clear the duplicate entry and remove the newly 
emptied cell while at the same time pulling up the cells with the rest of the num-
bers in the list below along with the cell at the end that contains the formula that 
sums the values together. Excel offers just such a command on the Home tab in 
the form of the Delete button and its drop-down menu. When you click Delete 
Cells from the Delete button’s drop-down menu (or press Alt+HDD), the Delete 
dialog box appears, similar to the one shown in Figure 3-4 (sample workbook: 
Home Sales.xlsx). This dialog box lets you choose how you want the remaining 
cells to be shifted when the selected cell (or cells) is removed from the worksheet.

When you use the Delete Cells option, Excel zaps everything, including the con-
tents, formatting, and any and all attached comments. Don’t forget about the 
Undo button on the Quick Access toolbar or Ctrl+Z in case you ever zap something 
you shouldn’t have!

Figures  3-4 and  3-5 (sample workbook: Home Sales.xlsx for both) illustrate 
how Delete Cells works in the example where a duplicate entry has been mistak-
enly entered in a column of numbers that is totaled by a summing formula. In  
Figure 3-4, I selected cells A5:B5, which contain duplicate entries, before  clicking 
the Delete button’s drop-down button and then clicking Delete Cells from its 
drop-down menu to display the Delete dialog box.

FIGURE 3-4:  
When you select 

Delete Cells, 
Excel asks how 

you want the 
 remaining cells 

to be shifted. 
(Sample  

workbook: Home 
Sales.xlsx)
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When the Delete dialog box opens, the Shift Cells Left option is automatically 
selected. That’s not what I want here. Instead, I want Excel to shift the remain-
ing cells up to fill in the blank cells, so that’s why I’ve selected the Shift Cells Up 
option in Figure 3-4. Figure 3-5 shows the same worksheet after clicking OK in 
the Delete dialog box. Notice how Excel pulled up the entries in the cells below 
when it deleted the duplicate in cell B5, while at the same time automatically 
recalculating the summing formula to reflect the total of the remaining entries.

Don’t confuse the use of the Delete key and the Delete Cells command. When you 
press the Delete key, Excel automatically deletes just the contents of the cells that 
are selected (keeping the cell formatting intact), leaving seemingly blank cells in 
the worksheet. When you click Delete Cells from the Delete button’s drop-down 
menu, Excel displays the Delete dialog box, which deletes the selected cells and 
then shifts the remaining cells in the direction that you designate (up or to the 
left) to fill in what would otherwise be blank cells.

If you know that you want to use the Shift Cells Up option when deleting the 
current cell selection, you don’t have to bother with opening the Delete dialog 
box at all: Click the Delete button (rather than its drop-down button), and Excel 
instantly deletes the selection and pulls up all remaining cells.

Inserting cells
The Home tab’s Insert command (it’s in the Cells group) is the opposite of the 
Delete button immediately below it. That is, rather than removing cells for your 
worksheet, you use Insert to create new cells in your worksheet.

For example, suppose that you discover that you’ve left out three numbers from 
a column of summed numbers and that these values should have appeared in the 
middle of the column. You could shift the bottom half of the column down three 
cells to create some room, but that can be a pain if you’re dealing with a long 
column of values. Instead, you can use the Insert command to get Excel to do the 
work for you.

FIGURE 3-5:  
Worksheet after 
deleting the cell 

with the duplicate 
entry. (Sample 

workbook: Home 
Sales.xlsx)
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To make this edit, select the first data row that needs to be shifted down to make 
room for the missing entries. If you were just inserting a single entry, you can 
leave it at that. However, to let Excel know how many rows you want to insert, 
you drag the selection down until you’ve selected the number of rows you want 
inserted. For example, you’d select three rows if you wanted to insert three entries.

Figures 3-6 and 3-7 (sample workbook: Home Sales.xlsx for both) illustrate this 
situation. In Figure 3-6, I selected the cell range A5:B7, where cells for the three 
missing entries are to be inserted. I then clicked the drop-down button on the 
Insert button followed by Insert Cells on its drop-down menu. The Insert dialog 
box opens with the Shift Cells Right option button selected. Because I needed to 
have the cells in the selected range moved down to make room for the missing 
entries, I then selected the Shift Cells Down option.

After clicking OK in the Insert dialog box, Excel moves down the existing entries 
as shown in Figure  3-7. This leaves the previously occupied range A5:B7 with 
three blank data rows, where I can input my missing entries.

FIGURE 3-6:  
Inserting three 
blank cells for 

missing entries 
in two columns 
of a table while 

shifting the 
existing entries 
down. (Sample 

workbook: Home 
Sales.xlsx)

FIGURE 3-7:  
The worksheet 

table after 
 entering the 

missing entries 
in the newly 

inserted blank 
cells. (Sample 

workbook: Home 
Sales.xlsx)
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If you know that you want to move existing cells down with the Shift Cells Down 
option when inserting new cells in the current cell selection, you don’t have to 
bother with opening the Insert dialog box at all: Click the Insert button (rather 
than its drop-down button), and Excel instantly inserts new cells while moving 
the existing ones down.

A Worksheet with a View
Excel provides a number of features that can help you find your way and keep 
your place in the worksheet that needs editing. Among these are its Zoom feature, 
which enables you to increase or decrease the magnification of the worksheet 
window, thus making it possible to switch from a really up-close view to a really 
far-away view in seconds, and its Freeze Panes feature, which enables you to keep 
pertinent information, such as column and row headings, on the worksheet win-
dow as you scroll other columns and rows of data into view.

Zooming in and zooming back out again
Excel enables you to change the magnification of the active worksheet window 
with its Zoom slider feature on the Status bar in the lower-right corner of the 
window. The Zoom slider contains two buttons, one on either end:

 » Zoom Out (-): Reduces the worksheet area’s magnification percentage by  
10 percent each time you click the button.

 » Zoom In (+): Increases the worksheet area’s magnification percentage by  
10 percent each time you click the button.

You can also quickly change the worksheet area’s magnification percentage (and 
thus zoom out and in on the data) by dragging the slider’s button to the left or 
right.

When you first open the worksheet, the Zoom slider button is always located in 
the very center of the Zoom slider, putting the worksheet area magnification at 
100% (the normal screen, depending upon your computer monitor’s screen reso-
lution). As you click the Zoom Out or Zoom In button or drag the slider button, 
Excel keeps you informed of the current magnification percentage by displaying it 
to the immediate right of the Zoom In button on the status bar. Note too, that 10% 
is the lowest percentage you can select by dragging the button all the way to the 
left on the slider, and 400% is the highest percentage you can select by dragging 
the button all the way to the right.
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On a touchscreen device, you can use your fingers to zoom in and out on a work-
sheet. Stretch your forefinger and thumb out to zoom in on the cells and pinch 
them together to zoom out. As you do, the Zoom slider on the Status bar shows 
you the current zoom percentage and moves the slider right or left to follow your 
stretch or pinch gesture.

Although the Zoom slider is always available on the Status bar in any worksheet 
you have open, you can also change the worksheet area’s magnification percent-
age via the Ribbon: on the View tab, click the Zoom button (or press Alt+WQ). Excel 
opens the Zoom dialog box, where you have three ways to change the Zoom level:

 » Select one of the preset magnification percentages: 200%, 100%, 75%, 
50%, or 25%.

 » Select the Custom option and then use the Custom text box to enter any 
magnification percentage between a minimum of 10% and a maximum  
of 400%.

 » Select the Fit Selection option to have Excel change the magnification so that 
the selected cell range takes up the entire height or width of the worksheet 
area. Alternatively, select your cell range, and then click the View tab’s Zoom to 
Selection button.

If the device you’re running Excel on is equipped with a physical mouse with a 
wheel in between the two mouse buttons), you can configure Excel so that rolling 
the wheel back and forth zooms out and in on the current worksheet. To do this, 
display the Advanced tab of the Excel Options dialog box (File ➪ Options ➪ Advanced 
or Alt+FTA), and then click the Zoom on Roll with IntelliMouse check box in the 
Editing Options section. Now, instead of scrolling up the rows of the worksheet, 
rolling the wheel forward increases the magnification (by 15% until you reach 
the maximum 400%); instead of scrolling down the rows of the sheet, rolling the 
wheel backward decreases the magnification (by 15% until you reach the mini-
mum 10% value).

Figures 3-8 and 3-9 (sample workbook: Income Analysis.xlsx for both) illustrate 
how you can use the Zoom feature to first zoom out to locate a region in a large 
worksheet that needs editing and then zoom in on the region to do the editing. In 
Figure 3-8, I zoomed out on the Income Analysis to display all its data by selecting 
a 50% magnification setting. At the 50% setting, I could just barely make out the 
headings and read the numbers in the cells. I then located the cells that needed 
editing and selected their cell range (J20:L25) in the worksheet.
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I then clicked the Zoom to Selection command button on the View tab, and  
Figure 3-9 shows the result. As you can see on the Status bar, Excel boosted the 
magnification from 50% up to 232% to get the range to fit (in this case) the width 
of the worksheet area.

Because Excel immediately puts the slider button at whatever point you click, you 
can instantly return the magnification percentage to the normal 100% after select-
ing any other magnification. Click the line at the midpoint in the Zoom slider on 
the Status bar. Alternatively, in the View tab’s Zoom group, click the 100% button.

FIGURE 3-8:  
The Income 

 Analysis 
 worksheet 

after zooming 
out to a 50% 

 magnification 
setting. (Sample 

workbook: 
Income  

Analysis.xlsx)

FIGURE 3-9:  
Worksheet 

at 232% 
 magnification 

after zooming in 
on the cell range 
J20:L25. (Sample 

workbook: 
Income  

Analysis.xlsx)
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Freezing window panes
Excel’s Freeze Panes feature enables you to specify one or more rows and/or  
columns that stay put while you scroll the worksheet. For example, if you freeze 
row 1 (the top row) of the worksheet, the data in that row remains visible no  
matter how far down you scroll in the worksheet. Similarly, if you freeze column 
A (the leftmost column) of the worksheet, the data in that column remains visible 
no matter how far right you scroll in the worksheet.

How is this useful? Well, Figure 3-9 could be the poster child for the Freeze Panes 
feature. Although zooming in on the range of cells that needs editing makes their 
data entries more readable, it also removes all the column and row labels that 
enable you to figure out what data you’re looking at. If I had used the Freeze 
Panes command to freeze column A with the row labels and row 2 with the column 
labels, they would remain displayed on the screen — regardless of the magnifica-
tion settings that I select or how I scroll through the cells.

To use the Freeze Panes feature in this manner, you first position the cell pointer 
in the cell that’s located to the immediate right of the column or columns that you 
want to freeze and immediately beneath the row or rows that you want to freeze. 
Now, in the View tab’s Window group, select Freeze Panes to drop down the menu, 
and then select the Freeze Panes command. (You can also select the Freeze Panes 
command by pressing Alt+WFF.)

To freeze the top row of the worksheet (assuming that it contains column head-
ings) from anywhere in the worksheet (it doesn’t matter where the cell cursor is), 
display the View tab and choose Freeze Panes ➪ Freeze Top Row. If you want to 
freeze the first column (assuming that it contains row headings) from anywhere 
in the worksheet, display the View tab and choose Freeze Panes ➪ Freeze First 
Column.

Figures 3-10 and 3-11 (sample workbook: Income Analysis.xlsx for both) illustrate 
how this works. Figure 3-10 shows the Income Analysis worksheet after freezing 
column A and rows 1 and 2. To do this, I positioned the cell cursor in cell B3 before 
choosing Freeze Panes from the Freeze Panes button’s drop-down menu. Notice 
the thin black line that runs down column A and across row 2, marking which 
column and rows of the worksheet are frozen on the display and that now remain 
in view — regardless of how far you scroll to the right to new columns or scroll 
down to new rows.
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As Figure 3-11 shows, frozen panes stay on the screen even when you zoom in and 
out on the worksheet. For Figure 3-11, I repeated the steps I took in changing the 
magnification for Figures 3-8 and 3-9 (only this time with the frozen panes in 
place). First, I zoomed out on the Income Analysis worksheet by dialing the 50% 
magnification setting on the Zoom slider; second, I selected the range J20:L25 and 
then clicked the Zoom to Selection button on the View tab.

FIGURE 3-10:  
The income 

worksheet after 
freezing column 

A and rows 1:2 in 
the worksheet 

display. (Sample 
workbook: 

Income Analysis.
xlsx)

FIGURE 3-11:  
The income 

worksheet after 
zooming in on the 
cell range J20:L25 

after freezing 
panes. (Sample 

workbook: 
Income Analysis.

xlsx)
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Figure 3-11 shows the result. Note that with the frozen panes in place, this time 
Excel only selected a 172% magnification setting instead of the original 232% 
setting. This lower magnification setting is worth it because all the important 
information has been added to the cell range.

When you press the Ctrl+Home shortcut key after you’ve frozen panes in a work-
sheet, instead of positioning the cell cursor in cell A1 as normal, Excel positions 
the cell cursor in the first unfrozen cell. In the example illustrated in Figure 3-10, 
pressing Ctrl+Home from anywhere in the worksheet puts the cell cursor in B3. 
From there, you can position the cell cursor in A1 either by clicking the cell or by 
pressing the arrow keys.

To unfreeze the panes after you’ve finished editing, click the Unfreeze Panes 
option on the Freeze Panes button’s drop-down menu. (This option replaces 
Freeze Panes at the top of the menu.)

Saving custom views
In the course of creating and editing a worksheet, you may find that you need to 
modify the worksheet display many times as you work with the document. For 
example, you may find at some point that you need to reduce the magnification 
of the worksheet display to 75% magnification. At another point, you may need 
to return to 100% magnification and hide different columns in the worksheet. At 
some later point, you may have to redisplay the hidden columns and then freeze 
panes in the worksheet.

Excel’s Custom Views feature enables you to save any of these types of changes to 
the worksheet display. This way, instead of taking the time to manually set up the 
worksheet display that you want, you can have Excel re-create it for you by select-
ing the view. When you create a view, Excel can save any of the following set-
tings: the current cell selection, print settings (including different page setups), 
column widths and row heights (including hidden columns), display settings on 
the Advanced tab of the Excel Options dialog box, as well as the current position 
and size of the document window and the window pane arrangement (including 
frozen panes).

To create a custom view of your worksheet, follow these steps:

1. Make all the necessary changes to the worksheet display so that the 
worksheet window appears exactly as you want it to appear each time 
you select the view. Also select all the print settings on the Page Layout 
tab that you want used in printing the view. (See Book 2, Chapter 5 for 
details.)
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2. In the View tab’s Workbook Views group, click the Custom Views button 
(or press Alt+WC).

Excel opens the Custom Views dialog box, similar to the one shown in 
Figure 3-12.

3. Click Add.

Excel opens the Add View dialog box.

4. Enter a unique and descriptive name for your view in the Name text box.

Make sure that the name you give the view reflects all its pertinent settings.

5. To include print settings and hidden columns and rows in your view, 
leave the Print Settings and Hidden Rows, Columns and Filter Settings 
check boxes selected. If you don’t want to include these settings, clear 
the check mark from either one or both of these check boxes.

6. Click OK.

When you click OK, Excel closes both the Add View and Custom Views dialog 
boxes. When you next open the Custom Views dialog box, the name of your 
new view appears in the Views list box.

Custom views are saved as part of the workbook file. To be able to use them 
whenever you open the worksheet for editing, you need to save the workbook 
with the new view.

7. Click the Save button on the Quick Access toolbar or press Ctrl+S to save 
the new view as part of the workbook file.

After you create your views, you can display the worksheet in that view at any time 
while working with the worksheet. To display a view, follow these steps:

1. In the View tab’s Workbook Views group, click Custom Views (or press 
Alt+WC).

2. In the Views list box, either double-click the name of the view that you 
want to use or click the name and then click Show.

FIGURE 3-12:  
The custom 

views you create 
appear in the 

Custom Views 
dialog box.
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Always start by defining a Normal 100% view in the Custom Views dialog box 
that represents the standard view of the worksheet before you go about defining 
custom views that hide columns, freeze panes, and mess with the worksheet’s 
magnification. This way, you can recover from a special view (especially one that 
you only use in printing part of the worksheet but never use when editing it) by 
 double-clicking Normal 100% in the Views list box of the Custom Views dialog box.

Copying and Moving Stuff Around
Moving and copying worksheet data are among the most common editing tasks 
that you perform when editing a typical worksheet. Excel offers two basic meth-
ods for moving and copying a cell selection in a worksheet: First, you can use 
drag-and-drop to place the cells in a new location; second, you can cut or copy 
the contents to the Clipboard and then paste them into the desired area. Moving 
and copying data to new areas in a worksheet are basically very straightforward 
procedures. You need to keep a few things in mind, however, when rearranging 
cell entries in a worksheet:

 » When you move or copy a cell, Excel moves everything in the cell, including 
the contents, formatting, and any note assigned to the cell. (See Book 4, 
Chapter 2, for information on adding notes to cells.)

 » If you move or copy a cell so that it overlays an existing entry, Excel replaces 
the existing entry with the contents and formatting of the cell that you’re 
moving or copying. This means that you can replace existing data in a range 
without having to clear the range before moving or copying the replacement 
entries. It also means that you must be careful not to overlay any part of an 
existing range that you don’t want replaced with the relocated or copied cell 
entries.

 » When you move cells referred to in formulas in a worksheet, Excel automati-
cally adjusts the cell references in the formulas to reflect their new locations in 
the worksheet.

 » When you copy formulas that contain cell references, Excel automatically 
adjusts the cell references in the copies relative to the change in their position 
in the worksheet. (See Book 3, Chapter 1 for details on copying formulas in a 
worksheet.)

For situations in which you need to copy only a single data entry to cells in a single 
row or to cells in a single column of the worksheet, you can use AutoFill to extend 
the selection left or right or up or down by dragging the fill handle. (See Book 2, 
Chapter 1 for information about using AutoFill to extend and copy a cell entry.)
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Copying and moving with drag-and-drop
Drag-and-drop provides the most direct way to move or copy a range of cells in 
a single worksheet. To move a range, select the cells, position the pointer on any 
one of the edges of the range (the pointer’s cursor changes to a white arrowhead 
pointing to the center of a black cross with four black arrowheads), drag the range 
to its new position in the worksheet, and then release the mouse button.

Note that it can be a real drag to use drag-and-drop to copy or move a cell selec-
tion when the first cell of the range into which the cells are being copied or moved 
is far away in an unseen part of the Excel worksheet area. To make moving or 
copying easier in this scenario, set up two windows in the worksheet area: one 
that displays the cells that you’re moving or copying and another that displays 
the worksheet area into which you want to move or copy the cells. (See Book 2, 
Chapter  4 for information on setting up windows that enable this.) When you 
don’t have such windows set up, use the cut-and-paste method (as described in 
the later section, “Copying and moving with copy, cut, and paste”) to make dis-
tant moves and copies.

You can use drag-and-drop with a stylus on your touchscreen device if it’s so 
equipped. If you’re using your finger, however, you must tap the cell selection and 
then use the Cut or Copy option followed by the Paste option on the mini-toolbar 
that appears. (See “Copying and moving with copy, cut, and paste,” later in this 
chapter.)

When you use drag-and-drop with a stylus, Excel displays a pop-up menu when 
you release the rectangular outline indicating where the range is to be moved or 
copied in a new area of the worksheet by removing the stylus’ pointer from the 
touchscreen. You then select between the Move Here and Copy Here options on 
this pop-up menu to complete the move or copy operation.

Moving cells with drag-and-drop
As you drag a cell range using drag-and-drop, Excel displays only the outline 
of the range with a ScreenTip that keeps you informed of its new cell or range 
address. After you’ve positioned the outline of the selected range so that the out-
line surrounds the appropriate cells in a new area of the worksheet, release the 
mouse button or your finger or stylus from the touchscreen. Excel moves the 
selected cells (including the entries, formatting, and comments) to this area.

If the outline of the cell selection that you’re dropping encloses any cells with 
existing data entries, Excel displays an Alert dialog box asking whether you want 
to replace the contents of the destination cells. If you click OK in this dialog 
box, the overlaid data entries are completely zapped when they’re replaced by 
the incoming entries. If you inadvertently overwrite useful data, not to worry: 
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Immediately press Ctrl+Z (or click the Home tab’s Undo command) to reverse the 
move and restore the zapped cells.

Copying cells with drag-and-drop
You can use drag-and-drop to copy cell ranges as well as to move them. To modify 
drag-and-drop so that the feature copies the selected cells rather than relocating 
them, hold down the Ctrl key when you position the mouse pointer on one of the 
edges of the selected range. Excel indicates that drag-and-drop is ready to copy 
rather than move the cell selection by changing the mouse pointer to an out-
line pointer with a small plus sign in the upper-right. When the pointer assumes 
this shape, drag the outline of the selected cell range to the desired position and 
release both the Ctrl key and mouse button.

Copying and moving with  
copy, cut, and paste
Given the convenience of using drag-and-drop, you may still prefer to use the 
more traditional cut-or-copy-and-paste method when moving or copying cells in 
a worksheet. This is especially true when running Excel on a touchscreen device 
that doesn’t have access to a mouse. Cut-or-copy-and-paste uses the Clipboard 
(a special area of memory shared by all Windows programs), which provides a 
temporary storage area for the data in your cell selection until you paste the selec-
tion into its new position in the worksheet. Here are the basic techniques:

 » Moving a cell selection: Click the Home tab’s Cut command (the one with the 
scissors icon) in the Clipboard group (or press Alt+HX, Ctrl+X, or Shift+Delete).

 » Copying a cell selection: Click the Home tab’s Copy command (with the two 
sheets of paper side by side immediately beneath the Cut button) in the 
Clipboard group (or press Alt+HC, Ctrl+C, or Ctrl+Insert).

When you cut or copy a selection to the Clipboard, Excel displays a marquee around 
the cell selection (sometimes called marching ants), and the following message 
appears on the status bar:

Select destination and press ENTER or choose Paste

To complete the move or copy operation, select the first cell in the range where 
you want the relocated or copied selection to appear and then press the Enter 
key, click the Home tab’s Paste button, or press Alt+HV, Ctrl+V, or Shift+Insert. 
Excel then completes the move or copy operation, pasting the range as required, 
starting with the active cell. When selecting the first cell of a paste range, be sure 
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that you have sufficient blank cells below and to the right of the active cell so that 
the range you’re pasting doesn’t overwrite any existing data that you don’t want 
Excel to replace.

Unlike when moving and copying a cell selection with drag-and-drop, the  
cut-and-paste method doesn’t warn you when it’s about to replace existing cell 
entries in cells that are overlaid by the incoming cell range — it just goes ahead 
and replaces them with nary a beep or an alert! If you find that you moved the 
selection to the wrong area or replaced cells in error, immediately click the Undo 
button on the Quick Access toolbar or press Ctrl+Z to restore the range to its previ-
ous position in the worksheet.

“Paste it again, Sam”
When you complete a copy operation with cut-and-paste by clicking the Paste 
button in the Clipboard group at the beginning of the Ribbon’s Home tab instead 
of pressing the Enter key, Excel copies the selected cell range to the paste area in 
the worksheet without removing the marquee from the original range. You can 
continue to paste the selection to other areas in the worksheet without having to 
recopy the cell range to the Clipboard. If you don’t need to paste the cell range in 
any other place in the worksheet, you can press Enter to complete the copy oper-
ation. If you don’t need to make further copies after using the Paste command, 
you can remove the marquee from the original selection by pressing the Escape 
or the Enter key.

Also, when you paste a cell selection that you’ve copied to the Clipboard (this 
doesn’t apply when pasting cells that you’ve cut to the Clipboard), Excel displays 
the Paste Options button in the lower-right corner of the cell selection (marked 
with the word Ctrl). When you position the mouse pointer over this Paste Options 
button (or press the Ctrl key), a palette of buttons divided into three sections 
(Paste, Paste Values, and Other Paste Options) appears as shown in Figure 3-13 
(sample workbook: Home Sales.xlsx).

The buttons in these three sections of the Paste Options palette offer you the fol-
lowing choices for refining your paste operation. The eight buttons that appear in 
the Paste section are

 » Paste (P): Excel pastes everything in the cell selection (text, values, formulas, 
and cell formatting).

 » Formulas (F): Excel pastes all the text, numbers, and formulas in the current 
cell selection without their formatting.

 » Formulas & Number Formatting (O): Excel pastes the number formats 
assigned to the copied values along with their formulas.
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 » Keep Source Formatting (K): Excel copies the formatting from the original 
cells and pastes this into the destination cells (along with the copied entries).

 » No Borders (B): Excel pastes everything in the cell selection without copying 
any borders applied to its cell range.

 » Keep Source Column Widths (W): Excel makes the width of the columns in 
the destination range the same as those in the source range when it copies 
their cell entries.

 » Transpose (T): Excel changes the orientation of the pasted entries. For 
example, if the original cell entries run down the rows of a single column of 
the worksheet, the transposed pasted entries run across the columns of a 
single row.

 » Merge Conditional Formatting (G): Excel combines the conditional format-
ting rules of the source and destination ranges. You don’t see this button if 
neither range has any conditional formatting rules applied. See Book 2, 
Chapter 2 to find out more about conditional formatting.

The three buttons that appear in the Paste Values section of the Paste Options 
palette are

 » Values (V): Excel pastes only the calculated results of any formulas in the 
source cell range.

FIGURE 3-13:  
The Paste Option 

button’s palette 
with the option 

buttons that 
commonly appear 
after pasting a cell 

selection that’s 
been copied to 
the Clipboard. 

(Sample  
workbook: Home 

Sales.xlsx)
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 » Values & Number Formatting (A): Excel pastes the calculated results of any 
formulas along with all the formatting assigned to the values in the source cell 
range into the destination range.

 » Values & Source Formatting (E): Excel pastes the calculated results of all 
formulas along with all formatting assigned to the source cell range.

The four buttons that appear in the Other Paste Options section of the Paste 
Options palette are

 » Formatting (R): Excel pastes only the formatting (and not the entries) copied 
from the source cell range to the destination range.

 » Paste Link (N): Excel creates linking formulas in the destination range so that 
any changes that you make to the entries in cells in the source range are also 
reflected in the corresponding cells of the destination range.

 » Picture (U): Excel pastes only the pictures in the copied cell selection.

 » Linked Picture (I): Excel pastes a link to the pictures in the copied cell 
selection.

Taking it out of the Clipboard task pane
When the Office Clipboard is open, Excel puts the contents of all cell selections 
that you copy and paste (using the Copy and Paste command buttons or their 
keyboard equivalents) into the Office Clipboard. In fact, the Office Clipboard stores 
the contents of up to the last 24 copied-and-pasted cell selections (before replac-
ing them with new copied-and-pasted selections) not only from Excel, but from 
every Office program. Up to that point, you can examine the contents of the Office 
Clipboard and even paste your cell selections in other places in your worksheet or 
in documents open in other programs that you’re running.

To open the Clipboard task pane on the left side of the Excel program window, 
click the dialog box launcher in the lower-right corner of the Home tab’s Clip-
board group.

When the Clipboard task pane is displayed, it shows all the individual cut or copied 
items that have been placed there (up to a maximum of 24). While this pane is 
open, Excel also places there all selections that you cut or copy in the worksheet, 
even those that you paste by pressing the Enter key as well as those you don’t 
paste elsewhere.
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If you want Excel to place all selections that you cut and copy in the worksheet 
into the Office Clipboard even when the Clipboard task pane is not open, click 
Options at the bottom of the Clipboard pane and then click to activate the Collect 
Without Showing Office Clipboard option.

To paste an item on the Clipboard into a cell of one of your worksheets, click the 
cell and then click the item in the Clipboard task pane.

If you’re doing a lot of copy-or-cut-and-paste work in a worksheet using the 
Clipboard, you can have Excel automatically display the Clipboard task pane as 
you do the editing. Open the Clipboard task pane, click the Options button at the 
very bottom, and then click to activate the Show Office Clipboard Automatically 
option. When this setting is selected, Excel automatically opens the Clipboard task 
pane if you put more than two items in the Clipboard during your work session. To 
have Excel display the Clipboard task pane when you press Ctrl+C twice in a row 
(Ctrl+CC), click to activate the Show Clipboard When Ctrl+C Pressed Twice option 
from the Options menu.

Inserting rather than replacing copied cells
When you use cut-or-copy-and-paste to move or copy a cell selection, you can 
have Excel paste the data into the worksheet without replacing existing entries 
in overlaid cells. In the Home tab’s Cells group, click Insert and then click either 
Insert Cut Cells or Insert Copied Cells (depending on whether you cut or copied the 
cells to the Clipboard) instead of clicking the normal Paste command. Excel dis-
plays the Insert dialog box, where you can choose between the following options:

 » Shift Cells Right: Excel moves the existing cells to the right to make room for 
the moved or copied cells.

 » Shift Cells Down: Excel moves the existing cells down to make room for the 
moved or copied cells.

If you want to shift existing cells down to make room for the ones you’ve cut or 
copied to the Clipboard, you can click the Home tab’s Insert button rather than 
dropping down its menu.

Pasting just the good parts with Paste Special
Normally, when you paste worksheet data from the Clipboard, Excel pastes all 
the information (entries, formatting, and comments) from the cell selection into 
the designated paste area, thus replacing any existing entries in the cells that are 
overlaid. However, the Home tab’s Paste button also has a drop-down menu that 
you can use to choose how you want Excel to paste your data. You can also click 
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Paste Special from this drop-down menu (or press Alt+HVS) to open the Paste 
Special dialog box for extra pasting goodness.

The Paste Special dialog box (see Figure  3-14) offers a wide range of pasting 
options, including some that perform simple mathematical computations (Add, 
Subtract, Multiply, and Divide) between the number of cell entries that overlay 
each other. (See Table 3-1.)

FIGURE 3-14:  
The paste options 

in the Paste 
Special dialog 
box give you 

control over how 
a cell selection on 

the Clipboard is 
pasted into your 

worksheet.

TABLE 3-1 The Paste Special Dialog Box Options
Option What It Does

All Pastes all types of entries (numbers, formulas, and text), their formats, and 
comments from the selection in the paste area

Formulas Pastes only the entries (numbers, formulas, and text) from the selection in the 
paste area

Values Pastes only numbers and text from the selection in the paste area, converting all 
formulas to their current calculated values so they’re pasted into the worksheet 
as numbers

Formats Pastes only the formats from the selection into the paste area

Comments and Notes Pastes only the comments and notes from the selection into the paste area

Validation Pastes only the data validation settings from the selection into the paste area  
(see Book 2, Chapter 1 for info on data validation)

All Using Source Theme Pastes all types of entries (numbers, formulas, and text), their formats, 
comments, and notes from the selection in the paste area and uses the colors, 
fonts, and graphic effects in the theme assigned to their source worksheet  
(see Book 5, Chapter 2)

(continued)
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The options in the Paste Special dialog box are divided into two areas: Paste and 
Operation. The Paste option buttons (some of which duplicate the options on the 
drop-down menu on the Ribbon and the Paste Option’s palette in the worksheet) 
enable you to specify which components of the copied cell selection you want cop-
ied; see Table 3-1 for a list of options.

Option What It Does

All Except Borders Pastes everything but the borders assigned to the cell selection into the 
paste area

Column Widths Pastes everything into the paste area and adjusts the column widths in this area 
to match those of the original cell selection

Formulas and 
Number Formats

Pastes the labels, values, and formulas from the cell selection into the paste area, 
but only pastes the formatting of the numeric entries

Values and 
Number Formats

Pastes the labels, values, and formula results from the cell selection into the paste 
area, but only pastes the formatting of the numeric entries

All Merging 
Conditional Formats

Pastes only the numbers and number formatting that meets the conditions 
specified by conditional formatting in the cell selection (see Book 2, Chapter 2)

None Performs no mathematical operation between the values in the cell selection 
placed on the Clipboard and those in the destination range in the worksheet 
(the default)

Add Adds the values in the cell selection placed on the Clipboard to those in the 
destination range in the worksheet

Subtract Subtracts the values in the cell selection placed on the Clipboard from those in 
the destination range in the worksheet

Multiply Multiplies the values in the cell selection placed on the Clipboard with those in the 
destination range in the worksheet

Divide Divides the values in the cell selection placed on the Clipboard by those in the 
destination range in the worksheet

Skip Blanks When selected, doesn’t replace existing entries in the worksheet with any 
overlaying blank cells placed on the Clipboard as part of the cut or copied 
cell selection

Transpose When selected, switches the orientation of the entries in the cell selection placed 
on the Clipboard so that data that originally ran across the rows now runs down 
the columns in the new area of the worksheet and the data that ran down 
columns now runs across rows

Paste Link Pastes links to the original cell selection placed on the Clipboard

TABLE 3-1 (continued)
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The Operation option buttons in the Paste Special dialog box enable you to specify 
which mathematical operation, if any, should be performed between the overlay-
ing values in copy and paste ranges. Select the Skip Blanks check box when you 
don’t want Excel to replace existing entries in the paste range with overlaying 
blank cells in the copy range.

The Transpose option, which appears on the Paste button’s drop-down menu and 
the Paste Options button (also duplicated by the Transpose check box in the Paste 
Special dialog box), is particularly helpful when you have a row of column head-
ings that you want to convert into a column of row headings or when you have a 
column of row headings that you want to convert into a row of column headings. 
You can also use this option to pivot an entire table of data so that the data that 
runs across the rows now runs down the columns, and vice versa.

Figure 3-15 (sample workbook: Production Schedule - 2022.xlsx) illustrates just 
such a situation. Here, I selected the production schedule table (including the col-
umn headings) in the cell range A2:J6, clicked the Home tab’s Copy button, and 
then moved the cell cursor to cell A8. After that, I chose the Transpose option  
from the Paste button’s drop-down menu. Excel’s Live Preview feature then 
shows how this transposition would appear in the cell range A8:E17 in Figure 3-15.

FIGURE 3-15:  
Transposing 

a copy of the 
production 

schedule table so 
that dates now 

form the row 
headings and the 

part numbers 
now form the 

column headings. 
(Sample  

workbook:  
Production 

Schedule - 2022.
xlsx)
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In the transposed table, the original row headings are now the column headings 
just as the original column headings are now the row headings. Note, too, that 
when transposing the table, Excel retains any formulas from the original range 
and adjusts the cell and range operands as needed to preserve the results.

To convert a cell range that contains formulas to its calculated values (as though 
you had input them as numbers), select the cell range, click the Home tab’s Copy 
button, and then click the Paste Values option from the Paste button’s drop-down 
menu without moving the cell cursor. This causes Excel to paste the calculated val-
ues on top of the formulas that created them, thus zapping the overlaid formulas 
and leaving you with only the computed values!

Finding and Replacing Worksheet Data
No discussion of worksheet editing would be complete without including the Find 
and Replace features in Excel. You can use the Find feature to quickly locate one or 
more occurrences of a specified string (a series of characters) or numeric value in 
a worksheet. You can use the Replace feature to have Excel update the cells that it 
finds with new text or numbers.

Both the Find and the Replace features share the same dialog box — aptly called 
the Find and Replace dialog box. If you only want to find a cell’s particular con-
tents, you use the options on the Find tab. If you want to update the contents of 
some or all of the cells that you find, use the options on the Replace tab.

The Find and Replace tabs in the Find and Replace dialog box contain a bunch of 
search options that you can use in finding and replacing stuff in your worksheet. 
The only problem is that these options are hidden when you first open the Find 
and Replace dialog box. To expand the Find and Replace dialog box to display the 
extra search options on the Find and Replace tab, click the Options button.

Finding data
To use the Find command to locate information in your worksheet, follow these 
steps:

1. To search the entire worksheet, select a single cell. To restrict the search 
to a specific cell range or nonadjacent selection, select all the cells you 
want to search.
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2. In the Home tab’s Editing group, click Find & Select (the magnifying glass 
icon) and then click Find (or press either Ctrl+F or Alt+HFDF).

Excel opens the Find and Replace dialog box with the Find tab selected.

3. Type the search value that you want to locate in the Find What 
combo box.

When entering the search value, you can use the question mark (?) or asterisk (*) 
wildcards to stand in for any characters that you’re unsure of. Use the question 
mark to stand for a single character, as in Sm?th, which matches either Smith or 
Smyth. Use the asterisk to stand for multiple characters as in 9*1, which locates 
91, 94901, or even 9553 1st Street. To search with the asterisk as a literal 
character, precede the character with a tilde (~), as in ~*2.5, to locate formulas 
that are multiplied by the number 2.5. (The asterisk is the multiplication 
operator in Excel.)

If the cell holding the search string that you’re looking for is formatted in a 
particular way, you can narrow the search by specifying what formatting to 
search for.

4. Click the Format drop-down button and then either click the Format 
command to select the formatting from the Find Format dialog box or 
click the Choose Format from Cell command to select the formatting 
directly from a cell in the worksheet. (If you don’t see the Format button, 
click Options to display it.)

When you click the Format command, Excel opens the Find Format dialog box 
with the same tabs and options as the standard Format Cells dialog box 
(Number, Alignment, Font, Border, Fill, and Protection). You then select the 
formatting that you want to search for in this dialog box and click OK.

When you click the Choose Format from Cell command, the Find and Replace 
dialog box temporarily disappears until you click the cell in the worksheet that 
contains the formatting that you want to search for with the thick, white-cross 
mouse pointer with eyedropper icon.

Note that when using the Find feature to locate a search string, by default, 
Excel searches only the current worksheet for your search string. If you want 
Excel to search all the cells of all worksheets in the workbook, you need to 
follow Step 5.

5. In the Within list, choose the Workbook option to have Excel search all 
worksheets in the workbook.

If the Within drop-down list box doesn’t appear at the bottom of your Find and 
Replace dialog box, click the Options button to expand it and add the Within, 
Search, and Look In drop-down lists along with the Match Case and Match 
Entire Cell Contents check boxes.



220      BOOK 2  Worksheet Design

6. Choose the By Columns option from the Search drop-down menu to have 
Excel search down the columns (that is, down and then to the right from 
the active cell).

By default, Excel locates the search string in the contents of each cell as entered 
on the Formula bar. This means that if you’re looking for a cell that contains 
1,250 and the worksheet contains the formula =750+500, whose calculated 
value as displayed in the cell is 1,250, Excel won’t consider this cell to be a match 
because in searching the Formula bar, it finds =750+500 instead of 1,250.

7. Choose Values from the Look In drop-down menu to have Excel locate the 
search string in the contents of each cell as it’s displayed in the work-
sheet. Choose Comments from this drop-down menu instead to have 
Excel locate the search string in the comments that you’ve added to cells.

Note that when you select Comments to search the comments you’ve added to 
the worksheet, you can’t specify any formatting to search for because the 
Format button in the Find and Replace dialog box becomes grayed out.

8. Select the Match Case check box to find occurrences of the search string 
when it matches the case that you entered.

By default, Excel ignores case differences between the search string and the 
content of the cells being searched so that Assets, ASSETS, and assets all match 
the search string, Assets.

9. Select the Match Entire Cell Contents check box to find occurrences of 
the search string only when it’s the entire cell entry.

By default, Excel considers any occurrence of the search string to be a match — 
even when it occurs as part of another cell entry. So when the search string is 25, 
cells containing 25, 15.25, 25 Main Street, and 250,000 are all considered matches.

10. Click the Find All button to find all occurrences of the search string. Click 
the Find Next button to find just the first occurrence of the search string.

When you click Find All, Excel lists all the cells containing the search string in a list 
box at the bottom of the Find and Replace dialog box, as shown in Figure 3-16. 
You can then have Excel select the cell with a particular occurrence by clicking its 
link in this list box. You may have to drag the Find and Replace dialog box out of 
the way to see the selected cell.

When you click Find Next, Excel selects the next cell in the worksheet (using the 
designated search direction). To find subsequent occurrences of the search 
string, you need to continue to click Find Next until you reach the cell that you’re 
looking for. Again, you may have to drag the Find and Replace dialog box out of 
the way to see the cell that Excel has located and selected in the worksheet.

11. After you finish searching the worksheet for the search string, click the 
Close button.
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Note that Excel retains your search string and search option conditions even after 
closing the Find and Replace dialog box. To repeat a search, just press Ctrl+F and 
then click Find All or Find Next. You can also reinstate a search string that you 
used earlier in your work session by choosing it from the Find What drop-down 
menu.

Finding and replacing data
The Find feature is sufficient if all you want to do is locate an occurrence of a 
search string in your worksheet. Many times, however, you also want to change 
some or all of the cells that match the search string. For those situations, you 
use the Replace feature to locate the search string and replace it with some other 
string.

To search and replace information in your worksheet, follow these steps:

1. To search and replace the entire worksheet, select a single cell. To 
restrict the search and replace operation to a specific cell, range, or 
nonadjacent selection, select all the cells to be searched.

2. In the Home tab’s Editing group, click Find & Select (the magnifying glass 
icon) and then click Replace (or press either Ctrl+H or Alt+HFDR).

Excel opens the Find and Replace dialog box with the Replace tab selected 
(similar to the one shown in Figure 3-17). Note that if the Find and Replace 
dialog box is already open from choosing the Find option from the Find & 
Select button’s drop-down menu or pressing Ctrl+F, all you have to do is click 
the Replace tab.

FIGURE 3-16:  
Finding a value in 

a worksheet by 
using the options 

on the Find tab.
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3. In the Find What combo box, type the search string that you want to 
locate and specify any formatting to be searched by using its Format 
button.

Refer to the previous steps on finding a search string for details on specifying 
the search string in the Find What combo box and specifying the formatting to 
be searched for.

4. In the Replace With combo box, type the replacement string.

Enter this string exactly as you want it to appear in the cells of the worksheet. 
Use uppercase letters where uppercase is to appear, lowercase letters where 
lowercase is to appear, and the question mark and asterisk only where they 
are to appear. (They don’t act as wildcard characters in a replacement string.)

5. Click the Format drop-down button and click Format to select the 
formatting to be added to your replacement string from the Find Format 
dialog box. Or click Choose Format from Cell and select the formatting 
directly from a cell in the worksheet.

When you click the Format item, Excel opens a Find Format dialog box with the 
same tabs and options as the standard Format Cells dialog box. You may then 
select the formatting that you want the replacement string to have in this 
dialog box and then click OK.

When you click the Choose Format from Cell item on the Format button 
drop-down menu, the Find and Replace dialog box temporarily disappears 
until you click the cell in the worksheet that contains the formatting that you 
want the replacement string to have with the thick, white-cross mouse pointer 
with eyedropper icon.

FIGURE 3-17:  
Updating dates 
in a worksheet 
using the Find 

and Replace 
feature.
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You’re free to run formatting-only search-and-replace operations. For example, 
you may want to replace all instances of bold with italics. In this case, you don’t 
specify a string either in the Find What text box or the Replace With text box.

6. Make any necessary changes to the Within, Search, Look In, Match Case, 
and Match Entire Cell Contents options for the search string.

These options work just as they do on the Find tab. If these options aren’t 
displayed on the Replace tab of your Find and Replace dialog box, click its 
Options button to expand the dialog box.

7. Click the Find Next button to locate the first occurrence of the search 
string. Then, click the Replace button to replace the first occurrence with 
the replacement string or click the Find Next button again to skip this 
occurrence.

Using the Find Next and Replace buttons to search and replace on a case- 
by-case basis is by far the safest way to use the Find and Replace feature. If 
you’re certain (really certain) that you won’t mess up anything by replacing all 
occurrences throughout the worksheet, you can click the Replace All button to 
have Excel make the replacements globally without stopping to show you 
which cells are updated.

8. When you finish replacing entries on a case-by-case basis, click the Close 
button.

This action abandons the Find and Replace operation and closes the Find and 
Replace dialog box. When you globally replace the search string, Excel auto-
matically closes the Find and Replace dialog box after replacing the last search 
string match.

You can click the Undo button on the Quick Access toolbar or press Ctrl+Z to restore 
any replacements that you made in error.

Getting It Right: Spell Checking Your 
Worksheets

You can use Excel’s Spell Check feature to catch all the spelling mistakes that Auto-
Correct lets slip through. To spell check your worksheet, display the Review tab and 
click the Spelling button (it’s in the Proofing group) or press either F7 or Alt+RS.

When you spell check a worksheet, Excel looks up each word in the Excel Diction-
ary. If the word isn’t found (as is often the case with less-common last names, 
abbreviations, acronyms, and technical terms), Excel selects the cell with the 
unknown spelling and then displays a Spelling dialog box showing the unknown 
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word in the Not in Dictionary text box with suggested correct spellings shown in 
a Suggestions list box below, which is similar to the one shown in Figure 3-18.

You can then take any of the following actions to take care of the unknown word:

 » Click one of the words in the Suggestions list box and then click the Change 
button to have Excel replace the unknown word with the selected suggestion 
and continue spell checking the rest of the worksheet.

 » Click one of the words in the Suggestions list box and then click the Change All 
button to have Excel replace all occurrences of the unknown word with the 
selected suggestion throughout the entire worksheet and then continue spell 
checking.

 » Click the Ignore Once button to let the misspelling slide just this once and 
continue spell checking the rest of the worksheet.

 » Click the Ignore All button to ignore all occurrences of the unknown word in 
the worksheet and continue spell checking.

 » Click the Add to Dictionary button to add the unknown word to a custom 
dictionary so that Excel knows the word the next time you spell check the 
worksheet.

 » Click the AutoCorrect button to have Excel add the unknown word to the 
AutoCorrect list with the selected suggestion as its automatic replacement.

Excel checks the spelling of the cells only in the current worksheet (and not all the 
sheets in the workbook). If you want Excel to spell check another worksheet, you 
need to click its sheet tab to make it active and then click the Spelling button on the 
Review tab (or press F7). If you want to spell check just a portion of the worksheet, 
select the range or nonadjacent cell selection before you start the spell check.

FIGURE 3-18:  
Spell checking a 
worksheet with 

the Spelling  
dialog box.
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When Excel finishes checking the current worksheet or cell selection, the pro-
gram displays an alert dialog box that indicates that the spell checking has been 
completed.

Changing the spelling options
When you use the Spell Check feature, you can change certain spelling options to 
better suit the worksheet that you’re checking. To change the spelling options, 
you have two choices:

 » If the Spelling dialog box is onscreen (meaning Excel has found what it thinks 
is a spelling error), click the Options button.

 » Choose File ➪ Options ➪ Proofing.

The Proofing tab of the Excel Options dialog box opens with the following options 
in the When Correcting Spelling in Microsoft Office Programs section:

 » Ignore Words in UPPERCASE: Remove the check mark from the check box so 
that Excel marks acronyms and other words entered in all uppercase letters 
as misspellings.

 » Ignore Words That Contain Numbers: Remove the check mark from the 
check box so that Excel marks words such as B52 that contain letters and 
numbers as misspellings.

 » Ignore Internet and File Addresses: Remove the check mark from the check 
box so that Excel marks web URL addresses such as www.dummies.com and 
file pathnames such as c:\documents\finance as misspellings.

 » Flag Repeated Words: Remove the check mark so that Excel no longer marks 
repeated words such as Bora Bora as misspellings.

 » Enforce Accented Uppercase in French: Add a check mark so that Excel 
marks uppercase French words that don’t have the proper accent marks as 
misspellings.

 » Suggest from Main Dictionary Only: Have Excel use only the main dictionary 
when doing a spell check (thus, ignoring all words that you’ve added to a 
custom dictionary).

 » Custom Dictionaries: Open the Custom Dictionaries dialog box where you 
can edit the words in a custom dictionary or add a new custom dictionary to 
be used in spell checking. (See “Adding words to the custom dictionary” that 
follows.)

http://www.dummies.com
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 » French Modes or Spanish Modes: Choose between the traditional or more 
modern spellings of French or Spanish words, respectively.

 » Dictionary Language: Specify the language and country of the dictionary to 
use when spell checking the worksheet.

Adding words to the custom dictionary
You use the Add to Dictionary button in the Spelling dialog box to add unknown 
words to a custom dictionary. By default, Excel adds words to a custom diction-
ary file named RoamingCustom.dic. To locate this file on your device, search for 
roamingcustom.dic in the Windows File Explorer.

If you want, you can create other custom dictionaries to use when spell checking 
your worksheets. To create a new custom dictionary, follow these steps:

1. If the Spelling dialog box is onscreen, click Options. Otherwise, choose 
File ➪ Options ➪ Proofing.

Excel opens the Excel Options dialog box with the Proofing tab displayed.

2. Click Custom Dictionaries.

Excel opens the Custom Dictionaries dialog box.

3. Click New.

Excel opens the Create Custom Dictionary dialog box.

4. Type the name for your new custom dictionary and then click Save.

After the Create Custom Dictionary dialog box closes, the name of the custom 
dictionary you created appears underneath RoamingCustom.dic (Default) in 
the Dictionaries list box.

5. (Optional) To restrict the language of a custom dictionary, use the Dictionaries 
list to select the custom dictionary and then use the Dictionary Language 
drop-down list to select the language you want to use.

6. To make the new custom dictionary the default dictionary into which 
new words are saved, click the dictionary’s name in the Dictionaries list 
and then click Change Default.

7. Click OK to close the Custom Dictionaries dialog box and then click OK 
again to close the Excel Options dialog box.

Excel returns you to the Spelling dialog box.

8. Click the Add to Dictionary button to add the unknown word to the new 
default custom dictionary and then continue spell checking your 
worksheet.
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Note that Excel continues to add all unknown words to your new custom dictionary 
until you change the default back to the original custom dictionary (or to another 
custom one that you’ve created). To change back and start adding unknown words 
to the original custom dictionary, select the RoamingCustom.dic file in the Cus-
tom Dictionaries dialog box and then click the Change Default button.

You can directly edit the words that you add to your custom dictionary. Click the 
Custom Dictionaries button on the Proofing tab of the Excel Options dialog box 
(File ➪ Options ➪ Proofing or Alt+FTP), select the dictionary in the Dictionaries list, 
and then click the Edit Word List command button. Excel then opens a dialog box 
with the default dictionary’s name that contains a Word(s) text box where you can 
enter new words to add to the custom dictionary and a Dictionary list box below 
that lists all the words added to the dictionary in alphabetical order. To add a new 
word to the dictionary, type it in the Word(s) text box (carefully, you don’t want 
to add a misspelling to the dictionary) and then click the Add button. To remove a 
word, click it in the Dictionary list box and then click the Delete button.

Looking Up and Translating Stuff
Besides the very useful Spelling button (discussed in the previous section), the 
Proofing, Insights, and Language groups on the Review tab contains three other 
command buttons that can come in handy from time to time:

 » Thesaurus opens the Thesaurus task pane. Here you can look up synonyms 
for a particular term that you enter into the Search For text box or for the 
contents of the current cell automatically entered into this text box.

 » Smart Lookup opens the Search task pane where you can find a definition 
and more online information about the entry that’s in the active cell when you 
click it.

 » Translate opens the Translator task pane. Here you can look up a translation for 
a particular term that you enter into the text box under the From drop-down 
button. You then select the target language using the To drop-down button’s list.

Marking Invalid Data
Besides using the Data Validation feature to restrict what kind of data can be 
entered into cell ranges of a worksheet as described in Book 2, Chapter 1, you can 
also use Data Validation to mark all the data (by circling their cells) that are out-
side of expected or allowable parameters.
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To use the Data Validation feature in this way, you follow these general steps:

1. Select the cell range(s) in the worksheet that need to be validated and 
marked.

2. In the Data tab’s Data Tools group, click Data Validation (or press 
Alt+AVV) to open the Data Validation dialog box.

3. Use the Data Validation dialog box options to set up the validation 
criteria that determine which values in the selected cell range are out of 
bounds. (See Book 2, Chapter 1 for details.)

4. In the Data tab’s Data Tools group, choose Data Validation ➪ Circle Invalid 
Data (or press Alt+AVI).

Figure  3-19 (sample worksheet: Chris’s Cookies - Annual Sales.xlsx) shows an 
example of how you may use Data Validation to mark entries that are below a cer-
tain threshold. In this case, I set up Data Validation to check the monthly sales in 
the Total column (the range D4:D15) and treat as valid any values that are above 
$50,000. Values below that threshold get marked with a red circle around their cells.

To remove the circles from the cells marked as invalid, choose the Clear Valida-
tion Circles option from the Data Validation button’s drop-down menu or press 
Alt+AVR.  To clear the validation settings from the cells, select the range and 
then open the Data Validation dialog box and click its Clear All button before you 
click OK.

FIGURE 3-19:  
Using Data 

 Validation to 
mark entries 

below a  specified 
 threshold 

($50,000 in 
this case) in a 

table. (Sample 
 worksheet: Chris’s 

Cookies - Annual 
Sales.xlsx)
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Managing Worksheets

Being able to manage and reorganize the information in your worksheets is 
almost as important as being able to input data and edit it. As part of these 
skills, you need to know how to manipulate the columns and rows of a 

single worksheet, the worksheets within a single workbook, and, at times, other 
workbooks that contain supporting or relevant data.

This chapter examines how to reorganize information in a single worksheet by 
inserting and deleting columns and rows, as well as how to apply outlining to data 
tables that enables you to expand and collapse details by showing and hiding col-
umns and rows. It also covers how to reorganize and manipulate the worksheets 
in a workbook and discusses strategies for visually comparing and transferring 
data between the different workbooks that you have open for editing.

Chapter 4

IN THIS CHAPTER

 » Inserting and deleting columns and 
rows in a worksheet

 » Splitting the worksheet into separate 
panes

 » Outlining data in a worksheet

 » Inserting, deleting, and reordering 
worksheets in a workbook

 » Opening windows on different 
worksheets in a workbook

 » Working with multiple workbooks

 » Opening windows on different 
workbooks

 » Consolidating worksheet data
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Reorganizing the Worksheet
Every Excel worksheet that you work with has 16,384 columns and 1,048,576 
rows — no more, no less, regardless of how many or how few of its cells you use. 
As your worksheet grows, you may find it beneficial to rearrange the data so that it 
doesn’t creep. Many times, this involves deleting unnecessary columns and rows 
to bring the data ranges and tables closer to each other. At other times, you may 
need to insert new columns and rows in the worksheet to create some breathing 
room between the groups of data.

Within the confines of this humongous worksheet space, your main challenge 
is often keeping tabs on all the information spread out throughout the sheet. At 
times, you may find that you need to split the worksheet window into panes so 
that you can view two disparate regions of the worksheet together in the same 
window and compare their data. For large ranges and tables, you may want to 
outline the worksheet data so that you can immediately collapse the information 
down to the summary or essential data and then just as quickly expand the infor-
mation to show some or all of the supporting data.

Being cautious when deleting  
and inserting columns and rows
The first thing to keep in mind when inserting or deleting columns and rows in a 
worksheet is that these operations affect all 1,048,576 rows in those columns and 
all 16,384 columns in those rows. As a result, you have to be sure that you’re not 
about to adversely affect data in unseen rows and columns of the sheet before you 
undertake these operations. Note that, in this regard, inserting columns or rows 
can be almost as detrimental as deleting them if, by inserting them, you split 
apart existing data tables or lists whose data should always remain together.

One way to guard against inadvertently deleting existing data or splitting apart a 
single range is to use the Zoom slider on the Status bar to zoom out on the sheet 
and then check visually for intersecting groups of data in the hinterlands of the 
worksheet. You can do this quickly by dragging the Zoom slider button to the left 
to the 25% setting. Of course, even at the smallest zoom setting of 10%, you can 
see neither all the columns nor all the rows in the worksheet, and because every-
thing’s so tiny at that setting, you can’t always tell whether the column or row 
you intend to fiddle with intersects those data ranges that you can identify.

Another way to check is to press End+→ or End+↓ to move the cell pointer from 
data range to data range across the column or row affected by your column or row 
deletion. Remember that pressing End plus an arrow key when the cell pointer is 
in a blank cell jumps the cell pointer to the next occupied cell in its row or column. 
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That means if you press End+→ when the cell pointer is in row 52 and the pointer 
jumps to cell XFD52 (the end of the worksheet in that row), you know that there 
isn’t any data in that row that would be eliminated by your deleting that row or 
shifted up or down by your inserting a new row. So too, if you press End+↓ when 
the cell pointer is in column D and the cell pointer jumps down to cell D1048576, 
you’re assured that no data is about to be purged or shifted left or right by that 
column’s deletion or a new column’s insertion at that point.

When you’re sure that you aren’t about to make any problems for yourself in 
other, unseen parts of the worksheet by deleting or inserting columns, you’re 
ready to make these structural changes to the worksheet.

Deleting columns and rows
To delete columns or rows of the worksheet, select them by clicking their column 
letters or row numbers in the column or row header and then, in the Home tab’s 
Cells group, click the Delete button. (Alternatively, click any selected column or 
row header and then click Delete.) Remember that you can select groups of col-
umns and rows by dragging through their letters and numbers in the column or 
row header. You can also select nonadjacent columns and rows by holding down 
the Ctrl key as you click them.

When you delete a column, all the data entries within the cells of that column are 
immediately zapped. At the same time, all remaining data entries in succeeding 
columns to the right move left to fill the blank left by the now-missing column. 
When you delete a row, all the data entries within the cells of that row are imme-
diately eliminated, and the remaining data entries in rows below move up to fill in 
the gap left by the missing row.

Rather than selecting the columns or rows you want to delete in advance, you can 
also select just one or more cells in each column or row. Then, in the Home tab’s 
Cells group, click the Delete button’s drop-down list and then click either Delete 
Sheet Columns or Delete Sheet Rows.

Pressing the Delete key is not the same as clicking the Delete button on the Home 
tab of the Ribbon. When you press the Delete key after selecting columns or rows 
in the worksheet, Excel clears the data entries in their cells without adjusting any 
of the existing data entries in neighboring columns and rows. Click the Delete 
command button on the Home tab when your purpose is both to delete the data 
in the selected columns or rows and to fill in the gap by adjusting the position of 
entries to the right and below the ones you eliminate.
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Should your row or column deletions remove data entries referenced in formulas, 
the #REF! error value replaces the calculated values in the cells of the formulas 
affected by the elimination of the original cell references. You must then either 
restore the deleted rows or columns or re-create the original formula and then 
recopy it to get rid of these nasty formula errors. (See Book 3, Chapter 2 for more 
on error values in formulas.)

Adding new columns and rows
To insert a new column or row into the worksheet, you select the column or row 
where you want the new blank column or row to appear (again by clicking its col-
umn letter or row number in the column or row header):

 » For a new column, select the column to the left of where you want the new 
column to appear.

 » For a new row, select the row above where you want the new column to 
appear.

Then, in the Home tab’s Cells group, click the Insert button. (Alternatively, click 
any selected column or row header and then click Insert.)

When you insert a blank column, Excel moves the existing data in the selected 
column to the right, while simultaneously moving any other columns of data on 
the right over one. When you insert a blank row, Excel moves the existing data in 
the selected row down, while simultaneously adjusting any other rows of existing 
data that fall below it down by one.

To insert multiple columns or rows at one time in the worksheet, select the col-
umns or rows where you want the new blank columns or rows to appear (by 
dragging through their column letters and row numbers in the column and row 
header) before you click the Home tab’s Insert command.

Rather than first selecting entire columns or rows, you can also select just one or 
more cells in each column or row. Then, in the Home tab’s Cells group, click the 
Insert command’s drop-down menu and then click either the Insert Sheet Col-
umns or Insert Sheet Rows option, respectively.

Whenever your column or row insertions reposition data entries that are refer-
enced in other formulas in the worksheet, Excel automatically adjusts the cell 
references in the formulas affected to reflect the movement of their columns left 
or right or rows up or down.
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Splitting the worksheet into panes
Excel enables you to split the active worksheet window into two or four panes. 
After splitting up the window into panes, you can use the Excel workbook’s hori-
zontal and vertical scroll bars to bring different parts of the same worksheet into 
view. This is great for comparing the data in different sections of a table that 
would otherwise not be legible if you zoomed out far enough to have both sections 
displayed in the worksheet window.

You can split a worksheet window in three ways:

 » Two horizontal panes: Position the cell pointer in column A of the worksheet 
in the cell where you want the horizontal division to take place. Every row 
above that cell appears in the top pane, while the cell’s row and every row 
below it appears in the bottom pane.

 » Two vertical panes: Position the cell pointer in the first row of the column 
where the split is to occur. Every column to the right of that cell appears in the 
right pane, while the cell’s column and every column to its left appears in the 
left pane.

 » Four panes: Position the cell pointer in the cell in the column to the right of 
where you want the vertical dividing line and in the row below where you 
want the horizontal dividing line. After you create the split, the cell pointer is in 
the upper-left corner of the lower-right pane.

To perform the split, in the View tab’s Window group, click the Split button (or 
press Alt+WS).

Excel displays the borders of the window panes you create in the document win-
dow with a bar that ends with the vertical or horizontal split bar. To modify the 
size of a pane, you position the white-cross pointer on the appropriate dividing 
bar. When the pointer changes to either a double-headed arrow (if you’re adjust-
ing two panes) or a four-headed arrow (if you’re adjusting four panes), drag the 
bar until the pane is the correct size and release the mouse button.

When you split a window into panes, Excel automatically synchronizes the scroll-
ing, depending on how you split the worksheet. When you split a window into two 
horizontal panes, as shown in Figure  4-1 (sample workbook: Income Analysis.
xlsx), the worksheet window contains a single horizontal scroll bar and two sep-
arate vertical scroll bars. This means that all horizontal scrolling of the two panes 
is synchronized, while the vertical scrolling of each pane remains independent.
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When you split a window into two vertical panes, as shown in Figure 4-2 (sample 
workbook: Income Analysis.xlsx), the situation is reversed. The worksheet win-
dow contains a single vertical scroll bar and two separate horizontal scroll bars. 
This means that all vertical scrolling of the two panes is synchronized, while hori-
zontal scrolling of each pane remains independent.

When you split a window into two horizontal and two vertical panes, as shown in 
Figure 4-3 (sample workbook: Income Analysis.xlsx), the worksheet window con-
tains two horizontal scroll bars and two separate vertical scroll bars. This means 
that vertical scrolling is synchronized in the top two window panes when you use 
the top vertical scroll bar and synchronized for the bottom two window panes 

FIGURE 4-1:  
The Regional 

Income 
 worksheet with 

the window 
divided into 

two horizontal 
panes at row 10. 

(Sample  
workbook: 

Income  
Analysis.xlsx)

FIGURE 4-2:  
The Regional 

Income 
 worksheet with 

the window 
divided into two 
vertical panes at 

column F.  
(Sample 

 workbook: 
Income Analysis.

xlsx)
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when you use the bottom vertical scroll bar. Likewise, horizontal scrolling is syn-
chronized for the left two window panes when you use the horizontal scroll bar on 
the left, and it’s synchronized for the right two window panes when you use the 
horizontal scroll bar on the right.

To remove all panes from a window when you no longer need them, you click the 
View tab’s Split button, press Alt+WS, or drag the dividing bar (with the black  
double-headed split arrow cursor) either for the horizontal or vertical pane until 
you reach one of the edges of the worksheet window. You can also remove a 
pane by positioning the mouse pointer on a pane-dividing bar and then, when it 
changes to a double-headed or four-headed split arrow, double-clicking it.

Remember that on a touchscreen, you can also remove the panes in a worksheet 
by directly double-tapping the pane-dividing bar with your finger or stylus.

You can freeze panes in the window so that information in the upper pane and/
or in the leftmost pane remains in the worksheet window at all times, no matter 
what other columns and rows you scroll to or how much you zoom in and out on 
the data. (See Book 2, Chapter 3 for more on freezing panes.)

Outlining worksheets
The Outline feature enables you to control the level of detail displayed in a work-
sheet range or table. To outline a range or table, the data must use a uniform lay-
out with a row of column headings identifying each column of data and summary 
rows that subtotal and total the data in rows above (like the CG Music Sales data 
shown in Figure 4-4; sample workbook: CG Music Sales.xlsx).

FIGURE 4-3:  
Splitting the 

worksheet 
window into 

four panes: two 
horizontal and 
two vertical at 

cell F10. (Sample 
workbook: 

Income Analysis.
xlsx)
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After outlining a range, you can condense the range’s display when you want 
to see only particular levels of summary information, and you can just as easily 
expand the outlined range to display levels of detail data as needed. Being able to 
control which outline level is displayed in the worksheet makes it easy to print 
summary reports with levels of data (see Book 2, Chapter 5) as well as to chart just 
the summary data (see Book 5, Chapter 1).

Worksheet outlines are a little different from the outlines you created in high 
school and college. In those outlines, you placed the headings at the highest 
level (I.) at the top of the outline with the intermediate headings indented below. 
Most worksheet outlines, however, seem backward in the sense that the highest 
level summary row and column are located at the bottom and far right of the table 
or list of data, with the columns and rows of intermediate supporting data located 
above and to the left of the summary row and column.

The reason that worksheet outlines often seem “backward” when compared to 
word-processing outlines is that, most often, to calculate your summary totals 
in the worksheet, you naturally place the detail levels of data above the summary 
rows and to the left of the summary columns that total them. When creating a 
word-processing outline, however, you place the major headings above subordi-
nate headings, while at the same time indenting each subordinate level, reflecting 
the way we read words from left to right and down the page.

FIGURE 4-4:  
Automatic outline 

applied to the 
CG Music sales 
data with three 
levels of detail 

 displayed.  
(Sample 

 workbook: CG 
Music Sales.xlsx)
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Creating the outline
To create an outline, position the cell pointer in the range or table containing the 
data to be outlined. In the Data tab’s Outline group, click Group and then click 
Auto Outline (or press Alt+AGA).

By default, Excel assumes that summary rows in the selected data table are below 
their detail data, and summary columns are to the right of their detail data, which 
is normally the case. If, however, the summary rows are above the detail data, and 
summary columns are to the left of the detail data, Excel can still build the outline, 
but you need to adjust some settings.

In the Data tab’s Outline group, start by clicking the dialog box launcher in the 
lower-right corner of the group. In the Settings dialog box that appears, dese-
lect the Summary Rows below Detail and/or Summary Columns to Right of Detail 
check boxes. Also, you can have Excel automatically apply styles to different levels 
of the outline by selecting the Automatic Styles check box. (For more information 
on these styles, see the “Applying outline styles” section, later in this chapter.) 
To have Excel create the outline, click Create; if you click OK, instead, Excel closes 
the dialog box without outlining the selected worksheet data.

Figure 4-4 shows the first part of the outline created by Excel for the CG Music 
Sales worksheet. Note the outline symbols that Excel added to the worksheet when 
it created the outline. Figure 4-4 identifies most of these outline symbols (the Show 
Detail button with the plus sign is not displayed in this figure; see Figure 4-6), and 
Table 4-1 explains their functions.

If you don’t see any of the outline doodads identified in Figure 4-4 and Table 4-1, 
it means that Excel is configured not to show them. Open the Excel Options dialog 
box and display the Advanced tab (or press Alt+FTA). In the Display Options for 
This Worksheet section, select the Show Outline Symbols If an Outline Is Applied 
check box, and then click OK. Alternatively, you can press Ctrl+8 to toggle the 
display of the outline symbols.

TABLE 4-1 Outline Buttons
Button Function

Row Level (1-8) 
and Column 
Level (1-8)

Displays a desired level of detail throughout the outline (1, 2, 3, and so on, up to 8). 
When you click an outline’s level bar rather than a numbered Row Level or Column 
Level button, Excel hides only that level in the worksheet display, the same as clicking 
the Hide Detail button (explained below).

Show Detail (+) Expands the display to show the detail rows or columns that have been collapsed.

Hide Detail (–) Condenses the display to hide the detail rows or columns that are included in its row or 
column level bar.
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You can have only one outline per worksheet. If you’ve already outlined one table 
and then try to outline another table on the same worksheet, Excel displays the 
Modify Existing Outline alert box when you click the Outline command. If you 
click OK, Excel adds the outlining for the new table to the existing outline for the 
first table (even though the tables are nonadjacent). To create separate outlines 
for different data tables, you need to place each table on a different worksheet of 
the workbook.

Applying outline styles
You can apply predefined row and column outline styles to your data.

To apply these styles when creating the outline, don’t use the Auto Outline 
method. Instead, in the Data tab’s Outline group, click the dialog box launcher in 
the lower-right corner to open the Settings dialog box, select the Automatic Styles 
check box, and then click Create.

If your outline is already displayed, you can still apply the outline styles. First, 
select all the cells in the outlined range. In the Data tab’s Outline group, click the 
dialog box launcher in the lower-right corner to open the Settings dialog box, 
select the Automatic Styles check box, and then click Apply Styles.

Figure  4-5 (sample workbook: CG Music Sales.xlsx) shows you the sample CG 
Music Sales table after I applied the automatic row and column styles to the out-
lined table data. In this example, Excel applied two row styles (RowLevel_1 and 
RowLevel_2) and two column styles (ColLevel_1 and ColLevel_2) to the work-
sheet table.

FIGURE 4-5:  
The outline 

after applying 
 automatic styles 
with the Settings 

dialog box. 
(Sample  

workbook: CG 
Music Sales.xlsx)
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The RowLevel_1 style is applied to the entries in the first-level summary row 
(row 21) and makes the font appear in bold. The ColLevel_1 style is applied to 
the data in the first-level summary column (column R, which isn’t shown in  
the figure), and it, too, makes the font bold. The RowLevel_2 style is applied  
to the data in the second-level rows (rows 8, 14, and 20), and this style adds  
italics to the font. The ColLevel_2 style is applied to all second-level summary 
columns (columns E, I, M, and Q), and it also italicizes the font. (Note that columns 
M and Q are also not visible in Figure 4-5.)

Sometimes Excel can get a little finicky about applying styles to an existing out-
line. If, in the Settings dialog box, you click the Automatic Styles check box, click 
the Apply Styles button, and nothing happens to your outline, re-create the out-
line by selecting the Data tab’s Group➪  Auto Outline command in the Outline 
group. Excel displays an alert dialog box asking you to confirm that you want to 
modify the existing outline. When you click OK, Excel redisplays your outline, this 
time with the automatic styles applied.

Displaying and hiding different outline levels
The real effectiveness of outlining worksheet data becomes apparent when you 
start using the outline symbols to change the way the data are displayed in the 
worksheet. By clicking the appropriate row or column level symbol, you can 
immediately hide detail rows and columns to display just the summary informa-
tion in the table. For example, Figure 4-6 (sample workbook: CG Music Sales.xlsx) 
shows you the CG Music Sales table after clicking the number 2 Row Level button 
and number 2 Column Level button. Here, you see only the first- and second-level 
summary information; that is, the totals for the quarterly and annual totals for 
the three types of music sales.

FIGURE 4-6:  
Collapsed  

worksheet outline 
showing first- and 

secondary-level 
summary  

information. 
(Sample  

workbook: CG 
Music Sales.xlsx)
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You can also hide and display levels of the outlined data via the Ribbon. First, 
position the cell cursor in the column or row. Then, in the Data tab’s Outline 
group, click either Hide Detail (or press Alt+AJ) or Show Detail (or press Alt+AH). 
The great thing about using these buttons or their hot key equivalents is that they 
work even when the outline symbols are not displayed in the worksheet.

Figure 4-7 (sample workbook: CG Music Sales.xlsx) shows you the same table, 
this time after clicking the number 1 Row Level button and number 1 Column 
Level button. Here, you see only the first-level summary for the column and the 
row, that is, the grand total of the annual CG Music sales. To expand this view 
horizontally to see the total sales for each quarter, you would click the number 
2 Column Level button. To expand this view even further horizontally to display 
each monthly total in the worksheet, you would click the number 3 Column Level 
button. So too, to expand the outline vertically to see totals for each type of media, 
you would click the number 2 Row Level button. To expand the outline one more 
level vertically so that you can see the sales for each type of music as well as each 
type of media, you would click the number 3 Row Level button.

When displaying different levels of detail in a worksheet outline, you can use the 
Hide Detail and Show Detail buttons along with the Row Level and Column Level 
buttons. For example, Figure 4-8 (sample workbook: CG Music Sales.xlsx) shows 
you another view of the CG Music outlined sales table. Here, in the horizontal 
dimension, you see all three column levels have been expanded, including the 
monthly detail columns for each quarter. In the vertical dimension, however, only 
the detail rows for the Download sales have been expanded. The detail rows for the 
CD and Vinyl Record sales are still collapsed.

To create this view of the outline, you click the number 2 Column Level and 
Row Level buttons, and then click only the Show Detail (+) button located to the 
left of the Total Download Sales row heading. When you want to view only the  
summary-level rows for each media type, you can click the Hide Detail (–) but-
ton to the left of the Total Download Sales heading, or you can click its level bar 
(drawn from the collapse symbol up to the first music type to indicate all the detail 
rows included in that level).

FIGURE 4-7:  
Totally collapsed 

worksheet outline 
showing only 
the first-level 

 summary 
 information. 

(Sample 
 workbook: CG 

Music Sales.xlsx)
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Excel adjusts the outline levels displayed on the screen by hiding and redisplaying 
entire columns and rows in the worksheet. Therefore, changes that you make that 
reduce the number of levels displayed in the outlined table also hide the display 
of all data outside of the outlined table that are in the affected rows and columns.

After selecting the rows and columns you want displayed, you can then remove 
the outline symbols from the worksheet display to maximize the amount of data 
displayed onscreen. To do this, press Ctrl+8.

Manually adjusting the outline levels
Most of the time, Excel’s Auto Outline feature correctly outlines the data in your 
range or table. Every once in a while, however, you’ll have to manually adjust one 
or more of the outline levels so that the outline’s summary rows and columns 
include the right detail rows and columns. To adjust levels of a worksheet outline, 
you must select the rows or columns that you want to promote to a higher level 
(that is, one with a lower level number) in the outline and then click the Group 
button on the far right side of the Data tab of the Ribbon. If you want to demote 
selected rows or columns to a lower level in the outline, select the rows or columns 
with a higher level number and then click the Ungroup button on the Data tab.

Before you use the Group and Ungroup buttons to change an outline level, you 
must select the rows or columns that you want to promote or demote. To select 
a particular outline level and all the rows and columns included in that level, you 
need to display the outline symbols (Ctrl+8), and then hold down the Shift key 
as you click its collapse or expand symbol. Note that when you click an expand 
symbol, Excel selects not only the rows or columns visible at that level, but all the 
hidden rows and columns included in that level as well. If you want to select only 
a particular detail or summary row or column in the outline, you can click that row 
number or column letter in the worksheet window, or you can hold down the Shift 

FIGURE 4-8:  
Worksheet  

outline expanded 
to show only 

details for 
 Download sales 

for all four 
quarters. (Sample 

workbook: CG 
Music Sales.xlsx)



242      BOOK 2  Worksheet Design

key and click the dot (period) to the left of the row number or above the column 
letter in the outline symbols area.

If you select only a range of cells in the rows or columns (as opposed to entire 
rows and columns) before you click the Group and Ungroup command buttons, 
Excel displays the Group or Ungroup dialog box, which contains a Rows and Col-
umns option button (with the Rows button selected by default). To promote or 
demote columns instead of rows, click the Columns option button before you click 
OK. To close the dialog box without promoting or demoting any part of the out-
line, click Cancel.

To see how you can use the Group and Ungroup command buttons on the Data 
tab of the Ribbon to adjust outline levels, consider once again the CG Music Sales 
outline. When Excel created this outline, the program didn’t include row 3 (which 
contains only the row heading, Downloads) in the outline. As a result, when you 
collapse the rows by selecting the number 1 Row Level button to display only the 
first-level Total Sales summary row (refer to Figure 4-7), this Downloads row 
heading remains visible in the table, even though it should have been included and 
thereby hidden along with the other summary and detail rows.

You can use the Group command button to move this row (3) down a level so that 
it’s included in the first level of the outline. You click the row header 3 to select the 
row and then click the Group command button on the Data tab (or press Alt+AGG). 
Figure 4-9 (sample workbook: CG Music Sales.xlsx) shows you the result of doing 
this. Notice how the outside level bar (for level 1) now includes this row. Now, 
when you collapse the outline by clicking the number 1 row level button, the head-
ing in row 3 is hidden as well, as shown in Figure 4-10 (sample workbook: CG 
Music Sales.xlsx).

FIGURE 4-9:  
Manually 

 adjusting the 
level 1 rows in 
the worksheet 

outline. (Sample 
workbook: CG 

Music Sales.xlsx)
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Removing an outline
To delete an outline from your worksheet, display the Data tab, and then in the 
Outline group, click the drop-down button attached to the Ungroup button and 
then click Clear Outline (or you can press Alt+AUC). Note that removing the outline 
doesn’t affect the data in any way — Excel merely removes the outline structure. 
Also note that it doesn’t matter what state the outline is in at the time you select 
this command. If the outline is partially or totally collapsed, deleting the outline 
automatically displays all the hidden rows and columns in the data table or list.

Restoring an outline that you’ve removed isn’t one of the commands that you 
can undo (Ctrl+Z). If you clear an outline by mistake, you must re-create it all 
over again. For this reason, most often you’ll want to expand all the outline levels 
(by clicking the lowest number column and row level button) and then hide all 
the outline symbols by pressing Ctrl+8 rather than permanently remove the out-
line. Note that if you press Ctrl+8 when your worksheet table isn’t yet outlined, 
Excel displays an alert dialog box indicating that it can’t show the outline symbols 
because no outline exists. This alert also asks you whether you want to create an 
outline. To go ahead and outline the worksheet, click OK or press Enter. To remove 
the alert dialog box without creating an outline, click Cancel.

Creating different custom views of the outline
After you’ve created an outline for your worksheet table, you can create custom 
views that display the table in levels of detail. Then, instead of having to display 
the outline symbols and manually click the Show Detail and Hide Detail buttons or 
the appropriate row level buttons and/or column level buttons to view a particular 
level of detail, you select the appropriate outline view in the Custom Views dialog 
box (View➪  Custom Views or Alt+WCV).

When creating custom views of outlined worksheet data, be sure that you leave 
the Hidden Rows, Columns, and Filter Settings check box selected in the Include 
in View section of the Add View dialog box. (See Book 2, Chapter 3 for details on 
creating and using custom views in a worksheet.)

FIGURE 4-10:  
Collapsing 

the adjusted 
 worksheet 

 outline to the first 
level summary 

 information. 
(Sample  

workbook: CG 
Music Sales.xlsx)
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Reorganizing the Workbook
Any new workbook that you open already comes with a single blank worksheet. 
Although most of the workbooks you create and work with may never wander 
beyond the confines of this one worksheet, you do need to know how to organ-
ize your worksheet information three-dimensionally for those occasions when 
spreading out all the information in one sprawling worksheet is not practical. 
However, the normal, everyday problems related to keeping on top of the infor-
mation in a single worksheet can easily get out of hand when you use multiple 
worksheets in a workbook. For this reason, you need to be sure that you are fully 
versed in the basics of using multiple worksheets.

The sheet tabs shown at the bottom of each workbook are the keys to keeping your 
place in a workbook. To tell which sheet is current, you have only to look at which 
sheet tab appears on the top, matches the background of the other cells in the 
worksheet, and has its name displayed in bold type and underlined.

To move between the sheets in a workbook, you can click the sheet tab for that 
worksheet or press Ctrl+PgDn (next sheet) or Ctrl+PgUp (preceding sheet) until 
the sheet is selected. If the sheet tab for the worksheet you want isn’t displayed 
on the scroll bar at the bottom of the document window, use the tab scrolling but-
tons (the buttons with the left- and right-pointing triangles) to bring it into view.

To use the tab scrolling buttons, click the one with the right-pointing triangle to 
bring the next sheet into view and click the one with the left-pointing triangle to 
bring the preceding sheet into view. Ctrl-click the tab scrolling buttons with the 
directional triangles to display the very first or very last group of sheet tabs in a 
workbook. Ctrl-clicking the button with the triangle pointing left to a vertical line 
brings the first group of sheet tabs into view; Ctrl-clicking the button with the 
triangle pointing right to a vertical line brings the last group of sheet tabs into 
view. When you scroll sheet tabs to find the one you’re looking for, don’t forget to 
click the desired sheet tab to make the worksheet current.

Right-click either of the tab scrolling buttons to display the Activate dialog box. 
This dialog box displays the names of all the worksheets in the current workbook 
in their current order. You can then scroll to and activate any of the sheets by 
selecting them followed by OK or by double-clicking them.

Excel indicates that more worksheets are in a workbook whose tabs are not visi-
ble by adding a continuation button (indicated by an ellipsis, that is, three dots in 
a row) either immediately following the last visible tab on the right or the first 
visible tab on the left. Keep in mind that you can also scroll the next or previously 
hidden sheet tab into view by clicking the continuation button on the right of the 
last visible sheet tab or left of the first visible tab, respectively.
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Renaming a worksheet
When you add new worksheets to a new workbook, Excel gives each one a default 
sheet name along the lines of Sheet2, Sheet3, and so on. Boring! And not helpful 
because these default names don’t describe the content of the worksheet. To make 
it easier to navigate and work with multi-sheet workbooks, you should give all 
your worksheets short, descriptive names.

To rename a worksheet, you take these steps:

1. Bring the worksheet tab into view, if it’s not already.

2. Double-click the worksheet tab. Alternatively, choose Home➪   
Format➪  Rename Sheet. (You can also press Alt+HOR or right-click the 
sheet tab and then click Rename.)

Excel opens the tab name text for editing and positions the insertion point at 
the end of the name.

3. Replace or edit the name on the sheet tab and press Enter.

Note that the name must be unique in the workbook, no longer than 31 
characters, and can include any character except the following: \ / ? * [ ] and :.

When you rename a worksheet in this manner, keep in mind that Excel then 
uses that sheet name in any formulas that refer to cells in that worksheet. So, for 
instance, if you rename Sheet2 to Sales and then create a formula in cell A10 of 
Sheet1 that adds its cell B10 to cell C34 in Sheet2, the formula in cell A10 becomes

=B10+Sales!C34

This is in place of the more obscure =B10+Sheet2!C34. For this reason, keep your 
sheet names short and to the point so that you can easily and quickly identify the 
sheet and its data without creating excessively long formula references.

Designer sheets
Excel makes it easy to color-code the worksheets in your workbook. This makes it 
possible to create a color scheme that helps either identify or prioritize the sheets 
and the information they contain.

When you color a sheet tab, note that the tab appears in that color only when it’s 
not the active sheet. The moment you select a color-coded sheet tab, it becomes 
white with just a gradient of the assigned color appearing under the sheet name. 
Note, too, that when you assign darker colors to a sheet tab, Excel automatically 
reverses out the sheet name text to white when the worksheet is not active.
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Color coding sheet tabs
To assign a new color to a sheet tab, follow these three steps:

1. Click the tab you want to color if it’s displayed at the bottom of the 
workbook window. Otherwise, press Ctrl+PgDn until the sheet is active.

Don’t forget that you have to select and activate the sheet whose tab you want 
to color, or you end up coloring the tab of whatever sheet happens to be 
current at the time you perform the next step.

2. On the Home tab, click the Format button (or press Alt+HOT).

Excel displays a color palette.

An alternative way to display the color palette is to right-click the tab and then 
click Tab Color on the shortcut menu that appears.

3. Click the color you want to assign to the current sheet tab.

To remove color-coding from a sheet tab, repeat Steps 1 and 2, and then click the 
No Color command near the bottom of the color palette.

Assigning a graphic image as the 
sheet background
If coloring the sheet tabs isn’t enough for you, you can also assign a graphic image 
to be used as the background for all the cells in the entire worksheet. Just be aware 
that the background image must either be very light in color or use a greatly 
reduced opacity for your worksheet data to be read over the image. This probably 
makes most graphics that you have readily available unusable as worksheet back-
ground images. It can, however, be quite effective if you have a special corporate 
watermark graphic (as with the company’s logo at extremely low opacity) that 
adds just a hint of a background without obscuring the data being presented in 
its cells.

To add a local graphic file as the background for a worksheet, take these steps:

1. Click the sheet tab if it’s displayed at the bottom of the workbook 
window, or press Ctrl+PgDn until the sheet is active.

Don’t forget that you have to select and activate the sheet to which the graphic 
file will act as the background, or you end up assigning the file to whatever 
sheet happens to be current at the time you perform the following steps.

2. In the Page Layout tab’s Page Setup group, click the Background com-
mand (or press Alt+PG).

Excel opens the Insert Pictures dialog box.



M
an

ag
in

g 
W

or
ks

he
et

s

CHAPTER 4  Managing Worksheets      247

3. Click the Browse button to the right of the From a File link.

Excel opens the Sheet Background dialog box.

4. Open the folder that contains the image you want to use, click the image 
file, and then click Insert.

Excel applies the image as the background for all cells in the current work-
sheet. (Usually, the program does this by stretching the graphic so that it takes 
up all the cells that are visible in the Workbook window. In the case of some 
smaller images, the program does this by tiling the image so that it’s duplicated 
across and down the viewing area.)

A graphic image that you assign as the worksheet background doesn’t appear in 
the printout, unlike the pattern and background colors that you assign to ranges 
of cells in the sheet.

To remove a background image, click the Page Layout tab’s Delete Background 
command (which replaces the Background button when you assign a background 
image to a worksheet) or press Alt+PG again.

You can also turn online graphics into worksheet backgrounds. Select the Page 
Layout tab’s Background command and use the Bing Image Search text box to 
search for the image you want to use. (See Book 5, Chapter 2 for details.) When 
you locate the online image you want to use, double-click its thumbnail to down-
load the image and insert it into the current worksheet as the sheet’s background.

Adding worksheets
You can add as many worksheets as you need to build out your workbook model. 
To add a new worksheet, click the New Sheet button (the plus inside a circle 
icon), which always appears immediately to the right of the last sheet tab in the 
workbook.

Excel inserts a new worksheet after whatever sheet was active when you clicked 
New Sheet and the program assigns it the next available sheet number (Sheet2, 
Sheet3, Sheet4, and so on).

You can also insert a new sheet (and not necessarily a blank worksheet) into  
the workbook by right-clicking a sheet tab and then clicking Insert at the top 
of the tab’s shortcut menu. Excel opens the Insert dialog box containing differ-
ent file icons that you can select — Worksheet, Chart, MS Excel 4.0 Macro, and 
MS Excel 5.0 Dialog, along with a variety of different worksheet templates. Click 
Worksheet to insert a blank worksheet; click Chart to insert a specialized chart 
sheet (see Book 5, Chapter 1); click MS Excel 4.0 Macro to insert a macro sheet 
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(Book 8, Chapter 1); click MS Excel 5.0 to insert a sheet for a custom dialog box; 
or click a template to insert a worksheet that follows a template design (Book 2, 
Chapter 1). Note that when you insert a new sheet using the Insert dialog box, 
Excel inserts the new sheet to the left of the worksheet that’s active (in contrast 
to clicking the New Sheet button, which inserts the new sheet to the right of the 
active worksheet).

If you find that a single worksheet just never seems sufficient for the kind of 
workbooks you normally create, you can change the default number of sheets 
that are automatically available in all new workbook files that you open. To do 
this, open the Excel Options dialog box (File➪  Options or Alt+FT) and select the 
General tab. Then use the Include This Many Sheets text box to specify the default 
number of worksheets you want to see in each new workbook you create (up to a 
maximum of 255).

Deleting worksheets
To remove a worksheet, first make the sheet active. Then, in the Home tab’s Cells 
group, click the Delete drop-down button and choose Delete Sheet from its drop-
down menu (or press Alt+HDS). Alternatively, right-click the worksheet’s tab and 
then click Delete from its shortcut menu. If Excel detects that the worksheet con-
tains some data, the program then displays an alert dialog box cautioning you that 
the worksheet you’re about to zap will be permanently deleted. To go ahead and 
delete the sheet (data and all), click Delete. To preserve the worksheet, click Can-
cel or press the Escape key.

Deleting a sheet is one of those actions that you can’t undo with the Undo button 
on the Quick Access toolbar. This means that after you click the Delete button, 
you’ve kissed your worksheet goodbye, so don’t do this unless you’re certain that 
you aren’t dumping needed data. Also, keep in mind that you can’t delete a work-
sheet if that sheet is the only one in the workbook until you’ve inserted another 
blank worksheet: Excel won’t allow a workbook file to be completely sheetless.

Changing the sheets
Excel enables you to rearrange the order of the sheets in your workbook. To move 
a sheet, click and drag its sheet tab to the new position in the row of tabs. As you 
drag, the pointer changes shape to an arrowhead on a dog-eared piece of paper, 
and you see a black triangle pointing downward above the sheet tabs. When this 
triangle is positioned where you want the sheet moved, release the mouse button.

If you need to copy a worksheet to another position in the workbook, hold down 
the Ctrl key as you click and drag the sheet tab. As you drag, the pointer changes 
shape to an arrowhead on a dog-eared piece of paper that includes a plus sign (+), 
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and you see a black triangle pointing downward above the sheet tabs. When this 
triangle is positioned where you want the sheet copied, release the mouse button. 
Excel creates a copy with a new sheet tab name based on the number of the copy 
and the original sheet name. For example, if you copy Sheet1 to a new place in the 
workbook, the first copy is renamed Sheet1 (2) (the next copy would be Sheet1 (3), 
and so on). You can then rename the worksheet whatever you want.

You can also move or copy a worksheet by right-clicking its sheet tab and then 
choosing the Move or Copy command to open the Move or Copy dialog box. In the 
Before Sheet list box, click the name of the worksheet that you want the currently 
active worksheet to now precede. If you want to copy the worksheet, select the 
Create a Copy check box. Click OK to make it so.

Editing and formatting multiple  
worksheets as a group
If you’re working on a bunch of worksheets that share essentially the same layout 
and require the same type of formatting, you may not have to edit and format the 
sheets individually. Excel offers the welcome capability of editing and formatting 
more than one worksheet at a time. A collection of two or more selected work-
sheets is called a group.

For example, suppose that you have a workbook that contains annual sales work-
sheets (named YTD2020, YTD2021, and YTD2022) for three consecutive years. The 
worksheets share the same layout (with months across the columns and quarterly 
and annual totals, locations, and types of sales down the rows) but lack standard 
formatting.

To format any part of these three worksheets in a single operation, you resort 
to group editing, which requires selecting the three sales worksheets. Click the 
YTD2020 sheet tab, hold down Ctrl, and click the YTD2021 and YTD2022 sheet 
tabs. Alternatively, if the three sheets appear consecutively, you can click the 
YTD2020 tab and then hold down the Shift key as you click the YTD2022 tab.

After you select the last sheet, the Group indicator appears in the title bar of the 
active document window.

The Group indicator lets you know that any editing changes you make to the cur-
rent worksheet will affect all the sheets that are currently selected. For example, 
if you select a row of column headings and add bold and italics to the headings in 
the current worksheet, the same formatting is applied to the same cell selection in 
all the selected sheets. All headings in the same cell range in the other worksheets 
are now in bold and italics. Keep in mind that you can apply not only formatting 
changes to a cell range, but also editing changes, such as replacing a cell entry, 
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deleting a cell’s contents, or moving a cell selection to a new place in the work-
sheet. These changes affect all the worksheets you have selected as long as they’re 
grouped together.

After you’re finished making editing changes that affect all the grouped work-
sheets, you can break up the group by right-clicking one of the grouped sheet tabs 
and then clicking Ungroup Sheets at the top of the shortcut menu. As soon as you 
break up the group, the Group indicator disappears from the title bar. Any editing 
or formatting changes that you make once again affect only the cells in the active 
worksheet.

To select all the worksheets in the workbook for group editing in one operation, 
right-click the tab of the sheet where you want to make the editing changes that 
affect all the other sheets, and then choose Select All Sheets from its shortcut 
menu.

Hiding worksheets
Another technique that comes in handy when working with multiple worksheets 
is hiding particular worksheets in the workbook. Just as you can hide particu-
lar columns, rows, and cell ranges in a worksheet, you can also hide particular 
worksheets in the workbook. For example, you may want to hide a worksheet that 
contains sensitive (for-your-eyes-only) material, such as the one with all the 
employee salaries in the company or the one that contains all the macros used in 
the workbook.

As with hiding columns and rows, hiding worksheets enables you to share 
onscreen or print the contents of the workbook without the data in worksheets 
that you consider either unnecessary or too private for widespread distribution 
but which, nonetheless, are required in the workbook. Then after you’ve finished 
sharing the workbook onscreen or after the workbook is printed, you can redisplay 
the worksheets by unhiding them.

To hide a worksheet, first make it active by selecting its sheet tab. In the Home 
tab’s Cells group, click the Format command, and then click Hide & Unhide➪  Hide 
Sheet (or press Alt+HOUS). Alternatively, right-click the worksheet tab and then 
click Hide. Excel temporarily removes this worksheet’s tab from the row of sheet 
tabs.

To redisplay any of the sheets you’ve hidden, click the Home tab’s Format com-
mand, then click Hide & Unhide➪  Unhide Sheet (or press Alt+HOUH) to display 
the Unhide dialog box. Alternatively, right-click any worksheet tab and then click 
Unhide.
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In the Unhide Sheet list box, click the name of the sheet that you want to display 
once again in the workbook. If you want to restore multiple sheets, hold down Ctrl 
and click each sheet you want to unhide. Click OK and Excel redisplays the hidden 
worksheet (or worksheets).

Opening windows on different sheets
The biggest problem with keeping your worksheet data on different worksheets 
rather than keeping it all together on the same sheet is being able to compare the 
information on the different sheets. When you use a single worksheet, such com-
parisons aren’t so bad because you can split the workbook window into horizontal 
or vertical panes (see “Splitting the worksheet into panes,” earlier in this chapter) 
and then scroll different sections of the sheet into view.

If you want to compare data located in different worksheets, however, you need to 
open new windows for the workbook — one for each worksheet you want to view. 
You then arrange the windows so that you can see the data you want to compare 
from all the worksheets. However, rather than fussing with moving and sizing 
windows, you can get Excel to do the heavy lifting by running the View Side by 
Side command to tile the windows one above the other and automatically syn-
chronize the scrolling between them.

Comparing worksheet windows side by side
Figure 4-11 helps illustrate how the View Side by Side feature works. This figure 
contains two windows showing parts of two different worksheets (2020 Sales and 
2021 Sales) in the same workbook (CG Music 2020 – 2022 Sales.xlsx). These 
windows are arranged horizontally so that they fit one above the other and to 
show more data, I have unpinned the Ribbon in both windows so that only the 
row of tabs are visible.

As you can see, the top window shows the upper-left portion of the first work-
sheet with the 2020 sales data, while the lower window shows the upper-left 
portion of the second worksheet with the 2021 sales data. Note that both windows 
contain the same sheet tabs (although different tabs are active in the different 
windows) but that only the top, active window is equipped with a set of horizontal 
and vertical scroll bars. However, because Excel automatically synchronizes the 
scrolling between the windows, you can use the single set of scroll bars to bring 
different sections of the two sheets into view.
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Here are the steps I followed to create and arrange these windows in the CG Music 
2020 – 2022 Sales.xlsx workbook:

1. Open the workbook file for editing and then create a new window by 
clicking the View tab’s New Window command (it’s in the Window group), 
or by pressing Alt+WN.

Excel appends the number 2 to the workbook’s filename displayed at the top 
of the screen (as in CG Music 2020 – 2022 Sales.xlsx - 2) to indicate 
that a new window has been added to the workbook.

2. In the View tab’s Window group, click the View Side by Side command 
(the one with the icon that shows two pages side by side), or press 
Alt+WB.

Excel displays the Compare Side by Side dialog box.

Note that you only see this dialog box if you have at least one other Excel 
window open. If you just have the two windows of your workbook open, Excel 
arranges the two windows one on top of the other, so you can skip the rest of 
these steps.

3. In the Compare Side by Side With list, click the other workbook window.

4. Click OK to arrange the two workbook windows one on top of the other, 
as shown in Figure 4-11.

FIGURE 4-11:  
Use Excel’s View 

Side by Side 
 command to 

compare data 
stored on two 

different sheets 
in the same 
 workbook.  

(Sample  
workbook: CG  
Music 2020 – 

2022 Sales.xlsx)
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You can switch between open workbook windows by clicking the View tab’s Switch 
Windows button followed by the name of the window you want to activate.

Immediately below the View Side by Side command button in the Windows group 
on the View tab of the Ribbon, you find these two command buttons:

 » Synchronous Scrolling: When you select this button, any scrolling that you 
do in the worksheet in the active window is mirrored and synchronized in the 
worksheet in the inactive window beneath it. To scroll the worksheet in the 
active window independently of the inactive window, deactivate the 
Synchronous Scrolling button.

 » Reset Window Position: Click this button if you manually resize the active 
window (by dragging its size box) and then want to restore the two windows 
to their previous side-by-side arrangement.

To remove the side-by-side windows, click the View tab’s View Side by Side com-
mand button again or press Alt+WB.  Excel returns the windows to the display 
arrangement (see “Window arrangements” that follows for details) that you 
were using before clicking the View Side by Side command the first time. If you  
haven’t previously selected a display option in the Arrange Windows dialog box, 
Excel displays the active window full size.

Note, too, that you can use Excel’s View Side by Side feature to compare work-
sheets in different workbooks just as well as different sheets in the same work-
book. (See “Comparing windows on different workbooks” later in this chapter.)

Window arrangements
After creating one or more additional windows for a workbook (by clicking the 
View tab’s New Window command), you can then vary their arrangement by 
clicking the View tab’s Arrange All button (or by pressing Alt+WA) to open the 
Arrange Windows dialog box. The Arrange Windows dialog box contains the fol-
lowing four options:

 » Tiled: Excel arranges and sizes the windows so that they all fit side by side on 
the screen in the order in which you open them (when only two windows are 
open, selecting the Tiled or Vertical option results in the same side-by-side 
arrangement).

 » Horizontal: Excel sizes the windows equally and then arranges them one 
above the other (this is the default arrangement option that Excel uses when 
you click the View Side by Side command button).
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 » Vertical: Excel sizes the windows equally and then arranges them next to one 
other, vertically from left to right.

 » Cascade: Excel arranges and sizes the windows so that they overlap one 
another with only their title bars visible.

To ensure that Excel arranges only the windows you have open for your workbook, 
select the Windows of Active Workbook check box and click OK.

After arranging your windows, you can then select different sheets to display in 
either window by clicking their sheet tabs, and you can select different parts of the 
sheet to display by using the window’s scroll bars.

To activate different windows on the workbook so that you can activate a different 
worksheet by selecting its sheet tab and/or use the scroll bars to bring new data 
into view, click the window’s title bar or press Ctrl+F6 until its title bar is selected.

When you want to resume normal, fullscreen viewing in the workbook window, 
click the Maximize button in one of the windows. To get rid of a second window, 
click its button on the taskbar and then click its Close Window button on the far-
right side of the menu bar (the one with the X). (Be sure that you don’t click the 
Close button on the far-right of the Excel title bar, because doing this closes your 
workbook file and exits you from Excel!)

Viewing workbook stats
After you’ve spent some time building an impressive workbook model, you may 
start asking yourself some questions: How many tables am I using? How many 
formulas have I created? What is the last cell on the current worksheet? Well, 
okay, maybe you’ve never even thought to ask these questions. That’s fine. The 
good news is that, just in case curiosity strikes, the answers are a few of clicks 
away.

Excel displays stats for both the entire workbook and the current worksheet, so 
begin by selecting the worksheet you want to see statistics for. Click the Review 
tab and then, in the Proofing group, click Workbook statistics. Excel opens the 
Workbook Statistics dialog box, which is similar to the one shown in Figure 4-12.
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Working with Multiple Workbooks
Working with more than one worksheet in a single workbook is bad enough but 
working with worksheets in different workbooks can be really wicked. The key to 
doing this successfully is just keeping track of “who’s on first”; you do this by 
opening and using windows on the individual workbook files you have open.

With the different workbook windows in place, you can then compare the data 
in different workbooks, use the drag-and-drop method to copy or move data 
between workbooks, or even copy or move entire worksheets.

Comparing windows on different 
workbooks
To work with sheets from different workbook files you have open, you manu-
ally arrange their workbook windows in the Excel work area, or you click the 
View tab’s View Side by Side command (or press Alt+WB). If you have only two 
workbooks open when you do this, Excel places the active workbook that you last 
opened above the one that opened earlier (with their active worksheets displayed). 
If you have more than two workbooks open, Excel displays the Compare Side by 
Side dialog box where you click the name of the workbook that you want to com-
pare with the active one and then click OK.

If you need to compare more than two workbooks on the same screen, instead of 
clicking the View tab’s View Side by Side button, you click the View tab’s Arrange 
All button and then select the desired Arrange option (Tiled, Horizontal, Vertical, 
or Cascading) in the Arrange Windows dialog box. Just make sure when selecting 
this option that the Windows of Active Workbook check box is not selected in the 
Arrange Windows dialog box.

FIGURE 4-12:  
The  Workbook 

Statistics 
 command tells 
you a few vital 

statistics for 
your current 

 worksheet 
and the entire 

workbook.
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Transferring data between open windows
After you arrange the windows on your different workbooks the way you want 
them, you can compare or transfer information between the windows. To compare 
data in different workbooks, you switch between the different windows, activat-
ing and bringing the regions of the different worksheets you want to compare 
into view.

To move data between workbook windows, arrange the worksheets in these win-
dows so that both the cells with the data entries you want to move and the cell 
range into which you want to move them are both displayed in their respective 
windows. Select the range you want to move, drag it to the other worksheet win-
dow, drag it to the first cell of the destination range, and release the mouse but-
ton. To copy data between workbooks, you follow the same steps, except that 
you hold down the Ctrl key as you drag the selected range from one window to 
another. (See Book 2, Chapter 3 for information on using drag-and-drop to copy 
and move data entries.)

When you’re finished working with workbook windows arranged in some manner, 
you can return to the normal full-screen view by clicking the Maximize button on 
one of the windows. As soon as you maximize one workbook window, all the rest 
of the arranged workbook windows are made full size as well. If you used the View 
Side by Side feature to set up the windows, you can do this by clicking the View 
tab’s View Side by Side command button again or by pressing Alt+WB.

Moving or copying sheets from one  
workbook to another
Instead of copying cell ranges from one workbook to another, you can move (or 
copy) entire worksheets between workbooks. You can do this with drag-and-drop 
or by choosing the Move or Copy Sheet option from the Format command button’s 
drop-down menu on the Ribbon’s Home tab.

To use drag-and-drop to move a sheet between open windows, you drag its sheet 
tab from its window to the place on the sheet tabs in the other window. When 
you release the mouse button, the entire worksheet is moved from one file to the 
other, and its sheet tab now appears among the others in that workbook. To copy a 
sheet rather than move it, you perform the same steps, except that you hold down 
the Ctrl key as you drag the sheet tab from one window to the next.
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To use the Move or Copy Sheet option on the Format command button’s drop-
down menu to move or copy entire worksheets, you follow these steps:

1. Open both the workbook containing the sheets to be moved or copied 
and the workbook where the sheets will be moved or copied to.

Both the source and destination workbooks must be open to copy or move 
sheets between them.

2. Click the workbook window with sheets to be moved or copied.

Doing this activates the source workbook so that you can select the sheet or 
sheets you want to move or copy.

3. Select the sheet tab of the worksheet or worksheets to be moved or 
copied.

To select more than one worksheet, hold down the Ctrl key as you click the 
individual sheet tabs.

4. In the Home tab’s Cells group, click the Format button and then choose 
Move or Copy Sheet (or press Alt+HOM).

Excel opens the Move or Copy dialog box.

5. From the To Book drop-down menu, choose the filename of the work-
book into which the selected sheets are to be moved or copied.

If you want to move or copy the selected worksheets into a new workbook file, 
click the (New Book) item at the very top of this drop-down menu.

6. In the Before Sheet list box, click the name of the sheet that should 
immediately follow the sheet(s) that you’re about to move or copy into 
this workbook.

If you want to move or copy the selected sheet(s) to the very end of the 
destination workbook, click (Move to End) at the bottom of this list box.

7. If you want to copy the selected sheet(s) rather than move them, click 
the Create a Copy check box.

If you don’t click this check box, Excel automatically moves the selected sheet(s) 
from one workbook to the other instead of copying them.

8. Click OK to close the Move or Copy dialog box and complete the move or 
copy operation.
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Consolidating Worksheets
Excel allows you to consolidate data from different worksheets into a single work-
sheet. Using the program’s Consolidate command button on the Data tab of the 
Ribbon, you can easily combine data from multiple worksheets. For example, you 
can use the Consolidate command to total all budget worksheets prepared by each 
department in the company or to create summary totals for income statements for 
a period of several years. If you used a template to create each worksheet you’re 
consolidating, or an identical layout, Excel can quickly consolidate the values by 
virtue of their common position in their respective worksheets. However, even 
when the data entries are laid out differently in each worksheet, Excel can still 
consolidate them provided that you’ve used the same labels to describe the data 
entries in their respective worksheets.

Most of the time, you want to total the data that you’re consolidating from the 
worksheets. By default, Excel uses the SUM function to total all the cells in the 
worksheets that share the same cell references (when you consolidate by position) 
or that use the same labels (when you consolidate by category). You can, however, 
have Excel use any of the other following statistical functions when doing a con-
solidation: AVERAGE, COUNT, COUNTA, MAX, MIN, PRODUCT, STDEV, STDEVP, 
VAR, or VARP. (See Book 3, Chapter 5 for more information on these functions.)

To begin consolidating the sheets in the same workbook, you select a new work-
sheet to hold the consolidated data. (If need be, insert a new sheet in the work-
book by clicking the Insert Worksheet button.) To begin consolidating sheets in 
different workbooks, open a new workbook. If the sheets in the workbooks are 
generated from a template, open the new workbook for the consolidated data from 
that template.

Before you begin the consolidation process on the new worksheet, you choose  
the cell or cell range in this worksheet where the consolidated data is to appear. 
(This range is called the destination area.) If you select a single cell, Excel expands 
the destination area to columns to the right and rows below as needed to accom-
modate the consolidated data. If you select a single row, the program expands the 
destination area down subsequent rows of the worksheet, if required to accom-
modate the data. If you select a single column, Excel expands the destination area 
across columns to the right, if required to accommodate the data. If, however, you 
select a multi-cell range as the destination area, the program does not expand the 
destination area and restricts the consolidated data just to the cell selection.

If you want Excel to use a particular range in the worksheet for all consolidations 
you perform in a worksheet, assign the range name Consolidate_Area to this cell 
range. Excel then consolidates data into this range whenever you use the Consol-
idate command.
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When consolidating data, you can select data in sheets in workbooks that you’ve 
opened in Excel or in sheets in unopened workbooks stored on disk. The cells that 
you specify for consolidation are referred to as the source area, and the worksheets 
that contain the source areas are known as the source worksheets.

If the source worksheets are open in Excel, you can specify the references of the 
source areas by pointing to the cell references (even when the Consolidate dialog 
box is open, Excel allows you to activate different worksheets and scroll through 
them as you select the cell references for the source area). If the source work-
sheets are not open in Excel, you must type in the cell references as external 
references, following the same guidelines you use when typing a linking formula 
with an external reference (except that you don’t type =). For example, to specify 
the data in range B4:R21 on Sheet1 in a workbook named CG Music - 2022 Sales.
xlsx as a source area, you enter the following external reference:

'[CG Music – 2022 Sales.xlsx]Sheet1'!$b$4:$r$21

Note that if you want to consolidate the same data range in all the worksheets that 
use a similar filename (for example, CG Music - 2020 Sales, CG Music - 2021 
Sales, CG Music - 2022 Sales, and so on), you can use the asterisk (*) or the 
question mark (?) as wildcard characters to stand for missing characters as in

'[CG Music - 20?? Sales.xlsx]Sheet1'!$B$4:$R$21

In this example, Excel consolidates the range A2:R21 in Sheet1 of all versions of 
the workbooks that use “CG - Music - 20” in the main file when this name is fol-
lowed by another two characters (be they 20, 21, 22, and so on).

When you consolidate data, Excel uses only the cells in the source areas that con-
tain values. If the cells contain formulas, Excel uses their calculated values, but 
if the cells contain text, Excel ignores them and treats them as though they were 
blank. (Except in the case of category labels when you’re consolidating your data 
by category as described later in this chapter.)

Consolidating by position
You consolidate worksheets by position when they use the same layout (such as 
those created from a template). When you consolidate data by position, Excel does 
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not copy the labels from the source areas to the destination area, only values. To 
consolidate worksheets by position, you follow these steps:

1. Open all the workbooks with the worksheets you want to consolidate. If 
the sheets are all in one workbook, open it in Excel.

Now you need to activate a new worksheet to hold the consolidated data. If 
you’re consolidating the data in a new workbook, you need to open it 
(File➪  New or Alt+FN). If you’re consolidating worksheets generated from a 
template, use the template to create the new workbook in which you are to 
consolidate the worksheet data.

2. Click the New Sheet button to open a new worksheet to hold the consoli-
dated data.

Next, you need to select the destination area in the new worksheet that is to 
hold the consolidated data.

3. Click the cell at the beginning of the destination area in the consolidation 
worksheet or select the cell range if you want to limit the destination 
area to a particular region.

If you want Excel to expand the size of the destination area as needed to 
accommodate the source areas, just select the first cell of this range.

4. In the Data tab’s Data Tools group, click the Consolidate command (or 
press Alt+AN).

Excel opens the Consolidate dialog box, shown in Figure 4-13. By default, Excel 
uses the SUM function to total the values in the source areas. If you want to 
use another statistical function such as AVERAGE or COUNT, select the desired 
function from the Function drop-down list box.

FIGURE 4-13:  
Using the 

 Consolidate 
dialog box 

to total sales 
data for three 

years stored 
on  separate 
worksheets.
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5. (Optional) Select the function you want to use from the Function drop-
down list box if you don’t want the values in the source areas summed 
together.

Now, you need to specify the source ranges to be consolidated and add them 
to the All References list box in the Consolidate dialog box. To do this, you 
specify each range to be used as the source data in the Reference text box 
and then click the Add button to add it to the All References list box.

6. Select the cell range or type the cell references for the first source area in 
the Reference text box.

When you select the cell range by pointing, Excel minimizes the Consolidate 
dialog box to the Reference text box so that you can see what you’re selecting. 
If the workbook window is not visible, choose it from the Switch Windows button 
on the View tab or the Windows taskbar and then select the cell selection as you 
normally would. (Remember that you can move the Consolidate dialog box 
minimized to the Reference text box by dragging it by the title bar.)

If the source worksheets are not open, you can click the Browse command 
button to select the filename in the Browse dialog box to enter it (plus an 
exclamation point) into the Reference text box, and then you can type in the 
range name or cell references you want to use. If you prefer, you can type in 
the entire cell reference including the filename. Remember that you can use 
the asterisk (*) and question mark (?) wildcard characters when typing in the 
references for the source area.

7. Click the Add button to add this reference to the first source area to the 
All References list box.

8. Repeat Steps 6 and 7 until you have added all the references for all the 
source areas that you want to consolidate.

9. Click OK in the Consolidate dialog box.

Excel closes the Consolidate dialog box and then consolidates all the values in 
the source areas in the place in the active worksheet designated as the 
destination area. Note that you can click the Undo button on the Quick Access 
toolbar or press Ctrl+Z to undo the effects of a consolidation if you find that 
you defined the destination and/or the source areas incorrectly.

Figure 4-14 shows you the first part of a consolidation for three years (2020, 2021, 
and 2022) of record store sales in the newly created CG Music 2020 - 2022 Con-
solidated Sales.xlsx file in the workbook window in the upper-left corner. The 
Consolidated worksheet in this file totals the source area B4:R21 from the Sales 
worksheets in the CG Music - 2020 Sales.xlsx workbook with the 2020 annual 
sales, the CG Music - 2021 Sales.xlsx workbook with the 2021 annual sales, and 
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the CG Music - 2022 Sales.xlsx workbook with the 2022 annual sales. These 
sales figures are consolidated in the destination area, B4:R21, in the Consolidated 
sheet in the CG Music 2020 - 2022 Consolidated Sales.xls workbook. (How-
ever, because all these worksheets use the same layout, only cell B4, the first cell 
in this range, was designated at the destination area.)

Excel allows only one consolidation per worksheet at one time. You can, how-
ever, add to or remove source areas and repeat a consolidation. To add new source 
areas, open the Consolidate dialog box and then specify the cell references in the 
Reference text box and click the Add button. To remove a source area, click its 
references in the All References list box and then click the Delete button. To per-
form the consolidation with the new source areas, click OK. To perform a second 
consolidation in the same worksheet, choose a new destination area, open the 
Consolidate dialog box, clear all the source areas you don’t want to use in the All 
References list box with the Delete button, and then redefine all the new source 
areas in the Reference text box with the Add button before you perform the con-
solidation by clicking the OK button.

Consolidating by category
You consolidate worksheets by category when their source areas do not share the 
same cell coordinates in their respective worksheets, but their data entries do 
use common column and/or row labels. When you consolidate by category, you 
include these identifying labels as part of the source areas. Unlike when con-
solidating by position, Excel copies the row labels and/or column labels when you 
specify that they should be used in the consolidation.

FIGURE 4-14:  
The Consolidated 

worksheet after 
having Excel total 

sales from the 
last three years.
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When consolidating worksheet data by category, you must specify whether to use 
the top row of column labels and/or the left column of row labels in determining 
which data to consolidate. To use the top row of column labels, select the Top Row 
check box in the Use Labels In section of the Consolidate dialog box. To use the left 
column of row labels, select the Left Column check box in this area. Then, after 
you’ve specified all the source areas (including the cells that contain these column 
and row labels), you perform the consolidation in the destination area by clicking 
the Consolidate dialog box’s OK button.

Linking consolidated data
Excel allows you to link the data in the source areas to the destination area during 
a consolidation. That way, any changes that you make to the values in the source 
area are automatically updated in the destination area of the consolidation work-
sheet. To create links between the source worksheets and the destination work-
sheet, select the Create Links to Source Data check box in the Consolidate dialog 
box when defining the settings for the upcoming consolidation.

When you perform a consolidation with linking, Excel creates the links between 
the source areas and the destination area by outlining the destination area. (See 
“Outlining worksheets” earlier in this chapter for details.) Each outline level cre-
ated in the destination area holds rows or columns that contain the linking for-
mulas to the consolidated data.
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Printing Worksheets

You probably won’t print your worksheets all that often, but for those times 
when you need to hand out one or more worksheets at a meeting or pres-
entation, Excel gives you the tools to produce professional-looking reports. 

This chapter covers how to select the printer that you want to use; print all or 
just selected parts of the worksheet; change your page layout and print settings, 
including the orientation, paper size, print quality, number of copies, and range of 
pages, all from the Excel Backstage view. The chapter also enlightens you on how 
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to use the Ribbon to set up reports using the correct margin settings, headers and 
footers, titles, and page breaks; and use the Page Layout, Print Preview, and Page 
Break Preview features to make sure that the pages of your report are the way you 
want them to appear before you print them.

The printing techniques covered in this chapter focus primarily on printing the 
data in your worksheets. However, in Excel you can also print your charts in chart 
sheets. Not surprisingly, you’ll find that most of the printing techniques that you 
learn for printing worksheet data in this chapter also apply to printing charts in 
their respective sheets. (For specific information on printing charts, see Book 5, 
Chapter 1.)

Printing from the Backstage View
The Backstage view contains a Print screen (shown in Figure  5-1; sample 
workbook: Income Analysis.xlsx) opened by choosing File ➪ Print or pressing 
Ctrl+P. This Print screen enables you to do any of the following:

 » Change the number of copies to be printed by entering a new value in the 
Copies combo box.

 » Click the name of a new printer to use in printing the worksheet report from 
the Printer drop-down list box. (See “Selecting the printer to use” that follows 
for details.)

 » Change what part of the worksheet is printed in the report by selecting a new 
preset in the first drop-down list under Settings. You can choose between Print 
Active Sheets (the default), Print Entire Workbook, or Print Selection — or by 
entering a new value in the Pages combo boxes immediately below. Click the 
Ignore Print Area option when you want one of the other Print What options (Active 
Sheets, Entire Workbook, or Selection) that you selected to be used in the printing 
rather than the Print Area you previously defined. (See the “Setting and clearing the 
Print Area” section later in this chapter for details on how to set this area.)

 » Print on both sides of the paper (assuming that your printer is capable of 
double-sided printing) by opening the second drop-down list under Settings 
and then clicking either the Print on Both Sides, Flip Pages on Long Edge 
option, or the Print on Both Sides, Flip Pages on Short Edge option.

 » Print multiple copies of the worksheet report without having your printer 
collate the pages of each copy (collating the copies is the default) by opening 
the third drop-down list under Settings and then clicking the Uncollated option.

 » Change the orientation of the printing on the paper from the default portrait 
orientation to landscape (so that more columns of data and fewer rows are 
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printed on each page of the report) by opening the fourth drop-down list 
under Settings and then clicking the Landscape Orientation option.

 » Change the paper size from Letter (8.5 x 11 in) to another paper size sup-
ported by your printer by opening the fifth drop-down list under Settings and 
then selecting a paper size option.

 » Change the margins from the default Normal margins to Wide, Narrow, or the 
Last Custom Setting (representing the margin settings you last manually set 
for the report) by opening the sixth drop-down list under Settings and then 
selecting one of these presets. (See “Massaging the margins” later in this 
chapter for details.)

 » Scale the worksheet so that all its columns or all its rows or all of its columns 
and rows fit onto a single printed page by opening the seventh (and final) 
drop-down list under Settings and then selecting a preset.

 » Change the default settings used by your printer by using the options in the 
particular printer’s Options dialog box. (These settings can include the print 
quality and color versus black and white or grayscale, depending upon the 
type of printer.) Open it by clicking the Printer Properties link right under the 
name of your printer in the Print screen.

 » Preview the pages of the worksheet report on the right side of the Print 
screen. (See “Previewing the printout” later in this chapter for details.)

FIGURE 5-1:  
You can use the 

Print screen in 
the Backstage 

view to customize 
your worksheet 

reports. (Sample 
workbook: 

Income  
Analysis.xlsx)
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Selecting the printer to use
Windows allows you to install more than one printer for use with your applica-
tions. If you’ve installed multiple printers, the first one installed becomes the 
default printer, which is used by all Windows applications, including Excel. If you 
get a new printer, you must first install it from the Windows’ Settings app before 
you can select and use the printer in Excel.

To select a new printer to use in printing the current worksheet, follow these 
steps:

1. Open the workbook with the worksheet that you want to print and 
activate that worksheet.

2. Choose File ➪ Print or press Ctrl+P.

The Print screen opens in the Backstage view (similar to the one shown in 
Figure 5-1).

3. In the Printer drop-down list, select the name of the new printer that you 
want to use.

If the printer that you want to use isn’t listed in the drop-down list, you can try 
to add the printer with the Add Printer link near the bottom of the list. When 
you click this button, Excel opens the Settings app and displays the Printers & 
Scanners screen where you then click Add Device to install the printer that you 
want to use. Note that if you don’t have a printer connected to your computer, 
clicking the Find Printer button and opening the Find Printers dialog box results 
in opening a Find in the Directory alert dialog box with the message, “The 
Active Directory Domain Services is Currently Unavailable.” When you click OK 
in this alert dialog box, Excel closes it as well as the Find Printers dialog box.

4. To change any of the default settings for the printer that you’ve selected, 
click the Printer Properties link and then select the new settings in the 
Properties dialog box for the printer that you selected.

5. Make any other required changes using the options (Pages, Collated, and 
so on) in the Settings section of the Print screen.

6. Click the Print button near the top of the left side of the Print screen to 
print the specified worksheet data using the newly selected printer.

Keep in mind that the printer you select and use in printing the current worksheet 
remains the selected printer in Excel until you change back to the original printer 
(or some other printer).
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Previewing the printout
Excel gives you two ways to check the page layout before you send the report to the 
printer. In the worksheet, you can use the Page Layout view in the regular work-
sheet window that shows all the pages plus the margins along with the worksheet 
and row headings and rulers. Or, in the Excel Backstage view, you can use the old 
standby Print Preview on the right side of the Print screen, which shows you the 
pages of the report more or less as they appear on the printed page.

Checking the paging in Page Layout view
Excel’s Page Layout view gives you instant access to the paging of the active work-
sheet. To switch to Page Layout view, Excel gives you two choices:

 » Display the View tab; then, in the Workbook Views group, click Page Layout.

 » In the Status bar, click the Page Layout View icon, pointed out in Figure 5-2.

As you can see in Figure 5-2 (sample workbook: Income Analysis.xlsx), when you 
switch to Page Layout view, Excel adds horizontal and vertical rulers to the col-
umn letter and row number headings. In the worksheet area, this view shows the 
margins for each printed page with any headers and footers defined for the report 
along with the breaks between each. (Often you have to use the Zoom slider to 
reduce the screen magnification to display the page breaks on the screen.)

FIGURE 5-2:  
Viewing a 

 worksheet in 
Page Layout 

view. (Sample 
 workbook: 

Income  
Analysis.xlsx)
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To see all the pages required to print the active worksheet, drag the slider button 
in the Zoom slider on the Status bar to the left until you decrease the screen mag-
nification sufficiently to display all the pages of data.

Excel displays rulers using the default units for your computer (inches on a 
United States computer and centimeters on a Canadian or European machine). 
To change the units, open the Advanced tab of the Excel Options dialog box 
(File ➪ Options ➪ Advanced or Alt+FTA) and then choose the appropriate unit from 
the Ruler Units drop-down menu (Inches, Centimeters, or Millimeters) in the 
Display section. You can turn the rulers off and back on in Page Layout view by 
deselecting the View tab’s Ruler check box (it’s in the Show group) or by pressing 
Alt+WR.

Previewing the pages of the report
Stop wasting paper and save your sanity by using the Print Preview feature before 
you print any worksheet, section of a worksheet, or entire workbook. Because of 
the peculiarities in paging worksheet data, check the page breaks for any report 
that requires more than one page. You can use Print Preview in the Print screen 
of the Excel Backstage view to see exactly how the worksheet data will be paged 
when printed. That way, you can return to the worksheet and make any necessary 
last-minute changes to the data or page settings before sending the report on to 
the printer.

To switch to the Print screen and preview the printout, choose File ➪ Print or press 
Ctrl+P. Excel displays the first page of the report on the right side of the Print 
screen. Look at Figure 5-3 (sample workbook: Income Analysis.xlsx) to see the 
first preview page of a ten-page report as it initially appears in the Print screen.

When Excel displays a full page in the Print Preview window, you sometimes can 
barely read its contents. In such a case, you can increase the view to actual size 
when you need to verify specific regions of the worksheet by clicking the Zoom 
to Page button (pointed out in Figure 5-3). Check out the difference in Figure 5-4 
(sample workbook: Income Analysis.xlsx) — here you can see what the first page 
of the ten-page report looks like after I zoom in by clicking the Zoom to Page 
button.

After you enlarge a page to actual size, use the scroll bars to bring new parts of the 
page into view in the Print Preview window. To return to the full-page view, you 
deselect the Zoom to Page button by clicking it a second time.
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FIGURE 5-3:  
Page 1 of 

a ten-page 
report in Print 

 Preview. (Sample 
 workbook: 

Income  
Analysis.xlsx)

FIGURE 5-4:  
Page 1 of a 

ten-page report 
after selecting 

the Zoom to Page 
button. (Sample 

workbook: 
Income Analysis.

xlsx)
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Excel indicates the number of pages in a report at the bottom left of the Print 
Preview area. If your report has more than one page, view pages that follow by 
clicking the Next Page button (pointed out in Figure 5-3). To review a page you’ve 
already seen, back up a page by clicking the Previous Page button (also pointed out 
in Figure 5-3). (The Previous Page button is grayed out if you’re on the first page.) 
You can also advance to a particular page in the report by typing its page number 
into the text box to the immediate right of the Previous Page button that shows 
the current page and then pressing Enter.

If you want to display the current margin settings for the report in the print pre-
view area, click the Show Margins button (pointed out in Figure 5-3). After the 
margins are displayed, you can then manually manipulate them by dragging them 
to new positions. (See “Massaging the margins” later in this chapter for details.)

When you finish previewing the report, you can print the worksheet report by 
clicking the Print button in the Print screen or you can exit the Backstage view 
and return to the worksheet by clicking the Back button at the very top of the File 
menu along the left side of the screen.

Quick Printing the Worksheet
If you want to use Excel’s default print settings to print all the cells in the current 
worksheet, printing in Excel becomes a one-click exercise. To get that conven-
ience, display the Quick Access toolbar (see Book 1, Chapter 2), click the Customize 
Quick Access Toolbar button and then click the Quick Print item from its drop-
down menu.

After adding the Quick Print button to the Quick Access toolbar, you can use this 
button to print a single copy of all the information in the current worksheet, 
including any charts and graphics, everything but the notes you’ve added to cells.

When you click Quick Print, Excel routes the print job to the Windows print queue, 
which sends the job to the printer. While Excel sends the print job to the print 
queue, Excel displays a Printing dialog box to inform you of its progress (display-
ing such updates as Printing Page 2 of 3). After this dialog box disappears, you’re 
free to go back to work in Excel. To stop the printing while the job is still being 
sent to the print queue, click the Cancel button in the Printing dialog box.

If you don’t realize that you want to cancel the print job until after Excel fin-
ishes shipping it to the print queue (that is, while the Printing dialog box appears 
onscreen), you must take these steps:
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1. Right-click the printer icon in the notification area at the far right of the 
Windows taskbar and then click the Open All Active Printers command 
from its shortcut menu.

The dialog box opens for the printer with the Excel print job in its queue (as 
described under the Document Name heading in the list box).

2. Select the Excel print job that you want to cancel in the list box of your 
printer’s dialog box.

3. Choose Document ➪ Cancel from the menu and then click Yes to confirm 
you want to cancel the print job.

4. Wait for the print job to disappear from the queue in the printer’s dialog 
box and then click the Close button to return to Excel.

Working with the Page Setup Options
About the only thing the slightest bit complex in printing a worksheet is figuring 
out how to get the pages right. Fortunately, the commands in the Page Layout tab 
give you a great deal of control over what goes on which page.

Two groups of buttons on the Page Layout tab are helpful in getting your page set-
tings exactly as you want them: the Page Setup group and the Scale to Fit group 
both described in upcoming sections.

To see the effect of changes you make to the page setup settings in the Worksheet 
area, put the worksheet into Page Layout view by clicking the Page Layout button 
on the Status bar (pointed out earlier in Figure 5-2) as you work with the com-
mand buttons in Page Setup and Scale to Fit groups on the Page Layout tab.

Using the buttons in the Page Setup group
The Page Setup group of the Page Layout tab contains the following commands for 
getting your page layout just right:

 » Margins: Select one of three preset margins for the report or click Custom 
Margins to set your own margins using the Margins tab of the Page Setup 
dialog box. (See “Massaging the margins” later in this chapter.)

 » Orientation: Choose between Portrait and Landscape mode for the printing. 
(See “Getting the lay of the landscape” later in this chapter.)
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 » Size: Select one of the preset paper sizes or to set a custom size or to change 
the printing resolution or page number on the Page tab of the Page Layout 
dialog box.

 » Print Area: Set and clear the Print Area. (See “Setting and clearing the Print 
Area” immediately following in this chapter.)

 » Breaks: Insert or remove page breaks. (See “Solving Page Break Problems” 
later in this chapter.)

 » Background: Open the Sheet Background dialog box, where you can select a 
new graphic image or photo to be used as a background for all the work-
sheets in the workbook. (Note that this button changes to Delete Background 
as soon as you select a background image.) See Book 2, Chapter 4, for the 
details.

 » Print Titles: Open the Sheet tab of the Page Setup dialog box, where you can 
define rows of the worksheet to repeat at the top and columns at the left as 
print titles for the report. (See “Putting out the print titles” later in this 
chapter.)

Setting and clearing the Print Area
Excel includes a special printing feature called the Print Area, which is the por-
tion of the worksheet that you want printed. Begin by selecting the range that you 
want in your printout. Then, in the Page Layout tab’s Page Setup group, choose 
Print Area ➪ Set Print Area (or press Alt+PRS) to define that range as the Print 
Area. Excel then prints just this range whenever you print the worksheet (either 
with the Quick Print button on the Quick Access toolbar or by choosing File ➪ Print 
and then clicking the Print button on the Print screen).

Whenever you fool with the Print Area, you need to keep in mind that after you 
define it, its cell range is the only one you can print (regardless of what other print 
area options you select in the Print screen unless you click the Ignore Print Areas 
check box at the bottom of the very first drop-down menu in the Settings section 
of the Print screen and until you clear the Print Area).

To clear the Print Area (and therefore go back to the printing defaults Excel estab-
lishes in the Print screen), display the Page Layout tab and then choose Print 
Area ➪ Clear Print Area (press Alt+PRC).

You can also define and clear the Print Area by displaying the Page Layout tab and 
clicking the Page Setup group’s dialog box launcher (or by pressing Alt+PSP). In 
the Page Setup dialog box that appears, select the Sheet tab, click the Print Area 
text box to insert the cursor, and then select the range or ranges in the worksheet. 
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To clear the Print Area from this dialog box, select the cell addresses in the Print 
Area text box and press the Delete key.

Massaging the margins
The Normal margin settings that Excel applies to a new report use standard top 
and bottom margins of 0.75 inch (¾ inch) and left and right margins of 0.7 inch 
with 0.3 inches (just over a ¼ inch) separating the header and footer from the top 
and bottom margins, respectively.

Besides the Normal margin settings, Excel enables you to choose two other stan-
dard margins:

 » Wide margins with 1-inch top, bottom, left, and right margins and ½ inch 
separating the header and footer from the top and bottom margins, 
respectively.

 » Narrow margins with top and bottom margins of ¾ inch and left and right 
margins of ¼ inch with slightly more than ¼ inch separating the header and 
footer from the top and bottom margins, respectively.

Excel gives you three ways to choose Normal, Wide, or Narrow margins or to set 
custom margins for your printout:

 » Backstage view: In the Print screen, use the Margins drop-down list under 
Settings. Select a predefined margin set or click Custom Margins to open the 
Page Setup dialog box with the Margins tab displayed. Alternatively, click to 
activate the Show Margins button (pointed out earlier in Figure 5-3) and then 
drag the margin markers in the print preview area (see Figure 5-6).

 » Page Layout tab: In the Page Setup group, click Margins. Select a prefab 
margin set or click Custom Margins to open the Page Setup dialog box with 
the Margins tab displayed

 » Page Layout dialog box: In the Page Layout tab, click the Page Setup group’s 
dialog box launcher, and then display the Margins tab, shown in Figure 5-5. 
Enter the new settings in the Top, Bottom, Left, and Right text boxes — or 
select the new margin settings with their respective spinner buttons.

Select one or both Center on Page options in the Margins tab of the Page Setup 
dialog box (refer to Figure 5-5) to center a selection of data (that takes up less 
than a full page) between the current margin settings. In the Center on Page sec-
tion, select the Horizontally check box to center the data between the left and 
right margins. Select the Vertically check box to center the data between the top 
and bottom margins.
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If you activate the Show Margins button at the bottom of the Print screen in the 
Excel Backstage view (Ctrl+P) to change the margin settings, you can modify the 
column widths as well as the margins. (See Figure 5-6; sample workbook: Income 
Analysis.xlsx.) To change one of the margins, position the mouse pointer on the 
desired margin marker (the pointer shape changes to a double-headed arrow) and 
drag the marker with your mouse in the appropriate direction. When you release 
the mouse button, Excel redraws the page, using the new margin setting. You may 
gain or lose columns or rows, depending on what kind of adjustment you make. 
Changing the column width is the same story: Drag the column marker to the left 
or right to decrease or increase the width of a particular column.

Getting the lay of the landscape
The drop-down menu attached to the Orientation button in the Page Setup group 
of the Page Layout tab of the Ribbon contains two options:

 » Portrait (the default), where the printing runs parallel to the short edge 
of the paper

 » Landscape, where the printing runs parallel to the long edge of the paper

Because many worksheets are far wider than they are tall (such as budgets or 
sales tables that track expenditures across all 12 months), you may find that their 
worksheets page better if you switch the orientation from the normal portrait 
mode (which accommodates fewer columns on a page because the printing runs 
parallel to the short edge of the page) to landscape mode.

FIGURE 5-5:  
You can adjust 

your report 
margins from the 

Margins tab in 
the Page Setup 

dialog box.
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In Figure  5-7 (sample workbook: Income Analysis.xlsx), you can see the Print 
screen in the Backstage view with the first page of a report in landscape mode in 
the Page Layout view. For this report, Excel can fit three more columns of infor-
mation on this page in landscape mode than it can in portrait mode. Therefore, 
the total page count for this report decreases from ten pages in portrait mode to 
six pages in landscape mode.

Putting out the print titles
Excel’s Print Titles enable you to print row and column headings on each page 
of the report. Print titles are important in multi-page reports where the columns 
and rows of related data spill over to other pages that no longer show the row and 
column headings on the first page.

Don’t confuse print titles with the header of a report. Even though both are printed 
on each page, header information prints in the top margin of the report; print 
titles always appear in the body of the report — at the top, in the case of rows used 
as print titles, and on the left, in the case of columns.

FIGURE 5-6:  
Drag a marker 

to adjust its 
 margin in the 
Page Preview 

window when the 
Show Margins 

check box is 
selected. (Sample 

 workbook: 
Income  

Analysis.xlsx)
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To designate rows and/or columns as the print titles for a report, follow these 
steps:

1. In the Page Layout tab’s Page Setup group, click the Print Titles button (or 
press Alt+PI).

The Page Setup dialog box appears with the Sheet tab selected.

To designate worksheet rows as print titles, go to Step 2a. To designate 
worksheet columns as print titles, go to Step 2b.

2a. Select the Rows to Repeat at Top text box and then drag through the 
rows with information you want to appear at the top of each page in the 
worksheet below. If necessary, reduce the Page Setup dialog box to just 
the Rows to Repeat at Top text box by clicking the text box’s Collapse/
Expand button.

In the example I show you in Figure 5-8, I clicked the minimize button associ-
ated with the Rows to Repeat at Top text box and then dragged through rows 1 
and 2 in column A of the Income Analysis worksheet, and the program entered 
the row range $1:$2 in the Rows to Repeat at Top text box.

Note that Excel indicates the print-title rows in the worksheet by placing a 
dotted line (that moves like a marquee) on the border between the titles and 
the information in the body of the report.

FIGURE 5-7:  
A landscape 

mode report 
in Page Layout 
view. (Sample 

 workbook: 
Income  

Analysis.xlsx)
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2b. Select the Columns to Repeat at Left text box and then drag through the 
range of columns with the information you want to appear at the left 
edge of each page of the printed report in the worksheet below. If 
necessary, reduce the Page Setup dialog box to just the Columns to 
Repeat at Left text box by clicking its Collapse/Expand button.

Note that Excel indicates the print-title columns in the worksheet by placing a 
dotted line (that moves like a marquee) on the border between the titles and 
the information in the body of the report.

3. Click OK or press Enter to close the Page Setup dialog box or click the 
Print Preview button to preview the page titles in the Print Preview pane 
on the Print screen.

After you close the Page Setup dialog box, the dotted line showing the border 
of the row and/or column titles disappears from the worksheet.

In Figure 5-8, rows 1 and 2 containing the worksheet title and column headings 
for the Income Analysis worksheet are designated as the print titles for the report. 
In Figure  5-9 (sample workbook: Income Analysis.xlsx), you can see the Print 
Preview window with the second page of the report. Note how these print titles 
appear on all pages of the report.

To clear print titles from a report if you no longer need them, open the Sheet tab 
of the Page Setup dialog box and then delete the row and column ranges from the 
Rows to Repeat at Top and the Columns to Repeat at Left text boxes before you 
click OK or press Enter.

FIGURE 5-8:  
Specify the rows 
and columns to 

use as print titles 
on the Sheet tab 

of the Page Setup 
dialog box.
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Using the buttons in the Scale to Fit group
If your printer supports scaling options, you’re in luck because you have more 
options for squeezing your printout to consume fewer pages. For example, if your 
current report prints in two pages with just a little data on the second page, you 
can scale the printout so that it only uses a single page.

This scaling magic occurs in the Page Layout tab’s Scale to Fit group, which offers 
the following three options:

 » Width: Select the number of pages you want, and Excel scales the width of 
your printout so that it fits on that number of pages. You can also click 
Automatic to let Excel figure this out for you.

 » Height: Select the number of pages you want, and Excel scales the height of 
your printout so that it fits on that number of pages. You can also click 
Automatic to let Excel do the hard work for you.

 » Scale: Select a percentage and Excel shrinks (if you set a percentage less than 
100%) or expands (if you set a percentage greater than 100%) the printout.

Alternatively, click the Shrink to Fit group’s dialog box launcher to open the Page 
Setup dialog box with the Page tab displayed. From here, select the Fit To option 
button and then try changing the number of pages in the Page(s) Wide and Tall 

FIGURE 5-9:  
Page 2 of a 

sample report 
in Print Preview 

with defined print 
titles. (Sample 

workbook: 
Income  

Analysis.xlsx)
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text boxes. You can also select the Adjust To option button and setting a shrink or 
expand percentage in the spin box.

After using the Width and Height Scale to Fit options, you may find that you 
don’t want to scale the printing. Cancel scaling by selecting Automatic on both 
the Width and Height drop-down lists and then entering 100 in the Scale text (or 
select 100 with its spinner buttons).

Using the Print options on the Sheet tab  
of the Page Setup dialog box
The Print section of the Sheet tab of the Page Setup dialog box (Alt+PSP) contains 
some very useful Print check box options and a couple of drop-down options of 
which you should be aware:

 » Gridlines: When selected, prints the column and row gridlines on each page 
of the report.

 » Comments and notes: Tells Excel to print all the worksheet comments and 
notes either at the very end of the data in the report or on pages of the report 
as they are displayed in the worksheet (see Book 4, Chapter 3 for details on 
adding notes; see Book 4, Chapter 3 to find out about comments).

 » Cell Errors As: Tells Excel to print the formula errors in the worksheet cells 
with blank cells, double dashes, or #NA symbols (see Book 3, Chapter 2 for 
more information on error values in worksheet formulas).

 » Black and White: When selected, prints the entire report in black ink, 
ignoring all color text enhancements and graphics in the report (useful when 
you only need a draft printout of the worksheet data and want to conserve 
your color ink cartridges).

 » Draft Quality: When selected, prints a draft of the report at a lower resolution, 
thus saving on ink (note that not all printers support different printing at 
different resolutions so check the Quality option in your printer’s Properties 
dialog box by clicking the Printer Properties link on the Print screen to be sure).

 » Row and Column Headings: When selected, prints the row headings with the 
row numbers, and the column headings with the column letters on each page 
of the report.

Select both the Gridlines and Row and Column Headings check boxes when you 
want the printed version of your worksheet data to match as closely as possible to 
their onscreen appearance. This is useful when you need to use the cell references 
on the printout to help you later locate the cells in the actual worksheet that needs 
editing. Note that you can select them without opening the Page Setup dialog box 
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by clicking the Layout tab’s two Print check boxes (one in the Gridlines section 
and one in the Headings section). You can also press Alt+PPG to select the Grid-
lines Print check box and Alt+PPH to select the Headings Print check box.

Headers and Footers
Headers and footers are text that appears on every page of the report. A header 
is printed in the top margin of the page, and a footer is printed — you guessed 
it — in the bottom margin. Both are centered vertically in the margins. Unless 
you specify otherwise, Excel usually doesn’t automatically add either a header or 
footer to a new workbook (the exception is that some templates come with head-
ers and/or footers).

Use headers and footers in a report to identify the document used to produce the 
report and display the page numbers and the date and time of printing.

The easiest way to add a header or footer to a report is in Page Layout view: Click 
the Page Layout View button on the Status bar or click the View Tab’s Page Lay-
out View button (or press Alt+WP). To work with the header, click Add Header in 
the top margin of the first page; to work with the footer, click Add Footer in the 
bottom margin of the first page.

Excel displays the header or footer as three sections: one on the left, one in the 
center, and one on the right. To create a centered header or footer, click the center 
section of the header or footer area; to add a left-aligned header or footer, click 
the left section; to add a right-aligned header or footer, click the right section.

Excel adds a Header & Footer contextual tab, as shown in Figure 5-10 (sample 
workbook: Income Analysis.xlsx). The Header & Footer tab is divided into four 
groups: Header & Footer, Header & Footer Elements, Navigation, and Options.

Adding a ready-made header or footer
In the Header & Footer contextual tab’s Header & Footer group, the Header and 
Footer buttons enable you to add predefined headers and footers in an instant by 
clicking their examples from the drop-down menus that appear.

To create the centered header and footer for the report shown in Figure 5-11 (sam-
ple workbook: Income Analysis.xlsx), I clicked the Header & Footer tab’s Header 
button and then I first clicked the following item in the drop-down list:

Income Analysis, Confidential, Page 1
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Income Analysis is the name of the worksheet; Confidential is stock text; and Page 
1 is the current page number.

To set up the footer, I clicked the Header & Footer tab’s Footer button and then I 
clicked the following in the drop-down list:

Page 1 of ?

This item puts the current page number, along with the total number of pages, 
in the report. You can choose this paging option from either the Header or Footer 
drop-down menu.

Check out the results in Figure 5-11, which is the first page of the report in Page 
Layout view. Here you can see the header and footer as they will print. You can 
also see how choosing Page 1 of ? works in the footer: On the first page, you see 
the centered footer: Page 1 of 6; on the second page, you would see the centered 
footer Page 2 of 6.

If, after selecting a ready-made header or footer, you decide that you no longer 
need either the header or footer printed in your report, click the header or footer 
in Page Layout view and then choose the (none) option at the top of the Header 
button’s or Footer button’s drop-down menu.

FIGURE 5-10:  
Clicking inside 
the header (or 

footer) displays 
the Header & 

Footer  contextual 
tab. (Sample 

 workbook: 
Income  

Analysis.xlsx)
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Creating a custom header or footer
Most of the time, the stock headers and footers available on the Header button’s 
and Footer button’s drop-down menus are sufficient for your report printing 
needs. Every once in a while, however, you may want to insert information not  
available in these list boxes or in an arrangement Excel doesn’t offer in the  
ready-made headers and footers.

For those times, you need to use the command buttons that appear in the  
Header & Footer Elements group of the Header & Footer Tools contextual tab. 
These command buttons enable you to blend your own information with that 
generated by Excel into different sections of the custom header or footer you’re 
creating.

The command buttons in the Header & Footer Elements group include the 
following:

 » Page Number: Inserts the &[Page] code that prints the current 
page number.

 » Number of Pages: Inserts the &[Pages] code that prints the total number of 
pages.

 » Current Date: Inserts the &[Date] code that prints the current date.

FIGURE 5-11:  
The first page 
of a report in 
Page Layout 

view shows you 
how the header 

and footer will 
print. (Sample 

 workbook: 
Income  

Analysis.xlsx)
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 » Current Time: Inserts the &[Time] code that prints the current time.

 » File Path: Inserts the &[Path]&[File] code that prints the folder path along 
with the name of the workbook file.

 » File Name: Inserts the &[File] code that prints the name of the workbook file.

 » Sheet Name: Inserts the &[Tab] code that prints the name of the worksheet 
as shown on the sheet tab.

 » Picture: Inserts the &[Picture] code that inserts the image that you select 
from the Insert Pictures dialog box (see Book 5, Chapter 2 for more on 
inserting pictures).

 » Format Picture: Applies the formatting that you choose from the Format 
Picture dialog box to the &[Picture] code that you enter with the Insert 
Picture button without adding any code of its own.

To use these command buttons in the Header & Footer Elements group to create a 
custom header or footer, follow these steps:

1. Put your worksheet into Page Layout view by clicking the Page Layout 
View button on the Status bar, or by choosing View ➪ Page Layout View 
on the Ribbon, or by pressing Alt+WP.

In Page Layout view, the text Add Header appears centered in the top margin 
of the first page, and the text Add Footer appears centered in the bottom 
margin.

2. Click the header or footer section where you want to add your custom 
header or footer text.

The Header & Footer contextual tab becomes active on the Ribbon.

3. To add program-generated information to your custom header or footer 
such as the filename, worksheet name, current date, and so forth, click 
its command button in the Header & Footer Elements group.

Excel inserts the appropriate header/footer code preceded by an ampersand 
(&) in the header or footer. These codes are replaced by the actual information 
(filename, worksheet name, graphic image, and the like) as soon as you click 
another section of the header or footer or finish the header or footer by 
clicking the mouse pointer outside of it.

4. (Optional) To add your own text to the custom header or footer, type it at 
the insertion point.

When joining program-generated information indicated by a header/footer 
code with your own text, be sure to insert the appropriate spaces and 



286      BOOK 2  Worksheet Design

punctuation. For example, to have Excel display Page 1 of 4 in a custom 
header or footer, do the following:

a. Type the word Page and press the spacebar.

b. Click the Page Number command button and press the spacebar again.

c. Type the word of and press the spacebar a third time.

d. Click the Number of Pages command button.

This inserts Page &[Page] of &[Pages] in the custom header (or footer).

5. (Optional) To modify the font, font size, or some other font attribute of 
your custom header or footer, drag through its codes and text, click the 
Home tab, and then click the appropriate command button in the Font 
group.

In addition to selecting a new font and font size for the custom header or 
footer, you can add bold, italics, underlining, and a new font color to its text 
with the Bold, Italic, Underline, and Font Color command buttons on the 
Home tab.

6. After you finish defining and formatting the codes and text in your 
custom header or footer, click a cell in the Worksheet area to deselect 
the header or footer area.

Excel replaces the header/footer codes in the custom header or footer with 
the actual information, while at the same time removing the Header & Footer 
Tools contextual tab from the Ribbon.

Figure 5-12 (sample workbook: Income Analysis.xlsx) shows you a custom footer  
I added to a worksheet in Page Layout view. This custom footer blends my own 
text with program-generated page, date, and time information, and uses all three 
sections: left-aligned page information, a centered Preliminary warning, and 
right-aligned current date and time.

Creating unique first-page headers and footers
Excel enables you to define a header or footer for the first page that’s different 
from all the rest of the pages. In the Header & Footer tab’s Options group, select 
the Different First Page check box.

Now define the unique header and/or footer for just the first page (now marked 
First Page Header or First Page Footer). Then, on the second page of the report, 
define the header and/or footer (marked Header or Footer) for the remaining 
pages of the report. (See “Adding a ready-made header or footer” and “Creating a 
custom header or footer” earlier in the chapter for details.)
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Use this feature when your worksheet report has a cover page that needs no header 
or footer. For example, say you have a report that needs the current page number 
and total pages centered at the bottom of all pages but the first, cover page. To do 
this, select the Different First Page check box on the Design tab of the Header & 
Footer Tools contextual tab on the Ribbon and then define a centered stock footer 
that displays the current page number and total pages (Page 1 of ?) on the second 
page of the report, leaving the Add Footer text intact on the first page.

Excel correctly numbers both the total number of pages in the report and the  
current page number without printing this information on the first page. So if 
your report has a total of six pages (including the cover page), the second page 
footer reads Page 2 of 6; the third page, Page 3 of 6; and so on, even if the first 
printed page has no footer at all.

Creating different even and odd page  
headers and footers
If you plan to do two-sided printing or copying of your worksheet report, you 
may want to define one header or footer for the even pages and another for the 
odd pages of the report. That way, the header or footer information (such as the 
report name or current page) alternates from being right-aligned on the odd 
pages (printed on the front side of the page) to being left-aligned on the even 
pages (printed on the back side of the page).

In the Header & Footer tab’s Options group, select the Different Odd & Even Pages 
check box. After that, create a header or footer on the first page of the report (now 
marked Odd Page Header or Odd Page Footer) in the third, right-aligned section 

FIGURE 5-12:  
A worksheet 

in Page Layout 
view showing 

the  custom 
footer. (Sample 

 workbook: 
Income  

Analysis.xlsx)
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header or footer area and then re-create this header or footer on the second page 
(now marked Even Page Header or Even Page Footer), this time in the first, left-
aligned section.

Solving Page Break Problems
The Page Break Preview feature in Excel enables you to spot page break problems 
in an instant as well as fix them, such as when the program wants to split onto dif-
ferent pages information that you know should always appear on the same page.

Figure 5-13 (sample workbook: Income Analysis.xlsx) shows a worksheet in Page 
Break Preview with an example of a bad vertical and horizontal page break that 
you can remedy by adjusting the location of the page break on Pages 1 and 3. Given 
the page size, orientation, and margin settings for this report, Excel inserts a 
vertical page break between columns H and I. This break separates the April, May, 
and June sales on Page 1 from the Qtr 2 subtotals on Page 3. It also inserts a hori-
zontal page break between rows 30 and 31, splitting the Net Income data.

To correct the bad vertical page break, you need to move the page break to a col-
umn on the left several columns so that it occurs between columns E (with the Qtr 
1 subtotals) and F (containing the April sales) so that the second quarter sales and 

FIGURE 5-13:  
Preview page 

breaks in a report 
in Page Break 

Preview. (Sample 
workbook: 

Income  
Analysis.xlsx)
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subtotals are printed together on Page 3. To correct the bad horizontal page break, 
you need to move that break up four rows so that the Net Income heading prints 
on the page with its data on Page 2.

Figure 5-13 illustrates how you can correct these two bad page breaks in Page 
Break Preview mode by following these steps:

1. Click the Status bar’s Page Break Preview button (pointed out in Figure 5-13) 
or choose the Ribbon’s View ➪ Page Break Preview command (or press Alt+WI).

This takes you into a Page Break Preview mode that shows your worksheet 
data at a reduced magnification (60 percent of normal in Figure 5-13) with the 
page numbers displayed in large, light type and the page breaks shown by 
heavy dashed lines between the columns and rows of the worksheet.

2. Position the mouse or Touch pointer somewhere on the page break 
indicator (one of the heavy dashed lines surrounding the representation 
of the page) that you need to adjust; when the pointer changes to a 
double-headed arrow, drag the page break indicator to the desired 
column or row and release the mouse button.

For the example shown in Figure 5-13, I dragged the page break indicator 
between Pages 1 and 3 to the left so that it’s between columns E and F and the 
page break indicator between Page 1 and 2 up so that it’s between row 26 and 27.

In Figure 5-14 (sample workbook: Income Analysis.xlsx), you can see Page 1 of 
the report as it then appears in the Print Preview window.

3. After you finish adjusting the page breaks in Page Break Preview (and, 
presumably, printing the report), click the Status bar’s Normal button 
(also pointed out in Figure 5-13), or click the Ribbon’s View ➪ Normal 
command (or press Alt+WL) to return the worksheet to its regular view.

FIGURE 5-14:  
Page 1 of the 

report in the Print 
Preview window 

after  adjusting 
the page 

breaks in Page 
Break Preview 

mode. (Sample 
 workbook: 

Income  
Analysis.xlsx)
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You can also insert your own manual page breaks at the cell cursor’s position by 
choosing the Page Layout tab’s Breaks ➪ Insert Page Break command (or press 
Alt+PBI). To remove a manual page break, select the same cell and choose the 
Page Layout tab’s Breaks ➪ Remove Page Break command (or press Alt+PBR). To 
remove all manual page breaks that you’ve inserted into a report, choose the Page 
Layout tab’s Breaks ➪ Reset All Page Breaks command (or press Alt+PBA).

Printing the Formulas in a Report
There’s one more printing technique you may need every once in a while, and 
that’s how to print the formulas in a worksheet in a report instead of printing the 
calculated results of the formulas. You can check over a printout of the formulas in 
your worksheet to make sure that you haven’t made a mistake (such as replacing 
a formula with a number or using the wrong cell references in a formula) before 
you distribute the worksheet company wide.

Before you can print a worksheet’s formulas, you have to display the formulas, 
rather than their results. In the Formulas tab’s Formula Auditing group, click the 
Show Formulas button (or press either Ctrl+` or Alt+MH).

Excel then displays the contents of each cell in the worksheet as they normally 
appear only in the Formula bar or when you’re editing them in the cell. Notice that 
value entries lose their number formatting, formulas appear in their cells (Excel 
widens the columns with best-fit so that the formulas appear in their entirety), 
and long text entries no longer spill over into neighboring blank cells.

Excel allows you to toggle between the normal cell display and the formula cell 
display by pressing Ctrl+`. (That is, press Ctrl and the backtick key — sometimes 
called the back quote key.)

After Excel displays the formulas in the worksheet, you are ready to print it as you 
would any other report. You can include the worksheet column letters and row 
numbers as headings in the printout so that if you do spot an error, you can pin-
point the cell reference right away.

After you print the worksheet with the formulas, return the worksheet to normal 
by clicking the Formulas tab’s Show Formulas button or by pressing Ctrl+`.
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Building Basic Formulas

You can, if you want, use Excel only to store data. Using the tables that you 
find out about in Book 6, you can turn Excel into a competent database 
management system. Nothing wrong with that. However, using Excel only 

to store data is kind of like having a bicycle and only walking with it everywhere 
you go: You’re missing the best part!

What part of Excel are you missing if you only use the program to store data? One 
word: formulas, which are, hands down, Excel’s most powerful and most useful 
feature. Formulas enable you to take the static, lifeless data you’ve stored in a 
worksheet and animate that data to return answers and analyses and generate 
insights and information. Whether you want to add a few cells together, find the 
average value in a range, or calculate the tax on an invoice, Excel formulas can get 
the job done.

Chapter 1

IN THIS CHAPTER

 » Summing data ranges with AutoSum

 » Creating simple formulas with 
operators

 » Understanding the operators and 
their priority in the formula

 » Copying formulas and changing the 
type of cell references

 » Building array formulas

 » Using names and variables in 
formulas

 » Creating linking formulas that bring 
values forward

 » Controlling formula recalculation

 » Dealing with circular references in 
formulas
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So, I hear you thinking, if Excel formulas are so powerful, they must be hid-
eously complex, right? Well, I’m not going to lie to you: Advanced Excel formulas 
make the Dead Sea Scrolls look like a first-grade reader. That’s the bad news. The  
oh-so-good news is that most Excel formulas are much simpler and very straight-
forward and learning how to build these basic formulas doesn’t require a graduate 
degree in math or finance. Are you pumped to learn Excel’s most exciting feature? 
I knew it!

Getting Started with Formulas
A formula is a special type of cell entry that performs a calculation. When you 
complete the cell entry, two things happen, as demonstrated in Figure 1-1:

 » The formula result appears in the cell.

 » When you select the cell, the formula itself appears in the Formula bar.

Here’s the formula shown in the Figure 1-1 example:

=10 + 5

What’s going on here? This formula just adds the number 10 and the number 5, 
resulting in the value 15 that appears in cell D2 of Figure 1-1. Happily, even this 
simple formula demonstrates pretty much everything you need to know to get 
started with Excel formulas. That is, it demonstrates the equal sign (=), operands, 
and operators:

 » Equal sign (=): All Excel formulas—from the simple addition formula shown in 
Figure 1-1 to the most complex statistical calculation—begin with the equal 
sign (=). This symbol says to Excel, “Hey, everything that follows is a for-
mula, okay?”

FIGURE 1-1:  
The formula 

result appears 
in the cell, while 

the formula itself 
appears in the 

Formula bar.
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 » Operands: An operand provides a bit of data for the formula to work with. In 
the formula used in Figure 1-1, the operands are the numbers 10 and 5. 
Operands can be raw data values (which are called constants), function results 
(I talk about functions a bit later; see “Augmenting Formulas with Worksheet 
Functions”), or cell or range addresses. If you enter a cell address in a formula, 
Excel uses the current value of that cell in your formula. For example, 
Figure 1-2 shows an updated version of the example formula from Figure 1-1. 
This time, the value 10 is stored in cell D1 and the value 5 is stored in cell E1, 
so here’s the updated formula (visible in the Formula bar):

=D1 + E1

The advantage of using cell range addresses instead of constants in formulas 
is that when you use cell addresses, Excel automatically updates the formula 
result whenever you change the values in the cells.

 » Operators: An operator is a special symbol that tells Excel what to do with the 
operands. As demonstrated in Figure 1-1 and 1-2, the addition (+) operator 
tells Excel to add the two operands. Other common operands are subtraction 
(-), multiplication (*), and division (/).

So, when you create a formula, you perform these general steps:

1. Select the cell where you want the formula to appear.

2. Type the equal sign (=) to alert Excel that you’re building a formula.

3. Type the first operand, such as a constant, function, cell address, or range 
coordinates.

4. Type an operator.

5. Type the next operand.

6. Repeat Steps 4 and 5 until your formula is done.

7. Complete the cell entry by clicking the Enter button, pressing Enter, or pressing 
an arrow key.

FIGURE 1-2:  
You can use 

cell addresses 
as  formula 
operands.



296      BOOK 3  Formulas and Functions

Pointing at formula cells
When building your formulas, when you get to a point in the formula where you 
want to use a cell address as an operand, you can either type the cell address or 
you can click the cell in the worksheet. Clicking the cell is called pointing at the cell 
and what happens is that Excel inserts the cell address into your formula. (Point-
ing also works for range operands, where in this case you click and drag over the 
range you want to use in your formula.)

Using the pointing method to supply a cell address for a formula is often easier 
and is always a much more foolproof method than entering the cell address by 
hand. The problem with typing a cell address is that it’s all-too easy to type the 
incorrect row number or column letter (or both), so now your formula is refer-
encing the wrong cell. By contrast, when you click the cell directly, Excel always 
enters the correct address (assuming you clicked the correct cell!).

Therefore, stick to pointing when building your formulas and restrict typing cell 
addresses to the odd occasion when you need to enter or edit a cell address and 
pointing to it is either not practical or just too much trouble.

As with the other types of cell entries, you must take some action to complete a 
formula and enter it into the current cell (such as clicking the Enter button on the 
Formula bar, pressing the Enter key, or pressing an arrow key). Unlike when enter-
ing numeric or text entries, however, you want to stay clear of clicking another 
cell to complete the data entry. This is because, when you click a cell when build-
ing or editing a formula on the Formula bar, more often than not, you end up not 
only selecting the new cell, but also adding its address to the otherwise complete 
formula.

FORMULAS AND FORMATTING
When defining a formula that uses operators or functions, Excel picks up the number 
formatting of the cells that are referenced in the formula. For example, if you add cell A2 
to B3, as in =A2+B3, and cell B3 is formatted with the Currency Style format, the result 
will inherit this format and be displayed in its cell using the Currency Style.
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As soon as you complete a formula entry, Excel calculates the result, which then 
displays it inside the cell within the worksheet. (The contents of the formula, 
however, continue to be visible on the Formula bar anytime the cell is active.) If 
you make an error in the formula that prevents Excel from being able to calcu-
late the formula at all, Excel displays an Alert dialog box suggesting how to fix 
the problem. If, however, you make an error that prevents Excel from being able 
to display a proper result when it calculates the formula, the program displays an 
Error value rather than the expected computed value. (See Book 3, Chapter 2 for 
details on dealing with both types of errors in formulas.)

Editing formulas
As with numeric and text entries, you can edit the contents of formulas either in 
their cells or on the Formula bar. To edit a formula in its cell, double-click the cell 
or press F2 to position the insertion point in that cell. (Double-clicking the cell 
positions the insertion point in the middle of the formula, whereas pressing F2 
positions it at the end of the formula — you can also double-click at the beginning 
or end of the cell to position the insertion point there.) To edit a formula on the 
Formula bar, use the I-beam mouse to position the insertion point at the place in 
the formula that needs editing first.

As soon as you put the Excel program into Edit mode, Excel displays each of the 
cell references in the formula within the cell in a different color and uses each 
color to outline the corresponding cell or cell range in the worksheet. This color-
ation enables you to quickly identify the cells and their values that are referred to 
in your formula and, if necessary, modify them as well. You can use any of the four 
sizing handles that appear around the cell or cell range to modify the cell selec-
tion in the worksheet and consequently update the cell references in the formula.

USING EXCEL LIKE A HANDHELD 
CALCULATOR
Sometimes, you may need to calculate the number that you need to input in a cell as 
a constant. Instead of reaching for your smartphone Calculator app to compute the 
needed value and then manually entering it into a cell of your worksheet, you can set up 
a formula in the cell that returns the number that you need to input and then convert 
the formula into a constant value. You convert the formula into a constant by press-
ing F2 to edit the cell, immediately pressing F9 to recalculate the formula and display 
the result on the Formula bar, and then clicking the Enter button on the Formula bar 
or pressing the Enter key to input the calculated result into the cell (as though you had 
manually input the result in the cell).
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Using AutoSum to add numbers
The easiest and often the most used formula that you will create is the one that 
totals rows and columns of numbers in your worksheet. Usually, to total a row 
or column of numbers, you can click the Sum command button (the one with the 
Σ on it) on the Ribbon’s Home tab, in the Editing group. When you click Sum, 
Excel inserts the built-in SUM function into the active cell and simultaneously 
selects what the program thinks is the most likely range of numbers that you want 
summed.

Instead of taking the time to click the Sum button on the Home tab, it’s often 
faster and easier to press Alt+= (equal sign) to insert the SUM function in the cur-
rent cell and have Excel select the range of cells most likely to be totaled.

Figure 1-3 (sample workbook: Production Schedule 2022.xlsx) demonstrates how 
this works. For this figure, I positioned the cell cursor in cell B7, which is the 
first cell where I need to build a formula that totals the various parts produced in 
April. I then clicked the Sum button (pointed out in Figure 1-3) on the Ribbon’s 
Home tab.

As Figure 1-3 shows, Excel inserts an equal sign followed by the SUM function 
and correctly suggested the cell range B3:B6 as the argument to this function 
(that is, the range to be summed). Because Excel correctly selected the range to be 
summed (leaving out the date value in cell B2), all I have to do is click the Enter 
button on the Formula bar to have the April total calculated.

FIGURE 1-3:  
Using AutoSum 
to create a SUM 

 formula that 
totals a column of 

numbers.  
(Sample 

 workbook: 
 Production 

Schedule  
2022.xlsx)
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Figure  1-4 (sample workbook: Production Schedule 2022.xlsx) shows another 
example of using AutoSum to instantly build a SUM formula, this time to total the 
monthly production numbers for Part 100 in cell K3. Again, all I did to create the 
formula shown in Figure 1-4 was to select cell K3 and then click the Sum button. 
Again, Excel correctly selected B3:J3 as the range to be summed (rightly ignoring 
cell A3 with the row title) and input this range as the argument of the SUM func-
tion. All that remains to be done is to click the Enter button on the Formula bar to 
compute the monthly totals for Part 100.

If for some reason AutoSum doesn’t select the entire or correct range that you want 
summed, you can adjust the range by dragging the cell cursor through the cell 
range or by clicking the marquee around the cell range, which turns the march-
ing ants into a solid-colored outline. Then position the mouse pointer on one of 
the sizing handles at the four corners. When the mouse pointer turns into a thick 
white arrowhead pointing to the center of a pair of black double-crossed arrows, 
drag the outline until it includes all the cells you want included in the total.

FIGURE 1-4:  
Using the 

 AutoSum feature 
to create a SUM 

formula that 
totals a row 
of numbers. 

(Sample  
workbook:  
Production 

Schedule  
2022.xlsx)

WHEN AUTOSUM DOESN’T SUM
Although the Sum button’s primary function is to build formulas with the SUM function 
that totals ranges of numbers, that’s not its only function (pun intended). Indeed, you 
can have the AutoSum feature build formulas that compute the average value, count the 
number of values, or return the highest or lowest value in a range — all you have to do 
is click the drop-down button that’s attached to the Sum command button on the Home 
tab and then click Average, Count Numbers, Max, or Min from its drop-down menu.

Also, don’t forget about the Average, Count, and Sum indicator on the Status bar. This 
indicator automatically shows you the average value, the count of the numbers, and the 
total of all numbers in the current cell selection. You can use this feature to preview the 
total that’s to be returned by the SUM formula that you create with the AutoSum button 
by selecting the cell range that contains the numbers to be summed.
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All Excel functions enclose their argument(s) in a pair of parentheses, as shown in 
the examples with the SUM function. Even those rare functions that don’t require 
any arguments at all still require the use of a closed pair of parentheses (even 
when you don’t put anything inside of them).

Using Quick Analysis to add numbers
Instead of resorting to the Sum button and AutoFill to create totals for a worksheet 
table, you can use the Totals feature on the Quick Analysis tool to get the job done. 
The Quick Analysis tool offers a bevy of features for doing anything from add-
ing conditional formatting, charts, PivotTables, and sparklines to your worksheet 
tables. And it turns out Quick Analysis is also a whiz at adding running totals and 
sums to the rows and columns of your new worksheet tables.

To use the Quick Analysis tool, select the worksheet range’s data cells and then 
click the Quick Analysis button that automatically appears in the lower-right cor-
ner of the last selected cell. A palette of options (from Formatting to Sparklines) 
appears right beneath the Quick Analysis tool.

To add totals to your selected data, first click the Totals tab. You then click one of 
the Sum buttons (the buttons where the icon is a worksheet containing a Sigma):

 » Click the first Sum button (the one where the bottom row is highlighted) to 
add column totals in a new row below the selected range, as shown in 
Figure 1-5 (sample workbook: Production Schedule 2022.xlsx).

 » Click the second Sum button (the one where the rightmost column is high-
lighted) to add row totals in a new column to the right of the selected range.

FIGURE 1-5:  
Adding a row of 

totals with the 
Quick  Analysis 

tool’s Sum 
 button. (Sample 

workbook:  
Production 

Schedule  
2022.xlsx)
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If you have trouble selecting the Quick Analysis button to open its palette for any 
reason, right-click the cell selection and select the Quick Analysis item on its 
shortcut menu.

Building formulas with  
computational operators
Many of the simpler formulas that you build require the sole use of Excel’s opera-
tors, which are the symbols that indicate the type of calculation that is to take place 
between the cells and/or constants interspersed between them. Excel uses four dif-
ferent types of computational operators: arithmetic, comparison, text, and reference. 
Table 1-1 shows all these operators arranged by type and accompanied by an example.

TABLE 1-1 The Different Types of Operators in Excel
Type Character Operation Example

Arithmetic + Addition =A2 + B3

– Subtraction or negation =A3 – A2 or –C4

* Multiplication =A2 * B3

/ Division =B3 / A2

% Percent (dividing by 100) =B3%

^ Exponentiation =A2 ^ 3

Comparison = Equal to =A2 = B3

> Greater than =B3 > A2

< Less than =A2 < B3

>= Greater than or equal to =B3 >= A2

<= Less than or equal to =A2 <= B3

<> Not equal to =A2 <> B3

Text & Concatenates (connects) entries 
to produce one continuous entry

=A2 & ” “ & B3 

Reference : Range operator that includes =SUM(C4:D17)

 , Union operator that combines 
multiple references into 
one reference

=SUM(A2, C4:D17, B3) 

(space) Intersection operator that 
produces one reference to cells 
in common with two references

=SUM(C3:C6 C3:E6) 
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More about operators
Most of the time, you’ll rely on the arithmetic operators when building formulas 
in your worksheets that don’t require functions because these operators perform 
computations between the numbers in the various cell references and produce 
new mathematical results.

The comparison operators, on the other hand, produce only the logical value TRUE 
or the logical value FALSE, depending on the result of the comparison. For exam-
ple, say that you enter the following formula in cell A10:

=B10 <> C10

If B10 contains the number 15 and C10 contains the number 20, the formula in 
A10 returns the logical value TRUE. If, however, both cell B10 and C10 contain the 
value 12, the formula returns the logical value FALSE.

The single text operator (the so-called ampersand) is used in formulas to join two 
or more text entries (an operation with the highfalutin’ name concatenation). For 
example, suppose that you enter the following formula in cell C2:

=A2 & B2

If cell A2 contains John and cell B2 contains Smith, the formula returns the new 
(squashed together) text entry, JohnSmith. To have the formula insert a space 
between the first and last names, include a space as part of the concatenation as 
follows:

=A2 & " " & B2

You most often use the comparison operators with the IF function when building 
more complex formulas that perform one type of operation when the IF condition 
is TRUE and another when it is FALSE. You use the concatenating operator (&) 
when you need to join text entries that come to you entered in separate cells but 
that need to be entered in single cells (like the first and last names in separate col-
umns). See Book 3, Chapter 2 for more on logical formulas, and Book 3, Chapter 6 
for more on text formulas.

Order of operator precedence
When you build a formula that combines different computational operators, Excel 
follows the set order of operator precedence, as shown in Table 1-2. When you use 
operators that share the same level of precedence, Excel evaluates each element in 
the equation by using a strictly left-to-right order.
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Suppose that you enter the following formula in cell A4:

=B4 + C4 / D4

Because division (like multiplication) has a higher level of precedence than addi-
tion (4 versus 5), Excel evaluates the division between cells C4 and D4 and then 
adds that result to the value in cell B4. If, for example, cell B4 contains 2, C4 
contains 9, and D4 contains 3, Excel would essentially be evaluating this equation 
in cell A4:

=2+9/3

In this example, the calculated result displayed in cell A4 is 5 because the program 
first performs the division (9/3) that returns the result 3 and then adds it to 2 to 
get the final result of 5.

If you had wanted Excel to evaluate this formula in a strictly left-to-right man-
ner, you could get it to do so by enclosing the leftmost operation (the addition 
between B4 and C4) in a closed pair of parentheses. Parentheses alter the natural 
order of precedence so that any operation enclosed within a pair is performed 
before the other operations in the formula, regardless of level in the order. (After 
that, the natural order is once again used.)

To have Excel perform the addition between the first two terms (B4 and C4) and 
then divide the result by the third term (cell D4), you modify the original formula 
by enclosing the addition operation in parentheses as follows:

=(B4 + C4) / D4

TABLE 1-2 Natural Order of Operator Precedence in Formulas
Precedence Operator Type/Function

1 – Negation

2 % Percent

3 ^ Exponentiation

4 * and / Multiplication and Division

5 + and – Addition and Subtraction

6 & Concatenation

7 =, <, >, <=, >=, <> All Comparison Operators
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Assuming that cells B4, C4, and D4 still contain the same numbers (2, 9, and 3, 
respectively), the formula now calculates the result as 3.666667 and returns it to 
cell A4 (2+9=11 and 11/3=3.66667).

If necessary, you can nest parentheses in your formulas by putting one set of 
parentheses within another (within another, within another, and so on). When 
you nest parentheses, Excel performs the calculation in the innermost pair of 
parentheses first before anything else and then starts performing the operations 
in the outer parentheses.

Consider the following sample formula:

=B5 + (C5 – D5) / E5

In this formula, the parentheses around the subtraction (C5–D5) ensure that it 
is the first operation performed. After that, however, the natural order of prece-
dence takes over. So, the result of the subtraction is then divided by the value in 
E5, and that result is then added to the value in B5. If you want the addition to be 
performed before the division, you need to nest the first set of parentheses within 
another set as follows:

=(B5 + (C5 – D5)) / E5

In this revised formula, Excel performs the subtraction between the values in C5 
and D5, adds the result to the value in cell B5, and then divides that result by the 
value in cell E5.

Of course, the biggest problem with parentheses is that you have to remember 
to enter them in pairs. If you forget to balance each set of nested parentheses by 
having a right parenthesis for every left parenthesis, Excel displays an Alert dialog 
box, informing you that it has located an error in the formula. Excel also suggests 
a correction that would balance the parentheses used in the formula. Although 
the suggested correction corrects the imbalance in the formula, it unfortunately 
doesn’t give you the calculation order that you wanted — and if accepted, the sug-
gested correction would give you what you consider an incorrect result. For this 
reason, be very careful before you click the Yes button in this kind of Alert dialog 
box. Do so only when you’re certain that the corrected parentheses give you the 
calculation order that you want. Otherwise, click No and balance the parentheses 
in the formula by adding the missing parenthesis or parentheses yourself.
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Augmenting Formulas with  
Worksheet Functions

Excel supports a wide variety of built-in worksheet functions that you can use 
when building formulas. A function is a kind of predefined formula that performs 
a specific calculation. For example, consider the following formula:

=A1 + A2 _ A3 + A4 + A5 + A6 + A7 + A8 + A9 + A10

You can imagine how tedious that would be to type into a cell. To make your Excel 
life easier, you can use the SUM function, instead, which sums whatever range 
address (or addresses) you provide (these inputs are known as arguments):

=SUM(A1:A10)

The most popular built-in function is by far the SUM function, which is automati-
cally inserted when you click the Sum command button on the Ribbon’s Home tab. 
(Keep in mind that you can also use this drop-down button attached to the Sum 
button to insert the AVERAGE, COUNT, MAX, and MIN functions — see the “Using 
AutoSum to add numbers” section previously in this chapter for details.)

Inserting a function
To use other Excel functions, you can type the function and its arguments, if you 
happen to know the correct syntax. Otherwise, you can use either the Insert Func-
tion button or the Ribbon’s Formulas tab.

Entering a function manually
If you know the name of the function you want to insert and you know its syntax, 
it’s often easier to just type the function manually into your formula. When you 
begin typing a function name in a formula, Excel’s AutoComplete feature kicks in 
by displaying a drop-down menu with the names of all the functions that begin 
with the character(s) you’ve typed. You can then insert the name of the function 
you want to use by double-clicking its name on this drop-down menu, or high-
lighting the name and pressing Tab. Excel then inserts the function name along 
with the open parenthesis as in =DATE(. Now you fill in the rest of the function, 
add a closing (right) parenthesis, and you’re done.
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Using the Insert Function button
When you click the Insert Function button on the Formula bar (the one with the 
fx), Excel displays the Insert Function dialog box, similar to the one shown in 
Figure 1-6. You can then use its options to find and select the function that you 
want to use and to define the argument or arguments that the function requires 
to perform its calculation.

To select the function that you want to use, you can use any of the following 
methods:

 » Click the function name if it’s one that you’ve used lately and is therefore 
already listed in the Select a Function list box.

 » Select the name of the category of the function that you want to use from the 
Or Select a Category drop-down list box (Most Recently Used is the default 
category) and then select the function that you want to use in that category 
from the Select a Function list box.

 » Replace the text “Type a brief description of what you want to do and then 
click Go” in the Search for a Function text box with keywords or a phrase 
about the type of calculation that you want to do (such as “return on invest-
ment”). Click the Go button or press Enter and click the function that you want 
to use in the Recommended category displayed in the Select a Function 
list box.

When selecting the function to use in the Select a Function list box, click the  
function name to have Excel give you a short description of what the function 
does, displayed underneath the name of the function with its argument(s) shown 

FIGURE 1-6:  
Use the Insert 

Function dialog 
box to, you know, 
insert a function.



Bu
ild

in
g 

Ba
si

c 
Fo

rm
ul

as

CHAPTER 1  Building Basic Formulas      307

in parentheses (referred to as the function’s syntax). To get help on using the 
function, click the Help on This Function link displayed in the lower-left corner 
of the Insert Function dialog box to open the Help window in its own pane on the 
right. When you finish reading and/or printing this help topic, click the Close but-
ton to close the Help window and return to the Insert Function dialog box.

When you click OK after selecting the function that you want to use in the current 
formula, Excel inserts the function name followed by a closed set of parentheses 
on the Formula bar. At the same time, the program closes the Insert Function 
dialog box and then opens the Function Arguments dialog box, similar to the one 
shown in Figure 1-7.

Using the Ribbon’s Formulas tab
You can also insert a function using the Ribbon’s Formulas tab. In the Function 
Library group, you see drop-down lists for several function categories: Financial, 
Logical, Text, Date & Time, Lookup & Reference, and Math & Trig. In addition, you 
can click More Functions to eyeball a few more categories: Statistical, Engineer-
ing, Cube, Information, Compatibility, and Web. If the function you want is one 
you’ve used recently, it may appear on the handy Recently Used drop-down list. 
Click the category that contains the function you want and then click the function 
to insert it into your formula and open the Function Arguments dialog box.

For your formula-building convenience, note that in the Ribbon’s Formulas tab, 
the Function Library group also includes the same AutoSum button that’s availa-
ble in the Home tab’s Editing group.

FIGURE 1-7:  
Use the Function 

Arguments dialog 
box to specify the 

arguments for a 
function.
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Entering function arguments
A function argument is an input that gets fed into the function’s internal calcu-
lations. Almost all functions accept at least one argument, and most functions 
accept two or more. And, yep, in case you’re wondering: Some functions don’t 
require any arguments. For example, the TODAY function returns the current 
date, with no arguments required.

Function arguments come in two flavors:

 » Required: Arguments that you must include for the function to 
return a result.

 » Optional: Arguments that you can omit and still get a valid result from the 
function.

All functions — even those that don’t take any arguments, such as the TODAY 
function — follow the function name by a set of left and right parentheses. For 
example, the TODAY function requires no arguments, so it appears in a formula 
as TODAY( ). If the function requires arguments, these arguments must appear 
within the parentheses following the function name. When a function requires 
multiple arguments, such as the PMT function (used to calculate a loan payment), 
you must enter the arguments in the order designated by the function’s syntax (so 
that Excel knows which argument is which).

How do you know the proper order? That comes from the function’s syntax, which 
specifies the function name, its arguments, the data type of each argument, the 
order to enter those arguments, and which arguments are required.

The easiest way to see a function’s syntax is to type the function’s name in a 
formula followed by the opening (left) parenthesis. Below the cell, Excel displays 
a ScreenTip that contains the syntax. Figure 1-8 (sample workbook: Loan Pay-
ments.xlsx) shows the syntax that appears for the PMT function. Look closely and 
you’ll notice three things about this syntax:

 » The arguments are displayed in the order you must enter them, separated 
by commas.

 » The current argument (that is, the argument you’re about to type or click) is 
displayed in bold type. When you enter that argument and type a comma, the 
next argument in the list (if there is one) is displayed in bold.

 » Optional arguments are surrounded by square brackets (such as [fv] and 
[type] for the PMT function).
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If you’re not typing the function by hand — that is, you used the Insert Func-
tion button or the Formulas tab to get your function off the ground — the func-
tion syntax appears in the Function Arguments dialog box. Figure 1-9 shows the 
Function Arguments dialog box for the PMT function. Again, you can notice three 
things about the syntax here:

 » Although arguments are displayed in the order required by the function (from 
top to bottom), you can fill in the text boxes in any order you prefer.

 » To the right of each argument is a text label that tells you the data type of the 
argument (such as “number” or “date”).

 » Required argument names appear in bold type (Rate, Nper, and Pv in 
Figure 1-9), while optional argument names appear in regular type (Fv and 
Type in Figure 1-9).

FIGURE 1-8:  
Type the function 

name followed 
by the left 

 parenthesis to 
see a ScreenTip 

with the function 
syntax. (Sample 
workbook: Loan 

Payments.xlsx)

FIGURE 1-9:  
The Function 

Arguments dialog 
box shows the 

function syntax.
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When you use the text boxes in the Function Arguments dialog box to input the 
arguments for a function, you can select the cell or cell range in the worksheet that 
contains the entries that you want used. Click the text box for the argument that you 
want to define and then either start dragging the cell cursor through the cells or, if 
the Function Arguments dialog box is obscuring the first cell in the range that you 
want to select, click the Collapse Dialog Box button located to the immediate right 
of the text box. Dragging or clicking this button reduces the Function Arguments 
dialog box to just the currently selected argument text box, thus enabling you to 
drag through the rest of the cells in the range.

If you started dragging without first clicking the Collapse Dialog Box button, Excel 
automatically expands the Function Arguments dialog box as soon as you release 
the mouse button. If you clicked the Collapse Dialog Box button, you have to either 
press Enter or click the Expand Dialog Box button (which replaces the Collapse 
Dialog Box button located to the right of the argument text box) to restore the 
Function Arguments dialog box to its original size.

As you define arguments for a function in the Function Arguments dialog box, 
Excel shows you the calculated result following the heading, “Formula result =” 
near the bottom of the Function Arguments dialog box. When you finish entering 
the required argument(s) for your function (and any optional arguments that may 
pertain to your calculation), click OK to have Excel close the Function Arguments 
dialog box and insert the function into the formula.

For details on how to use different types of built-in functions for your worksheets, 
refer to the following chapters in Book 3 that discuss the use of various categories: 
Chapter 2 for information on Logical functions; Chapter 3 for Date and Time func-
tions; Chapter 4 for Financial functions; Chapter 5 for Math and Statistical func-
tions; and Chapter 6 for Lookup, Information, and Text functions.

Copying Formulas
Copying formulas is one of the most common tasks that you do in a typical work-
sheet that relies primarily on formulas. Although most copy operations for for-
mulas are straightforward, you need to exercise a bit of care to make sure that 
the copied formula is performing the calculation you want. The next few sections 
explain what I mean.
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Copying with relative cell references
When a formula uses cell references rather than constant values (as nearly all 
formulas should), Excel makes the task of copying most formulas straightfor-
ward. (To find out why I added the hedge word “most” in that last sentence, see 
“Copying with absolute references,” next.) The program does this by automati-
cally adjusting the cell references in the original formula to suit the position of 
the copies that you make. It does this through a system known as relative cell 
addresses, where the column references in the cell address in the formula change 
to suit their new column position and the row references change to suit their new 
row position.

Figures 1-10 and 1-11 (sample workbook for both: Production Schedule 2022.xlsx) 
illustrate how this works. For Figure 1-10, I used the AutoSum button in cell B7 to 
build the original formula that uses the SUM function that totals the April sales. 
The formula in cell B7 reads

=SUM(B3:B6)

FIGURE 1-10:  
An original  

formula copied 
with the Fill 

 handle across 
the last row of 

the data. (Sample 
workbook:  
Production 

Schedule  
2022.xlsx)

FIGURE 1-11:  
An original 

 formula copied 
with the Fill 

 handle down the 
last column of 

the data. (Sample 
 workbook: 
 Production 

Schedule  
2022.xlsx)
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I then used the AutoFill feature to copy this formula by dragging the Fill handle to 
include the cell range B7:J7. (Copying the formula with the cut-and-paste method 
would work just as well, although it’s a little more work.) Note in the cell range 
C7:J7 that Excel did not copy the original formula to the other cells verbatim. 
(Otherwise, each of the copied formulas would return the same result, 1915, as the 
original in cell B7.) If you look at the Formula bar in Figure 1-10, you see that the 
copy of the original formula in cell C7 reads

=SUM(C3:C6)

In this copy, Excel adjusted the column reference of the range being summed from 
B to C to suit the new position of the copy. Figure 1-11 shows how this works when 
copying an original formula in the other direction, this time down a column. For 
this figure, I used the AutoSum button to create a SUM formula that totals all the 
monthly sales for Part 100 in row 3. The formula in cell K3 reads

=SUM(B3:J3)

You can then use the Fill handle to copy this formula down the last column of 
the table to include the cell range by positioning the cell cursor in K3 and then 
dragging the Fill handle down to select K3:K7. If you were to then position the 
cell cursor in cell K4, you would see on the Formula bar that when Excel copied 
the original formula in cell K3 down to cell K4, it automatically adjusted the row 
reference to suit its new position so that the formula in cell K4 reads

=SUM(B4:J4)

Copying with absolute references
Most of the time, relative cell references are exactly what you need in your for-
mulas to enable Excel to adjust the row and/or column references during copying. 
However, you’ll encounter some situations where Excel should not adjust one or 
more parts of the cell reference in the copied formula. The most common case is 
when you want to use a cell value as a constant in all the copies that you make of 
a formula.

Figure  1-12 (sample workbook: Production Schedule 2022.xlsx) illustrates just 
such a situation. In this situation, you want to build a formula in cell B9 that 
calculates what percentage April’s part production total (B7) is of the total nine-
month production (cell K7). Normally, you would create the following formula in 
cell B9 with all its relative cell references:

=B7 / K7
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However, when you copy this formula across to the range C9:J9 to calculate the 
percentages for the other eight months (May through December), look what hap-
pens: all those cells now show #DIV/0!, an Excel formula error that means divi-
sion by zero (which is a no-no).

What happened? You can start to understand the problem by thinking about copy-
ing the original formula from cell B9 to C9 to calculate the percentage for May. In 
this cell, you want the following formula that divides the May production total in 
cell C7 by the nine-month total in cell K7:

=C7 / K7

However, if you don’t indicate otherwise, Excel adjusts both parts of the formula 
in the copies, so that C9 incorrectly contains the following formula:

=C7 / L7

Because cell L7 is currently blank and blank cells have the equivalent of the value 
0, this formula returns the #DIV/0! formula error as the result, thus indicating 
that Excel can’t properly perform this arithmetic operation. (See Book 3, Chapter 2 
for details on this error message.)

To indicate that you don’t want a particular cell reference (such as cell K7 in the 
example) to be adjusted in the copies that you make of a formula, you change the 
cell reference from a relative cell reference to an absolute cell reference. An absolute 
cell reference contains dollar signs before the column letter and the row number, 
as in $K$7.

If you realize that you need to convert a relative cell reference to an absolute ref-
erence as you’re building the original formula, you can convert the relative refer-
ence to absolute by selecting the cell and then pressing F4. To get an idea of how 

FIGURE 1-12:  
Copying the 

formula in cell B9 
across produces 
#DIV/0! errors in 

the cells C9:J9. 
(Sample  

workbook:  
Production 

Schedule  
2022.xlsx)
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this works, follow along with these steps for creating the correct formula =B7 / 
$K$7 in cell B9:

1. Click cell B9 to make it active.

2. Type = to start the formula; then click cell B7 and type / (the sign for 
division).

The Formula bar now reads =B7/.

3. Click K7 to select this cell and add it to the formula.

The Formula bar now reads =B7/K7.

4. Press F4 once to change the cell reference from relative (K7) to absolute 
($K$7).

The Formula bar now reads =B7/$K$7. You’re now ready to enter the formula 
and then make the copies.

5. Click the Enter button on the Formula bar and then drag the Fill handle 
to cell J9 before you release the mouse button.

Figure 1-13 (sample workbook: Production Schedule 2022.xlsx) shows the  
(now correct) results.

Like it or not, you won’t always anticipate the need for an absolute value until 
after you’ve built the formula and copied it to a range. When this happens, you 
have to edit the original formula, change the relative reference to absolute, and 
then make the copies again.

When editing the cell reference in the formula, you can change its reference by 
positioning the insertion point anywhere in its address and then pressing F4. You 
can also do this by inserting dollar signs in front of the column letter(s) and row 
number when editing the formula, although doing that isn’t nearly as easy as 
pressing F4.

FIGURE 1-13:  
Using an absolute 

cell reference in 
the divisor gets 
rid of the error 

and produces the 
correct results. 

(Sample  
workbook: 
 Production 

Schedule  
2022.xlsx)
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You can make an exact copy of a formula in another cell without using absolute 
references. To do this, make the cell with the formula that you want to copy the 
active one, use the I-beam pointer to select the entire formula in the Formula bar 
by dragging through it, and then click the Copy command button on the Ribbon’s 
Home tab (or press Ctrl+C). Next, click the Cancel button to deactivate the Formula 
bar, select the cell where you want the exact copy to appear, and then click the 
Paste command button on the Home tab (or press Ctrl+V). Excel then pastes an 
exact duplicate of the original formula into the active cell without adjusting any of 
its cell references (even if they are all relative cell references).

When using the sum options on the Totals tab of the Quick Analysis tool’s palette 
(see “Using Quick Analysis to add numbers” earlier in this chapter for details) all 
the cell references in the total and sum formulas that Excel creates are relative 
references.

If you’re building a formula that requires an absolute or some sort of mixed cell 
reference (see the following section) on a touchscreen device and using the Touch 
keyboard with no access to function keys, you need to add the required dollar 
sign(s) into the formula on the Formula bar by using the dollar sign ($) key on 
the Touch keyboard. To access the dollar sign key, tap the Numeric key (&123) to 
switch the Touch keyboard out of the QWERTY letter arrangement.

Copying with mixed cell references
Some formulas don’t require you to change the entire cell reference from relative 
to absolute to copy them correctly. In some situations, you need to indicate only 
that the column letter or the row number remains unchanged in all copies of the 
original formula. A cell reference that is part relative and part absolute is called a 
mixed cell reference.

A mixed cell reference has a dollar sign just in front of the column letter or row 
number that should not be adjusted in the copies. For example, $C10 adjusts row 
10 in copies down the rows but leaves column C unchanged in all copies across 
columns to its right. Another example is C$10, which adjusts column C in copies 
to columns to the right but leaves row 10 unchanged in all copies down the rows. 
(For an example of using mixed cell references in a master formula, refer to the 
information on using the PMT Function in Book 3, Chapter 4.)

To change the cell reference that you select in a formula (by clicking the flashing 
insertion point somewhere in its column letter and row number) from relative to 
mixed, continue to press F4 until the type of mixed reference appears on the For-
mula bar. When the Formula bar is active and the insertion point is somewhere in 
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the cell reference (either when building or editing the formula), pressing F4 cycles 
through each cell-reference possibility in the following order:

 » The first time you press F4, Excel changes the relative cell reference to 
absolute (C10 to $C$10).

 » The second time you press F4, Excel changes the absolute reference to a 
mixed reference where the column is relative and the row is absolute  
($C$10 to C$10).

 » The third time you select the Reference command, Excel changes the mixed 
reference where the column is relative and the row is absolute to a mixed 
reference where the row is relative and the column is absolute (C$10 to $C10).

 » The fourth time you press F4, Excel changes the mixed reference where  
the row is relative and the column is absolute back to a relative reference 
($C10 to C10).

If you bypass the type of cell reference that you want to use, you can return to it 
by continuing to press F4 until you cycle through the variations again to reach the 
one that you need.

Adding Array Formulas
As noted previously in this chapter, many worksheet tables use an original for-
mula that you copy to adjacent cells by using relative cell references (sometimes 
referred to as a one-to-many copy). In some cases, you can build the original for-
mula so that Excel performs the desired calculation not only in the active cell, but 
also in all the other cells to which you would normally copy the formula. You do 
this by creating an array formula. An array formula is a special formula that oper-
ates on a collection of values. If a cell range supplies this collection (as is often the 
case), it’s referred to as an array range. If this range is supplied by a list of numer-
ical values, they’re known as an array constant.

Although the array concept may seem foreign at first, you’re already familiar with 
arrays because the column-and-row structure of the Excel worksheet grid nat-
urally organizes your data ranges into one-dimensional and two-dimensional 
arrays. (1-D arrays take up a single row or column, whereas 2-D arrays take up 
multiple rows and columns.)
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Figure 1-14 illustrates a couple of two-dimensional arrays with numerical entries 
of two different sizes. The first array is a 3 x 2 array in the cell range B2:C4. This 
array is a 3 x 2 array because it occupies three rows and two columns. The second 
array is a 2 x 3 array in the cell range F2:H3. This array is a 2 x 3 array because it 
uses two rows and three columns.

If you were to list the values in the first 3 x 2 array as an array constant in a for-
mula, they would appear as follows:

{1,4;2,5;3,6}

Several things in this list are noteworthy. First, the array constant is enclosed in 
a pair of braces ({}). Second, columns within each row are separated by commas 
(,) and rows within the array are separated by semicolons (;). Third, the constants 
in the array are listed across each row and then down each column and not down 
each column and across each row.

The second 2 x 3 array expressed as an array constant appears as follows:

{7,8,9;10,11,12}

Note again that you list the values across each row and then down each column, 
separating the values in different columns with commas and the values in differ-
ent rows with a semicolon.

Using array formulas can significantly reduce the amount of formula copying that 
you have to do in a worksheet by producing multiple results throughout the array 
range in a single operation. Also, array formulas use less computer memory than 
standard formulas copied in a range. This can be important when creating a large 
worksheet with many tables because it may mean the difference between fitting 
all your calculations on one worksheet and having to split your model into several 
worksheet files.

FIGURE 1-14:  
A worksheet with 

two different 
sizes of arrays.
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Creating an array formula
To get an idea of how you build and use array formulas in a worksheet, con-
sider the sample worksheet shown in Figure  1-15 (sample workbook: Wages 
02-22.xlsx). This worksheet is designed to compute the biweekly wages for each 
employee. It does this by multiplying each employee’s hourly rate by the number 
of hours worked in each pay period.

One way to make these calculations would be to create the following formula in 
cell R10 and then copy the formula down the cells R11 through R13:

=A4 * R4

That works, but having to copy the formula is an extra step that can be a pain if 
you have a ton of copies to make. Instead, you can skip the copying step altogether 
by adding the following array formula in the array range (R10:R13):

=A4:A7 * R4:R7

This array formula multiplies each of the hourly rates in the 4 x 1 array in the 
range A4:A7 with the corresponding number of hours worked in the 4 x 1 array 
in the range R4:R7. This same formula is entered into all cells of the array range 
(R10:R13) as soon as you complete the formula in the active cell R10.

This type of formula is known as a dynamic array formula, and it only works in 
Excel 2019 and later. If you need your array calculation to work in earlier ver-
sions of Excel, use the method I describe in the “Building old-fashioned array  
formulas” section.

FIGURE 1-15:  
The goal: to 

 calculate each 
employee’s 

hourly wages 
for the first pay 
period. (Sample 

workbook:  
Wages 02-22.xlsx)
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Follow along with the steps required to build this array formula:

1. Ensure that all the cells in the array range are empty.

In the example, you’d clear out the range R10:R13, if needed.

2. Select the first cell in the array range and type an equal sign (=).

In the example, you’d make cell R10 the current cell.

3. Enter your formula. When you come to an operand that would normally 
be a cell reference, enter a range reference that contains all the cells in 
the array.

In the example, you’d replace the cell reference A4 with the range reference 
A4:A7, and you’d replace the cell reference R4 with the range reference R4:R7. 
Your formula should now look like this:

=A4:A7 * R4:R7

4. Press Enter or click the Enter button in the Formula bar.

Presto! Excel adds the array formula not only to the current cell, but to all the 
cells in the array range, as shown in Figure 1-16 (sample workbook: Wages 
02-22.xlsx). Here, I’ve selected cell R11 so you can see that, yep, Excel applies 
the same array formula to each cell of the array range (R10:R13).

The process where Excel automatically applies your array formula to the other 
cells in the range is known in Excel World as spilling the data and the range that 
gets filled in is called the spill range.

FIGURE 1-16:  
An array formula 

makes short work 
of hourly wage 

 calculation.  
(Sample 

 workbook:  
Wages 02-22.xlsx)
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You can use array formulas to complete the rest of the February wage table. In the 
second cell range, AI10:AI13, you’d enter the following array formula to calculate 
the hourly wages for the second pay period in February:

=A4:A7 * AI4:AI7

In the third cell range, AJ10:AJ13, you’d enter the following array formula to cal-
culate the total wages paid to each employee in February 2022:

=R10:R13 + AI10:AI13

Editing a dynamic array formula
Although it appears in Figure 1-16 that the dynamic array formula now resides 
in cell R11, that’s not quite the case. Excel applies the formula to that cell (as well 
as to cells R12 and R13), but the formula that you see in R11 is only a virtual copy. 
The actual formula only resides in the cell where you entered the formula (R10, in 
the example).

Therefore, when you need to edit the array formula, you must first select the same 
cell that you used to enter the array formula. When you finish your edit and press 
Enter or click the Enter button, Excel propagates the changes to the rest of the 
array range.

Building old-fashioned array formulas
I mentioned earlier that Excel’s newfangled dynamic arrays only work with Excel 
2019 and later. If you need to keep your worksheets compatible with previous ver-
sions of Excel, you can use Excel’s old method for building arrays. Going back to 
the example worksheet shown in Figure 1-15, you can create the following array 
formula in the array range:

={A4:A7 * R4:R7}

This array formula looks (and works) just like its dynamic cousin, except that it 
has those curly brackets — they’re called braces — surrounding everything that 
comes after the equal sign (=).
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To see how you create this version of the array formula, follow along with these 
steps:

1. Make cell R10 the current cell, and then select the array range R10:R13 
and type = (equal sign) to start the array formula.

You always start an array formula by selecting the cell or cell range where the 
results are to appear. Note that array formulas, like standard formulas, begin 
with the equal sign.

2. Select the range A4:A7 that contains the hourly rate for each employee as 
shown, type an * (asterisk for multiplication), and then select the range 
R4:R7 that contains the total number of hours worked during the first 
pay period.

3. Press Ctrl+Shift+Enter to insert an array formula in the array range.

When you press Ctrl+Shift+Enter to complete the formula, Excel inserts braces 
around the formula and copies the array formula {=A4:A7 * R4:R7} into each of 
the cells in the array range R10:R13.

When entering an old-style array formula, you must press Ctrl+Shift+Enter 
instead of just the Enter key because this special key combination tells Excel that 
you are building an older array formula, so that the program encloses the formula 
in braces and copies it to every cell in the array range. Also, don’t try to create this 
type of array formula by editing it on the Formula bar and then insert curly braces 
because this doesn’t cut it. The only way to create an old-fashioned array formula 
is by pressing Ctrl+Shift+Enter to complete the formula entry.

When you enter an old-style array formula, the formula should produce an array 
with the same dimensions as the array range that you selected. If the resulting 
array returned by the formula is smaller than the array range, Excel expands the 
resulting array to fill the range. If the resulting array is larger than the array 
range, Excel doesn’t display all the results. When expanding the results in an 
array range, Excel considers the dimensions of all the arrays used in the argu-
ments of the operation. Each argument must have the same number of rows as 
the array with the most rows and the same number of columns as the array with 
the most columns.

Editing an old-fashioned array formula
Editing old-style array formulas differs somewhat from editing normal formulas. 
In editing an array range, you must treat the range as a single unit and edit it in 
one operation (corresponding to the way in which the array formula was entered). 
This means that you can’t edit, clear, move, insert, or delete individual cells in 
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the array range. If you try, Excel displays an Alert dialog box stating “You cannot 
change part of an array.”

To edit the contents of an array formula, select a cell in the array range and then 
activate Edit mode by clicking inside the Formula bar or by pressing F2. When 
you do this, Excel displays the contents of the array formula without the custom-
ary braces. The program also outlines the ranges referred to in the array formula 
in the cells of the worksheet in different colors that match those assigned to the 
range addresses in the edited formula on the Formula bar. After you make your 
changes to the formula contents, you must remember to press Ctrl+Shift+Enter to 
enter your changes and have Excel enclose the array formula in braces once again.

If you want to convert the results in an array range to their calculated values, 
select the array range and click the Copy button on the Ribbon’s Home tab or press 
Ctrl+C. Then, without changing the selection, click the Paste Values option from 
the Paste button’s drop-down menu (or press Alt+HVV). As soon as you convert 
an array range to its calculated values, Excel no longer treats the cell range as an 
array.

Naming Cells and Ranges
Thus far, all the example formulas in this chapter have used a combination of 
numerical constants, cell references (both relative and absolute), and range refer-
ences. Although cell and range references provide a convenient method for point-
ing out the cell location in the worksheet grid, they’re not at all descriptive of 
their content or function when used in formulas. Fortunately, Excel enables you 
to assign descriptive names to worksheet cells and ranges. Adding such names 
makes your worksheet formulas immediately more readable by showing the con-
tent or function of the cell and range operands.

To get an idea of how names can help to document the purpose of a formula, con-
sider the following formula:

=B4 * B2

It’s a legit formula, but what does it do? It’s impossible to say without examining 
the worksheet in more detail to look for clues.

Now check out the following formula that performs the same calculation but, this 
time, with the use of names:

=Retail_Price * Discount_Rate
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Ah, that’s better: Just by looking at the formula, you can deduce that it’s a calcu-
lation for determining the sale price of an item. Now the function of the formula 
is much more comprehensible, not only to you as the creator of the worksheet but 
also to anyone else who has to use it.

Names are extremely useful not only for documenting the function of the formu-
las in your worksheet, but also for finding and selecting cell ranges quickly and 
easily. This is especially helpful in a large worksheet that you aren’t very familiar 
with or only use intermittently. After you assign a name to a range, you can locate 
and select all the cells in that range with the Go To dialog box. On the Ribbon’s 
Home tab, drop down the Find & Select list and click Go To (or press Ctrl+G or 
F5). Then double-click the name in the Go To list box or click the name and click 
OK. Excel then selects the entire range and, if necessary, shifts the worksheet dis-
play so that you can see the first cell in that range on the screen.

If you’re using Excel on a Windows device such as a tablet without the benefit of 
a keyboard or mouse, you will definitely find it to your advantage to assign names 
to often-used cell ranges in your worksheets. That way, you can go to and select 
these ranges by tapping the Name box drop-down button followed by the name. 
That’s so much faster and easier than manually finding and selecting the range 
with your finger or stylus.

Defining cell and range names
The most straightforward way to define a name is to follow these steps:

1. Select the worksheet area you want to name.

You can select a cell, a range, or a collection of nonadjacent cells.

2. Use the Formula bar’s Name box to type the name you want to assign to 
the selection.

See Figure 1-17 (sample workbook: Loan Payments.xlsx).

3. Press Enter.

FIGURE 1-17:  
You can define a 
name using the 

Formula bar’s 
Name box.  

(Sample 
 workbook: Loan 

Payments.xlsx)
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You can also name a cell, cell range, or nonadjacent selection by displaying the 
Ribbon’s Formulas tab and clicking the Define Name command (or by pressing 
Alt+MMD). Excel opens the New Name dialog box, as shown in Figure 1-18, where 
you can type the selection’s name in the Name text box. If Excel can identify a 
label in the cell immediately above or to the left of the active one, the program 
inserts this label as the suggested name in the Name text box.

The New Name dialog box also displays the scope of the name in the Scope drop-
down list box. The scope tells you where the name is recognized by Excel. Workbook 
scope means you can use the name anywhere in the current workbook; worksheet 
scope means you can only use the name within the specified worksheet.

The New Name dialog box also displays the reference of the selected cell or range 
(expressed as absolute references) in the Refers To text box below.

You can do the following:

 » To change the scope from the entire workbook to a particular worksheet in 
the workbook so that the name is only recognized on that sheet, select the 
sheet’s name from the Scope drop-down list.

 » To change the cell or range the name refers to, click inside the Refers To box 
and then select the new cell or range in the worksheet. (Remember that you 
can collapse the New Name dialog box to the Refers To text box by clicking its 
Collapse button.)

 » If you have similar names or names that require some elaboration, use the 
Comment box to add some descriptive text. You see these comments in the 
Name Manager, which I describe a bit later (see “Managing names”).

When you’re done, click OK to define the name.

FIGURE 1-18:  
You can use the 

New Name dialog 
box to define a 

new name.
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When naming a range, you need to follow the same naming conventions as when 
defining a name in the Name box on the Formula bar. Basically, this means that 
the name must begin with a letter rather than a number, contain no spaces, and 
not duplicate any other name in the workbook. (See Book 2, Chapter 2 for more 
on naming ranges.)

If you want to assign the same name to similar ranges on different worksheets in 
the workbook, you have two choices:

 » For each worksheet, create the named range and scope the name to that 
worksheet.

 » Preface the name with the sheet name followed by an exclamation point and 
then the descriptive name. For example, if you want to give the name Costs to 
the cell range A2:A10 on both Sheet1 and Sheet2, you name the range 
Sheet1!Costs on Sheet1 and Sheet2!Costs on Sheet2. If you have renamed the 
worksheet to something more descriptive than Sheet1, you need to enclose 
the name in single quotes if it contains a space when you enter the range. For 
example, if you rename Sheet1 to Income Statement 2022, you enter the 
name including the worksheet reference for the Costs cell range as follows:

'Income Statement 2022'!Costs

When you preface a name with the sheet name as shown in this example, you 
don’t have to use the sheet name part of the name in the formulas that you create 
on the same worksheet. In other words, if you create a SUM formula that totals 
the values in the ‘Income Statement 2022’!Costs range somewhere on the Income 
Statement 2022 worksheet, you can enter the formulas as follows:

=SUM(Costs)

However, if you were to create this formula on any other worksheet in the work-
book, you would have to include the full name in the formula, as in

=SUM('Income Statement 2022'!Costs)

Naming constants and formulas
Besides naming cells and ranges in your worksheet, you can also assign names to 
the constants and formulas that you use often. For example, if you’re creating a 
worksheet table that calculates sales prices, you can assign the discount percent-
age rate to the name discount_rate. Then, you can supply this name as a constant 
in any formula that calculates the sale discount used in determining the sale price 
for merchandise.



326      BOOK 3  Formulas and Functions

For example, to assign a constant value of 15% to the name discount_rate, you 
open the New Name dialog box, type discount_rate in the Name text box, type 
=15% (that’s the value of the discount rate) in the Refers To text, and then click 
OK. After assigning this constant percentage rate to the name discount_rate in 
this manner, you can apply it to any formula by typing or pasting in the name. 
(See the “Using names in building formulas” section that follows in this chapter 
for details.)

In addition to naming constants, you can also give a name to a formula that you 
use repeatedly. When building a formula in the Refers To text box of the New 
Name dialog box (Alt+MMD), keep in mind that Excel automatically applies abso-
lute references to any cells that you point to in the worksheet. If you want to cre-
ate a formula with relative cell references that Excel adjusts when you enter or 
paste the name in a new cell, you must press F4 to convert the current cell refer-
ence to relative or type in the cell address without dollar signs.

When creating the constant in the New Name dialog box, don’t change the Scope 
setting from Workbook to a particular sheet in the workbook unless you’re posi-
tive that you’ll never need to use that constant in a formula on any other work-
sheet. If you limit the scope to a particular worksheet, Excel doesn’t let you use 
the name in a formula on any other worksheet (you’ll get the #NAME? error), and 
Scope is the one aspect you can’t change when editing a name via the Name Man-
ager. (I discuss managing names later in this chapter.)

Using names in building formulas
After you assign a name to a cell or range in your worksheet, you can then click 
the name from the Use in Formula button’s drop-down menu on the Ribbon’s 
Formulas tab to paste it into the formulas that you build (Alt+MS).

For example, in the sample Autumn 2022 Furniture Sale table shown in Figure 1-19, 
after assigning the discount rate of 15% to the name, discount_rate, you can create 
the formulas that calculate the amount of the sale discount. To do this, you multiply 
the retail price of each item by the discount_rate constant using the Use in Formula 
command button by following these steps:

1. Make cell D3 active.

2. Type = (equal sign) to start the formula.

3. Click cell C3 to select the retail price for the first item and then type * 
(asterisk).

The formula on the Formula bar now reads, =C3*.
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4. On the Ribbon’s Formulas tab, click the Use in Formula button (or press 
Alt+MS).

Excel opens the Use in Formula drop-down menu, which lists your defined 
range names.

5. Click the name discount_rate.

The formula now reads =C3*discount_rate, as shown in Figure 1-19 (sample 
workbook: Autumn Furniture Sale 2022.xlsx).

6. Click the Enter button on the Formula bar to input the formula in cell D3.

Now, all that remains is to copy the original formula down column D.

7. Drag the Fill handle in cell D3 down to cell D7 and release the mouse 
button to copy the formula and calculate the discount for the entire 
table.

Creating names from column  
and row headings
In the Ribbon’s Formulas tab, you can use the Create from Selection command to 
automatically create column and row names from the existing column and row 
headings in a table of data. Create from Selection defines column names from 
the labels used as column headings in the top or bottom row of the table, the row 
names from the labels used as row headings in the leftmost or rightmost column, 
or any combination of these headings.

FIGURE 1-19:  
In the Use in 

 Formula list, click 
the name you 
want to paste 

into your formula 
(such as the 

name discount_
rate). (Sample 

workbook: 
Autumn Furniture 

Sale 2022.xlsx)
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For example, the sample worksheet in Figure 1-20 illustrates a typical data layout 
that uses column headings in the top row of the data and row headings in the first 
column of the data. You can assign these labels to the rows and columns in the 
data by using the Create from Selection command button as follows:

1. Select the data cells, including those with the column and row labels that 
you want to use as names.

For the example shown in Figure 1-20, you select the range A2:E7.

2. On the Formulas tab, click the Create from Selection command (Alt+MC).

Excel opens the Create Names from Selection dialog box that contains four 
check boxes: Top Row, Left Column, Bottom Row, and Right Column. The 
program selects the check box or boxes in this dialog box based on the 
arrangement of the labels in your data. In the example shown in Figure 1-20 
(sample workbook: Autumn Furniture Sale 2022.xlsx), Excel selects both the 
Top Row and Left Column check boxes because the data contains both column 
headings in the top row and row headings in the left column.

3. If necessary, select the check boxes that correspond to the layout of  
your data.

4. Click OK to assign the names to your data.

Note that when you select both the Top Row and Left Column check boxes in the 
Create Names from Selection dialog box, Excel assigns the label in the cell in the  
upper-left corner of the range to the data portion of the range you selected  
(that is, the part of the range that doesn’t include the row and column  headings).  
In the example illustrated in Figure 1-20, Excel assigns the name Item_ Description 
(the heading for column A) to the cell range B3:E7.

Excel also defines each column heading as the name of that column’s data. For 
example, Excel assigns the name Retail_Price to the cell range C3:C7. Similarly, 
Excel defines each row heading as the name of that row’s data. For example, Excel 
assigns the name China_Hutch to the cell range B7:E7.

FIGURE 1-20:  
Creating names 

from the row 
and column 

headings in a 
worksheet data 
range. ( Sample 

 workbook: 
Autumn Furniture 

Sale 2022.xlsx)
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Managing names
As you assign names in your workbook, their names appear in the Name Manager 
dialog box (see Figure 1-21.) You open this dialog box by displaying the Formulas 
tab and clicking the Name Manager command (or by pressing Alt+MN).

The Name Manager enables you to do any of the following:

 » Define a new name: Click New to open the New Name dialog box. (See 
“Defining cell and range names” earlier in this chapter.)

 » Edit an existing name: Click the name you want to modify and then click Edit 
to open the Edit Name dialog box. Change the name, comment, or reference 
(but not the scope), and then click OK.

 » Delete an existing name: Click the name and then click Delete. When Excel 
asks you to confirm the deletion, click OK.

 » Filter the names: Click the Filter button and then click a filter option (Names 
Scoped to Worksheet, Names Scoped to Workbook, Names with Errors, 
Names without Errors, Defined Names, or Table Names) from its drop-down 
menu.

Be careful that you don’t delete a name that is already used in formulas in the 
worksheet. If you do, Excel returns the #NAME? error value to any formula that 
refers to the name you deleted!

FIGURE 1-21:  
The Name 

Manager lists all 
names defined in 

the workbook.
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Applying names to existing formulas
Excel doesn’t automatically replace cell or range references with the descriptive 
names that you assign to them in the New Name or Create Names from  Selection 
dialog boxes. To replace cell or range references with their names, display the 
Formulas tab, drop down the Define Name list, and then click Apply Names  
(or press Alt+MMA).

When you choose this command, Excel opens the Apply Names dialog box, where 
you select the names that you want applied in formulas used in your worksheet by 
selecting the names in the Apply Names list box.

Note that when you first open this dialog box, it contains just two check boxes: 
Ignore Relative/Absolute and Use Row and Column Names (both of which are 
selected). You can click the Options button to expand the Apply Names dialog 
box and display other options that you can use when applying your names. The 
expanded Apply Names dialog box offers the following options:

 » Ignore Relative/Absolute: The program replaces cell references with the 
names that you’ve selected in the Apply Names list box, regardless of the type 
of reference used in their formulas. If you want Excel to replace only those cell 
references that use the same type of references as are used in your names 
(absolute for absolute, mixed for mixed, and relative for relative), deselect this 
check box. Most of the time, you want to leave this check box selected 
because Excel automatically assigns absolute cell references to the names 
that you define and relative cell references to the formulas that you build.

 » Use Row and Column Names: The names created from row and column 
headings with the Create Names command appear in your formulas. Deselect 
this option if you don’t want these row and column names to appear in the 
formulas in your worksheet.

 » Omit Column Name If Same Column: Prevents Excel from repeating the 
column name when the formula is in the same column. Deselect this check 
box when you want the program to display the column name even in 
formulas in the same column as the heading used to create the column name.

 » Omit Row Name If Same Row: Prevents Excel from repeating the row name 
when the formula is in the same row. Deselect this check box when you want 
the program to display the row name even in formulas in the same row as the 
heading used to create the row name.

 » Name Order: Click the Row Column option (the default) if you want the row 
name to precede the column name when both names are displayed in the 
formulas or click the Column Row option if you want the column name to 
precede the row name.
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After applying all the names by using the default Apply Names options (that is, 
Ignore Relative/Absolute, Use Row and Column Names, Omit Column Name If 
Same Column, Omit Row Name If Same Row, and Name Order options selected), 
Excel replaces all the cell references in the formulas in the Sale Price table. In cell 
E3, for example, in place of the original formula, =C3–D3, the cell now contains 
the formula

=Retail_Price – Discount

Cell D3, to the immediate left, instead of =C3 * discount_rate now contains:

=Retail_Price * discount_rate

Only one problem occurs with applying names by using the default settings. This 
problem begins to show up as soon as you select cell E4. Although this formula 
subtracts cell D4 from C4, its contents now also appear as

=Retail_Price – Discount

This is identical in appearance to the contents of cell E3 above (and, in fact, iden-
tical in appearance to cells E5, E6, and E7 in the cells below).

The reason that the formulas all appear identical (although they’re really not) is 
because the Omit Row Name If Same Row check box was selected when I applied 
the names to the formulas. With this setting selected, Excel doesn’t bother to 
repeat the row name when the formula is in the same row.

When you deselect the Omit Row Name if Same Row check box while still select-
ing the Use Row and Column Name check box in the Apply Names dialog box, the 
formula in cell E3 would appear as follows:

=Dining_Table Retail_Price – Dining Table Discount

If you were then to select cell E4 below, the formula would now appear quite dif-
ferently in this form:

=Side_Chair Retail_Price – Side_Chair Discount

Now Excel displays both the row and column names separated by a space for 
each cell reference in the formulas in this column. Remember that the space 
between the row name and column name is called the intersection operator. (Refer 
to Table 1-1.) You can interpret the formula in E3 as saying, “Take the cell at the 
intersection of the Table row and Retail_Price column and subtract it from the 
cell at the intersection of the Table row and Discount column.” The formula in E4 
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is similar, except that it says, “Take the cell at the intersection of the Side_chair 
row and Retail_Price column and subtract it from the cell at the intersection of 
the Side_chair row and Discount column.”

Adding Linking Formulas
Linking formulas are formulas that transfer a constant or other formula to a new 
place in the same worksheet, same workbook, or even a different workbook with-
out copying it to its new location. When you create a linking formula, it brings 
forward the constant or original formula to a new location so that the result in 
the linking formula remains dynamically tied to the original. If you change the 
original constant or any of the cells referred to in the original formula, the result 
in the cell containing the linking formula is updated at the same time as the cell 
containing the original constant or formula.

You can create a linking formula in one of two ways:

 » Select the cell where you want the linking formula, type = (equal sign), and 
then click the cell with the constant (text or number) or the formula that you 
want to bring forward to that cell. Complete the cell entry by clicking the Enter 
button on the Formula bar or pressing the Enter key.

 » Select the cell with the constant or formula that you want to bring forward to 
a new location and then click the Home tab’s Copy button or press 
Ctrl+C. Then click the cell where the linking formula is to appear, drop down 
the Home tab’s Paste menu, and then click Paste Link (or press Alt+HVN).

When you use the first simple formula method to create a link, Excel uses a rela-
tive cell reference to refer to the cell containing the original value or formula (as 
in =A10 when referring to an entry in cell A10). However, when you use the second 
copy-and-paste link method, Excel uses an absolute cell reference to refer to the 
original cell (as in =$A$10 when referring to an entry in cell A10).

When you create a linking formula to a cell on a different sheet of the same work-
book, Excel inserts the worksheet name (followed by an exclamation point) in front 
of the cell address. So, if you copy and paste a link to a formula in cell A10 on a dif-
ferent worksheet called Income 2022, Excel inserts the following linking formula:

='Income 2022!$A$10

When you create a linking formula to a cell in a different workbook, Excel inserts 
the workbook filename enclosed in square brackets before the name of the work-
sheet, which precedes the cell address. So, if you bring forward a formula in cell 
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A10 on a worksheet called Cost Analysis in the Projected Income 2023 workbook, 
Excel inserts this linking formula:

='[Projected Income 2023.xlsx]Cost Analysis'!$A$10

If you ever need to sever a link between the cell containing the original value or 
formula and the cell to which it’s been brought forward, you can do so by editing 
the linking formula. Press F2, immediately recalculate the formula by pressing F9, 
and then click the Enter button on the Formula bar or press Enter. This replaces the  
linking formula with the currently calculated result. Because you’ve converted  
the dynamic formula into a constant, changes to the original cell no longer affect 
the one to which it was originally brought forward.

Controlling Formula Recalculation
Normally, Excel recalculates your worksheet automatically as soon you change 
any entries, formulas, or names on which your formulas depend. This system 
works fine as long as the worksheet isn’t too large or doesn’t contain tables whose 
formulas depend on several values.

When Excel does calculate your worksheet, the program recalculates only those 
cells that are affected by the change that you’ve made. Nevertheless, in a complex 
worksheet that contains many formulas, recalculation may take several seconds. 
(During which time, the pointer changes to an hourglass, and the word “Recalcu-
lation” followed by the number of cells left to be recalculated appears on the left 
side of the Formula bar.)

Because Excel recalculates dependent formulas in the background, you can always 
interrupt this process and make a cell entry or click a command even when the 
pointer assumes the hourglass shape during the recalculation process. As soon as 
you stop making entries or selecting commands, Excel resumes recalculating the 
worksheet.

To switch to manual recalculation, display the Formulas tab, click Calculation 
Options, and then select the Manual option (or press Alt+MXM). After switching 
to manual recalculation, when you make a change in a value, formula, or name 
that would usually cause Excel to recalculate the worksheet, the program displays 
the message “Calculate” on the Status bar.

When you’re ready to have Excel recalculate the worksheet, display the Formulas 
tab and then click the Calculate Now command (the handheld calculator icon), or 
press F9 or Ctrl+=. This tells the program to recalculate all dependent formulas and 
open charts and makes the Calculate status indicator disappear from the Status bar.
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After switching to manual recalculation, Excel still automatically recalculates the 
worksheet whenever you save the file. When you are working with a large and 
complex worksheet, recalculating the worksheet each time you want to save your 
changes can make this process quite time-consuming. If you want to save the work-
sheet without first updating dependent formulas and charts, choose File ➪ Options to 
open the Excel Options dialog box, display the Formulas tab, and then deselect the 
Recalculate Workbook before Saving check box in the Calculation Options section.

If your worksheet contains large data tables used to perform what-if analysis, you 
can bypass those data tables during Excel’s automatic recalculations by display-
ing the Formulas tab, clicking Calculation Options, and then clicking Automatic 
Except Data Tables (or press Alt+MXE). You can now change a number of variables 
in the what-if formulas before having Excel recalculate the data table. (See Book 7, 
Chapter 1 for more on performing what-if analysis.)

Automatic, Automatic Except Data Tables, and Manual are by no means the only 
calculation options available in Excel. Table 1-3 explains each of the options that 
appear in the Calculation Options section of the Formulas tab of the Excel Options 
dialog box.

TABLE 1-3 The Calculation Options in Excel
Option Purpose

Automatic Calculates all dependent formulas and updates open or embedded charts every time 
you make a change to a value, formula, or name. This is the default setting for each 
new workbook that you start.

Automatic Except 
for Data Tables

Calculates all dependent formulas and updates open or embedded charts. Does not 
calculate data tables created with the Data Table feature. (See Book 7, Chapter 1, for 
information on creating data tables.) To recalculate data tables when this option button is 
selected, click the Formulas tab’s Calculate Now command or press F9 in the worksheet.

Manual Calculates open worksheets and updates open or embedded charts only when you 
click the Formulas tab’s Calculate Now command button or press F9 or Ctrl+= in the 
worksheet.

Recalculate 
Workbook 
before Saving

When this check box is selected, Excel calculates open worksheets and updates open 
or embedded charts when you save them even when the Manually option button 
is selected.

Enable Iterative 
Calculation

When this check box is selected, Excel sets the iterations, that is, the number of times that 
a worksheet is recalculated, when performing goal seeking (see Book 7, Chapter 1) or 
resolving circular references to the number displayed in the Maximum Iterations text box.

Maximum 
Iterations

Sets the maximum number of iterations (100 by default) when the Iteration check box 
is selected.

Maximum Change Sets the maximum amount of change to the values during each iteration (0.001 by 
default) when the Iteration check box is selected.
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Circular References
A circular reference in a formula is one that depends, directly or indirectly, on its 
own value. The most common type of circular reference occurs when you mistak-
enly refer in the formula to the cell in which you’re building the formula itself. For 
example, suppose that cell B10 is active when you build this formula:

=A10 + B10

As soon as you click the Enter button on the Formula bar or press Enter or an 
arrow key to insert this formula in cell B10 (assuming the program is in Automatic 
recalculation mode), Excel displays an Alert dialog box, stating that it can’t calcu-
late the formula due to the circular reference.

If you then press Enter or click OK to close this Alert dialog box, an Excel Help 
window appears containing general information about circular references in two 
sections: Locate and Remove a Circular Reference and Make a Circular Reference 
Work by Changing the Number of Times Microsoft Excel Iterates Formulas.

When you close this Excel Help window by clicking its Close button, Excel inserts 
0 in the cell with the circular reference, and the Circular Reference status indicator 
followed by the cell address with the circular reference appears on the Status bar.

Some circular references are solvable by increasing the number of times they 
are recalculated (each recalculation bringing you closer and closer to the desired 
result), whereas others are not (for no amount of recalculating brings them closer 
to any resolution) and need to be removed from the worksheet.

The formula in cell B10 is an example of a circular reference that Excel is unable to 
resolve because the formula’s calculation depends directly on the formula’s result. 
Each time the formula returns a new result, this result is fed into the formula, 
thus creating a new result to be fed back into the formula. Because this type of 
circular reference sets up an endless loop that continuously requires recalculating 
and can never be resolved, you need to fix the formula reference or remove the 
formula from the worksheet.

Figure 1-22 illustrates the classic example of a circular reference, which ultimately 
can be resolved. Here, you have an income statement that includes bonuses equal 
to 20 percent of the net earnings entered as an expense in cell B15 with the formula

=B21 * 20%
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This formula contains a circular reference because it refers to the value in B21, 
which itself indirectly depends on the amount of bonuses (the bonuses being 
accounted for as an expense in the very worksheet formulas that determine the 
amount of net earnings in cell B21).

To resolve the circular reference in cell B15 and calculate the bonuses based on 
net earnings in B21, you need to click the Enable Iterative Calculation check box 
in the Calculation Options section of the Formulas tab in the Excel Options dialog 
box (File ➪ Options ➪ Formulas or Alt+FTF). However, if manual recalculation is 
selected, you must click the Formulas tab’s Calculate Now command (or press F9 
or Ctrl+=) as well.

FIGURE 1-22:  
Income 

 statement with 
a  resolvable 

 circular 
reference.
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Logical Functions and 
Error Trapping

Excel formulas can become quite complex and one of the iron-clad rules of 
spreadsheet work is that as complexity increases, so does the chance of 
having errors infest your work. If you’re starting to see errors in your work-

sheets, you’ve come to the right place: Troubleshooting the formula errors in 
a worksheet is the main topic of this chapter. Here, you see how to locate the 
source of all those vexing formula errors so that you can shoot them down and 
set things right! The biggest problem with errors in your formulas — besides 
how ugly such values as #REF! and #DIV/0! are — is that they spread like wild-
fire through the workbook to other cells containing formulas that refer to the 
error-laden cells. If you’re dealing with a large worksheet in a workbook with 
lots of tabs, you may have a hard time figuring out which cell contains the for-
mula that’s causing all the mayhem. And if you can’t track down the cell that’s 
the cause of all this unpleasantness, you really have no way of restoring law and 
order to your workbook. Fortunately, as you discover in this chapter, Excel offers 

Chapter 2

IN THIS CHAPTER

 » Understanding formula error values

 » Understanding the logical functions

 » Creating IF formulas that trap errors

 » Auditing formulas

 » Changing the Error Checking options

 » Masking error values in your 
printouts
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a few powerful formula auditing tools that help you locate and examine pesky 
worksheet errors.

Keeping in mind that the best defense is a good offense, you also find out in this 
chapter how to isolate potential errors at their source and thereby prevent them 
from wreaking havoc on the rest of your worksheet. This technique, known affec-
tionately as error trapping, is accomplished by skillfully using the IF function to 
look for potential errors and to provide formula alternatives to work around any 
error that rears its head.

Understanding Error Values
If Excel can’t properly calculate a formula that you enter in a cell, the program 
displays an error value in the cell as soon as you complete the formula entry. Excel 
uses several error values, all of which begin with the number sign (#), which 
is not to be confused with the ######## that Excel displays in a cell when its 
entry is too long to fit. Table 2-1 shows you the error values in Excel along with 
the meanings and the most probable causes for their display. To remove an error 
value from a cell, you must discover what caused the value to appear and then edit 
the formula so that Excel can complete the desired calculation.

If a formula in your worksheet contains a reference to a cell that returns an error 
value, that formula returns that error value as well. This can cause error values to 
appear throughout the worksheet, and make it look like it’s riddled with errors. 
But the good news is that (hopefully!) just a single error is getting propagated 
around the worksheet. The bad news is that all those error values can make it very 
difficult for you to discover which cell contains the formula that caused the origi-
nal error value so that you can fix the problem. Not to worry, though: You find out 
about Excel’s tools for finding errors a bit later (see “Checking It Twice: Auditing 
Your Formulas”).
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TABLE 2-1	 Error Values in Excel
Error Value Meaning Causes

#CALC! Unsupported formula or 
expression

Excel has come across a formula or expression that it 
doesn’t support, such as an array nested inside an array.

#DIV/0! Division by zero The division operation in your formula refers to an 
operand (such as a cell or function result) that contains 
the value 0 or is blank.

#FIELD! Invalid linked data type Your formula refers to a linked data type that doesn’t exist 
or is in some other way invalid.

#N/A No value available Your formula was unable to return a valid result. For 
example, many worksheet functions return #N/A if you 
omit a required argument or use an invalid argument.

#NAME? Excel doesn’t recognize a name This error value appears when you incorrectly type 
the range name, refer to a deleted range name, or 
forget to put quotation marks around a text string in a 
formula (causing Excel to think that you’re referring to a 
range name).

#NULL! You specified an intersection 
of two ranges that 
don’t intersect

Because the space is the intersection operator, this error 
occurs if you insert a space instead of a comma (the union 
operator) between ranges used in function arguments.

#NUM! Problem with a number in 
the formula

This error can be caused by an invalid argument in an 
Excel function or a formula that produces a number too 
large or too small to be represented in the worksheet.

#REF! Invalid cell reference This error occurs when you delete a cell referred to in the 
formula or if you paste cells over the ones referred to in 
the formula.

#SPILL! Non-empty spill range Your dynamic array formula (see Book 3, Chapter 1) can’t 
spill the array results because the spill range contains one 
or more cells that aren’t empty.

#UNKNOWN! Unsupported data type Your formula references a data type that isn’t supported 
by your Excel version.

#VALUE! Wrong type of argument 
in a function or wrong type 
of operator

This error is most often the result of specifying a 
mathematical operation with one or more cells that 
contain text.
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Using Logical Functions
In Excel, a logical expression is one that returns either of the following values:

 » TRUE: This logical value means that the expression is valid. For example, the 
expressions 2=2 and 5<10 would resolve to TRUE.

 » FALSE: This logical value means that the expression is not valid. For example, 
the expressions 2<>2 and 5>10 would resolve to FALSE.

A logical function, therefore, is a function that evaluates to either TRUE or 
FALSE. You can find Excel’s logical functions either in the Logical category of the 
Insert Function dialog box or on the Ribbon’s Formulas tab in the Logical com-
mand’s drop-down menu (Alt+ML). Here are the names of the functions along 
with their argument syntax:

 » AND(logical1, logical2,. . .) — Tests whether the logical arguments are all 
TRUE. If the arguments are all TRUE, the AND function returns TRUE; if one  
or more of the arguments are FALSE, the AND function returns FALSE.

 » FALSE( ) — Returns FALSE.

 » IF(logical_test, value_if_true, value_if_false) — Tests whether the logical_test 
expression is TRUE or FALSE. If the expression is TRUE, the IF function returns 
the value_if_true argument; if the expression is FALSE, the IF function returns 
the value_if_false argument.

 » IFERROR(value, value_if_error) — Tests whether the value expression returns an 
error. If value is not an error, IFERROR returns the value argument; otherwise, 
IFERROR returns the value_if_error argument.

 » IFNA(value, value_if_na) — Tests whether the value expression returns the #N/A 
error. If value is not #N/A, IFNA returns the value argument; otherwise, IFNA 
returns the value_if_na argument.

 » =IFS(logical_test1, value_if_true1, logical_test2, value_if_true2, . . .) — Tests 
whether the logical_test arguments return TRUE or FALSE. If one or more of 
the logical_test arguments return TRUE, IFS returns the corresponding value 
argument (value_if_true1 for logical_test1, value_if_true2 for logical_test2 and so 
on) for the first test that returns TRUE. If none of the logical_test arguments 
return TRUE, IFS returns the #N/A error value.

 » NOT(logical) — Tests whether the logical argument is TRUE or FALSE and 
returns the opposite logical value. That is, if logical is TRUE, NOT returns 
FALSE; if logical is FALSE, NOT returns TRUE.
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 » OR(logical1, logical2,. . .) — Tests whether at least one of the logical arguments 
is TRUE. If one or more arguments return TRUE, OR returns TRUE; if all the 
arguments return FALSE, OR returns FALSE.

 » SWITCH(expression, value1, result1, [default]) — Tests the value returned by the 
expression argument against a list of value arguments (value1, value2, and so 
on to value126) and returns the corresponding result (result1 for value1, result2 
for value2, and so on to result126 for value126) when a match is TRUE. The 
optional default argument is returned when none of the value arguments 
match the expression argument. When no default argument is specified, Excel 
returns the #N/A error value when there is no match.

 » TRUE( ) — Returns TRUE.

 » XOR(logical1, logical2,. . .) — Tests whether the logical arguments (usually in an 
array) are TRUE or FALSE. When there are just two arguments, XOR returns 
TRUE if one and only one argument is TRUE; if neither argument is TRUE or if 
both arguments are TRUE, XOR returns FALSE. (These results are why XOR is 
called the exclusive OR function.) Things get weird with three or more argu-
ments. In that case, XOR returns TRUE when the number of TRUE arguments 
is odd and XOR returns FALSE when the number of TRUE arguments is even.

The logical_test and logical arguments that you specify for these logical functions 
usually employ the comparison operators (=, <, >, <=, >=, or <>), which them-
selves return logical TRUE or logical FALSE values. For example, suppose that you 
enter the following formula in your worksheet:

=AND(B5=D10, C15>=500)

In this formula, Excel first evaluates the first logical argument to determine 
whether the contents in cell B5 and D10 are equal. If they are, the first comparison 
returns TRUE. If they’re not equal, this comparison returns FALSE. The program 
then evaluates the second logical argument to determine whether the content of 
cell C15 is greater than or equal to 500. If it is, the second comparison returns 
TRUE. If it isn’t greater than or equal to 500, this comparison returns FALSE.

After evaluating the comparisons in the two logical arguments, the AND function 
compares the results: If logical argument 1 and logical argument 2 are both found 
to be TRUE, the AND function returns logical TRUE. If, however, either argument 
is (or both arguments are) found to be FALSE, the AND function returns logical 
FALSE.

Getting to know the powerful IF function
When you use the IF function, you specify what’s called a logical_test argument 
whose outcome determines whether the value_if_true or value_if_false argument 
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is evaluated and returned. The logical_test argument normally uses comparison 
operators, which return either the logical TRUE or logical FALSE value. When the 
argument returns TRUE, the entry or expression in the value_if_true argument 
is returned. When the argument returns FALSE, the entry or expression in the 
value_if_false argument is returned.

Figure 2-1 (sample workbook: Products to Buy.xlsx) shows a list of products to be 
purchased. Consider the following formula that uses the IF function to determine 
whether to charge tax on an item:

=IF(E4="Yes", D4 + D4 * 7.5%, D4)

If cell E4 (the first cell in the column where you indicate whether the item being 
sold is taxable or not) contains “Yes,” the IF function uses the value_if_true argu-
ment that tells Excel to add the extended price entered in cell D4, multiply it by a 
tax rate of 7.5%, and then add the computed tax to the extended price. If, however, 
cell D4 is blank or contains anything other than the text “Yes,” the IF function 
uses the value_if_false argument, which tells Excel to just return the extended 
price to cell D4 without adding any tax to it.

As you can see, the value_if_true and value_if_false arguments of the IF function 
can contain constants or expressions whose results are returned to the cell that 
holds the IF formula.

Evaluating the many talents  
of the IFS function
The IFS logical function enables you to test for multiple conditions (up to a maxi-
mum of 127) all in a single formula without having to go through the trouble and 
potential confusion of nesting multiple IF functions.

FIGURE 2-1:  
Using the IF 
 function to 
 determine 
whether to 

charge tax on an 
item. (Sample 

workbook: 
 Products  

to Buy.xlsx)
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The worksheet shown in Figure 2-2 (sample workbook: Customer Sales by Coun-
try.xlsx) illustrates how this nifty and powerful function works. Here, I want to 
test for three conditions:

 » “Weak” customer sales, meaning the amount is less than $5,000

 » “Moderate” customer sales, meaning the amount is between $5,000 and 
$10,000

 » “Strong” customer sales, meaning the amount is above $10,000

To do this with the IFS function, I created the following formula in cell C4 of my 
worksheet that evaluates the sales amount in cell B4:

=IFS(B4 < 5000, "Weak", AND(B4 >= 5000, B4 <= 10000), 
"Moderate", B4 > 10000, "Strong")

This IFS function contains three different logical_test arguments, using three dif-
ferent value_if_true resulting arguments:

 » If the value in cell B4 is less than 5000, then return the text entry Weak as the 
value in cell C4

 » If the value in cell B4 is both greater than or equal to 5,000 and less than or 
equal to 10,000 (tested using the nested AND function), then return the text 
entry Moderate as the value in cell C4

 » If the value in cell B4 is greater than 10,000, then return the text entry Strong 
as the value in cell C4

Figure 2-2 shows the result of copying the original IFS function formula in cell C4 
down the range C5:C8 of the worksheet so that all the values entered in column B 
are evaluated as weak, moderate, or strong.

FIGURE 2-2:  
Using the IFS 

function to 
test multiple 

 conditions in a 
single  formula. 

(Sample 
 workbook: 

 Customer Sales 
by Country.xlsx)
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Learning about the SWITCH function
The SWITCH logical function enables you to test a value returned by a single 
expression argument against a series of value arguments (up to 126), each of which 
is followed in the syntax by a result argument. When SWITCH comes across the 
first value argument that matches the expression, it returns the corresponding 
result argument.

To see how this works, consider the example shown in Figure 2-3 (sample work-
book: Famous Events.xlsx). Here, I’ve entered the names of the days of the week 
in cell range A1:A7. In the cell range D3:D8, I’ve entered the dates of the famous 
events listed in C3:C8. The question I want to answer here is, for each date, on 
which day of the week did the event occur? To find out, in E3 I entered the first 
formula, which uses the SWITCH logical function with a nested WEEKDAY func-
tion followed by a series of value and result arguments as follows:

=SWITCH(WEEKDAY(D3), 1, $A$1, 2, $A$2, 3, $A$3, 4, $A$4, 5, 
$A$5, 6, $A$6, 7, $A$7)

The WEEKDAY function in this formula returns the day of week in any date as a 
number between 1 for Sunday and 7 for Saturday (see Book 3, Chapter 3 for more 
on using Date functions). This WEEKDAY function with cell D3 as its serial date 
number argument serves as the expression argument of the SWITCH function. Fol-
lowing this expression argument, you see a series of value and result arguments. 
When the WEEKDAY function returns one of the values (between 1 and 7), the 
SWITCH argument replaces it with the corresponding days of the week in the cell 
range A1:A7 as a vertical lookup table.

Note that when I entered the individual cell references from this lookup table 
into the appropriate result argument in the formula, I switched the cell reference 
from its default relative cell reference (as in A1, A2, and so forth) to its absolute 
cell reference ($A$1, $A$2, and so on). However, when I entered the cell reference 
D3 as the serial_number argument of the WEEKDAY function, I left it a relative 

FIGURE 2-3:  
Using the SWITCH 
function to match 
days of the week 

against a series of 
results returned 

by a WEEKDAY 
function. (Sample 

workbook: 
Famous  

Events.xlsx)
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reference. I did this so I could successfully copy the original formula created in cell 
E3 down to the range E4:E8 by having Excel adjust the D3 reference in the original 
formula in each copy to its appropriate row in column D, while at the same time 
preventing Excel from returning results for matches from any other cells outside 
the A1:A7 lookup table.

Figure 2-3 shows the results. The original formula with the SWITCH function in 
cell E3 has been copied down the column to the cell range E4:E8. These formu-
las all compare the day of the week number calculated by the WEEKDAY func-
tion on the dates in corresponding cells in the same row of column D. They then 
return the matching name of the day of the week from the cell range A1:A7 to their 
respective cells.

Error-Trapping Formulas
Sometimes, you know ahead of time that certain error values are unavoidable in 
a worksheet if it’s missing certain data. The most common error value that gets 
you into this kind of trouble is our old friend, the #DIV/0! error value. Suppose, for 
example, that you’re creating a new sales workbook from your sales template, and 
one of the rows in this template contains formulas that calculate the percentage 
that each monthly total is of the quarterly total. To work correctly, the formulas 
must divide the value in the cell that contains the monthly total by the value in the 
cell that contains the quarterly total. When you start a new sales workbook from 
its template, the cells that contain the formulas for determining the quarterly 
totals contain zeros, and these zeros put #DIV/0! errors in the cells with formulas 
that calculate the monthly/quarterly percentages.

These particular #DIV/0! error values in the new workbook don’t really represent 
mistakes as such because they automatically disappear as soon as you enter some 
of the monthly sales for each quarter (so that the calculated quarterly totals are 
no longer 0). The problem that you may have is convincing your nonspreadsheet-
savvy coworkers (especially the boss) that, despite the presence of all these error 
values in your worksheet, the formulas are hunky-dory. All that your coworkers 
see is a worksheet riddled with error values, and these error values undermine 
your coworkers’ confidence in the correctness of your worksheet.

Well, I have the answer for just such “perception” problems. Rather than risk 
having your manager upset over the display of a few little #DIV/0! errors here and 
there, you can set up these formulas so that, whenever they’re tempted to return 
any type of error value (including #DIV/0!), they instead return a non-error value, 
such as some text (for example, “Waiting for the quarterly total”) or a zero.



346      BOOK 3  Formulas and Functions

Error-trapping with IF
This sleight of hand in an original formula not only effectively eliminates errors 
from the formula but also prevents their spread to any cells that are dependent on 
the formula. To create such a formula, you use the IF function, which operates one 
way when a certain condition exists and another when it doesn’t.

To see how you can use the IF function in a formula that sometimes gives you 
a #DIV/0! error, consider the sample worksheet shown in Figure  2-4 (sample 
workbook: Production Schedule 2023.xlsx). This figure shows a blank Production 
Schedule worksheet for storing the 2023 production figures arranged by month 
and part number. Because I haven’t yet had a chance to input any data into this 
table, the SUM formulas in the last row and column contain 0 values. Because cell 
K7 with the grand total currently also contains 0, all the percent-of-total formu-
las in the cell range B9:J9 contain #DIV/0! error values.

The first percent-of-total formula in cell B9 contains the following:

=B7 / $K$7

Because cell K7 with the grand total contains 0, the formula returns the #DIV/0! 
error value. Now, let me show you how to set a trap for the error in the logical_ 
test argument inside an IF function. After the logical_test argument, you enter 
the value_if_true argument (which is 0  in this example) and the value_if_false 
argument (which is the B7/$K$7). With the addition of the IF function, the final  
formula looks like this:

=IF($K$7 = 0, 0, B7 / $K$7)

This formula then inputs 0 into cell B9, as shown in Figure 2-5, when the formula 
actually returns the #DIV/0! error value (because cell K7 is still empty or has a 0 in 
it), and the formula returns the percentage of total production when the formula 

FIGURE 2-4:  
Blank 2023 
 Production 

Schedule 
 spreadsheet 
that’s full of 

#DIV/0! errors. 
(Sample 

 workbook: 
 Production 

Schedule  
2023.xlsx)
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doesn’t return the #DIV/0! error value (because cell K7 with the total production 
divisor is no longer empty or contains any other value besides 0). Next, all you 
have to do is copy this error-trapping formula in cell B9 over to J9 to remove all 
the #DIV/0! errors from this worksheet.

Upping your error-trapping  
game with ISERROR
The error-trapping formula created with the IF function in cell B9 works fine as 
long as you know that the grand total in cell K7 will contain either 0 or some other 
numerical value. It does not, however, trap any of the various error values, such 
as #REF! and #NAME?, nor does it account for the special #N/A (Not Available) 
value. If, for some reason, one of the formulas feeding into the SUM formula in K7 
returns one of these beauties, they suddenly cascade throughout all the cells with 
the percent-of-total formulas (cell range B9:J9).

To trap all error values in the grand total cell K7 and prevent them from spread-
ing to the percent-to-total formulas, you need to add the ISERROR function to the 
basic IF formula. The ISERROR function returns the logical value TRUE if the cell 
specified as its argument contains any type of error value, including the special 
#N/A value (if you use ISERR instead of ISERROR, it checks for all types of error 
values except for #N/A).

To add the ISERROR function, place it in the IF function as the logical_test argu-
ment. If, indeed, K7 does contain an error value or the #N/A value at the time the 
IF function is evaluated, you specify 0 as the value_if_true argument so that Excel 
inputs 0 in cell B9 rather than an error value or #N/A. For the value_if_false argu-
ment, you specify the original IF function that inputs 0 if the cell K7 contains 0; 
otherwise, it performs the division that computes what percentage the April pro-
duction figure is of the total production.

FIGURE 2-5:  
2023  Production 

Schedule 
 spreadsheet after 

trapping all the 
#DIV/0! errors.
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This amended formula with the ISERROR and two IF functions in cell B9 looks 
like this:

=IF(ISERROR($K$7), 0, IF($K$7 = 0, 0, B7 / $K$7))

As soon as you copy this original formula to the cell range C9:J9, you’ve protected 
all the cells with the percent-of-total formulas from displaying and spreading any 
of those ugly error values.

Some people prefer to remove the display of zero values from any template that 
contains error-trapping formulas so that no one interprets the zeros as the correct 
value for the formula. To remove the display of zeros from a worksheet, deselect 
the Show a Zero in Cells That Have Zero Value check box in the Display Options 
for this Worksheet section of the Advanced tab of the Excel Options dialog box 
(File➪  Options or Alt+FT). By this action, the cells with error-trapping formulas 
remain blank until you give them the data that they need to return the correct 
answers!

Whiting-Out Errors with Conditional 
Formatting

Instead of creating logical formulas to suppress the display of potential error val-
ues, you can use Conditional Formatting (see Book 2, Chapter  2 for details) to 
deal with them. All you have to do is create a new conditional formatting rule that 
displays all potential error values in a white font (essentially, rendering them 
invisible in the cells of your worksheet). I think of using conditional formatting in 
this manner to deal with possible error values in a worksheet as applying a kind of 
electronic white-out that masks rather than suppresses formula errors.

To create this conditional formatting white-out for cells containing formulas that 
could easily be populated with error values, follow these steps:

1. Select the ranges of cells with the formulas to which you want the new 
conditional formatting rule applied.

2. Click the Conditional Formatting button on the Home tab and then click 
New Rule from its drop-down menu (Alt+HLN).

Excel displays the New Formatting Rule dialog box.

3. Click the Format Only Cells That Contain option in the Select a Rule Type 
section at the top of the New Formatting Rule dialog box.
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4. Click the Errors item from the Cell Value drop-down menu under Format 
Only Cells With section of the New Formatting Rule dialog box.

The New Formatting Rule dialog box now contains an Edit the Rule Description 
section at the bottom of the dialog box with Errors displayed under the Format 
Only Cells With heading.

5. Click the Format button to the immediate right of the Preview text box 
that now contains No Format Set.

Excel opens the Format Cells dialog box with the Font tab selected.

6. Click the Color drop-down menu button, click the white swatch (the very 
first one on the color palette displayed under Theme Colors), and then 
click OK.

Excel closes the Format Cells dialog box and the Preview text box in the New 
Formatting Rule dialog box now appears empty (as the No Format Set text is 
now displayed in a white font).

7. Click OK in the New Formatting Rule dialog box to close it and apply the 
new conditional formatting rule to your current cell selection.

After applying the new conditional formatting rule to a cell range, you can test it 
out by deliberately entering an error value into one of the cells referenced in one of 
the formulas in that range now covered by the “white-out” conditional format-
ting. Entering the #N/A error value in one of these cells with the =NA( ) function 
is perhaps the easiest to do. Instead of seeing #N/A values spread throughout the 
cell range, the cells should now appear empty because of the white font applied to 
all the #N/As, rendering them, for all intents and purposes, invisible.

Checking It Twice: Auditing Your Formulas
Auditing your worksheet’s formulas means taking a close look at your formulas 
and their results to make sure everything is error-free and accurate. Auditing is 
generally a three-step process:

1. Examine your worksheet for formula errors (such as #DIV/0! and #NAME?).

2. If an error is getting propagated through multiple cells, locate the original cell 
that’s causing the error.

3. Fix the error.
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Fortunately, Excel offers some very effective formula auditing tools for tracking 
down the cell that’s causing your error woes by tracing the relationships between 
the formulas in the cells of your worksheet. By tracing the relationships, you can 
test formulas to see which cells, called direct precedents in spreadsheet jargon, 
directly feed the formulas and which cells, called dependents (nondeductible, of 
course), depend on the results of the formulas. Excel even offers a way to visually 
backtrack the potential sources of an error value in the formula of a particular cell.

You can see the formula auditing tools on the Ribbon’s Formulas tab, in the  
Formula Auditing group. This groups contains the following commands:

 » Trace Precedents: Draws arrows to the cells (the so-called direct precedents) 
that are referred to in the formula inside the selected cell. When you click this 
button again, Excel adds “tracer” arrows that show the cells (the so-called 
indirect precedents) that are referred to in the formulas in the direct 
precedents.

 » Trace Dependents: Draws arrows from the selected cell to the cells (the 
so-called direct dependents) that use, or depend on, the results of the formula 
in the selected cell. When you click this button again, Excel adds tracer arrows 
identifying the cells (the so-called indirect dependents) that refer to formulas 
found in the direct dependents.

 » Remove Arrows: Removes all the arrows drawn, no matter what button or 
pull-down command you used to put them there. Click the drop-down button 
attached to this button to display a drop-down menu with three options:

• Remove Arrows: Removes all arrows (just like clicking the Remove Arrows 
command button).

• Remove Precedent Arrows: Gets rid of the arrows that were drawn when you 
clicked the Trace Precedents button.

• Remove Dependent Arrows: Gets rid of the arrows that were drawn when 
you clicked the Trace Dependents button.

 » Show Formulas: Displays all formulas in their cells in the worksheet instead 
of their calculated values — just like pressing Ctrl+` (back tick).

 » Error Checking: Displays the Error Checking dialog box, which describes the 
nature of the error in the current cell, gives you help on it, and enables you to 
trace its precedents. Click the Trace Error option from this button’s drop-down 
menu to attempt to locate the cell that contains the original formula that has 
an error. Click the Circular References option from this button’s drop-down 
menu to display a continuation menu with a list of all the cell addresses 
containing circular references in the active worksheet — click a cell address on 
this menu to select the cell with a circular reference formula in the worksheet. 
(See Book 3, Chapter 1 for more on circular references in formulas.)
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 » Evaluate Formula: Opens the Evaluate Formula dialog box, where you can 
have Excel evaluate each part of the formula in the current cell. The Evaluate 
Formula feature can be quite useful in formulas that nest many functions 
within them.

 » Watch Window: Opens the Watch Window dialog box, which displays the 
workbook, sheet, cell location, range name, current value, and formula in any 
cells that you add to the watch list. That way, you can keep an eye on a cell’s 
current value even when you’re working in another worksheet or workbook. 
To add a cell to the watch list, click the cell in the worksheet, click the Add 
Watch button in the Watch Window dialog box, and then click Add in the Add 
Watch dialog box that appears.

Clicking the Trace Precedents and Trace Dependents buttons in the Formula 
Auditing group of the Formulas tab on the Ribbon lets you see the relationship 
between a formula and the cells that directly and indirectly feed it, as well as 
those cells that directly and indirectly depend on its calculation. Excel establishes 
this relationship by drawing arrows from the precedent cells to the active cell and 
from the active cell to its dependent cells.

If these cells are on the same worksheet, Excel draws solid red or blue arrows 
extending from each of the precedent cells to the active cell and from the active 
cell to the dependent cells. If the cells are not located locally on the same work-
sheet (they may be on another sheet in the same workbook or even on a sheet in 
a different workbook), Excel draws a black dotted arrow. This arrow comes from 
or goes to an icon picturing a miniature worksheet that sits to one side, with the 
direction of the arrowheads indicating whether the cells on the other sheet feed 
the active formula or are fed by it.

Tracing precedents
On the Ribbon’s Formulas tab, you can click the Trace Precedents command but-
ton (or press Alt+MP) to trace all the generations of cells that contribute to the 
formula in the selected cell (kind of like tracing all the ancestors in your fam-
ily tree). Figures 2-6 and 2-7 (sample workbook: Error Tracing.xlsx, for both) 
illustrate how you can use the Trace Precedents command button or its hot key 
equivalent to quickly locate the cells that contribute, directly and indirectly, to the 
simple addition formula in cell B9.

Figure 2-6 shows the worksheet after I clicked the Trace Precedents command 
button the first time. As you can see, Excel draws trace arrows from cells A5 and 
C5 to indicate that they are the direct precedents of the addition formula in cell B9.
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In Figure  2-7, you see what happened when I clicked this command button a 
second time to display the indirect precedents of this formula. (Think of them as 
being a generation earlier in the family tree.) The new tracer arrows show that 
cells A2, A3, and A4 are the direct precedents of the formula in cell A5 — indicated 
by a border around the three cells. (Remember that cell A5 is the first direct pre-
cedent of the formula in cell B9.) Likewise, cells B2 and B3 as well as cell C2 are the 
direct precedents of the formula in cell C5. (Cell C5 is the second direct precedent 
of the formula in cell B9.)

FIGURE 2-6:  
Clicking the 

Trace Precedents 
command button 
shows the direct 

precedents of the 
formula. (Sample 
workbook: Error 

Tracing.xlsx)

FIGURE 2-7:  
Clicking the 

Trace Precedents 
command button 

again shows 
the indirect 

 precedents of the 
formula. (Sample 
workbook: Error 

Tracing.xlsx)
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Each time you click the Trace Precedents command button, Excel displays another 
(earlier) set of precedents, until no more generations exist. If you are in a hurry 
(as most of us are most of the time), you can speed up the process and display 
both the direct and indirect precedents in one operation by double-clicking the 
Trace Precedents command button. To clear the worksheet of tracer arrows, click 
the Remove Arrows command button on the Formulas tab.

Figure 2-8 (sample workbook: Error Tracing.xlsx) shows what happened after I 
clicked the Trace Precedents command button a third time (after clicking it twice 
before, as shown in Figures 2-6 and 2-7). Clicking the command button reveals 
both the indirect precedents for cell C5. The formulas in cells B2 and C2 are the 
direct precedents of the formula in cell C5. The direct precedent of the formula 
in cell C2 (and, consequently, the indirect precedent of the one in cell C5) is not 
located on this worksheet. This fact is indicated by the dotted tracer arrow coming 
from that cute miniature worksheet icon sitting on top of cell A3.

To find out exactly which workbook, worksheet, and cell(s) hold the direct prec-
edents of cell C2, I double-clicked somewhere on the dotted arrow. (Clicking the 
icon with the worksheet miniature doesn’t do a thing.) Double-clicking the dotted 
tracer arrow opens the Go To dialog box, which shows a list of all the precedents, 
including the workbook, worksheet, and cell references. To go to a precedent on 
another worksheet, double-click the reference in the Go To list box, or select it 
and click OK. (If the worksheet is in another workbook, this workbook file must 
already be open before you can go to it.)

FIGURE 2-8:  
Clicking the 

Trace Precedents 
 command 

 button a third 
time shows 

a  precedent 
on another 
 worksheet. 

 (Sample 
 workbook: Error 

Tracing.xlsx)
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The Go To dialog box, shown in Figure  2-9 (sample workbook: Error Tracing.
xlsx), displays the following direct precedent of cell C2, which is cell B4 on Sheet2 
of the same workbook:

'[Error Tracing.xlsx]Sheet2'!$B$4

To jump directly to this cell, double-click the cell reference in the Go To dia-
log box.

You can also select precedent cells that are on the same worksheet as the active 
cell by double-clicking somewhere on the cell’s tracer arrow. Excel selects the 
precedent cell without bothering to open up the Go To dialog box.

You can use the Special button in the Go To dialog box (see Figure 2-9) to select 
all the direct or indirect precedents or the direct or indirect dependents that are on 
the same sheet as the formula in the selected cell. After opening the Go To dialog 
box (Ctrl+G or F5) and clicking the Special button, you simply click the Precedents 
or Dependents option button and then click between the Direct Only and All Levels 
option buttons before you click OK.

Tracing dependents
On the Ribbon’s Formulas tab, you can click the Trace Dependents command but-
ton in the Formula Auditing group (or press Alt+MD) to trace all the generations 
of cells that either directly or indirectly utilize the formula in the selected cell 
(kind of like tracing the genealogy of all your descendants). Tracing dependents 

FIGURE 2-9:  
Double-clicking 

the dotted tracer 
arrow opens 

the Go To dialog 
box showing the 

location. (Sample 
workbook: Error 

Tracing.xlsx)
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is much like tracing precedents, described in the previous section. Each time you 
click Trace Dependents, Excel draws another set of arrows that show a generation 
of dependents further removed. To display both the direct and indirect dependents 
of a cell in one fell swoop, double-click the Trace Dependents command button.

Figure 2-10 (sample workbook: Error Tracing.xlsx) shows what happened after I 
selected cell B9 and then double-clicked the Trace Dependents button to display 
both the direct and indirect dependents and then clicked it a third time to display 
the dependents on another worksheet.

As Figure 2-10 shows, Excel first draws tracer arrows from cell B9 to cells C12 
and C13, indicating that C12 and C13 are the direct dependents of cell B9. Then, it 
draws tracer arrows from cells C12 and C13 to E12 and E13, respectively, the direct 
dependents of C12 and C13 and the indirect dependents of B9. Finally, it draws a 
tracer arrow from cell E12 to another sheet in the workbook (indicated by the dot-
ted tracer arrow pointing to the worksheet icon).

Error checking
Whenever a formula yields an error value other than #N/A (refer to Table  2-1 
earlier in this chapter for a list of all the error values) in a cell, Excel displays a 
tiny error indicator (a green triangle) in the upper-left corner of the cell, and an 
alert options button appears to the left of that cell when the cell is active. If you 
position the mouse or Touch pointer on that options button, a drop-down button 
appears to its right that you can click to display a drop-down menu, and a Screen-
Tip appears below describing the nature of the error value.

FIGURE 2-10:  
Clicking the Trace 

Dependents 
command button 

shows all the 
dependents of 
the formula in 

cell B9. (Sample 
workbook: Error 

Tracing.xlsx)



356      BOOK 3  Formulas and Functions

When you click the drop-down button, a menu appears, containing an item with 
the name of the error value followed by the following items:

 » Help on This Error: Opens an Excel Help window with information on the 
type of error value in the active cell and how to correct it.

 » Show Calculation Steps: Opens the Evaluate Formula dialog box where you 
can walk through each step in the calculation to see the result of each 
computation.

 » Ignore Error: Bypasses error checking for this cell and removes the error alert 
and Error options button from it.

 » Edit in Formula Bar: Activates Edit mode and puts the insertion point at the 
end of the formula on the Formula bar.

 » Error Checking Options: Opens the Formulas tab of the Excel Options dialog 
box where you can modify the options used in checking the worksheet for 
formula errors. (See “Changing the Error Checking options” section that 
immediately follows for details.)

If you’re dealing with a worksheet that contains many error values, you can dis-
play the Ribbon’s Formulas tab and then click the Error Checking command but-
ton (the one with the check mark on top of a red alert exclamation mark) in the 
Formula Auditing group. Excel selects the cell with the first error value and opens 
the Error Checking dialog box (see Figure 2-11) that identifies the nature of the 
error value in the current cell.

The command buttons in the Error Checking dialog box directly correspond to the 
menu options that appear when you click the cell’s alert options button. (Except 
that Error Checking Options on this drop-down menu is simply called the Options 
button in this dialog box.)

FIGURE 2-11:  
Flagging an 

error value in a 
worksheet in the 

Error Checking 
dialog box.
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In addition, the Error Checking dialog box contains Next and Previous buttons 
that you can click to have Excel select the cell with the next error value or return 
to the cell with the previously displayed error value.

Note that when you click the Next or Previous button when Excel has flagged the 
very first or last error value in the worksheet, the program displays an alert dialog 
box letting you know that the error check for the worksheet is complete. When 
you click OK, Excel closes both the alert dialog box and the Error Checking dialog 
box. Also note that clicking the Ignore Error button is the equivalent of clicking 
the Next button.

Changing the Error Checking options
When you click Error Checking Options from the alert options drop-down menu 
attached to a cell with an error value or click the Options button in the Error 
Checking dialog box, Excel opens the Formulas tab of the Excel Options dialog 
box. This tab displays the Error Checking and Error Checking Rules options that 
are currently in effect in Excel. You can use these options on this Formulas tab to 
control when the worksheet is checked for errors and what cells are flagged:

 » Enable Background Error Checking: When selected, Excel checks your 
worksheets for errors when the computer is idle.

 » Indicate Errors Using This Color: Enables you to change the color of the 
error indicator that appears as a tiny triangle in the upper-left corner of the 
cell (normally this indicator is green).

 » Reset Ignored Errors: Restores the error indicator and alert options button to 
all cells that you previously told Excel to ignore by clicking the Ignore Error 
item from the alert options drop-down menu attached to the cell.

 » Cells Containing Formulas That Result in an Error: When selected, Excel 
inserts the error indicator and adds the alert options button to all cells that 
return error values.

 » Inconsistent Calculated Column Formula in Tables: When selected, flags 
formulas in columns of cell ranges formatted as tables that vary in their 
computations from the other formulas in the column.

 » Cells Containing Years Represented as 2 Digits: When selected, flags as an 
error all dates entered as text with just the last two digits of the year as errors. 
(See Book 2, Chapter 1 to find out why this can potentially be a problem.)

 » Numbers Formatted as Text or Preceded by an Apostrophe: When 
selected, flags as an error all numbers entered as text.
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 » Formulas Inconsistent with Other Formulas in Region: When selected, 
flags as an error any formula that differs from the others in the same area of 
the worksheet.

 » Formulas Which Omit Cells in a Region: When selected, flags as an error 
any formula where cells contain data that are adjacent to the range the 
formula refers to.

 » Unlocked Cells Containing Formulas: When selected, flags as an error any 
formula whose cell is unlocked when the worksheet is protected. (See Book 4, 
Chapter 1 for information on protecting worksheets.)

 » Formulas Referring to Empty Cells: When selected, flags as an error any 
formula that refers to blank cells.

 » Data Entered in a Table Is Invalid: When selected, flags as an error any 
formulas for which you’ve set up Data Validation (see Book 2, Chapter 1 for 
details) and that contain values outside of those defined as valid.

Error tracing
Tracing a formula’s family tree, so to speak, with the Trace Precedents and Trace 
Dependents command buttons on the Ribbon’s Formulas tab is fine, as far as it 
goes. However, when it comes to a formula that returns a hideous error value, 
such as #VALUE! or #NAME?, you need to turn to Excel’s trusty Trace Error option.

To perform error tracing on the current cell, display the Ribbon’s Formulas tab 
and then click the Trace Error option from the Error Checking command’s drop-
down menu (or press Alt+MKE).

Selecting the Trace Error option is a lot like using both the Trace Precedents 
and the Trace Dependents command button options, except that the Trace Error 
option works only when the active cell contains some sort of error value returned 
by either a bogus formula or a reference to a bogus formula. In tracking down the 
actual cause of the error value in the active cell (remember that these error values 
spread to all direct and indirect dependents of a formula), Excel draws blue tracer 
arrows from the precedents for the original bogus formula and then draws red 
tracer arrows to all the dependents that contain error values as a result.

Figure 2-12 (sample workbook: Error Tracing.xlsx) shows the sample worksheet 
after I made some damaging changes that left three cells — C12, E12, and E13 — 
with #DIV/0! errors (meaning that somewhere, somehow, I ended up creating a 
formula that is trying to divide by zero, which is a real no-no in the wonderful 
world of math). To find the origin of these error values and identify its cause, I 
clicked the Trace Error option on the Error Checking command button’s drop-
down menu while E12 was the active cell.
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You can see the results in Figure  2-12. Note that Excel has selected cell C12, 
although cell E12 was active when I selected the Trace Error option. To cell C12, 
Excel has drawn two blue tracer arrows that identify cells B5 and B9 as its direct 
precedents. From cell C12, the program has drawn a single red tracer arrow from 
cell C12 to cell E12 that identifies its direct dependent.

WHEN TRACE ERROR LOSES THE TRAIL
The Trace Error option finds errors along the path of a formula’s precedents and depen-
dents until it finds either the source of the error or one of the following problems:

• It encounters a branch point with more than one error source. In this case, Excel 
doesn’t make a determination on its own as to which path to pursue.

• It encounters existing tracer arrows. Therefore, always click the Remove Arrows 
command button to get rid of tracer arrows before you click the Trace Error option 
from the Error Checking button’s drop-down menu.

• It encounters a formula with a circular reference. (See Book 3, Chapter 1 for more 
on circular references.)

FIGURE 2-12:  
Using the Trace 

Error option 
to show the 

 precedents and 
 dependents of 

the  formula. 
(Sample 

 workbook: Error 
Tracing.xlsx)
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As it turns out, Excel’s Trace Error option is right on the money because the for-
mula in cell C12 contains the bad apple rotting the whole barrel. I revised the 
formula in cell C12 so that it divided the value in cell B9 by the value in cell B5 
without making sure that cell B5 first contained the SUM formula that totaled the 
values in the cell range B2:B4. The #DIV/0! error value showed up — remember 
that an empty cell contains a zero value as if you had actually entered 0 in the 
cell — and immediately spread to cells E12 and E13, which, in turn, used the value 
returned in C12  in their own calculations. Thus, these cells were infected with 
#DIV/0! error values as well.

As soon as you correct the problem in the original formula and thus, get rid of 
all the error values in the other cells, Excel automatically converts the red tracer 
arrows (showing the proliferation trail of the original error) to regular blue tracer 
arrows, indicating merely that these restored cells are dependents of the formula 
that once contained the original sin. You can then remove all the tracer arrows 
from the sheet by clicking the Remove Arrows command button in the Formula 
Auditing group of the Ribbon’s Formulas tab (or by pressing Alt+MAA).

Evaluating a formula
The Evaluate Formula command button in the Formula Auditing group of the Rib-
bon’s Formulas tab (the one with fx inside a magnifying glass) opens the Evaluate 
Formula dialog box, where you can step through the calculation of a complicated 
formula to see the current value returned by each part of the calculation. This is 
often helpful in locating problems that prevent the formula from returning the 
hoped for or expected results.

To evaluate a formula step-by-step, position the cell pointer in that cell and 
then click the Evaluate Formula command button on the Formulas tab (or press 
Alt+MV). This action opens the Evaluate Formula dialog box with an Evaluation 
list box that displays the contents of the entire formula that’s in the current cell.

To have Excel evaluate the first expression or term in the formula (shown under-
lined in the Evaluation list box) and replace it with the currently calculated value, 
click the Evaluate button. If this expression uses an argument or term that is itself 
a result of another calculation, you can display its expression or formula by click-
ing the Step In button (see Figure 2-13; sample workbook: Error Tracing.xlsx) and 
then calculate its result by clicking the Evaluate button. After that, you can return 
to the evaluation of the expression in the original formula by clicking the Step Out 
button.
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After you evaluate the first expression in the formula, Excel underlines the next 
expression or term in the formula (by using the natural order of precedence and a 
strict left-to-right order unless you have used parentheses to override this order), 
which you can then replace with its calculated value by clicking the Evaluate but-
ton. When you finish evaluating all the expressions and terms of the current for-
mula, you can close the Evaluate Formula dialog box by clicking its Close button 
in the upper-right corner of the window.

Instead of the Evaluate Formula dialog box, open the Watch Window dialog box by 
clicking the Watch Window button on the Formulas tab (Alt+MW) and add formu-
las to it when all you need to do is to keep an eye on the current value returned by 
a mixture of related formulas in the workbook. This enables you to see the effect 
that changing various input values has on their calculations (even when they’re 
located on different sheets of the workbook).

Removing Errors from the Printout
What if you don’t have the time to trap all the potential formula errors or track 
them down and eliminate them before you have to print and distribute the spread-
sheet? In that case, you may just have to remove the display of all the error values 
before you print the report.

To do this, display the Page Layout tab and click the dialog box launcher in the 
lower-right corner of the Page Setup group. In the Page Setup dialog box, click 
the Sheet tab and then click the drop-down button attached to the Cell Errors As 
drop-down list box.

FIGURE 2-13:  
Calculating each 

part of a formula 
in the Evaluate 
Formula dialog 

box. (Sample 
workbook: Error 

Tracing.xlsx)



362      BOOK 3  Formulas and Functions

The default value for this drop-down list box is Displayed, meaning that all error 
values are displayed in the printout exactly as they currently appear in the work-
sheet. This drop-down list also contains the following items that you can click to 
remove the display of error values from the printed report:

 » Click the <blank> option to replace all error values with blank cells.

 » Click the - - option to replace all error values with two dashes.

 » Click the #N/A option to replace all error values (except for #N/A entries, of 
course) with the special #N/A value (which is considered an error value when 
you select the <blank> or -- options).

Blanking out error values or replacing them with dashes or #N/A values has no 
effect on them in the worksheet itself, only in any printout you make of the work-
sheet. You need to view the pages in the Print Preview area in the Print screen in 
the Backstage view (Ctrl+P) before you can see the effect of selecting an option 
besides the Displayed option in the Cell Errors As drop-down list box. Also, 
remember to reset the Cell Errors As option on the Sheet tab of the Page Setup 
dialog box back to the Displayed option when you want to print a version of the 
worksheet that shows the error values in all their cells in the worksheet printout.
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Date and Time Formulas

Creating formulas that use dates and times can be a little confusing if you 
don’t have a good understanding of how Excel treats these types of values. 
After you’re equipped with this understanding, you can begin to make good 

use of the many Date and Time functions that the program offers.

This chapter begins with a quick overview of date and time numbers in Excel and 
how you can use them to build simple formulas that calculate differences between 
elapsed dates and times. The chapter goes on to survey Excel’s built-in Date and 
Time functions, which enable you to return and calculate with dates and times.

Understanding Dates and Times
Excel doesn’t treat the dates and times that you enter in the cells of your work-
sheet as simple text entries. (For more information on inputting numbers in a 
worksheet, see Book 2, Chapter 1.) Any entry with a format that resembles one 
of the date and time number formats recognized by Excel is automatically con-
verted, behind the scenes, into a serial number. In the case of dates, this serial 
number represents the number of days that have elapsed since the beginning of 
the 20th century so that January 1, 1900, is serial number 1; January 2, 1900, is 
serial number 2; and so forth. In the case of times, this serial number is a frac-
tion that represents the number of hours, minutes, and seconds that have elapsed 
since midnight, which is serial number 0.0, so that 12:00:00 p.m. (noon) is serial 
number 0.5; 11:00:00 p.m. is 0.95833333; and so forth.

Chapter 3

IN THIS CHAPTER

 » Understanding dates and times in 
Excel

 » Creating formulas that calculate 
elapsed dates and times

 » Using the Date functions

 » Using the Time functions
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As long as you format an entry so that it conforms to a recognized date or time 
format, Excel enters it as a date or time serial number. Only when you enter a 
formatted date or time as a text entry (by prefacing it with an apostrophe) or 
import dates and times as text entries into a worksheet do you have to worry about 
converting them into date and time serial numbers, which enables you to build 
worksheet formulas that perform calculations on them.

Changing the date locale
Excel isn’t set up to automatically recognize European date formats in which the 
number of the day precedes the number of the month and year. For example, you 
may want 6/11/2022 to represent November 6, 2022, rather than June 11, 2022. If 
you’re dealing with a worksheet that uses this type of European date system, you 
have to customize the locale that Excel uses for its Date number formats.

To make this change, you follow these steps:

1. Select the cells to which you want to apply the new date locale.

2. On the Home tab, click the dialog box launcher in the Number group (or 
press Ctrl+1).

Excel opens the Format Cells dialog box with the Number tab displayed.

3. In the Category list, click Date.

4. Use the Locale drop-down list to select the location that uses the date 
format you want to apply, such as English (United Kingdom).

5. Click OK.

After changing the Date format locale, Excel formats the selected dates according 
to the new location. If you chose English (United Kingdom), for example, 3/5/22 is 
interpreted as May 3, 2022, rather than March 5, 2022.

Building formulas that calculate  
elapsed dates
Most of the date formulas that you build are designed to calculate the number of 
days or years that have elapsed between two dates. To do this, you build a formula 
that subtracts the earlier date from the later date.

For example, if you input the date 4/25/95 in cell B4 and 6/3/22 in cell C4 and you 
want to calculate the number of days that have elapsed between April 25, 1995, 
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and June 3, 2022, in cell D4, you’d enter the following subtraction formula in  
that cell:

=C4-B4

Excel then inputs 9901 as the number of days between these dates in cell D4 using 
the General number format.

If you want the result between two dates expressed in the number of years rather 
than the number of days, divide the result of your subtraction by the number of 
days in a year. In this example, you can enter the formula =D4/365 in cell E4 to 
return the result 27.12603, which you can then round off to 27 by clicking the 
Home tab’s Decrease Decimal button (it’s in the Number group) or by pressing 
Alt+H9 until only 27 remains displayed in the cell.

Building formulas that calculate 
elapsed times
Some worksheets require formulas that calculate the amount of elapsed time 
between a starting and an ending time. For example, suppose that you keep a 
worksheet that records the starting and stopping times for your hourly employees, 
and you need to calculate the number of hours and minutes that elapse between 
these two times to figure their daily and monthly wages.

To build a formula that calculates how much time has elapsed between two differ-
ent times of the day, subtract the starting time of day from the ending time of day. 
For example, suppose that you enter a person’s starting time in cell B6 and ending 
time in C6. In cell D6, you’d enter the following subtraction formula:

=C6-B6

Excel then returns the difference in cell D6 as a decimal value representing what 
fraction that difference represents of an entire day (that is, a 24-hour period). If, 
for example, cell B6 contains a starting time of 9:15 a.m. and cell C6 contains an 
ending time of 3:45 p.m., Excel returns the following decimal value to cell D6:

6:30 AM

To convert this time of day into its equivalent decimal number, you convert the 
time format automatically given to it to the General format (Ctrl+Shift+`), which 
displays the following result in cell D6:

0.270833
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To convert this decimal number representing the fraction of an entire day into the 
number of hours that have elapsed, you multiply this result by 24 as in =D6*24, 
which gives you a result of 6.5 hours.

Using Date Functions
Excel contains a number of built-in Date functions that you can use in your work-
sheets. You can access the Date functions either via the Insert Function icon on the 
Formula bar, or via the Ribbon’s Formulas tab by clicking the Date & Time drop-
down menu. The next few sections take you through a few of the most common 
Date functions.

TODAY
The most basic Date function has to be TODAY. This function takes no arguments 
and is always entered as follows:

=TODAY()

When you enter the TODAY function in a cell or formula, Excel returns the current 
date using the following Date format:

9/15/2022

The date inserted into a cell with the TODAY function is not static. Whenever you 
open a worksheet that contains this function, Excel recalculates the function and 
updates its contents to the current date. This means that you don’t usually use 
TODAY to input the current date when you’re doing it for historical purposes (an 
invoice, for example) and never want it to change.

If you do use TODAY and then want to make the current date static in the work-
sheet, you need to convert the function into its serial number. You can do this for 
individual cells: First, select the cell, press F2 to activate Edit mode, press F9 to 
replace =TODAY() with today’s serial number on the Formula bar, and click the 
Enter button to insert this serial number into the cell. You can do this conver-
sion on a range of cells by selecting the range, copying it to the Clipboard by 
clicking the Copy button on the Home tab of the Ribbon (or pressing Ctrl+C), and 
then immediately pasting the calculated values into the same range by choosing 
the Paste Values option from the Paste command button’s drop-down menu (or 
pressing Alt+HVV).
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DATE and DATEVALUE
The DATE function returns a date serial number given a year, month, and day as 
arguments. The DATE function uses the following syntax:

DATE(year,month,day)

This function comes in handy when you have a worksheet that contains the differ-
ent parts of the date in separate columns, similar to the one shown in Figure 3-1. 
You can use it to combine the three columns of date information into a single date 
cell that you can use in sorting and filtering. (See Book 6, Chapters 1 and 2 to find 
out how to sort and filter data.)

The DATEVALUE function returns the date serial number for a date that’s been 
entered into the worksheet as text so that you can use it in date calculations. This 
function takes a single argument:

DATEVALUE(date_text)

Suppose, for example, that you’ve made the following text entry in cell B12:

'5/21/2022

(Remember that when you preface an entry with an apostrophe, Excel inserts that 
entry as text even if the program would otherwise treat it as a value.) You can con-
vert this text entry into a date serial number by entering the following formula in 
cell C12 next door:

=DATEVALUE(B12)

FIGURE 3-1:  
Using the DATE 

function to  
combine  

separate date 
information into 

a single entry.
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Excel returns the date serial number, 44702, to cell C12, which you can con-
vert into a more intelligible date by formatting it with one of Excel’s Date  
formats (Ctrl+1).

You must convert the DATE and DATEVALUE functions into their calculated date 
serial numbers to sort and filter them. To convert these functions individually, 
select a cell, press F2 to activate Edit mode, and then press F9 to replace the 
function with the calculated date serial number; finally, click the Enter button on 
the Formula bar to insert this serial number into the cell. To do this conversion 
on a range of cells, select the range, copy it to the Clipboard by pressing Ctrl+C, 
and then immediately paste the calculated serial numbers into the same range by 
choosing the Paste Values option from the Paste command button’s drop-down 
menu (or press Alt+HVV).

DAY, WEEKDAY, MONTH, and YEAR
The DAY, WEEKDAY, MONTH, and YEAR Date functions all return just parts of the 
date serial number that you specify as their argument:

 » DAY(serial_number): Returns the day of the month in the date (as a number 
between 1 and 31).

 » WEEKDAY(serial_number,[return_type]): Returns the day of the week  
(as a number between 1 and 7 or 0 and 6). The optional return_type argument 
is a number between 1 and 3; 1 (or no return_type argument) specifies the 
first type where 1 equals Sunday and 7 equals Saturday; 2 specifies the 
second type where 1 equals Monday and 7 equals Sunday; and 3 specifies the 
third type where 0 equals Monday and 6 equals Sunday.

 » MONTH(serial_number): Returns the number of the month in the date serial 
number (from 1 to 12).

 » YEAR(serial_number): Returns the number of the year (as an integer between 
1900 and 9999) in the date serial number.

For example, if you enter the following DAY function in a cell as follows:

DAY(DATE(2022, 4, 15))

Excel returns the value 15 to that cell. If, instead, you use the WEEKDAY function 
as follows:

WEEKDAY(DATE(2022, 4, 15))
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Excel returns the value 6, which represents Friday (using the first return_type 
where Sunday is 1 and Saturday is 7) because the optional return_type argument 
isn’t specified. (See Book 3, Chapter 2 for an example using the WEEKDAY func-
tion as the expression argument of the SWITCH function to replace the day num-
bers (1 – 7) with their corresponding names (Sunday – Saturday).

If you use the MONTH function on this date as in the following:

MONTH(DATE(2022, 4, 15))

Excel returns 4 to the cell.

To avoid errors in your date formulas, always enter all four digits of the year. For 
example, consider the following:

DATE(22, 4, 15)

This returns the date April 15, 1922, which is probably not what you want.

Note that you can use the YEAR function to calculate the difference in years 
between two dates. For example, if cell B6 contains 7/23/1978 and cell C6 contains 
7/23/2022, you can enter the following formula using the YEAR function to deter-
mine the difference in years:

=YEAR(C6) - YEAR(B6)

Excel then returns 44 to the cell containing this formula.

Don’t use these functions on dates entered as text entries. Always use the  
DATEVALUE function to convert these text dates and then use the DAY, WEEKDAY, 
MONTH, or YEAR functions on the serial numbers returned by the DATEVALUE 
function to ensure accurate results.

DAYS360
The DAYS360 function returns the number of days between two dates based on a 
360-day year (that is, one in which there are 12 equal months of 30 days each), 
which is an accounting convention. The DAYS360 function takes the following 
arguments:

DAYS360(start_date, end_date, [method])
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The start_date and end_date arguments are date serial numbers or references to 
cells that contain such serial numbers. The optional method argument is either 
TRUE or FALSE, where FALSE specifies the use of the U.S. calculation method and 
TRUE specifies the use of the European calculation method:

 » U.S. (NASD) method (FALSE or method argument omitted): In this method, 
if the starting date is equal to the 31st of the month, it becomes equal to the 
30th of the same month; if the ending date is the 31st of a month and the 
starting date is earlier than the 30th of the month, the ending date becomes 
the 1st of the next month; otherwise, the ending date becomes equal to the 
30th of the same month.

 » European method (TRUE): In this method, starting and ending dates that 
occur on the 31st of a month become equal to the 30th of the same month.

Other useful Date functions
Excel includes a few other Date functions that, while somewhat specialized, may 
come in handy from time to time. These Date functions expand your ability to do 
date calculations in the worksheet — especially those calculations that work with 
standard workdays: Monday through Friday.

EDATE
The EDATE (for Elapsed Date) function calculates a future or past date that is a 
specified number of months ahead or behind some starting date. You can use the 
EDATE function to quickly determine the date at a specified interval in the future 
or past (for example, three months ahead or one month ago).

The EDATE function takes two arguments:

EDATE(start_date, months)

The start_date argument is the date serial number that you want used as the base 
date. The months argument is a positive (for future dates) or negative (for past 
dates) integer that represents the number of months ahead or months past to 
calculate.

For example, suppose that you enter the following EDATE function in a cell:

=EDATE(DATE(2022, 1, 15), 1)

Excel returns the date serial number, 44607, which becomes 2/15/2022 when you 
apply the m/d/yyyy Date format.
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Note that EDATE “rounds” off some calculations to the end of the month. For 
example, consider the following formula:

=EDATE(DATE(2022, 3, 31), 1)

Excel returns the date serial number, 44681, which becomes 4/30/2022 when you 
apply the m/d/yyyy Date format. That is, because there’s no such date as April 31, 
2022, EDATE “rounds” the result to the valid date April 30, 2022.

EOMONTH
The EOMONTH (for End of Month) function calculates the last day of the month 
that is a specified months ahead or behind a starting date. You can use the 
EOMONTH function to quickly determine the end of the month at a set interval in 
the future or past.

For example, suppose that you enter the following EOMONTH function in a cell:

=EOMONTH(DATE(2022, 1, 1), 1)

Excel returns the date serial number, 44620, which becomes 2/28/2022 when you 
apply the m/d/yyyy Date format.

NETWORKDAYS
The NETWORKDAYS function returns the number of workdays that exist between 
a starting date and ending date that you specify as arguments:

NETWORKDAYS(start_date, end_date, [holidays])

When using this function, you can also specify a cell range in the worksheet or 
array constant to use as an optional holidays argument that lists the state, fed-
eral, and floating holidays observed by your company. Excel then excludes any 
dates listed in the holidays argument when they occur in between start_date and 
end_date arguments.

Figure  3-2 (sample workbook: Work Days.xlsx) illustrates how this function 
works. In this worksheet, I created a list in the cell range B3:B13 with all the 
observed holidays in the calendar year 2022 and named this range Days_Off.  
I then entered the following NETWORKDAYS function in cell E4:

NETWORKDAYS(DATE(2021, 12, 31), DATE(2022, 12, 31), Days_Off)
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The preceding function calculates the number of workdays between December 
31, 2021, and December 31, 2022 (261 total work days), and then subtracts the 
dates listed in the cell range Days_Off (B3:B13) if they fall on a weekday. Because 
eight of the holidays in the Days_Off range happen to fall on a weekday in the 
year 2022, the number of workdays between December 31, 2021, and December 31, 
2022, is calculated as 253 in cell E4 (261–8=253).

WEEKNUM
The WEEKNUM function returns a number indicating where the week in a speci-
fied date falls within the year. This function takes the following arguments:

WEEKNUM(serial_number, [return_type])

In this function, the serial_number argument is the date whose week in the year 
you want to determine. The optional return_type argument is 1 or 2, where 1 indi-
cates that the new week begins on Sunday and weekdays are numbered from 1 to 
7, and 2 indicates that the new week begins on Monday and that weekdays are also 
numbered from 1 to 7.

Note that even if the first week of the year contains just a single day, that week is 
considered week 1 from the WEEKNUM function’s perspective. For example, if you 
enter the following WEEKNUM function in a cell:

=WEEKNUM(DATE(2022, 1, 23))

Excel returns the number 5, indicating that the week containing the date  
January 23, 2022, is the fifth week in the year when Sunday is considered as the 
first day of the week. January 23, 2022 falls on a Sunday and, if you look at a cal-
endar, it appears to be only the fourth Sunday of the year. But look closer and you 

FIGURE 3-2:  
Using the 

NETWORKDAYS 
function to find 

the number 
of workdays 

between two 
dates. (Sample 

workbook: Work 
Days.xlsx)
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see that January 1, 2022 falls on a Saturday, so the week that includes January 1, 
2022 (which technically begins on Sunday, December 27, 2021) is considered to 
be week 1.

Note that if I had added 2 as the optional return-type argument, Excel would return 
4 as the result because January 23, 2022, is deemed to fall on the last day of the 
fourth week of the year when Monday is considered the first day of the week.

WORKDAY
You can use the WORKDAY function to find out the date that is a specified num-
ber of workdays before or after a starting date. This function takes the following 
arguments:

WORKDAY(start_date, days, [holidays])

The start_date argument is the initial date that you want used in calculating the 
date of the workday that falls so many days before or after it. The days argument 
is the number of workdays ahead (positive integer) or behind (negative integer) 
the start_date. The optional holidays argument is an array constant or cell range 
that contains the dates of the holidays that should be excluded (when they fall on 
a weekday) in calculating the new date.

For example, suppose that you want to determine a due date for a report that is 30 
workdays after February 1, 2022, by using the same holiday schedule entered in 
the cell range named Days_Off (B3:B13) in the Work Days 2022 workbook, shown 
in Figure 3-2. To do this, you enter the following formula:

=WORKDAY(DATE(2022, 2, 1), 30, Days_Off)

Excel then returns the serial number 44636 to the cell, which then appears as 
3/16/2022, when you format it with the Short Date format.

YEARFRAC
The YEARFRAC (for Year Fraction) function enables you to calculate the fraction of 
the year, which is computed from the number of days between two dates. You can 
use the YEARFRAC function to determine the proportion of a whole year’s benefits 
or obligations to assign to a specific period.

The YEARFRAC function uses the following arguments:

YEARFRAC(start_date, end_date, [basis])
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The optional basis argument in the YEARFRAC function is a number between 0 and 
4 that determines the day count basis to use in determining the fractional part of 
the year:

 » 0 (or omitted) to base it on the U.S. (NASD) method of 30/360 (see “DAYS360” 
earlier in the chapter for details on the U.S. method)

 » 1 to base the fraction on actual days/actual days

 » 2 to base the fraction on actual days/360

 » 3 to base the fraction on actual days/365

 » 4 to base the fraction on the European method of 30/360 (see “DAYS360” 
earlier in the chapter for details on the European method)

For example, if you enter the following YEARFRAC formula in a cell to find what 
percentage of the year remains as of October 15, 2022:

=YEARFRAC(DATE(2022, 10, 15),DATE(2022, 12, 31))

Excel returns the decimal value 0.2111111 to the cell, indicating that just over  
21 percent of the year remains.

Using Time Functions
Excel offers far fewer Time functions when compared with the wide array of Date 
functions. Like the Date functions, however, the Time functions enable you to 
convert text entries representing times of day into time serial numbers so that 
you can use them in calculations. The Time functions also include functions for 
combining different parts of a time into a single serial time number, as well as 
those for extracting the hours, minutes, and seconds from a single time serial 
number. You can access the Time functions either via the Insert Function icon 
on the Formula bar, or via the Ribbon’s Formulas tab by clicking the Date & Time 
drop-down menu. The next few sections take you through a few of the most com-
mon Time functions.

NOW
The NOW function returns the current date and time based on your comput-
er’s internal clock. You can use the NOW function to date- and time-stamp the 
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worksheet. Like the TODAY function, NOW takes no arguments and is automati-
cally recalculated every time you open the worksheet:

=NOW()

When you enter the NOW function in a cell, Excel puts the date before the current 
time. It also formats the date with the Short Date format and the time with the 
24-hour Time format. So, if the current date were August 19, 2022 and the current 
time was 12:57 p.m. at the moment when Excel calculates the NOW function, your 
cell would contain the following entry:

8/19/2022 12:57

Note that the combination Date/Time format that the NOW function uses is a cus-
tom number format. If you want to assign a different date/time to the date and 
time serial numbers returned by this function, you have to create your own cus-
tom number format and then assign it to the cell that contains the NOW function. 
(See Book 2, Chapter 2 for information on creating custom number formats.)

TIME and TIMEVALUE
Given values representing the hour, minute, and second, the TIME function returns 
a decimal number representing the time serial number, ranging from 0 (zero) to 
0.99999999, representing time 0:00:00 (12:00:00 AM) to 23:59:59 (11:59:59 PM). 
You can use the TIME function to combine the hours, minutes, and seconds of a 
time into a single time serial number when these parts are stored in separate cells.

The TIME function takes the following arguments:

TIME(hour, minute, second)

When specifying the hour argument, you use a number between 0 and 23. (Any 
number greater than 23 is divided by 24, and the remainder is used as the hour 
value.) When specifying the minute and second arguments, you use a number 
between 0 and 59. (Any minute argument greater than 59 is converted into hours 
and minutes, just as any second argument greater than 59 is converted into hours, 
minutes, and seconds.)

For example, if cell A3 contains 4, cell B3 contains 37, and cell C3 contains 0, and 
you enter the following TIME function in cell D3:

=TIME(A3, B3, C3)
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Excel enters 4:37 AM in cell D3. If you then assign the General number format 
to this cell (Ctrl+Shift+` or Ctrl+~), it would then contain the time serial number, 
0.192361.

The TIMEVALUE function converts a time entered or imported into the work-
sheet as a text entry into its equivalent time serial number so that you can use it 
in time calculations. The TIMEVALUE function uses a single time_text argument 
as follows:

TIMEVALUE(time_text)

So, for example, if you put the following TIMEVALUE function in a cell to deter-
mine the time serial number for 10:35:25:

=TIMEVALUE("10:35:25")

Excel returns the time serial number 0.441262 to the cell. If you then assign the 
first Time number format to this cell, the decimal number appears as 10:35:25 
a.m. in the cell.

HOUR, MINUTE, and SECOND
The HOUR, MINUTE, and SECOND functions on the Date & Time command but-
ton’s drop-down menu enable you to extract specific parts of a time value in the 
worksheet. Each of these three Time functions takes a single serial_number argu-
ment that contains the hour, minute, or second that you want to extract.

So, for example, if cell B5 contains the time 1:30:10 p.m. (otherwise known as 
serial number 0.5626157) and you enter the following HOUR function in cell C5:

=HOUR(B5)

Excel returns 13 as the hour to cell C5 (hours are always returned in 24-hour 
time). If you then enter the following MINUTE function in cell D5:

=MINUTE(B5)

Excel returns 30 as the number of minutes to cell D5. Finally, if you enter the fol-
lowing SECOND function in cell E5:

=SECOND(B5)

Excel returns 10 as the number of seconds to cell E5.
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Finagling Financial 
Formulas

A killer app is a software program so good or so useful that it justifies the price 
of whatever platform it runs on. Back in the late 1970s, the Apple II com-
puter found its killer app in the VisiCalc spreadsheet program. A few years 

later, the original IBM PC’s killer app was the Lotus 1-2-3 spreadsheet software. 
Yep, that’s right: The early history of personal computing was pretty much defined 
by people desperately wanting to digitize their company or personal finances.

Forty years later, nothing has changed. Sure, VisiCalc and Lotus 1-2-3 have bit 
the digital dust, but folks like you and me still spend a ton of time wrestling 
with financial data stored in spreadsheets. Those spreadsheet financial models 
are now mostly stored in Excel workbooks. And no wonder: Excel not only lets you 
add, subtract, multiple, and divide financial values. but it also offers a sophisti-
cated toolkit of financial functions. Excel’s financial prowess includes functions 
for determining such things as the present, future, or net present value of an 
investment; the payment, number of periods, or the principal or interest part of a 
payment on an amortized loan; the rate of return on an investment; or the depre-
ciation of your favorite assets.

Excel also comes with quite a few advanced financial functions that cover such 
highly specialized use cases as calculating the accrued interest for a security pay-
ing interest periodically and only at maturity, and calculating the internal rate of 
return and the net present value for a schedule of nonperiodic cash flows.

Chapter 4

IN THIS CHAPTER

 » Using basic investment functions

 » Using basic depreciation functions

 » Using basic currency conversion 
functions
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Some Financial Function Basics  
Before You Begin

The key to using any of Excel’s financial functions is to understand the terminol-
ogy used by their arguments. Many of the most common financial functions, such 
as PV (Present Value), NPV (Net Present Value), FV (Future Value), PMT (Pay-
ment), and IPMT (Interest Payment) take similar arguments:

 » PV: The present value of a loan or investment. For a loan, PV is the principal 
(that is, the amount borrowed); for an investment, PV is the amount initially 
deposited into the investment.

 » FV: The future value of a loan or investment. For a loan, FV is the principal that 
remains at the end of the term; for an investment, FV is the total amount in 
the investment at the end of the term (the original deposit plus interest).

 » PMT: The payment made each period for a loan or investment. For a loan, 
PMT is usually set over the term of the loan and includes principal plus 
interest; for an investment, PMT is the amount you deposit each period.

 » RATE: The interest rate for a loan or investment. Normally, the rate is 
expressed as an annual percentage.

 » NPER: The total number of payment periods in the term of the loan or 
investment. You calculate this number by taking the Term (the amount of time 
that interest is paid) and multiplying it by the Period (the point in time when 
interest is paid or earned) so that a loan with a 3-year term with 12 monthly 
interest payments has 3 x 12, or 36 payment periods.

When using financial functions, keep in mind that the fv, pv, and pmt arguments 
can be positive or negative, depending on whether you’re receiving the money (as 
in the case of an investment) or paying out the money (as in the case of a loan).

Also keep in mind that you want to express the rate argument in the same time 
units as the nper argument. If rate is an annual percentage, then nper must be 
expressed in years; if nper is expressed in months, rate must be a monthly per-
centage. For example, suppose you make monthly payments on a 30-year mort-
gage, so you express nper as the total number of monthly payments, which is 
360 (30 x 12). To get accurate results in your mortgage calculations, you need to 
express the annual interest rate in monthly terms as well. For example, if you pay 
an annual interest rate of 3 percent on the loan, you express the rate argument as 
0.03/12 so that it is monthly as well.
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The PV, NPV, and FV Functions
The PV (Present Value), NPV (Net Present Value), and FV (Future Value) functions —  
all found on the Ribbon’s Formulas tab in the Financial button’s drop-down menu 
(Alt+MI) — enable you to determine the profitability of an investment.

Calculating the Present Value
The PV, or Present Value, function returns the present value of an investment, 
which is the total amount that a series of future payments is worth presently. The 
syntax of the PV function is as follows:

=PV(rate, nper, pmt,[fv],[type])

The fv and type arguments are optional arguments in the function (indicated by 
the square brackets). The fv argument is the future value or cash balance that 
you want to have after making your last payment. If you omit the fv argument, 
Excel assumes a future value of zero (0). The type argument indicates whether the 
payment is made at the beginning or end of the period: Enter 0 (or omit the type 
argument) when the payment is made at the end of the period, and use 1 when it 
is made at the beginning of the period.

Figure  4-1 (sample workbook: Present Value Examples.xlsx) contains several 
examples using the PV function. All three PV functions use the same annual per-
centage rate of 1.25 percent and term of 10 years. Because payments are made 
monthly, each function converts these annual figures into monthly ones. For 
example, in the PV function in cell E3, the annual interest rate in cell A3 is con-
verted into a monthly rate by dividing by 12 (A3/12). The annual term in cell B3 is 
converted into equivalent monthly periods by multiplying by 12 (B3 x 12).

Note that although the PV functions in cells E3 and E5 use the rate, nper, and pmt 
($218.46) arguments, their results are slightly different. This is caused by the 
difference in the type argument in the two functions: the PV function in cell E3 
assumes that each payment is made at the end of the period (the type argument 
is 0 whenever it is omitted), whereas the PV function in cell E5 assumes that each 
payment is made at the beginning of the period (indicated by a type argument of 
1). When the payment is made at the beginning of the period, the present value of 
this investment is $0.89 higher than when the payment is made at the end of the 
period, reflecting the interest accrued during the last period.
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The third example in cell E7 (shown in Figure  4-1) uses the PV function with 
an fv argument and no pmt argument. In this example, the PV function tells you 
that if you wanted to have $8,000 at the end of a 10-year investment that pays 
monthly interest at an annual rate of 1.25 percent, you would have to make an ini-
tial deposit of $7,060.43. Note that when you use the PV function without the pmt 
argument, you must still indicate the position of the pmt argument in the function 
with a comma (thus the two commas in a row in the function) so that Excel does 
not mistake your fv argument for the pmt argument.

Calculating the Net Present Value
The NPV function calculates the net present value based on a series of cash flows. 
The syntax of this function is

=NPV(rate, value1, [value2], [...])

where value1, value2, and so on are between 1 and 13 value arguments representing 
a series of payments (negative values) and income (positive values), each of which 
is equally spaced in time and occurs at the end of the period. The NPV investment 
begins one period before the period of the value1 cash flow and ends with the last 
cash flow in the argument list. If your first cash flow occurs at the beginning of 
the period, you must add it to the result of the NPV function rather than include 
it as one of the arguments.

Figure 4-2 (sample workbook: Net Present Value Example.xlsx) illustrates the use 
of the NPV function to evaluate the attractiveness of a five-year investment that 
requires an initial investment of $30,000 (the value in cell G3). The first year, you 
expect a loss of $22,000 (cell B3); the second year, a profit of $15,000 (cell C3); the 
third year, a profit of $25,000 (cell D3); the fourth year, a profit of $32,000 (cell 
E3); and the fifth year, a profit of $38,000 (cell F3). Note that these cell references 
are used as the value arguments of the NPV function.

FIGURE 4-1:  
Using the PV 

function to 
 calculate the 

present value 
of various 

 investments. 
(Sample 

 workbook: 
Present Value 

Examples.xlsx)
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Unlike when using the PV function, the NPV function doesn’t require an even 
stream of cash flows. The rate argument in the function is set at 2.25 percent. In 
this example, this represents the discount rate of the investment — that is, the 
interest rate that you may expect to get during the five-year period if you put your 
money into some other type of investment, such as a high-yield money-market 
account. This NPV function in cell A3 returns a net present value of $49,490.96, 
indicating that you can expect to realize a great deal more from investing your 
$30,000 in this investment than you possibly could from investing the money in 
a money-market account at the interest rate of 2.25 percent.

Calculating the Future Value
The FV function calculates the future value of an investment. The syntax of this 
function is

=FV(rate, nper, pmt, [pv], [type])

The rate, nper, pmt, and type arguments are the same as those used by the PV func-
tion. The pv argument is the present value or lump-sum amount for which you 
want to calculate the future value. As with the fv and type arguments in the PV 
function, both the pv and type arguments are optional in the FV function. If you 
omit these arguments, Excel assumes their values to be zero (0) in the function.

You can use the FV function to calculate the future value of an investment, such as 
an IRA (Individual Retirement Account). For example, suppose that you establish 
an IRA at age 43 and will retire 22 years from now at age 65 and that you plan to 
make annual payments into the IRA at the beginning of each year. If you assume a 
rate of return of 2.5 percent a year, you’d enter the following FV function in your 
worksheet:

=FV(2.5%, 22, –1500, , 1)

FIGURE 4-2:  
Using the NPV 

function to 
 calculate the net 
present value of 

an  investment. 
(Sample 

 workbook: Net 
Present Value 
Example.xlsx)
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Excel then indicates that you can expect a future value of $44,376.64 for your 
IRA when you retire at age 65. If you had established the IRA a year prior and the 
account already has a present value of $1,538, you would amend the FV function 
as follows:

=FV(2.5%, 22, –1500, –1538, 1)

In this case, Excel indicates that you can expect a future value of $47,024.42 for 
your IRA at retirement.

The PMT Function
The PMT function calculates the periodic payment for a loan or investment, 
assuming a stream of equal payments and a constant rate of interest. The PMT 
function uses the following syntax:

=PMT(rate, nper, pv, [fv], [type])

As with the other common financial functions, rate is the interest rate per period, 
nper is the number of periods, pv is the present value or the amount the future 
payments are worth presently, fv is the future value or cash balance that you want 
after the last payment or deposit is made (Excel assumes a future value of zero 
when you omit this optional argument as you would when calculating loan pay-
ments), and type is the value 0 for payments made at the end of the period or the 
value 1 for payments or deposits made at the beginning of the period. (If you omit 
the optional type argument, Excel assumes that the payment or deposit is made at 
the end of the period.)

The PMT function is often used to calculate the payment for mortgage loans that 
have a fixed rate of interest. Figure 4-3 (sample workbook: Loan Payments.xlsx) 
shows a sample worksheet that contains a table using the PMT function to calcu-
late loan payments for a range of interest rates (from 2.75 percent to 4.00 percent) 
and principals ($150,000 to $159,000). The table uses the initial principal that you 
enter in cell B2, copies it to cell A7, and then increases it by $1,000 in the range 
A8:A16. The table uses the initial interest rate that you enter in cell B3, copies it to 
cell B6, and then increases this initial rate by 1/4 of a percent in the range C6:G6. 
The term in years in cell B4 is a constant factor that is used in the entire loan pay-
ment table.



Fi
na

gl
in

g 
Fi

na
nc

ia
l 

Fo
rm

ul
as

CHAPTER 4  Finagling Financial Formulas      383

To learn how to build this type of loan payment table with the PMT function, fol-
low these steps for creating it in a new worksheet:

1. Enter the titles Loan Payments in cell A1, Principal in cell A2, Interest Rate in 
cell A3, and Term (in years) in cell A4.

2. Enter $150,000 in cell B2, enter 2.75% in cell B3, and enter 30 in cell B4.

You build the Loan Payments table with these starting values.

3. Position the cell pointer in B6 and then build the formula =B3.

By creating a linking formula that brings forward the starting interest rate value 
in B3 with the formula, you ensure that the interest rate value in B6 will 
immediately reflect any change that you make in cell B3.

4. Position the cell pointer in cell C6 and then build the formula =B6 + .25%.

By adding 1/4 of a percent to the interest rate to the value in B6 with the 
formula =B6 + 0.25% in C6 rather than creating a series with the AutoFill 
handle, you ensure that the interest rate value in cell C6 is 1/4 of a percent 
larger than any interest rate value entered in cell B6.

5. Drag the Fill handle in cell C6 to extend the selection to the right to cell G6.

6. Position the cell pointer in cell A7 and then build the formula =B2.

Again, by using the formula =B2 to bring the initial principal forward to cell A7, 
you ensure that cell A7 always has the same value as cell B2.

7. Position the cell pointer in A8 and then build the formula =A7 + 1000.

Here too, you use the formula =A7 + 1000 rather than create a series with the 
AutoFill feature so that the principal value in A8 will always be $1,000 greater 
than any value placed in cell A7.

FIGURE 4-3:  
Loan Payments 
table using the 

PMT function to 
calculate various 

loan  payments. 
(Sample 

 workbook: Loan 
Payments.xlsx)
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8. Drag the Fill handle in cell A8 down until you extend the selection to cell 
A16 and then release the mouse button.

9. In cell B7, click the Insert Function button on the Formula bar, select 
Financial from the Or Select a Category drop-down list, and then double-
click the PMT function in the Select a Function list box.

The Function Arguments dialog box that opens allows you to specify the rate, 
nper, and pv arguments. Be sure to move the Function Arguments dialog box 
to the right so that no part of it obscures the data in columns A and B of your 
worksheet before proceeding with the following steps for filling in the 
arguments.

10. Click cell B6 to insert B6 in the Rate text box and then press F4 twice to 
convert the relative reference B6 to the mixed reference B$6 (column 
relative, row absolute) before you type /12.

You convert the relative cell reference B6 to the mixed reference B$6 so that 
Excel does not adjust the row number when you copy the PMT formula down 
each row of the table, but it does adjust the column letter when you copy the 
formula across its columns. Because the initial interest rate entered in B3 (and 
then brought forward to cell B6) is an annual interest rate, but you want to 
know the monthly loan payment, you need to convert the annual rate to a 
monthly rate by dividing the value in cell B6 by 12.

11. Click the Nper text box, click cell B4 to insert this cell reference in this 
text box, and then press F4 once to convert the relative reference B4 to 
the absolute reference $B$4 before you type * 12.

You need to convert the relative cell reference B4 to the absolute reference 
$B$4 so that Excel adjusts neither the row number nor the column letter when 
you copy the PMT formula down the rows and across the columns of the table. 
Because the term is an annual period, but you want to know the monthly loan 
payment, you need to convert the yearly periods to monthly periods by 
multiplying the value in cell B4 by 12.

12. Click the PV text box, click A7 to insert this cell reference in this text box, 
and then press F4 three times to convert the relative reference A7 to the 
mixed reference $A7 (column absolute, row relative).

You need to convert the relative cell reference A7 to the mixed reference $A7 
so that Excel won’t adjust the column letter when you copy the PMT formula 
across each column of the table, but adjusts the row number when you copy 
the formula down across its rows.

13. Click OK to insert the formula =PMT(B$6 / 12, $B$4 * 12, $A7) in cell B7.

Now you’re ready to copy this original PMT formula down and then over to fill 
in the entire Loan Payments table.
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14. Drag the Fill handle on cell B7 down until you extend the fill range to cell 
B16 and then release the mouse button.

After you’ve copied the original PMT formula down to cell B16, you’re ready to 
copy it to the right to G16.

15. Drag the Fill handle to the right until you extend the fill range B7:B16 to 
cell G16 and then release the mouse button.

After copying the original formula with the Fill handle, be sure to widen columns 
B through G sufficiently to display their results. (You can do this in one step by 
dragging through the headers of these columns and then double-clicking the right 
border of column G.)

After you’ve created a loan table like this, you can then change the beginning 
principal or interest rate, as well as the term to see what the payments would be 
under various other scenarios. You can also turn on manual recalculation so that 
you can control when the Loan Payments table is recalculated.

For information on how to switch to manual recalculation and use this mode to 
control when formulas are recalculated, see Book 3, Chapter 1. For information 
on how to protect the worksheet so that users can input new values only into the 
three input cells (B2, B3, and B4) to change the starting loan amount, interest 
rate, and the term of the loan, see Book 4, Chapter 1.

Depreciation Functions
Excel offers several depreciation functions, each of which uses a slightly different 
method for depreciating an asset over time. You can find these built-in deprecia-
tion functions on the Ribbon’s Formulas tab, in the Financial button’s drop-down 
menu. Here are the four most commonly used depreciation functions:

 » SLN(cost, salvage, life): Calculates straight-line depreciation

 » SYD(cost, salvage, life, per): Calculates sum-of-years-digits depreciation

 » DB(cost, salvage, life, period, [month]): Calculates declining balance depreciation

 » DDB(cost, salvage, life, period, [factor]): Calculates double-declining balance 
depreciation
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As you can see, with the exception of the optional month argument in the DB func-
tion and the optional factor argument in the DDB function, all the depreciation 
functions require the cost, salvage, and life arguments, and all but the SLN function 
require a period argument as well:

 » Cost is the initial cost of the asset that you’re depreciating.

 » Salvage is the value of the asset at the end of the depreciation (also known as 
the salvage value of the asset).

 » Life is the number of periods over which the asset is depreciating (also known 
as the useful life of the asset).

 » Per or period is the period over which the asset is being depreciated. The units 
that you use in the period argument must be the same as those used in the life 
argument of the depreciation function so that if you express the life argument 
in years, you must also express the period argument in years.

Note that the DB function accepts an optional month argument. This argument 
is the number of months that the asset is in use in the first year. If you omit the 
month argument from your DB function, Excel assumes the number of months of 
service to be 12.

When using the DDB function to calculate the double-declining balance method 
of depreciation, you can add an optional factor argument. This argument is the 
rate at which the balance declines in the depreciation schedule. If you omit this 
optional factor argument, Excel assumes the rate to be 2 (thus, the name double-
declining balance).

Figure  4-4 (sample workbook: Depreciation Table.xslx) contains a Deprecia-
tion table that uses all four depreciation methods to calculate the depreciation of 
office furniture originally costing $50,000 to be depreciated over a 10-year period, 
assuming a salvage value of $1,000 at the end of this depreciation period.

The Formula bar shown in Figure 4-4 shows the SLN formula that I entered into 
cell B8:

=B7 - SLN($C$3, $C$5, $C$4)
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This formula subtracts the amount of straight-line depreciation to be taken in 
the first year of service from the original cost of $50,000. (This value is brought 
forward from cell C3 by the formula =C3.) After creating this original formula in 
cell B8, I then used the Fill handle to copy it down to cell B17, which contains the 
final salvage value of the asset in the 10th year of service.

Cell C8 contains a similar formula for calculating the sum-of-years-digits depre-
ciation for the office furniture. This cell contains the following formula:

=C7 - SYD($C$3, $C$5, $C$4, $A8)

This formula subtracts the amount of sum-of-years-digits depreciation to be 
taken at the end of the first year from the original cost of $50,000 in cell C7 (also 
brought forward from cell C3 by the formula =C3). After creating this original for-
mula in cell C8, I again used the Fill handle to copy it down to cell C17, which also 
contains the final salvage value of the asset in the 10th year of service.

I used the same basic procedure to create the formulas using the DB and DDB 
depreciation methods in the cell ranges D8:D17 and E8:E17, respectively. Cell D8 
contains the following DB formula:

=D7 - DB($C$3, $C$5, $C$4, $A8)

FIGURE 4-4:  
A  Depreciation 
table  showing 

10-year 
 depreciation of 
an asset using 

various  methods. 
(Sample 

 workbook: 
 Depreciation 

Table.xslx)
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Cell E8 contains the following DDB formula:

=E7 - DDB($C$3, $C$5, $C$4, $A8)

Note that, like the SYD function, both of these depreciation functions require the 
use of a period argument, which is supplied by the list of years in the cell range 
A8:A17. Note also that the value in cell C4, which supplies the life argument to the 
SYD, DB, and DDB functions, matches the year units used in this cell range.

Excel’s Advanced Financial Functions
The financial functions discussed so far in this chapter are the ones you use for 
most of your money-related worksheet models. However, Excel is loaded with 
tons of more advanced financial functions that can perform some powerful and 
useful tasks. Table 4-1 lists Excel’s advanced financial functions which, as you can 
see from this table, are varied and quite sophisticated.

You may note in Table  4-1 that many of these financial functions include an 
optional basis argument. The basis argument is a number between 0 and 4 that 
determines the day count basis to use in determining the fractional part of the 
year:

 » 0 (or omitted): Bases the fraction on the U.S. (NASD) method of 30/360 (see 
the coverage on the DAYS360 function in Book 3, Chapter 3 for details on the 
U.S. method)

 » 1: Bases the fraction on actual days/actual days

 » 2: Bases the fraction on actual days/360

 » 3: Bases the fraction on actual days/365

 » 4: Bases the fraction on the European method of 30/360 (see the DAYS360 
coverage in Book 3, Chapter 3 for details on the European method)

For detailed information on the other required arguments for the advanced finan-
cial functions shown in this table, select the function from the Financial button’s 
drop-down list and then click the Help on This Function link in the lower-left 
corner of its Function Arguments dialog box.
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TABLE 4-1 Excel’s Advanced Financial Functions
Function What It Calculates

ACCRINT(issue, first_interest, settlement, 
rate, par, frequency, [basis], [calc_method])

The accrued interest for a security that pays periodic interest.

ACCRINTM(issue, settlement, 
rate,par, [basis])

The accrued interest for a security that pays interest at maturity.

AMORDEGRC(cost, date_purchased, first_
period, salvage, period, rate, [basis]) and

AMORLINC(cost, date_purchased, first_
period, salvage, period, rate, [basis])

Used in French accounting systems for calculating depreciation. 
AMORDEGRC and AMORLINC return the depreciation for each 
accounting period. AMORDEGRC works like AMORLINC except 
that it applies a depreciation coefficient in the calculation that 
depends upon the life of the assets.

COUPDAYBS(settlement, maturity, 
frequency, [basis])

The number of days from the beginning of a coupon period to 
the settlement date.

COUPDAYS(settlement, maturity, 
frequency, [basis])

The number of days in the coupon period.

COUPDAYSNC(settlement, maturity, 
frequency, [basis])

The number of days from the settlement date to the next 
coupon date.

COUPNCD(settlement, maturity, 
frequency, [basis])

A number that represents the next coupon date after a 
settlement date.

COUPNUM(settlement, maturity, 
frequency, [basis])

The number of coupons payable between the settlement date 
and maturity date, rounded up to the nearest whole coupon.

COUPPCD(settlement, maturity, 
frequency, [basis])

A number that represents the previous coupon date before the 
settlement date.

CUMIPMT(rate, nper, pv, start_period, 
end_period, type)

The cumulative interest paid on a loan between the start_period 
and end_period. The type argument is 0 when the payment 
is made at the end of the period and 1 when it’s made at the 
beginning of the period.

CUMPRINC(rate, nper, pv, start_period, 
end_period, type)

The cumulative principal paid on a loan between the start_
period and end_period. The type argument is 0 when the 
payment is made at the end of the period and 1 when it’s made 
at the beginning of the period.

DISC(settlement, maturity, pr, 
redemption, [basis])

The discount rate for a security.

DOLLARDE(fractional_dollar, fraction) Converts a dollar price expressed as a fraction into a dollar price 
expressed as a decimal number.

DOLLARFR(decimal_dollar, fraction) Converts a dollar price expressed as a decimal number into a 
dollar price expressed as a fraction.

(continued)
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Function What It Calculates

DURATION(settlement, maturity, coupon, 
yld, frequency, [basis])

The Macauley duration for an assumed par value of $100. 
(Duration is defined as the weighted average of the present 
value of the cash flows and is used as a measure of the 
response of a bond price to changes in yield.)

EFFECT(nominal_rate, npery) The effective annual interest rate given the nominal interest rate 
and the number of compounding periods per year.

FVSCHEDULE(principal, schedule) The future value of an initial deposit after applying a series of 
compound interest rates.

INTRATE(settlement, maturity, investment, 
redemption, [basis])

The interest rate for a fully invested security.

IPMT(rate, per, nper, pv, [fv], [type]) The interest payment for the specified period of a loan or 
investment.

IRR(values, [guess]) The internal rate of return for a schedule of cash flows.

ISPMT(rate, per, nper, pv) The interest paid during the specified period of an investment.

MDURATION(settlement, maturity, coupon, 
yld, frequency, [basis])

The modified Macauley duration for a security with an assumed 
part value of $100.

MIRR(values, finance_rate, reinvest_rate) The internal rate of return for a schedule of periodic cash flows 
factoring in the cost of investment and the interest on the 
reinvestment of the cash.

NOMINAL(effect_rate, npery) The nominal annual interest rate given the effective rate and the 
number of compounding periods per year.

ODDFPRICE(settlement, maturity, issue, 
first_coupon, rate, yld, redemption, 
frequency, [basis])

The price per $100 face value of a security having an odd (short 
or long) first period.

ODDFYIELD(settlement, maturity, issue, 
first_coupon, rate, pr, redemption, 
frequency, [basis])

The yield of a security that has an odd (short or long) first period.

ODDLPRICE(settlement, maturity, 
last_interest, rate, yld, redemption, 
frequency, [basis])

The price per $100 face value of a security having an odd (short 
or long) last coupon period.

ODDLYIELD(settlement, maturity, 
last_interest, rate, pr, redemption, 
frequency, [basis])

The yield of a security that has an odd (short or long) last period.

PDURATION(rate, pv, fv) The number of periods that an investment requires to reach the 
specified future value.

PRICE(settlement, maturity, rate, yld, 
redemption, frequency, [basis])

The price per $100 face value of a security that pays 
periodic interest.

TABLE 4-1 (continued)
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Function What It Calculates

PRICEDISC(settlement, maturity, discount, 
redemption, [basis])

The price per $100 face value of a discounted security.

PRICEMAT(settlement, maturity, issue, rate, 
yld, [basis])

The price per $100 face value of a security that pays interest 
at maturity.

RECEIVED(settlement, maturity, investment, 
discount, [basis])

The amount received at maturity for a fully invested security.

RRI(nper, pv, rate) The equivalent interest rate for the growth of an investment.

STOCKHISTORY(stock, start_date, 
[end_date], [interval], [headers], 
[properties1], . . .)

An array of historical quote data for the specified stock over the 
specified date range.

TBILLEQ(settlement, maturity, discount) The bond-equivalent yield for a Treasury bill.

TBILLPRICE(settlement, maturity, discount) The price per $100 face value for a Treasury bill.

TBILLYIELD(settlement, maturity, pr) The yield for a Treasury bill.

VDB(cost, salvage, life, start_period, end_
period, [factor], [no_switch])

The depreciation of an asset for a specified period.

XIRR(values, dates, [guess]) The internal rate of return for a schedule of cash flows that are 
not periodic.

XNPV(rate, values, dates) The net present value for a schedule of cash flows that are 
not periodic.

YIELD(settlement, maturity, rate, pr, 
redemption, frequency, [basis])

The yield on a security that pays periodic interest (used to 
calculate bond yield).

YIELDDISC(settlement, maturity, pr, 
redemption, [basis])

Calculates the annual yield for a discounted security.

YIELDMAT(settlement, maturity, issue, rate, 
pr, [basis])

Calculates the annual yield of a security that pays interest 
at maturity.
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Math and Statistical 
Formulas

This chapter examines two larger categories of Excel functions: Math & Trig 
and Statistical functions. The Math & Trig functions include all the special-
ized trigonometric functions such as those that return the sine, cosine, or 

tangents of various angles and logarithmic functions (for finding the base-10 and 
natural logarithms of a number), along with the more common math functions for 
summing numbers, rounding numbers up or down, raising a number to a certain 
power, and finding the square root of numbers.

The Statistical functions include the more common functions that return the aver-
age, highest, and lowest values in a cell range all the way to the very sophisticated 
and specialized functions that calculate such things as the chi-squared distribu-
tion, binomial distribution probability, frequency, standard deviation, variance, 
and the skewness (great word!) of a distribution in a particular population.

Chapter 5

IN THIS CHAPTER

 » Rounding off numbers

 » Raising numbers to powers and 
finding square roots

 » Conditional summing

 » Using basic statistical functions, such 
as AVERAGE, MIN, and MAX

 » Building formulas that count

 » Using specialized statistical functions
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Math & Trig Functions
You can access the Math & Trig functions either via the Insert Function icon on 
the Formula bar, or via the Ribbon’s Formulas tab by clicking the Math & Trig 
drop-down menu.

The Math & Trig category groups together all the trigonometric functions with 
the more common arithmetic functions. Although the trigonometric functions are 
primarily of use to engineers and scientists, the mathematical functions provide 
you with the ability to manipulate any type of value. The math functions include 
SUM, the most commonly used of all functions; functions such as INT, EVEN, 
ODD, and ROUND, that rounds off the values in your worksheet; functions such as 
PRODUCT, SUMPRODUCT, and SUMSQ that you can use to calculate the products 
of various values in the worksheet; and the SQRT function that you can use to cal-
culate the square root of a value.

Rounding off numbers
You use the ROUND function to round up or down fractional values in the work-
sheet as you might when working with financial worksheets that need to show 
monetary values only to the nearest dollar. Unlike when applying a number format 
to a cell, which affects only the number’s display, the ROUND function actually 
changes the way Excel stores the number in the cell that contains the function. 
ROUND uses the following syntax:

ROUND(number, num_digits)

In this function, the number argument is the value that you want to round off, 
and num_digits is the number of digits to which you want the number rounded. 
If you enter 0 (zero) as the num_digits argument, Excel rounds the number to 
the  nearest integer. If you make the num_digits argument a positive value, Excel 
rounds the number to the specified number of decimal places. If you enter the 
num_digits argument as a negative number, Excel rounds the number to the left 
of the decimal point.

Instead of the ROUND function, you can use the ROUNDUP or ROUNDDOWN 
 function. Both ROUNDUP and ROUNDDOWN take the same number and num_digits 
arguments as the ROUND function. The difference is that the ROUNDUP  function 
always rounds up the value specified by the number argument, whereas the 
ROUNDDOWN function always rounds the value down.
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Figure 5-1 (sample workbook: Round Function Examples.xlsx) illustrates the use 
of the ROUND, ROUNDUP, and ROUNDDOWN functions in rounding off the value 
of the mathematical constant pi (π). In cell A3, I entered the value of this constant 
(with just nine places of nonrepeating fraction displayed when the column is wid-
ened) into this cell, using Excel’s PI function in the following formula:

=PI()

I then used the ROUND, ROUNDUP, and ROUNDDOWN functions in the cell range 
B3 through B10 to round this number up and down to various decimal places.

Cell B3, the first cell that uses one of the ROUND functions to round off the value 
of pi, rounds this value to 3 because I used 0 (zero) as the num_digits argument 
of its ROUND function (causing Excel to round the value to the nearest whole 
number).

In Figure 5-1, note the difference between using the ROUND and ROUNDUP func-
tions both with 2 as their num_digits arguments in cells B5 and B7, respectively. 
In cell B5, Excel rounds the value of pi off to 3.14, whereas in cell B7, the program 
rounds its value up to 3.15. Note that using the ROUNDDOWN function with 2 as its 
num_digits argument yields the same result, 3.14, as does using the ROUND func-
tion with 2 as its second argument.

The whole number and nothing  
but the whole number
You can also use the INT (for Integer) and TRUNC (for Truncate) functions to lop 
off unneeded parts of values in your worksheets. You use these functions only 
when you don’t care about all or part of the fractional portion of the value.

FIGURE 5-1:  
Rounding off 

the value of pi 
with the ROUND, 

ROUNDUP, and 
ROUNDDOWN 

functions.  
(Sample 

workbook: 
Round Function 

Examples.xlsx)
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When you use the INT function, which requires only a single number argument, 
Excel rounds the value down to the nearest integer (whole number). For example, 
cell A3 contains the value of pi, as shown in Figure 5-1, and you enter the follow-
ing INT function formula in the worksheet:

=INT(A3)

Excel returns the value 3 to the cell, the same as when you use 0 (zero) as the 
num_digits argument of the ROUND function in cell B3.

The TRUNC function uses the same number and num_digits arguments as the 
ROUND, ROUNDUP, and ROUNDDOWN functions, except that in the TRUNC func-
tion, the num_digits argument is purely optional. This argument is required in the 
ROUND, ROUNDUP, and ROUNDDOWN functions.

The TRUNC function doesn’t round off the number in question; it truncates the 
number to the nearest integer by removing the fractional part of the number. 
However, if you specify a num_digits argument, Excel uses that value to deter-
mine the precision of the truncation. So, going back to the example illustrated 
in Figure 5-1, if you enter the following TRUNC function, omitting the optional 
num_digits argument as in

=TRUNC($A$3)

Excel returns 3 to the cell just like the formula =ROUND($A$3,0) does in cell B3. 
However, if you modify this TRUNC function by using 2 as its num_digits argu-
ment, as in

=TRUNC($A$3,2)

Excel then returns 3.14 (by cutting the rest of the fraction) just as the formula 
=ROUND($A$3,2) does in cell B5.

The only time you notice a difference between the INT and TRUNC functions is 
when you use them with negative numbers or when you use a negative value for 
the TRUNC function’s num_digits argument. For example, if you use the TRUNC 
function to truncate the value –5.4 in the following formula:

=TRUNC(–5.4)

Excel returns –5 to the cell. If, however, you use the INT function with the same 
negative value, as in

=INT(–5.4)
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Excel returns –6 to the cell. This is because the INT function rounds numbers 
down to the nearest integer using the fractional part of the number.

Similarly, if you use INT with the value 12345.678, as in the following formula:

=INT(12345.678)

Excel returns 12345. However, if you use TRUNC on the same value, but with -2 as 
the num_digits argument, as in the formula:

=TRUNC(12345.678, -2)

Excel returns 12300. In this case, TRUNC “truncates” the first two digits to the left 
of the decimal point by converting them to 0s.

Let’s call it even or odd
Excel’s EVEN and ODD functions also round off numbers. The EVEN function 
rounds the value specified as its number argument up to the nearest even integer. 
The ODD function, of course, does just the opposite: rounding the value up to the 
nearest odd integer. So, for example, if cell C18 in a worksheet contains the value 
345.25 and you use the EVEN function in the following formula:

=EVEN(C18)

Excel rounds the value up to the next whole even number and returns 346 to the 
cell. If, however, you use the ODD function on this cell, as in

=ODD(C18)

Excel rounds the value up to the next odd whole number and returns 347 to the 
cell instead.

Building in a ceiling
The CEILING.MATH function enables you to not only round up a number, but also 
set the multiple of significance to be used when doing the rounding. This func-
tion can be very useful when dealing with figures that need rounding to particular 
units.

For example, suppose that you’re building a worksheet that lists the retail prices 
for the products that you sell, all based upon a particular markup over whole-
sale, and that many of these calculations result in prices with cents below 50. If 
you don’t want to have any prices in the list that aren’t rounded to the nearest  
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50 cents or whole dollar, you can use the CEILING function to round up all these 
calculated retail prices to the nearest half dollar.

The CEILING.MATH function uses the following syntax:

CEILING.MATH(number, [significance], [mode])

The number argument specifies the number you want to round up and the optional 
significance argument specifies the multiple to which you want to round. (By 
default, the significance is +1 for positive numbers and –1 for negative numbers.) 
The optional mode argument comes into play only when dealing with negative 
numbers where the mode value indicates the direction toward (+1) or away (–1) 
from 0.

For the half-dollar example, suppose that you have the calculated number 
$12.35 in cell B3 and you enter the following formula in cell C3:

=CEILING.MATH(B3, 0.5)

Excel then returns $12.50 to cell C3. Further, suppose that cell B4 contains the cal-
culated value $13.67, and you copy this formula down to cell C4 so that it contains

=CEILING.MATH(B4, 0.5)

Excel then returns $14.00 to that cell.

CEILING.MATH replaces the CEILING function supported in older versions of Excel 
(prior to Excel 2019). You can still use the CEILING function to round your values; 
just be aware that this function is no longer available on the Math & Trig drop-
down menu on the FORMULAS tab of the Ribbon or in the Insert Function dialog 
box. To use CEILING, either choose Formulas ➪ More Functions ➪ Compatibility 
➪  CEILING, or type =cei directly into the cell to have the CEILING function appear 
in the function drop-down menu immediately below CEILING.MATH.

POWER and SQRT
Although you can use the caret (^) operator to build a formula that raises a num-
ber to any power, you also need to be aware that Excel includes a math function 
called POWER that accomplishes the same thing. For example, to build a formula 
that raises 5.9 to the third power (that is, cubes the number), you can use the 
exponentiation operator, as in

=5.9 ^ 3
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You can have Excel perform the same calculation with the POWER function by 
entering this formula:

=POWER(5.9, 3)

In either case, Excel returns the same result, 205.379. The only difference between 
using the exponentiation operator and the POWER function occurs on that rare, 
rare occasion when you have to raise a number by a fractional power. In that case, 
you need to use the POWER function instead of the caret (^) operator to get the 
correct result. For example, suppose that you need to raise 20 by the fraction 3/4; 
to do this, you build the following formula with the POWER function:

=POWER(20, 3/4)

To use the exponentiation operator to calculate the result of raising 20 by the 
fraction 3/4, you can convert the fraction into decimal form, as in

=20 ^ 0.75

The SQRT function calculates the square root of any number that you specify as 
its sole number argument. For example, if you use the SQRT function to build the 
following formula in a cell:

=SQRT(144)

Excel returns 12 to that cell.

The SQRT function can’t deal with negative numbers, so if you try to find the 
square root of a negative value, Excel returns a nice #NUM! error value to that cell. 
To avoid such a nuisance, you need to use the ABS (for absolute) math function, 
which returns the absolute value of a number (that is, the number without a sign). 
For example, suppose that cell A15 contains ($49.00), a negative value formatted 
in parentheses with the Accounting Number format to show that it’s something 
you owe, and you want to return the square root of this number in cell A16. To 
avoid the dreaded #NUM! error, you nest the ABS function inside the SQRT func-
tion. The ABS function returns the absolute value of the number you specify as its 
sole argument (that is, the value without its sign). To nest this function inside the 
SQRT function, you create the following formula:

=SQRT(ABS(A15))

Excel then returns 7 instead of #NUM! to cell A16 because the ABS function 
removes the negative sign from the 49.00 before the SQRT function calculates its 
square root. (Remember that Excel always performs the calculations in the inner-
most pair of parentheses first.)



400      BOOK 3  Formulas and Functions

The SUM of the parts
No function in the entire galaxy of Excel functions comes anywhere close to the 
popularity of the SUM function in the worksheets that you build. So popular is 
this function, in fact, that Excel has its own Alt+= shortcut key as well as a Sum 
command button located on the Home tab and on the Formula tab of the Ribbon 
(the one with the Σ on it) that you most often use to build your SUM formulas. 
You should, however, be aware of the workings of the basic SUM function that the 
AutoSum button enables you to use so easily.

For the record, the syntax of the SUM function is as follows:

SUM(number1, [number2], [...])

When using the SUM function, only the number1 argument is required; this is the 
range of numbers in a cell range or array constant that you want added together. 
Be aware that you can enter up to a total of 29 other optional number arguments 
in a single SUM formula. For example, you can build a SUM formula that totals 
numbers in several different ranges, as in

=SUM(B3:B10, Sheet2!B3:B10, Sheet3!B3:B10)

In this example, Excel sums the values in the cell range B3:B10 on Sheet1, Sheet2, 
and Sheet3 of the workbook, giving you the grand total of all these values in what-
ever cell you build this SUM formula.

Conditional summing
The SUM function is perfect when you want to get the totals for all the numbers 
in a particular range or set of ranges. But what about those times when you only 
want the total of certain items within a cell range? For those situations, you can 
use the SUMIF or SUMIFS function.

The SUMIF function enables you to tell Excel to add together the numbers in a 
particular range only when those numbers meet the criteria that you specify. The 
syntax of the SUMIF function is as follows:

SUMIF(range, criteria, [sum_range])

In the SUMIF function, the range argument specifies the range of cells that you 
want Excel to evaluate when doing the summing; the criteria argument specifies 
the criteria to be used in evaluating whether to include certain values in the range 
in the summing; and finally, the optional sum_range argument is the range of all 
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the cells to be summed. If you omit the sum_range argument, Excel sums the cells 
specified in the range argument if they meet the criteria specified in the criteria 
argument.

The SUMIFS function works like SUMIF function except that it enables you to 
specify more than one criteria range that controls when a certain range of values 
are summed. Its syntax is a little bit different:

SUMIFS(sum_range, criteria_range, criteria, ...)

For this function, the sum_range argument specifies all the possible values that 
can be summed, the criteria_range specifies the cells with all the entries that are 
to be evaluated by the if criteria, and the criteria argument contains the expression 
that is to be applied to the entries in the criteria_range to determine which of the 
values to total in the sum_range.

Summing certain cells with SUMIF
Figure 5-2 (sample workbook: Chris Cookies - January Sales.xlsx) illustrates how 
you can use the SUMIF function to total sales by the items sold. This figure shows 
a Sales data list sorted by the store location and then the item sold. In this Daily 
Sales data list, there are three locations: Mission Street, Anderson Rd., and Curtis 
Way, of which only sales made at the Anderson Rd. location are visible in this 
figure.

FIGURE 5-2:  
Using SUMIF 
to total sales 

by items 
sold. (Sample 

 workbook: Chris 
Cookies - January 

Sales.xlsx)
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To total the sales of Lemon tarts at all three locations in this data list, I created the 
following SUMIF formula in cell I3:

=SUMIF(item_sold, "=Lemon tarts", daily_sales)

In this example, item_sold is the range name given to the cell range C3:C62, 
which contains the list of each item that has been sold in the first five days of 
January, 2022 (Lemon tarts, Blueberry muffins, Lots of chips cookies, or Straw-
berry pie), and daily_sales is the range name assigned to the cell range G3:G62, 
which contains the extended sales made at each store for each item.

The SUMIF formula in cell I3 then looks for each occurrence of “Lemon tarts” in 
the item_sold range (the criteria argument for the SUMIF function) in the Item 
column of the Cookie Sales list and then adds its extended sales price from the 
daily_sales range in the Daily Sales column to the total.

The formulas in cells I4, I5, and I6 contain SUMIF functions very similar to the 
one in cell I3, except that they substitute the name of the dessert goodie in ques-
tion in place of the =Lemon tarts criteria argument.

Summing on multiple criteria with SUMIFS
Figure 5-3 (sample workbook: Chris Cookies - January Sales.xlsx) illustrates the 
use of the SUMIFS function to apply multiple criteria in the summing of the daily 
sales. Here, I want to know the total of the sales of one item (Lemon tarts) at one 
store location (Anderson Rd.).

To do this, I created the following formula in cell I8, using the SUMIFS function:

=SUMIFS(daily_sales, item_sold, "Lemon tarts", store,  
"Anderson Rd.")

In this formula, the sum_range argument (specified first and not last as in SUMIF) 
is still the daily_sales cell range (G3:G62). The first criteria_range argument is 
item_sold (C3:C62) where the criteria is “Lemon tarts,” and the second crite-
ria_range argument is store (B3:B62) where the criteria is “Anderson Rd.” When 
Excel evaluates the formula in cell I8, it applies both criteria so that the program 
ends up totaling only those daily sales where the item is Lemon tarts and the store 
location is Anderson Rd.
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The formula in cell I9 immediately below in the worksheet shown in Figure 5-3 
also uses the SUMIFS function, but this time applies just a single criteria in per-
forming the summation. This formula sums the daily sales for any bakery item 
that is not a Strawberry pie:

=SUMIFS(daily_sales, item_sold, "<>Strawberry pie")

Because I prefaced the item Strawberry pie with the not (<>) operator (which can 
be placed before or after the open double quotation mark), Excel sums the sale of 
every item except for Strawberry pie.

Statistical Functions
Excel includes one of the most complete sets of statistical functions available out-
side of a dedicated statistics software program. When you want to access these 
functions from the Ribbon’s Formulas tab instead of using the Insert Function 
dialog box, you need to click the More Functions command button and then click 
Statistical in the drop-down menu (or press Alt+MQS).

The statistical functions run the gamut from the more mundane AVERAGE, MAX, 
and MIN functions to the more exotic and much more specialized CHITEST, 
POISSON, and PERCENTILE statistical functions.

FIGURE 5-3:  
Using SUMIFS 

to total sales by 
location as well 

as the items 
sold. (Sample 

workbook: Chris 
Cookies - January 

Sales.xlsx)
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In addition to the more specialized statistical functions, Excel offers an assort-
ment of counting functions that enable you to count the number of cells that con-
tain values, count the number that are nonblank (and thus contain entries of any 
kind), or count the cells in a given range that meet the criteria that you specify.

AVERAGE, MAX, MIN, and MEDIAN
The AVERAGE, MAX (for maximum), MIN (for minimum), and MEDIAN functions 
are the most commonly employed of the statistical functions because they are of 
use to both the average number cruncher as well as the dedicated statistician. All 
three functions follow the same syntax as the good old SUM function. For exam-
ple, the syntax of the AVERAGE function uses the following arguments just as the 
SUM, MAX, and MIN functions do:

AVERAGE(number1, [number2], [...])

Just as in the SUM function, the number arguments are between 1 and 30 numeric 
arguments for which you want the average. Figure  5-4 (sample workbook: 
Paradise Estates - Apr-May Sales.xlsx) illustrates how you can use the AVERAGE, 
MAX, MIN, and MEDIAN functions in a worksheet. This example uses these func-
tions to compute a few statistics on the selling prices of homes in a particular 
neighborhood. These statistics include the average, highest, lowest, and median 
selling price for the homes sold in April and May. All the statistical functions 
in this worksheet use the same number argument; that is, the cell range named 
home_prices in C3:C7.

The AVERAGE function computes the arithmetic mean of the values in this range 
by summing them and then dividing them by the number of values in the range.

FIGURE 5-4:  
Home sales 

 worksheet 
using  common 

 statistical 
 functions. 

 (Sample 
 workbook: 

 Paradise  
Estates - Apr-May  

Sales.xlsx)
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The MAX and MIN functions compute the highest and lowest values in the cell 
range used as the number argument. The MEDIAN function computes the value 
that is in the middle of the range of values; that is, the one where half the values 
are greater and half are less. This is the reason that the median sales price (in cell 
C13) differs from the average sales price (in cell C10) in this worksheet.

Counting cells
Sometimes you need to know how many cells in a particular cell range, column 
or row, or even worksheet in your workbook have cell entries and how many are 
still blank. Other times, you need to know just how many of the occupied cells 
have text entries and how many have numeric entries. Excel includes a number of 
counting functions that you can use in building formulas that calculate the num-
ber of cells in a particular region or worksheet that are occupied and can tell you 
what general type of entry they contain.

Building counting formulas
Figure  5-5 (sample workbook: Paradise Estates - Apr-May Sales Count.xlsx) 
illustrates the different types of counting formulas that you can build to return 
such basic statistics as the total number of cells in a particular range, the number 
of occupied cells in that range, as well as the number of numeric and text entries 
in the occupied range. In this example worksheet, I gave the name sales_table to 
the cell range A1:C8 (shown selected in Figure 5-5).

I then used the sales_table range name in a number of formulas that count its 
different aspects. The most basic formula is the one that returns the total number 
of cells in the sales_table range. To build this formula in cell C10, I used the ROWS 

FIGURE 5-5:  
A version of 

the home sales 
worksheet with 

various  counting 
 formulas. 

 (Sample 
 workbook: 

 Paradise  
Estates - Apr-May 
Sales Count.xlsx)
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and COLUMNS information functions (see Book 3, Chapter 6 for more on these 
types of functions) to return the number of rows and columns in the range, and 
then I created the following formula that multiplies these two values together:

=ROWS(sales_table) * COLUMNS(sales_table)

This formula, of course, returns 24 to cell C10. In the next formula, I calculated 
the number of these 24 cells that contain data entries (of whatever type) using the 
COUNTA function. This function counts the number of cells that are not empty 
in the ranges that you specify. The COUNTA function uses the following syntax:

COUNTA(value1, [value2], [...])

The value arguments (all of which are optional except for value1) are up to 30 dif-
ferent values or cell ranges that you want counted. Note that the COUNTA function 
counts a cell as long it has some entry, even if the entry is empty text set off by 
a single apostrophe (’). In the example shown in Figure 5-5, cell C11 contains the 
following COUNTA function:

=COUNTA(sales_table)

This formula returns 20 to cell C11. The next formula in the sample worksheet cal-
culates the number of numeric entries in the cell range called sales_table. To do 
this, you use the COUNT function. The COUNT function takes the same arguments 
as COUNTA, the only difference being that COUNT counts a value or cell specified 
in its value arguments only if it contains a numeric entry.

Cell C12 contains the following formula for calculating the number of numeric 
entries in the Home Sales table range called sales_table:

=COUNT(sales_table)

Excel returns 11 to cell C12. Note that in calculating this result, Excel counts the 
five date entries (with the date of each sale) in the cell range B3:B7 as well as 
the six numeric data entries (with the selling prices of each home plus total) in the 
cell range C3:C8.

The next formula in the sample worksheet shown in Figure 5-5 uses the COUNT-
BLANK function to calculate the number of blank cells in the sales_table range. 
The COUNTBLANK function works just like the COUNTA and COUNT functions 
except that it returns the number of nonoccupied cells in the range. For this 
example, I entered the following COUNTBLANK function in cell C13:

=COUNTBLANK(sales_table)
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Excel then returns 4 to cell C13 (which makes sense because you know that of the 
24 total cells in this range, Excel already said that 20 of them have entries of some 
kind).

The last two counting formulas in the sample worksheet shown in Figure  5-5 
return the number of text and nontext entries in the sales_table cell range. To do 
this, instead of counting functions, they use the ISTEXT and ISNONTEXT infor-
mation functions as part of the IF conditions used in conjunction with the good 
old SUM function.

The first formula for returning the number of text entries in the sales_table range 
in cell C14 is

{=SUM(IF(ISTEXT(sales_table), 1, 0))}

The second formula for returning the number of nontext entries in the sales_table 
range in cell C15 is just like the one in cell C15 except that it uses the ISNONTEXT 
function instead of ISTEXT, as follows:

{=SUM(IF(ISNONTEXT(sales_table), 1, 0))}

The ISTEXT function in the formula in cell C14 returns logical TRUE when a cell 
in the sales_table range contains a text entry and FALSE when it does not. The 
ISNONTEXT function in the formula in cell C15 returns logical TRUE when a cell is 
blank or contains a numeric entry (in other words, anything but text) and FALSE 
when it contains text.

In both these formulas, the ISTEXT and ISNONTEXT functions are used as the 
logical_test arguments of an IF function with 1 as the value_if_true argument and 0 
as the value_if_false argument (so that the cells are counted only when the ISTEXT 
or ISNONTEXT functions return the logical TRUE values). These IF functions are 
then nested within SUM functions, and these SUM functions, in turn, are entered 
as array formulas.

Counting occupied cells in entire rows,  
columns, and worksheets
You can use the COUNTA function to count the number of occupied cells in an 
entire row or column of a worksheet or even an entire worksheet in your work-
book. For example, to count all the occupied cells in row 17 of a worksheet, you 
enter the following COUNTA formula:

=COUNTA(17:17)
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If you want to find the number of nonblank cells in column B of the worksheet, 
you enter the following COUNTA formula:

=COUNTA(B:B)

To find out the number of occupied cells in the entire second worksheet of your 
workbook (assuming that it’s still called Sheet2), you enter this COUNTA formula:

=COUNTA(Sheet2!1:1048576)

Note that you can also enter the argument for this COUNTA function by designat-
ing the entire range of column letters (rather than the range of row numbers) 
as in:

=COUNTA(Sheet2!A:XFD)

However, Excel automatically converts the argument that specifies the range of 
columns to rows, using absolute references ($1:$1048576) as soon as you enter 
the COUNTA function in its cell.

When entering COUNTA functions that return the number of occupied cells in an 
entire row, column, or worksheet, you must be sure that you do not enter the for-
mula in a cell within that row, column, or worksheet. If you do, Excel displays a 
Circular Reference Alert dialog box when you try to enter the formula in the work-
sheet. This happens because you are asking Excel to use the cell with the formula 
that does the counting in the count itself (definitely the type of circular logic that 
the program doesn’t allow).

Conditional counting
Excel includes a COUNTIF function that you can use to count cells in a range only 
when they meet a certain condition. The COUNTIF function takes two arguments 
and uses the following syntax:

COUNTIF(range, criteria)

The range argument specifies the range of cells from which the conditional count 
is to be calculated. The criteria argument specifies the condition to use. You can 
express this argument as a number, expression, or text that indicates which cells 
to count. When specifying a number for the criteria argument, you don’t have to 
enclose the number in quotes. For example, in a cell range named table_data, to 
count the number of entries that contain the number 5, you enter the following 
COUNTIF formula:

=COUNTIF(table_data, 5)
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However, when specifying an expression or text as the criteria argument, you must 
enclose the expression or text in closed quotes as in “=5”, “>20”, or “New York”. 
So, if you want to use COUNTIF to find out how many cells in the table_data range 
have values greater than 5, you enter this version of the COUNTIF function:

=COUNTIF(table_data, ">5")

When you want to use the COUNTIF function to find out the number of cells whose 
contents are equal to the contents of a particular cell in the worksheet, you just 
add the cell reference as the function’s criteria argument. For example, if you want 
to count the number of cells in the table_data range that are equal to the contents 
of cell B3 in the worksheet, you enter this formula:

=COUNTIF(table_data, B3)

However, when you want to specify an expression other than equality that refers 
to the contents of a cell in the worksheet, you must enclose the operator in a pair 
of double quotation marks and then add the ampersand (&) concatenation opera-
tor before the cell reference. For example, if you want to count how many cells in 
the table_data range have a value greater than the contents of cell B3, you enter 
this form of the COUNTIF function:

=COUNTIF(table_data, ">" & B3)

Note that when specifying text as the condition, you can use the two wildcard 
characters: the asterisk (*) to represent an unspecified number of characters and 
the question mark (?) to represent single characters in the COUNTIF function’s 
criteria argument. For example, to count all the cells in the table_data range 
whose text entries end with the word Street, you use the asterisk in the COUNTIF 
criteria argument as follows:

=COUNTIF(table_data, "*Street")

To count the cells in the table_data range whose text entries contain the word 
discount anywhere in the entry, you sandwich discount between two asterisks in 
the COUNTIF criteria argument as follows:

=COUNTIF(table_data, "*discount*")

To count the cells in the table_data range whose cell entries consist of any two 
characters followed by the letter y (as in day, say, pay, and so on), you use two 
question marks to stand in for the nonspecific characters followed by a y in the 
COUNTIF criteria argument, as in

=COUNTIF(table_data, "??y")
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When using the COUNTIF function to find the number of cells, you can include 
other statistical functions as the criteria argument. For example, suppose that you 
want to know the number of cells in the table_data range whose values are less 
than the average value in the range. To do this, you insert the AVERAGE function 
in the COUNTIF criteria argument as follows:

=COUNTIF(table_data, "<" & AVERAGE(table_data))

Using specialized statistical functions
You can use the built-in statistical functions found on the Statistical continuation 
menu or located in the Statistical category in the Insert Function dialog box, both 
of which I discuss earlier in this chapter. Excel also offers a complete set of special 
analysis tools as part of the Analysis ToolPak add-in.

The tools included in the Analysis ToolPak enable you to analyze worksheet data 
by using such things as ANOVA, F-test, rank and percentile, t-test, and Fourier 
Analysis.

If you want to dive deep into these and other statistical functions, get yourself a 
copy of Statistical Analysis with Excel For Dummies, 5th Edition by Joseph Schmuller, 
PhD, which covers the statistical functions in exquisite detail.

To load these tool packs so that you can use their functions, you need to open 
the Add-Ins dialog box by choosing File ➪ Options ➪ Add-Ins and then clicking the 
Go button at the bottom of the Excel Options dialog box (make sure that Excel  
Add-ins is displayed in the Manage drop-down list box before you click Go). In 
the Add-Ins dialog box, select the Analysis ToolPak check box and then click OK.

In the Data tab’s Analysis group, click the Data Analysis button (or press Alt+AY2). 
Excel opens the Data Analysis dialog box, as shown in Figure 5-6.

FIGURE 5-6:  
Selecting a 

 statistical analysis 
tool added by the 
Analysis ToolPak.
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Lookup, Information, 
and Text Formulas

This chapter covers three categories of Excel functions: the lookup and ref-
erence functions that return values and cell addresses from the worksheet; 
the information functions that return particular types of information about 

cells in the worksheet; and the text functions that enable you to manipulate 
strings of text in the worksheet.

In these three different categories of Excel functions, perhaps none are as handy 
as the lookup functions that enable you to have Excel look up certain data in 
a range and then return other related data from that same range based on the 
parameters of that lookup.

Chapter 6

IN THIS CHAPTER

 » Looking up data in a table and adding 
it to a list

 » Transposing vertical cell ranges to 
horizontal and vice versa

 » Getting information about a cell’s 
contents

 » Evaluating a cell’s type with the IS 
information functions

 » Using text functions to manipulate 
text entries

 » Creating formulas that combine text 
entries
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Looking Up Stuff with the  
Lookup Functions

Excel’s lookup function enables you to perform range lookups that either return 
information about entries in the range or actually return related data to other 
ranges in the worksheet. By using lookup tables to input information into a range, 
you not only reduce the amount of data input that you have to do, but also elimi-
nate the possibility of data entry errors. Using lookup tables also makes it a snap 
to update your data: All you have to do is make the edits to the entries in the 
original lookup table or schedule to have all their data entries in the list updated 
as well.

You can access the Lookup functions either via the Insert Function icon on the 
Formula bar, or via the Ribbon’s Formulas tab by clicking the Lookup & Refer-
ence drop-down menu. The next few sections take you through the most common 
Lookup functions.

Modern lookups with XLOOKUP
In early February 2020, Microsoft released an Excel update for Microsoft 365 sub-
scribers on Windows and Mac. That update included support for the XLOOKUP 
function, which Microsoft touted as a simpler and more versatile replacement for 
the very popular (yet oft maligned) lookup function VLOOKUP (and its horizontal 
cousin, HLOOKUP).

For those of you not yet familiar with VLOOKUP (deemed the third most-used 
function right after SUM and AVERAGE), this function searches vertically by row 
in the leftmost column of a lookup table from top to bottom until it finds a value 
in a lookup column specified by an offset number that matches or exceeds the one 
you’re looking up. Although tremendously useful for locating particular items in a 
long list or column of a range in your worksheet, the VLOOKUP function has sev-
eral limitations. Here’s how XLOOKUP improves upon those limitations:

 » XLOOKUP defaults to finding exact matches for your lookup value in the 
lookup range.

 » XLOOKUP can search both vertically (by row) and horizontally (by column) in a 
table, thereby replacing the need for using the HLOOKUP function when 
searching horizontally by column.

 » XLOOKUP can search left or right so that the lookup range in your lookup 
table does not have to be located in a column to the left of the one designated 
as the return range in order for the function to work.
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 » When the exact match default is used, XLOOKUP works even when values in 
the lookup range are not sorted in a particular order.

 » XLOOKUP can search from the bottom row to the top in the lookup array 
range, using an optional search mode argument.

The XLOOKUP function has six arguments, the first three of which are required 
and the last three optional, using the following syntax:

XLOO KUP(lookup_value, lookup_array, return_array,  
[if_not_found], [match_mode], [search_mode])

The lookup_value argument designates the value for which you’re searching; the 
look_up array argument designates the range of cells to be searched for this lookup 
value; and the return_array argument designates the range of cells containing the 
value you want returned when Excel finds an exact match.

When designating the lookup_array and return_array arguments in your XLOOKUP 
function, both ranges must be of equal length, otherwise Excel returns the 
#VALUE! error to your formula. This is all the more reason for you to use range 
names or table column names when defining these arguments rather than point-
ing to them or typing their cell references.

The optional if_not_found argument specifies a text string to return to the formula 
if XLOOKUP fails to locate a matching value in the lookup_array.

The optional match_mode argument can contain any of the following four values:

 » 0 for an exact match (the default, same as when no match_mode argument is 
designated)

 » -1 for exact match or next lesser value

 » 1 for exact match or next greater value

 » 2 for partial match using wildcard characters: ? to match a single character 
and * to match any number of characters. To search for either a question 
mark or asterisk, precede the character with a tilde: ~? or ~*.

The optional search_mode argument can contain any of the following four values:

 » 1 to search first-to-last, that is, from top to bottom (the default, same as when 
no search_mode argument is designated)

 » -1 to search last-to-first, that is, bottom to top
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 » 2 for a binary search in ascending order

 » -2 for binary search in descending order

The best way to understand the power and versatility of the XLOOKUP func-
tion is to see it in action in an Excel worksheet. In Figure 6-1 (sample workbook: 
Customer Sales by Country - Lookups.xslx), I have a worksheet with sales data 
arranged by country. To use XLOOKUP to return the total sales from this range in 
cell F4 based on the country you enter in cell E4 of the worksheet, you take these 
steps:

1. Position the cell cursor in cell F4 of the worksheet.

2. On the Formulas tab, click Lookup & Reference and then click XLOOKUP.

Excel displays the Function Arguments dialog box.

3. Click in the Lookup_value argument text box and then click cell E4.

4. Click in the Lookup_array argument text box, then select the range A4:A8.

A4:A8 is the range that XLOOKUP searches for whatever value you enter into 
cell E4.

5. Click in the Return_array argument text box, and then select the range 
B4:B8.

B4:B8 is the range that that XLOOKUP uses to select the return value based on 
the results of the search.

6. Click OK to enter the following XLOOKUP formula in cell F4:

=XLOOKUP(E4, A4:A8, B4:B8)

FIGURE 6-1:  
The XLOOKUP 
formula in cell 

F4 returns sales 
based on the 

country entered 
in cell E4. (Sample 

workbook: 
 Customer Sales 

by Country -  
Lookups.xslx)
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In Figure 6-1, with Costa Rica entered into the lookup cell E4, XLOOKUP returns 
4900 as the result because, as you can see in the sales table, this is indeed the total 
sales made for that country.

Because XLOOKUP works right-to-left just as well as left-to-right, you can use 
this function to return the country from this sales table based on a particular sales 
figure. Figure 6-2 (sample workbook: Customer Sales by Country - Lookups.xslx) 
shows you how you do this. This time, you create the XLOOKUP formula in cell F4 
and designate the value entered in cell E4 (11,000, in this case) as the lookup_value 
argument.

In addition, you enter -1 as the match_mode argument to override the function’s 
exact match default so that Excel returns the country with an exact match to the 
sales value entered in the lookup cell E4 or the one with the next lower total 
sales (Mexico with $10,000 in this case as there is no country in this table with 
$11,000 of total sales). Without designating a match_mode argument for this for-
mula, Excel would return #NA as the result, because there’s no exact match to 
$11,000 in this sales table.

Because the XLOOKUP function is equally comfortable searching horizontally by 
column as it is searching vertically by row, you can use it to create a formula that 
performs a two-way lookup (replacing the need to create a formula that combines 
the INDEX and MATCH functions as in the past). Figure 6-3 (sample workbook: 
Production Schedule XLOOKUP.xlsx), containing the production schedule table for 
part numbers, AB-100 through AB-103 for the months April through December, 
shows you how this is done.

FIGURE 6-2:  
The XLOOKUP 
formula in cell 
F4 returns the 

country based on 
the sales entered 

in cell E4. (Sample 
 workbook: 

 Customer Sales 
by Country -  

Lookups.xslx)
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In cell B12, I created the following formula:

=XLOOKUP(B10, A3:A6, XLOOKUP(B11, B2:J2, B3:J6))

The outer XLOOKUP function takes whatever part number is entered in cell B10 
and searches vertically for an exact match in the range A3:A6 of the production 
table. Note that the return_array argument for this outer XLOOKUP function is 
itself a second XLOOKUP function.

This second, nested XLOOKUP function takes whatever date is entered in cell B11 
and searches horizontally for an exact match in the range B2:J2. The return_array 
argument for this nested XLOOKUP function is B3:J6, the range of all production 
values in the table.

The way this formula works is that Excel first calculates the result of the second, 
nested XLOOKUP function by performing a horizontal search that, in this case, 
returns the array in cell range D3:D6 of the Jun-22 column (with the values: 546, 
150, 321, and 959) as its result. This result, in turn, becomes the return_array 
argument for the outer XLOOKUP function that performs a vertical search by row 
for an exact match to the part number entry made in cell B10. Because, in this 
example, B10 contains AB-102, the formula returns just the Jun-22 production 
value for that part, 321, from the result of the nested XLOOKUP function.

There you have it! XLOOKUP is a powerful, versatile, and fairly easy-to-use 
lookup function that can not only do the single-value lookups performed by the 
VLOOKUP and HLOOKUP functions but also the two-way value lookups performed 
by combining the INDEX and MATCH functions as well (all of which I discuss in 
the sections that follow).

FIGURE 6-3:  
A formula with 

nested XLOOKUP 
 functions to 

return the 
 number of 

units produced 
for a part in 
a  particular 

month. (Sample 
 workbook: 
 Production 

Schedule 
XLOOKUP.xlsx)
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Unfortunately, the XLOOKUP function is not backward compatible with earlier 
versions of Microsoft Excel that only support the VLOOKUP and HLOOKUP func-
tions. This means that if you share a workbook containing XLOOKUP formulas 
with co-workers or clients who are using a version of Excel that doesn’t support 
this new lookup function, all these formulas will return #NAME? error values 
when they open its worksheet.

Old-fashioned lookups with VLOOKUP  
and HLOOKUP
For the sake of completeness and to enable you to perform lookups in versions of 
Excel that don’t support XLOOKUP, this section and the next take you through the 
old way of doing lookups in Excel: VLOOKUP and HLOOKUP in this section; INDEX 
and MATCH in the next section. Remember, however, that if you have a version of 
Excel that supports XLOOKUP and your worksheets will never be used by anyone 
with a version of Excel that is XLOOKUP-ignorant, then you can safely and smil-
ingly skip these two sections.

The most popular of the lookup functions are HLOOKUP (for Horizontal Lookup) 
and VLOOKUP (for Vertical Lookup) functions. These functions are located on the 
Lookup & Reference drop-down menu on the Formulas tab of the Ribbon (Alt+MO) 
as well as in the Lookup & Reference category in the Insert Function dialog box. 
They are part of a powerful group of functions that can return values by looking 
them up in data tables.

The VLOOKUP function searches vertically (from top to bottom) the leftmost col-
umn of a lookup table until the program locates a value that matches or exceeds 
the one you are looking up. The HLOOKUP function searches horizontally (from 
left to right) the topmost row of a lookup table until it locates a value that matches 
or exceeds the one that you’re looking up.

The VLOOKUP function uses the following syntax:

VLOO KUP(lookup_value, table_array, col_index_num, 
[range_lookup])

The HLOOKUP function follows the nearly identical syntax:

HLOO KUP(lookup_value, table_array, row_index_num, 
[range_lookup])

In both functions, the lookup_value argument is the value that you want to look up 
in the lookup table, and table_array is the cell range or name of the lookup table 
that contains both the value to look up and the related value to return.
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The col_index_num argument designates the column of the lookup table contain-
ing the values that are returned by the VLOOKUP function based on matching the 
value of the lookup_value argument against those in the table_array argument. 
You determine the col_index_num argument counting how many columns this 
column is over to the right from the first column of the vertical lookup table, and 
you include the first column of the lookup table in this count.

Similarly, the row_index_num argument designates the row containing the val-
ues that are returned by the HLOOKUP function in a horizontal table. You deter-
mine the row_index_num argument by counting how many rows down this row is 
from the top row of the horizontal lookup table. Again, you include the top row of 
the lookup table in this count.

The value you enter for the the col_index_num or row_index_num arguments in the 
VLOOKUP and HLOOKUP functions can’t exceed the total number of columns or 
rows in the lookup table.

The optional range_lookup argument in both the VLOOKUP and the HLOOKUP 
functions is the logical TRUE or FALSE that specifies whether you want Excel 
to find an exact or approximate match for the lookup_value in the table_array. 
When you specify TRUE or omit the range_lookup argument in the VLOOKUP or 
HLOOKUP function, Excel finds an approximate match. When you specify FALSE 
as the range_lookup argument, Excel finds only exact matches.

Finding approximate matches pertains only when you’re looking up numeric 
entries (rather than text) in the first column or row of the vertical or horizontal 
lookup table. When Excel doesn’t find an exact match in this lookup column or 
row, it locates the next highest value that doesn’t exceed the lookup_value argu-
ment and then returns the value in the column or row designated by the col_
index_num or row_index_num arguments.

When using the VLOOKUP and HLOOKUP functions, the text or numeric entries in 
the lookup column or row (that is, the leftmost column of a vertical lookup table 
or the top row of a horizontal lookup table) must be unique. These entries must 
also be arranged or sorted in ascending order; that is, alphabetical order for text 
entries, and lowest-to-highest order for numeric entries. (See Book 6, Chapter 1 
for detailed information on sorting data in a worksheet.)

Figure  6-4 (sample workbook: Tip Table VLOOKUP.xlsx) shows an example of 
using the VLOOKUP function to return either a 15% or 20% tip from a tip table, 
depending on the pretax total of the check. Cell F3 contains the VLOOKUP function:

=VLO OKUP(Pretax_Total, Tip_Table, IF(Tip_Percentage = 0.15, 2,  
3))
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This formula returns the amount of the tip based on the tip percentage in cell F1 
and the pretax amount of the check in cell F2.

To use this tip table, enter the percentage of the tip (15% or 20%) in cell F1 (named 
Tip_Percentage) and the amount of the check before tax in cell F2 (named Pre-
tax_Total). Excel then looks up the value that you enter in the Pretax_Total cell 
in the first column of the lookup table, which includes the cell range A2:C101 and 
is named Tip_Table.

Excel then moves down the values in the first column of Tip_Table until it 
finds a match, whereupon the program uses the col_index_num argument in the 
VLOOKUP function to determine which tip amount from that row of the table to 
return to cell F3. If Excel finds that the value entered in the Pretax_Total cell 
($16.50 in this example) doesn’t exactly match one of the values in the first col-
umn of Tip_Table, the program continues to search down the comparison range 
until it encounters the first value that exceeds the pretax total (17.00 in cell A19 in 
this example). Excel then moves back up to the previous row in the table and 
returns the value in the column that matches the col_index_num argument of the 
VLOOKUP function. (This is because the optional range_lookup argument has been 
omitted from the function.)

Note that the tip table example in Figure 6-4 uses an IF function to determine 
the col_index_num argument for the VLOOKUP function in cell F3. The IF function 
determines the column number to be used in the tip table by matching the per-
centage entered in Tip_Percentage (cell F1) with 0.15. If they match, the function 

FIGURE 6-4:  
Using the 
VLOOKUP 

 function to return 
the amount of 
the tip to add 

from a Lookup 
table. (Sample 

workbook:  
Tip Table 

VLOOKUP.xlsx)
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returns 2 as the col_index_num argument, and the VLOOKUP function returns a 
value from the second column (the 15% column B) in the Tip_Table range. Other-
wise, the IF function returns 3 as the col_index_num argument, and the VLOOKUP 
function returns a value from the third column (the 20% column C) in the Tip_
Table range.

Figure  6-5 (sample workbook: Chris’s Cookies - January Sales HLOOKUP.xlsx) 
shows an example that uses the HLOOKUP function to look up the price of each 
bakery item stored in a separate price lookup table and then to return that price to 
the Price/Doz column of the Daily Sales list. Cell F3 contains the original formula 
with the HLOOKUP function that is then copied down column F:

=HLOOKUP(@item, Price_table, 2, FALSE)

In this HLOOKUP function, the range name Item that’s given to the Item column 
in the range C3:C62 is defined as the lookup_value argument and the cell range 
name Price table that’s given to the cell range I1:M2 is the table_array argument. 
The row_index_num argument is 2 because you want Excel to return the prices in 
the second row of the Prices Lookup table, and the optional range_lookup argu-
ment is FALSE because the item name in the Daily Sales list must match exactly 
the item name in the Prices lookup table.

By having the HLOOKUP function use the Price table range to input the price 
per dozen for each bakery goods item in the Daily Sales list, you make it a very 
straightforward matter to update any of the sales in the list. All you have to do is 
change its Price/Doz cost in this range, and the HLOOKUP function immediately 
updates the new price in the Daily Sales list wherever the item is sold.

FIGURE 6-5:  
Using the 

HLOOKUP 
 function to 

return the price 
of a bakery item 

from a lookup 
table. (Sample 

workbook: Chris’s 
Cookies - January 

Sales  
HLOOKUP.xlsx)
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Performing an old-fashioned two-way 
lookup with MATCH and INDEX
In both the VLOOKUP and HLOOKUP examples, Excel only compares a single value 
in the data list to a single value in the vertical or horizontal lookup table. Some-
times, however, you may have a table in which you need to perform a two-way 
lookup, whereby a piece of data is retrieved from the lookup table based on look-
ing up a value in the top row (with the table’s column headings) and a value in the 
first column (with the table’s row headings).

Figure 6-6 (sample workbook: Production Schedule MATCH and INDEX Lookup.
xlsx) illustrates a situation in which you would use two values, the production 
date, and the part number to look up the expected production. In the Production 
Schedule table, the production dates for each part form the column headings in 
the first row of the table, and the part numbers form the row headings in its first 
column of the table.

To look up the number of the part scheduled to be produced in a particular month, 
you need to the use the MATCH function, which returns the relative position of a 
particular value in a cell range or array. The syntax of the MATCH function is as 
follows:

MATCH(lookup_value, lookup_array, [match_type])

The lookup_value argument is, of course, the value whose position you want 
returned when a match is found, and the lookup_array is the cell range or array 
containing the values that you want to match. The optional match_type argument 

FIGURE 6-6:  
Doing a two-

way lookup in 
the  Production 
Schedule table. 

(Sample  
workbook: 
 Production 

Schedule MATCH 
and INDEX 

Lookup.xlsx)
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is the number 1, 0, or –1, which specifies how Excel matches the value specified by 
the lookup_value argument in the range specified by the lookup_array argument:

 » Use match_type 1 to find the largest value that is less than or equal to the 
lookup_value. Note that the values in the lookup_array must be placed in 
ascending order when you use the 1 match_type argument. (Excel uses this 
type of matching when the match_type argument is omitted from the MATCH 
function.)

 » Use match_type 0 to find the first value that is exactly equal to the lookup_
value. Note that the values in the lookup_array can be in any order when you 
use the 0 match_type argument.

 » Use match_type –1 to find the smallest value that is greater than or equal to 
the lookup_value. Note that the values in the lookup_array must be placed in 
descending order when you use the –1 match_type argument.

In addition to looking up the position of the production date and part number in 
the column and row headings in the Production Schedule table, you need to use 
an INDEX function, which uses the relative row and column number position to 
return the number to be produced from the table itself. The INDEX function uses 
two different syntax forms: array and reference. You use the array form when you 
want a value returned from the table (as you do in this example), and you use the 
reference form when you want a reference returned from the table.

The syntax of the array form of the INDEX function is as follows:

INDEX(array, [row_num], [col_num])

The syntax of the reference form of the INDEX function is as follows:

INDEX(reference, [row_num], [col_num], [area_num])

The array argument of the array form of the INDEX function is a range of cells or 
an array constant that you want Excel to use in the lookup. If this range or con-
stant contains only one row or column, the corresponding row_num or col_num 
arguments are optional. If the range or array constant has more than one row or 
more than one column, and you specify both the row_num and the col_num argu-
ments, Excel returns the value in the array argument that is located at the inter-
section of the row_num argument and the col_num argument.

For the MATCH and INDEX functions in the example shown in Figure  6-6,  
I assigned the following range names to the following cell ranges:
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 » table_data to the cell range A2:J6 with the production data plus column and 
row headings

 » part_list to the cell range A2:A6 with the row headings in the first column of 
the table

 » date_list to the cell range A2:J2 with the column headings in the first row of 
the table

 » part_lookup to cell B10 that contains the name of the part to look up in the 
table

 » date_lookup to cell B11 that contains the name of the production date to look 
up in the table

As Figure 6-6 shows, cell B12 contains a rather long and — at first glance — 
complex formula using the range names outlined previously and combining the 
INDEX and MATCH functions:

=IN DEX(table_data, MATCH(part_lookup, part_list),  
MATCH(date_lookup, date_list))

So you can better understand how this formula works, I break the formula down 
into its three major components: the first MATCH function that returns the row_
num argument for the INDEX function, the second MATCH function that returns 
the col_num argument for the INDEX function, and the INDEX function itself that 
uses the values returned by the two MATCH functions to return the number of 
parts produced.

The first MATCH function that returns the row_num argument for the INDEX 
function is

MATCH(part_lookup, part_list)

This MATCH function uses the value input into cell B10 (named part_lookup) and 
looks up its position in the cell range A2:A6 (named part_list). It then returns this 
row number to the INDEX function as its row_num argument. In the case of the 
example shown in Figure 6-6 where part AB-101 is entered in the part_lookup 
cell in B10, Excel returns 3 as the row_num argument to the INDEX function.

The second MATCH function that returns the col_num argument for the INDEX 
function is

MATCH(date_lookup, date_list)

This second MATCH function uses the value input into cell B11 (named date_
lookup) and looks up its position in the cell range A2:J2 (named date_list). It then 
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returns this column number to the INDEX function as its col_num argument. In 
the case of the example shown in Figure 6-6 where September 1, 2022 (format-
ted as Sep-22), is entered in the date_lookup cell in B11, Excel returns 7 as the 
col_num argument to the INDEX function.

This means that for all its supposed complexity, the INDEX function shown on 
the Formula bar in Figure 6-6 contains the equivalent of the following formula:

=INDEX(table_data, 3, 7)

As Figure 6-6 shows, Excel returns 155 units as the planned production value for 
part AB-101  in September 2022. You can verify that this is correct by manually 
counting the rows and the columns in the table_data range (cell range A2:J6). If 
you count down three rows (including row 2, the first row of this range), you come 
to Part 101 in column A. If you then count seven columns over (including column A 
with AB-101), you come to cell G4 in the Sep-16 column with the value 155.

Getting Cell Reference Info with  
the Reference Functions

The reference functions in Excel enable you to return specific information about 
particular cells or parts of the worksheet; create hyperlinks to different docu-
ments on your computer, network, or the Internet; and transpose ranges of verti-
cal cells so that they run horizontally and vice versa.

You can access the Reference functions either via the Insert Function icon on the 
Formula bar, or via the Ribbon’s Formulas tab by clicking the Lookup & Reference 
drop-down menu. This group of functions includes:

 » ADDRESS: Returns a cell reference as a text entry in a cell of the worksheet

 » AREAS: Returns the number of areas in a list of values (areas are defined as a 
range of contiguous cells or a single cell in the cell reference)

 » COLUMN: Returns the number representing the column position of a cell 
reference

 » COLUMNS: Returns the number of columns in a reference

 » FORMULATEXT: Returns the formula referenced as a text string

 » GETPIVOTDATA: Returns data stored in an Excel pivot table (see Book 7, 
Chapter 2 for details)
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 » HYPERLINK: Creates a link that opens another document stored on your 
computer, network, or the Internet (you can also do this by choosing 
Insert➪  Hyperlink; see Book 4, Chapter 2 for details)

 » INDIRECT: Returns a cell reference specified by a text string and bring the 
contents in the cell to which it refers to that cell

 » LOOKUP: Returns a value from an array

 » OFFSET: Returns a reference to a cell range that’s specified by the number of 
rows and columns from a cell or a cell range

 » ROW: Returns the row number of a cell reference

 » ROWS: Returns the number of rows in a cell range or array

 » RTD: Returns real-time data from a server running a program that supports 
COM (Component Object Model) automation

 » TRANSPOSE: Returns a vertical array as a horizontal array and vice versa

Get the skinny on columns and rows
The COLUMNS and ROWS functions return the number of columns and rows in a 
particular cell range or array. For example, if you have a cell range in the work-
sheet named product_mix, you can find out how many columns it contains by 
entering this formula:

=COLUMNS(product_mix)

If you want to know how many rows this range uses, you then enter this formula:

=ROWS(product_mix)

As indicated in the previous chapter, you can use the COLUMNS and ROWS func-
tions together to calculate the total number of cells in a particular range. For 
example, if you want to know the exact number of cells used in the product_mix 
cell range, you create the following simple multiplication formula by using the 
COLUMNS and ROWS functions:

=COLUMNS(product_mix) * ROWS(product_mix)

Don’t confuse the COLUMNS (plural) function with the COLUMN (singular) func-
tion and the ROWS (plural) function with the ROW (singular) function. The COL-
UMN function returns the number of the column (as though Excel were using the 
R1C1 reference system) for the cell reference that you specify as its sole argument. 
Likewise, the ROW function returns the number of the row for the cell reference 
that you specify as its argument.
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Transposing cell ranges
The TRANSPOSE function enables you to change the orientation of a cell range 
(or an array — see the section on entering array formulas in Book 3, Chapter 1 for 
details). You can use this function to transpose a vertical cell range where the data 
runs down the rows of adjacent columns to one where the data runs across the 
columns of adjacent rows and vice versa.

Suppose that you want to transpose the data entered into the range A10:C11 (a 2 x 
3 array) to the range E10:F12 (a 3 x 2 array) of the worksheet. After first making 
sure that there’s no existing data in the range E10:F12, you’d enter the following 
formula into cell E10:

=TRANSPOSE(A10:C11)

Figure 6-7 (sample workbook: TRANSPOSE Example.xlsx) illustrates the use of 
the TRANSPOSE function. The cell range B2:C4 contains the original 3 x 2 array 
that I want to transpose. To convert this 3 x 2 array to a 2 x 3 array in the range 
B6:D7, I entered the following formula in cell B6:

=TRANSPOSE(B2:C4)

Similarly in Figure 6-7, to transpose the 4 x 3 array in the range F2:I4 to the 3 x 4 
range F6:H9, I entered the following formula into cell F6:

=TRANSPOSE(F2:I4)

The TRANSPOSE examples in this section assume you’re using a version of Excel 
that supports dynamic arrays. If you’re using Excel 2016 or earlier, you need to 
select the entire destination array, type your TRANSPOSE formula, and then com-
plete it by pressing Ctrl+Shift+Enter.

FIGURE 6-7:  
Using the 

 TRANSPOSE 
 function to 
change the 

orientation of 
a simple array. 

(Sample  workbook: 
 TRANSPOSE 

Example.xlsx)
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If all you want to do is transpose row and column headings or a simple table of 
data, you don’t have to go through the rigmarole of creating an array formula 
using the TRANSPOSE function. Copy the range of cells to be transposed, position 
the cell cursor in the first empty cell where the transposed range is to be pasted, 
and then choose Paste➪  Transpose.

Interrogating Excel
The information functions are designed to test the contents of a cell or cell range 
and give you information on its current contents. You can access the Information 
functions either via the Insert Function icon on the Formula bar, or via the Rib-
bon’s Formulas tab by choosing More Functions➪  Information.

These kinds of information functions are often combined with IF functions, which 
determine what type of calculation, if any, to perform. The information function 
then becomes the logical_test argument of the IF function, and the outcome of 
the test, expressed as the logical TRUE or logical FALSE value, decides whether 
its value_if_true or its value_if_false argument is executed. (See Book 3, Chapter 2 
for information on using information functions that test for error values to trap 
errors in a worksheet.)

In addition to the many information functions that test whether the contents of a 
cell are of a certain type, Excel offers a smaller set of functions that return coded 
information about a cell’s contents or formatting and about the current operating 
environment in which the workbook is functioning. The program also offers an N 
(for Number) function that returns the value in a cell and an NA (for Not Availa-
ble) function that inserts the #N/A error value in the cell.

Getting information about a cell
The CELL function is the basic information function for getting all sorts of data 
about the contents and formatting of a cell. The syntax of the CELL function is

CELL(info_type, [reference])

The info_type argument is a text value that specifies the type of cell informa-
tion you want returned. The optional reference argument is the reference of the 
cell range for which you want information. When you omit this argument, Excel 
specifies the type of information given by the info_type argument for the last cell 
that was changed in the worksheet. When you specify a cell range as the reference 
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argument, Excel returns the type of information given by the info_type argument 
for the first cell in the range (that is, the one in the upper-left corner, which may 
or may not be the active cell of the range).

Table 6-1 shows the various info_type arguments that you can specify when using 
the CELL function. Remember that you must enclose each info_type argument in 
the CELL function in double-quotes (to enter them as text values) to prevent Excel 
from returning the #NAME? error value to the cell containing the CELL function 
formula. So, for example, if you want to return the contents of the first cell in the 
range B10:E80, you enter the following formula:

=CELL("contents",B10:E80)

TABLE 6-1 The CELL Functions info_type Arguments
CELL Function info_
type Argument

Returns This Information

“address” Cell address of the first cell in the reference as text using absolute cell references

“col” Column number of the first cell in the reference

“color” 1 when the cell is formatted in color for negative values; otherwise returns 0 (zero)

“contents” Value of the upper-left cell in the reference

“filename” Filename (including the full pathname) of the file containing the cell reference: 
returns empty text (“”) when the workbook containing the reference has not yet 
been saved

“format” Text value of the number format of the cell (see Table 6-2): Returns “-” at the end of 
the text value when the cell is formatted in color for negative values and “()” when 
the value is formatted with parentheses for positive values or for all values

“parentheses” 1 when the cell is formatted with parentheses for positive values or for all values

“prefix” Text value of the label prefix used in the cell: Single quote (‘) when text is left-
aligned; double quote (“) when text is right-aligned; caret (^) when text is centered; 
backslash (\) when text is fill-aligned; and empty text (“”) when the cell contains any 
other type of entry

“protect” 0 when the cell is unlocked and 1 when the cell is locked (see Book 4, Chapter 1 for 
details on protecting cells in a worksheet)

“row” Row number of the first cell in the reference

“type” Text value of the type of data in the cell: “b” for blank when cell is empty; “l” for 
label when cell contains text constant; and “v” for value when cell contains any 
other entry

“width” Column width of the cell rounded off to the next highest integer (each unit of 
column width is equal to the width of one character in Excel’s default font size)



Lo
ok

up
, I

nf
or

m
at

io
n,

 
an

d 
Te

xt
 F

or
m

ul
as

CHAPTER 6  Lookup, Information, and Text Formulas      429

Table 6-2 shows the different text values along with their number formats (codes) 
that can be returned when you specify “format” as the info_type argument in a 
CELL function. (Refer to Book 2, Chapter 3 for details on number formats and the 
meaning of the various number format codes.)

TABLE 6-2 Text Values Returned by the “format” info_type
Text Value Number Formatting

“G” General

“F0” 0

“,0” #,##0

“F2” 0.00

“,2” #,##0.00

“C0” $#,##0_);($#,##0)

“C0-” $#,##0_);[Red]($#,##0)

“C2” $#,##0.00_);($#,##0.00)

“C2-” $#,##0.00_);[Red]($#,##0.00)

“P0” 0%

“P2” 0.00%

“S2” 0.00E+00

“G” # ?/? or # ??/??

“D4” m/d/yy or m/d/yy h:mm or mm/dd/yy

“D1” d-mmm-yy or dd-mmm-yy

“D2” d-mmm or dd-mmm

“D3” mmm-yy

“D5” mm/dd

“D7” h:mm AM/PM

“D6” h:mm:ss AM/PM

“D9” h:mm

“D8” h:mm:ss
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For example, if you use the CELL function that specifies “format” as the info_type 
argument on cell range A10:C28 (which you’ve formatted with the Comma style 
button on the Formula bar), as in the following formula

=CELL("format”, A10:C28)

Excel returns the text value “,2-” (without the quotation marks) in the cell where 
you enter this formula signifying that the first cell uses the Comma style format 
with two decimal places and that negative values are displayed in color (red) and 
enclosed in parentheses.

Are you my TYPE?
Excel provides another information function that returns the type of value in a 
cell. Aptly named, the TYPE function enables you to build formulas with the IF 
function that execute one type of behavior when the cell being tested contains a 
value and another when it contains text. The syntax of the TYPE function is

TYPE(value)

The value argument of the TYPE function can be any Excel entry: text, number, 
logical value, or even an error value or a cell reference that contains such a value. 
The TYPE function returns the following values, indicating the type of contents:

 » 1 for numbers

 » 2 for text

 » 4 for logical value (TRUE or FALSE)

 » 16 for error value

 » 64 for an array range or constant (see Book 3, Chapter 1)

The following formula combines the CELL and TYPE functions nested within an 
IF function. This formula returns the type of the number formatting used in cell 
D11 only when the cell contains a value. Otherwise, it assumes that D11 contains a 
text entry, and it evaluates the type of alignment assigned to the text in that cell:

=IF(TYPE(D11) = 1, CELL("format", D11), CELL("prefix", D11))
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Using the IS functions
The IS information functions (as in ISBLANK, ISERR, and so on) are a large group 
of functions that work in essentially the same way. They evaluate a value or cell 
reference and return the logical TRUE or FALSE, depending on whether the value 
is or isn’t the type for which the IS function tests. For example, if you use the 
ISBLANK function to test the contents of cell A1 as in

=ISBLANK(A1)

Excel returns TRUE to the cell containing the formula when A1 is empty and FALSE 
when it’s occupied by any type of entry.

Excel offers a dozen built-in IS information functions:

 » ISBLANK(value): Evaluates whether the value or cell reference is empty.

 » ISERR(value): Evaluates whether the value or cell reference contains an Error 
value (except for #N/A).

 » ISERROR(value): Evaluates whether the value or cell reference contains an 
Error value (including #N/A).

 » ISEVEN(value): Evaluates whether the value in the referenced cell is even 
(TRUE) or odd (FALSE).

 » ISFORMULA(value): Evaluates whether the value or cell reference contains a 
formula.

 » ISLOGICAL(value): Evaluates whether the value or cell reference contains the 
logical TRUE or FALSE value.

 » ISNA(value): Evaluates whether the value or cell reference contains the 
special #N/A Error value.

 » ISNONTEXT(value): Evaluates whether the value or cell reference contains 
any type of entry other than text.

 » ISNUMBER(value): Evaluates whether the value or cell reference contains a 
number.

 » ISODD(number): Evaluates whether the value in the referenced cell is odd 
(TRUE) or even (FALSE).

 » ISREF(value): Evaluates whether the value or cell reference is itself a cell 
reference.

 » ISTEXT(value): Evaluates whether the value or cell reference contains a text entry.

For an example of how to use the ISERROR function, refer to the section on error 
trapping in Book 3, Chapter 2.
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Working with Text Functions  
and Formulas

Normally, when you think of doing calculations in a worksheet, you think of per-
forming operations on its numeric entries. You can, however, use the text func-
tions as well as the concatenation operator (&) to perform operations on its text 
entries as well (referred to collectively as string operations).

Using text functions
Text functions found on the Text command button’s drop-down menu on the 
Ribbon’s Formulas tab (Alt+MT) include two types of functions: functions such as 
VALUE, TEXT, and DOLLAR that convert numeric text entries into numbers and 
numeric entries into text, and functions such as UPPER, LOWER, and PROPER that 
manipulate the strings of text themselves.

Many times, you need to use the text functions when you work with data from 
other programs. For example, suppose that you purchase a target client list on 
disk, only to discover that all the information has been entered in all uppercase 
letters. To use this data with your word processor’s mail merge feature, you would 
use Excel’s PROPER function to convert the entries so that only the initial letter of 
each word is in uppercase.

Text functions such as the UPPER, LOWER, and PROPER functions all take a sin-
gle text argument that indicates the text that should be manipulated. The UPPER 
function converts all letters in the text argument to uppercase. The LOWER func-
tion converts all letters in the text argument to lowercase. The PROPER function 
capitalizes the first letter of each word as well as any other letters in the text 
argument that don’t follow another letter and changes all other letters in the text 
argument to lowercase.

Figure 6-8 (sample workbook: Client List.xlsx) illustrates a situation in which you 
would use the PROPER function. Here, both last and first name text entries have 
been made in all uppercase letters. Follow these steps for using the PROPER func-
tion to convert text entries to the proper capitalization:

1. Position the cell cursor in cell C3, click the Text command button on the 
Ribbon’s Formulas tab (or press Alt+MT), and then choose PROPER from 
its drop-down menu.

The Function Arguments dialog box for the PROPER function opens with the 
Text box selected.
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2. Click cell A3 in the worksheet to insert A3 in the Text box of the Function 
Arguments dialog box and then click OK to insert the PROPER function 
into cell C3.

Excel closes the Insert Function dialog box and inserts the formula 
=PROPER(A3) in cell C3, which now contains the proper capitalization of the 
last name Aiken.

3. Drag the fill handle in the lower-right corner of cell C3 to the right to cell 
D3 and then release the mouse button to copy the formula with the 
PROPER function to this cell.

Excel now copies the formula =PROPER(B3) to cell D3, which now contains the 
proper capitalization of the first name, Christopher. Now you’re ready to copy 
these formulas with the PROPER function down to row 17.

4. Drag the fill handle in the lower-right corner of cell D3 down to cell D17 
and then release the mouse button to copy the formulas with the 
PROPER function down.

The cell range C3:D17 now contains first and last name text entries with the 
proper capitalization. (See Figure 6-8.) Before replacing all the uppercase 
entries in A3:B17 with these proper entries, you convert them to their calcu-
lated values. This action replaces the formulas with the text as though you had 
typed each name in the worksheet.

5. With the cell range C3:D17 still selected, click the Copy command button 
on the Home tab of the Ribbon.

6. Immediately choose the Paste Values option from the Paste command 
button’s drop-down menu.

You’ve now replaced the formulas with the appropriate text. Now you’re ready 
to move this range on top of the original range with the all-uppercase entries. 
This action replaces the uppercase entries with the ones using the proper 
capitalization.

7. With the cell range C3:D17 still selected, position the white-cross mouse 
or Touch pointer on the bottom of the range; when the pointer changes 
to an arrowhead, drag the cell range until its outline encloses the range 
A3:B17 and then release the mouse button or remove your finger or 
stylus from the touchscreen.

Excel displays an alert box asking whether you want the program to replace 
the contents of the destination’s cells.

8. Click OK in the Alert dialog box to replace the all-uppercase entries with 
the properly capitalized ones in the destination cells.
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Your worksheet now looks like the one shown in Figure 6-9 (sample workbook: 
Client List.xlsx). Everything is fine in the worksheet with the exception of the two 
last names, Mcavoy and Mcclinton. You have to manually edit cells A11 and A12 to 
capitalize the A in McAvoy and the second C in McClinton.

FIGURE 6-8:  
Using the 

PROPER  function 
to  convert names 

in all  uppercase 
letters to proper 

 capitalization. 
(Sample 

 workbook: Client 
List.xlsx)

FIGURE 6-9:  
Worksheet 

after replacing 
names in all 

 uppercase letters 
with  properly 

 capitalized 
names. (Sample 

workbook: Client 
List.xlsx)
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The T function
The T text function enables you to test whether a cell entry somewhere else in the 
workbook contains text. It does this by testing the entry specified in its sole value 
argument as in

=T(C28)

If cell C28 in this example does currently contain a text entry, the T function dis-
plays that text in the cell containing the T function formula. If C28 currently con-
tains anything else besides text, Excel puts empty text (with double quotes with 
nothing inside them) in the cell with the T function formula that makes it appear 
as though that cell is blank.

TEXTJOIN function
The TEXTJOIN function gives you a new and easy way to join together text entered 
into separate cells of a worksheet into one long text entry with each of its erstwhile 
individual text entries separated by whatever delimiting character you choose to 
use. This function is useful for those times when you have data lists that need to 
be exported to an external database program. The most common situation is when 
you need to convert to an Excel data list into a CSV (Comma Separated Value) text 
file that can be directly imported into an external database app. The TEXTJOIN 
function uses the following syntax:

=TEXTJOIN(delimiter, ignore_empty, text1, [text2],...)

To see how this may work, consider the example shown in Figure 6-10 (sample 
workbook: TEXTJOIN.xlsx). Here, I have entered a data list into the cell range 
A1:F6 with clients names and addresses. To make it easy to sort and query this 
data, I have formatted this list as an Excel table. To save this data in a CSV text file 
ready for export to another program, I use the TEXTJOIN function, designating the 
comma (“,”) as the delimiter as follows:

=TEXTJOIN(",", FALSE, A2:F2)

In CSV files, individual fields (such as First Name, Last Name, and so on) are nor-
mally separated by commas (although spaces and tabs are also used), and indi-
vidual records (Amelia Adams, Jack Smith, and so on) are separated by link breaks 
(designated in a worksheet by the different rows). So for this original TEXTJOIN 
formula, I designate the comma as the initial delimiter argument (enclosed in 
double quotes). I then designate the ignore_empty argument as FALSE. This is a 
required logical argument that tells Excel whether to skip cells in the list that are 
blank. Finally, I designate the cell range A2:F2 as the sole text argument as it con-
tains all name and address data that comprise Amelia Adams’s record.



436      BOOK 3  Formulas and Functions

After entering the original TEXTJOIN formula in cell H2, I then use the fill handle 
to copy the formula to the cell range H3:H6. As a result, Excel combines each piece 
of name and address data into a single, long string of text separated by commas. 
In cell H4 in Figure 6-10, you can also see the result of setting the ignore_empty 
argument to FALSE the TEXTJOIN function. Because I’ve told Excel to not ignore 
empty fields, even though Andrew Miller’s street address in cell C4 is missing, 
the TEXTJOIN function keeps a place for this data in the calculated result in H4 
by placing a space followed by a comma immediately following Andrew Miller’s 
name. This is important because the record of the exported CSV file needs to have 
the same amount of fields to prevent the external database program from putting 
the city of Boston into the Street field and the state abbreviation of MA into the 
City field (and so on) in Andrew Miller’s record in the resulting database.

All that’s left to do after copying the TEXTJOIN formulas is to copy the values 
returned by these formulas to the worksheet of a new workbook and then save 
this new workbook as in the CSV file format. To do this, you follow these steps:

1. Select the cell range H2:H6 with the TEXTJOIN formulas and press Ctrl+C.

2. Open a new workbook file by pressing Ctrl+N.

3. Click the Values options on the Paste button’s drop-down menu to paste 
the long comma separated text entries into the cell range A1:A5 in the 
new workbook (Book 1).

4. Save the new workbook file as a CSV file by pressing Ctrl+S, designating 
the new filename as well as the drive and folder where it’s to be saved, 
clicking CSV (Comma Delimited) from the Save As Type drop-down menu, 
and clicking the Save button.

After saving the joined comma separated client address data in the new CSV file, 
you’re ready to send the file to whatever department needs it. (See Book 4, Chap-
ter 3 for more on sharing files.)

FIGURE 6-10:  
Using the 

 TEXTJOIN  function 
to create a CSV 

file for export 
where fields are 

separated by 
commas and 

records by line 
breaks. (Sample 

workbook: 
 TEXTJOIN.xlsx)
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Concatenating text
You can use the ampersand (&) operator to concatenate (or join) separate text 
strings together. For example, in the Client list worksheet shown in Figure 6-9, 
you can use this operator to join together the first and last names currently entered 
in two side-by-side cells into a single entry, as shown in Figure  6-11 (sample 
workbook: Client List.xlsx).

To join the first name entry in cell B3 with the last name entry in cell A3, I entered 
the following formula in cell C3:

=B3 & " " & A3

Notice the use of the double quotes in this formula. They enclose a blank space 
that is placed between the first and last names joined to them with the two con-
catenation operators. If I didn’t include this space in the formula and just joined 
the first and last names together with this formula

=B3 & A3

Excel would return ChristopherAiken to cell C3, all as one word.

After entering the concatenation formula that joins the first and last names in cell 
C3 separated by a single space, I then drag the fill handle in cell C3 down to C17 to 
join all the other client names in a single cell in column C.

FIGURE 6-11:  
Worksheet after 

concatenating 
the first and 

last names in 
column C.  

(Sample 
 workbook: Client 

List.xlsx)
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After the original concatenation formula is copied down the rows of column C, I 
copy the selected cell range C3:C17 to the Clipboard by clicking the Copy button 
in the Clipboard group of the Home tab on the Ribbon, and then I immediately 
choose the Paste Values option from the Paste command button’s drop-down 
menu. This action pastes calculated text values over the concatenation formulas, 
thereby replacing the original formulas. The result is a list of first and last names 
together in the same cell in the range C3:C17, as though I had manually input 
each one.



4Worksheet 
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Protecting Workbooks 
and Worksheet Data

Before you start sending your worksheets for review, you need to make them 
secure. Security in Excel exists on two levels. The first is protecting the 
workbook file so that only people entrusted with the password can open 

the file to view, print, or edit the data. The second is protecting the worksheets 
in a workbook from unwarranted changes so that only people entrusted with that 
password can make modifications to the worksheet contents and design.

When it comes to securing the integrity of your worksheets, you can decide 
which aspects of the sheets in the workbook your users can and can’t change. For 
example, you may prevent changes to all formulas and headings in a worksheet, 
while still enabling users to make entries in the cells referenced in the formulas 
themselves.

Chapter 1

IN THIS CHAPTER

 » Assigning a password for opening a 
workbook

 » Assigning a password for making 
editing changes in a workbook

 » Using the Locked and Hidden 
protection formats

 » Protecting a worksheet and selecting 
what actions are allowed

 » Enabling cell range editing by 
particular users in a protected sheet

 » Doing data entry solely in unlocked 
cells of a protected worksheet

 » Protecting the workbook
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Password-Protecting the Workbook
By password-protecting the workbook, you can prevent unauthorized users from 
opening the workbook and/or editing the workbook.

You set a password for opening the file when you’re dealing with a workbook that 
contains data of a sufficiently private or sensitive nature that only a certain group 
of people in the company should have access to it (such as worksheets dealing 
with personal information and salaries). After you set the password required to 
open the workbook, you must supply this password to those people who need 
access to the data.

You set a password for modifying the file when you’re dealing with a workbook 
that contains data that needs to be viewed and printed by different users, none of 
whom are authorized to make changes to any of the entries. For example, you may 
assign a password for modifying a workbook before distributing it companywide, 
after the workbook’s been through a complete editing and review cycle and all the 
suggested changes have been merged. (See Book 4, Chapter 3 for details for how 
to share your workbooks.)

Protecting the workbook when  
saving the file
If you’re dealing with a workbook that contains private, confidential, or sensitive 
data and shouldn’t be modified by anyone who’s not authorized to open it, you 
need to set both a password for opening and a password for modifying the work-
book file. You assign either one or both of these types of passwords to a workbook 
file at the time you save it by choosing File➪  Save As (for a local file) or File➪  Save 
a Copy (for an online file), or press Alt+FA.

When you choose this command (or, for a new file that’s never been saved, click 
the Save button on the Excel title bar or press Ctrl+S), Excel opens the Save As 
screen where you select the place where you want to save the file. (See Book 2, 
Chapter 1 for details.) After you select the place to save the file and assign its file-
name on the Save As screen, click the More Options link to have Excel open the 
Save As dialog box where you can then set the password to open and/or the pass-
word to modify the file by taking these steps:

1. Click the Tools button in the Save As dialog box and then choose General 
Options from its drop-down menu.

Doing this opens the General Options dialog box, similar to the one shown in 
Figure 1-1, where you can enter a password to open and/or a password to 
modify in the File Sharing section.
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2. (Optional) If you want to assign a password to open the file, type the 
password in the Password to Open text box.

Your password can be as long as 255 characters, consisting of a combination of 
letters and numbers with spaces. When adding letters to your passwords, keep 
in mind that these passwords are case-sensitive. This means that opensesame 
and OpenSesame are not the same password because of the different use of 
upper- and lowercase letters.

When entering a password, make sure that you don’t enter something that you 
can’t easily reproduce or, for heaven’s sake, that you can’t remember. You 
must be able to immediately reproduce the password to assign it, and you 
must be able to reproduce it later if you want to be able to open or change the 
workbook ever again.

As you type the password, Excel masks the actual characters you type by 
rendering them as dots in the text box, as shown in Figure 1-1.

If you decide to assign a password for opening and modifying the workbook at 
the same time, proceed to Step 3. Otherwise, skip to Step 4.

When entering the password for modifying the workbook, you want to assign a 
password that’s different from the one you just assigned for opening the file (if 
you did assign a password for opening the file in this step).

3. (Optional) If you want to assign a password for modifying the workbook, 
type it in the Password to Modify text box.

4. Click OK.

The Confirm Password dialog box appears.

5. If you entered a password to open the file, use the Reenter Password to 
Proceed text box to type the same password as you entered in Step 2, 
and then click OK.

6. If you entered a password to modify the file, use the Reenter Password to 
Modify text box to type the same password as you entered in Step 3, and 
then click OK.

7. (Optional) If you want to save the password-protected version under a 
new filename or in a different folder, edit the name in the File Name text 
box and then select the new folder from the Save In drop-down list.

8. Click Save.

Excel saves the file if this is the first time you’ve saved it. If not, the program 
displays an alert dialog box indicating that the file you’re saving already exists 
and asking you whether you want to replace the existing file.

9. Click Yes.
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Select the Read-Only Recommended check box in the General Options dialog box 
instead of assigning a password for editing the workbook in the Password to Mod-
ify text box when you never want the user to be able to make and save changes in 
the same workbook file. When Excel marks a file as read-only, the user must save 
any modifications in a different file using the Save As (or Save a Copy) command. 
(See “Entering the password to make changes” later in this chapter for more on 
working with a read-only workbook file.)

The last chance you have to password-protect the opening of the file is before you 
close the file during the work session in which you originally assign the password. 
If, for whatever reason, you decide that you don’t want to go through the hassle of 
having to reproduce the password each and every time you open this file, you can 
get rid of it by choosing File➪   Save As (for a local file) or File➪  Save a Copy (for an 
online file), or pressing Alt+FA, clicking More Options, choosing General Options 
from the Tools drop-down menu, and then deleting the password in the Password 
to Open text box. Click OK in the General Options dialog box and the Save button 
in the Save As dialog box. Excel resaves the workbook file without a password to 
open it so that you don’t have to worry about reproducing the password the next 
time you open the workbook for editing or printing.

Assigning a password to open from  
the Info screen
Instead of assigning the password to open your workbook at the time you save 
changes to it, you can do this as well from Excel’s Info screen in the Backstage 
view by following these simple steps:

1. Choose File➪  Info or press Alt+FI.

Excel opens the Info screen.

2. Click the Protect Workbook button to open its drop-down menu and then 
choose Encrypt with Password.

Excel opens the Encrypt Document dialog box.

FIGURE 1-1:  
Setting a 

 password to open 
and modify the 

workbook in the 
General Options 

dialog box.
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3. Type the password in the Password text box and then click OK.

Excel opens the Confirm Password dialog box.

4. Type the password in the Reenter Password text box exactly as you typed 
it into the Password text box in the Encrypt Document dialog box and 
then click OK.

The drop-down menu attached to the Protect Workbook button in the Info screen 
in the Backstage doesn’t contain an option for protecting the workbook from fur-
ther modification after it’s opened in Excel. Instead, it contains a Mark as Final 
option that assigns read-only status to the workbook file that prevents the user 
from saving changes to the file under the same filename.

Entering the password to gain access
After you close a workbook file to which you’ve assigned a password for opening 
it, you must be able to faithfully reproduce the password to open the file (at least 
until you change or delete the password). When you next try to open the work-
book, Excel opens a Password dialog box like the one shown in Figure 1-2, where 
you must enter the password exactly as it was assigned to the file.

A password-protected workbook file for which you can’t reproduce the cor-
rect password can be a real nightmare (especially if you’re talking about a really 
important workbook with loads of vital data). So, for heaven’s sake, don’t forget 
your password, or you’ll be stuck. Excel doesn’t provide any sort of command for 
overriding the password and opening a protected workbook, nor does Microsoft 
offer any such utility. If you think that you may forget the workbook’s password, 
be sure to write it somewhere and then keep that piece of paper in a secure place, 
preferably under lock and key. It’s always better to be safe than sorry when it 
comes to passwords for opening files.

Entering the password to make changes
If you’ve protected your workbook from modifications with the Password to 
Modify option in the General Options dialog box, as soon as you attempt to open 

FIGURE 1-2:  
Entering the 

 password 
required to open 

a protected 
 workbook file.
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the workbook (and have entered the password to open the file, if one has been 
assigned), Excel immediately displays the Password dialog box where you must 
accurately reproduce the password assigned for modifying the file or click the 
Read Only button to open it as a read-only file.

When you supply the correct password, Excel immediately closes the Password 
dialog box, and you are free to edit the workbook in any way you wish (unless 
certain cell ranges or worksheets are protected). If you’re unable to successfully 
reproduce the password, you can click the Read Only command button, which 
opens a copy of the workbook file into which you can’t save your changes unless 
you choose File➪  Save As command (or File➪  Save a Copy) and then rename the 
workbook and/or locate the copy in a different folder.

When you click the Read Only button, Excel opens the file with a [Read-Only] 
indicator appended to the filename as it appears on the Excel title bar. If you then 
try to save changes with the Save button on the Excel title bar or the Save com-
mand on the File menu, the program displays an alert dialog box, indicating that 
the file is read-only and that you must save a copy by renaming the file in the Save 
As dialog box. As soon as you click OK to clear the alert dialog box, Excel displays 
the Save As dialog box, where you can save the copy under a new filename and/or 
location. Note that the program automatically removes the password for modify-
ing from the copy so that you can modify its contents any way you like.

Because password-protecting a workbook against modification doesn’t prevent 
you from opening the workbook and then saving an unprotected version under a 
new filename with the Save As command, you can assign passwords for modify-
ing files without nearly as much trepidation as assigning them for opening files. 
Assigning a password for modifying the file assures that you’ll always have an 
intact original of the worksheet from which you can open and save a copy, even if 
you can never remember the password to modify the original itself.

Changing or deleting a password
Before you can change or delete a password for opening a workbook, you must 
first be able to supply the current password to get the darned thing open. Assum-
ing you can do this, all you have to do to change or get rid of the password is open 
the Info screen in the Backstage view (Alt+FI) and then choose the Encrypt with 
Password option from the Protect Workbook button’s drop-down menu.

Excel opens the Encrypt Document dialog box with your password in the Password 
text box masked by asterisks. To then delete the password, remove all the aster-
isks from this text box before you click OK.
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To reassign the password, replace the current password with the new one you 
want to assign by typing it over the original one. Then, when you click OK in the 
Encrypt Document dialog box, re-enter the new password in the Confirm Pass-
word dialog box and then click OK. Finally, after closing the Encrypt Document 
dialog box, you click the Save option on the File menu in the Backstage view to 
save your changes and return to the regular worksheet window.

To change or delete the password for modifying the workbook, you must do this 
from the General Options dialog box. Choose File➪   Save As (for a local file) or 
File➪  Save a Copy (for an online file), press Alt+FA and then, after indicating the 
place to save the file in the Save As screen, click the More Options link to open 
the Save As dialog box where you can choose the General Options item from the 
Tools drop-down menu. You then follow the same steps for changing or deleting 
the password that’s entered into the Password to Modify text box in the General 
Options dialog box.

Setting Up Worksheet Data Protection
After you have the worksheet the way you want it, you often need the help of 
Excel’s Protection feature to keep it that way. Nothing’s worse than having an 
inexperienced data entry operator doing major damage to the formulas and func-
tions that you’ve worked so hard to build and validate. To keep the formulas and 
standard text in a worksheet safe from any unwarranted changes, you need to 
protect the worksheet.

Before you start using Excel’s commands for protecting the worksheet, you need 
to understand how protection works in Excel. All cells in the workbook are either 
locked or unlocked for editing and hidden or unhidden for viewing.

When you open a new worksheet, all the cells in the workbook have locked as 
their editing status and unhidden as their display status. However, these default 
settings do nothing until you turn on protection with the Protect Sheet and Pro-
tect Workbook command buttons on the Review tab. At that time, you’re then 
prevented from making any editing changes to all cells with a locked status and 
from viewing the contents of all cells on the Formula bar when they contain the 
cell cursor with a hidden status.

What this means in practice is that, prior to turning on worksheet protection, you 
go through the worksheet removing the Locked Protection format from all the cell 
ranges where you or your users need to be able to do data entry and editing even 
when the worksheet is protected. You also assign the Hidden Protection format 
to all cell ranges in the worksheet where you don’t want the contents of the cell 
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to be displayed when protection is turned on in the worksheet. Then, when that 
formatting is done, you activate protection for all the remaining locked cells and 
block the Formula bar display for all the hidden cells in the sheet.

When setting up your own worksheet templates, you will want to unlock all the 
cells where users need to input new data and keep locked all the cells that contain 
headings and formulas that never change. You may also want to hide cells with 
formulas if you’re concerned that their display may tempt the users to waste time 
trying to fiddle with or finesse them. Then, turn on worksheet protection prior 
to saving the file in the template file format. (See Book 2, Chapter 1, for details.) 
You are then assured that all worksheets generated from that template automati-
cally inherit the same level and type of protection as you assigned in the original 
worksheet.

Changing a cell’s Locked and Hidden  
Protection formatting
To remove the Locked protection status from a cell range or nonadjacent selec-
tion, use either of the following methods:

 » Select the range or ranges to be unlocked; then, in the Home tab’s Cells group, 
click Format and then click to deactivate the Lock Cell option (or press Alt+HOL).

 » Select the range or ranges to be unlocked; then, in the Home tab’s Cells group, 
choose Format➪  Format Cells (or press Ctrl+1 or Alt+HOE) to open the Format 
Cells dialog box. Click the Protection tab, deselect the Locked check box, and 
then click OK.

Excel lets you know that the cells that contain formulas in the selected range are 
no longer locked by adding tiny green triangles to the upper-left corner of each 
cell in the range that, when clicked, display an alert drop-down button whose tool 
tip reads, “This cell contains a formula and is not locked to protect it from being 
changed inadvertently.” When you click this alert button, a drop-down menu with 
Lock Cell as one of its menu items appears. Note that as soon as you turn on pro-
tection in the sheet, these indicators disappear.

To hide the display of the contents of the cells in the current selection, in the 
Home tab’s Cells group, choose Format➪  Format Cells (or press Ctrl+1 or Alt+HOE) 
to open the Format Cells dialog box. Click the Protection tab, select the Hidden 
check box, and then click OK.
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Changing the protection formatting of cell ranges in the worksheet (as described 
in this section) does nothing in and of itself. It’s not until you turn on the protec-
tion for your worksheet (as outlined in the next section) that your unlocked and 
hidden cells work or appear any differently from the locked and unhidden cells. At 
that time, only unlocked cells accept edits, and only unhidden cells display their 
contents on the Formula bar when they contain the cell cursor.

Protecting the worksheet
When you’ve got all the cells and ranges you want unlocked and hidden correctly 
formatted in the worksheet, you’re ready to turn on protection. To do this, display 
the Review tab and then, in the Protect group, click the Protect Sheet command (or 
press Alt+RPS) to open the Protect Sheet dialog box, shown in Figure 1-3.

When you first open this dialog box, the Protect Worksheet and Contents of Locked 
Cells check box is selected. Also, in the Allow All Users of This Workbook To list, 
the Select Locked Cells and Select Unlocked Cells check boxes are selected. All the 
other check boxes are deselected.

This means that if you click OK at this point, the only things that you’ll be per-
mitted to do in the worksheet are edit unlocked cells and select cell ranges (of any 
type: both locked and unlocked alike).

If you really want to keep other users out of all the locked cells in a worksheet, 
deselect the Select Locked Cells check box. That way, your users are completely 
restricted to just those unlocked ranges where you permit data input and content 
editing.

FIGURE 1-3:  
Use the Protect 

Sheet dialog 
box to select 

your worksheet 
 protection 

options.
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Don’t, however, deselect both the Select Unlocked Cells check box and the Select 
Locked Cells check box, because doing this causes the cell pointer to disappear 
from the worksheet. Without the cell pointer, the cell address in the Formula bar’s 
Name Box becomes the sole way for you and your users to keep track of their posi-
tion in the worksheet (which is, believe me, the quickest way to drive you and your 
users stark raving mad).

Selecting what actions are allowed in a  
protected sheet
Besides enabling users to select locked and unlocked cells in the worksheet, you 
can enable the following actions in the protected worksheet by selecting their 
check boxes in the Allow All Users of This Worksheet To list box of the Protect 
Sheet dialog box:

 » Format Cells: Enables the formatting of cells (with the exception of changing the 
locked and hidden status on the Protection tab of the Format Cells dialog box).

 » Format Columns: Enables formatting so that users can modify the column 
widths and hide and unhide columns.

 » Format Rows: Enables formatting so that users can modify the row heights 
and hide and unhide rows.

 » Insert Columns: Enables the insertion of new columns in the worksheet.

 » Insert Rows: Enables the insertion of new rows in the worksheet.

 » Insert Hyperlinks: Enables the insertion of new hyperlinks to other docu-
ments, both local and on the web. (See Book 2, Chapter 1, for details.)

 » Delete Columns: Enables the deletion of columns in the worksheet.

 » Delete Rows: Enables the deletion of rows in the worksheet.

 » Sort: Enables the sorting of data in unlocked cells in the worksheet. (See Book 6, 
Chapter 1, for details.)

 » Use AutoFilter: Enables the filtering of data in the worksheet. (See Book 6, 
Chapter 2, for more information.)

 » Use PivotTable & PivotChart: Enables the manipulation of PivotTables and 
PivotCharts in the worksheet. (For more about PivotTables, see Book 7, 
Chapter 2.)

 » Edit Objects: Enables the editing of graphic objects, such as text boxes, embed-
ded images, and the like, in the worksheet. (See Book 5, Chapter 2, for details.)

 » Edit Scenarios: Enables the editing of what-if scenarios, including modifying 
and deleting them. (For details of what-if scenarios, see Book 7, Chapter 1.)
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Assigning a password to unprotect the sheet
Besides enabling particular actions in the protected worksheet, you can also 
assign a password that’s required to remove the protections from the protected 
worksheet. When entering a password in the Password to Unprotect Sheet text box 
of the Protect Sheet dialog box, you observe the same guidelines as when assign-
ing a password to open or to make changes in the workbook. (A maximum of 255 
characters that can consist of a combination of letters, numbers, and spaces, with 
the letters being case-sensitive.)

As with assigning a password to open or make changes to a workbook, when you 
enter a password (whose characters are masked with asterisks) in the Password to 
Unprotect Sheet text box and then click OK, Excel displays the Confirm Password 
dialog box. Here, you must accurately reproduce the password you just entered 
(including upper- and lowercase letters) before Excel turns on the sheet protec-
tion and assigns the password for removing protection.

Excel closes the Protect Sheet dialog box and enables protection for that sheet, 
using whatever settings you designated in that dialog box.

If you don’t assign a password to unprotect the sheet, any user with a modi-
cum of Excel knowledge can lift the worksheet protection and make any man-
ner of changes to its contents, including wreaking havoc on its computational 
capabilities by corrupting its formulas. Keep in mind that it makes little sense to 
turn on the protection in a worksheet if you’re going to permit anybody to turn 
it off by clicking the Unprotect Sheet command button on the Review tab (which 
automatically replaces the Protect Sheet command button as soon as you turn on 
protection in the worksheet).

Removing protection from a worksheet
When you assign protection to a sheet, your input and editing are restricted solely 
to unlocked cells in the worksheet, and you can perform only those additional 
actions that you enabled in the Allow Users of this Worksheet To list box. If you 
try to replace, delete, or otherwise modify a locked cell in the protected worksheet, 
Excel displays an alert dialog box with the following message:

The  cell or chart you're trying to change is on a protected 
sheet.

The message then goes on to tell you

To make a change, unprotect the sheet. You might be requested 
to enter a password.
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If you’ve assigned a password to unprotect the sheet, when you click the Unpro-
tect Sheet button, the program displays the Unprotect Sheet dialog box, where 
you must enter the password exactly as you assigned it. As soon as you remove 
the protection by entering the correct password in this dialog box and clicking 
OK, Excel turns off the protection in the sheet, and you can once again make any  
kinds of modifications to its structure and contents in both the locked and 
unlocked cells.

When you protect a worksheet, only the data and graphics on that particular 
worksheet are protected. This means that you can modify the data and graphics 
on other sheets of the same workbook without removing protection. If you have 
data or graphics on other sheets of the same workbook that also need protecting, 
you need to activate each sheet and then repeat the entire procedure for protect-
ing it as well (including unlocking cells that need to be edited and selecting which 
other actions, if any, to enable in the worksheet, and whether to assign a pass-
word to unprotect the sheet) before distributing the workbook. When assigning 
passwords to unprotect the various sheets of the workbook, you may want to stick 
with a single password rather than have to worry about remembering a different 
password for each sheet, which is a bit much, don’t you think?

Enabling cell range editing by certain users
In the Review tab’s Protect group, you can use the Allow Edit Ranges command to 
enable the editing of particular ranges in the protected worksheet by certain users. 
When you use this feature, you give specified users permission to edit particular 
cell ranges, as long as they can correctly provide the password you assign to that 
range.

To give access to particular ranges in a protected worksheet, follow these steps:

1. Choose Review➪  Allow Edit Ranges (or press Alt+RU1).

Note that the Allow Edit Ranges command is disabled if the worksheet is 
currently protected. In that case, you must remove protection by clicking the 
Unprotect Sheet command button on the Review tab before you retry Step 1.

Excel opens the Allow Users to Edit Ranges dialog box, as shown in Figure 1-4.

2. Click the New button.

Doing this opens the New Range dialog box where you give the range a  
title, define its cell selection, and provide the range password, as shown in 
Figure 1-5.
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3. If you wish, type a name for the range in the Title text box; otherwise, 
Excel assigns a name such as Range1, Range2, and so on.

Next, you designate the cell range or nonadjacent cell selection to which access 
is restricted.

4. Click the Refers to Cells text box and then type the address of the cell 
range (without removing the = sign) or select the range or ranges in the 
worksheet.

Next, you need to enter a password that’s required to access the range. Like all 
other passwords in Excel, this one can be up to 255 characters long, mixing 
letters, numbers, and spaces. Pay attention to the use of upper- and lowercase 
letters because the range password is case-sensitive.

5. Type the password for accessing the range in the Range Password 
dialog box.

You need to use the Permissions button in the New Range dialog box to open 
the Permissions dialog box for the range you’re setting.

6. Click the Permissions button in the Range Password dialog box.

Next, you need to add the users who are to have access to this range.

7. Click the Add button in the Permissions dialog box.

Excel opens the Select Users or Groups dialog box, where you designate the 
names of the users to have access to the range.

8. Click the name of the user in the Enter the Object Names to Select list 
box at the bottom of the Select Users or Groups dialog box. To select 
multiple users from this list, hold down the Ctrl key as you click each 
username.

If this list box is empty, click the Advanced button to expand the Select Users or 
Groups dialog box and then click the Find Now button to locate all users for 
your location. You can then click the name or Ctrl+click the names you want to 
add from this list, and then when you click OK, Excel returns you to the original 
form of the Select Users or Groups dialog box and adds these names to its 
Enter the Object Names to Select list box.

9. Click OK in the Select Users or Groups dialog box.

Doing this returns you to the Permissions dialog box where the names you’ve 
selected are now listed in the Group or User Names list box. Now you need to 
set the permissions for each user. When you first add users, each one is 
permitted to edit the range without a password. To restrict the editing to only 
those who have the range password, you need to click each name and then 
select the Deny check box.
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10. Click the name of the first user who must know the password and then 
select the Deny check box in the Permissions For list box.

You need to repeat this step for each person in the Group or User Names list 
box that you want to restrict in this manner. (See Figure 1-6.)

11. Repeat Step 10 for each user who must know the password and then click 
OK in the Permissions dialog box.

The Windows Security dialog box appears, letting you know that you’re setting 
a deny permission that takes precedence over any allowed entries, so that if 
the person is a member of two groups, one with an Allow entry and the other 
with a Deny entry, the deny entry permission rules (meaning that the person 
has to know the range password).

12. Click the Yes button in the alert dialog box.

Doing this closes this dialog box and returns you to the New Range dialog box.

13. Click OK in the New Range dialog box.

The Confirm Password dialog box opens where you must accurately reproduce 
the range password.

14. Type the range password in the Reenter Password to Proceed text box 
and then click the OK button.

Doing this returns you to the Allow Users to Edit Ranges dialog box where the 
title and cell reference of the new range are displayed in the Ranges Unlocked 
by a Password When Sheet Is Protected list box, as shown in Figure 1-7.

If you need to define other ranges available to other users in the worksheet, 
you can do so by repeating Steps 2 through 14.

When you finish adding ranges to the Allow Users to Edit Ranges dialog box, 
you’re ready to protect the worksheet. If you want to retain a record of the 
ranges you’ve defined, go to Step 15. Otherwise, skip to Step 16.

15. (Optional) Select the Paste Permissions Information Into a New 
Workbook check box if you want to create a new workbook that contains 
all the permissions information.

When you select this check box, Excel creates a new workbook whose first 
worksheet lists all the ranges you’ve assigned, along with the users who may 
gain access by providing the range password. You can then save this workbook 
for your records. Note that the range password isn’t listed on this worksheet — 
if you want to add it, be sure that you password-protect the workbook so that 
only you can open it.
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Now, you’re ready to protect the worksheet. If you want to do this from within 
the Allow Users to Edit Ranges dialog box, you click the Protect Sheet button to 
open the Protect Sheet dialog box. If you want to protect the worksheet later 
on, click OK to close the Allow Users to Edit Ranges dialog box and then click 
the Protect Sheet command button on the Review tab of the Ribbon (or press 
Alt+RPS) when you’re ready to activate the worksheet protection.

16. Click the Protect Sheet button to protect the worksheet; otherwise, click 
the OK button to close the Allow Users to Edit Ranges dialog box.

If you click the Protect Sheet button, Excel opens the Protect Sheet dialog box, 
where you can set a password to unprotect the sheet. This dialog box is also where 
you select the actions that you permit all users to perform in the protected work-
sheet (as outlined earlier in this chapter).

After you turn on protection in the worksheet, only the users you’ve designated 
are able to edit the cell range or ranges you’ve defined. Of course, you need to sup-
ply the range password to all the users allowed to do editing in the range or ranges 
at the time you distribute the workbook to them.

FIGURE 1-4:  
Designating 
the range to 
be unlocked 

by a password 
in a protected 

worksheet.

FIGURE 1-5:  
Assigning the 

range title, 
address, and 
password in 

the New Range 
 dialog box.
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Be sure to assign a password to unprotect the worksheet at the time you protect 
the worksheet if you want to prevent unauthorized users from being able to make 
changes to the designated editing ranges in the worksheet. If you don’t, any user 
can make changes by turning off the worksheet protection and thereby gaining 
access to the Allow Users to Edit Ranges command by clicking the Unprotect Sheet 
command button on the Review tab of the Ribbon.

Doing data entry in the unlocked cells  
of a protected worksheet
The best part of protecting a worksheet is that you and your users can jump right 
to unlocked cells and avoid even dealing with the locked ones (which can’t be 

FIGURE 1-6:  
Setting the 

permissions 
for each user in 
the Permissions 

 dialog box.

FIGURE 1-7:  
Getting ready to 

protect the sheet 
in the Allow Users 

to Edit Ranges 
dialog box.
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changed, anyway) by using the Tab and Shift+Tab keys to navigate the worksheet. 
All you have to do is click the Select Locked Cells check box option to deselect it 
when you protect the worksheet. (See “Protecting the worksheet” earlier in this 
chapter.) When you press the Tab key in a protected worksheet when the Select 
Locked Cells option is turned off, Excel jumps the cell cursor to the next unlocked 
cell to the right of the current one in that same row. When you reach the last 
unlocked cell in that row, the program then jumps to the first unlocked cell in 
the rows below. To move back to a previous unlocked cell, press Shift+Tab. When 
Excel reaches the last unlocked cell in the worksheet, it automatically jumps back 
to the very first unlocked cell on the sheet.

You can also press the Enter key to move down the columns instead of across the 
rows. However, pressing the Enter key to progress down a column selects locked 
cells in that column as well as the unlocked ones, whereas pressing the Tab key 
skips all those cells with the Locked protection format.

Figure 1-8 (sample workbook: Spa Holiday Invoice.xltx) illustrates how you can 
put the Tab key to good use in filling out and navigating a protected worksheet. It 
shows a worksheet created from a Spa Holiday Hot Tubs invoice template. Because 
this invoice worksheet in the original template is protected, all worksheets gener-
ated from the template are protected as well. The only cells that are unlocked in 
this sheet are the cells in the following ranges:

 » F4:F6 with the invoice number, date, and customer ID fields

 » C9:C13 with the name, company name, street address, city, state and zip, and 
phone number fields

 » C16:D16 with the salesperson and job fields

 » Cell G16 with the due date field

 » C19:F38 with the quantity, description, and unit price fields

All the rest of the cells in this worksheet are locked and off limits.

To fill in the data for this new invoice, you can press the Tab key to complete the 
data entry in each field such as Invoice No., Date, Customer ID, Name, Company 
Name, Street Address, and so on. By pressing Tab, you don’t have to waste time 
moving through the locked cells that contain headings that you can’t modify any-
way. If you need to back up and return to the previous field in the invoice, just 
press Shift+Tab to go back to the previous unlocked cell.

To make it impossible for the user to select anything but the unlocked cells in the 
protected worksheet, clear the Select Locked Cells check box in the Allow All Users 
of This Worksheet To list box of the Protect Sheet dialog box.
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Protecting the Workbook Structure
There is one last level of protection that you can apply to your Excel files, and that 
is protecting the entire workbook. When you protect the workbook, you ensure 
that its users can’t change the structure of the file by adding, deleting, or even 
moving and renaming any of its worksheets. To protect your workbook, choose 
Review➪  Protect Workbook (or press Alt+RPW).

Excel displays the Protect Structure and Windows dialog box like the one shown 
in Figure 1-9. This dialog box contains two check boxes: Structure (which is auto-
matically selected) and Windows (which is disabled because this feature is no 
longer available). This dialog box also contains a Password (Optional) text box 
where you can enter a password that must be supplied before you can unprotect 
the workbook. Like every other password in Excel, the password to unprotect the 
workbook can be up to 255 characters maximum, consisting of a combination of 
letters, numbers, and spaces, with all the letters being case-sensitive.

FIGURE 1-8:  
Using the Tab 

key to move from 
unlocked cell to 

unlocked cell 
in a protected 

 worksheet. 
 (Sample 

 workbook:  
Spa Holiday 
Invoice.xltx)



Pr
ot

ec
ti

ng
 W

or
kb

oo
ks

 
an

d 
W

or
ks

he
et

 D
at

a

CHAPTER 1  Protecting Workbooks and Worksheet Data      459

When you protect a workbook with the Structure check box selected, Excel pre-
vents you or your users from doing any of the following tasks to the file:

 » Inserting new worksheets

 » Deleting existing worksheets

 » Renaming worksheets

 » Hiding or viewing hidden worksheets

 » Moving or copying worksheets to another workbook

 » Displaying the source data for a cell in a PivotTable or displaying a table’s 
Report Filter fields on separate worksheets (see Book 7, Chapter 2, for details)

 » Creating a summary report with the Scenario Manager (see Book 7, Chapter 1, 
for details)

When you turn on protection for a workbook after selecting the Windows check 
box in the Protect Structure and Windows dialog box, Excel prevents you from 
changing the size or position of the workbook’s windows (not usually something 
you need to control).

After you’ve enabled protection in a workbook, you can then turn it off by choosing 
the Review tab’s Unprotect Workbook command (or by pressing Alt+RPW again). 
If you’ve assigned a password to unprotect the workbook, you must accurately 
reproduce it in the Password text box in the Unprotect Workbook dialog box that 
then appears.

FIGURE 1-9:  
Protecting a 

workbook in the 
Protect Structure 

and Windows 
 dialog box.
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Preparing a Workbook 
for Distribution

Given Excel’s emphasis on saving your workbooks on your OneDrive in 
the cloud, it behooves you to be familiar not only with Excel’s sharing 
 capabilities (discussed at length in the next chapter), but also with its 

capabilities for checking compatibility and digitally signing the document before 
it goes out for review.

In this chapter, you discover how to check your workbook to prepare it for  
distribution. As part of this process, you may want to just add notes on aspects 
of the worksheet and suggest possible changes rather than make these changes 
yourself, or even mark up the worksheet with digital ink if your computer is 
equipped with a graphics tablet or running Excel on some sort of touchscreen 
device. In this chapter, you find out how to get your two cents in by annotating a 
worksheet with text notes that indicate suggested improvements or corrections, 
as well as highlighting potential change areas with ink.

Chapter 2

IN THIS CHAPTER

 » Checking workbook content and 
properties

 » Adding a digital signature

 » Adding notes to a workbook

 » Adding ink annotations to a 
workbook on a touchscreen device
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Getting Your Workbook Ready for Review
The Info screen in the Excel Backstage view (Alt+FI) shown in Figure 2-1 enables 
you to prepare your workbook for distribution by inspecting the properties of your 
workbook. Click the Check for Issues button and then select any of the following 
options:

 » Inspect Document: Opens the Document Inspector, which includes several 
check boxes related to hidden content, workbook metadata (data about the 
document), personal info, and more. The idea here is that you may want to 
remove some or all of this potentially sensitive data before you distribute the 
workbook. Select the check box beside each type of data you want to find, and 
then click Inspect. Excel scours the workbook and then displays the results. 
You can delete any not-safe-for-sharing content that Excel finds by clicking 
that item’s Remove All button.

 » Check Accessibility: Scans the workbook file for information that people with 
disabilities (particularly, some sort of sight impairment) may have difficulty 
with. See Book 4, Chapter 3 for a detailed look at Excel accessibility.

 » Check Compatibility: Checks the workbook file for the following:

• Features that won’t be supported if you open the workbook in an earlier 
version of Excel.

• Features that you’ll lose if you save the workbook in an older Excel file 
format.

The Info screen also contains a Manage Workbook button that, when clicked, gives 
you the following two options for recovering or clearing up draft versions of the 
workbook so that only the final version is available for sharing:

 » Recover Unsaved Workbooks: Enables you to browse all the versions of the 
current workbook that were closed without saving the final changes using 
Excel’s AutoRecover feature. (See Book 2, Chapter 1 for details.)

 » Delete All Unsaved Workbooks: Tells Excel to remove all the versions of the 
current workbook that were closed without saving the final changes. (Again, 
see Book 2, Chapter 1.) If you don’t see this command, it means there are no 
unsaved versions available to delete.

At the very bottom of the Info screen, you find a Browser View Options button 
that, when clicked, opens the Browser View Options dialog box with two tabs: 
Show and Parameters. When you want to share the file online, use the Show tab 
to control what parts of your workbook are displayed; use the Parameters tab to 
control what named cells can be edited.
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Adding properties to a workbook
You can add information about your workbook document (called metadata) in the 
Info panel in the Backstage view, using the various fields displayed in its right 
column (refer to Figure 2-1), which you open by choosing File➪  Info or pressing 
Alt+FI. You can then use the metadata that you enter into the Title, Tags, Catego-
ries, and Author fields in the Info panel in all the Windows quick searches or file 
searches you perform. Doing so enables you to quickly locate the file for opening 
in Excel for further editing and printing or distributing to others to review. When 
entering more than one piece of data into a particular field such as Title, Tags, or 
Categories, separate each piece with a comma.

Click the Show All Properties link to add text boxes for additional document meta-
data fields including Comments, Template, Status, Subject, Hyperlink Base, Com-
pany, and Manager.

Digitally signing a document
Excel enables you to add digital signatures to the workbook files that you send for 
review. After checking the worksheet and verifying its accuracy and readiness for 

FIGURE 2-1:  
Checking a 

 workbook’s 
properties in its 

Info screen in the 
Excel Backstage 

view.
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distribution, you can (assuming that you have the authority within your company) 
digitally sign the workbook in one of two ways:

 » Add a visible signature line as a graphic object in the workbook that contains 
your name, the date of the signing, your title, and, if you have a digital tablet 
connected to your computer or are running Excel on a touchscreen device, 
your inked handwritten signature.

 » Add an invisible signature to the workbook indicated by the Digital Signature 
icon on the status bar and metadata added to the document that verifies the 
source of the workbook.

By adding a digital signature, you warrant the following three things about the 
Excel workbook you’re about to distribute:

 » Authenticity: The person who signs the Excel workbook is the person they 
say they are (and not somebody else posing as the signer).

 » Integrity: The content of the file has not been modified in any way since the 
workbook was digitally signed.

 » Nonrepudiation: The signer stands behind the content of the workbook and 
vouches for its origin.

To make these assurances, the digital signature you add to the workbook must be 
valid in the following ways:

 » The certificate that is associated with the digital signature must be issued to 
the signing publisher by a reputable certificate authority.

 » The certificate must be current and valid.

 » The signing publisher must be deemed trustworthy.

Microsoft partners such as Comodo, GlobalSign, and IdenTrust offer digital ID 
services to which you can subscribe. As reputable certificate authorities, their pro-
tection services vouch for your trustworthiness as a signing publisher and the 
currency of the certificates associated with your digital signatures. In addition, 
they enable you to set the permissions for the workbook that determine who can 
open the document and how they can use it. To sign up with one of these services, 
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display the Insert tab and then, in the Text group, choose Signature Line➪  Add 
Signature Services and then follow the links on the Find Digital ID or Digital Sig-
nature Services web page.

To add a digital signature to your finalized workbook, follow these steps:

1. Inspect the worksheet data, save all final changes in the workbook file, 
and then position the cell pointer in a blank cell in the vicinity where you 
want the signature line graphic object to appear.

Excel adds the signature line graphic object in the area containing the cell 
pointer. If you don’t move the cell cursor to a blank area, you may have to 
move the signature line graphic so that the graphic’s box doesn’t obscure 
existing worksheet data or other graphics or embedded charts.

2. In the Insert tab’s Text group, choose Signature Line➪  Microsoft Office 
Signature Line (or press Alt+NG).

Excel displays the Signature Setup dialog box similar to the one shown in 
Figure 2-2.

3. Type the signer’s name into the Suggested Signer text box and then 
press Tab.

4. Type the signer’s title into the Suggested Signer’s Title text box and then 
press Tab.

5. Type the signer’s e-mail address into the Suggested Signer’s E-Mail 
Address text box.

6. (Optional) If needed, edit the default text in the Instructions to this 
Signer text box.

7. (Optional) Select the Allow the Signer to Add Comments in the Sign Dialog 
check box if you want to add your own comments.

8. (Optional) Deselect the Show Sign Date in Signature Line check box if you 
don’t want the date displayed as part of the digital signature.

9. Click OK to close the Signature Setup dialog box.

Excel adds a signature line graphic object in the vicinity of the cell cursor with a 
big X that contains your name and title (shown in Figure 2-3).
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10. Double-click this signature line graphic object or right-click the object and 
choose Sign.

If you don’t have a digital ID with one of the subscription services, Excel opens 
a Get a Digital ID alert dialog box asking you if you want to get one now. Click 
Yes and then follow the links on the Available Digital IDs web page to subscribe 
to one.

Otherwise, Excel opens the Sign dialog box similar to the one shown in 
Figure 2-3.

11. Add your signature to the list box containing the insertion point.

To add your signature, click the Select Image link on the right, select a graphics 
file that contains a picture of your handwritten signature in the Select 
Signature Image dialog box, and then click Select. If you’re using a touchscreen 
device or your computer has a digital tablet connected to it, you add this 
signature by physically signing your signature with digital ink.

12. Click the Commitment Type drop-down list box and choose one of the 
options from its drop-down menu: Created and Approved This Document, 
Approved This Document, or Created This Document.

If you selected the Allow the Signer to Add Comments in the Sign Dialog check 
box in Step 7, the Sign dialog box contains a Purpose for Signing This 
Document text box that you fill out in Step 12.

13. Click the Purpose for Signing This Document text box and then type the 
reason for digitally signing the workbook.

14. (Optional) Click the Details button to open the Additional Signing 
Information dialog box, where you can add the signer’s role and title as 
well as information on the place where the document was created.

By default, Excel issues a digital certificate for the person whose name is 
entered in the Suggested Signer text box back in Step 3. If you want to use a 
certificate issued to someone else in the organization, follow Step 15. 
Otherwise, proceed to Step 16.

15. (Optional) Click the Change command button to open the Windows 
Security dialog box, click More Choices, click the name of the person 
whose certificate you want to use in the list, and then click OK.

16. Click the Sign button to close the Sign dialog box.

Excel closes the Sign dialog box.

Excel adds your name to the digital signature graphic object and displays the 
MARKED AS FINAL alert at the top of the worksheet as shown in Figure 2-4.
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To display all the information about the digital signature added to the workbook, 
right-click its graphic object and then choose Signature Details from its short-
cut menu. To delete a digital signature from a workbook (which you need to do if 
you discover the sheets in the book require modification), right-click the signa-
ture graphic, click Remove Signature, and then click Yes in the Remove Signature  
dialog box.

FIGURE 2-2:  
Filling out 

the signing 
 information in 
the Signature 

Setup dialog box.

FIGURE 2-3:  
Filling in the 

 signature in the 
Sign dialog box.
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Annotating Workbooks
Even if you don’t save your workbooks on a OneDrive or use Excel on a network, 
you still can annotate your worksheet by adding your notes to the cells of a work-
book that ask for clarification or suggest changes, and then you can distribute 
copies of the workbook by email to other people who need to review and, perhaps, 
respond to your remarks. Excel makes it easy to annotate the cells of a worksheet, 
and the Notes command button’s options on the Review tab of the Ribbon make it 
easy to review these notes prior to emailing the workbook to others who have to 
review the notes, and even reply to suggested changes.

If you’re running Excel on a computer equipped with a digital tablet or on a touch-
screen device such as a Windows tablet, the Review tab of your Ribbon has a Start 
Inking command button (not included on this tab when running Excel on a regular 
PC). When you click the Start Inking command button, Excel adds an Ink Tools 
contextual tab to the Ribbon. You can then use the command buttons on its Pens 
tab to highlight and mark up various parts of the worksheet with digital ink.

FIGURE 2-4:  
The workbook 

after adding the 
digital signature 
line graphic with 

the Signature task 
pane displayed.
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Adding notes
You can add a note to the current cell by clicking the Review tab’s Notes➪  New 
Note command (or by pressing Alt+RTN). Excel responds by adding a Note box 
similar to the ones shown in Figure 2-5 (sample workbook: Income Analysis.xlsx) 
with your name listed at the top (or the name of the person who shows up in the 
User Name text box on the General tab of the Excel Options dialog box). You can 
then type the text of your note in this box. When you finish typing the text of 
the note, click the cell to which you’re attaching the note or any other cell in the 
worksheet to close the Note box.

Don’t confuse Notes with Comments on the Review tab. In earlier versions of 
Excel, notes were called comments. In Excel, comments now refer to threaded 
comments that you can add to cells of a worksheet to promote a discussion of real 
or proposed editing changes with other team members with whom you’ve shared 
the workbook online (see Book 4, Chapter 3). As with online chats, the comments 
you post to a worksheet cell as well as responses made to them by other team 
members appear sequentially in a thread forming the conversation.

Displaying and hiding notes
Excel indicates that you’ve attached a note to a worksheet cell by adding a red 
triangle to the cell’s upper-right corner. To display the Note box with its text, 
position the thick, white-cross mouse pointer on this red triangle, or you can click 
the Review tab’s Notes➪  Show All Notes command (Alt+RTS) to display all notes 
in the worksheet.

FIGURE 2-5:  
Adding notes 

to various cells 
of a  worksheet. 

 (Sample 
 workbook: 

Income  
Analysis.xlsx)
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When you display a note by positioning the mouse pointer on the cell’s red tri-
angle, the note disappears as soon as you move the pointer outside the cell. When 
you display all the notes on the worksheet by clicking the Review tab’s Show All 
Notes command, you must click the Show All Notes button a second time before 
Excel closes their Notes boxes (or press Alt+RTS).

Editing and formatting notes
When you first add a note to a cell, its text box appears to the right of the cell with 
an arrow pointing to the red triangle in the cell’s upper-right corner. If you need 
to, you can reposition a note’s text box and/or resize it so that it doesn’t obscure 
certain cells in the immediate region. You can also edit the text of a note and 
change the formatting of the text font.

To reposition or resize a note’s text box or edit the note text or its font, you make 
the cell current by putting the cell cursor in it and then on the Review tab, click 
the Edit Note option on the Notes command button’s drop-down menu, which 
replaces the New Note option, or press Alt+RTE. (You can also do this by right-
clicking the cell and then choosing Edit Note from the cell’s shortcut menu.)

Whichever method you use, Excel then displays the note’s text box and positions 
the insertion point at the end of the note text. To reposition the text box, posi-
tion the mouse pointer on the edge of the box. When the mouse or Touch pointer 
assumes the shape of a white arrowhead pointing to a black double-cross, you can 
then drag the outline of the text box to a new position in the worksheet. After you 
release the mouse button, Excel draws a new line ending in an arrowhead from 
the repositioned note text box to the red triangle in the cell’s upper-right corner.

When editing and formatting the notes you’ve added to the worksheet, you can do 
any of the following:

 » To resize the note’s text box, you position the mouse pointer on one of the 
open squares at the corners or in the middle of each edge on the box’s 
perimeter. When the mouse pointer changes into a double-headed arrow, you 
drag the handle of the text box until its dotted outline is the size and shape 
you want. (Excel automatically reflows the note text to suit the new size and 
shape of the box.)

 » To edit the text of the note (when the insertion point is positioned somewhere 
in it), drag the I-beam mouse pointer through text that needs to be replaced 
or press the Backspace key (to remove characters to the left of the insertion 
point) or Delete key (to remove characters to the right). You can insert new 
characters in the note to the right of the insertion point by typing them.
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 » To change the formatting of the note text, select the text by dragging the 
I-beam mouse pointer through it and then click the appropriate command 
button in the Font and Alignment groups on the Home tab of the Ribbon. (You 
can use Live Preview to see how a new font or font size, on its respective 
drop-down menu, looks in the note, provided that these drop-down menus 
don’t cover the Note box in the worksheet.)

You can also right-click the text and choose Format Comment from the shortcut 
menu. Doing this opens the Format Comment dialog box (with the same options 
as the Font tab of the Format Cells dialog box) where you can change the font, font 
style, font size, font color, or add special effects including underlining, strike-
through, as well as super- and subscripting.

When you finish making your changes to the note’s text box and text, close the 
Note box by clicking its cell or any of the other cells in the worksheet.

Deleting notes
When you no longer need a note, you can delete it by selecting its cell before you 
do either of the following:

 » In the Home tab’s Editing group, choose Clear   Clear Comments and Notes (or 
press Alt+HEM).

 » Right-click the cell and then choose Delete Note from its shortcut menu.

Marking up a worksheet with digital ink
If you’re running Excel with a computer connected to a digital tablet or on a 
touchscreen, you can mark up your worksheets with digital ink using the com-
mands on the Draw tab of the Ribbon. (The Draw tab is automatically added when 
running Excel on a device with a touch-sensitive display screen.)

By default, Excel chooses the felt tip pen as the pen type for annotating the work-
sheet with digital ink. If you’d prefer to use a ballpoint pen or highlighter in 
marking up the worksheet, tap the Drawing Tools group’s Pen, Pencil, or High-
lighter command. If you don’t have a stylus or digital pen available, tap the Draw 
with Touch command button on the Draw tab and then use your finger to make 
the pen, pencil, or highlighter ink annotations.
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When using the highlighter or either of the two pen types (felt tip or ballpoint 
pen), you can click the pen’s drop-down arrow to select a new line weight for the 
ink by choosing the point size (running from 3/4 all the way up to 6 points) from 
the Thickness section of the drop-down menu. You can also select a new ink color 
(yellow being the default color for the highlighter, red for the felt tip pen, and 
black for ballpoint pen) by selecting its color swatch in the Colors section of the 
drop-down menu.

After you select the pen nib, color, and line weight, you can use your finger or the 
stylus that comes with your digital tablet to mark up the worksheet as follows:

 » To highlight data in the worksheet with the highlighter, drag the highlight 
mouse pointer through the cells (just as though you had an actual yellow 
highlighter in your hand).

 » To circle data in the worksheet with the felt tip pen, drag the pen tip mouse 
pointer around the cells in the worksheet.

 » To add a note with the ballpoint pen, drag the pen tip mouse pointer to write 
your text in the worksheet.

Figure 2-6 (sample workbook: Income Analysis.xlsx) shows a copy of the Income 
Analysis worksheet after I used the Pen: Red command in the Pens group of the 
Draw tab to draw an oval around the range D2:D9 and write the text “Nice Work!!” 
in digital ink.

FIGURE 2-6:  
Adding inked 

notes to a 
 worksheet 

with my finger 
on a Windows 

tablet. (Sample 
 workbook: 

Income  
Analysis.xlsx)
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If you make a mistake with ink, you need to remove it and start over again. To 
delete the ink, select the Drawing Tools group’s Eraser tool and then tap some-
where on the highlighting, drawing, or handwriting you want to erase with the 
eraser mouse pointer. (Sometimes you have to drag through the ink to completely 
remove it.) Then, reselect the highlighter or felt tip or ballpoint pen and reapply 
your ink annotation.

In the Review tab’s Ink group, tap the Hide Ink command button on the Review tab 
(Alt+RH2H) to hide and redisplay the inked comments that you’ve added to your 
worksheet. The first time you tap this menu option when the inked comments 
you’ve added are displayed onscreen, Excel hides them. Tap the Hide Ink option 
again when you want all your inked comments redisplayed in the worksheet.

In the Draw tab’s Replay group, tap the Ink Replay command (or press Alt+JIK) to 
have Excel play back the individual strokes of all the digital inking you’ve done to 
the current worksheet as a quick video. You can tap the Rewind and Forward but-
tons on the video playback controls that appear at the bottom of the Excel work-
sheet display when you select the Ink Replay button to remove and rebuild your 
ink strokes one at a time. You can even drag the Rewind/Forward button (the solid 
circle) in the playback controls to manually scrub through your ink strokes. When 
you’re finished replaying the inked comments, tap the Ink Replay button again to 
remove the playback controls and deselect this command button.

Note that for the Ink Replay command on the Draw tab to work, the inked notes 
you’ve added to the worksheet must be displayed in the Excel worksheet area at 
the time you tap it and not be hidden with the Hide Ink option on the Hide Ink 
command button’s drop-down menu on the Review tab.

After marking a workbook up with your notes, you can then share it with clients 
or coworkers either by sending an email message inviting them to review the 
workbook or actually sending them a copy as an email attachment. (See Book 4, 
Chapter 3 for details.)
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Sharing Workbooks and 
Worksheet Data

Sharing data between Excel and other Windows programs that you use is 
the topic of this chapter. Perhaps the most straightforward way to share 
worksheet data is by sharing an Excel workbook saved in the cloud on your 

OneDrive, on your SharePoint team site, or in a folder in your Dropbox. This co-
authoring sharing process enables you and those with whom you share your 
workbook to see all the editing changes made and saved (automatically with the 
AutoSave feature) to it in real time.

Chapter 3

IN THIS CHAPTER

 » Co-authoring workbooks by sharing 
them with coworkers

 » Sending worksheets as PDF files for 
review and comments

 » Editing Excel worksheets with Excel 
Online

 » Sharing Excel data with other Office 
programs

 » Inserting Excel data into Word and 
PowerPoint documents

 » Making sure your shared workbooks 
are accessible

 » Exporting workbooks as PDF, XPS, 
and HTML (web page) files

 » Exchanging comments with 
collaborators
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In other cases, data sharing involves getting the Excel data stored in ranges, tables, 
and charts into other Office programs that you use, especially Microsoft Word 
documents and PowerPoint presentations. In other cases, data sharing involves 
getting data generated in other programs, such as in tables created in Microsoft 
Word and contacts maintained in Microsoft Outlook, into an Excel worksheet.

Finally, you can give people access to worksheet data using programs other than 
Excel, including Acrobat Reader, the XML Paper Specification Viewer, and their 
own web browsers by saving the workbook in a special PDF, XPS, or HTML file 
format.

Sharing Your Workbooks Online
Excel enables you to share your workbooks with trusted clients and coworkers. 
With Excel’s Share feature, you can send someone a link to an online workbook. 
You can also copy a link to an online workbook and then send the link via a service 
such as instant message or Microsoft Teams Chat.

For a workbook file saved on your OneDrive or SharePoint site, you can configure 
the sharing link to allow editing, which means that you and your collaborators can 
edit the workbook contents simultaneously with Excel on your own devices (or, if 
they don’t have Excel, in their web browsers with the Excel Online web app). This 
process, referred to as co-authoring, enables you to see all the people with whom 
you’ve shared a workbook as well as all the editing changes they make to it as 
soon as the AutoSave feature saves the changes to the file.

Sharing a workbook saved  
on your OneDrive
To share an Excel workbook from your OneDrive, follow these steps:

1. Open the OneDrive workbook file you want to share.

2. Either click the Share button near the upper-right corner of the window 
(or press Alt+ZS) or choose File➪  Share (or press Alt+FZ).

Excel opens the Send Link dialog box, shown in Figure 3-1.

3. (Optional) Click the Anyone with the Link Can Edit button.

Excel opens the Link Settings dialog box, shown in Figure 3-2.

4. Configure the sharing settings.
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By default, Excel allows the people with whom you share your workbooks to 
make editing changes to the workbook that are automatically saved on your 
OneDrive. If you want to restrict your recipients to reviewing the data without 
being able to make changes, deselect the Allow Editing check box.

If you wish to set an expiration date after which the sharing link is no longer 
operational, click the Set Expiration Date button to open the pop-up calendar 
where you select an expiration date by clicking it in the calendar.

To protect the shared workbook with a password, enter the password in the 
Set Password text box.

5. When you’re done with the Link Settings dialog box, click Apply to put 
your new settings into effect and return to the Send Link dialog box.

6. In the To text box, begin typing the email address of the first person with 
whom you want to share the workbook.

As you type, Excel matches the letters with the names and email addresses 
entered in your Address book. When it finds possible matches, they are 
displayed below the input text box, and you can select the person’s email 
address by clicking the button with their name. If the recipient is not in your 
Address book, just type that person’s email address.

7. (Optional) Click the Message text box and type a personal message that 
you want to incorporate as part of the email invitation to share the file.

Otherwise, Excel creates a generic invitation.

8. Click Send.

Excel emails the invitation to share the workbook to each of the recipients 
entered in the To text box.

All the people with whom you share a workbook receive an email containing a 
hyperlink to the workbook on your OneDrive. When they follow this link (and sign 
into the site if this is required), a copy of the workbook opens on a new tab in their 
default web browser using the Excel Online web app. The web app contains a Mode 
drop-down button.

When a coworker with whom you’ve shared the workbook clicks the Mode button 
in Excel Online, they see a menu with the following choices:

 » Viewing: The user can only examine the workbook; they can’t make 
any changes.

 » Editing: The user can make changes to the workbook. Users don’t see this 
option if you shared the workbook with editing disallowed.

 » Open in Desktop App: Opens the workbook in the desktop version of Excel.
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While sharing a workbook with the default Anyone Can Edit option, all changes 
made by the people with whom you’ve shared the workbook are automatically 
saved by the AutoSave feature. If you happen to have the workbook open in 
Excel on your computer with the same worksheet displayed, other users’ editing 
changes automatically appear in your worksheet (in as close to real time as the 
speed of your Internet access provides). Likewise, all the editing changes that you 
make to the workbook in Excel are automatically updated in their workbooks in 
Excel Online. Microsoft refers to this process as co-authoring.

FIGURE 3-1:  
Use the Send 

Link dialog box to 
invite  coworkers 

or clients to 
share an Excel 

 workbook saved 
on OneDrive.

FIGURE 3-2:  
Use the Link 

Settings dialog 
box to customize 

the link you’re 
sharing.
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If a questionable editing change appears in your worksheet when co-authoring 
with a coworker, you can start a comment thread (Review➪  New Comment) that 
communicates your reservations about the change they made. A comment marker 
appears in the upper-right corner of the cell where you made the comment in the 
user’s worksheet in Excel Online. When the coworker clicks this balloon, Excel 
Online displays the text of your comment calling into question their edit in a 
Comments task pane. They can then reply to your reservations by typing their 
explanation for the change in the same comment (or in the Comments task pane) 
and then updating it in your workbook by clicking the Post button. See the last 
section in this chapter, “Collaborating Conversationally with Comments,” about 
working with comment threads.

Copying a sharing link
Excel’s default sharing method  — the Send Link dialog box  — sends to each 
recipient an email invitation with a link to the OneDrive workbook you want to 
co-author with the invitees. However, these days there are many other ways to 
exchange information: text, social media direct messages, the Chat feature of a 
program such as Microsoft Teams or Zoom, and so on. If you’d rather use some-
thing other than email to invite your collaborators, you can have Excel create a 
link to a OneDrive workbook. You can then copy that link address and paste it in 
whatever app or service you want to use to send the invitation to all the people 
who require online review and/or editing access.

To copy and send a link to an online workbook, follow these steps:

1. Open the OneDrive workbook file you want to share.

2. Either click the Share button near the upper-right corner of the window 
(or press Alt+ZS) or choose File➪  Share (or press Alt+FZ).

Excel opens the Send Link dialog box, shown earlier in Figure 3-1.

3. (Optional) To customize the link sharing, click Anyone with the Link Can 
Edit to open the Link Settings dialog box (refer to Figure 3-2), make your 
changes, and then click Apply.

4. Click Copy Link.

Excel creates a link to the workbook, copies the link to the Clipboard, and then 
displays a dialog box similar to the one shown in Figure 3-3.

5. Click Close (X).

6. Paste the copied link into the app or service you want to use to invite 
your collaborators.
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Sharing Your Workbooks via Email
Excel enables you to share your workbooks via email with trusted clients and 
coworkers. With Excel’s Share feature, you can send your collaborators a copy of 
the workbook, either as an Excel file or as a PDF.

Emailing a copy of a workbook
To email a copy of a workbook you have open in Excel to a client or coworker, fol-
low these steps:

1. Open the OneDrive workbook file you want to share.

2. Either click the Share button near the upper-right corner of the window 
(or press Alt+ZS) or choose File➪  Share (or press Alt+FZ).

Excel opens the Send Link dialog box, shown earlier in Figure 3-1.

3. Choose Send a Copy➪  Excel Workbook.

Outlook creates a new email message with your workbook included as a file 
attachment.

4. Address the message, add a subject, and type a message to your 
recipients.

5. Click Send.

Excel emails the workbook to each of the recipients.

FIGURE 3-3:  
When you click 

Copy Link, Excel 
copies the link 
address to the 
Clipboard and 

then displays this 
dialog box.
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Emailing a workbook as a PDF file
Sometimes you may need to share workbooks with clients or coworkers who have 
no knowledge of using Excel but who, nonetheless, need to give you feedback 
about their worksheet data. For those situations, you can have Excel convert the 
workbook file into a PDF that’s then sent as an email attachment. Your recipients 
can then review and comment on the workbook contents using a copy of the Adobe 
Acrobat software (or any other app that can read the PDF file format) on their 
computer. After making their comments in the PDF, they can share or send a copy 
of it in PDF format or even convert it into an Excel file so you can then accordingly 
make whatever changes are necessary in the Excel workbook itself.

To send your Excel workbook file as a PDF, follow these steps:

1. Open the workbook file that contains the worksheet(s) you want 
converted to PDF and sent for comments in Excel.

2. Either click the Share button near the upper-right corner of the window 
(or press Alt+ZS) or choose File➪  Share (or press Alt+FZ).

Excel opens the Send Link dialog box, shown earlier in Figure 3-1.

3. Choose Send a Copy➪  PDF.

Outlook creates a new email message with a PDF conversion of your workbook 
included as a file attachment.

4. Address the message, add a subject, and type a message to your 
recipients.

5. Click Send.

Excel emails the PDF to each of the recipients.

After making their comments directly in the PDF file, your coworkers can save 
their edits and then either send them to you in PDF form as an email attachment 
or first convert the annotated PDF file into an Excel workbook file and send that 
file as an email attachment that can open directly in Excel.

If you receive an email with an annotated PDF file attached to it, open it in your 
copy of Adobe Acrobat and then choose Tools➪  Export PDF➪  Spreadsheet➪  Micro-
soft Excel Workbook to convert the annotated PDF file into an Excel workbook file 
for opening in Excel.
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Sharing Excel Data with Office Programs
You share information between Excel and other programs in two ways: You copy 
or move discrete objects or blocks of data from one program’s file to another, or 
you open an entire file created with one program in the other program.

The key to sharing blocks of data or discrete objects in Excel is the Windows Clip-
board. Remember that Excel always gives you access to the contents of the Clip-
board in the form of the Clipboard task pane, which you can open by clicking the 
dialog box launcher in the lower-right corner of the Home tab’s Clipboard group. 
When the Clipboard task pane is open, you can then copy a Clipboard item — such 
as an object or block of text — into a cell of the open worksheet by clicking the 
item.

Because very few people purchase Excel as a separate program outside the Micro-
soft Office suite, it should be no surprise that most of the file sharing happens 
between Excel and one of the other major applications included in Microsoft Office 
(particularly Word and PowerPoint).

However, before you rush off and start wildly throwing Excel worksheets into 
Word documents and Excel charts into PowerPoint presentations, you need 
to realize that Microsoft offers you a choice in the way that you exchange data 
between your various Office programs. You can either embed the worksheet or 
chart in the other program or set up a link between the Excel-generated object in 
the other program and Excel itself.

 » Embedding means that the Excel object (whether it’s a worksheet or a chart) 
actually becomes part of the Word document or PowerPoint presentation. 
Any changes that you then need to make to the worksheet or chart must be 
made within the Word document or PowerPoint presentation. This presup-
poses, however, that you have Excel on the same device as Word or 
PowerPoint and that that device has sufficient memory to run them both.

 » Linking means that the Excel object (worksheet or chart) is only referenced in 
the Word document or PowerPoint presentation. Any changes that you make 
to the worksheet or chart must be made in Excel itself and then updated 
when you open the Word document or PowerPoint presentation to which it is 
linked.

Use the embedding method when the Excel object (worksheet or chart) is not 
apt to change very often, if at all. Use the linking method when the Excel object 
(worksheet or chart) changes fairly often, when you always need the latest ver-
sion of the object to appear in your Word document or PowerPoint presentation, 
or when you don’t want to make the Word or PowerPoint document any bigger by 
adding the Excel data to it.
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Be aware that when you link an Excel worksheet or chart to another Office doc-
ument and you want to show or print that document on a different device, you 
must copy both the Excel workbook with the linked worksheet/chart and the Word 
or PowerPoint file to it. Also be aware that when you embed an Excel worksheet 
or a chart in another Office document and then want to edit it on another device, 
that device must have both Excel and the other Microsoft Office program (Word or 
PowerPoint) installed on it.

Use the embedding or linking techniques only when you have a pretty good suspi-
cion that the Excel stuff is far from final and that you want to be able to update the 
Excel data either manually (with embedding) or automatically (with linking). If 
your Excel stuff will remain unchanged, just use the old standby method of copy-
ing the Excel data to the Clipboard by choosing Home➪  Copy (or pressing Ctrl+C) 
and then switching to the Word or PowerPoint document and pasting it in place 
by choosing Home➪  Paste (or pressing Ctrl+V).

Excel maintains a very close relationship with Microsoft Access, thus making it 
easy to import data from any of the tables or queries set up for a database into 
your Excel worksheet. For details on how to bring in data from Access, see Book 6, 
Chapter 2.

Sharing data between Excel and Word
Of all the Office programs (besides our beloved Excel), Microsoft Word is the one 
that you are most apt to use. You will probably find yourself using Word to type 
any memos, letters, and reports that you need in the course of your daily work. 
From time to time, you may need to bring some worksheet data or charts that 
you’ve created in your Excel workbooks into a Word document. When those occa-
sions arise, check out the information in the next section.

Although Word has a Table feature that supports calculations through a kind of 
mini-worksheet operation, you’ll probably be more productive if you create the 
data (formulas, formatting, and all) in an Excel workbook and then bring that 
data into your Word document by following the steps outlined in the next section. 
Likewise, although you can keep, create, and manage the data records that you use 
in mail merge operations within Word, you probably will find it more expedient 
to create and maintain them in Excel — considering that you are already familiar 
with how to create, sort, and filter database records in Excel.

Getting Excel data into a Word document
As with all the other Office programs, you have two choices when bringing Excel 
data (worksheet cell data or charts) into a Word document: You can embed the 
data in the Word document, or you can link the data that you bring into Word to 
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its original Excel worksheet. Embed the data or charts when you want to be able 
to edit right within Word. Link the data or charts when you want to be able to edit 
in Excel and have the changes automatically updated when you open the Word 
document.

Happily embedded after
The easiest way to embed a range of worksheet data or a chart is to use the good 
old drag-and-drop method: Drag the selected cells or chart between the Excel and 
Word program windows instead of to a new place in a worksheet. The only trick 
to dragging and dropping between programs is the sizing and maneuvering of the 
Excel and Word program windows themselves. Figures  3-4 (sample workbook: 
Historical and Forecast Sales.xlsx) and 3-5 illustrate the method for dragging a 
table of worksheet data with the 2004 to 2024 historical and forecasted annual 
sales activity from its worksheet (named Annual Sales) into a new Sales memo 
document in Word.

In Figure 3-4, you can see that the Excel window is positioned to the immediate 
right of the Word window. At that point, I had only to select the worksheet data 
in the Excel worksheet and then hold down the Ctrl key (to copy) as I dragged the 
outline over to the new paragraph marker in the memo in the Word document 
window.

FIGURE 3-4:  
Dragging the 

cell range 
A1:B23 from 

the  Historical 
Sales worksheet 

to the Word 
memo (Sample 

 workbook: 
 Historical and 

Forecast Sales.
xlsx).
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As I passed over the border between the Excel and Word program windows, the 
mouse pointer changed shape to the international “oh-no-you-don’t” symbol. 
When I reached the safe havens of the Word document area, however, the pointer 
changed again, this time to the shape of an arrowhead sticking up from a box  
with a plus sign. (How’s that for a description?) To indicate where in the Word 
document to embed the selected data, I positioned the arrowhead-sticking- 
up-from-a-box-with-a-plus-sign pointer at the place in the document where 
I wanted the Excel stuff to appear. Then I released the mouse button. Figure 3-5 
shows you the embedded worksheet table that appeared after I released the mouse 
button.

You can also use the copy-and-paste method to embed worksheet data into a 
Word document. Select the cells in Excel and then copy them to the Clipboard 
by clicking the Home tab’s Copy button (or press Ctrl+C). Then, open the Word 
document and position the cursor at the place where the worksheet table is to 
appear. In Word’s Home tab, click the Paste button’s drop-down arrow and then 
click Paste Special (or press Alt+HVS). In the Paste Special dialog box that appears, 
as shown in Figure 3-6, click Microsoft Excel Worksheet Object in the As list and 
then click OK. Word embeds the data in the body of the Word document just as 
though you had Ctrl+dragged the data from the Excel window over to the Word 
window.

FIGURE 3-5:  
Word memo 

after copying the 
 worksheet data.
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Editing embedded stuff
The great thing about embedding Excel data (as opposed to linking, which I get 
to in the next section) is that you can edit the data within Word itself. Figure 3-7 
shows the table after I centered it and widened it (by dragging a sizing handle). 
Notice what happens when I double-click the embedded table (or right-click the 
table and then choose Worksheet Object➪  Edit from the shortcut menu): A frame 
with Excel’s familiar column and row headers, scroll bars, and the gridlines of 
Excel’s worksheet area appear. Notice, too, that Word’s Ribbon has been tem-
porarily replaced by Excel’s Ribbon. At this point, you can edit any of the table’s 
contents by using the Excel commands that you already know.

The links that bind
Of course, as nice as embedding is, you will encounter occasions when linking the 
Excel data to the Word document is the preferred method (and, in fact, even easier 
to do). First, select the data in Excel. Note that you select a chart created in the 
worksheet by single-clicking it, not double-clicking it, as you would do to edit the 
chart in the worksheet. Then, in Excel’s Home tab, click Copy to send the data to 
the Clipboard.

In Word, position the insertion point at the beginning of the paragraph where 
the data needs to be. On the Home tab, click the Paste drop-down arrow and then 
click Paste Special. (You can also do this by pressing Alt+HVS.) In the Paste Special 
dialog box that appears (see Figure 3-8) select the Paste Link option button, use 
the As list to select the type of data you’re pasting, such as Microsoft Excel Chart 
Object, and then click OK. Figure 3-9 shows the Word memo after I clicked OK and 
pasted the Excel chart into place.

FIGURE 3-6:  
With the  

copy-and-paste 
method, use the 

Paste Special 
dialog box to tell 
Word what type 

of data you’re 
embedding.
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Editing linked data
Editing data linked to Excel (as a chart or range) is not quite as delightful as edit-
ing embedded worksheet data. For one thing, you first have to go back to Excel and 
make your changes — although you can easily open Excel and its workbook just 
by double-clicking the linked chart. The nice thing, however, is that any changes 
that you make to the original data or chart are immediately reflected in the Word 
document the moment you open it.

FIGURE 3-7:  
Editing the 
embedded 

 worksheet sales 
data from within 
the Word memo.

FIGURE 3-8:  
To link data, 

select the Paste 
Link option 

in Word’s 
Paste  Special 

 dialog box.
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Sharing data between Excel  
and PowerPoint
The process of embedding and linking worksheet data and charts in the slides of 
your Microsoft PowerPoint presentations is very similar to the techniques I out-
lined for Word in the last few sections. To embed a range or chart, drag the data or 
chart object from the Excel worksheet to the PowerPoint slide. If you prefer using 
the cut-and-paste method, copy the data or chart to the Clipboard (Ctrl+C), switch 
to PowerPoint, click the Home tab’s Paste drop-down arrow, and then click Paste 
Special (or press Alt+HVS). In the As list, select Microsoft Excel Worksheet Object, 
select the Paste option button, and then click OK.

If you want to link Excel data or a chart that you pasted into a PowerPoint pres-
entation slide to its source Excel workbook, the only thing you do differently is to 
click the Paste Link option button in the Paste Special dialog box.

Sometimes, after making changes to the linked data or chart in Excel, you need to 
manually update the link in the PowerPoint presentation slide to ensure that your 
presentation has the latest-and-greatest version of the Excel data. To manually 
update a linked table of Excel worksheet data or a linked chart, go to the slide 
in question, right-click the table or chart, and then choose Update Link from its 
shortcut menu.

FIGURE 3-9:  
A linked chart 

pasted into the 
Word memo.
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Figure 3-10 illustrates how easy it is to edit an Excel chart that is embedded in a 
PowerPoint slide. To edit the data within PowerPoint, click the chart on the slide. 
The PowerPoint Ribbon then adds the Chart Design and Format contextual tabs 
so that you can use their command buttons to make your changes. (See Book 5, 
Chapter 1 to find out to create and edit Excel charts.)

Making Shared Workbooks Accessible
Are your eyes, ears, or limbs not working as well as they once did? Or perhaps 
you’ve always faced challenges with your eyesight, hearing, or dexterity. Even if 
you don’t have these types of issues, did you know that, according to the World 
Health Organization, 15 percent of the world’s population identify as having a dis-
ability? That’s an eye-popping number and it means that if you share your work-
books with other people, there’s a good chance that someone (or likely several 
someones) will be trying to review your work with a visual, auditory, or mobility 
impairment. So, it’s important to take a bit of extra time before clicking “Share” 
to make sure your workbooks are accessible to everyone who will review them. 
Fortunately, as the following sections show, making Excel data accessible takes a 
minimum of effort.

FIGURE 3-10:  
Editing an 

embedded 
Excel chart in a 

 PowerPoint slide.
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Some useful accessibility guidelines  
and tweaks
To get your accessibility enhancements off to a good start, you can apply these few 
simple dos and don’ts to your workbooks before sharing them:

 » Organize your worksheets and worksheet content in a logical order. 
Screen readers go through your worksheets from left to right and they read 
worksheet content from left to right and from top to bottom. Make sure you 
organize your data so that this reading order makes sense to the reviewer.

 » Add alternative text to images. If you use visuals — such as charts, pictures, 
videos, and shapes — to convey information in your worksheet, add alterna-
tive text to help reviewers who can’t see the visuals. I show you how to add 
alternative text in the next section.

 » Don’t use visuals to convey important text. You can use visuals such as 
shapes and SmartArt graphics to convey text, but you run the risk of having 
some reviewers unable to see the visual and, hence, the text. Move the text 
out of the visual and into the worksheet where everyone can access it. If you 
really want to keep the visual, either repeat the text in the worksheet or add 
alternative text to the visual.

 » Don’t use red text for negative numbers. The color-blind or visually 
impaired may not be able to see the red, so always denote a negative number 
using either a minus sign (-) or parentheses.

 » Don’t use a worksheet background color or image that make the text 
hard to read. Always strive for a decent amount of contrast between the text 
color and the background color. The easiest way to achieve this is to use the 
default white background and apply the Automatic option (black) for text 
color.

 » Give your worksheet tabs descriptive names. Screen readers say the name 
of the active worksheet, so you’re doing visually impaired reviewers a big favor 
by making your sheet names descriptive enough to accurately summarize the 
sheet content.

 » Delete blank worksheets. To make it easier to navigate your workbook, 
remove any blank worksheets.

 » Make your tables accessible. An accessible table is one that’s easy for a 
screen reader to parse. That means having descriptive column headings (and 
descriptive row headings if you use them); no blank cells; no merged or split 
cells; and no nested tables.
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Adding alternative text to graphics
Adding visuals such as charts, pictures, videos, shapes, and SmartArt is great for 
both sprucing up an otherwise drab worksheet and for conveying information in 
an interesting way. Unfortunately, some of the people reviewing your Excel data 
won’t be able to see those visuals, so the bits of information the visuals are meant 
to convey are lost.

You can go a long way to solving this problem by adding alternative text, or alt 
text. Alt text is a short description of the visual. A screen reader that comes upon 
a visual element that includes alt text reads that text aloud. So even though the 
reviewer may not be able to see the visual, your alt text lets that person know what 
the visual is all about.

Before I show you how to add alt text to Excel’s visual elements, here are a few 
points to bear in mind when writing alt text:

 » The purpose of alt text is to tell the reviewer the purpose and content of 
the visual.

 » Keep alt text relatively short: one or two sentences is usually more than enough.

 » You can keep things concise and pithy by remembering that you don’t need to 
describe everything visible in the image. Instead, just state what the visual is 
meant to convey and describe the key elements of the visual.

 » Be as precise and as unambiguous as you can.

 » Don’t include in your alt text any text that’s already on the worksheet.

 » Don’t start the alt text with phrases such as “A visual of. . .” or “A picture that 
shows. . .”.

Here are the steps to follow to add alt text to a picture, shape, icon, SmartArt 
graphic, or chart:

1. Select the visual.

If the visual contains editable text (or editable elements, such as a chart or 
SmartArt graphic), selecting the visual usually means clicking one of its borders. 
You’re really trying here to make sure you’re not opening the visual for editing.

Excel displays the Format contextual tab which, depending on the type of 
visual, could be named Format, Graphics Format, or Picture Format.

2. In the Format contextual tab’s Accessibility group, click Alt Text.

Alternatively, right-click the visual and then click Edit Alt Text, or in the Review 
tab, choose Check Accessibility➪  Alt Text.

Excel displays the Alt Text pane.
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3. (Optional) If the visual is for decoration purposes only, select the Mark as 
Decorative check box and don’t bother writing any alt text.

If a visual isn’t meant to convey any information relevant to your worksheet, do 
your screen-reader-using reviewers a favor by marking the visual as decorative. 
The screen reader tells the reviewer that the visual is decorative and contains 
no important information.

4. Write your alt text in the large text box, as shown in Figure 3-11 (sample 
workbook: Historical and Forecast Sales.xlsx).

5. Click Close (X) to hide the Alt Text pane.

Running the Accessibility Checker
The accessibility enhancements I listed earlier in the “Some useful accessibility 
guidelines and tweaks” aren’t hard to implement, but they can be hard to remem-
ber. Fortunately, you can get Excel to do the hard work for you by remembering 
just one thing: to run the Accessibility Checker, which is a tool that scours a work-
book for accessibility issues such as missing alt text, missing column and/or row 
headings in a table, poor text color contrast, and much more.

To run the Accessibility Checker, display the Review tab and click the top half of 
the Check Accessibility button. Excel opens the Accessibility pane, which includes 
an Inspection Results section that lists any accessibility issues that need fixing 
(see Figure 3-12).

FIGURE 3-11:  
Use the Alt Text 

pane to compose 
your alternative 
text for a visual 

element, such as 
a chart. (Sample 

workbook: 
 Historical and 

Forecast  
Sales.xlsx)
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Rather than running the Accessibility Checker manually, you can have it running 
full-time in the background. That way, Excel alerts you immediately if an edit or 
a format change runs afoul of the Accessibility Checker. In the Accessibility pane, 
select the Keep Accessibility Checker Running While I Work check box. Alterna-
tively, choose File➪  Options to open the Excel Options dialog box, display the Ease 
of Access tab, select the Keep Accessibility Checker Running While I Work check 
box, and then click OK.  If Excel finds any accessibility issues, you see the text 
Accessibility: Investigate on the Status bar. Click that text to open the Accessibility 
pane and see the problem.

Exporting Workbooks to Other  
Usable File Formats

Sometimes you may need to share Excel data with coworkers and clients who 
don’t have Excel installed on their computers. It’s hard to imagine a coworker or 
client getting by without Excel, but it does happen. For those rare occasions, you 
can export your Excel workbook to one of four usable file formats for opening and 
printing with readily available software programs that support them:

 » PDF files for opening with Adobe Reader or Adobe Acrobat

 » XPS files for opening with the XML Paper Specification Viewer or a newer web 
browser

FIGURE 3-12:  
If the Accessibility 
Checker discovers 
one or more ways 

you can make 
your worksheet 
more inclusive, 
it lists them in 

the Accessibility 
pane.
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 » ODS files for opening with open-source spreadsheet program LibreOffice Calc

 » HTML files for opening with all types and versions of web browsers

When converting an Excel workbook to one of these other file formats, you can 
either change the file type in the Save As dialog box, or you can export them from 
the Export screen in the Backstage view.

Saving and exporting worksheets  
as PDF files
The PDF (Portable Document File) file format, developed by Adobe Systems Incor-
porated, enables people to open and print documents without any access to the 
original programs with which the documents were created. All they then need 
installed to be able to open and print the worksheet-as-PDF file is a copy of Adobe 
Reader (a free download from www.adobe.com), a copy of Adobe’s Acrobat soft-
ware, or a third-party app that can open PDF files.

Excel enables you to save your workbook files directly in this special PDF file for-
mat. To save a workbook as a PDF file, choose File➪  Save As or File➪  Save a Copy 
(Alt+FA), select the place where you want to save the new PDF file in the Save As 
screen, and then select PDF (*.pdf) from the Save as Type drop-down list.

You can modify the filename and the drive and folder in which the new PDF file is 
saved and click More Options to change any of the following options added to the 
bottom of the Save As dialog box:

 » Optimize For: Select the Standard (Publishing Online and Printing) option for 
the highest fidelity; select the Minimum Size (Publishing Online) option to 
compress the resulting PDF document for use on the web.

 » Open File after Publishing: Select this check box to have Excel automatically 
open the new PDF file in your copy of Adobe Reader or Acrobat.

 » Options: Click this button to open the Options dialog box where you can select 
the part of the workbook or worksheet to publish and choose to not have the 
document properties and accessibility tags included in the resulting PDF file.

After you designate the filename and file location and select your PDF file options, 
click the Save button to have Excel save the workbook (or some part of it) in a new 
PDF file.

Besides saving your workbook file in the PDF file format using the Save As dia-
log box, you can also accomplish the same thing from the Export screen. Choose 
File➪  Export, click Create PDF/XPS, and then click the Create PDF/XPS button to 

http://www.adobe.com/
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open the Publish as PDF or XPS dialog box. In the Publish as PDF or XPS (which 
pretty much looks and acts like the Save As dialog box when PDF is selected as the 
file type), PDF is automatically selected as the file format type, and you can then 
use the Folder list box, File Name text box, and PDF options (in a slightly different 
order) as needed before clicking the Publish button to save the PDF file version of 
your Excel workbook.

If you create an Excel workbook that incorporates new features not supported in 
earlier versions of Excel, instead of saving the workbook as an .xls file, thereby 
losing all its up-to-date enhancements, consider saving it as a PDF file so that 
coworkers still using pre-2007 Excel versions can still have access to the data in 
all its glory via the Adobe Reader.

Saving worksheets as XPS files
The XPS (XML Paper Specification) file format also enables people to open and 
print Excel worksheets without access to the Excel program. As with the PDF for-
mat, you can convert a workbook to an XPS file either in the Save As dialog box 
opened from the Save As screen (Alt+FA) or in the Publish as PDF or XPS dialog box 
opened from the Export screen by clicking the Create PDF/XPS button (Alt+FEPA).

From either dialog box, you need to choose XPS Document as the file format from 
the Save as Type drop-down menu. And in either dialog box, you have access (in a 
slightly different order) to Optimize For option buttons, Open File After Publish-
ing check box, and the Options command button for controlling the file size and 
what to do after it’s created.

After choosing XPS Document as the file type, if you don’t need to edit the file-
name (Excel automatically appends .xps to the current filename) or the folder 
location, click the Save button (in the Save As dialog box) or Publish button (in the 
Publish as PDF or XPS dialog box), and Excel saves the workbook in an XPS file.

If you want Excel to automatically open the new XPS file for your inspection in 
Microsoft Edge or the XPS Viewer, make sure that the Open File after Publishing 
check box is selected before you click the Publish button.

By default, the Standard (Publishing Online and Printing) option button is selected 
in the Optimize For section at the bottom of the Publish as PDF or XPS dialog box. 
If you want to make your XPS file version of the worksheet smaller for view-
ing online, click the Minimum Size (Publishing Online) option button before you 
click the Publish button. Also, if you need to restrict which parts of the current 
workbook are included in the new XPS file or don’t want nonprinting information 
included in the resulting file, open the Options dialog box by clicking the Options 
button and select the part of the workbook or worksheet to publish and choose 
which nonprinting information to omit from the resulting XPS file.
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Saving worksheets as ODS files
ODS (OpenDocument Spreadsheet) is the default spreadsheet file format that 
LibreOffice Calc, the spreadsheet program that comes with the open source and 
completely free LibreOffice suite, uses. To save your Excel workbook in this file 
format, choose the OpenDocument Spreadsheet (*.ods) option at the very bottom 
of the Save as Type drop-down list in the Excel Save As dialog box.

LibreOffice Calc can open native Excel workbook files (either .xls or .xlsx) just 
as Excel can open .ods files without any prior conversion.

Saving worksheets as HTML files
If converting your worksheets to PDF or XPS files is way too complex for your 
needs, you can save your worksheets as good old HTML files for viewing and 
printing in anybody’s web browser (as well as for publishing to your website). 
To save

1. Choose File➪  Save As (or File➪  Save a Copy) or press Alt+FA to open the 
Save As screen in the Backstage view.

Here you select the place into which to save the HTML file.

2. Select the drive and folder where you want the web version of the 
workbook saved.

Excel opens the Save As dialog box with the drive and folder you just desig-
nated open and selected.

3. Choose Single File Web Page or Web Page from the Save as Type drop-
down menu.

The Single File Web Page file format creates a web page archive file (using the 
.mht file extension) that contains all the data needed for the workbook. The 
Web Page file format creates an HTML file containing whichever worksheets 
you choose to include.

When you select either web page option, Excel expands the Save As dialog box 
to include the Entire Workbook (selected by default) and Selection: Sheet 
option buttons along with the Page Title text box and Change Title command 
button.

Next, you need to give a new filename to your web page in the File Name text 
box. Note that Excel automatically appends the filename extension .htm (for 
Hypertext Markup page) to whatever filename you enter here. When selecting 
a filename, keep in mind that some file servers (especially those running some 
flavor of UNIX) are sensitive to upper- and lowercase letters in the name.
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4. Enter the filename for the new HTML file in the File Name text box.

By default, Excel selects the Entire Workbook option button, meaning that all 
the worksheets in the workbook that contain data will be included in the new 
HTML file. To save only the data on the current worksheet in the HTML file, you 
need to take Step 5.

5. (Optional) If you want only the current worksheet saved in the new HTML 
file, select the Selection: Sheet option button.

If you want, you can have Excel add a Page title to your new HTML file by taking 
Step 6. The page appears centered at the top of the page right above your 
worksheet data. Don’t confuse the page title with the web page header that 
appears on the web browser’s title bar — the only way to set the web page 
header is to edit this HTML tag after the HTML file is created.

6. (Optional) If you want to add a page title to your HTML file, click the 
Change Title button and then type the text in the Page Title text box in 
the Set Page Title dialog box before you click OK.

You’re now ready to save your workbook as an HTML file by clicking the Save 
button. If you want to see how this file looks in your web browser immediately 
upon saving it, click the Publish button to open the Publish as Web Page dialog 
box and save the file from there after selecting the Open Published Web Page 
in Browser check box. And if you want Excel to automatically save an HTML 
version of the worksheet each time you save the workbook, you select the 
AutoRepublish Every Time This Workbook Is Saved check box as well.

7. Click the Save button to save the file without opening it in your web 
browser. Otherwise, click the Publish button so that you can see the web 
page in your browser right after saving it.

If you click the Save button, Excel closes the Save As dialog box, saves the file to 
disk, and returns to the Excel window (that now contains the HTML version of 
your workbook or worksheet in place of the original .xls file).

If you click the Publish button to view the new HTML file in your browser, Excel 
opens the Publish as Web Page dialog box, where you select the Open 
Published Web Page in Browser check box before clicking the Publish button.

8. Click the Open Published Web Page in Browser check box and then click 
the Publish button.

When you click the Publish button, Excel closes the Publish As Web Page dialog 
box, saves the worksheet as an HTML file, and then immediately launches your 
default web browsing program while at the same time opening the new HTML 
file in the browser. After you finish looking over the new HTML file in your web 
browser, click its program window’s Close button to close the browser and 
HTML file and to return to Excel and the original worksheet.
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If you add the Web Page Preview and Web Options commands as custom buttons 
to the Quick Access toolbar, you can use them to preview how a worksheet will 
appear as a web page locally in your web browser as well as control a whole vari-
ety of web page save options. To add these buttons, open the Customize the Quick 
Access Toolbar tab of the Excel Options dialog box (Alt+FTQ) and then add the Web 
Page Preview and Web Options from Commands Not in the Ribbon section. (See 
Book 1, Chapter 2 for details.)

Collaborating Conversationally  
with Comments

Adding a note to a cell (see Book 4, Chapter 2) is a useful way to both annotate a 
workbook for your own purposes and to supply information to other people with 
whom you share the workbook. Similarly, workbook reviewers can use cell notes 
to provide feedback, make suggested corrections, and so on.

In a sharing context, the problem with notes is that they only go one way: You can 
offer information to your reviewers, and they can offer you feedback, but there’s 
no real give-and-take here. One solution would be to have each reviewer record 
their feedback in an email, which enables you to respond to that feedback, the 
reviewer then responds back, and so on.

That’s fine, but feedback is most useful when it appears in the proper context. That 
is, if someone has a question, suggestion, or correction related to a workbook’s 
cell value, you’ll understand that feedback more readily not only if it appears 
within that workbook but if it’s attached to the cell in question.

To create a feedback conversation linked to a specific cell, you insert a comment, 
which is a separate section of text that’s associated with a particular cell. That 
sounds just like a note, I know, but the key difference is that you can reply to a 
comment, the reviewer can reply to your reply, and so on, and the entire conver-
sation is linked to the original cell.

Inserting a comment
To insert a comment, follow these steps:

1. Select the cell you want to comment on.

2. Choose Review➪  New Comment.

Excel displays a purple comment indicator in the upper-right corner of the cell 
and displays a text box for entering a comment.
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3. Use the Start a Conversation text box to type the comment, as shown in 
Figure 3-13.

You can supply multiline feedback by pressing Enter at the end of a line.

4. Click Post Comment or press Ctrl+Enter.

Excel posts the comment to the cell.

Displaying and hiding comments
Excel indicates that you’ve attached a comment to a worksheet cell by adding a 
purple flag to the cell’s upper-right corner. To display the Note box with its text, 
you position the thick, white-cross mouse pointer within the cell, or you can click 
the Review tab’s Show Comments command (Alt+RH1) to open the Comments 
pane, which displays all the comments.

When you display a comment by positioning the mouse pointer over the cell, the 
comment disappears as soon as you move the pointer outside the cell. When you 
display all the comments on the worksheet by clicking the Review tab’s Show 
Comments command, you must click the Show Comments button a second time, 
or click the Comment’s pane’s Close button (X).

Editing a comment
To edit your comment text, first either hover the mouse pointer over the cell to 
display the Comment box or choose Review➪  Show Comments to open the Com-
ments pane. Click the comment’s More Thread Actions icon (the three dots in the 
upper-right corner of the Comment box), and then click Edit Comment. Edit your 
comment text and then click Save (the check mark button).

FIGURE 3-13:  
Use this dialog 

box to type 
and post your 

comment.
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Replying to a comment
The whole point of Excel’s Comments feature is to create a conversation between 
yourself and one or more workbook reviewers. If you’ve been tasked to review a 
workbook, or if your reviewers have supplied some comment feedback, then it’s your 
turn to respond. Excel gives you two ways to reply to a comment in a particular cell:

 » Hover the mouse pointer over the cell to display the Comment box or choose 
Review➪  Show Comments to open the Comments pane.

 » Right-click the cell that contains the comment and then click Reply to 
Comment.

Type your response in the Reply text box (see Figure 3-14), and then click Post 
Reply (or press Ctrl+Enter).

Deleting a comment
When you no longer need a comment, you can delete it by selecting its cell before 
you do any of the following:

 » Either hover the mouse pointer over the cell to display the Comment box or 
choose Review➪  Show Comments to open the Comments pane. Click the 
comment’s More Thread Actions icon (the three dots in the upper-right corner 
of the Comment box), and then click Delete Comment.

 » In the Home tab’s Editing group, choose Clear➪  Clear Comments and Notes 
(or press Alt+HEM).

 » Right-click the cell and then click Delete Comment from its shortcut menu.

FIGURE 3-14:  
Use this dialog 

box to type and 
post a comment 

reply.
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Charting 
Worksheet Data

Charts present the data from your worksheet visually by representing the 
data in rows and columns as bars on a chart, for example, or as pieces of a 
pie in a pie chart. For a long time, charts and graphs have gone hand-in- 

hand with spreadsheets because they enable you to see trends and patterns that 
you often can’t glean from the numbers alone. Which has more consistent sales, 
the Southeast region or the Northwest region? Monthly sales reports may contain 
the answer, but a bar chart based on the data shows it more clearly.

In this chapter, you first become familiar with the terminology that Excel uses 
as it refers to the parts of a chart — terms that may be new, such as data marker 
and chart data series, as well as terms that are probably familiar already, such as 
axis. After you get acquainted with the terms, you begin to put them to use going 
through the steps required to create the kind of chart that you want, either as part 
of the worksheet or as a separate chart sheet.

Chapter 1

IN THIS CHAPTER

 » Understanding how to chart 
worksheet data

 » Creating an embedded chart or one 
on its own chart sheet

 » Editing an existing chart

 » Formatting the elements in a chart

 » Saving customized charts as 
templates and using these templates 
to create new charts

 » Adding sparklines to worksheet data

 » Printing a chart alone or with its 
supporting data
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The art of preparing a chart (and much of the fun) is matching a chart type to 
your purposes. To help you with this, I guide you through a tour of all the chart 
types available in Excel, from old standbys, such as bar and column charts, to 
more modern chart types with which you may be less familiar, such as Treemap, 
Funnel, Waterfall, and Box and Whisker charts. Finally, you discover how to print 
charts, either alone or as part of the worksheet.

Worksheet Charting 101
The typical Excel chart is comprised of several distinct parts. Figure  1-1  
(sample workbook: CG Music with Chart Sheet.xlsx) shows an Excel clustered  
column chart added to a worksheet with labels identifying the parts of this chart. 
Table 1-1 summarizes the parts of the typical chart.

FIGURE 1-1:  
A typical 

 clustered column 
chart  containing 

a variety of 
 standard chart 

 elements. 
 (Sample 

 workbook: CG 
Music with Chart 

Sheet.xlsx)
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Embedded charts versus separate  
chart sheets
An embedded chart appears in a worksheet, which is almost always the same work-
sheet that contains the chart data. Embedding a chart next to its data enables you 
to compare the raw data with its visualization in the chart.

TABLE 1-1 Parts of a Typical Chart
Part Description

Chart area Everything inside the chart window, including all parts of the chart (labels, axes, data 
markers, tick marks, and other elements in this table).

Data marker A symbol on the chart that represents a single value in the worksheet. A symbol may be a 
column in a column chart, a slice in a pie chart, or a line on a line chart. Data markers with 
the same shape or pattern represent a single data series in the chart.

Chart 
data series

A group of related values, such as all the values in a single row in the chart — all the 
quarterly sales for Rock CDs in the sample chart, for example. A chart can have just one 
data series (shown in a single bar or line), but it usually has several.

Series formula A formula describing a given data series. The formula includes a reference to the cell that 
contains the data series name, references to worksheet cells containing the categories and 
values plotted in the chart, and the plot order of the series. The series formula can also 
have the actual data used to plot the chart. You can edit a series formula and control the 
plot order.

Axis A line that serves as a major reference for plotting data in a chart. In two-dimensional 
charts, there are two axes: the x (horizontal/category) axis and the y (vertical/value) axis. 
In most two-dimensional charts (except, notably, bar charts), Excel plots categories (labels) 
along the x-axis and values (numbers) along the y-axis. Bar charts reverse the scheme, 
plotting values along the y-axis. Pie charts have no axes. Three-dimensional charts have an 
x-axis, a y-axis, and a z-axis. The x- and y-axes delineate the horizontal surface of the chart. 
The z-axis is the vertical axis, showing the depth of the third dimension in the chart.

Tick mark A small line intersecting an axis. A tick mark indicates a category, scale, or chart data series. 
A tick mark can have a label attached.

Plot area The area where Excel plots your data, including the axes and all markers that represent 
data points.

Gridlines Optional lines extending from the tick marks across the plot area, thus making it easier to 
view the data values represented by the tick marks.

Chart text A label or title that you add to the chart. Attached text is a title or label linked to an axis 
such as the Chart Title, Vertical Axis Title, and Horizontal Axis Title that you can’t move 
independently of the chart. Unattached text is text that you add such as a text box with the 
Text Box command button on the Insert tab of the Ribbon.

Legend A key that identifies patterns, colors, or symbols associated with the markers of a chart 
data series. The legend shows the data series name corresponding to each data marker 
(such as the name of the red columns in a column chart).
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Note that your charts don’t have to be embedded. You can also choose to create 
a chart in a separate sheet called (no surprises here) a chart sheet. Embed a chart 
on the worksheet when you want to be able to view or share the chart along with 
its supporting worksheet data. Place a chart on its own sheet when you prefer to 
share the chart separately from its worksheet data (because, for example, the raw 
data isn’t relevant or the worksheet contains data you don’t want others to see).

All charts (embedded or on their own sheets) are dynamically linked to the work-
sheet that they represent. This means that if you modify any of the values that are 
plotted in the chart, Excel immediately redraws the chart to reflect the change, 
assuming that the worksheet still uses automatic recalculation. When Manual 
recalculation is turned on, you must press F9 or click the Formulas tab’s Calcu-
late Now button (or press Alt+MB) to get Excel to redraw the chart to reflect any 
changes to the chart’s underlying worksheet values.

You can print any chart that you’ve embedded in a worksheet by itself without any 
worksheet data (as though it were created on its own chart sheet) by selecting it 
before you open the Print dialog box.

Inserting recommended charts
My personal favorite way to create a new embedded chart from selected data in 
a worksheet in Excel is with the Insert tab’s Recommended Charts command (or 
press Alt+NR).

Excel opens the Insert Chart dialog box with the Recommended Charts tab selected 
similar to the one shown in Figure 1-2 (sample workbook: CG Music with Chart 
Sheet.xlsx). Here, you can preview how the selected worksheet data will appear in 
different types of charts by clicking a thumbnail in the list box on the left. When 
you find the type of chart you want to create, click OK to embed the chart in the 
current worksheet.

MOVING AN EMBEDDED CHART ONTO  
ITS OWN CHART SHEET
If it’s important that the chart remain a separate element in the workbook, you can 
move the embedded chart onto its own chart sheet. Click the embedded chart if it’s 
not already selected in the worksheet and then click the Chart Design tab’s Move Chart 
command. Excel then opens the Move dialog box, where you then click the New Sheet 
option button and click OK to move the embedded chart to a new chart sheet.
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Inserting specific chart types  
from the Ribbon
In the Insert tab’s Charts group, to the right of the Recommended Charts button, 
Excel displays drop-down buttons with galleries for creating the following types 
and styles of charts:

 » Insert Column or Bar Chart: Graphs your data as a 2-D or 3-D vertical 
column or horizontal bar chart.

 » Insert Hierarchy Chart: Graphs your data in a Treemap or Sunburst hierar-
chy chart.

 » Insert Waterfall, Funnel, Stock, Surface, or Radar Chart: Graphs your data 
as a 2-D waterfall, funnel, or stock chart (using typical stock symbols), 2-D or 
3-D surface chart, or 3-D radar chart.

 » Insert Line or Area Chart: Graphs your data as a 2-D or 3-D line or area 
chart.

 » Insert Statistic Chart: Graphs your data as a 2-D histogram or box and 
whisker chart.

 » Insert Combo Chart: Graphs your data as a 2-D combo clustered column and 
line chart or clustered column and stacked area chart.

 » Insert Pie or Doughnut Chart: Graphs your data as a 2-D or 3-D pie chart or 
2-D doughnut chart.

 » Insert Scatter (X, Y) or Bubble Chart: Graphs your data as a 2-D scatter (X, Y) 
or bubble chart.

FIGURE 1-2:  
Insert Chart 

 dialog box 
with the 

 Recommended 
Charts tab 

selected. (Sample 
 workbook: CG 

Music with Chart 
Sheet.xlsx)
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 » Maps: Graphs your data as a 2-D filled map chart.

 » PivotChart: Graphs your data as a PivotChart. (See Book 7, Chapter 2 for 
more on creating this special type of interactive summary chart.)

When a gallery attached to any of these chart buttons is displayed, hover the 
mouse pointer over a chart type to preview your data as that style of chart. When 
you find a chart type that strikes your fancy, click the chart type icon to embed the 
chart in your worksheet.

If you’re not sure what type of chart best represents your data, rather than go 
through the different chart type buttons, you can use the All Charts tab of the 
Insert Chart dialog box shown in Figure 1-3 to “try out” your data in different 
chart types and styles. You can open the Insert Chart dialog box either by clicking 
Recommended Charts or by clicking the dialog box launcher in the lower-right 
corner of the Charts group, and then display the complete list of chart types by 
clicking the All Charts tab.

Excel includes some unusual chart types that you can preview and select from the 
All Charts tab in the Insert Chart dialog box. These chart types include:

 » Treemap: Shows hierarchical data in a tree-like structure using nested 
rectangles of different colors representing the branches and sub-branches 

FIGURE 1-3:  
Open the Insert 

Chart dialog box 
and then use 
the All Charts 

tab to see Excel’s 
complete lineup 

of chart types.



Ch
ar

ti
ng

 
W

or
ks

he
et

 D
at

a

CHAPTER 1  Charting Worksheet Data      509

within related data. Treemap charts provide a great way to represent very 
large amounts of hierarchical data in a very compact space.

 » Box & Whisker: Shows the spread and skew within an ordered data set or 
within two sets of data compared to one another. The Box and Whisker chart 
depicts five variables within the groups of data: maximum, upper quartile, 
median, lower quartile, and minimum. The maximum and minimum values 
are represented as thin vertical and horizontal lines (the whiskers) above and 
below a rectangle (the box) depicting the upper and lower quartiles with a 
horizontal dividing line that represents the median.

 » Waterfall: Shows the effect of sequential intermediate values that increase or 
decrease on initial values in the data set. The intermediate values showing the 
increase or decrease can either be based on time or on different categories. 
Values in the data are represented by floating columns of various sizes and colors.

 » Funnel: Shows the progressive reduction within an ordered data set as a 
percentage of the whole represented as different colored slices within an 
inverted triangle (creating a funnel shape). Funnel charts, like pie charts, do 
not have an X- and Y-axis.

Inserting charts with the  
Quick Analysis tool
For those times when you need to select a subset of a range as the data to be 
charted (as opposed to selecting a single cell within a data), you can use the Quick 
Analysis tool to create your chart. Just follow these steps:

1. Select the data you want to chart.

2. Click the Quick Analysis tool that appears at the lower-right corner of the 
selected range, then click the Charts tab at the top of the Quick Analysis 
options palette.

Excel displays buttons for different types of charts that suit the selected data, 
such as Column, Stacked Bar, and Clustered Bar, followed by a More button. 
The different types of chart buttons preview the selected data in that kind of 
chart. The final More button opens the Insert Chart dialog box with the 
Recommended Charts tab selected. Here you can preview and select a chart 
from an even wider range of chart types.

3. To preview each type of chart that Excel can create using the selected 
data, hover the mouse pointer over the chart type button in the Quick 
Analysis palette.

As you hover over each chart type, Excel’s Live Preview feature displays a large 
thumbnail of the chart that will be created from your table data. Figure 1-4 
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shows an example (sample workbook: CG Music with Chart Sheet.xlsx). This 
thumbnail appears above the Quick Analysis options palette for as long as the 
mouse or Touch pointer is over its corresponding button.

4. Click the chart type you want to use.

Excel then creates and inserts an embedded chart of the selected type in the 
current worksheet. This embedded chart is active so that you can immediately 
move it and edit it as you wish.

Creating a chart on a separate chart sheet
Sometimes you know you want your new chart to appear on its own separate sheet 
in the workbook, and you don’t have time to fool around with moving an embed-
ded chart to its own sheet. In such a situation, position the cell pointer somewhere 
in the range of data to be graphed (or select the specific cell range in a larger 
range) and then press F11.

Excel creates a clustered column chart using the range data or cell selection on 
its own chart sheet (named Chart1 for the first chart sheet, then Chart 2, Chart 3, 
and so on) as shown in Figure 1-5 (sample workbook: CG Music with Chart Sheet.
xlsx). You can then customize the chart on the new chart sheet as you would an 
embedded chart that’s described later in the chapter.

FIGURE 1-4:  
Previewing the 

embedded chart 
to insert from the 

Quick Analysis 
tool. (Sample 

workbook:  
CG Music with 

Chart Sheet.xlsx)
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Refining the chart from  
the Chart Design tab
When you click a chart to select it, you can use the tools on the Chart Design con-
textual tab to make all kinds of changes to your new chart. This tab contains the 
following groups:

 » Chart Layouts: Click the Add Chart Element button to select the type of chart 
element you want to add. (You can also do this by selecting the Chart 
Elements button in the upper-right corner of the chart itself.) Click the Quick 
Layout button and then click the thumbnail of the new layout style you want 
applied to the selected chart on the drop-down gallery.

 » Chart Styles: Click the Change Colors button to open a drop-down gallery and 
then select a new color scheme for the data series in the selected chart. In the 
Chart Styles gallery, highlight and then click the thumbnail of the new chart 
style you want applied to the selected chart. Note that you can select a new 
color and chart style in the opened galleries by clicking the Chart Styles button 
in the upper-right corner of the chart itself.

 » Data: Click Switch Row/Column to immediately interchange the worksheet 
data used for the Legend Entries (Series) with that used for the Axis Labels 
(Categories) in the selected chart. Click Select Data to open the Select Data 
Source dialog box, where you can not only modify which data is used in the 
selected chart but also interchange the Legend Entries (Series) with the Axis 
Labels (Categories), but also edit, delete, or add particular entries to either 
category.

FIGURE 1-5:  
Clustered column 

chart created 
on its own chart 

sheet. (Sample 
workbook: CG 

Music with Chart 
Sheet.xlsx)
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 » Type: Click Change Chart Type to change the type of chart and then click the 
thumbnail of the new chart type on the All Charts tab in the Change Chart 
dialog box, which shows all kinds of charts in Excel.

 » Location: Click Move Chart to open the Move Chart dialog box, where you 
move an embedded chart to its own chart or move a chart on its own sheet to 
one of the worksheets in the workbook as an embedded chart.

Modifying the chart layout and style
As soon as Excel draws a new chart in your worksheet, the program selects your 
chart and adds the Chart Design contextual tab. You can then use the Quick Layout 
and Chart Styles galleries to further refine the new chart.

Figure 1-6 (sample workbook: CG Music with Chart Sheet.xlsx) shows the origi-
nal clustered column chart (created in Figure 1-5) after selecting Layout 9 on the 
Quick Layout button’s drop-down gallery and then selecting the Style 8 thumb-
nail on the Chart Styles drop-down gallery. Selecting Layout 9 adds Axis Titles to 
both the vertical and horizontal axes as well as creating the Legend on the right 
side of the graph. Selecting Style 8 gives the clustered column chart its dark back-
ground and contoured edges on the clustered columns themselves.

FIGURE 1-6:  
Clustered column 

chart on its own 
chart sheet after 

selecting a new 
layout and style 
from the Design 

tab. (Sample 
workbook:  

CG Music with 
Chart Sheet.xlsx)
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Switching the rows and columns in a chart
Normally when Excel creates a new chart, it automatically graphs the data by rows 
in the cell selection so that the column headings appear along the horizontal (cat-
egory) axis at the bottom of the chart and the row headings appear in the legend 
(assuming that you’re dealing with a chart type that utilizes an x- and y-axis).

Select the chart to display the Chart Design contextual tab, and then click the 
Switch Row/Column command to switch the chart so that row headings appear on 
the horizontal (category) axis and the column headings appear in the legend (or 
you can press Alt+JCW).

Figure 1-7 (sample workbook: CG Music with Chart Sheet.xlsx) demonstrates how 
this works. This figure shows the clustered column chart from Figure 1-5 after 
selecting the Switch Row/Column command button on the Design tab. Now, col-
umn headings (Qtr 1, Qtr 2, Qtr 3, and Qtr 4) are used in the legend on the right 
and the row headings (Genre, Rock, Jazz, Classical, and Other) appear along the 
horizontal (category) axis.

TRYING ON ALL YOUR CHOICES IN THE 
CHART STYLES GALLERY
When using the Chart Styles gallery to select a new style for your chart, you can display 
all the style choices by clicking that gallery’s More button (the one with the horizontal 
bar directly over a triangle pointing downward). Doing this displays the thumbnails of 
all your layout and style choices for the new chart. You can also scroll through the rows 
of style choices by clicking the Previous Row or Next Row buttons immediately above it 
with the respective upward- or downward-pointing triangles.

FIGURE 1-7:  
The clustered 
column chart 

after switching 
the columns and 

rows. (Sample 
workbook: CG 

Music with Chart 
Sheet.xlsx)
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Editing the source of the data graphed  
in the chart
When you select the chart to display the Chart Design contextual tab and then 
click the Select Data command (or press Alt+JCE), Excel opens the Select Data 
Source dialog box similar to the one shown in Figure 1-8 (sample workbook: CG 
Music with Chart Sheet.xlsx), which corresponds to the chart layout shown earlier 
in Figure 1-5. The controls in this dialog box enable you to make the following 
changes to the source data:

 » Modify the range of data being graphed in the chart by clicking the Chart Data 
Range text box and then making a new cell selection in the worksheet or 
typing in its range address.

 » Switch the row and column headings back and forth by clicking its Switch 
Row/Column button.

 » Edit the labels used to identify the data series in the legend or on the horizon-
tal (category) by clicking the Edit button on the Legend Entries (Series) or 
Horizontal (Categories) Axis Labels side and then selecting the cell range with 
appropriate row or column headings in the worksheet.

 » Add additional data series to the chart by clicking the Add button on the 
Legend Entries (Series) side and then selecting the cell containing the heading 
for that series in the Series Name text box and the cells containing the values 
to be graphed in that series in the Series Values text box.

 » Delete a label from the legend by clicking its name in the Legend Entries 
(Series) list box and then clicking the Remove button.

 » Modify the order of the data series in the chart by clicking the series name in 
the Legend Entries (Series) list box and then clicking the Move Up button (the 
one with the arrow pointing upward) or the Move Down button (the one with 
the arrow pointing downward) until the data series appears in the desired 
position in the chart.

 » Indicate how to deal with empty cells in the data range being graphed by 
clicking the Hidden and Empty Cells button and then selecting the appropriate 
Show Empty Cells As option button (Gaps, the default; Zero or Connect Data 
Points with Line, for line charts). Click the Show Data in Hidden Rows and 
Columns check box to have Excel graph data in the hidden rows and columns 
within the selected chart data range.
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Customizing chart elements from  
the Format tab
When you select a chart, Excel displays the Format contextual tab, which offers 
tools for customizing the elements of your chart. Table 1-2 shows you the options 
that appear on the Format tab. Note that depending on the type of chart that’s 
selected at the time, some of these options may be unavailable.

Customizing the elements of a chart
The Chart Elements button (with the plus sign icon) that appears in the upper-
right corner of your chart when it’s selected contains a list of the major chart 
elements that you can add to your chart. To add a particular element missing 
from the chart, select the element’s check box in the list to put a check mark in 
it. To remove a particular element currently displayed in the chart, deselect the 
element’s check box to remove its check mark.

FIGURE 1-8:  
Using the Select 

Data Source 
 dialog box to 

remove the 
empty Genre 

label from the 
legend of the 

clustered column 
chart. (Sample 
workbook: CG 

Music with Chart 
Sheet.xlsx)

ADDING HIDDEN ROWS AND COLUMNS  
OF DATA TO A CHART
If you have hidden rows or columns in your data, Excel excludes that data from the 
chart. If you decide that you want to see the hidden data in the chart, all you have to do 
is open the Select Data Source dialog box (by clicking the Chart Design tab’s Select Data 
button) and then click its Hidden and Empty Cells command button. Excel then opens a 
Hidden and Empty Cell Settings dialog box, where you select the Show Data in Hidden 
Rows and Columns check box and then click OK. Excel then immediately redraws the 
chart adding your hidden rows and columns.
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TABLE 1-2 Format Tab Options
Tab Group Tool Name Click the Tool To

Current Selection Chart Elements Select a new chart element by choosing its name from the button’s 
drop-down menu.

Format Selection Open a Format task pane for the currently selected chart element as 
displayed on the Chart Elements drop-down list button.

Reset to 
Match Style

Remove all custom formatting from the selected chart and return 
it to the original formatting bestowed by the style selected for 
the chart.

Insert Shapes Gallery Add a shape to your chart from the drop-down gallery with a whole 
bunch of preset graphic shapes. (See Book 5, Chapter 2 for details.)

Change Shape This command is disabled in this context.

Shape Styles Shape Styles Display a drop-down gallery in which you can preview and select 
new colors and shapes for the currently selected chart element as 
displayed on the Chart Elements drop-down list button.

Shape Fill Display a drop-down color palette in which you can preview and 
select a new fill color for the currently selected chart element as 
displayed on the Chart Elements drop-down list button.

Shape Outline Display a drop-down color palette in which you can preview and 
select an outline color for the currently selected chart element as 
displayed on the Chart Elements drop-down list button.

Shape Effects Display a drop-down menu containing a variety of graphics effect 
options (including Shadow, Glow, Soft Edges, Bevel, and 3-D 
Rotation), many of which have their own pop-up palettes that allow 
you to preview their special effects, where you can select a new 
graphics effect for the currently selected chart element as displayed 
on the Chart Elements drop-down list button.

WordArt Styles Quick Styles Display a drop-down WordArt gallery in which you can preview and 
select a new WordArt text style for the titles selected in the chart. If 
the Chart Area is the currently selected chart element as displayed 
on the Chart Elements drop-down list button, the program applies 
the WordArt style you preview or select to all titles in the chart.

Text Fill Display a drop-down color palette in which you can preview and 
select a new text fill color for the titles selected in the chart. If the 
Chart Area is the currently selected chart element as displayed on 
the Chart Elements drop-down list button, the program applies the 
WordArt style you preview or select to all titles in the chart. You can 
also select an image to be used as the text fill rather than a color by 
selecting the Picture option below the color palette.

Text Outline Display a drop-down color palette in which you can preview and 
select a new text outline color for the titles selected in the chart. If 
the Chart Area is the currently selected chart element as displayed 
on the Chart Elements drop-down list button, the program applies 
the WordArt style you preview or select to all titles in the chart.
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To add or remove just part of a particular chart element or, in some cases as with 
the Chart Title, Data Labels, Data Table, Error Bars, Legend, and Trendline, to 
also specify its layout, you select the desired option on the element’s continuation 
menu. Figure 1-9 (sample workbook: CG Music with Chart Sheet.xlsx) shows the 
layout options for the Legend element.

Tab Group Tool Name Click the Tool To

Text Effects Display a drop-down menu with the Shadow, Reflection, Glow, Bevel, 
3-D Rotation, and Transform graphics effect options active, each of 
which have their own pop-up palettes that you can use to preview 
and select special effects for the titles selected in the chart. If the 
Chart Area is the currently selected chart element as displayed on 
the Chart Elements drop-down list button, the program applies the 
WordArt style you preview or select to all titles in the chart.

Accessibility Alt Text Display the Alt Text task pane, in which you can add alternative text 
that describes the purpose and results of the chart for reviewers 
who use a screen reader. (See Book 4, Chapter 3 for more.)

Arrange Bring Forward Move the object to a higher layer in the stack or choose the Bring 
to Front option from the button’s drop-down menu to bring the 
selected embedded chart or other graphic object to the top of its 
stack. (See Book 5, Chapter 2 for details.)

Send Backward Move the object to a lower level in the stack or choose the Send to 
Back option from the button’s drop-down menu to send the selected 
embedded chart or other graphic object to the bottom of its stack. 
(See Book 5, Chapter 2 for details.)

Selection Pane Display and hide the Selection and Visibility task pane that shows 
all the graphic objects in the worksheet and enables you to hide 
and redisplay them as well as promote or demote them to different 
layers. (See Book 5, Chapter 2 for details.)

Align Display a drop-down menu that enables you to snap the selected 
chart to an invisible grid on another graphic object as well as to 
choose between a number of different alignment options when 
multiple graphic objects are selected. (See Book 5, Chapter 2 
for details.)

Group This command is disabled in this context.

Rotate This command is disabled in this context.

Size Shape Height Modify the height of the selected embedded chart by typing a new 
value in it or selecting one with the spinner buttons.

Shape Width Modify the width of the selected embedded chart by typing a new 
value in it or selecting one with the spinner buttons.
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So, for example, to reposition a chart’s legend, you click the continuation button 
attached to Legend on the Chart Elements menu to display and select from among 
the following options on its continuation menu:

 » Right: Positions the legend so that it appears to the right of the plot area

 » Top: Positions the legend so that it appears above the plot area

 » Left: Positions the legend so that it appears to the left of the plot area

 » Bottom: Positions the legend so that it appears below the plot area

 » More Options: Opens the Format Legend task pane on the right side of the 
Excel window so you can use the options that appear to modify almost any 
aspect of the legend’s formatting.

Adding data labels to the series in a chart
Data labels identify the data points in your chart (that is, the columns, lines, and 
so forth used to graph your data) by displaying values from the cells of the work-
sheet represented next to them. To add data labels to your selected chart and 
position them, click the Chart Elements button next to the chart and then select 
the Data Labels check box before you select one of the following options on its 
continuation menu:

 » Center to position the data labels in the middle of each data point

 » Inside End to position the data labels inside each data point near the end

 » Inside Base to position the data labels at the base of each data point

FIGURE 1-9:  
Repositioning 

the chart legend 
in the example 

clustered column 
using the Chart 

Elements Legend 
item. (Sample 

workbook:  
CG Music with 

Chart Sheet.xlsx)
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 » Outside End to position the data labels outside of the end of each data point

 » Data Callout to add text labels as well as values that appear within text boxes 
that point to each data point

 » More Options to open the Format Data Labels task pane on the right side 
where you can use the options that appear when you select the Fill & Line, 
Effects, Size & Properties, and Label Options buttons under Label Options and 
the Text Fill & Outline, Text Effects, and Textbox buttons under Text Options in 
the task pane to customize almost any aspect of the appearance and position 
of the data labels

To remove all data labels from the data points in a selected chart, clear the Data 
Labels check box on the Chart Elements menu.

Adding a data table to a chart
Sometimes, instead of data labels that can easily obscure the data points in the 
chart, you’ll want Excel to draw a data table beneath the chart showing the work-
sheet data it represents in graphic form.

To add a data table to your selected chart and position and format it, click the 
Chart Elements button next to the chart and then select the Data Table check box 
before you select one of the following options on its continuation menu:

 » With Legend Keys to have Excel draw the table at the bottom of the chart, 
including the color keys used in the legend to differentiate the data series in 
the first column

 » No Legend Keys to have Excel draw the table at the bottom of the chart 
without any legend

 » More Options to open the Format Data Table task pane on the right side 
where you can use the options that appear when you select the Fill & Line, 
Effects, Size & Properties, and Table Options buttons under Table Options and 
the Text Fill & Outline, Text Effects, and Textbox buttons under Text Options in 
the task pane to customize almost any aspect of the data table

Figure 1-10 (sample workbook: CG Music with Chart Sheet.xlsx) illustrates how 
the sample clustered column chart (introduced in Figure 1-5) looks with a data 
table added to it. This data table includes the legend keys as its first column.

If you decide that having the worksheet data displayed in a table at the bottom of 
the chart is no longer necessary, click to deselect the Data Table check box on the 
Chart Elements menu.
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Editing the chart titles
When Excel first adds any title to a new chart, the program gives it a generic 
name, such as Chart Title or AXIS TITLE (for both the x- and y-axis title). To 
replace such generic titles with the actual chart titles, click the title in the chart 
or click the name of the title on the Chart Elements drop-down list. (Chart Ele-
ments is the first drop-down button in the Current Selection group on the Format 
contextual tab. Its text box displays the name of the element currently selected in 
the chart.) Excel lets you know that a particular chart title is selected by placing 
selection handles around its perimeter.

After selecting a title, you can then click the insertion point in the text and then 
edit as you would any worksheet text, or you can triple-click to select the entire 
title and completely replace it with the text you type. To force part of the title onto 
a new line, click the insertion point at the place in the text where the line break is 
to occur. After the insertion point is positioned in the title, press Enter to start a 
new line. After you finish editing the title, click somewhere else on the chart area to 
deselect it (or a worksheet cell, if you’ve finished formatting and editing the chart).

Double-click anywhere in a word in the chart title to completely select that word. 
Triple-click anywhere in the title text to completely select that chart title. When 
you double- or triple-click a chart title, a mini-bar appears above the title with 
buttons for modifying the selected text’s font, font size, and alignment, as well as 
for adding text enhancements such as bold, italic, and underlining.

If you want, you can instantly create a title for your chart by linking it to a heading 
that’s been entered into one of the cells in your worksheet. That way, if you update 
the heading in the worksheet, it’s automatically updated in your chart. To link a 
chart title to a heading in a worksheet cell, click the title in the chart to select it, 

FIGURE 1-10:  
Clustered column 

chart on its own 
Chart sheet 

with data table 
and legend 

keys. (Sample 
 workbook: CG 

Music with Chart  
Sheet.xlsx)
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then type = on the Formula bar, click the cell in the worksheet that contains the 
text you want to use as the chart title, and press Enter. Excel shows that the chart 
title is now dynamically linked to the contents of the cell by displaying its absolute 
cell reference whenever that title is selected in the chart.

Formatting elements of a chart
Excel offers you several methods for formatting particular elements of any chart 
that you create. The most direct way is to right-click the chart element (title, plot 
area, legend, data series, and so forth) in the chart itself. Excel displays a mini-bar 
with options such as Fill, Outline, and (in the case of chart titles), Style. You can 
then use the drop-down galleries and menus attached to these buttons to connect 
the selected chart element.

If the mini-bar formatting options aren’t sufficient for the kind of changes you 
want to make to a particular chart element, you can open a task pane for the ele-
ment. The easiest way to do this is by right-clicking the element in the chart and 
then selecting the Format option at the bottom of the shortcut menu that appears. 
This Format option, like the task pane that opens on the right side of the work-
sheet window, is followed by the name of the element selected so that when the 
Chart Title is selected, this menu option is called Format Chart Title, and the 
task pane that opens when you select this option is labeled Format Chart Title, as 
shown in Figure 1-11 (sample workbook: CG Music with Chart Sheet.xlsx).

FIGURE 1-11:  
Formatting the 
Chart Title with 

the options in 
the Format Chart 

Title task pane. 
(Sample  

workbook: CG 
Music with Chart  

Sheet.xlsx)
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The element’s task pane contains groups of options, often divided into two cat-
egories: Options for the selected element on the left — such as Title Options in 
the Format Chart Title task pane or Legend Options in the Format Legend task 
pane — and Text Options on the right. Each group, when selected, then displays 
its own cluster of buttons and each button, when selected has its own collection 
of formatting options, often displayed only when expanded by clicking the option 
name.

You can click the drop-down button found to the immediate right of any Options 
group in any Format task pane to display a drop-down menu with a complete list 
of all the elements in that chart. To select another element for formatting, select 
its name from this drop-down list. Excel then selects that element in the chart 
and switches to its Format task pane so that you have access to all its groups of 
formatting options.

The Format contextual tab also contains a Shape Styles and WordArt Styles group 
of command buttons that you can sometimes use to format the element you’ve 
selected in the chart. Table 1-2, shown earlier in this chapter, gives you the low-
down on the command buttons in these groups on the Format tab.

Formatting chart titles with the  
Format Chart Title task pane
When you choose the Format Chart Title option from a chart title’s shortcut 
menu, Excel displays a Format Chart Title task pane similar to the one shown in  
Figure 1-11. The Title Options group is automatically selected as is the Fill & Line 
button (with the paint can icon).

As shown in Figure 1-11, there are two groups of Fill & Line options: Fill and Bor-
der (neither of whose particular options are initially displayed when you first open 
the Format Chart Title task pane — in this figure, I clicked both Fill and Border so 
that you could see all of the Fill options and the first part of the Border options). 
Next to the Line & Fill button is the Effects button (with the pentagon icon). This 
button has four groups of options associated with it: Shadow, Glow, Soft Edges, 
and 3-D Format.

You would use the formatting options associated with the Fill & Line and Effects 
buttons in the Title Options group when you want to change the look of the text 
box that contains the selected chart title. More likely when formatting most chart 
titles, you will want to use the commands found in the Text Options group to 
actually change the look of the title text.

When you click Text Options in the Format Chart Title task pane, you find three 
buttons with associated options:
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 » Text Fill & Outline (with a filled A with an outlined underline at the bottom 
icon): When selected, it displays a Text Fill and Text Outline groups of options 
in the task pane for changing the type and color of the text fill and the type 
of outline.

 » Text Effects (with the outlined A with a circle at the bottom icon): When 
selected, it displays a Shadow, Reflection, Glow, Soft Edges, and 3-D Format 
and 3-D Rotation groups of options in the task pane for adding shadows to 
the title text or other special effects.

 » Textbox (with the A in the upper-left corner of a text box icon): When 
selected, it displays a list of Text Box options for controlling the vertical 
alignment, text direction (especially useful when formatting the Vertical 
[Value] Axis title), and angle of the text box containing the chart title. It also 
includes options for resizing the shape to fit the text and how to control any 
text that overflows the text box shape.

Formatting chart axes with the  
Format Axis task pane
The axis is the scale used to plot the data for your chart. Most chart types have 
axes. All 2-D and 3-D charts have an x-axis known as the horizontal axis and 
a y-axis known as the vertical axis with the exception of pie charts and radar 
charts. The horizontal x-axis is also referred to as the category axis and the ver-
tical y-axis as the value axis except in the case of XY (Scatter) charts, where the 
horizontal x-axis is also a value axis just like the vertical y-axis because this type 
of chart plots two sets of values against each other.

When you create a chart, Excel sets up the category and values axes for you auto-
matically, based on the data you are plotting. You can then adjust the axes in var-
ious ways. The most common ways you will want to modify the category axis of 
a chart is to modify the interval between its tick marks and where it crosses the 
value axis in the chart. The most common ways you will want to modify a value 
axis of a chart is to change the scale that it uses and assign a new number format-
ting to its units.

To make such changes to a chart axis in the Format Axis task pane, right-click 
the axis in the chart and then select the Format Axis option at the very bot-
tom of its shortcut menu. Excel opens the Format Axis task pane with the Axis 
Options group selected, displaying its four command buttons: Fill & Line, Effects, 
Size & Properties, and Axis Options. You then select the Axis Options button (with 
the clustered column data series icon) to display its four groups of options: Axis 
Options, Tick Marks, Labels, and Number.
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Then, click Axis Options to expand and display its formatting options for the par-
ticular type of axis selected in the chart. Figure 1-12 (sample workbook: CG Music 
with Chart Sheet.xlsx) shows the formatting options available when you expand 
this and the vertical (value) or y-axis is selected in the sample chart.

The Axis Options for formatting the Vertical (Value) Axis include:

 » Bounds to determine minimum and maximum points of the axis scale. Use 
the Minimum option to reset the point where the axis begins — perhaps 
$4,000 instead of the default of $0 — by entering a value higher than 0.0 in its 
text box. Use the Maximum to determine the highest point displayed on the 
vertical axis entering the new maximum value in its text box. Note that data 
values in the chart greater than the value you specify here aren’t displayed in 
the chart.

 » Units to change the units used in separating the tick marks on the axis. Use 
the Major option to modify the distance between major horizontal tick marks 
(assuming they’re displayed) in the chart by entering the number of the new 
distance in its text box. Use the Minor option to modify the distance between 
minor horizontal tick marks (assuming they’re displayed) in the chart by 
entering the number of the new distance in its text box.

 » Horizontal Axis Crosses to reposition the point at which the horizontal axis 
crosses the vertical axis by clicking the Axis Value option button and then 
entering the value in the chart at which the horizontal axis is to cross or by 
clicking the Maximum Axis Value option button to have the horizontal axis 
cross after the highest value, putting the category axis labels at the top of the 
chart’s frame.

FIGURE 1-12:  
Formatting the 
Vertical (Value) 

Axis with the 
options in the 

Format Axis task 
pane. (Sample 

workbook:  
CG Music with 

Chart Sheet.xlsx)
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 » Logarithmic Scale to base the value axis scale upon powers of ten and 
recalculate the Minimum, Maximum, Major Unit, and Minor Unit accordingly 
by selecting its check box to put a check mark in it. Enter a new number in its 
text box if you want the logarithmic scale to use a base other than 10.

 » Values in Reverse Order to place the lowest value on the chart at the top of 
the scale and the highest value at the bottom (as you may want to do in a 
chart to emphasize the negative effect of the larger values) by selecting its 
check box to put a check mark in it.

The Axis Options for formatting the Horizontal (Category) Axis include

 » Axis Type to indicate for formatting purposes that the axis labels are text 
entries by clicking the Text Axis option button or indicate that they are dates 
by clicking the Date Axis option button.

 » Vertical Axis Crosses to reposition the point at which the vertical axis crosses 
the horizontal axis by clicking the At Category Number option button. Then 
enter the number of the category in the chart (with 1 indicating the leftmost 
category) after which the vertical axis is to cross or by clicking the At Maximum 
option button to have the vertical axis cross after the very last category on the 
right edge of the chart’s frame.

 » Axis Position to reposition the horizontal axis so that its first category is 
located at the vertical axis on the left edge of the chart’s frame and the last 
category is on the right edge of the chart’s frame by selecting the On Tick 
Marks option button rather than between the tick marks (the default setting).

 » Categories in Reverse Order to reverse the order in which the data markers 
and their categories appear on the horizontal axis by clicking its check box to 
put a check mark in it.

The Tick Marks options in the Format Axis task pane include the following two 
options whether the Horizontal (Category) Axis or the Vertical (Value) Axis is 
selected:

 » Major Type to change how the major horizontal or vertical tick marks 
intersect the opposite axis by selecting the Inside, Outside, or Cross option 
from its drop-down list.

 » Minor Type to change how the minor horizontal or vertical tick marks 
intersect the opposite axis by selecting the Inside, Outside, or Cross option 
from its drop-down list.

Note that when modifying the Horizontal (Category) Axis, Excel offers an Interval 
Between Marks Tick Marks option that enables you to change the span between 
the tick marks that appear on this x-axis.
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In addition to changing y- and x-axis formatting settings with the options found 
in the Axis Options and Tick Marks sections in the Format Axis task pane, you can 
modify the position of the axis labels with the Label Position option under Labels 
and number formatting assigned to the values displayed in the axis with Category 
option under Number.

To reposition the axis labels, click Labels in the Format Axis task pane to expand 
and display its options. When the Vertical (Value) Axis is the selected chart ele-
ment, you can use the Label Position option to change the position to left of the 
chart’s plot area by selecting the Low option, to right of the chart’s plot area by 
selecting the High option, or to completely remove their display in the chart by 
selecting the None option on its drop-down list.

When the Horizontal (Category) Axis is selected, you can also specify the Interval 
between the Labels on this axis, specify their Distance from the Axis (in pixels), 
and even modify the Label Position with the same High (above the chart’s plot 
area), Low (below the chart’s plot area), and None options.

To assign a new number format to a value scale (General being the default), click 
Number in the Format Axis task pane to display its formatting options. Then, 
select the number format from the Category drop-down list and specify the num-
ber of decimal places and symbols (where applicable) as well as negative number 
formatting that you want applied to the selected axis in the chart.

Saving a customized chart as a template
After going through extensive editing and formatting of one of Excel’s basic chart 
types, you may want to save your work of art as a custom chart type that you can 
then use again with different data without having to go through all the painstak-
ing steps to get the chart looking just the way you want it. Excel makes it easy to 
save any modified chart that you want to use again as a custom chart type.

To convert a chart on which you’ve done extensive editing and formatting into a 
custom chart type, you take these steps:

1. Right-click the customized chart in the worksheet or on its chart sheet to 
select its chart area and display its shortcut menu.

You can tell that the chart area (as opposed to any specific element in the 
chart) is selected because the Format Chart Area option appears near the 
bottom of the displayed shortcut menu.

2. Choose the Save As Template option from the shortcut menu.

Excel opens the Save Chart Template dialog box. The program automatically 
suggests Chart1.crtx as the filename, Chart Template Files (*.crtx) as the file 
type, and the Charts folder in the Microsoft Templates folder as the location.
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3. Edit the generic chart template filename in the File Name text box to give 
the chart template file a descriptive name without removing the .crtx 
filename extension.

4. Click the Save button to close the Save Chart Template dialog box.

After creating a custom chart template in this manner, you can then use the tem-
plate anytime you need to create a new chart that requires similar formatting by 
following these steps:

1. Select the data in the worksheet to be graphed in a new chart using your 
chart template.

2. On the Insert tab, click the dialog box launcher in the lower-right corner 
of the Charts group.

The Insert Chart dialog box appears with the Recommended Charts tab 
selected.

3. Click the All Charts tab and then select the Templates option in the 
Navigation pane of the Insert Chart dialog box.

Excel then displays thumbnails for all the chart templates you’ve saved in the 
main section of the Create Chart dialog box. To identify these thumbnails by 
filename, position the mouse pointer over the thumbnail image.

4. Click the thumbnail for the chart template you want to use to select it 
and then click OK.

As soon as you click OK, Excel applies the layout and all the formatting saved as 
part of the template file to the new embedded chart created with the data in the 
current cell selection.

Adding Sparkline Graphics to a Worksheet
Excel supports a type of information graphic called sparklines that represents 
trends or variations in collected data. Sparklines — invented by Edward Tufte — 
are miniature charts designed to help you visualize nearby data in a worksheet. 
Sparklines are the height of the worksheet cells whose data they represent and can 
be any of following three chart types:

 » Line that represents the selected worksheet data as a connected line showing 
whose vectors display their relative value
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 » Column that represents the selected worksheet data as tiny columns

 » Win/Loss that represents the selected worksheet data as a win/loss chart 
whereby wins are represented by blue squares that appear above the red 
squares representing the losses

To add sparklines to the cells of your worksheet, you follow these general steps:

1. Select the cells in the worksheet with the data you want represented by 
a sparkline.

2. In the Insert tab’s Sparklines group, click the type of chart you want for 
your sparkline (Line, Column, or Win/Loss). Or press Alt+NSL for Line, 
Alt+NSO for Column, or Alt+NSW for Win/Loss.

Excel opens the Create Sparklines dialog box, which contains two text boxes: 
Data Range, which shows the cells you selected with the data you want 
graphed, and Location Range, where you designate the cell or cell range where 
you want the sparkline graphic to appear.

3. Select the cell or range of cells where you want your sparkline to appear 
in the Location Range text box and then click OK.

When creating a sparkline that spans more than a single cell, the Location 
Range must match the Data Range in terms of the same amount of rows and 
columns. (In other words, they need to be ranges of equal size and shape.)

Because sparklines are so small, you can easily add them to the cells in the final 
column of a table of data. That way, the sparklines can depict the data visually and 
enhance their meaning while remaining an integral part of the table whose data 
they epitomize.

Figure 1-13 (sample workbook: CG Music Downloads.xlsx) shows you a worksheet 
data table after adding sparklines to the table’s final column. These sparklines 
depict the variation in the sales over four quarters as tiny line graphs. As you can 
see in this figure, when you add sparklines to your worksheet, Excel adds a Spar-
kline contextual tab to the Ribbon.

The Sparkline tab contains buttons that you can use to edit the type, style, and for-
mat of the sparklines. The final group (called Group) enables you to band together 
a range of sparklines into a single group that can share the same axis and/or 
minimum or maximum values (selected using the options on its Axis drop-down 
button). This is very useful when you want a collection of different sparklines to 
all share the same charting parameters so that they equally represent the trends 
in the data.
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Adding Infographics to a Worksheet
Excel enables you to add basic infographics to your worksheets from the Insert 
tab of the Ribbon with the addition of Bing Maps and People Graph to the drop-
down menu on its Add-Ins button, and the Filled Map option in its Maps button. 
These infographics enhancements enable you to create visual representations of 
regionally related worksheet data that can point out trends and quickly convey 
their most pertinent information.

All you need to add great-looking infographics to a worksheet is some geographi-
cally related data. The geographic regions that Excel automatically recognizes and 
can work with when creating infographics include

 » Names of Countries, such USA, Russia, Canada, and so forth

 » Names of Provinces, such as Manitoba, Ontario, British Columbia, and so forth

 » Names of States, such as Maine, Connecticut, Florida, and so forth

 » Two-letter state abbreviations, such CA, NY, IA, and so forth

 » Postal codes, such as 94107, 78641, or SN13 9NH, WC2N 5DU, and the like

To demonstrate how to use Excel’s infographics, I created a simple worksheet 
that contains two columns of data. The first column contains four country names 
(China, India, USA, and Indonesia) and the second contains associated population 
figures (from 2021 data). Figure 1-14 (sample workbook: 2021 Population Info-
graphics.xlsx) shows the infographic that I created with the Bing Maps add-in for 
this data.

FIGURE 1-13:  
Sparklines 

 graphics 
 representing 
the variation 
in the data in 
a  worksheet 

table as tiny Line 
charts. (Sample 

workbook:  
CG Music 

 Downloads.xlsx)
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To create this Bing Maps infographic, I followed these steps:

1. Select the range with the population data (A1:B5).

2. On the Insert tab, choose Add-ins➪  Bing Maps (or press Alt+NZ1A1).

If you see the Bing Maps dialog box, be sure to click Trust This Add-In to 
continue.

3. Click the Show Locations button (the leftmost one in the top row) of the 
Welcome to Bing Maps graphic.

That’s all there is to it. Bing Maps automatically draws a 2-D map of the world 
including the four named countries and draws blue circles in each of them, rep-
resenting the relative size of their populations (according to the values in the B 
column of the Excel data table). If I wanted to, I could then use the Settings button 
(the second one on the top row with the cog icon) to change the default formatting 
of the population infographic or even filter its data with the Filters button (the 
third one on the top row).

Figure 1-15 (sample workbook: 2021 Population Infographics.xlsx) shows the Peo-
ple Graph infographic created from the same population data table an Excel work-
sheet. To create this infographic, I followed these steps:

1. Open the worksheet with the population data table.

2. Click the People Graph button on the drop-down menu attached to the 
Add-ins button on the Insert tab of the Ribbon (or press Alt+NZ1A2).

If you see the People Graph dialog box, be sure to click Trust This Add-In to 
continue.

FIGURE 1-14:  
Adding a Bing 

Maps  infographic 
to  illustrate the 

2021  population 
by country data 
in a  worksheet. 

 (Sample 
 workbook: 2021 

Population 
 Infographics.xlsx)
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3. Click the Data button (the one with the tiny worksheet icon) at the top of 
the Numbers About the App default infographic.

When you click the Data button, a Data panel appears in the default infographic 
where you can select the data to be represented as well as change the title.

4. Select the placeholder title text (Numbers About the App) in the Title text 
box and then replace it by entering your own title.

5. Click the Select Your Data button in the Data panel right above the Title 
text box and then drag through the cell range with the labels and values 
you want used in the new infographic.

6. Click the Create button.

As soon as you click the Create button, the People Graph add-in replaces its default 
infographic with the title and Excel data you specified. You can then use its Set-
tings button (the one with the cog icon) to modify its formatting if you so choose.

Figure  1-16 (sample workbook: 2021 Population Infographics.xlsx) shows the 
Filled Map chart created using the same population worksheet data as for the Bing 
Maps and People Graph infographics shown in Figures 1-14 and 1-15, respectively. 
This is the easiest of the three to create. All I had to do is position the cell cursor 
in one of the cells with the population data before clicking the Maps button on the 
Insert tab of the Ribbon.

Excel immediately created the Filled Map chart shown in Figure 1-16. All I then 
had to do was replace the Chart Title placeholder with the chart title shown in this 
figure.

FIGURE 1-15:  
Adding a 

People Graph 
 infographic to 

illustrate the 
2021  population 
by country data 
in a  worksheet. 

 (Sample 
 workbook: 2021 

Population 
 Infographics.xlsx)
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Printing Charts
To print an embedded chart as part of the data on the worksheet, you print the 
worksheet from the Print Settings screen in the Backstage view by pressing 
Ctrl+P. To print an embedded chart by itself without the supporting worksheet 
data, click the chart to select it before you press Ctrl+P to open the Print screen in 
the Backstage view. In the Print screen, Print Selected Chart appears as the default 
selection in the very first drop-down list box under the Settings heading and a 
preview of the embedded chart appears in the Preview pane on the right.

To print a chart that’s on a separate chart sheet in the workbook file, activate the 
chart sheet by clicking its sheet tab and then press Ctrl+P to open the Print panel, 
where Print Active Sheet(s) appears as the default selection for the Settings drop-
down list box and the chart itself appears in the Preview pane on the right.

When you want to print an embedded chart alone — that is, without its supporting 
data or in its own chart sheet — you may want to select the print quality options 
on the Chart tab of the Page Setup dialog box (which you can open by clicking the 
Page Setup link in the Print screen in the Backstage view or by clicking the dialog 
box launcher on the Page Layout tab) before sending the chart to the printer. The 
Print Quality options on the Chart tab include the following:

 » Draft Quality: Select this check box to print the chart using your printer’s 
draft-quality setting.

 » Print in Black and White: Select this check box to have your color printer 
print the chart in black and white.

FIGURE 1-16:  
Adding a Filled 

Map chart 
 infographic to 

illustrate the 
2021  population 
by country data 
in a  worksheet. 
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 workbook: 2021 

Population 
 Infographics.xlsx)
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Adding Graphic Objects

Just as charts can really help to clarify trends and implications that aren’t 
readily apparent in your worksheet data, graphics that you add to a worksheet 
can really spruce up your charts and make them read even better. Although 

you may often look at Excel graphic objects as chart enhancements, you can also 
use them to enhance regular worksheet data. Depending on the type of worksheet 
model, you may even end up using graphic elements not just to embellish the 
data, but also to present the data.

Chapter 2

IN THIS CHAPTER

 » Understanding what graphic objects 
are and how Excel treats them

 » Managing graphic objects on the 
worksheet

 » Adding online images to the 
worksheet

 » Adding text boxes with arrows

 » Inserting 2-D line art, icons, pictures, 
and 3-D model graphics in the 
worksheet

 » Adding WordArt text and SmartArt 
diagrams to the worksheet

 » Capturing screenshots of the 
Windows desktop as Excel graphics

 » Applying graphic themes to the 
worksheet
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Excel supports two types of graphic objects: those that you create yourself and 
those created by others that you import into the worksheet. This chapter covers 
how to create graphics with text and text as graphics, as well as basic graphic 
shapes. It also covers how to import two different types of graphic images: Online 
graphic images downloaded from the Internet along with local pictures and digital 
photos stored in a variety of different graphics file formats that Excel can read.

Going Graphical: The Basics of Working 
with Graphic Objects

It’s important to understand that all graphic objects (including embedded charts 
as covered in Book 5, Chapter 1), whether you create them or import them, are 
discrete objects in the worksheet that you can select and manipulate. To select a 
graphic object, you click it. Excel lets you know that the object is selected by plac-
ing white circular sizing handles around the perimeter. In the case of 2-D images, 
the program also adds a circular 2-D rotation handle that appears directly above 
and connected to the sizing handle of the graphic’s perimeter (the handle is on the 
top edge, in the middle) if the graphic can be rotated. In the case of 3-D models, 
Excel also adds a central rotation handle that enables you to manipulate the object 
in the space around its x-, y-, and z- axes. On some drawn objects (especially 3-D 
ones), yellow shaping handles also appear at the places where you can manipulate 
some part of the object’s shape, as shown in Figure 2-1.

To select multiple graphic objects in the worksheet, hold down the Shift or Ctrl 
key as you click each object. When you select more than one object, any manipula-
tions that you perform affect all the selected objects.

FIGURE 2-1:  
When you click a 
graphic object to 

select it, the  
rotation and 

circular sizing 
handles appear.
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To deselect a graphic object, click the thick, white cross pointer in any cell in 
the worksheet that it doesn’t cover. To deselect an object when you have several 
graphics selected at one time, click an unobstructed cell or another graphic.

Manipulating graphics
When you position the mouse pointer on a graphic object’s sizing handle, the 
mouse pointer becomes a double-headed arrow that you can then drag to increase 
or decrease the overall size and shape of the object. To constrain a graphic while 
resizing it, click the sizing handle and then press and hold down the Shift key as 
you drag. Holding down the Shift key restricts your dragging so that the graphic 
retains its original proportions as you make it bigger or smaller. To constrain the 
proportions of an object in two dimensions, hold down the Shift key as you drag 
one of the corner sizing handles.

When you position the pointer on a graphic object’s 2-D or 3-D rotation handle, 
the pointer becomes a curved arrow pointing clockwise. As you prepare to drag a 
2-D rotation handle, the pointer becomes four curved arrows in a circle pointing 
in the clockwise direction. You can then rotate the graphic to any degree in a circle 
that pivots around the rotation handle.

When you position the pointer on an object’s 3-D rotation handle, the pointer 
becomes a circular arrow that’s also pointing clockwise. You can then rotate the 
object in a 3-dimensional space as the handle pivots around the image so that the 
object can be displayed from any angle above or below as well as in front, on either 
side, or in back.

When you position the pointer on a graphic’s shaping handle (if it has one), 
the pointer becomes an arrowhead without any handles. You can then drag this 
pointer to reshape the side or section of the graphic. In the case of some 3-D 
graphic shapes, dragging the shaping handle rotates a part of the graphic in such 
a way that it alters the object’s perspective, thus changing the way it’s viewed.

To move the selected graphic object, position the mouse pointer somewhere on 
the object’s perimeter. Then, when the pointer becomes an arrowhead with a 
black double-cross at its point, drag the object to its new position within the 
worksheet. To copy the selected object, hold down the Ctrl key as you drag the 
graphic. (When you press the Ctrl key, a plus sign, indicating that the object is 
being copied, appears above the arrowhead pointer.)

When working with graphic objects on a touchscreen, you can use your finger 
or stylus on the various handles to rotate, reshape, and resize your image. In 
addition, you can pinch and open your fingers (forefinger and thumb) to resize a 
selected graphic object, making it smaller and larger, respectively.
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When moving graphics in a worksheet, you can make use of an invisible grid to 
help you position them. This is especially helpful when you’re trying to align one 
graphic with another (for example, when aligning two charts side by side in a 
worksheet). To turn on the grid, select the graphic object, and then choose the 
Snap to Grid option in the Arrange group of the object’s contextual tab, the name 
of which depends on the type of graphic:

 » Shape Format: When the selected graphic object is a drawn graphic, such as 
a predefined shape, text box, or WordArt.

 » Graphics Format: When the selected object is an icon downloaded from the 
extensive online Icon library.

 » Picture Format: When the selected graphic object is an imported line art 
image or digital photo, or a screenshot created with the Take a Screenshot 
command.

 » Format: When the graphic object is a piece of SmartArt.

After the Snap to Grid feature is turned on, whenever you position an object very 
close to an invisible horizontal or vertical gridline, it snaps to this line as soon as 
you release the mouse button.

You can “nudge” a selected graphic object into its desired position with a  
keyboard by pressing the arrow keys. When you press an arrow key, Excel moves 
the object just a very little bit in that direction. Nudging is useful when you have 
an object that’s almost in place and requires very little handling to get it into just 
the right position.

If you no longer need a graphic object, you can get rid of it by clicking it to select 
the object and then pressing the Delete key to remove it.

Moving graphic objects to new layers
All graphic objects that you add to a worksheet reside on different invisible layers 
that sit on top of the worksheet and over the worksheet data in the cells below. 
This means that if you move a graphic object over a cell that contains an entry, the 
graphic hides the data beneath it. Likewise, if you draw a shape or add an image 
and then position it on top of another graphic object (such as an embedded chart 
or other shape or picture), it also covers up the graphic below.

Figure 2-2 (sample workbook: Graphic Layers.xlsx) illustrates this situation. In 
this figure, you see a thumbs-up icon (named Graphic 20  in the Selection task 
pane) partially covering a photo of a hundred-dollar bill (Picture 16) and its cap-
tion (TextBox 17) and a 3-D model of a Microsoft Surface Pro (3D Model 18). The 
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distinct layers of the four graphic images are illustrated by their order in the list 
in the Selection task pane, and the currently selected layer is shown by the green 
highlight.

You display the Selection task pane by clicking the Selection Pane command  
button in the Arrange group of the Format, Graphics Format, Shape Format, or 
Picture Format contextual tab, depending on the type of graphic object selected.

You can move the graphic objects to other layers on the same worksheet using the 
Selection task pane. Click the name of the object in this task pane that you want 
to move and then drag the object up or down to the layer you prefer. Alternatively, 
click the Bring Forward button (the one with the arrow pointing upward at the 
top of the task pane to the immediate right of the Hide All button) or the Send 
Backward button (the one with the arrow pointing downward right next to it) to 
move the object. Clicking the Bring Forward button moves the selected object up 
a level in the Selection task pane just as clicking the Send Backward button moves 
the object down a level.

Any graphic object that appears above others in the list in the Selection task pane 
obscures all the objects below it, provided that the objects’ check boxes in the 
task pane are not empty but contain eye icons (meaning that they’re visible in 
the worksheet) and that the objects overlap each other in whole or in part in their 
placement on the worksheet.

FIGURE 2-2:  
Graphic objects 
on top obscure 
any worksheet 

data and  
parts of other 

graphics below. 
(Sample  

workbook: 
Graphic  

Layers.xlsx)
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If the Selection task pane isn’t open, you can use the Bring to Front and Send to 
Back buttons in the Arrange group of the Format, Graphics Format, Shape Format, 
or Picture Format contextual tab to move them to new layers:

 » Choose the Bring to Front option from the Bring Forward drop-down menu 
to bring the selected graphic object to the top of the stack.

 » Choose the Send to Back option from the Send Backward drop-down menu 
to send the object to the bottom of the stack.

 » Click the Bring Forward button to bring the selected object up to the next 
higher layer.

 » Click the Send Backward button to send the selected object down to the  
next layer.

Figure  2-3 (sample workbook: Graphic Layers.xlsx) illustrates how easy it is 
to move a graphic object to a different level in the Selection task pane. For this 
 figure, I clicked Picture 16 (the hundred-dollar bill) in the list and then selected 
the Bring to Front option to put this shape on top of all the others.

Aligning graphic objects
When you’re dealing with multiple graphic objects and you want to align them 
with each other, begin by selecting the objects in the worksheet. Now you can use 

FIGURE 2-3:  
The worksheet 

after moving the 
hundred-dollar 

bill graphic to the 
top layer with  

the Bring to  
Front option. 

(Sample  
workbook: 

Graphic  
Layers.xlsx)
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the options on the Align button’s drop-down menu in the Arrange group of the 
Format, Graphics Format, Shape Format, or Picture Format contextual tab:

 » Align Left: Aligns the left edges of the selected graphics with the left edge of 
the leftmost graphic object.

 » Align Center: Aligns the center of the selected graphics with the center 
defined by the halfway point between the left edge of the leftmost graphic 
object and the right edge of the rightmost graphic object.

 » Align Right: Aligns the right edges of the selected graphics with the right edge 
of the rightmost graphic object.

 » Align Top: Aligns the top edges of the selected graphics with the top edge of 
the topmost graphic object.

 » Align Middle: Aligns the vertical middle of the selected graphics with the 
vertical middle defined by the halfway point between the top edge of the 
topmost graphic object and the bottom edge of the bottommost graphic 
object.

 » Align Bottom: Aligns the bottom edges of the selected graphics with the 
bottom edge of the bottommost graphic object.

 » Distribute Horizontally: Equally distributes the selected graphic objects 
(three or more) horizontally.

 » Distribute Vertically: Equally distributes the selected graphic objects  
(three or more) vertically.

Grouping graphic objects
Sometimes you need to work with more than one graphic object. For example, 
the hundred-dollar bill photo (Picture 16) and its caption (TextBox 17) shown in 
Figure 2-3 would naturally always be grouped together. If you find that you’re 
constantly selecting two or more objects at the same time to move them or rotate 
them together, you can make life a lot simpler by grouping the graphics. When 
you group selected graphic objects, Excel then makes them into a single graphic 
object, which you can then manipulate.

To group a bunch of graphics together, select them all (either by Shift+clicking 
or Ctrl+clicking each one). After they’re selected, right-click the object on the top 
layer and then choose Group➪  Group from the object’s shortcut menu or click the 
Group option from the Group Objects command button’s drop-down menu on the 
Format tab of the object’s particular Format contextual tab.
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Excel indicates that the selected graphics are now grouped in the worksheet (and 
for all intents and purposes, are a single graphic object) by placing a single set 
of sizing handles around the perimeter formed by all the former separate graph-
ics and by giving them a group number in the Selection task pane, as shown in  
Figure 2-4 (sample workbook: Graphic Layers.xlsx).

You can then manipulate the grouped graphic as a single entity by moving it, siz-
ing it, rotating it, and so forth, as you would any other object. In the Selection task 
pane, Excel creates a new number Group that encompasses the erstwhile separate 
graphic objects, which are now indented in the list beneath the Group heading.

The great thing about grouping a bunch of different objects is that Excel never 
forgets that they were once separate objects that you could independently manip-
ulate. This means that you can always turn them back into separate graphics by 
ungrouping them. To do this, right-click the composite graphic object and then 
choose Group➪  Ungroup from its shortcut menu or choose the Ungroup option 
from the Group Objects command button’s drop-down menu on the object’s par-
ticular Format contextual tab.

Excel shows that the composite object is once again separated into many different 
objects by displaying sizing handles around each object’s perimeter. You can then 
deselect them all and manipulate each one once again independently by selecting 
it alone before moving, resizing, or rotating it. If you decide that you want the 
now-independent objects to be joined as a group once again, you can do this by 
right-clicking any one of the graphics in the erstwhile group and then choosing 
Group➪  Regroup from its shortcut menu or choosing the Regroup option from the 
Group Objects command button’s drop-down menu’s Format contextual tab.

Figure 2-4 illustrates grouping in action. For this figure, I selected both the hun-
dred dollar bill photo (Picture 16) and its caption (TextBox 17) and then chose 
Group from the Group Objects button’s drop-down menu. As you can see, in 

FIGURE 2-4:  
Grouping the 

hundred-dollar 
bill photo and its 

caption to turn 
them into a single 

graphic object. 
(Sample  

workbook: 
Graphic  

Layers.xlsx)
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grouping the two objects together into one, Excel created a new Group 1 object 
in the Selection task pane that consists of Textbox 17 caption and the Picture 16 
photo. After grouping the two graphics, not only does the caption move whenever 
I reposition the hundred-dollar bill, but they also both resize when I modify any 
of the sizing handles, and they rotate together if I were to manipulate the grouped 
graphics’ rotation handle.

Managing graphic objects in the  
Selection task pane
As I previously discussed in the “Moving graphic objects to new layers” section 
earlier in this chapter, the Selection task pane that you display by clicking the 
Selection Pane button in the Arrange group of the Format, Graphics Format, Shape 
Format, or Picture Format contextual tab enables you to move graphic objects that 
overlap one another in some manner to different layers in the stack.

Besides rearranging graphic objects on different layers, you can also use the 
Selection task pane to select graphic objects for editing or formatting as well as to 
temporarily hide their display in the worksheet:

 » To select a graphic object in the worksheet, click its name in the list in the 
Selection task pane. To select multiple graphics, press Ctrl as you select their 
names in the list.

 » To hide a particular graphic object in the worksheet, click the eye icon after its 
name (to close the eye), and to redisplay it, click this eye icon a second time to 
reopen its eye.

 » To hide all the graphic objects (including embedded charts) on the worksheet, 
click the Hide All button at the top of the task pane, and to redisplay them, 
click the Show All button.

Click the graphic object’s name in the Selection task pane to select it for editing 
or formatting whenever the object is difficult to select directly in the worksheet 
by clicking its shape or image, which is often the case when the object’s part of a 
stack of graphics. If you want to rename the graphic from the generic name Excel 
gives it (Picture 10, TextBox 12, Right Arrow 11, Group 21, and so forth), click the 
name in the Selection task pane and then edit or replace it in the text box that then 
appears. When you finish editing the graphic’s name, click outside the text box to 
apply the new name.
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Inserting Different Types of Graphics
Excel enables you to insert many different types of graphic images into your 
worksheets using the options in the Insert tab’s Illustrations group:

 » Pictures to import photos and other types of digital artwork saved locally on 
your computer, often in the Pictures library

 » Online Pictures to download and insert photos and other types of graphic 
images saved online — these online images include clip art saved on the 
Office.com website, web images that you locate using the Bing search engine, 
or images that you’ve saved in the cloud on your OneDrive

 » Shapes to draw predefined and free-form graphic shapes using any of the 
shape thumbnails displayed on the drop-down gallery attached to the Shapes 
option

 » Icons to download predefined black-and-white icons in a whole host of 
categories from the Insert Icons gallery

 » 3D Models to download 3-D graphics in several categories from the Microsoft 
Remix 3D online community website

 » SmartArt to generate complex graphical lists and relationship charts  
(like organizational charts) using the gallery opened by selecting the  
SmartArt option

 » Screenshot to take a snapshot of all or part of your Windows desktop and 
insert it as a graphic object in your worksheet

Inserting 2-D online images
Excel enables you to download pictures from the web using the Bing Image search 
engine and insert them into your worksheets. To download an image, display the 
Insert tab; then, in the Illustrations group, choose Pictures➪  Online Pictures to 
open the Online Pictures dialog box (or press Alt+NPO). Select one of the pre-
defined categories displayed or use the text box to type a keyword for the type of 
image you want to locate. When conducting a search, after you press Enter or click 
the Search button (with the magnifying glass icon), the Online Pictures dialog box 
displays a scrollable list of thumbnails for images matching your keyword. (See 
Figure 2-5.) You can then position the mouse pointer over any of the thumbnails 
and click the More Information and Actions button (the three dots in the lower-
right corner) to display a short description plus the size (in pixels) of the image in 
the lower-left corner of the Insert Pictures dialog box.
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Above the display of thumbnail images, the Online Pictures dialog box also dis-
plays the Creative Commons Only check box. This check box is selected by default, 
which tells you that the online images that Bing has returned in the search use 
what’s called Creative Commons. This licensing grants free distribution of what 
is otherwise copyrighted material under certain conditions (often noncommercial 
or educational use). The disclaimer then goes on to urge you to review the license 
for any image you insert into your worksheet so that you may be certain that you 
are in compliance with these conditions (always a good idea). If you want, you can 
deselect the Creative Commons Only check box to also see images that don’t use 
this licensing.

To the left of the Creative Commons Only check box you see the Filter icon. Click-
ing Filter displays a menu of options that enable you to filter the search results by 
size (such as Small or Extra Large), image type (such as Photograph or Clipart), 
image layout (such as Square or Wide), and Color (such as Color Only or Black & 
White).

To select an image for downloading, click its displayed thumbnail. To select more 
than one image, click each thumbnail. To insert the selected web image(s) into the 
current worksheet, click the Insert button.

FIGURE 2-5:  
Selecting a  

web image to 
download into 

your worksheet.
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Inserting 3-D online images
Excel also supports the use of 3-D images downloaded from the Microsoft Remix 
3D online community. Display the Insert tab; then, in the Illustrations group, 
choose 3D Models➪  Stock 3D Models to open the Online 3D Models dialog box (or 
press Alt+NS3S), as shown in Figure 2-6. Select a thumbnail of the model from 
one of its displayed categories or from a search you perform of the 3-D images 
uploaded to the Microsoft Remix 3D website. When you insert one of these 3-D 
images into your worksheet, you can rotate it so that it can be viewed from any 
angle you want.

Inserting local pictures
You can insert an image such as a digital photo or a scanned image saved locally 
on your computer in one of its local or network drives. Display the Insert tab; 
then, in the Illustrations group, choose Picture➪  This Device to open the Insert 
Picture dialog box (or just press Alt+NPD). Just be aware that even though Excel 
does compress pictures by default, depending upon the size of the photo or digital 
image, inserting such a graphic can dramatically increase the size of your Excel 
workbook file.

In the Insert Picture dialog box (see Figure 2-7), select the drive and folder con-
taining the graphics file in the Navigation pane on the left. Next, select the file to 
insert by clicking the thumbnail of graphics image before clicking the Insert but-
ton to open it and insert its image into your open worksheet.

FIGURE 2-6:  
Selecting an 

online 3-D model 
to insert into your 

worksheet.
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If you want to bring in a graphic image created in another graphics program that’s 
not saved in its own file, you select the graphic in that program and then copy it 
to the Clipboard. (Choose Home➪  Copy or press Ctrl+C.) When you get back to your 
worksheet, place the cursor where you want the picture to go and then paste the 
image in place. (Choose Home➪  Paste or press Ctrl+V.)

When you insert a picture from a graphics file into the worksheet, it’s automati-
cally selected (indicated by the sizing handles around its perimeter and its rota-
tion handle at the top). To deselect the graphic image and set it in the worksheet, 
click anywhere in the worksheet outside of the image.

Inserting icons, stock images, and  
other ready-made graphics
Excel gives you access to a huge library of ready-to-roll images that you can insert 
into your worksheets free of charge. To take a peek at what’s available, display the 
Insert tab, and then in the Illustrations group, choose Picture➪  Stock Images to 
open the search box shown in Figure 2-8 (or press Alt+NPS). (You can also get 
to this box by clicking the Icons button or pressing Alt+NNS.) Figure 2-8 shows 
the Images tab displayed, but you can also select a different tab: Icons, Cutout 
People, Stickers, and Illustrations. In each case, you see several categories and a 
few images from the default category. There’s also a Search text box that you can 
use to locate the type of image you want. Click the image or images you want to 
insert in your worksheet and then click Insert.

FIGURE 2-7:  
Selecting a 

local image to 
insert into your 

worksheet.
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Making Changes to Graphics
After you’ve inserted a graphic or three, it’s unlikely your objects are exactly the 
way you want them. They may be in the wrong place, they may be the wrong size, 
or you may want to fix the colors or add some special effects. Fortunately, your 
worksheet graphics aren’t set in stone, so you’re free to make as many changes as 
you need, as the next few sections show.

Editing pictures
As long as a photo or other graphics image is selected in your worksheet (indicated 
by the sizing handles around its perimeter and a rotation handle at the top), you 
can make any of the following editing changes to it:

 » Move the selected image to a new location in the chart by dragging it.

 » Resize the selected image by dragging the appropriate sizing handle.

 » Rotate the selected 2-D or 3-D image by dragging its rotation handle (the 
green circle at the top) in a clockwise or counterclockwise direction. Rotate a 
3-D model in space by dragging its 3-D rotation handle at the center of the 
image around the graphic

 » Delete the selected image by pressing the Delete key.

FIGURE 2-8:  
Use this box to 

select from a 
large collection 
of ready-to-use 

images.
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Formatting photos and line art pictures
When you select a two-dimensional graphics image, Excel adds the Picture For-
mat contextual tab to the Ribbon. The Picture Format tab’s command buttons are 
arranged into several groups: Adjust, Picture Styles, Accessibility, Arrange, and 
Size. The Adjust group contains the following important command buttons:

 » Remove Background: Removes the background from the selected image.

 » Corrections: Increases or decreases the picture’s sharpness or brightness 
and contrast when you click a new preset thumbnail image. Alternatively, click 
Picture Corrections Options to open the Format Picture task pane, where you 
can adjust these settings with its Sharpen and Soften or Brightness and 
Contrast sliders.

 » Color: Opens a drop-down menu, where you can select a new color thumbnail 
for the image or select a transparent color that drops out of the picture.

 » Artistic Effects: Applies a special effect filter to the image when you click one 
of the preset thumbnail images. You can also click Artistic Effects Options to 
open the Artistic Effects tab of the Format Picture task pane, where you can 
select another filter to apply or reset the image by removing all previously 
applied filters.

 » Transparency: Sets the transparency of the image when you click one of the 
preset thumbnail images. You can also click Picture Transparency Options to 
open the Picture Transparency tools of the Format Picture task pane, where 
you can choose a preset or set the transparency percentage manually.

 » Compress Pictures: Opens the Compress Pictures dialog box, where you can 
compress all images in the worksheet or just the selected graphic image to 
make them more compact and thus make the Excel workbook somewhat 
smaller when you save the images as part of its file.

 » Change Picture: Opens the Insert Picture dialog box, where you can select an 
image in a new graphics file to replace the picture. When replacing the 
currently selected picture with the new image, Excel automatically sizes and 
formats the new image with the settings applied to the old.

 » Reset Picture: Removes all formatting changes made and returns the picture 
to the state it was in when you originally inserted it into the worksheet.

You can also format a picture by opening the Format Picture task pane by selecting 
the image and then pressing Ctrl+1. Then, click the appropriate button — Fill & 
Line, Effects, Size & Properties, or Picture — to access the appropriate formatting 
options.
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You can also use the command buttons in the Picture Styles group to format the 
selected graphic image. Click a thumbnail on the Picture Styles drop-down gallery 
to select a new orientation and style for the selected picture or select a new border 
shape on the Picture Shape button’s drop-down palette, a new border color on the 
Picture Border button’s drop-down color palette, or a new shadow or 3-D rotation 
effect from the Picture Effects button’s drop-down menu.

You can remove a uniform background in a selected picture by clicking the Remove 
Background button in the Format tab’s Adjust group. Excel then adds a Back-
ground Removal contextual tab to the Ribbon and applies a violet filter to the 
identified background of the selected picture. You can then adjust the violet filter 
to indicate the extent of the image background to be removed. Then, click the 
Keep Changes button on the Background Removal contextual tab to close it and to 
remove the image’s background.

Formatting 3-D model images
When you select a 3-D image that you’ve inserted into your worksheet, Excel adds 
a 3D Model contextual tab to the Ribbon. The 3D Model tab is divided into the fol-
lowing groups:

 » Play 3D: For an animated 3D model, enables you to click Play and Pause to 
control the animation playback. You can also use the Scenes list to select 
which scene you want to play.

 » Adjust: Replaces the selected image with another online or local 3-D model or 
resets the image to its original rotation and/or size.

 » 3D Model Views: Selects a preset three-dimensional rotation.

 » Accessibility: Opens the Alt Text task pane where you can enter a description 
of the graphic that a screen reader can read aloud to a visually-impaired user.

 » Arrange: Modifies the selected image’s layer or groups or aligns it with other 
images (see “Aligning graphic objects” earlier in this chapter for details).

 » Size: Enters a new width or height (in inches, if that is the default unit in Excel) 
for the selected image.

You can also format a selected 3-D image with the options in the Format 3D Model 
task pane opened by pressing Ctrl+1 or clicking the Format 3D Model button on the 
right side of the 3D Model Views group or the Size and Position button on the right 
side of the Size group on the Format tab under the 3D Model Tools contextual tab. 
This task pane contains four buttons, Fill & Line, Effects, Size & Properties, and 
3D Model, with all sorts of options for formatting the appearance of the selected 
3-D image.
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Drawing Graphics
On the Insert tab, the Illustration group’s Shapes gallery and SmartArt button, 
along with the Text group’s Text Box and WordArt buttons, enable you to draw a 
wide variety of graphic objects. Some of these graphic objects, including the call-
out graphics on the Shapes gallery and all the SmartArt, Text Box, and WordArt 
graphics, enable you to combine text and graphics.

Drawing predefined shapes
On the Insert tab, the Illustration group’s Shapes gallery (Alt+NSH) contains a 
satisfying variety of predefined shapes that you can draw on your worksheet by 
dragging the mouse pointer.

The Shapes gallery is divided into nine sections: Recently Used Shapes, Lines, 
Rectangles, Basic Shapes, Block Arrows, Equation Shapes, Flowchart, Stars and 
Banners, and Callouts.

Click the icon of the shape you want to draw. The pointer becomes a crosshair, 
which you position where you want the shape to start, and then drag until the 
shape is the size you want.

After you release the mouse button or remove your finger or stylus from the 
touchscreen, the shape you’ve drawn remains selected, as indicated by the sizing 
and shaping handles around its perimeter and the rotation handle at the top. You 
can use these handles to resize, reshape, or rotate the graphic as needed. Excel 
also adds the Shape Format contextual tab to the Ribbon, and you can use this 
tab’s Shape Styles gallery and other buttons to further format the shape until it’s 
exactly the way you want it. To set the shape and remove the handles, click any-
where in the worksheet outside of the shape.

When drawing a rectangle or an oval, you can constrain the tool to draw a square 
or circle by holding down the Shift key as you drag the mouse. Note that when 
drawing a two-dimensional shape, such as a rectangle, square, oval, or circle, 
Excel automatically draws the shape with a blue fill that obscures any data or 
graphic objects that are beneath the shape on layers below.

Besides drawing basic shapes, lines, and arrows, you can also draw block arrows, 
equation symbols, flowchart symbols, banners, and callouts by selecting them 
from their respective areas on the Shapes gallery. Note that after you draw one of 
the callouts, Excel positions the insertion point within the shape so that you can 
enter the callout text. After you finish typing the text, click outside the shape to 
deselect the callout. (See the “Adding text boxes” section that follows for infor-
mation on how to edit and format the callout text.)
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Adding text boxes
Text boxes are special graphic objects that combine text with a rectangular graphic 
object. They’re great for calling attention to significant trends or special features 
in the charts that you create. (See Book 5, Chapter 1, for details.)

To create a text box, display the Insert tab and then click the Text group’s Text 
Box button (or press Alt+NX). The pointer changes to a thin vertical line with a 
short horizontal line crossing near the bottom. Drag this pointer to draw the out-
line of the new text box. When you release the mouse button or remove your finger 
or stylus from the touchscreen, Excel draws the text box and places the insertion 
point in the upper-left corner of the box.

You can then type the text that you want displayed in the text box. If you reach the 
end of the text box and still have more text to enter, you need to make the text box 
bigger (vertically and/or horizontally) to make sure all the text gets displayed. If 
you want to break a line before it reaches the right edge of the text box, press the 
Enter key. When you finish entering the text, click anywhere on the screen outside 
the text box.

Note that text boxes display two different border patterns when you select them:  
A dotted-line pattern is displayed when you click inside the text box, thus enabling 
you to format and edit the text, and a solid-line pattern is displayed when you 
click the border of the text box or start dragging the box to reposition it, thus 
indicating that you can format and edit the box itself.

Formatting a text box
After you add a text box, you can format its text by changing the font, font size, 
font style, and alignment of the text (including its orientation); you can also for-
mat the text box by changing its background color and line style, object position-
ing properties, and its text margins.

To change the formatting of the text entered in a text box, first either click the text 
box in the Selection task pane (displayed by choosing Shape Format➪  Selection 
Pane) or click any border of the text box until the solid outline appears around the 
box. Then click the appropriate commands in the Home tab’s Font and Alignment 
groups. Choose from the following options:

 » Font or Font Size drop-down list buttons and the Increase Font Size and 
Decrease Font Size buttons to change the font or font size of the text. Use 
Live Preview to see how the new font and font size looks in the text box.

 » Bold, Italic, or Underline buttons to add these attributes to the text in the 
text box.
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 » Font Color drop-down list to apply a new color to the text in the text box.

 » Align Text Left, Center, or Align Text Right buttons to change the horizontal 
alignment of the text with respect to the left and right edges of the text box.

 » Top Align, Middle Align, or Bottom Align buttons to change the vertical 
alignment of the text with respect to the top and bottom edges of the 
text box.

 » Increase Indent or Decrease Indent buttons to indent text within the box’s 
borders or remove previous indenting.

 » Orientation button to modify the orientation of the text in the text box by 
selecting the Vertical Text, Rotate Text Up, or the Rotate Text Down option.

To change the formatting of some of the text in a text box, click inside the text box 
to open the text for editing and then select the text you want to format.

To change the formatting of the text box itself, first click the text box in the Selec-
tion task pane (choose Shape Format➪  Selection Pane) or click any text box border 
until the solid outline appears around the box. Then, in the Shape Format contex-
tual tab, choose among the following formatting options:

 » Edit Shape drop-down list (the one with the dots around the graphic object in 
the Insert Shapes group) to change the text box shape or edit the wrap points.

 » Shape Styles gallery to select a new outline, fill, and text color all at one time 
by clicking one of the gallery’s thumbnails (after using Live Preview to see how 
the new color scheme looks).

 » Shape Fill drop-down list to select a new color, gradient, picture, or texture 
for the text box fill or to remove any existing fill (by selecting the No Fill 
option).

 » Shape Outline drop-down list to select a new color, line weight, or line style 
for the outline of the text box or to remove its outline (by selecting the No 
Outline option).

 » Shape Effects drop-down list to select a new special effect such as a shadow, 
glow, or other 3-D effect using the options and palettes available from its 
drop-down menu.

 » WordArt Styles drop-down palette to apply a new WordArt style for the text 
in the text box by clicking one of the gallery’s thumbnails (after using Live 
Preview to see how the new WordArt text style looks).

 » Text Fill drop-down list to select a new fill color, gradient, picture, or texture 
for the text in the text box or to remove any existing fill color (by selecting the 
No Fill option).
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 » Text Outline drop-down list to select a new color, line weight, or line style for 
the text in the text box or to remove its current outline (by selecting the No 
Outline option).

 » Text Effects drop-down list to select a new special effect such as a shadow, 
glow, or other 3-D effect for the text in the text box using the options and 
palettes available from its drop-down menu.

When you first enter the text in a text box, Excel sets scanty internal margins so 
that there’s not a lot of white space between the text characters and the edge of 
the text box. If you’re anything like me, one of the first things that you’ll want to 
do is add decent margins to the text box.

To modify the margins, right-click the text box and then choose Format Shape 
to open the Format Shape task pane. Click the Size & Properties tab (third to the 
right under Shape Options) and then click Text Box. Enter the new margin values  
(in fractions of an inch) that you want to use in the Left Margin, Right Margin, 
Top Margin, and Bottom Margin text boxes. Also, select the Resize Shape to Fit 
Text check box if you want Excel to automatically resize the text box to accommo-
date any formatting changes you make to its text (such as increasing the font size, 
adding bold, or selecting a new text alignment).

Editing the text in a text box
You can edit the text in a text box as you would in any cell of the worksheet. 
To insert new text, click the insertion point at the appropriate place and start  
typing. To delete text, press the Backspace key to delete characters to the left  
of the insertion point or the Delete key to delete characters to its right. To delete 
an entire section of text, select it with the I-beam mouse pointer and then press 
the Delete key.

To spell check some or all of the text in the text box, select the text by dragging 
the I-beam mouse or Touch pointer through it and then click the Review tab’s 
Spelling button (or press F7).

To delete a text box from the worksheet, click its border to select the box (indi-
cated by the solid as opposed to dotted outline) and then press the Delete key. Be 
sure that you don’t click inside the box because this selects only the text (indicated 
by the dotted outline), in which case, pressing the Delete key doesn’t get rid of 
anything but characters of text at the cursor’s position.
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Adding an arrow to a text box
When creating a text box, you may want to add an arrow to point directly to 
another graphic object or to the part of the worksheet or chart to which you’re 
referencing. To add an arrow, follow these steps:

1. Select the text box by clicking any border until the solid outline appears.

Sizing handles appear around the text box, and the Shape Format contextual 
tab appears on the Ribbon.

2. Click the Arrow command button in the Insert Shapes drop-down gallery 
at the very beginning of the Format tab.

The Arrow command button is the second from the left in the Lines section of 
Shapes gallery (with the picture of an arrow). When you click this button, it 
becomes selected in the gallery palette (indicated by the button’s green 
shading) and the mouse or Touch pointer assumes the crosshair shape.

3. Drag the crosshair pointer from the place on the text box where the end 
of the arrow (the one without the arrowhead) is to appear to the place 
where the arrow starts (and the arrowhead will appear) and release the 
mouse button.

As soon as you release the mouse button or remove your finger or stylus from 
the touchscreen, Excel draws two points, one at the base of the arrow 
(attached to the text box) and another at the arrowhead. At the same time, the 
contents of the Shape Styles drop-down gallery changes to line styles.

4. Click the More button in the lower-right corner of the Shapes Styles 
drop-down gallery to display the thumbnails of all its line styles and then 
highlight individual thumbnails to see how the arrow would look in each.

As you highlight the different line styles in this gallery, Excel draws the arrow 
between the two selected points in the text box using the highlighted style.

5. Click the thumbnail of the line style you want the new arrow to use in the 
Shape Styles gallery.

Excel then draws a new arrow using the selected shape style, which remains 
selected (with sizing handles at the beginning and end of the arrow). You can then 
edit the arrow as follows:

 » Move the arrow by dragging its outline into position.

 » Change the length of the arrow by dragging the sizing handle at the 
arrowhead.

 » Change the direction of the arrow by pivoting the mouse or Touch pointer 
around a stationary selection handle.
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 » Change the shape of the arrowhead or the thickness of the arrow’s shaft by 
clicking a thumbnail on the Shape Styles drop-down gallery or clicking a new 
option on the Shape Fill, Shape Outline, and Shape Effects button on the 
Format tab of the Drawing Tools contextual tab. Alternatively, open the 
Format Shape task pane (Ctrl+1) and then select the appropriate options after 
selecting the Fill & Line, Effects, Size & Properties, or Picture button.

 » Delete the arrow by pressing the Delete key.

Inserting WordArt
Excel’s WordArt gallery enables you to add artsy text to the worksheet. The only 
thing to keep in mind when adding WordArt is that, just as its name implies, this 
text is really a graphic (art) object that behaves just like any other Excel graphic 
object although it contains only text.

You add WordArt to your worksheet by following these steps:

1. In the Insert tab’s Text group, click the WordArt drop-down button (or 
press Alt+NW).

Excel displays the WordArt drop-down gallery, as shown in Figure 2-9.

2. Click the A thumbnail in the WordArt style you want to use in the 
WordArt drop-down gallery.

Excel inserts a selected text box containing Your Text Here in the center of 
the worksheet with this text in the WordArt style you selected in the gallery.

3. Type the text you want to display in the worksheet in the Text box.

As soon as you start typing, Excel replaces the Your Text Here text in the 
selected text box with the characters you enter.

4. (Optional) To format the background of the text box, use Live Preview in 
the Shape Styles drop-down gallery on the Format tab to find the style to 
use and then set it by clicking its thumbnail.

The Format tab on the Drawing Tools contextual tab is automatically added 
and activated whenever WordArt text is selected in the worksheet.

5. After making any final adjustments to the size, shape, or orientation of 
the WordArt text with the sizing and rotation handles, click a cell 
somewhere outside of the text to deselect the graphic.

Note that Excel automatically compresses the text to fill the shape and size of 
its text box. To put more space between the words and the characters in each 
word, make the text box wider by dragging the sizing handle on either side of 
the text box.
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When you click outside of the WordArt text, Excel deselects the graphic, and the 
Drawing Tools contextual tab disappears from the Ribbon. (If you ever want this 
tab to reappear, all you have to do is click somewhere on the WordArt text to select 
the graphic.)

Inserting SmartArt graphics
SmartArt graphics enable you to quickly construct fancy graphical lists, diagrams, 
and captioned pictures in your worksheet. SmartArt lists, diagrams, and pictures 
come in a wide array of configurations that include a variety of organizational 
charts and flow diagrams that enable you to add your own text to predefined 
graphic shapes.

To insert a SmartArt graphic into the worksheet, click the Insert tab’s Smart-
Art button in the Illustrations group (or press Alt+M1). Excel opens the Choose a 
SmartArt Graphic dialog box (shown in Figure 2-10), where you select a category 
in the navigation pane on the left followed by the list’s or diagram’s thumbnail in 
the center section before you click OK.

Excel then inserts the basic structure of the list, diagram, or picture into your 
worksheet with [Text] placeholders showing where you can enter titles, descrip-
tions, or captions (as shown in Figure 2-11), or, in the case of SmartArt pictures, 
picture icons showing where you can insert your own pictures into the SmartArt 
graphic. At the same time, the SmartArt Design contextual tab appears on the  
Ribbon with Layouts and SmartArt Styles galleries for the particular type of 
SmartArt list or diagram you originally selected.

FIGURE 2-9:  
Selecting the text 
style for the new 

WordArt text 
from its drop-
down gallery.
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Filling in the text for a new SmartArt graphic
To fill in the text for your new SmartArt graphic, click its [Text] placeholder and 
then type the text.

When you finish entering the text for your new diagram, click outside the graphic 
to deselect it.

If the style of the SmartArt list or diagram you select comes with more sections 
than you need, you can delete the unused graphics by clicking them to select them 
(indicated by the selection and rotation handles around it) and then pressing the 
Delete key.

FIGURE 2-10:  
Select the  

SmartArt list,  
diagram, or  

picture to insert 
in the worksheet 

in this dialog box.

FIGURE 2-11:  
Adding text  

for a new  
organizational 

chart in the 
SmartArt  

text pane.
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Adding images to a SmartArt picture
If the SmartArt graphic object you’ve added to your worksheet is one of those 
from the Picture group of the Choose a SmartArt Graphic dialog box, your selected 
SmartArt graphic contains an Insert Picture button (marked only by a small pic-
ture icon) along with the [Text] indicators. To add a graphic image to the SmartArt 
object, click this picture icon to open an Insert Pictures dialog box with the fol-
lowing four options:

 » From a File: Opens the Insert Picture dialog box where you can select a local 
photo or other graphic image saved in a local or networked drive on your 
computer (see “Inserting local pictures” earlier in this chapter).

 » Stock Images: Opens the search box shown earlier in Figure 2-8 with the 
Images tab selected, where you can choose a stock image to use with your 
SmartArt graphic.

 » Online Pictures: Opens the Online Pictures dialog box where you can 
download a photo or other graphic image from an online source such as Flickr 
or your OneDrive (see “Inserting 2-D online images” earlier in this chapter).

 » From Icons: Opens the Insert Icons dialog box where you can select one of 
the many categories of black and white images to insert.

Formatting a SmartArt graphic
After you deselect your SmartArt graphic, you can still format its text and format. 
To format the text, select all the graphic objects in the SmartArt list or diagram 
that need the same type of text formatting — remember you can select several 
objects in the list or diagram by holding down Ctrl as you click them — and then 
clicking the appropriate command buttons in the Home tab’s Font group.

To refine or change the default formatting the SmartArt graphic, you can use the 
Layouts, Change Colors, and SmartArt Styles drop-down galleries available on the 
SmartArt Design contextual tab:

 » Click the More button in the Layouts group and then click a thumbnail on the 
Layouts drop-down gallery to select an entirely new layout for your 
SmartArt graphic.

 » Click the Change Colors button in the SmartArt Styles group and then click a 
thumbnail in the drop-down Theme Colors gallery to change the color scheme 
for the current layout.

 » Click the More button in the SmartArt Styles group and then click a thumbnail 
on the SmartArt Styles drop-down gallery to select a new style for the current 
layout, using the selected color scheme.
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Adding Screenshots of the  
Windows Desktop

The Screenshot command button in the Illustrations group of the Insert tab 
enables you to capture Windows desktop graphics and insert them directly into 
your worksheet. Before clicking this button, you need to open the other applica-
tion window whose document you want to capture as an Excel graphic object or 
set up the Windows desktop icons that you want to capture.

Then, switch back to the Excel program window and click the Insert tab’s Screen-
shot button in the Illustrations group (press Alt+NSC). Excel then opens a Screen-
shot drop-down menu.

If you have application windows open on the Windows desktop, a thumbnail of 
each window appears on this Screenshot drop-down menu under the heading 
Available Screen Shots. To capture one of the open window’s information as a 
graphic object in the current Excel worksheet, click its thumbnail on this drop-
down menu and Excel adds the window as a selected graphic in your sheet.

If you don’t want to capture any of the discrete application windows as graphics, 
you can use the Screen Clipping option that appears at the bottom of the Screen-
shot drop-down menu to select the section of the desktop to capture as a graphic. 
When you click the Screen Clipping option, Windows minimizes the Excel applica-
tion window and displays the desktop with all of its windows and icons displayed 
but in a gauzy, hazy transparent mode. You then drag the black-cross pointer to 
select the section of the desktop you want captured as a worksheet graphic object. 
(As you drag, Windows removes the gauzy effect from the area you select.) When 
you release the mouse button, Windows immediately reopens the Excel program 
window with the section of the desktop added as a selected worksheet graphic.

Using Themes
With themes, Excel enables you to uniformly format all the graphics that you add 
to a worksheet. You can select a new theme for the active worksheet by clicking 
the Page Layout tab’s Themes drop-down button (or by pressing Alt+PTH) and 
then clicking the thumbnail of the theme you want to use.

Use Live Preview to see how the graphics you’ve added to your worksheet appear 
in the new theme before you click its thumbnail.
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Excel Themes combines three default elements: the color scheme applied to the 
graphics, the fonts (body and heading) used in the graphics, and the graphic 
effects applied. If you prefer, you can change any or all of these three elements in 
the worksheet by clicking their individual command buttons in the Themes group 
at the start of the Page Layout tab:

 » Colors to select a new color scheme by clicking its thumbnail of its color 
swatches on the drop-down palette. Click Customize Colors at the bottom 
of this palette to open the Create New Theme Colors dialog box where you 
can customize each element of the color scheme and save it with a new 
descriptive name.

 » Fonts to select a new font by clicking its thumbnail on the drop-down list. 
Click Customize Fonts at the bottom of this list to open the Create New 
Theme Fonts dialog box, where you can customize the heading and body 
fonts for both Latin and East Asian text and save it with a new descriptive 
name.

 » Effects to select a new set of graphics effects by clicking its thumbnail in the 
drop-down gallery.

To save your newly selected color scheme, font, and graphic effects as a  custom 
theme that you can reuse in other workbooks, click the Themes command  button 
and then click Save Current Theme at the bottom of the gallery to open the Save 
Current Theme dialog box. Edit the generic Theme1 name in the File Name text 
box (without deleting the .thmx filename extension) and then click the Save but-
ton. Excel then adds the custom theme to a Custom Themes section in the Themes 
drop-down gallery that you can apply to any active worksheet by clicking its 
thumbnail.





6Data 
Management



Contents at a Glance
CHAPTER 1: Building and Maintaining Tables  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 563

Table Basics  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 564
Sorting Table Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 574
Subtotaling Table Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 580

CHAPTER 2: Filtering and Querying a Table   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 583
Filtering Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 584
Using the Database Functions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 600
Querying External Data   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 602



CHAPTER 1  Building and Maintaining Tables      563

Building and Maintaining 
Tables

In addition to its considerable computational capabilities, Excel is also very 
accomplished at maintaining vast collections of related data in what are referred 
to as tables. This chapter covers all the basic procedures for creating and then 

maintaining different types of tables in the Excel worksheet.

This basic information includes how to design the basic table and then format it 
as a table so that you can add new data to the list without having to redefine it and 
can sort its data so that it’s arranged the way you like to see the information. For 
tables that contain numerical data, you also find out how to subtotal and total the 
data. For information on how to find data in the table and produce subsets of the 
list with just the data you need, see Book 6, Chapter 2.

Chapter 1

IN THIS CHAPTER

 » Setting up a table

 » Adding data to a table

 » Editing records in a table

 » Finding records in a table

 » Sorting records on values in a table

 » Sorting a list on font color, fill color, 
or cell icons

 » Subtotaling data in a table
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Table Basics
In Excel, a table is a range of worksheet data with a special structure. Unlike the 
other types of ranges that you may create in an Excel worksheet, a table uses only 
column headings (technically known as field names) to identify the different kinds 
of items that the table tracks. Each column in the table contains information for 
each item you track in the database, such as the client’s company name or tele-
phone number (technically known as a field of the table). Each row in the table 
contains information about each entity that you track in the table, such as ABC 
Corporation or National Industries (technically known as a record of the table).

After you’ve organized your data into a table that follows this structure, you can 
then use a variety of commands on the Ribbon’s Data tab to maintain the data, as 
well as to reorder the information it contains. In tables with numerical fields, you 
can also use the Subtotal command button to calculate subtotals and totals in the 
list when a certain field changes.

Designing the basic table
All you have to do to start a new table in a worksheet is to enter the names of the 
fields that you want to track in the top row of the worksheet, enter the first record 
of data beneath, and then format the two rows of data as a table. (See Book 2, 
Chapter 1 for details.) When entering the field names (as column headings), be 
sure each field name in the table is unique and, whenever possible, keep the field 
name short. When naming fields, you can align the field name in the selected cell 
so that its text wraps to a new line by clicking the Home tab’s Wrap Text but-
ton (or press Alt+HW). Also, you should not use numbers or formulas that return 
values as field names. (You can, however, use formulas that return text, such as a 
formula that concatenates labels entered in different cells.)

When deciding on what fields you need to create, you need to think of how you’ll 
be using the data that you store in your table. For example, in a client table, you 
split the client’s name into separate title, first name, and last name fields if you 
intend to use this information in generating form letters and mailing labels with 
your word processor. That way, you can address the person by his or her first 
name (as in Dear Jane) in the opening of the form letter you create, as well as 
by his or her full name and title (as in Dr. Jane Jackson) in the mailing label you 
generate.

Likewise, you split up the client’s address into separate street address, city, state, 
and zip code fields when you intend to use the client table in generating form 
letters, and you also want to be able to sort the records in descending order by 
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zip code and/or send letters only to clients located in the states of New  York, 
New Jersey, or Connecticut. By keeping discrete pieces of information in separate 
fields, you’re assured that you can use that field in finding particular records and 
retrieving information from the table, such as finding all the records where the 
state is California or the zip code is between 94105 and 95101.

To set up a new table in a worksheet, you follow these steps:

1. Click the blank cell where you want to start the new table and then enter 
the column headings (field names) that identify the different kinds of 
items you need to keep track of.

After creating the fields of the table by entering their headings, you’re ready to 
enter the first row of data.

2. Make the first entries in the appropriate columns of the row immediately 
below the one containing the field names.

These entries in the first row beneath the one with the field names constitute 
the first record of the table.

3. Select at least one of your cell entries, choose Home➪  Format as Table, 
and then click a thumbnail of one of the table styles in the gallery.

Excel displays a marquee around all the cells in the new table including the top 
row of field names. When you click a table style in the gallery, the Create Table 
dialog box appears, listing the address of the cell range enclosed in the 
marquee in the Where Is the Data for Your Table text box, and the My Table 
Has Headers check box is selected.

4. Click OK to close the Create Table dialog box.

Excel formats your new table in the selected table format and adds AutoFilter 
(drop-down buttons) to each of the field names in the top row.

Figure  1-1 shows a new employee table after formatting the first row with the 
field names and second row with the first data record as a table using Table Style 
Light 1. This new table begins in row 1 of this worksheet, which contains the col-
umn headings with the names for the ten fields in this table (ID No through Profit 
Sharing) all with AutoFilter buttons (thanks to the formatting as a table). Note 
that employees’ names are divided into separate First Name and Last Name fields 
in this list (columns B and C, respectively). Note too, that the first actual record 
of the table is entered in row 2 of the worksheet, directly under the row with the 
field names. When entering your records for a new table, you don’t skip rows but 
keep entering each record one below the other going down successive rows of the 
worksheet.
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When you’re entering the row with the first data record, be sure to format all the 
cells the way you want the entries in that field to appear in all the subsequent data 
records in the table. For example, if you have a Salary field in the table, and you 
want the salaries formatted with the Currency style number format without any 
decimal places, be sure to format the salary entry in the first record in this man-
ner. If you have a Zip Code field, format it with the Special Zip Code format or as 
Text so that Excel doesn’t drop the initial zeros from codes that begin with them 
such as 00234. That way, all subsequent records pick up that same formatting for 
their respective fields when you enter them with Excel’s data form.

Converting a range to a table (and back again)
What if you already have a range of data that you want to convert to a table? No 
problem. First, make sure the top row of your range has the text heading you want 
to use as your column names. Use any of the following techniques to convert the 
range to an honest-to-goodness table:

 » Select any cell within the range and then choose Insert➪  Table to open the 
Create Table dialog box, double-check that the range address in the Where Is 
the Data For Your Table? text box is correct, select the My Table Has Headers 
check box, and then click OK.

 » Select the entire range, click the Quick Analysis button (or press Ctrl+Q), click 
the Tables tab, and then click Table.

 » Select any cell within the range, choose Home➪  Format as Table, and then 
click a table format to open the Create Table dialog box. Make sure the range 
address in the Where Is the Data For Your Table? text box is correct, select the 
My Table Has Headers check box, and then click OK.

Creating calculated fields
When creating a new table, you can make full use of Excel’s calculating capabili-
ties by defining fields whose entries are returned by formula rather than entered 
manually. The sample employee list introduced in Figure 1-1 contains just such a 

FIGURE 1-1:  
Creating an 

employee table 
with the row of 

field names and 
first data record.
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calculated field (shown on the Formula bar) in cell I2 that contains the first entry 
in the Years of Service field.

The original formula for calculating years of service in cell I2 is as follows:

=YEAR(TODAY())–YEAR(H2)

This formula uses the YEAR Date function to subtract the serial number of the 
year in which the employee was hired (entered into the Date Hired field) in cell 
H2 from the serial number of the current year (returned by the TODAY function). 
After entering and formatting this original formula in cell I2, the data table picks 
up this formula and automatically copies it and applies it to any new record you 
add to the table.

Modifying the structure of the table
You may find after creating your table that you need to modify its structure. Here 
are the techniques you can use:

 » Renaming the table: Excel supplies each new table with a default name such 
as Table1. Boring! To give your new table a more descriptive name, select any 
cell with the table, select the Table Design contextual tab, and then use the 
Table Name text box (it’s in the Properties group on the far left of the tab) to 
enter the name you prefer.

 » Resizing the table: If you accidentally include one or more columns or rows 
in your table, you can resize the table to exclude those columns or rows. 
Select any cell in the table and choose Table Design➪  Resize Table. In the 
Resize Table dialog box that appears, select the correct range for your table 
and click OK.

 » Inserting a new field: If you need to add a new field to the table, you can 
insert the field as a new column anywhere within the existing table. Select any 
cell in the field to the left of which you want to add the new field. Choose 
Home➪  Insert➪  Insert Table Columns to the Left.

 » Inserting a new record: If you need to add a new record to the table, you can 
insert the record as a new row anywhere within the existing table. Select any 
cell in the record above which you want to add the new record. Choose 
Home➪  Insert➪  Insert Table Rows Above.

 » Deleting an existing field: If your table has one or more fields you no longer 
need, you can delete the fields. Select at least one cell in each field you want 
to remove and then choose Home➪  Delete➪  Delete Table Columns.

 » Deleting an existing record: If your table has one or more records you want to 
get rid of, you can delete those records. Select at least one cell in each record you 
want to delete and then choose Home➪  Delete➪  Delete Table Rows.
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Add new records to a table
After creating the field names and one record of the table and formatting them as 
a table, you’re ready to start entering the rest of the records in subsequent rows of 
the list. The most direct way to do this is to press the Tab key when the cell cursor 
is in the last cell of the last record. Excel tacks on an extra row to the table, where 
you can enter the appropriate information for the next record.

When doing data entry directly in a table, press the Tab key to proceed to the 
next field in the new record rather than the → key. That way, when you complete 
the entry in the last field of the record, you automatically extend the table, add a  
new record, and position the cell cursor in the first field of that record — if you 
press → to complete the entry, Excel moves the cell cursor to the next cell outside 
of the table.

Using the data form
The first time you click the custom Form button you’ve added to the Quick Access 
toolbar, Excel analyzes the row of field names and entries for the first record and 
creates a data form that lists the field names down the left side of the form, with 
the entries for the first record in the appropriate text boxes next to them.

Figure 1-2 (sample workbook: Employee data.xlsx) shows you the data form that 
Excel creates for the sample Employee table shown earlier in Figure 1-1. The data 
form consists of a dialog box (whose title bar contains the name of the current 
worksheet file, which just happens to be Employee Table) that contains a vertical 
listing of each field defined for the table.

ADDING THE FORM BUTTON
Instead of entering the records of a table directly in the table, you can use Excel’s data 
form to make the entries. The only problem with using the data form is that its com-
mand button is not found anywhere on the Ribbon: The only way to access the data 
form is by adding its command button in a custom Ribbon tab; see Book 1, Chapter 2, 
to find out how to add commands and tabs to the Ribbon. Alternatively, you can display 
the Quick Access toolbar (see Book1, Chapter 1) and add the Form command to it (as I 
describe in Book 1, Chapter 2).
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When you click the custom Form button on the Quick Access toolbar to display 
the data form, Excel automatically displays the field entries for the first record 
entered (which just happens to be the only record in the list at this point). On the 
right side of the dialog box, the data form indicates the current record number out 
of the total number of records in the table (1 of 1 in this case). This part of the form 
also contains a number of command buttons that enable you to add a new record, 
find a particular record for editing, or delete a record from the table.

When the data form is displayed in the active document, you can use the scroll bar 
to the right of the fields to move through the records in the table, or you can use 
various direction keys. Table 1-1 summarizes the use of the scroll bar and these 
keys. For example, to move to the next record in the table, you can press the ↓  
or the Enter key or click the scroll arrow at the bottom of the scroll bar. To move to 
the previous record in the table (assuming there’s more than one), you can press 
the ↑ key or Shift+Enter key or click the scroll arrow at the top of the scroll bar. To 
select a field in the current record for editing, you can click that field’s text box or 
press the Tab key (next field) or press Shift+Tab (previous field) until you select 
the field (and its current entry).

Note that the data form does not allow you to select and edit calculated fields 
(such as the Years of Service field shown earlier in Figure 1-2). Although calcu-
lated fields and their current entries are listed in the data form, the form doesn’t 
bother to provide a text box for the fields for making editing changes. To modify 
the contents of a calculated field, you would need to modify the original formula 
in the appropriate field in the first record and recopy the edited formula down to 
the other existing records in the list.

FIGURE 1-2:  
Opening the 

data form in the 
new table to add 

a new record. 
(Sample  

workbook: 
Employee  
data.xlsx)
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Adding new records with the data form
To add a new record to the table, you can either move to the end of the table (by 
dragging the scroll box to the very bottom of the scroll bar or by pressing Ctrl+↓ 
or Ctrl+PgDn) or click the New command button. Any way you do it, Excel displays 
a blank data form (marked New Record at the right side the dialog box), which 
you can then fill out. After entering the information for a field, press the Tab key 
to advance to the next field in the record. (Be careful not to press the Enter key 
because doing so inserts the new record into the table.)

When you’re making an entry in a new field, you can copy the entry from the same 
field in the previous record into the current field by pressing Ctrl+” (double quo-
tation mark). You can use this keystroke shortcut, for example, to carry forward 
entries in the text box for the State field when you are entering a series of records 
that all use the same state.

When you’ve entered all the information you have for the new record, press the ↓ 
or the Enter key or click the New button again. Excel then inserts the new record 
as the last record in the table and displays a blank data form where you can enter 
the next record. When you finish adding records to the table, press the Esc key or 
click the Close button to close the Data Form dialog box.

TABLE 1-1 Techniques for Navigating the Data Form
Movement Keystrokes or Scroll Bar Technique

Next record, same field 
in the table

Press the ↓ or the Enter key, click the downward-pointing scroll arrow, or click 
the Find Next command button.

Previous record, same 
field in the table

Press ↑ or Shift+Enter, click the upward-pointing scroll arrow, or click the Find 
Prev command button.

Next field in the data form Press Tab.

Previous field in 
the data form

Press Shift+Tab.

Move 10 records forward 
in the table

Press PgDn.

Move 10 records backward 
in the table

Press PgUp.

Move to the first record 
in the table

Press Ctrl+↑ or Ctrl+PgUp or drag the scroll box to the top of the scroll bar.

Move to the last record 
in the table

Press Ctrl+↓ or Ctrl+PgDn or drag the scroll box to the bottom of the scroll bar.

Move within a field Press ← or → to move one character at a time, press Home to move to the first 
character, and press End to move to the last character.
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Editing records in the data form
The data form makes it easy to edit records in your table. In a smaller table, you 
can use the navigation keys or the scroll bar in the data form to locate the record 
that requires editing. In a larger table, you can use the Criteria command button 
to quickly locate the record you need to change, as described in the next section.

When you’ve displayed the data form for the record that needs editing, you can 
then perform your editing changes by selecting the text boxes of the necessary 
fields and making your changes, just as you would edit the entry in its cell in the 
worksheet.

Finding records with the data form
You can use the Criteria button in the data form to find the records in your table 
that you need to edit (or delete as described in the next section). When you click 
the Criteria button in the data form, Excel clears all the field text boxes so that 
you can enter the criteria to search for. For example, assume that you need to edit 
Sherry Caulfield’s profit-sharing status. You don’t have her paperwork in front of 
you, so you can’t look up her employee number. You do know, however, that she 
works in the Boston office and, although you don’t remember exactly how she 
spells her last name, you do know that it begins with a C instead of a K.

To locate her record, you can at least narrow the search down to all the records 
where the Location field contains Boston and the employee’s Last Name begins 
with the letter C. To do this, you open the data form for the Employee table, click 
the Criteria command button, and then enter the following in the Last Name field:

C*

Then, in the Location field, you enter

Boston

When entering the criteria for locating matching records in the data form, you 
can use the question mark (?) and the asterisk (*) wildcard characters, just as you  
do when using the Excel Find feature to locate cells with particular entries. (See 
Book 2, Chapter 3, for a review of using these wildcard characters.)

When you click the Find Next button or press the Enter key, Excel locates the first 
record in the table where the last name begins with the letter C and the loca-
tion is Boston. This is William Cobb’s record. Then, to locate the next record that 
matches your criteria, click the Find Next button or press Enter, which brings you 
to Sherry Caulfield’s record. Having located Sherry’s record, you can then change 
her profit-sharing status by selecting the Profit Sharing text box and replacing No 
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with Yes. Excel inserts the editing change that you make in the record’s data form 
into the table itself as soon as you close the Data Form dialog box by clicking the 
Close button.

When using the Criteria button in the data form to find records, you can use the 
following logical operators when entering search criteria in fields that use num-
bers or dates:

 » Equal to (=): Finds records with the same text, value, or date you enter.

 » Greater than (>): Finds records after the text characters (in the alphabet) or 
the date, or larger than the value you enter.

 » Greater than or equal to (>=): Finds records the same as the text characters, 
date, or value you enter or after the characters (in the alphabet), after the 
date, or larger than the value.

 » Less than (<): Finds records before the text characters (in the alphabet) or 
date or smaller than the value you enter.

 » Less than or equal to (<=): Finds records the same as the text characters, 
date, or value you enter or before the characters (in the alphabet) or the date, 
or larger than the value.

 » Not equal to (<>): Finds records not the same as the text, value, or date  
you enter.

For example, to find all the records where the employee’s annual salary is $50,000, 
you can enter =50000 or 50000 in the Salary field text box. However, to find all 
the records for employees whose annual salaries are less than or equal to $35,000, 
you enter <=35000 in the Salary field text box. To find all the records for employ-
ees with salaries greater than $45,000, you would enter >45000 in the Salary field 
text box instead. If you wanted to find all the records where the employees are 
female and make more than $35,000, you would enter F in the Gender field text 
box and >35000 in the Salary field text box in the same Criteria data form.

When specifying search criteria that fit a number of records, you may have to click 
the Find Next or Find Prev button several times to locate the record you want to 
work with. If no record fits the search criteria you enter in the Criteria data form, 
your computer beeps at you when you click the Find Next or Find Prev button.

To change your search criteria, select the appropriate text box(es) and delete the 
old criteria and then enter the new criteria. To switch back to the current record 
without using the search criteria you enter, click the Form button. (This button 
replaces the Criteria button as soon you click the Criteria button.)
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Deleting records with the data form
In addition to adding and editing records with the data form, you can also delete 
them. To delete a record, you display its data form and then click the Delete but-
ton. Be very careful when deleting records, however, because you can’t restore the 
records you delete with Excel’s Undo feature. For this reason, Excel displays an 
alert dialog box whenever you click the Delete button, indicating that the record 
displayed in the data form is about to be permanently deleted. To continue and 
remove the record, you need to click OK or press Enter. To save the current record, 
press the Esc key or click the Cancel button instead.

Although you can use the Criteria data form to locate a group of records that you 
want to delete, you can remove only one record at a time with the Delete button.

Eliminating duplicate records
You can use Excel’s Eliminate Duplicates feature to quickly find and remove 
duplicate records from a list (or rows from a table). This feature is especially use-
ful when you’re dealing with a large table in which several different people do the 
data entry and that should not have any duplicate records (such as client lists, 
personnel files, and the like).

To have Excel remove all duplicate records from a table, you follow these simple 
steps:

1. Position the cell cursor in one of the cells of the table.

2. In the Data tab’s Data Tools group, click the Remove Duplicates com-
mand (or press Alt+AM).

Excel selects all the cells in the table while at the same time displaying the 
Remove Duplicates dialog box similar to the one shown in Figure 1-3 (sample 
workbook: Employee data.xlsx).

When this dialog box first opens, Excel automatically selects all the fields in the 
table (by selecting the check box in front of each name in the Columns list). 
When all the fields are selected and you click OK in this dialog box, Excel 
deletes only complete duplicates (in other words, copies) of the records in  
the list.

If you want the program to remove records where there’s any duplication of 
entries in particular fields (such as the ID No field), you remove the check 
marks from all the columns except for those whose duplication are sufficient 
reason for deleting the entire record (as described in Step 3). Otherwise, you 
proceed directly to Step 4.
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3. (Optional) Remove the check marks from all fields in the Columns list box 
except for those whose duplicates are reason for deleting the record.

If only one or two fields out of many need to be selected in the Columns list 
box, click the Unselect All button to remove the check marks from all field 
check boxes and then individually click the fields that can’t have duplicate 
entries.

4. Click OK to have Excel remove the duplicate records (rows) from the 
selected table.

Sorting Table Data
You can use the Home tab’s Sort & Filter command and the AutoFilter buttons on a 
table’s field names to quickly sort table data. You can sort the records in your table 
by sorting its rows, and you can sort the fields in the table by sorting its columns.

In sorting, you can specify either ascending or descending sort order for your 
data. When you specify ascending order (which is the default), Excel arranges text 
in A-to-Z order and values from smallest to largest. When you specify descend-
ing order, Excel reverses this order and arranges text in Z-to-A order and val-
ues range from largest to smallest. When sorting on a date field, ascending order 
puts the records in oldest to newest order, while descending order gives you the 
records in newest to oldest date order.

Although sorting is most often applied to rearranging and maintaining table 
records and fields, you can use the Sort & Filter command button to reorder data 
in any worksheet range, whether or not the range follows the strict table structure.

FIGURE 1-3:  
Using the Remove 

Duplicates  
dialog box to 

remove duplicate 
records from a 
table. (Sample 

workbook: 
Employee  
data.xlsx)
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Sorting records on a single field
When you need to sort the table only on one particular field (such as the ID No, 
Last Name, or Location field), you click that field’s AutoFilter button and then 
select the appropriate sort option from its drop-down list:

 » Sort A to Z or Sort Z to A in a text field

 » Sort Smallest to Largest or Sort Largest to Smallest in a number field

 » Sort Oldest to Newest or Sort Newest to Oldest in a date field

Excel then reorders all the records in the table in accordance with the new ascend-
ing or descending order in the selected field. If you find that you’ve sorted the list 
in error, click the Home tab’s Undo button or press Ctrl+Z right away to return the 
list to its previous order.

Excel shows when a field has been used in sorting the table by adding an up or 
down arrow to its filter button. An arrow pointing up indicates that the ascend-
ing sort order was used and one pointing down indicates that the descending sort 
order was used.

Sorting records on multiple fields
When you need to sort a table on more than one field, you use the Sort dialog 
box, shown in Figure 1-4 (sample workbook: Employee data.xlsx). And you need 
to sort on more than one field when the first field contains duplicate values and 
you want to determine how the records with duplicates are arranged. (If you don’t 
specify another field to sort on, Excel just puts the records in the order in which 
you entered them.)

MORE ABOUT ASCENDING AND 
DESCENDING SORT ORDERS
When you use the ascending sort order on a field in a table that contains many different 
kinds of entries, Excel places numbers (from smallest to largest) before text entries (in 
alphabetical order), followed by any logical values (FALSE and TRUE), error values, and 
finally, blank cells. When you use the descending sort order, Excel arranges the different 
entries in reverse: numbers are still first, arranged from largest to smallest; text entries 
go from Z to A; and the TRUE logical value precedes the FALSE logical value.
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The best and most common example of when you need more than one field is 
when sorting a large database alphabetically in last-name order. Say that you 
have a database that contains several people with the last name Smith, Jones, or 
Zastrow (as is the case when you work at Zastrow and Sons). If you specify the 
Last Name field as the only field to sort on (using the default ascending order), all 
the duplicate Smiths, Joneses, and Zastrows are placed in the order in which their 
records were originally entered. To better sort these duplicates, you can specify 
the First Name field as the second field to sort on (again using the default ascend-
ing order), making the second field the tiebreaker, so that Ian Smith’s record 
precedes that of Sandra Smith, and Vladimir Zastrow’s record comes after that of 
Mikhail Zastrow.

To sort records in a table using the Sort dialog box, follow these steps:

1. Position the cell cursor in one of the cells in the table.

2. Choose Data➪  Sort button (or press Alt+ASS).

Excel selects all the records of the database (without including the first row of 
field names) and opens the Sort dialog box, as shown in Figure 1-4. Note that 
you can also open the Sort dialog box by choosing Home➪  Sort & 
Filter➪  Custom Sort (or by pressing Alt+HSU).

3. Select the name of the field you first want the records sorted by from the 
Sort By drop-down list.

If you want the records arranged in descending order, remember also to select 
the descending sort option (Z to A, Smallest to Largest, or Oldest to Newest) 
from the Order drop-down list to the right.

FIGURE 1-4:  
Set up to  

sort records 
alphabetically 

by location and 
salary. (Sample 

workbook: 
Employee  
data.xlsx)
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4. (Optional) If the first field contains duplicates and you want to specify 
how the records in this field are sorted, click the Add Level button to 
insert another sort level, select a second field to sort on from the Then By 
drop-down list, and select either the ascending or descending option 
from its Order drop-down list to its right.

5. (Optional) If necessary, repeat Step 4, adding as many additional sort 
levels as required.

6. Click OK.

Excel sorts the records in the table using the sorting fields in the order of their 
levels in this dialog box. If you see that you sorted the database on the wrong 
fields or in the wrong order, choose Home➪  Undo or press Ctrl+Z to immedi-
ately restore the table records to their previous order.

By default, when you perform a sort operation, Excel assumes that you’re sorting 
a table that has a header row (with the field names) that is not to be reordered 
with the rest of the records in doing the sort. You can, however, use the Sort 
feature to sort a cell selection that doesn’t have such a header row. In that case, 
you need to specify the sorting keys by column letter, and you need to be sure to 
deselect the My Data Has Headers check box in the Sort dialog box.

Also, the Sort dialog box contains an Options button that, when clicked, opens 
a Sort Options dialog box, which contains a Case Sensitive check box that, when 
selected, enables you to sort text fields based on case, where lowercase comes 
before uppercase. This dialog box also contains options for changing the orienta-
tion of the sort from the normal top-to-bottom order to left-to-right order when 
you want to sort columns in a list.

Figure 1-5 (sample workbook: Employee data.xlsx) illustrates sorting the employee 
table first in ascending order by location and then in descending order by salary. 
For this sort, the Location field is designated as the field (column) to sort on in 
the first level and the Salary field as the other field (column) as the second level. 
Also, to have the records within each location sorted from highest to lowest salary, 
I selected Largest to Smallest from the Order drop-down list to the right of the 
first Then By combo box.

After clicking OK in the Sort dialog box, the records are now organized first in 
ascending order by the city listed in the Location field (Atlanta, Boston, Chicago, 
and so on) and within each city in descending order by Salary (38,900, 32,200, 
29,200, and so on).
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Sometimes, you may need to sort on a whole bunch of fields to get the desired 
order. For example, suppose that you’re working with a personnel table and you 
want to organize the records in alphabetical order, first by department, then by 
supervisor, and finally by last name, first name, and middle name. To sort the 
records in this table on these five fields, you have to define each of the columns as 
a separate level in the Sort dialog box as follows:

 » First by Department field in A to Z order

 » Then by Supervisor field in A to Z order

 » Then by Last Name field in A to Z order

 » Then by First Name field in A to Z order

 » Then by Middle Name field in A to Z order

Figure 1-6 (sample workbook: Personnel table.xlsx) shows the Sort dialog box after 
defining these as the columns on five separate levels on which to sort the person-
nel table. Figure 1-7 (sample workbook: Personnel table.xlsx) shows the result. 
After performing this sort operation, the records are now arranged in ascending 
order by department, then by supervisor within department, and finally by the 
last name, first name, and middle name under each supervisor.

Sorting a table on font and  
fill colors and cell icons
Although you normally sort the records of a table or rows of a table on the values 
(entries) contained in one or more columns of the list or table, Excel also enables 
you to sort on the font or fill color or cell icons that you assign to them as well. 

FIGURE 1-5:  
Employee table 

sorted by  
location and 

salary. (Sample 
workbook: 
Employee  
data.xlsx)
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These colors and icons are assigned by using the conditional formatting feature 
to mark those values in the columns of a table or table that are within or outside 
certain parameters with a distinctive font or fill colors or cell icon. (See the section 
on the conditional formatting feature in Book 2, Chapter 2 for details.)

To sort a table on a font color, fill color, or cell icon in a single field of the table, 
you click its AutoFilter button and then choose the Sort by Color option from the 
drop-down menu. Excel then displays a continuation menu on which you click the 
font color, fill color, or cell icon to use in the sort:

 » To sort the records so that those with a particular font color in the selected 
column — assigned with the Highlight Cell Rules or Top/Bottom Rules 
options — appear at the top of the table, click its color swatch in the Sort  
by Font Color section on the continuation menu.

 » To sort the records so that those with a particular fill color in the selected 
column — assigned with the Highlight Cell Rules, Top/Bottom Rules, Data 
Bars, or Color Scales options — appear at the top of the table, click its color 
swatch in the Sort by Font Color section on the continuation menu.

FIGURE 1-6:  
The Sort dialog 

box with five  
levels of sorting 
keys for sorting 

the Personnel 
table. (Sample 

workbook:  
Personnel  
table.xlsx)

FIGURE 1-7:  
The Personnel 

table after sorting 
by department, 
supervisor, last, 
first, and finally 
middle names. 

(Sample  
workbook:  
Personnel  
table.xlsx)
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 » To sort the records so that those with a particular cell icon in the selected 
column — assigned with the Icon Sets options — appear at the top of the 
table, click the icon in the Sort by Cell Icon section of the continuation menu.

You can also sort the table on more than one color or cell icon in the Sort dialog 
box opened by selecting the Custom Sort option from the Sort & Filter button’s 
drop-down list on the Ribbon’s Home tab or on the Sort by Color continuation 
menu.

When you want to sort the records in a table on more than one font or fill color or 
cell icon, you select the field with the color or icon from the Column drop-down 
list; select Font Color, Fill Color, or Cell Icon in the Sort On drop-down list; and 
then click the color swatch or icon to use in the first level of the sort in the Order 
drop-down list.

If you need to add another sort level, you click the Add Level button and then 
repeat this procedure of selecting the field in the Column drop-down list, select-
ing the Font Color, Fill Color, or Cell Icon in the Sort On drop-down list, and 
selecting the specific color or icon in the Order drop-down list. When you finish 
defining all the levels for the sort, click OK to have Excel go ahead and sort the 
list’s records.

You can sort the records in the table order by all the fill colors or cell icons assigned 
by applying the Conditional Formatting Color Scales and Cell Icons options. For 
each of three or five sorting levels you define in the Sort dialog box, the name 
of the field in the Column drop-down list button remains the same in all levels 
along with the Fill Color or Cell Icon option in the Sort On drop-down list button. 
Only the actual color or icon selected in the Order drop-down list button changes, 
reflecting the order in which you want to see the records appear in the sorted 
table.

Subtotaling Table Data
You can use Excel’s Subtotals feature to subtotal data in a sorted table. You sort 
the list on the field for which you want subtotals shown before you designate the 
field that contains the values you want subtotaled — these are almost always not 
the same fields in the table.

For example, to subtotal the salaries within each department in the sample 
Employee table (sample workbook: Employee data.xlsx), you first sort the list in 
A-to-Z order on the Dept column. Then, you designate this Dept field as the one 
for which you want the subtotals calculated (so that a subtotal appears at each 
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change in department) and the Salary field as the one to be subtotaled so that 
Excel uses the SUM function on its data entries.

When you use the Subtotals feature, you aren’t restricted to having the values in 
the designated field added together with the SUM function. You can instead have 
Excel return the number of entries with the COUNT function, the average of the 
entries with the AVERAGE function, the highest entry with the MAXIMUM func-
tion, the lowest entry with the MINIMUM function, or even the product of the 
entries with the PRODUCT function.

Excel doesn’t allow you to subtotal a table formatted as a table. Before you can 
use the Subtotal command button, you must first convert your table into a normal 
range of cells. To do this, click a cell in the table and then click the Design tab on 
the Table Tools contextual tab on the Ribbon. Finally, click the Convert to Range 
command button in the Tools group followed by the Yes button in the alert dia-
log box asking you to confirm this action. Excel then removes the filter buttons 
from the columns at the top of the table while still retaining the original table 
formatting.

Figures  1-8 and  1-9 (sample workbook for both: Employee data.xlsx) illustrate 
how to use the Subtotals feature to obtain totals in a table. In Figure 1-8, I sorted 
the sample Employee table first by the Dept field in ascending order and then by 
the Salary field in descending order (Largest to Smallest) and converted the table 
to a range (by choosing Table Design➪  Convert to Range). Then, in the Data tab’s 
Outline group, I clicked the Subtotal command to open the Subtotal dialog box 
shown in Figure 1-8.

FIGURE 1-8:  
Using the  

Subtotal dialog 
box to subtotal 
the salaries for 

each department. 
(Sample  

workbook: 
Employee  
data.xlsx)
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Here, I selected the Dept field as the field for which the subtotals are to be calcu-
lated in the At Each Change In drop-down list box, Sum as the function to use in 
the Use Function drop-down list box, and the Salary check box as the field whose 
values are to be summed in the Add Subtotal To list box.

Figure  1-9 shows the results I obtained after clicking OK in the Subtotal  
dialog box. Here, you see the bottom of the table showing the salary subtotals 
for the Administration, Engineering, Human Resources, and Information Services 
departments along with the grand total of the salaries for all the departments. 
The grand total is displayed at the bottom of the table because I left the Summary 
below Data check box selected in the Subtotal dialog box — if I hadn’t wanted a 
grand total, I would have removed the check mark from this check box.

As you can see in Figure 1-9, when you use the Subtotals command, Excel outlines 
the data and adds the rows with the departmental salary totals and the grand 
total. This means that you can collapse the table down to just its departmental 
subtotal rows or even just the grand total row by collapsing the outline down to 
the second or first level. (Remember that you can toggle between showing and 
hiding the outline symbols at the left edge of the table by pressing Ctrl+8.)

In a large table, you may want Excel to insert page breaks (often referred to as 
breaks) every time data changes in the field on which the list is being subtotaled 
(that is, the field designated in the At Each Change In drop-down list box). To do 
this, you select the Page Break between Groups check box in the Subtotal dialog 
box to put a check mark in it before you click OK to subtotal the list.

FIGURE 1-9:  
Bottom of the 
table showing 
the subtotals 

and grand total 
for department 

salaries. (Sample 
workbook: 
Employee  
data.xlsx)
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Filtering and Querying a 
Table

It’s one thing to set up a table and load it with tons of data and quite another 
to get just the information that you need out of that table. How you go about 
extracting the data that’s important to you is the subject of this chapter. The 

process for specifying the subset of the data that you want displayed in an Excel 
table is called filtering the table. The process for extracting only the data that you 
want from the table is called querying the table.

Besides helping you with filtering and querying the data in your table, this chapter 
also explains how you can use Excel’s database functions to perform calculations 
on numeric fields for only the records that meet the criteria that you specify. 
These calculations can include getting the total (DSUM), the average (DAVER-
AGE), the record count (DCOUNT and DCOUNTA), and the like.

Chapter 2

IN THIS CHAPTER

 » Understanding how to filter and 
query a table

 » Using AutoFilter to show only the 
data you want to see

 » Filtering a table with custom criteria

 » Filtering a table on font color, fill 
color, or cell icons

 » Using database functions to compute 
statistics from records that match 
your filter criteria

 » Performing external data queries 
with text files, web pages, and data 
files kept in other database sources
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Finally, this chapter introduces you to querying an external data source to bring 
some or all of its data into the more familiar worksheet setting. Data sources 
can be in the form of external databases in other Windows database programs, 
such as Microsoft Access or in even more sophisticated, server-based database- 
management systems, such as those provided by SQL Server, Azure SQL Database, 
and ODBC connections. They can also be in the form of tables stored on web pages 
and in text files, which can be parsed into separate cells of an Excel worksheet.

Filtering Data
Filtering the table to leave behind only the information that you want to work with 
is exactly the procedure that you follow in Excel. At the most basic level, you use 
the AutoFilter feature to temporarily hide the display of unwanted records and 
leave behind only the records that you want to see. Much of the time, the capa-
bilities of the AutoFilter feature are all that you need, especially when your main 
concern is displaying just the information of interest in the table.

You’ll encounter situations, however, in which the AutoFilter feature isn’t suffi-
cient, and you must do what Microsoft refers to as advanced filtering in your table. 
You need to use advanced filtering when you use computed criteria (such as when 
you want to see all the records where the entry in the Sales column is twice the 
amount in the Owed column) and when you need to save a copy of the filtered 
data in a different part of the worksheet (Excel’s version of querying the data in 
a table).

Using AutoFilter
Excel’s AutoFilter feature makes filtering out unwanted data in a table as easy 
as clicking the AutoFilter button on the column on which you want to filter the 
data and then choosing the appropriate filtering criteria from that column’s drop-
down menu.

If you open a worksheet with a table and you don’t find AutoFilter buttons attached 
to each of the field names at the top of the list, you can display them by position-
ing the cell pointer in one of the cells with the field names and then clicking 
the Filter command button on the Ribbon’s Data tab or pressing Ctrl+Shift+L or 
Alt+AT.

The filter options on a column’s AutoFilter drop-down menu depend on the type 
of entries in the field. On the drop-down menu in a column that contains only 
date entries, the menu contains a Date Filters option to which a submenu of the 
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actual filters is attached. On the drop-down menu in a column that contains only 
numeric entries (besides dates) or a mixture of dates with other types of numeric 
entries, the menu contains a Number Filters option. On the drop-down menu 
in a column that contains only text entries or a mixture of text, date, and other 
numeric entries, the menu contains a Text Filters option.

Doing basic filtering by selecting  
specific field entries
Besides the Date Filters, Text Filters, or Number Filters options (depending on the 
type of field), the AutoFilter drop-down menu for each field in the table contains 
a list box with a complete listing of the unique entries made in that column, each 
with its own check box. At the most basic level, you can filter the table by clearing 
the check box for all the entries whose records you don’t want to see in the list.

This kind of basic filtering works best in fields such as City, State, or Country, 
which contain many duplicates, so you can see a subset of the table that contains 
only the cities, states, or countries you want to work with at the time.

The easiest way to perform this basic type of filtering on a field is to first deselect 
the (Select All) check box at the top of the field’s list box, and then select each  
of the check boxes containing the entries for the records you do want displayed in 
the filtered table. After you finish selecting the check boxes for all the entries you 
want to keep, click OK to close the AutoFilter drop-down menu.

Excel then hides rows in the table for all records except for those that contain the 
entries you just selected. The program also lets you know which field or fields 
have been used in the filtering operation by adding a cone filter icon to the col-
umn’s AutoFilter button. To restore all the records to the table, you can remove 
the filtering by clicking the Clear command button in the Sort & Filter group of the 
Data tab of the Ribbon or by pressing Alt+AC.

When doing this basic kind of table filtering, you can select specific entries from 
more than one field in this list. Figure 2-1 (sample workbook: Employee Table.
xlsx) illustrates this kind of situation. Here, I want only the employees in the 
company who work in the Engineering and Information Services departments in 
the Chicago and Seattle offices. To do this, I selected only the Engineering and 
Information Services entries in the list box on the Dept field’s AutoFilter drop-
down menu and only the Chicago and Seattle entries in the list box on the Location 
field’s AutoFilter drop-down menu.
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As you can see in Figure 2-1, after filtering the Employee table so that only the 
records for employees in either the Engineering or Information Services depart-
ment in either the Chicago or Seattle office locations are listed, Excel adds the 
cone filter icon to the AutoFilter buttons on both the Dept and Location fields in 
the top row, indicating that the table is filtered using criteria involving both fields.

Using the Text Filters options
The AutoFilter drop-down menu for a field that contains only text or a combina-
tion of text, date, and numeric entries contains a Text Filters option that displays 
a submenu containing the following options:

 » Equals: Opens the Custom AutoFilter dialog box with the Equals operator 
selected in the first condition.

 » Does Not Equal: Opens the Custom AutoFilter dialog box with the Does Not 
Equal operator selected in the first condition.

 » Begins With: Opens the Custom AutoFilter dialog box with the Begins With 
operator selected in the first condition.

 » Ends With: Opens the Custom AutoFilter dialog box with the Ends With 
operator selected in the first condition.

 » Contains: Opens the Custom AutoFilter dialog box with the Contains operator 
selected in the first condition.

 » Does Not Contain: Opens the Custom AutoFilter dialog box with the Does 
Not Contain operator selected in the first condition.

 » Custom Filter: Opens the Custom AutoFilter dialog box where you can select 
your own criteria for applying more complex AND or OR conditions.

FIGURE 2-1:  
The employee 

table after  
filtering the  

Dept and  
Location fields. 

(Sample  
workbook: 
Employee  

Table.xlsx)
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Using the Date Filters options
The AutoFilter drop-down menu for a field that contains only date entries contains 
a Date Filters option that displays a submenu containing the following options:

 » Equals: Opens the Custom AutoFilter dialog box with the Equals operator 
selected in the first condition.

 » Before: Opens the Custom AutoFilter dialog box with the Is Before operator 
selected in the first condition.

 » After: Opens the Custom AutoFilter dialog box with the Is After operator 
selected in the first condition.

 » Between: Opens the Custom AutoFilter dialog box with the Is After or Equal 
To operator selected in the first condition and the Is Before or Equal To 
operator selected in the second AND condition.

 » Tomorrow: Filters the table so that only records with tomorrow’s date in this 
field are displayed in the worksheet.

 » Today: Filters the table so that only records with the current date in this field 
are displayed in the worksheet.

 » Yesterday: Filters the table so that only records with yesterday’s date in this 
field are displayed in the worksheet.

 » Next Week: Filters the table so that only records with date entries in the week 
ahead in this field are displayed in the worksheet.

 » This Week: Filters the table so that only records with date entries in the 
current week in this field are displayed in the worksheet.

 » Last Week: Filters the table so that only records with date entries in the 
previous week in this field are displayed in the worksheet.

 » Next Month: Filters the table so that only records with date entries in the 
month ahead in this field are displayed in the worksheet.

 » This Month: Filters the table so that only records with date entries in the 
current month in this field are displayed in the worksheet.

 » Last Month: Filters the table so that only records with date entries in the 
previous month in this field are displayed in the worksheet.

 » Next Quarter: Filters the table so that only records with date entries in the 
three-month quarterly period ahead in this field are displayed in the 
worksheet.

 » This Quarter: Filters the table so that only records with date entries in the 
current three-month quarterly period in this field are displayed in the 
worksheet.
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 » Last Quarter: Filters the table so that only records with date entries in the 
previous three-month quarterly period in this field are displayed in the 
worksheet.

 » Next Year: Filters the table so that only records with date entries in the 
calendar year ahead in this field are displayed in the worksheet.

 » This Year: Filters the table so that only records with date entries in the current 
calendar year in this field are displayed in the worksheet.

 » Last Year: Filters the table so that only records with date entries in the 
previous calendar year in this field are displayed in the worksheet.

 » Year to Date: Filters the table so that only records with date entries in the 
current year up to the current date in this field are displayed in the worksheet.

 » All Dates in the Period: Filters the table so that only records with date entries 
in the quarter (Quarter 1 through Quarter 4) or month (January through 
December) that you choose from its submenu are displayed in the worksheet.

 » Custom Filter: Opens the Custom AutoFilter dialog box where you can select 
your own criteria for more complex AND or OR conditions.

When selecting dates for conditions using the Equals, Before, or After operator 
in the Custom AutoFilter dialog box, you can select the date by clicking the Date 
Picker button (the one with the calendar icon) and then clicking the specific date 
on the drop-down date palette. When you open the date palette, it shows the cur-
rent month and the current date selected. To select a date in an earlier month, 
click the Previous button (the one with the triangle pointing left) until its month 
is displayed in the palette. To select a date in a later month, click the Next but-
ton (the one with the triangle pointing right) until its month is displayed in the 
palette.

Using the Number Filters options
The AutoFilter drop-down menu for a field that contains only numeric entries 
besides dates or a combination of dates and other numeric entries contains a 
Number Filters option that displays a submenu containing the following options:

 » Equals: Opens the Custom AutoFilter dialog box with the Equals operator 
selected in the first condition.

 » Does Not Equal: Opens the Custom AutoFilter dialog box with the Does Not 
Equal operator selected in the first condition.

 » Greater Than: Opens the Custom AutoFilter dialog box with the Is Greater 
Than operator selected in the first condition.
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 » Greater Than or Equal To: Opens the Custom AutoFilter dialog box with the 
Is Greater Than or Equal To operator selected in the first condition.

 » Less Than: Opens the Custom AutoFilter dialog box with the Is Less Than 
operator selected in the first condition.

 » Less Than or Equal To: Opens the Custom AutoFilter dialog box with the Is 
Less Than or Equal to operator selected in the first condition.

 » Between: Opens the Custom AutoFilter dialog box with the Is Greater Than or 
Equal To operator selected in the first condition and the Is Less Than or Equal 
To operator selected in the second AND condition.

 » Top 10: Opens the Top 10 AutoFilter dialog box so that you can filter the table 
to just the ten or so top or bottom values or percentages in the field. (See 
“Making it to the Top Ten!” that follows in this chapter for details.)

 » Above Average: Filters the table to display only records where the values in 
the field are greater than the average of the values in this field.

 » Below Average: Filters the table to display only records where the values in 
the field are less than the average of the values in this field.

 » Custom Filter: Opens the Custom AutoFilter dialog box where you can select 
your own criteria for more complex AND or OR conditions.

Making it to the Top Ten!
The Top Ten option on the Number Filters option’s submenu enables you to filter 
out all records except those whose entries in that field are at the top or bottom of 
the table by a certain number (10 by default) or in a certain top or bottom percent 
(10 by default). You can only use the Top Ten item in numerical fields and date 
fields; this kind of filtering doesn’t make any sense when you’re dealing with 
entries in a text field.

When you click the Top Ten option on the Number Filters option’s submenu, Excel 
opens the Top 10 AutoFilter dialog box where you can specify your filtering crite-
ria. By default, the Top 10 AutoFilter dialog box is set to filter out all records except 
those whose entries are among the top ten items in the field by selecting Top in 
the drop-down list box on the left, 10 in the middle combo box, and Items in the 
drop-down list box on the right. If you want to use these default criteria, you click 
OK in the Top 10 AutoFilter dialog box.

Figure  2-2 (sample workbook: Employee Table.xlsx) shows you the sample 
employee table after using the Top 10 Items AutoFilter to display only the records 
with the top ten salaries in the table.
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You can also change the filtering criteria in the Top 10 AutoFilter dialog box before 
you filter the data. You can choose between Top and Bottom in the leftmost drop-
down list box and between Items and Percent in the rightmost one. You can also 
change the number in the middle combo box by clicking it and entering a new 
value or using the spinner buttons to select one.

Filtering a table on a field’s font and  
fill colors or cell icons
Just as you can sort a table using the font or fill color or cell icons that you’ve 
assigned with the Conditional Formatting feature to values in the field that are 
within or outside of certain parameters (see the section on the Conditional Format-
ting feature in Book 2, Chapter 2 for details), you can also filter the table.

To filter a table on a font color, fill color, or cell icon used in a field, you click its 
AutoFilter button and then select the Filter by Color option from the drop-down 
menu. Excel then displays a submenu from which you choose the font color, fill 
color, or cell icon to use in the sort:

 » To filter the table so that only the records with a particular font color in the 
selected field — assigned with the Conditional Formatting Highlight Cell Rules 
or Top/Bottom Rules options — appear in the table, click its color swatch in 
the Filter by Font Color submenu.

 » To filter the table so that only the records with a particular fill color in the 
selected field — assigned with the Conditional Formatting Highlight Cell Rules, 
Top/Bottom Rules, Data Bars, or Color Scales options — appear in the table, 
click its color swatch in the Filter by Font Color submenu.

 » To filter the table so that only the records with a particular cell icon in the 
selected field — assigned with the Conditional Formatting Icon Sets options — 
appear in the table, click the icon in the Filter by Cell Icon submenu.

FIGURE 2-2:  
Using the Top 10 
Items AutoFilter 

to filter out all 
records except 

for those with the 
top ten salaries. 

(Sample  
workbook: 
Employee  

Table.xlsx)
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Custom AutoFilter at your service
You can click the Custom Filter option on a field’s Text Filters, Date Filters, or 
Number Filters continuation menu to open the Custom AutoFilter dialog box, 
where you can specify your own filtering criteria by using conditions with the 
AND or OR logical operators (called AND OR conditions for short). When you click 
the Custom Filter option, Excel opens the Custom AutoFilter dialog box, similar to 
the one shown in Figure 2-3 (sample workbook: Employee Table.xlsx).

Here, you select the type of operator to use in evaluating the first and second con-
ditions in the top and bottom drop-down list boxes and the values to be evaluated 
in the first and second conditions in the associated combo boxes. You also specify 
the type of relationship between the two conditions with the And option button. 
(The And option button is selected by default.)

When selecting the operator for the first and second condition in the leftmost 
drop-down list boxes at the top and bottom of the Custom AutoFilter dialog box, 
you have the following choices, depending on the types of entries in the selected 
field:

 » Equals: Matches records where the entry in the field is identical to the text, 
date, or number you enter in the associated combo box.

 » Does Not Equal: Matches records where the entry in the field is anything 
other than the text, date, or number you enter in the associated combo box.

 » Is After: Matches records where the entry in the date field comes after the 
date you enter or select in the associated combo box.

 » Is After or Equal To: Matches records where the entry in the date field comes 
after or is the same as the date you enter or select in the associated 
combo box.

 » Is Before: Matches records where the entry in the date field precedes the 
date you enter or select in the associated combo box.

FIGURE 2-3:  
Using Custom 

AutoFilter to 
filter out records 
except for those 

within a range of 
salaries. (Sample 

workbook: 
Employee  

Table.xlsx)
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 » Is Before or Equal To: Matches records where the entry in the date field 
precedes or is the same as the date you enter or select in the associated 
combo box.

 » Is Greater Than: Matches records where the entry in the field follows the 
text in the alphabet, comes after the date, or is larger than the number you 
enter in the associated combo box.

 » Is Greater Than or Equal To: Matches records where the entry in the field 
follows the text in the alphabet or is identical, the date comes after or is 
identical, or the number is larger than or equal to the one you enter in the 
associated combo box.

 » Is Less Than: Matches records where the entry in the field comes before the 
text in the alphabet, comes before the date, or is less than the number you 
enter in the associated combo box.

 » Is Less Than or Equal To: Matches records where the entry in the field comes 
before the text in the alphabet or is identical, the date comes before or is 
identical, or the number is less than or equal to the one you enter in the 
associated combo box.

 » Begins With: Matches records where the entry in the field starts with the text, 
the part of the date, or the number you enter in the associated combo box.

 » Does Not Begin With: Matches records where the entry in the field starts 
with anything other than the text, the part of the date, or the number you 
enter in the associated combo box.

 » Ends With: Matches records where the entry in the field ends with the text, 
the part of the date, or the number you enter in the associated combo box.

 » Does Not End With: Matches records where the entry in the field ends with 
anything other than the text, the part of the date, or the number you enter in 
the associated combo box.

 » Contains: Matches records where the entry in the field contains the text, the 
part of the date, or the number you enter in the associated combo box.

 » Does Not Contain: Matches records where the entry in the field contains 
anything other than the text, the part of the date, or the number you enter in 
the associated combo box.

Note that you can use the Begins With, Ends With, and Contains operators and 
their negative counterparts when filtering a text field  — you can also use the 
question mark (?) and asterisk (*) wildcard characters when entering the values 
for use with these operators. (The question mark wildcard stands for individual 
characters, and the asterisk stands for one or more characters.) You use the other 
logical operators when dealing with numeric and date fields.
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When specifying the values in the associated combo boxes on the right side of the 
Custom AutoFilter dialog box, you can type the text, number, or date, or you can 
select an existing field entry by clicking the box’s drop-down list button and then 
clicking the entry on the drop-down menu. In date fields, you can select the dates 
directly from the date drop-down palette opened by clicking the box’s Date Picker 
button (the one with the calendar icon).

Figure 2-3 illustrates setting up filtering criteria in the Custom AutoFilter dialog 
box that selects records whose Salary values fall within two separate ranges of 
values. In this example, I’m using an OR condition to filter out all records where 
the salaries fall below $100,000 or are greater than $75,000 by entering the fol-
lowing complex condition:

Salary Is Greater Than 75000 OR Is Less Than 100000

Using the Advanced Filter
When you use advanced filtering, you don’t use the field’s AutoFilter buttons and 
associated drop-down menu options. Instead, you create a so-called criteria range 
somewhere on the worksheet that contains the table to be filtered before opening 
the Advanced Filter dialog box.

When you use the Advanced Filter feature to do a query, you extract copies of the 
records that match your criteria by creating a subset of the table. You can locate 
the criteria range to the right of the table and then specify the Copy To range 
underneath the criteria range, similar to the arrangement shown in Figure 2-4 
(sample workbook: Employee Table with Criteria Range.xlsx).

To create a criteria range, you copy the names of the fields in the table to a new 
part of the worksheet and then enter the values (text, numbers, or formulas) that 
are to be used as the criteria in filtering the table in rows underneath. When set-
ting up the criteria for filtering the table, you can create either comparison criteria 
or calculated criteria.

After you’ve set up your criteria range with all the field names and the criteria that 
you want used, you click the Data tab’s Advanced command (or press Alt+AQ) to 
open the Advanced Filter dialog box similar to the one shown in Figure 2-4. Here, 
you specify whether you just want to filter the records in the table (by hiding the 
rows of all those that don’t meet your criteria) or you want to copy the records that 
meet your criteria to a new area in the worksheet (by creating a subset of the table).
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To just filter the data in the table, leave the Filter the List, In-Place option but-
ton selected. To query the table and copy the data to a new place in the same 
worksheet (note that the Advanced Filter feature doesn’t let you copy the data to 
another sheet or workbook), you select the Copy to Another Location option but-
ton. When you select this option button, the Copy To text box becomes available, 
along with the List Range and Criteria Range text boxes.

To specify the table that contains the data that you want to filter or query, click 
the List Range text box and then enter the address of the cell range or select 
it directly in the worksheet by dragging through its cells. To specify the range 
that contains a copy of the field names along with the criteria entered under the 
appropriate fields, you click the Criteria Range text box and then enter the range 
address of this cell range or select it directly in the worksheet by dragging through 
its cells. When selecting this range, be sure that you include all the rows that con-
tain the values that you want evaluated in the filter or query.

FIGURE 2-4:  
Using Advanced 

Filter to copy 
records that meet 

the criteria in  
the Criteria 

Range. (Sample  
workbook: 

Employee Table 
with Criteria 
Range.xlsx)

ONLY THE UNIQUE NEED APPLY!
To filter out duplicate rows or records that match your criteria, select the Unique 
Records Only check box in the Advanced Filter dialog box. You can remove the display 
of all duplicate records from a table by selecting this check box and removing all cell  
references from the Criteria Range text box before you click OK.
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If you’re querying the table by copying the records that meet your criteria to a new 
part of the worksheet (indicated by clicking the Copy to Another Location option 
button), you also click the Copy To text box and then enter the address of the cell 
that is to form the upper-left corner of the copied and filtered records or click this 
cell directly in the worksheet.

After specifying whether to filter or query the data and designating the ranges 
to be used in this operation, click OK to have Excel apply the criteria that you’ve 
specified in the criteria range in either filtering or copying the records.

After filtering a table, you may feel that you haven’t received the expected 
results  — for example, no records are listed under the field names that you 
thought should have several. You can bring back all the records in the table by 
clicking the Data tab’s Clear command or by pressing Alt+AC. Now you can fiddle 
with the criteria in the criteria range text box and try the whole advanced filtering 
thing all over again.

Specifying comparison criteria
Entering selection criteria in the Criteria Range for advanced filtering is very sim-
ilar to entering criteria in the data form after selecting the Criteria button. How-
ever, you need to be aware of some differences. For example, if you are searching 
for the last name Paul and enter the label Paul in the criteria range under the cell 
containing the field name Last Name, Excel matches any last name that begins 
with P-a-u-l such as Pauley, Paulson, and so on. To avoid having Excel match any 
other last name beside Paul, you would have to enter a formula in the cell below 
the one with the Last Name field name, as in

="Paul"

When entering criteria for advanced filtering, you can also use the question mark 
(?) or the asterisk (*) wildcard character in your selection criteria just like you do 
when using the data form to find records. If, for example, you enter J*n under the 
cell with the First Name field name, Excel considers any characters between J and 
n in the First Name field to be a match including Joan, Jon, or John as well as Jane 
or Joanna. To restrict the matches to just those names with characters between J 
and n and to prevent matches with names that have trailing characters, you need 
to enter the following formula in the cell:

="J*n"

When you use a selection formula like this, Excel matches names such as Joan, 
Jon, and John but not names such as Jane or Joanna that have a character after 
the n.
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When setting up selection criteria, you can also use the other comparative opera-
tors, including >, >=, <, <=, and <>, in the selection criteria. See Table 2-1 for 
descriptions and examples of usage in selection criteria for each of these logical 
operators.

To find all the records where a particular field is blank in the database, enter = 
and press the spacebar to enter a space in the cell beneath the appropriate field 
name. To find all the records where a particular field is not blank in the database, 
enter <> and press the spacebar to enter a space in the cell beneath the appropri-
ate field name.

Setting up logical AND logical OR conditions
When you enter two or more criteria in the same row beneath different field 
names in the Criteria Range, Excel treats the criteria as a logical AND condition 
and selects only those records that meet both criteria. Figure 2-5 (sample work-
book: Employee Table with Criteria Range.xlsx) shows an example of the results 
of a query that uses an AND condition. Here, Excel has copied only those records 
where the location is Boston and the date hired is before January 1, 2000, because 
both the criteria Boston and <1/1/00 are placed in the same row (row 2) under their 
respective field names, Location and Date Hired.

When you enter two or more criteria in different rows of the Criteria Range, Excel 
treats the criteria as a logical OR and selects records that meet any one of the 
criteria they contain. Figure 2-6 (sample workbook: Employee Table with Criteria 
Range.xlsx) shows you an example of the results of a query using an OR condi-
tion. In this example, Excel has copied records where the location is either Boston 

TABLE 2-1 The Comparative Operators in the Selection Criteria
Operator Meaning Example Locates

= Equal to =“CA” Records where the state is CA

> Greater than >m Records where the name starts with a letter after M (that is, N 
through Z)

>= Greater than >=3/4/02 Records where the date is on or after or equal to March 4, 2002

< Less than <d Records where the name begins with a letter before D (that is, 
A, B, or C)

<= Less than <=12/12/04 Records where the date is on or before or equal to 
December 12, 2004

<> Not equal to <>“CA” Records where the state is not equal to CA
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or San Francisco because Boston is entered under the Location field name in the 
second row (row 2) of the Criteria Range above San Francisco entered in the third 
row (row 3).

When creating OR conditions, you need to remember to redefine the Criteria 
Range to include all the rows that contain criteria, which in this case is the cell 
range L2:U3. (If you forget, Excel uses only the criteria in the rows included in the 
Criteria range.)

FIGURE 2-5:  
Copied records 

where the  
location is Boston 

and the date 
hired is prior to 
January 1, 2000. 

(Sample  
workbook: 

Employee Table 
with Criteria 
Range.xlsx)

FIGURE 2-6:  
Copied records 

where the  
location is Boston 

and the date 
hired prior to 

January 1, 2000 
or the location 

is San Francisco 
location for any 

date hired.  
(Sample  

workbook: 
Employee  
Table with  

Criteria  
Range.xlsx)
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When setting up your criteria, you can combine logical AND and logical OR con-
ditions (again, assuming you expand the Criteria Range sufficiently to include 
all the rows containing criteria). For example, if you enter Boston in cell R2 
(under Location) and <1/1/00 in cell S2 (under Date Hired) in row 2 and enter San  
Francisco in cell R3 and then repeat the query, Excel copies the records where 
the location is Boston and the date hired is before January 1, 2000, as well as the 
records where the location is San Francisco (regardless of the date hired).

Setting up calculated criteria
You can use calculated criteria when filtering or querying your table. All you need 
to do is enter a logical formula that Excel can evaluate as either TRUE or FALSE in 
the Criteria Range under a made-up name that is not any field name used in the 
table (I repeat, is not a field name in the table). Calculated criteria enable you to 
filter or query records based on a comparison of entries in a particular field with 
entries in other fields of the table or based on a comparison with entries in the 
worksheet that lie outside the table itself.

Figure 2-7 (sample workbook: Employee Table with Calculated Criteria.xlsx) shows 
an example of using a calculated criterion that compares values in a field to a  
calculated value that isn’t actually entered in the table. Here, you want to perform 
a query that copies all the records from the Employee table where the employee’s 
salary is above the average salary. In this figure, cell V2 contains the formula that 
uses the AVERAGE function to compute average employee salary and then com-
pares the first salary entry in cell F2 of the table to that average with the following 
formula:

=F2 > AVERAGE($F$2:$F$33)

FIGURE 2-7:  
Copied records 
extracted from 

the table for 
employees whose 

salaries are 
above the salary 

average. (Sample 
workbook: 

Employee Table 
with Calculated 

Crtieria.xlsx)
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Note that this logical formula is placed under the label Calculated Criteria in cell 
V2, which has been added to the end of the criteria range. Cell F2 is the first cell 
in the table that contains a salary entry. The cell range, $F$2:$F$33, used as the 
argument of the AVERAGE function, is the range in the Salary field that contains 
all the salary entries.

To use this calculated criterion, you must remember to place the logical formula 
under a name that isn’t used as a field name in the table itself. (In this example, 
the label Calculated Criteria does not appear anywhere in the row of field names.) 
You must include this label and formula in the Criteria Range. (For this query 
example, the criteria range is defined as the range L2:V2.)

When you then perform the query by using the Advanced Filter feature, Excel 
applies this calculated criterion to every record in the database. Excel does this by 
adjusting the first Salary field cell reference F2 (entered as a relative reference) 
as the program examines the rest of the records below. Note, however, that the 
range reference specified as the argument of the AVERAGE function is entered as 
an absolute reference ($F$2:$F$33) in the criterion formula so that Excel won’t 
adjust this reference but compare the Salary entry for each record to AVERAGE 
computed for this entire range (which just happens to be 40,161).

When entering formulas for calculated criteria that compare values outside the 
table to values in a particular field, you should always reference the cell contain-
ing the very first entry for that field to ensure that Excel applies your criteria to 
every record in the table.

You can also set up calculated criteria that compare entries in one or more fields 
to other entries in the table. For example, to extract the records where the Years of 
Service entry is at least two years greater than the record above it (assuming you 
have sorted the table in ascending order by years of service), you would enter the 
following logical formula under the cell labeled Calculated Criteria:

=I3 > I2 + 2

Most often, when referencing cells within the table itself, you want to leave the 
cell references relative so that they can be adjusted, because each record is exam-
ined, and the references to the cells outside the database are absolute so that these 
won’t be changed when making the comparison with the rest of the records.

When you enter the logical formula for a calculated criterion, Excel returns the 
logical value TRUE or FALSE. This logical value applies to the field entry for the first 
record in the table that you refer to in the logical formula. By inspecting this field 
entry in the database and seeing whether it does indeed meet your intended selec-
tion criteria, you can usually tell whether your logical formula is correct.
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Using the AND, OR, and NOT functions  
in calculated criteria
You can also use Excel’s AND, OR, and NOT functions with the logical operators in 
calculated criteria to find records that fall within a range. For example, to find all 
the records in the employee database where the salaries range between $55,000 
and $75,000, you would enter the following logical formula with the AND function 
under the cell with the label Calculated Criteria:

=AND(F2 >= 55000, F2 <= 75000)

To find all the records in the Employee table where the salary is either below 
$29,000 or above $45,000, you would enter the following logical formula with the 
OR function under the cell with the label Calculated Criteria:

=OR(F2 < 29000, F2 > 45000)

Using the Database Functions
Excel includes several so-called database functions that you can use to calculate 
statistics, such as the total, average, maximum, minimum, and count in a partic-
ular field of the table only when the criteria that you specify are met. For example, 
you could use the DSUM function in the sample Employee table to compute the 
sum of all the salaries for employees who were hired after January 1, 2000, or you 
could use the DCOUNT function to compute the number of records in the table for 
the Human Resources department.

The database functions, regardless of the difference in names (they all begin with 
the letter D) and the computations that they perform, all take the same three 
arguments as illustrated by the DAVERAGE function:

DAVERAGE(database, field, criteria)

The arguments for the database functions require the following information:

 » database is the argument that specifies the range containing the table, and it 
must include the row of field names in the top row.

 » field is the argument that specifies the table column from which the values  
are to be calculated by the database function (averaged in the case of the 
DAVERAGE function). You can specify this argument by enclosing the name of 
the field in double quotes (as in “Salary” or “Date Hired”), or you can do this by 
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entering the number of the column in the table (counting from left to right 
with the first field counted as 1).

 » criteria is the argument that specifies the address of the range that contains 
the criteria that you’re using to determine which values are calculated. This 
range must include at least one field name that indicates the field whose 
values are to be evaluated and one cell with the values or expression to be 
used as the criteria.

Note that in specifying the field argument, you must refer to a column in the table 
that contains numeric or date data for all the database functions with the exception 
of DGET. All the rest of the database functions can’t perform computations on text 
fields. If you mistakenly specify a column with text entries as the field argument for 
these database functions, Excel returns an error value or 0 as the result. Table 2-2 
lists the various database functions available in Excel along with an explanation of 
what each one calculates. (You already know what arguments each one takes.)

TABLE 2-2 The Database Functions in Excel
Database Function What It Calculates

DAVERAGE Averages all the values in a field of the table that match the criteria you specify.

DCOUNT Counts the number of cells with numeric entries in a field of the table that match the 
criteria you specify.

DCOUNTA Counts the number of nonblank cells in a field of the table that match the criteria 
you specify.

DGET Extracts a single value from a record in the table that matches the criteria you 
specify. If no record matches, the function returns the #VALUE! error value. If 
multiple records match, the function returns the #NUM! error value.

DMAX Returns the highest value in a field of the table that matches the criteria you specify.

DMIN Returns the lowest value in a field of the table that matches the criteria you specify.

DPRODUCT Multiplies all the values in a field of the table that match the criteria you specify.

DSTDEV Estimates the standard deviation based on the sample of values in a field of the table 
that match the criteria you specify.

DSTDEVP Calculates the standard deviation based on the population of values in a field of the 
table that match the criteria you specify.

DSUM Sums all the values in a field of the table that match the criteria you specify.

DVAR Estimates the variance based on the sample of values in a field of the table that 
match the criteria you specify.

DVARP Calculates the variance based on the population of values in a field of the table that 
match the criteria you specify.
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The database functions are too rarely used to rate their own command button on the 
Ribbon’s Formulas tab. As a result, to use them in a worksheet, you must click the  
Insert Function (fx) button on the Formula bar, select Database from the Select a  
Category drop-down list box, and then click the function. You can also type the data-
base function directly into the cell.

Figure  2-8 (sample workbook: Employee Table with Database Function.xlsx) 
illustrates the use of the database function DSUM. Cell C2 in the worksheet shown 
in this figure contains the following formula:

=DSUM(Table1[#All], "Salary", F1:F2)

This DSUM function computes the total of all the salaries in the table that are 
above $55,000. This total is $468,500, as shown in cell C2, which contains the 
formula.

To perform this calculation, I specified the range A3:J35, which contains the entire 
table. This range includes the top row of field names as the database argument 
(which Excel automatically converted to its range name equivalent, Table1[#All]). 
I then specified “Salary” as the field argument of the DSUM function because this 
field name contains the values that I want totaled. Finally, I specified the range 
F1:F2 as the criteria argument of the DSUM function because these two cells con-
tain the criteria range that designate that only the values exceeding 55000 in the 
Salary field are to be summed.

Querying External Data
Excel enables you to query tables stored in external databases to which you have 
access and then extract the data that interests you into your worksheet for fur-
ther manipulation and analysis. These data sources can include Microsoft Access 

FIGURE 2-8:  
Using DSUM to 

total the salaries 
over $55,000 in 

the Employee 
table. (Sample 

workbook: 
Employee Table 

with Database 
Function.xlsx)
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database files, web pages, text files, and other data sources, such as database 
tables on SQL Server or Oracle, XML data files, and data tables from online con-
nections such as Azure Table Storage.

When importing data from such external sources into your Excel worksheets, you 
may well be dealing with data stored in multiple related tables all stored in the 
database (what Excel refers to as a data model). The relationship between different 
tables in the same database is based on a common field (column) that occurs in 
each related data table, which is officially known as a key field, but in Excel is gen-
erally known as a lookup column. When relating tables on a common key field, in 
at least one table, the records for that field must all be unique with no duplicates, 
such as a Clients table where each item in the Customer ID field is unique (where 
it’s known as the primary key). In the other related table, the common field (known 
as the foreign key) may or may not be unique as in an Orders data table where a 
particular entry in its Customer ID field can appear multiple times, as it’s quite 
permissible (even desirable) to have the same client making multiple purchases.

There’s only one other thing to keep in mind when working with related data 
tables and that is the type of relationship that exists between the two tables. Two 
types of relationships are supported in a data model:

 » One-to-one relationship where the entries in both the primary and foreign 
key fields are unique such as a relationship between a Clients table and 
Discount table where the Customer ID field occurs only once in each table  
(as each client has only one discount percentage assigned).

 » One-to-many relationship where duplicate entries in the foreign key field 
are allowed, as in a relationship between a Clients table and an Orders table 
where the Customer ID field may occur multiple times (as the client makes 
multiple purchases).

Most of the time, Excel can figure out the relationship between the data tables 
you import. However, if Excel should ever get it wrong or your tables contain 
more than one common field that could possibly serve as the key, you can manu-
ally define the proper relationship. In the Data tab’s Data Tools group, select the 
Relationships button (or press Alt+AA) to open the Manage Relationships dialog 
box. Click New to open the Create Relationship dialog box, where you define the 
common field in each of the two related data tables. After creating this relation-
ship, you can use any of the fields in either of the two related tables in reports that 
you prepare or PivotTables that you create. (See Book 7, Chapter 2 for details on 
creating and using PivotTables.)
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To import data from external database files and tables, you select the Data tab’s 
Get Data drop-down button in the Get & Transform Data group (or press Alt+APN). 
Excel displays a menu with the following choices:

 » From File: Enables you to import data from a file saved on a local or network 
drive in various file formats, including Excel workbook, text or CSV (Comma 
Delimited Value), XML (Extensible Markup Language), and JSON (JavaScript 
Object Notation) file formats.

 » From Database: Enables you to import data from tables in a specific type of 
database file, including SQL Server Database, Microsoft Access, Analysis 
Services, and SQL Analysis Server Database.

 » From Azure: Enables you to import data from an Azure SQL database or one 
of the various storage spaces available on this Microsoft cloud service (visit 
https://azure.microsoft.com for more information).

 » From Power BI dataset: Enables you to launch Power BI (Business 
Intelligence), a Microsoft visual data analytics program, and import data into 
Excel from the Power BI Data Catalog (see https://powerbi.microsoft.
com for more information).

 » From Online Services: Enables you to import data saved on an online service 
to which you already subscribe, such as Microsoft Exchange Online, Dynamics 
365, or Salesforce.

 » From Other Sources: Enables you to import data from a variety of sources, 
including From Sheet (a range or table in the existing workbook) or From Web 
(tables on a web page) or using existing queries from Microsoft Query, OData 
Feed, ODBC (Open Database Connectivity), OLEDB (Object Linking and 
Embedded Database), and Blank Query to create a new query with Excel’s 
Power Query Editor add-in.

 » Combine Queries: Enables you to merge two existing data tables in the 
current workbook or append one data table to another.

 » Launch Power Query Editor: Opens Excel’s Query Editor add-in that enables 
you to create advanced data queries that connect various data sources and 
perform complex analysis.

 » Data Source Settings: Opens the Data Source Settings dialog box where you 
can manage permissions for the external data sources that Excel can use in 
data queries.

 » Query Options: Opens the Query Options dialog box where you manage the 
global and current workbook load and privacy settings.

https://azure.microsoft.com
https://powerbi.microsoft.com
https://powerbi.microsoft.com
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Retrieving data from Access  
database tables
To make an external data query to a Microsoft Access database table, choose 
Data➪   Get Data➪   From Database➪   From Microsoft Access Database (or press 
Alt+APNDC). Excel opens the Import Data dialog box, where you select the name 
of the Access database (using the .accdb or .mdb file extension) and then click the 
Import button.

After Excel establishes a connection with the Access database file, the Navigator 
dialog box opens, similar to the one shown in Figure 2-9 (sample file: Northwind.
accdb). The Navigator dialog box is divided into two panes: Selection on the left 
and Preview on the right. When you click the name of a data table or query in the 
Selection Pane, Excel displays a portion of the Access data in the Preview pane on 
the right. To import multiple (related) data tables from the selected Access data-
base, select the Select Multiple Items check box. Excel then displays check boxes 
before the name of each table in the database. After you select the check boxes for 
all the tables you want to import, you have a choice of options:

 » Load: Imports the Access file data from the item(s) selected in the Navigator 
directly into the current worksheet starting at the cell cursor’s cur-
rent position.

 » Load➪  Load To: Opens the Import Data dialog box where you can specify how 
you want to view the imported Access data (as a worksheet table, a PivotTable, 
a PivotChart, or as a data connection without importing any data) and where 
to import the Access data (existing or new worksheet) as well as whether to 
add the Access data to the worksheet’s data model.

 » Transform Data: Displays the Access data table(s) in the Excel Power Query 
Editor where you can further query and transform the data before importing 
into the current Excel worksheet with its Close & Load or Close & Load To 
option.

When you select the Load To option to specify how and where to import the Access 
data, the Import Data dialog box contains the following options:

 » Table: Imports the Access data into an Excel table in either the current or new 
worksheet — see the “Existing Worksheet” and “New Worksheet” bullets that 
follow. Note that when you import more than one data table, the Existing 
Worksheet option is no longer available, and the data from each imported 
data table is imported to a separate new worksheet in the current workbook.

 » PivotTable Report: Imports the Access data into a new PivotTable (see  
Book 7, Chapter 2) that you can construct with the Access data.
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 » PivotChart: Imports the Access data into a new PivotTable (see Book 7, 
Chapter 2) with an embedded PivotChart that you can construct with the 
Access data.

 » Only Create Connection: Creates a connection to the Access database 
table(s) that you can use later to import its data.

 » Existing Worksheet: Imports the Access data into the current worksheet 
starting at the current cell address listed in the text box below.

 » New Worksheet: Imports the Access data into a new sheet that’s added to 
the end of the sheets already in the workbook.

 » Add This Data to the Data Model: Adds the Access data to the data model 
already defined in the Excel workbook using relatable, key fields.

 » Properties: Opens the drop-down menu with the Import Relationships 
Between Tables check box (selected by default) and Properties item. Deselect 
the check box to prevent Excel from recognizing the relationship established 
between the data tables in Access. Click the Properties button to open the 
Connection Properties dialog box, where you can modify all sorts of connec-
tion properties, including when the Access data’s refreshed in the Excel 
worksheet and how the connection is made.

FIGURE 2-9:  
Using the  

Navigator to 
select which 

data tables and 
queries from the 

Northwind Access  
database to 

import into the 
current Excel 

worksheet. 
(Sample file: 

Northwind.accdb)
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Figure 2-10 (sample file: Northwind.accdb) shows you a workbook after importing 
both the Customers and Orders tables from the sample Northwind Access data-
base as new tables on separate worksheets. When I imported the two data tables, 
Excel automatically added two new worksheets (named Customers and Orders) to 
the workbook, while at the same time importing the Customers data table to the 
Customers sheet and the Orders data table to the Orders sheet.

Figure 2-11 (sample file: Northwind.accdb) shows the same new workbook, this 
time with the Orders worksheet selected and the Manage Relationships dialog 
box open (by clicking the Data tab’s Relationships button or pressing Alt+AA). 
When Excel imported these two data tables, it automatically picked up on and 
retained the original relationship between them in the Northwind database, where 
the CustomerID field is the primary key field in the Customers data table and a 
foreign key field in the Orders data table.

After importing the external data into one of your Excel worksheets, you can then 
use the Filter buttons attached to the various fields to sort the data (as described 
in Book 6, Chapter 1) and filter the data (as described earlier in this chapter).

After you import data from an external source, such as a Microsoft Access data-
base, Excel automatically displays a Queries & Connections task pane with two 
tabs: Queries, which displays the source(s) of the data imported into the current 
workbook, and Connections, which displays their connection to the workbook data 
model (and to each other if there are multiple sources and they are related to 
each other). If this task pane is not currently displayed in the current worksheet, 
choose Data➪  Queries & Connections (or press Alt+AO) to redisplay it.

FIGURE 2-10:  
Customers  
worksheet 

with the data 
imported from 

the Access  
Customers data 

table in the 
sample  

Northwind  
database.  

(Sample file: 
Northwind.accdb)
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Excel keeps a list of all the external data sources and data queries you make to the 
current workbook so that you can reuse them to import updated data from another 
database or web page. To quickly reconnect with a data source, click the Data tab’s 
Recent Sources button (or press Alt+PR) to open the Recent Sources dialog box 
where you click the name of the external file before you select the Connect but-
ton. To reuse a query, click the Data tab’s Existing Connections button (or press 
Alt+AX) to open the Existing Connections dialog box to access this list and then 
click the name of the query to repeat before you click the Open button.

Retrieving data from the web
To make a web page query, choose Data➪  Get Data➪  From Other Sources➪  From 
Web (or press Alt+AFW). Excel then opens the From Web dialog box containing a 
URL text box where you specify the address of the web page containing the data 
you want to import into Excel as in

www.nasdaq.com

After you click OK in the From Web dialog box, Excel establishes a connection with 
the web page before opening the Navigator dialog box (similar to the one shown 
earlier in Figure 2-9). When you select a table in the list in the Selection pane on 
the left, Excel displays a preview of the data in the Table View tab of the Preview 
pane on the right (to display the data more or less as it appears on the web page 
itself, you click the Web View tab in this pane). To import more than one table of 
data from a web page, click the Select Multiple Items check box and then click the 
check boxes in front of the name (Table 1, Table 2, and so on) you want imported.

FIGURE 2-11:  
Orders worksheet 

with the data 
imported from 

the Orders data 
table in  

the sample 
Northwind  

database  
showing the  
relationship 

with the  
Customers table. 

(Sample file: 
Northwind.accdb)

http://www.nasdaq.com
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After you finish checking the table or tables you want to import on the page, you 
can select one of the following three import options:

 » Load: Imports the web data in the tables selected in the Navigator directly 
into the current worksheet starting at the cell cursor’s current position.

 » Load➪  Load To: Opens the Import Data dialog box where you can choose 
how you want to view the imported web data (as a worksheet table, 
PivotTable, PivotChart, or just data connection without importing any 
data) and where to import the web data (into an existing or new worksheet) 
as well as whether to add the web data to the worksheet’s data model.

 » Transform Data: Display the web data table(s) in the Excel Power Query 
Editor where you can further query and transform the data before importing 
into the current Excel worksheet with its Close & Load or Close & Load To 
option.

After importing your web data into a new or existing worksheet, you can then 
manipulate the data as you would any other worksheet table, including filtering it 
and sorting with the AutoFilter buttons.

When working with tables of stock quotes imported from financial websites, such 
as NASDAQ and MSN Money, during periods when the markets are still open and 
active, you can use the Data tab’s Refresh All command (or press Alt+ARA) to keep 
the stock prices and trading volume entries in your worksheet up to date.

You can only make web queries when your computer has Internet access. So, if 
you’re using Excel on a device that can’t connect to the web at the moment, you 
won’t be able to perform a new web query until you get to a place where you can 
get online.

Retrieving data from text files
If you have a text file containing data you need to bring into your worksheet, you 
can import it by choosing Data➪  Get Data➪  From File➪   From Text/CSV (or press 
Alt+AFT) and then selecting the file to use in the Import Data dialog box. After you 
select the text file containing the data you need to retrieve in this dialog box and 
click its Import button, Excel opens the Navigator dialog box with the name of the 
text or CSV (Comma Separated Value) file as its title.

This version of the Navigator, as shown in Figure 2-12 (sample file: Employees.
txt), automatically scans and analyzes the data in the text or CSV file and attempts 
to correctly split up (or parse) its data into separate cells of the worksheet based 
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on what Excel character the program determines is the standard character used to 
separate each data item (such as a comma or tab) in every line, just as it uses the 
character for the Enter key to mark the separation of each line of data within the file.

Text files that use the comma to separate data items are known as CSV files (for 
Comma Separated Values). Those that use tabs to separate the individual data 
items are known as tab delimited files. Note that some programs use the generic 
term, delimited files, to refer to any text file that uses a standard character, such as 
a comma or tab, to separate its individual data items.

If Excel has correctly parsed the data in your text or CSV file as shown in the 
preview in the Navigator, you can then select one of the following three import 
options to bring the data into your worksheet:

 » Load: Imports the parsed text data previewed in the Navigator directly into 
the current worksheet starting at the cell cursor’s current position.

 » Load➪  Load To: Opens the Import Data dialog box where you can 
choose how you want to view the imported text data (as a worksheet 
table, PivotTable, PivotChart, or just data connection without importing any 
data) and where to import the text data (into an existing or new worksheet) 
as well as whether to add the text data to the worksheet’s data model.

FIGURE 2-12:  
Importing the 

data in a  
tab-delimited 
text file into a 

worksheet using 
the options in 

Navigator dialog 
box. (Sample file: 

Employees.txt)
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 » Transform Data: Displays the parsed text data in the Excel Power Query 
Editor where you can further query and transform the data before importing 
into the current Excel worksheet with its Close & Load or Close & Load To 
option.

If Excel has not correctly parsed the data in your text or CSV file in the preview in 
the Navigator, you can try changing one of the three settings used in determining 
how the data is parsed before proceeding with any kind of import:

 » File Origin: Select a new text file type based on its country code on the 
File Origin drop-down menu.

 » Delimiter: Select a new delimiting character on the Delimiter drop-down 
menu to be used in parsing the data into separate cells.

 » Data Type Detection: Change the number of rows used in trying to deter-
mine whether the parsed data is a number, date, or text value either by 
selecting the Based on Entire Dataset option on the Data Type Detection 
drop-down menu to use all the rows in the file or select Do Not Detect Data 
Types option to prevent Excel from trying to differentiate the data types.

If Excel still can’t correctly parse your text or CSV file in the preview and insists 
on importing each row of text data into a single column, all is not lost. You can 
still go ahead with the import and then after bringing the data of the text file into 
a new or existing worksheet, use the Convert to Text Wizard to correctly parse it 
into separate columns.

To do this, select the cells with the imported text data. then click the Data tab’s 
Text to Columns command (or press Alt+AE). Excel opens the Convert Text to 
Columns Wizard - Step 1 of 3 dialog box. Here, you choose between the Delimited 
and Fixed Width option determine how the data is to be separated before click-
ing the Next button to open the Convert Text to Columns Wizard - Step 2 of 3  
dialog box.

In the Step 2 of 3 dialog box when you previously selected the Delimited option  
in the Step 1 of 3 dialog box, you need to select the delimiting character if the  
wizard selects the wrong character in the Delimiters section before clicking the 
Next button. If your text file uses a custom delimiting character, you need to select 
the Other check box and then enter that character in its text box. If your file uses 
two consecutive characters (such as a comma and a space), you need to select their 
check boxes as well as the Treat Consecutive Delimiters As One check box.

By default, the Convert Text to Columns Wizard treats any characters enclosed in 
a pair of double quotes as text entries (as opposed to numbers). If your text file 
uses a single quote, click the single quote (‘) character in the Text Qualifier drop-
down list box.
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If, instead, you selected the Fixed Width option in the Step 1 of 3 dialog box, the 
Step 2 of 3 dialog box previews the column breaks that indicate how the text data 
appears when split apart into separate columns of the worksheet. You can then 
modify the column breaks in the preview with your mouse. Click in the sample 
data shown in the Data Preview area to create new column breaks and modify the 
extent of the breaks by dragging their borders. When the column breaks in the 
data preview appear correct, click the Next button to open the Convert Text to 
Columns Wizard - Step 3 of 3 dialog box.

In the Step 3 of 3 dialog box, you get to assign a data type to the various columns 
of text data or indicate that a particular column of data should be skipped and 
therefore not imported into your Excel worksheet.

When setting data formats for the columns of the text file, you can choose among 
the following three data types:

 » General (the default) to convert all numeric values to numbers, entries 
recognized as date values to dates, and everything else in the column to text

 » Text to convert all the entries in the column to text

 » Date to convert all the entries to dates by using the date format shown in the 
associated drop-down list box

To assign one of the three data types to a column, click its column in the Data Pre-
view section and then click the appropriate radio button (General, Text, or Date) 
in the Column Data Format section in the upper-left corner.

In determining values when using the General data format, Excel uses the  
period (.) as the decimal separator and the comma (,) as the thousands separator. 
If you’re dealing with data that uses these two symbols in just the opposite way 
(the comma for the decimal and the period for the thousands separator), as is 
the case in many European countries, click the Advanced button in the Step 3 of 3  
dialog box to open the Advanced Text Import Settings dialog box. There, select 
the comma (,) in the Decimal Separator drop-down list box and the period (.) in 
the Thousands Separator drop-down list box before you click OK. If your text file 
uses trailing minus signs (as in 100–) to represent negative numbers (as in −100), 
make sure that the Trailing Minus for Negative Numbers check box contains a 
check mark.

If you want to change the date format for a column to which you’ve assigned the 
Date data format, click its M-D-Y code in the Date drop-down list box (where M 
stands for the month, D for the day, and Y for the year).
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To skip the importing of a particular column, click it in the Data Preview and then 
select the Do Not Import Column (Skip) option button at the bottom of the Column 
Data Format section.

After you have all the columns formatted as you want, click the Finish button in 
the Convert Text to Columns – Step 3 of 3 dialog box. Excel then splits the entries 
in the imported text file into separate columns of the current worksheet, and all 
that’s left for you to do is, perhaps, adjust the column widths to suit.

Querying data from other data sources
Database tables created and maintained with Microsoft Access are not, of course, 
the only external database sources on which you can perform external data que-
ries. To import data from other sources, choose Data➪  Get Data➪  From Database 
(or press Alt+APND) to open a drop-down menu with other database options 
including:

 » From SQL Server Database to import data from an SQL server database.

 » From Analysis Services to import data from an SQL Server Analysis cube.

 » From SQL Server Analysis Services Database (Import) to import data from 
an SQL server database using an optional MDX or DAX query.

In addition, the From Other Sources option on the Get Data drop-down menu 
offers you the following querying choices:

 » From Sheet to create a new query in the Power Query Editor using the 
selected Excel data table or named cell range in the current worksheet (same 
as clicking the From Table/Range command button on the Ribbon’s Data tab).

 » From Web to import data from a web page (same as clicking the From Web 
command button on the Ribbon’s Data tab).

 » From Microsoft Query to import data from a database table using Microsoft 
Query that follows the ODBC (Open DataBase Connectivity) standards.

 » From SharePoint List to import data from a Microsoft SharePoint website.

 » From OData Feed to import data from any database table following the Open 
Data Protocol (shortened to OData) — note that you must provide the file 
location (usually a URL) and user ID and password to access the OData data 
feed before you can import any of its data into Excel.

 » From Hadoop File (HDFS) to import data from a Hadoop Distributed File 
System.
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 » From Active Directory to import data from the Microsoft Active Directory 
service for Windows domain networks.

 » From Microsoft Exchange to import data from a Microsoft Exchange Server.

 » From ODBC to import data from a database that follows Microsoft’s ODBC 
(Open Database Connectivity) standards.

 » From OLEDB to import data from a database that follows the OLEDB (Object 
Linked Embedded Database) standards.

 » Blank Query to create a brand-new database query in the Power Query 
Editor.

Transforming a data query in the  
Power Query Editor
Whenever you do a data query in Excel using the From Text/CSV, From Web, or 
From Sheet command buttons on the Ribbon’s Data tab, you have the option of 
transforming that query in the Power Query Editor. When you do an external 
query with the From Text/CSV, or From Web options, you open the Power Query 
Editor after specifying the data table(s) to import into Excel by clicking Transform 
Data button in the Navigator dialog box. However, whenever you use the From 
Sheet command to designate a selected cell range in the current worksheet as a 
data table, Excel automatically opens the data table in a new Power Query Editor 
window so that you can create or transform an existing query.

Although the subject of using the Power Query Editor to perform advanced queries 
is well beyond the scope of this book, basic use of the Power Query Editor should 
prove to be no problem as the Power Query Editor’s interface and essential fea-
tures are very similar to those of Excel.

Figure 2-13 (sample workbook: Contoso Stores.xlsx) shows the Power Query Edi-
tor window after opening it to create a new query with the Contoso Stores table. 
To create the new query, I select a cell in the table before choosing Data➪  Get 
Data➪  From Sheet.

As you see in this figure, in the Power Query Editor, the imported Excel client data 
table retains its worksheet row and column arrangement with the column head-
ings complete with Auto-Filter drop-down buttons intact. Above the data table, 
the Power Query Editor sports a Ribbon type command structure with a File menu 
followed by four tabs: Home, Transform, Add Column, and View. To the right of 
the imported data table, a Query Settings task pane appears that not only displays 
the source of the data (a table named Table1) but also all the steps applied in 
building this new query.
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Once the Contoso Store data records are loaded into the Power Query Editor, I can 
use its commands to query the data before returning the subset of records to a new 
worksheet in Excel. For this query, I am interested in creating a subset of records 
where the status of the store is On and the number of employees is greater than 
100. To do this, I use the AutoFilter buttons on the Status and EmployeeCount 
fields, as shown in Figure 2-14 (sample workbook: Contoso Stores.xlsx) to filter 
the records to display just those with On in the Status field and with the Greater 
Than number filter set to 100 for the EmployeeCount field. Then, I sort the records 
from the highest to lowest employee count by sorting on the EmployeeCount field 
in descending order. After that, I’m ready to select the Close & Load To option on 
the Close & Load command button on the Home tab to save my query and load it 
into a new worksheet in the current workbook. To do this, I accept the default set-
tings of Table and New Worksheet in the Import Data dialog box that appears after 
selecting the Close & Load To option prior to clicking OK.

Figure 2-15 shows the results. Here you see the new Excel worksheet that the Edi-
tor created before it copied the filtered and sorted the subset of the Contoso Stores 
records into a new data table in cell range A1:Y4. When the Power Query Editor 
imported this new data table, the program also assigned it a table style, added 
AutoFilter buttons, and opened a Queries & Connections task pane. Now all that’s 
left to do is a bit of formatting and renaming the worksheet.

FIGURE 2-13:  
Creating a new 

query in the 
Power Query  

Editor using 
a data table 

created in an 
Excel worksheet. 

(Sample  
workbook:  

Contoso  
Stores.xlsx)
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FIGURE 2-14:  
Setting the  

filtering and  
sorting criteria 

for the new data 
query in the 

Power Query 
Editor. (Sample 

workbook:  
Contoso  

Stores.xlsx)

FIGURE 2-15:  
The Contoso 

Stores data  
queried in the 
Power Query  

Editor after  
loading it into 

a new Excel 
worksheet.
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Performing What-If 
Analysis

Because electronic worksheet formulas are so good at automatically updating 
their results based on new input, they have long been used (and, some-
times, misused) to create financial projections based on reasonable (and, 

sometimes, dubious) assumptions. Under the guise of what-if analysis, company 
number crunchers often use Excel as their crystal ball for projecting the results 
of promising (and, sometimes, harebrained) schemes designed to make the com-
pany more money.

As you start dabbling in this form of electronic fortune-telling, keep in mind that 
the projections you get back from this type of analysis are only as good as your 
assumptions. So, when the results of what-if analysis tell you that you’re going to 
be richer than King Midas after undertaking this new business venture, you still 
need to ask yourself whether the original assumptions on which these glowing 
projections are based fit in with real-world marketing conditions. In other words, 
when the worksheet tells you that you can make a million bucks of pure profit by 
selling lead-lined boxer shorts, you still have to question how many men really 
need that kind of protection and are willing to pay for it.

Chapter 1

IN THIS CHAPTER

 » Doing what-if analysis in one- and 
two-variable data tables

 » Creating and playing with different 
scenarios

 » Performing goal seeking

 » Using the Solver add-in utility
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In Excel, what-if analysis comes in a variety of flavors (some of which are more 
complicated than others). In this chapter, I introduce you to three straightforward 
methods:

 » Data tables enable you to see how changing one or two variables affects 
the bottom line. (For example, you may want to know what happens to 
the net profit if you fall into a 45 percent tax bracket, a 60 percent tax 
bracket, and so on.)

 » Goal seeking enables you to find out what it takes to reach a predetermined 
objective, such as how much you have to sell to make a $20 million profit 
this year.

 » Scenarios let you set up and test a wide variety of cases, all the way from 
the best-case scenario (profits grow by 20 percent) to the worst-case scenario 
(in which you don’t make any profit).

I also introduce you to Solver utility, which enables you to find solutions to more 
complex what-if problems involving multiple variables. You can use Solver to help 
you with classic resource problems, such as finding the correct product mix to 
maximize your profits, staffing to minimize your general costs, and routing to 
minimize transportation costs.

Using Data Tables
In an Excel worksheet, you can see the effect of changing an input value on the 
result returned by a formula as soon as you enter a new input value in a cell that 
feeds into the formula. Each time you change this input value, Excel automati-
cally recalculates the formula and shows you the new result based on the new 
value. This method is of limited use, however, when you are performing what-if 
analysis and need to be able to see the range of results produced by using a series 
of different input values in the same worksheet so that you can compare them to 
each other.

To perform this type of what-if analysis, you can use Excel’s Data Table com-
mand. When creating a data table, you enter a series of input values in the work-
sheet, and Excel uses each value in the formula that you specify. When Excel is 
finished computing the data table, you see the results produced by each change 
in the input values in a single range of the worksheet. You can then save the data 
table as part of the worksheet if you need to keep a record of the results of a series 
of input values.
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When creating data tables, you can create a one-variable or a two-variable data 
table. In a one-variable data table, Excel substitutes a series of different values for 
a single input value in a formula. In a two-variable data table, Excel substitutes a 
series of different values for two input values in a formula.

Creating a one-variable data table
To create a one-variable data table, you need to set up the master formula in your 
worksheet and then, in a different range of the worksheet, enter the series of dif-
ferent values that you want substituted for a single input value in that formula. 
Figures  1-1 and  1-2 (sample workbook: Data Table  1 - Projected Sales.xlsx for 
both) demonstrate how this is done.

In Figure  1-1, cell B5 contains a formula for computing the projected sales for 
2022, assuming an annual growth rate of 1.75% over the annual sales in 2021.  
The 2022 projected sales in this cell are calculated with the following formula:

=Sales_2021 + (Sales_2021 * Growth_2022)

This formula adds cell B2 (named Sales_2021) to the contents of B2 multiplied by 
the growth rate of 1.75% in cell B3 (named Growth_2022). Cell B5 shows you that, 
assuming an annual growth rate of 1.75% in 2022, you can project total sales of 
$890,312.50.

FIGURE 1-1:  
Creating a  

one-variable data 
table. (Sample 

workbook:  
Data Table 1 - 

Projected  
Sales.xlsx)
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But what if the growth rate in 2022 is higher than 1.75%, or what if the growth 
rate is even (heaven forbid) lower than anticipated? To create the one-variable 
table to answer these questions, you first bring forward the master formula in cell 
B5 to cell C7 with the formula =B5 (which appears as =Projected_Sales_2022 on 
the Formula bar as this is the range name given to the cell). Then, you enter the 
series of different growth rates as the input values in column B, starting in cell B8. 
(Cell B7, at the intersection of the row with the master formula and the column 
with the input values, must be left blank in a one-variable data table.) This series 
of input values for the data table can be created with the AutoFill feature. (See 
Book 2, Chapter 1 for details.) In this example, a data series that increments each 
succeeding value by 0.25% percent is created in the cell range B8:B17, starting at 
1.00 percent and ending at 3.25% percent.

After bringing the formula in cell B5 forward to cell C7 with the linking  
formula =B5 and generating the growth rate series in the cell range B8:B17, you 
then select the cell range B7:C17. In the Data tab’s Forecast group, choose What-If 
Analysis ➪  Data Table (or press Alt+AWT) to open the Data Table dialog box shown 
in Figure 1-1.

In this dialog box, you specify the row input cell in the Row Input Cell text box 
and/or the column input cell in the Column Input Cell text box. The cell that you 
designate as the row or column input cell in the Table dialog box must correspond 
to the cell in the worksheet that contains the original input value that is fed into 
the master formula.

In the data table in this example, you need to designate only B3 as the column 
input cell. (In the case of Figure 1-1, when you click this cell or use an arrow key 

FIGURE 1-2:  
The completed 

one-variable  
data table.  

(Sample  
workbook:  

Data Table 1 - 
Projected  

Sales.xlsx)
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to select this cell, Excel enters the absolute cell reference, as in $B$3.) You choose 
cell B3 because this cell contains the growth rate value used in the master formula.

After indicating the row or column input cells, Excel computes the data table when 
you click the OK button. In this example, the program creates the data table by 
substituting each input value in the data series in the range B8:B17 into the col-
umn input cell B3. The value of cell B3 is then used in the master formula to cal-
culate a new result, which is entered in the corresponding cell in the cell range 
C8:C17. After the program has finished calculating the data table, Excel returns 
the original value to the row or column input cell (in this case, 1.75% in cell B3).

Figure  1-2 shows the completed data table. Here, you can see at a glance how 
changing a quarter percentage point for the growth rate affects the projected sales 
for 2022. After creating the data table, you can then format the results and save 
the table as part of the worksheet.

If you want to see how using a different range of variables affects the results in 
the table, you only need to enter the new input values in the existing range. By 
default, Excel automatically recalculates the results in the output range of a data 
table whenever you change any of its input values. If you want to control when 
each data table is recalculated while still allowing the formulas in the worksheet 
to be automatically recalculated, choose Formulas ➪  Calculation Options ➪  Auto-
matic Except Data Tables (or press Alt+MXE).

Excel computes the results in a data table by creating an array formula that uses 
the TABLE function. (See Book 3, Chapter 1, for more information on array for-
mulas.) In this example, the array formula entered into the cell range C8:C17 is 
as follows:

{=TABLE(, B3)}

The TABLE function can take two arguments, row_ref and/or column_ref, which 
represent the row input cell and column input cell for the data table, respectively. 
In this example, the data table uses only a column input cell, so B3 is the second 
and only argument of the TABLE function. Because Excel enters the results in a 
data table by using an array formula, Excel won’t allow you to clear individual 
result cells in its output range. If you try to delete a single result in the data table, 
Excel displays an Alert dialog box, stating that you can’t change part of a table.

If you want to delete just the results in the output range of a data table, you must 
select all the cells in the output range (cell range C8:C17, in the current example) 
before you press the Delete key or choose the Clear All option from the Clear but-
ton’s drop-down menu (or press Alt+HEA).
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Creating a two-variable data table
When you have a master formula in a worksheet in which you want to see the 
effect of changing two of its input values, you create a two-variable data table. 
When you create a two-variable data table, you enter two ranges of input values 
to be substituted in the master formula: a single-row range in the first row of the 
table and a single-column range in the first column of the data table. When you 
create a two-variable data table, you place a copy of the master formula in the cell 
at the intersection of this row and column of input values.

Figure 1-3 (sample workbook: Data Table 2 - Projected Sales.xlsx) shows the typ-
ical setup for a two-variable data table. This figure uses the projected sales work-
sheet shown previously in the section on a one-variable data table. Here, however, 
a second variable has been added to projecting the total sales in 2022. This work-
sheet contains a value in cell B4 (named Expenses_2022) that shows the projected 
percentage of expenses to sales, which is used, in turn, in the master formula in 
cell B5 as follows:

=Sales_2021 + (Sales_2021*Growth_2022)-(Sales_2021 * 
Expenses_2022)

Note that when you factor in the expenses of 10% of the annual sales, the pro-
jected sales at an annual growth rate of 1.75% falls in cell B5 from $890,312.50 to 
$802,812.50.

FIGURE 1-3:  
Creating a  

two-variable  
data table.  

(Sample  
workbook:  

Data Table 2 - 
Projected  

Sales.xlsx)
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To determine how changing both the growth rate and the percentage of expenses 
to sales will affect the projected sales for 2022, you create a two-variable data 
table. In setting up this table, you still enter the variable growth rates down col-
umn B in the cell range B8:B17. Then, you enter the variable expense rates across 
row 7  in the range C7:F7. This time, you bring forward the master formula by 
entering the formula =B5 in cell B7, the cell at the intersection of the row and 
column containing the two input variables.

After setting up the two series of variables in this manner, you are ready to cre-
ate the table by selecting the cell range B7:F17, and then choosing Data ➪  What-If 
Analysis ➪  Data Table (or pressing Alt+AWT) to open the Data Table dialog box, as 
shown in Figure 1-3. For a two-variable data table, you must designate both a row 
input and column cell in the worksheet. In this example, the row input cell is B4, 
which contains the original expense-to-sales percentage, and the column input 
cell remains B3, which contains the original growth rate. After these two input 
cells are entered in the Table dialog box, you are ready to generate the data table 
by clicking the OK button.

Figure  1-4 (sample workbook: Data Table  2 - Projected Sales.xlsx) shows the 
completed two-variable data table with the results of changing both the projected 
growth rate and the projected expenses. As with a one-variable data table, you can 
save this two-variable data table as part of your worksheet. You can also update 
the table by changing any of the (two types) input variables.

FIGURE 1-4:  
The completed 

two-variable  
data table.  

(Sample  
workbook:  

Data Table 2 - 
Projected  

Sales.xlsx)
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The array formula entered in the output range (C8:F17) to create this two-variable 
data table is very similar to the one created previously for the one-variable data 
table, only this time the TABLE function uses both a row_ref and column_ref argu-
ment as follows:

{=TABLE(B4, B3)}

Because this data table used an array formula, you must select all the cells in the 
output range if you want to delete them.

Exploring Different Scenarios
Excel enables you to create and save sets of input values that produce different 
results as scenarios with the Scenario Manager feature. A scenario consists of a 
group of input values, each of which is associated with a cell in the worksheet. You 
assign the scenario a name, such as Best Case, Worst Case, Most Likely Case, and so 
on. When you select the name of the scenario that you want to use. Excel applies 
the input values stored in that scenario to the associated cells in the worksheet. 
You can then view the results that these input values produce in the worksheet. 
You can also use the Scenario Manager to create a summary report showing both 
the input values stored in each scenario and the key results produced by each.

Creating new scenarios
When creating a scenario for your worksheet, you create a worksheet that uses 
certain cells that change in each scenario (appropriately enough, called chang-
ing cells). To make it easier to identify the changing cells in each scenario that 
you create (especially in any scenario summary reports that you generate), you 
should assign range names to the variables in the worksheet before you create 
your scenarios.

To create your scenarios with the Scenario Manager, follow these steps:

1. Select the changing cells in the worksheet — that is, the cells whose 
values vary in each of your scenarios.

Remember that you can select nonadjacent cells in the worksheet by holding 
down the Ctrl key as you click them.

2. Choose Data ➪  What-If Analysis ➪  Scenario Manager (press Alt+AWS).

Excel opens the Scenario Manager dialog box.
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3. Click Add.

Excel opens the Add Scenario dialog box, similar to the one shown in Figure 1-5 
(sample workbook: Sales Forecast.xlsx). The Add Scenario dialog box contains a 
Scenario Name text box, where you give the new scenario a descriptive name 
such as Best Case, Most Likely Case, and so on. This dialog box also contains a 
Changing Cells text box that contains the addresses of the variable cells that 
you selected in the worksheet, a Comment box that contains a note with your 
name, and the current date, so you’ll always know when you created the 
particular scenario, and Protection check boxes that prevent users from 
making changes and/or enable you to hide the scenario when the worksheet 
is protected.

4. Type a descriptive name for the new scenario in the Scenario Name 
text box.

Now, you should check over the cell references in the Changing Cells text box 
to make sure that they’re correct. You can modify them if necessary by clicking 
the Changing Cells text box and then by clicking the cells in the worksheet 
while holding down the Ctrl key. You can also edit the note in the Comment 
box if you want to add more information about your assumptions as part of 
the new scenario.

By default, Excel protects a scenario from changes when you turn on protec-
tion for the worksheet (see Book 4, Chapter 1, for details) so that you can’t edit 
or delete the scenario in any way. If you want Excel to hide the scenario as well 
when worksheet protection is turned on, click the Hide check box. If you don’t 
want to protect or hide the scenario when worksheet protection is turned on, 
click the Prevent Changes check box to remove its check mark and leave the 
Hide check box as it is.

FIGURE 1-5:  
Adding a new 

Most Likely  
scenario for the 

sales forecast. 
(Sample  

workbook: Sales 
Forecast.xlsx)
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5. In the Protection section of the Add Scenario dialog box, choose what 
kind of scenario protection that you need, if any, with the Prevent 
Changes and Hide check boxes.

Now you’re ready to specify the changing values for the new scenario.

6. Click OK in the Add Scenario dialog box.

This action closes the Add Scenario dialog box and then opens the Scenario 
Values dialog box, similar to the one shown in Figure 1-6 (sample workbook: 
Sales Forecast.xlsx). The Scenario Values dialog box numbers and shows the 
range name (assuming you named each of the cells), followed by the current 
value for each of the changing values that you selected in the worksheet 
before starting to define different scenarios for your worksheet.

You can accept the values shown in the text box for each changing cell if it suits 
the current scenario that you’re defining, or you can increase or decrease any 
or all of them as needed to reflect the scenario’s assumptions.

7. Check the values in each changing cell’s text box and modify the values 
as needed.

Now you’re ready to close the Scenario Values dialog box, which completes the 
definition of the new scenario.

8. Click the Add button in the Scenario Values dialog box.

The Scenario Values dialog box closes and you return to the Add Scenario 
dialog box, where you can define a new scenario name for the changing cells.

9. Repeat Steps 4 to 8 to add all the other scenarios that you want to create.

After you finish defining all the different scenarios you want to apply to the 
changing values in the worksheet, you can close the Scenario Values dialog box 
and then return to the Scenario Manager dialog box, where you can use the 
Show button to see how using different sets of changing values affects your 
worksheet.

10. Click OK in the Add Values dialog box and then click the Close button in 
the Scenario Manager dialog box.

FIGURE 1-6:  
Specifying the 

changing values 
in the Scenario 

Values dialog 
box. (Sample 

workbook: Sales 
Forecast.xlsx)
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When you return to the Scenario Manager dialog box, the names of all the scenarios 
that you added appear in the Scenarios list box. For example, in Figure 1-7 (sample 
workbook: Sales Forecast.xlsx), you see that three scenarios — Most Likely, Best 
Case, and Worst Case — are now listed in the Scenarios list box.

To show a particular scenario in the worksheet that uses the values you entered 
for the changing cells, you double-click the scenario name in this list box or click 
the name and then click the Show command button. Figure 1-7 shows the results 
in the sample forecast worksheet after showing the Worst Case scenario.

If, after creating the scenarios for your worksheet, you find that you need to use 
different input values or you want to add or remove scenarios, you can edit the 
scenarios in the Scenario Manager dialog box. To modify the scenario’s name and/
or the input values assigned to the changing cells of that scenario, click the sce-
nario name in the Scenarios list box and then click the Edit button so that you can 
make the appropriate changes in the Edit Scenario dialog box. To remove a sce-
nario from a worksheet, select the scenario’s name in the Scenarios list box and 
then click the Delete button. Note, however, that if you delete a scenario in error, 
you can’t restore it with the Undo command. Instead, you must re-create the sce-
nario by using the Add command button as outlined in the previous steps.

You can also merge scenarios from other Excel workbook files that are open.  
(Of course, the workbooks must share the same worksheet layout and changing 
cells.) To merge a scenario into the current worksheet from another workbook, 

FIGURE 1-7:  
Worksheet  

after showing 
the Worst Case 

scenario. (Sample 
workbook: Sales 

Forecast.xlsx)
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click the Merge button in the Scenario Manager dialog box and then select the 
workbook from the Book drop-down list box and the worksheet from the Sheet 
drop-down list box before you click OK. Excel then copies all the scenarios defined 
for that worksheet and merges them with any scenarios that you’ve defined for 
the current worksheet.

Producing a summary report
After creating the different scenarios for your worksheet, you can use the Sum-
mary button in the Scenario Manager dialog box to create a summary report that 
shows the changing values used in each scenario and, if you want, key resulting 
values that each produces. When you click the Summary button, Excel opens a 
Scenario Summary dialog box, similar to the one shown in Figure  1-8 (sample 
workbook: Sales Forecast.xlsx), where you may designate a cell selection of result 
cells in the Result Cells text box to be included in the report. After selecting the 
result cells for the report, click OK to have Excel generate the summary report and 
display it in a new worksheet window.

In the example shown in Figure  1-8, the cell range C7:G7, containing the pro-
jected income figures for the sales forecast, are designated as the result cells to 
be included in the summary report. Figure 1-9 (sample workbook: Sales Forecast.
xlsx) shows the actual summary report generated for this sample worksheet in 
a new document window. Note that because all the changing and result cells in 
this worksheet are named, the summary report uses their range names in place 
of their cell references. Also, when the Scenario Manager generates a summary 
report, it automatically outlines the summary data, thus creating two vertical  
levels — one for the changing cells and another for the result cells.

FIGURE 1-8:  
Designating 

the result cells 
in the Scenario 

Summary dialog 
box. (Sample 

workbook: Sales 
Forecast.xlsx)
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Note that the Scenario Summary dialog box contains an option, Scenario Pivot-
Table Report, which enables you to view the scenario results as a pivot table. See 
Book 7, Chapter 2 for details on the uses of PivotTables.

Hide and Goal Seeking
Sometimes, you know the outcome that you want to realize in a worksheet, and 
you need Excel to help you find the input values necessary to achieve those results. 
This procedure, which is the opposite of the what-if analysis that I’ve been exam-
ining in this chapter, is referred to as goal seeking.

When you need to find the value for a single variable that will give the desired 
result in a particular formula, you can perform this simple type of goal seeking 
with the Goal Seek command. If you have charted the data and created a two- 
dimensional column, bar, or line chart, you can also perform the goal seeking by 
directly manipulating the appropriate marker on the chart. And when you need to 
perform more complex goal seeking, such as that which involves changing mul-
tiple input values to realize a result or constraining the values to a specific range, 
you can use Solver command.

To use the Goal Seek command, select the cell containing the formula that will 
return the result that you are seeking (referred to as the set cell), indicate what 
value you want this formula to return, and then indicate the location of the input 
value that Excel can change to return the desired result. Figures  1-10 and  1-11 
(sample workbook: Sales Forecast.xlsx for both) illustrate how you can use the 
Goal Seek command to find how much sales must increase to realize first quar-
ter income of $475,000 (given certain growth, cost of goods sold, and expense 
assumptions).

FIGURE 1-9:  
A Scenario  
Summary 

report for the 
scenarios in the 

Sales Forecast 
table. (Sample 

workbook: Sales 
Forecast.xlsx)
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To find out how much sales must increase to return a net income of $475,000 in 
the first quarter, you first select cell B7, which contains the formula that calcu-
lates the first quarter income before you choose Data ➪  What-If Analysis ➪  Goal 
Seek (or press Alt+AWG). Excel opens the Goal Seek dialog box, similar to the one 
shown in Figure 1-10. Because cell B7 is the active cell when you open this dialog 
box, the Set Cell text box already contains the cell reference B7. You then select the 
To Value text box and enter 475000 as the goal. Then, you select the By Changing 
Cell text box and select cell B3 in the worksheet (the cell that contains the first 
quarter sales).

Figure 1-11 shows the Goal Seek Status dialog box that appears when you click OK 
in the Goal Seek dialog box to have Excel go ahead and adjust the sales figure to 
reach your desired income figure. As this figure shows, Excel increases the sales 
in cell B3 from $432,692.31 to $913,461.54 which, in turn, returns $475,000.00 

FIGURE 1-10:  
Using goal  

seeking to find 
out how much 

sales must 
increase to 

reach a target 
income. (Sample 
workbook: Sales 

Forecast.xlsx)

FIGURE 1-11:  
A worksheet 

showing a  
goal-seeking  
solution and 

the Goal Seek 
Status dialog 
box. (Sample 

workbook: Sales 
Forecast.xlsx)
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as the income in cell B7. The Goal Seek Status dialog box informs you that goal 
seeking has found a solution and that the current value and target value are now 
the same. (If this were not the case, the Step and Pause buttons in the dialog box 
would become active, and you could have Excel perform further iterations to try to 
narrow and ultimately eliminate the gap between the target and current values.)

If you want to keep the values entered in the worksheet as a result of goal seek-
ing, click OK to close the Goal Seek Status dialog box. If you want to return to the 
original values, click the Cancel button instead. If you change the value by clicking 
OK, you can still switch between the “before” and “after” input values and results 
by choosing Home ➪  Undo or by pressing Ctrl+Z.

To flip back and forth between the “after” and “before” values when you’ve 
closed the Goal Seek Status dialog box, press Ctrl+Z to display the original values 
before goal seeking and then Ctrl+Y to display the values engendered by the goal-
seeking solution.

Using Solver
Although the Data Table and Goal Seek commands work just fine for simple prob-
lems that require determining the direct relationship between the inputs and 
results in a formula, you need to use the Solver add-in when dealing with more 
complex problems. For example, use Solver to find the best solution when you 
need to change multiple input values in your model and you need to impose con-
straints on these values and/or the output value.

Solver works by applying iterative methods to find the “best” solution given the 
inputs, desired solution, and the constraints that you impose. With each itera-
tion, the program applies a trial-and-error method (based on the use of linear or 
nonlinear equations and inequalities) that attempts to get closer to the optimum 
solution.

When using Solver, keep in mind that many problems, especially the more com-
plicated ones, have many solutions. Although Solver returns the optimum solu-
tion, given the starting values, the variables that can change, and the constraints 
that you define, this solution is often not the only one possible and, in fact, may 
not be the best solution for you. To be sure that you are finding the best solution, 
you may want to run Solver more than once, adjusting the initial values each time 
you solve the problem.
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When setting up the problem for Solver in your worksheet, define the following 
items:

 » Objective cell: The target cell in your worksheet whose value is to be 
maximized, minimized, or made to reach a particular value. Note that this cell 
must contain a formula.

 » Variable cells: The changing cells in your worksheet whose values are to be 
adjusted until the answer is found.

 » Constraint cells: The cells that contain the limits that you impose on the 
changing values in the variable cells and/or the target cell in the objective cell.

After you finish defining the problem with these parameters and have Solver solve 
the problem, the program returns the optimum solution by modifying the val-
ues in your worksheet. At this point, you can choose to retain the changes in the 
worksheet or restore the original values to the worksheet. You can also save the 
solution as a scenario to view later before you restore the original values.

You can use Solver with the Scenario Manager to help set up a problem to solve or 
to save a solution so that you can view it later. The changing cells that you define 
for the Scenario Manager are automatically picked up and used by Solver when 
you select this command, and vice versa. Also, you can save Solver’s solution to a 
problem as a scenario (by clicking the Save Scenario button in Solver dialog box) 
that you can then view with the Scenario Manager.

Setting up and defining the problem
The first step in setting up a problem for Solver to work on is to create the work-
sheet model for which you will define the objective cell, variables cells, and the 
constraint cells.

Because Solver is an add-in utility, you need to make sure that Solver program 
is loaded. Choose File ➪  Options ➪  Add-Ins, make sure Add-Ins is selected in the 
Manage drop-down list, and then click Go. In the Add-Ins dialog box that appears, 
select the Solver Add-In check box and click OK. Excel adds the Solver command 
to the Data tab’s Analysis group.

To define and solve a problem with Solver after you’ve loaded the add-in and have 
created your worksheet model, follow these steps:

1. Choose Data ➪  Solver.

Excel opens Solver Parameters dialog box, which is similar to the one shown in 
Figure 1-12 (sample workbook: Sales Forecast.xlsx).
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2. Click the target cell in the worksheet or enter its cell reference or range 
name in the Set Objective text box.

3. Click the appropriate option button option in the To section of the dialog 
box. If you select the Value Of option button, enter the value to match in 
the associated text box.

Click the Max option button when you want the target cell’s value to be as large 
as possible. Click the Min option button when you want the target cell’s value 
to be as small as possible. Click the Value Of option button and then enter a 
value in the associated text box when you want the target cell’s value to reach 
a particular value.

4. Click the By Changing Variable Cells text box and then select the cells to 
change in the worksheet or enter their cell references or range name in 
the text box.

Remember that to select nonadjacent cells in the worksheet, you need to hold 
down the Ctrl key as you click each cell in the selection. To have Excel choose 
the changing cells for you based on the target cell that you selected, click the 
Guess button to the right of this text box.

FIGURE 1-12:  
Specifying the 
parameters to 

apply to the 
model in Solver 

Parameters  
dialog box.  

(Sample  
workbook: Sales 

Forecast.xlsx)
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5. (Optional) Click the Add button to the right of the Subject to the 
Constraints list box in Solver Parameters dialog box.

You can add constraints for the target cell or any of the changing cells that 
determine its limits when adjusting the values. When defining a constraint 
in the Add Constraint dialog box, choose the cell whose value you want to 
constrain or select the cell in the worksheet or enter its cell reference in the 
Cell Reference text box. Then select the relationship (=, <=, >=, or int for integer 
or bin for binary) from the drop-down list box to the right and (unless you 
chose int or bin) enter the appropriate value or cell reference in the Constraint 
text box.

To continue adding constraints for other cells used by Solver, click the Add 
button to add the constraint and clear the text boxes in the Add Constraint 
dialog box. Then, repeat Step 5 to add a new constraint. After you finish 
defining constraints for the target cell and changing values in the model, 
click OK to close the Add Constraint dialog box and return to the Solver 
Parameters dialog box (which now lists your constraints in the Subject to 
the Constraints list box).

6. (Optional) Deselect the Make Unconstrained Variables Non-Negative 
check box if you want to allow negative values when the variable cells 
are not subject to constraints.

By default, Solver employs the GRG (Generalized Reduced Gradient) Nonlinear 
method in solving the model whose parameters you’re setting known as a very 
efficient way to solve smooth nonlinear problems. To use the LP Simplex method 
(for Linear Programming following the Simplex algorithm) or Evolutionary engine 
for solving non-smooth problems, you need to follow Step 7.

7. (Optional) Select LP Simplex or Evolutionary from the Select a Solving 
Method drop-down list to use either one of these methods solving 
nonsmooth problems.

8. Click the Solve button to have Solver solve the problem as you’ve defined 
it in Solver Parameters dialog box.

Solving the problem
When you click the Solve button, the Solver Parameters dialog box disappears, and 
the Status bar indicates that Solver is setting up the problem and then keeps you 
informed of the progress in solving the problem by showing the number of the 
intermediate (or trial) solutions as they are tried. To interrupt the solution process 
at any time before Excel calculates the last iteration, press the Esc key. Excel then 
displays the Show Trial Solution dialog box, informing you that the solution pro-
cess has been paused. To continue the solution process, click the Continue button. 
To abort the solution process, click the Stop button.
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When Excel finishes the solution process, the Solver Results dialog box appears, 
similar to the one shown in Figure 1-13 (sample workbook: Sales Forecast.xlsx). 
This dialog box informs you whether Solver was able to find a solution, given the 
target cell, changing cells, and constraints defined for the problem. To retain the 
changes that Solver makes in your worksheet model, leave the Keep Solver Solu-
tion option button selected and click OK to close the Solver Results dialog box. 
To return the original values to the worksheet, click the Restore Original Values 
option button instead. To save the changes as a scenario before you restore the 
original values, click the Save Scenario button and assign a name to the current 
scenario before you select the Restore Original Values option and click OK.

Unlike when using the Goal Seek command, after clicking the Keep Solver Solution 
option button in Solver Results dialog box, you can’t use the Undo command but-
ton on the Quick Access toolbar to restore the original values to your worksheet. 
If you want to be able to switch between the “before” and “after” views of your 
worksheet, you must save the changes with the Save Scenario button and then 
select the Restore Original Values option button. That way, you can retain the 
“before” view in the original worksheet and use the Scenario Manager to display 
the “after” view created by Solver.

Changing Solver options
For most of the problems, the default options used by Solver are adequate. In some 
situations, however, you may want to change some of the Solver options before 

FIGURE 1-13:  
The Solver 

Results dialog 
box showing that 

Solver found a 
solution to the 

problem. (Sample 
workbook: Sales 

Forecast.xlsx)
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you begin the solution process. To change the solution options, click the Options 
button in the Solver Parameters dialog box. Excel then opens the Options dialog 
box with the All Methods tab selected, shown in Figure 1-14, where you can make 
all necessary changes. (See Table 1-1 for information on each option.)

After changing the options, click OK to return to the Solver Parameters dialog box; 
from here, you can then click the Solve button to begin the solution process with 
the new solution settings that you just changed.

When you use the default GRG (Generalized Reduced Gradient) Nonlinear or Evo-
lutionary method, you can set additional Solver settings using the options on the 
GRG Nonlinear and Evolutionary tabs of the Options dialog box. These options 
include changing the Converge, Population Size, and Random Seed settings for 
either of these particular methods.

TABLE 1-1 Solver Option Settings
Option Function

Constraint Precision Specifies the precision of the constraints. The number that you enter in this text 
box determines whether the value in a constraint cell meets the specified value or 
the upper or lower limit you have set. Specify a lower number (between 0 and 1) 
to reduce the time it takes Solver to return a solution to your problem.

Use Automatic Scaling Select this check box to have Solver automatically scale the results when solving 
the problem.

Show Iteration Results Select this check box to have Solver show the results for the iterations followed in 
solving the problem.

Ignore Integer 
Constraints

Select this check box to have Solver ignore any constraints you specify that 
use integers.

Integer Optimality (%) Specifies the percentage of integer optimality criteria that Solver applies in solving 
the problem.

Max Time (seconds) Specifies the maximum number of seconds that Solver will spend on finding 
the solution.

Iterations Specifies the maximum number of times that Solver will recalculate the worksheet 
when finding the solution.

Max Subproblems Specifies the maximum number of subproblems that Solver takes on when using 
the Evolutionary method to solve the problem.

Max Feasible Solutions Specifies the maximum number of feasible solutions that Solver will pursue when 
you select the Evolutionary method for solving the problem.
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Saving and loading a model problem
The objective cell, variable cells, constraint cells, and Solver options that you most 
recently used are saved as part of the worksheet when you click the Save button 
(or press Ctrl+S). When you define other problems for the same worksheet that 
you want to save, you must click the Save Model button in the Solver Options 
dialog box and indicate the cell reference or name of the range in the active work-
sheet where you want the problem’s parameters to be inserted.

When you click the Load/Save button, Excel opens the Load/Save Model dialog 
box, containing a Select Model Area text box. This text box contains the cell refer-
ences for a range large enough to hold all the problem’s parameters, starting with 
the active cell. To save the problem’s parameters in this range, click OK. If this 
range includes cells with existing data, you need to modify the cell reference in 
this text box before you click OK to prevent Excel from replacing the existing data.

After you click OK, Excel copies the problem’s parameters in the specified range. 
These values are then saved as part of the worksheet the next time you save the 
workbook. To reuse these problem parameters when solving a problem, you need 
to open Solver Options dialog box, click the Load/Save button to open the Load/
Save Model dialog box, click the Load button, and then select the range containing 
the saved problem parameters. When you click OK in the Load Model dialog box, 

FIGURE 1-14:  
Modifying the 

solution options 
in the Options 

dialog box.
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Excel loads the parameters from this cell range into the appropriate text boxes in 
Solver Parameters dialog box. You can then close the Solver Options dialog box by 
clicking OK, and you can solve the problem by using these parameters by clicking 
the Solve command button.

You can use the Reset All button whenever you want to clear all the parameters 
defined for the previous problem and return the Solver options to their defaults.

Creating Solver reports
You can create three different types of reports with Solver:

 » Answer report: Lists the target cell and changing cells with their original and 
final values, along with the constraints used in solving the problem.

 » Sensitivity report: Indicates how sensitive an optimal solution is to changes 
in the formulas that calculate the target cell and constraints. The report 
shows the changing cells with their final values and the reduced gradient 
for each cell. (The reduced gradient measures the objective per unit increase 
in the changing cell.) If you defined constraints, the Sensitivity report lists 
them with their final values and the Lagrange multiplier for each constraint. 
(The Lagrange multiplier measures the objective per unit increase that 
appears in the right side of the constraint equation.)

 » Limits report: Shows the target cell and the changing cells with their values, 
lower and upper limits, and target results. The lower limit represents the 
lowest value that a changing cell can have while fixing the values of all other 
cells and still satisfying the constraints. The upper limit represents the highest 
value that will do this.

Excel places each report that you generate for a Solver problem in a separate 
worksheet in the workbook. To generate one (or all) of these reports, select the 
report type (Answer, Sensitivity, or Limits) from the Reports list box of the Solver 
Results dialog box (as shown previously in Figure 1-13). To select more than one 
report, just click the name of the report.

When you click OK to close the Solver Results dialog box (after choosing between 
the Keep Solver Solution and Restore Original Values options), Excel generates the 
report (or reports) that you selected in a new worksheet that it adds to the begin-
ning of the workbook. (Report sheet tabs are named by report type, as in Answer 
Report 1, Sensitivity Report 1, and Limits Report 1.)
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Performing Large-Scale 
Data Analysis

The subject of this chapter is performing data analysis on a larger scale in 
Excel worksheets, often with visual components that enable you and your 
users to immediately spot developing trends. The primary Excel tool for 

performing such large-scale analysis on your worksheet data is the PivotTable and 
its visual counterpart, the PivotChart. PivotTables enable you to quickly summa-
rize large amounts of data revealing inherent relationships and trends, whereas 
PivotCharts enable you to easily visualize these connections.

You also have access to Excel’s Power Pivot add-in when you need to perform 
analysis on data models whose tables contain huge amounts of data. Finally, Excel 
offers two visual data analysis features designed to help you quickly identify sig-
nificant indicators of your business’s health and well-being: 3D Maps, which pro-
duces stunning, interactive, 3-D maps animating data over time, and Forecast 
Sheet, which generates worksheets showing developing trends in your data.

Chapter 2

IN THIS CHAPTER

 » Analyzing worksheet data with 
PivotTables and PivotCharts

 » Analyzing worksheet data with the 
Power Pivot add-in

 » Analyzing data visually over time 
with 3D Maps

 » Analyzing data trends in a visual 
forecast worksheet
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Creating PivotTables
PivotTable is the name given to a special type of data summary table that you 
can use to analyze and reveal the relationships inherent in the tables that you 
maintain in Excel. PivotTables are great for summarizing particular values in a 
table or range because they do their magic without making you create formulas to  
perform the calculations. Unlike Subtotals, which is another summarizing feature 
(see Book 6, Chapter 1 for more information), PivotTables let you play around with 
the arrangement of the summarized data — even after you generate the table. 
(The Subtotals feature only lets you hide and display different levels of totals in 
the table.) This capability to change the arrangement of — that is, to pivot — the 
summarized data by rotating row and column headings gives the PivotTable its 
name.

PivotTables are also versatile because they enable you to summarize data by using 
a variety of summary functions (although totals created with the SUM function 
will probably remain your old standby). You can also use PivotTables to cross-
tabulate one set of data in your range or table with another. For example, you can 
use this feature to create a PivotTable from an employee database that totals the 
salaries for each job category cross-tabulated (arranged) by department or job 
site. Moreover, Excel makes it easy to create PivotTables that summarize data 
from more than one related table entered in the worksheet or retrieved from 
external data in what’s known as a Data Model. (See Book 6, Chapter 2 for more 
on relating tables and retrieving external data.)

You can create a PivotTable from either a table or a range, provided the latter has 
column headings. So, in the sections that follow, when I say “table,” what I really 
mean is “table or range.”

Excel offers several methods for creating new PivotTables in your worksheets:

 » Quick Analysis tool: With all the cells in the table selected, click the Quick 
Analysis tool and then select your PivotTable on the Tables tab of its drop-
down palette.

 » Recommended PivotTables button: With the cell pointer in one of the cells 
of a table, click the Recommended PivotTables button on the Insert tab and 
then select your PivotTable in the Recommended PivotTables dialog box.

 » PivotTable button: With the cell pointer in one of the cells of a table, click 
the PivotTable button on the Insert tab and then use the Create PivotTable 
dialog box to specify the contents and location of your new table before you 
manually select the fields in the data source to use.
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Creating PivotTables with the  
Quick Analysis tool
Excel enables you to create a new PivotTable using a range or table selected in 
your worksheet with its Quick Analysis tool. To preview various types of Pivot-
Tables that Excel can create for you on the spot using the entries in a table that 
you have open in an Excel worksheet, follow these steps:

1. Select all the data (including the column headings) as a cell range in the 
worksheet.

If you’ve assigned a range name to the data, you can select the column 
headings and all the data records in one operation by choosing the name 
from the Name box drop-down menu.

2. Click the Quick Analysis tool that appears right below the lower-right 
corner of the current cell selection.

Excel opens the palette of Quick Analysis options with the initial Formatting 
tab selected and its various conditional formatting options displayed.

3. Click the Tables tab at the top of the Quick Analysis options palette.

Excel displays its Table and PivotTable option buttons. The Table button 
previews how the selected data would appear formatted as a table. 
The other PivotTable buttons preview the various types of PivotTables 
that can be created from the selected data.

4. To preview each PivotTable that Excel can create for your data, highlight 
its PivotTable button in the Quick Analysis palette.

As you highlight each PivotTable button in the options palette, Excel’s Live 
Preview feature displays a thumbnail of a PivotTable that can be created using 
your table data. This thumbnail appears above the Quick Analysis options 
palette for as long as the mouse or Touch pointer is over its corresponding 
button.

5. When a preview of the PivotTable you want to create appears, click its 
button in the Quick Analysis options palette to create it.

Excel then creates the previewed PivotTable on a new worksheet that’s 
inserted before the active worksheet. This new worksheet containing the 
PivotTable is active so that you can immediately rename and relocate the 
sheet as well as edit the new PivotTable, if you wish.
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Figures 2-1 and 2-2 (sample workbook: Employee Table.xlsx for both) show you 
how this procedure works. In Figure 2-1, I’ve highlighted the fourth suggested 
PivotTable button in the Quick Analysis tool’s option palette. The previewed table 
in the thumbnail displayed above the palette shows the salaries subtotals and 
grand totals in the Employee Table organized by whether the employees partici-
pate in profit sharing (Yes or No).

Figure 2-2 shows you the PivotTable that Excel created when I clicked the high-
lighted button in the options palette in Figure 2-1. Note this PivotTable is selected 
on its own worksheet (Sheet1) that’s been inserted in front of the Employee 
Data worksheet. Because the new PivotTable is selected, the PivotTable Fields 
task pane is displayed on the right side of the Excel worksheet window and the 
 PivotTable Analyze and Design contextual tabs are displayed on the Ribbon. You 
can use the options on this task pane and these contextual tabs to customize your 
new PivotTable as described in the “Formatting a PivotTable” section later in this 
chapter.

Note that if Excel can’t suggest any PivotTables to create from the selected data in 
the worksheet, a single Blank PivotTable button is displayed after the Table button 
in the Quick Analysis tool’s options on the Tables tab. You can select this button 
to manually create a new PivotTable for the data as described later in this chapter.

FIGURE 2-1:  
Previewing the 

PivotTable  
created from  
the selected 

data in the Quick 
Analysis options 
palette. (Sample 

workbook: 
Employee  

Table.xlsx)
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Creating recommended PivotTables
If creating a new PivotTable with the Quick Analysis tool (described in the previ-
ous section) is too much work for you, you can quickly generate a PivotTable with 
the Recommended PivotTables command button. To use this method, follow these 
three steps:

1. Select a cell in the table you want to use as the source data for the new 
PivotTable.

Provided that the table has a row of column headings with contiguous rows of 
data as described in Book 6, Chapter 1, this can be any cell in the table.

2. Choose Insert ➪  Recommended PivotTables (or press Alt+NSP).

Excel displays a Recommended PivotTables dialog box similar to the one 
shown in Figure 2-3 (sample workbook: Employee Table.xlsx). This dialog box 
contains a list box on the left side that shows samples of all the suggested 
PivotTables that Excel can create from the data in your table.

3. Select the sample of the PivotTable you want to create in the list box on 
the left and then click OK.

FIGURE 2-2:  
Previewed  
PivotTable  

created on a  
new worksheet 
with the Quick 

Analysis tool. 
(Sample  

workbook: 
Employee  

Table.xlsx)
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Excel creates a new PivotTable based on the selected sample on its own worksheet 
inserted just before the worksheet that contains the source table. This PivotTable 
is selected on the new sheet so that the PivotTable Fields task pane is displayed 
on the right side of the Excel worksheet window and the PivotTable Analyze and 
Design contextual tabs are displayed on the Ribbon. You can use the options on 
this task pane and these contextual tabs to then customize your new PivotTable as 
described in the “Formatting a PivotTable” section later in this chapter.

Creating PivotTables manually
Creating PivotTables with the Quick Analysis tool or the Recommended Pivot-
Tables button on the Insert tab is fine provided you’re only summarizing the data 
stored in a single table that’s stored in your Excel worksheet.

When you want your PivotTable to work with data from fields in more than one 
(related) data table or with data stored in a table that doesn’t reside in your work-
sheet (as when connecting with an external data source; see Book 6, Chapter 2), 
you need to manually create the PivotTable.

Creating a PivotTable with local data
To manually create a new PivotTable using a table stored in your Excel workbook, 
open the worksheet that contains that table (see Book 6, Chapter  1) you want 
summarized by the PivotTable, position the cell pointer somewhere in the cells 
of this table, and then choose Insert ➪  PivotTable ➪  From Table/Range (or press 
Alt+NVT).

FIGURE 2-3:  
Creating a  

new PivotTable 
from the sample 

PivotTables 
displayed in the 
Recommended 

PivotTables  
dialog box. 

(Sample  
workbook: 
Employee  

Table.xlsx)
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Excel selects all the data in the table (indicated by a marquee around the cell 
range) and then opens the PivotTable from Table or Range dialog box similar to 
the one shown in Figure 2-4 (sample workbook: Employee Table.xlsx). You can 
then adjust the value in the Table/Range text box if the displayed range name or 
range reference doesn’t include all the data to be summarized in the PivotTable.

By default, Excel builds the new PivotTable on a new worksheet it inserts just 
before the worksheet that contains your table. If you want the PivotTable to appear 
on the same worksheet, select the Existing Worksheet option button and then 
indicate the location of the first cell of the new table in the Location text box. (Just 
be sure that this new PivotTable isn’t going to overlap any existing tables of data.)

If the table you’ve selected in the Table/Range text box is related to another table 
in your workbook and you want to be able to analyze and summarize data from 
both, be sure to select the Add This Data to the Data Model check box at the bottom 
of the Create PivotTable dialog box before you click OK. (See Book 6, Chapter 2 for 
details on creating relationships between tables using key fields.)

Creating a PivotTable from external data
If you’re creating a PivotTable using external data not stored in your workbook, 
you want to locate the cell pointer in the first cell of the worksheet where you 
want the PivotTable before opening the PivotTable from an External Data Source 
dialog box by choosing Insert ➪  PivotTable ➪  From External Data Source (or press 
Alt+NVE).

To specify the external data table to use, click the Choose Connection button to 
open the Existing Connections dialog box, where you select the name of the con-
nection you want to use and then click Open. (See Book 6, Chapter 2 for informa-
tion on establishing connections with external database tables.)

FIGURE 2-4:  
Indicate the  

data source and 
PivotTable  
location in  
the Create  

PivotTable dialog 
box. (Sample 

workbook: 
Employee  

Table.xlsx)
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Excel then returns you to the PivotTable from an External Data Source dialog box, 
where the name of the selected external data connection is displayed after the Use 
an External Data Source heading. You can then modify the location settings, if 
need be, before creating the new PivotTable by clicking OK. Note that the Add This 
Data to the Data Model check box is automatically selected (and cannot be dese-
lected) — the relationships between the data tables in the source database speci-
fied by the external data connection are automatically reflected in fields displayed 
in the Field list for the new PivotTable.

Constructing the new PivotTable
Whether you create your new PivotTable from a table or an external data source, 
Excel adds a placeholder graphic (with the text, “To build a report, choose fields 
from the PivotTable Field List”) indicating where the new PivotTable will go in 
the worksheet and displays the PivotTable Fields task pane on the right side of the 
worksheet area, as shown in Figure 2-5 (sample workbook: Employee Table.xlsx).

This PivotTable Fields task pane is divided into two areas: the Choose Fields to 
Add to Report list box with a check box for each field name in the table you used 
as the source of the PivotTable, and an area identified by the heading, Drag Fields 
Between Areas Below, which is divided into four drop zones (Filters, Columns, 
Rows, and Values) at the bottom.

FIGURE 2-5:  
A new  

PivotTable  
displaying the 

blank table  
grid and the 

PivotTable Fields 
List task pane. 

(Sample  
workbook: 
Employee  

Table.xlsx)
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To complete the new PivotTable, you assign the fields in the PivotTable Fields task 
pane to the various areas of the PivotTable. You do this by dragging a field name from 
the Choose Fields to Add to Report list box to one of the four areas (or drop zones) in 
the Drag Fields Between Areas Below section at the bottom of the task pane:

 » Filters: One or more fields that enable you to page through the data summa-
ries shown in the PivotTable by filtering out sets of data — they act as the 
filters for the report. So, for example, if you designate the Year field from a 
table as a report filter, you can display data summaries in the PivotTable for 
individual years or for all years represented in the table. They appear at the 
top of the report above the columns and rows of the PivotTable.

 » Columns: One or more fields that determine the arrangement of data shown 
in the columns of the PivotTable. Their entries appear in the PivotTable’s 
column headings.

 » Rows: One or more fields that determine the arrangement of data shown in 
the rows of the PivotTable. Their entries appear in the PivotTable’s row 
headings.

 » Values: One or more fields that determine the summary results that appear 
in the body of the PivotTable. They are the values that are totaled in the last 
row and column of the PivotTable.

You can also add fields to the new PivotTable by selecting the check box in front of 
the field name. When you use this method to build your PivotTable, Excel places 
the fields as follows:

 » If Excel identifies the field as text, it automatically adds the field to the 
Rows area.

 » If Excel identifies the field as numeric, it automatically adds the field to the 
Values area.

To remove a field from the PivotTable, clear its check box in the PivotTable Fields 
task pane.

To better understand how you can use these various areas in a PivotTable, look at 
a completed PivotTable in Figure 2-6 (sample workbook: Employee Table.xlsx). 
For this PivotTable, I dragged these fields in the employee table to the following 
areas in the PivotTable Fields task pane:

 » Filters: Uses the Gender field, which contains F (for female) or M (for male) to 
indicate the employee’s gender.
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 » Columns: Uses the Dept field, which contains the names of the various 
departments in the company (Accounting, Administration, and so on).

 » Rows: Uses the Location field, which contains the names of the various cities 
with corporate offices (Atlanta, Boston, and so on).

 » Values: Uses the Salary field, which contains the annual salary for each 
employee.

This PivotTable displays the sum of the salaries for both the men and women 
employees in each department (across the columns) and then presents these sums 
by their location (in each row).

When you create a new PivotTable (or select the cell of an existing PivotTable in 
a worksheet), Excel displays the PivotTable Analyze contextual tab. Among the 
many groups on this tab, you find the Active Field group, which contains the  
following useful command buttons:

 » Active Field: Indicates the PivotTable field that’s active in the worksheet.

 » Field Settings: Opens the Field Settings dialog box, where you can change 
various settings for the PivotTable field that’s active in the worksheet.

FIGURE 2-6:  
A completed 

PivotTable after 
adding the 

fields from the 
employee table 

to its various 
sections. (Sample 

workbook: 
Employee  

Table.xlsx)
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Formatting a PivotTable
Formatting a PivotTable is similar to formatting any other table or range. All you 
need to do is click a cell of the PivotTable to add the Design contextual tab to the 
Ribbon.

The Design contextual tab is divided into three groups:

 » Layout group to add subtotals and grand totals to the PivotTable and modify 
its basic layout

CUSTOMIZING THE PIVOTTABLE  
FIELDS TASK PANE DISPLAY
By default, Excel displays the list of fields stacked on top of the four areas — Filters, 
Columns, Rows, and Values — in the PivotTable Fields task pane. You can change this 
arrangement by clicking the Tools drop-down button (the gear icon to the right of the 
Choose Fields to Add to Report heading) and then choosing one of the following options 
from its drop-down menu:

• Fields Section and Areas Section Stacked: Displays the list of fields over the areas 
section (this is the default view).

• Fields Section and Areas Section Side-by-Side: Displays the list of fields in a col-
umn to the left of the areas section.

• Fields Section Only: Displays only the list of fields.

• Areas Section Zones Only (2 by 2): Displays only the areas section in two columns.

• Areas Section Zones Only (1 by 4): Displays only the areas section in one column.

When you display only the four areas in the PivotTable Fields task pane, you can click 
the drop-down buttons that appear to the right of the name of each field you add to the 
four areas to manipulate the fields: Move to Report Filter to move the field to the Filters 
area; Move to Row Labels to move the field to the Rows area; Move to Column Labels to 
move the field to the Columns area; or Move to Values to move the field to the Values 
area, Remove Field to remove the field from its current drop zone, or Field Settings to 
open the Fields Settings dialog box, where you can adjust the subtotals, filter, layout, 
and print settings for the field.
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 » PivotTable Style Options group to refine the PivotTable style you select for 
the table using the PivotTable Styles gallery to the immediate right

 » PivotTable Styles group containing the gallery of styles you can apply to the 
active PivotTable by clicking the desired style thumbnail

Refining the PivotTable layout and style
After selecting a style from the PivotTable Styles gallery on the Design contextual 
tab, you can then refine the style using the command buttons in the Layout group 
and the check boxes in the PivotTable Style Options group.

The Layout group on the Design tab contains the following four command buttons:

 » Subtotals: Hide subtotals in the summary report or have them displayed at 
the top or bottom of their groups in the report.

 » Grand Totals: Turn on or off the display of grand totals in the last row or 
column of the report.

 » Report Layout: Modify the display of the report by selecting between the 
default Compact Form and the much more spread-out Outline Form (which 
connects the subtotals across the columns of the table with lines or shading 
depending on the table style selected) and Tabular Form (which connects the 
row items in the first column and the subtotals across the columns of the 
table with gridlines or shading depending on the table style selected)

 » Blank Rows: Insert or remove a blank row after each item in the table

The PivotTable Style Options group contains the following four check boxes:

 » Row Headers: Remove and then re-add the font and color formatting from 
the row headers of the table in the first column of the table applied by the 
currently selected PivotTable style

 » Column Headers: Remove and then re-add the font and color formatting 
from the column headers at the top of the table applied by the currently 
selected PivotTable style

 » Banded Rows: Add and remove banding in the form of gridlines or shading 
(depending on the currently selected PivotTable style) from the rows of the 
PivotTable

 » Banded Columns: Add and remove banding in the form of gridlines or 
shading (depending on the currently selected PivotTable style) from the 
columns of the PivotTable
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Figure  2-7 (sample workbook: Employee Table.xlsx) shows the original Pivot-
Table created from the employee table after making the following changes:

 » Adding the Years of Service field as a second row field and then closing the 
PivotTable Fields task pane

 » Selecting the Banded Rows check box in the PivotTable Style Options group 
on the Design contextual tab

 » Choosing the Show in Outline Form option from the Report Layout command 
button’s drop-down menu in the Layout group of the Design tab

 » Choosing the Insert Blank Line after Each Item option from the Blank Rows 
command button’s drop-down menu in the Layout group of the Design tab

 » Choosing the Show All Subtotals as Bottom of Group option from the 
Subtotals command button’s drop-down menu in the Layout group of the 
Design tab

Formatting the parts of the PivotTable
Even after applying a style to your new PivotTable, you may still want to make 
some individual adjustments to its formatting, such as selecting a new font, font 
size, or cell alignment for the text of the table and a new number format for the 
values in the table’s data cells.

FIGURE 2-7:  
The revised  

PivotTable in the 
Outline Form with 

an extra blank 
row between 

each item. 
(Sample  

workbook: 
Employee  

Table.xlsx)
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You can make these types of formatting changes to a PivotTable by selecting the 
part of the report to which the formatting is to be applied and then selecting the 
new formatting from the appropriate command buttons in the Home tab’s Font, 
Alignment, and Number groups.

Applying a new font, font size, or  
alignment to the PivotTable
You can modify the text in a PivotTable by selecting a new font, font size, or 
horizontal alignment. To make these formatting changes to the text in the entire 
table, select the entire table before you use the appropriate command buttons in 
the Home tab’s Font and Alignment groups. To apply these changes only to the 
headings in the PivotTable, select only its labels before using the commands on 
the Home tab. To apply these changes only to the data in the body of the Pivot-
Table, select only its cells.

To help you select the cells you want to format in a PivotTable, use the following 
Select items on the Actions command button’s drop-down list:

1. Click a cell in the PivotTable in the worksheet and then choose PivotTable 
Analyze  ➪  Select (or press Alt+JTW).

2. On the Select submenu, you can do the following:

• Click the Label and Values option to select the cells with the row and 
column headings and those with the values in the table.

• Click the Values option to select only the cells with values in the table.

• Click the Labels option to select only the cells with the rows and column 
headings in the table.

• Click the Entire PivotTable option on the Select submenu to select all the 
PivotTable cells, including the Report Filter cells.

• Click the Enable Selection option to be able to select single rows or 
columns of the PivotTable by clicking them with the mouse or Touch 
pointer.

You can also use the following hot keys to select all or part of your PivotTable:

 » Alt+JTWA to select the label cells with the row and column headings as well as 
the data cells with the values in the body of the PivotTable

 » Alt+JTWV to select only the data cells with the values in the body of the 
PivotTable
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 » Alt+JTWL to select only the label cells with the row and column headings in 
the PivotTable

 » Alt+JTWT to select the entire table, that is, all the cells of the PivotTable 
including those with the Report Filter

You can use the Label and Values, Values, and Labels options on the Select  button’s 
drop-down menu and their hot key equivalents only after you have selected the 
Entire PivotTable option to select all the cells.

Use Live Preview to preview the look of a new font or font size on the Font or Font 
Size drop-down menu in the Font group on the Ribbon’s Home tab.

Applying a number format to the data cells
When you first create a PivotTable, Excel doesn’t apply a number format to the 
cells in the Values area or to the subtotals and grand totals that Excel adds to the 
table. You can, however, assign any of the Excel number formats to the values in 
the PivotTable in one of two manners.

In the first method, you select the entire table (Alt+JTWT), select only its data 
cells in the body of the PivotTable (Alt+JTWV), and then apply the desired number 
format using the command buttons in the Number group of the Home tab of the 
Ribbon. For example, to format the data cells with the Accounting number format 
with no decimal places, you click the Accounting Number Format command but-
ton and then click the Decrease Decimal command button twice.

You can also apply a number format to the data cells in the body of the PivotTable 
by following these steps:

1. Click the name of the field in the PivotTable that contains the words 
“Sum of” and then choose PivotTable Analyze ➪  Field Settings to open the 
Summarize Values By tab of the Value Field Settings dialog box.

In my Employee example PivotTable, this field is called Sum of Salary because 
the Salary field is summarized. Note that this field is located at the intersection 
of the Column and Row Label fields in the table.

2. Click the Number Format command button in the Value Field Settings 
dialog box to open the Number tab of the Format Cells dialog box.

3. Click the type of number format you want to assign to the values in the 
PivotTable on the Category list box of the Number tab.
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4. (Optional) Modify any other options for the selected number format such 
as Decimal Places, Symbol, and Negative Numbers that are available for 
that format.

5. Click OK twice — the first time to close the Format Cells dialog box and 
the second to close the Value Field Settings dialog box.

Sorting and Filtering the PivotTable Data
When you create a new PivotTable, you’ll notice that Excel automatically adds 
AutoFilter buttons to the Report Filter field as well as the labels for the Column 
and Row fields. These AutoFilter buttons enable you to filter out all but certain 
entries in any of these fields, and in the case of the Column and Row fields, to sort 
their entries in the table.

When you add more than one Column or Row field to your PivotTable, Excel adds 
collapse buttons (–) that you can use to temporarily hide subtotal values for a 
particular secondary field. After clicking a collapse button in the table, it imme-
diately becomes an expand button (+) that you can click to redisplay the subtotals 
for that one secondary field.

Filtering the report
Perhaps the most important AutoFilter buttons in a PivotTable are the ones added 
to the Report Filter field(s). By selecting a particular option on the drop-down 
lists attached to one of these AutoFilter buttons, only the summary data for that 
subset you select is then displayed in the PivotTable itself.

For example, in the example PivotTable (refer to Figure 2-6) that uses the Gender 
field from the employee table as the Report Filter field, you can display the sum 
of just the women’s salaries by location and department in the body of the Pivot-
Table by clicking the Gender field’s filter button, selecting F from the drop-down 
list, and then clicking OK.

Excel then displays F in the Gender Report Filter field instead of the default (All) 
and replaces the standard drop-down button icon with a cone-shaped filter icon, 
indicating that the field is currently being filtered to show only some of the values 
in the data source.

Likewise, you can view the summary of the men’s salaries by selecting M from 
this filter button’s drop-down list. To later redisplay the summary of the salaries 
for all the employees, select the (All) option from this list and then click OK.
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Filtering individual Column and Row fields
The AutoFilter buttons on the Column and Row fields enable you to filter par-
ticular groups and, in some cases, individual entries in the data source. To filter 
the summary data in the columns or rows of a PivotTable, click the Column or 
Row field’s filter button and start by deselecting the check box for the (Select All) 
option at the top of the drop-down list to clear its check mark. Select the check 
boxes for all the groups or individual entries whose summed values you still want 
displayed in the PivotTable, and then click OK.

As when filtering a Report Filter field in the table, Excel replaces the standard 
drop-down button icon displayed in the particular Column or Report field with a 
cone-shaped filter icon. This icon indicates that the field is currently being fil-
tered and only some of its summary values are now displayed in the PivotTable. 
To redisplay all the values for a filtered Column or Report field, you need to click 
its filter button, click the (Select All) option at the top of its drop-down list, and 
then click OK.

Figure 2-8 (sample workbook: Employee Table.xlsx) shows the original sample 
PivotTable after formatting the values (with a number format that uses a comma 
as a thousands separator and displays zero decimal places) and then filtering 
its Gender Filter Report Field to women by selecting F (for Female) and its Dept 
 Column Field to Accounting, Administration, and Human Resources.

FIGURE 2-8:  
The PivotTable 

after filtering the 
Gender Filter 

Report field and 
the Dept Column 

field. (Sample 
workbook: 
Employee  

Table.xlsx)
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Notice in Figure 2-8 that after filtering the PivotTable by selecting F in the Gen-
der Filter Report field and selecting Accounting, Administration, and Human 
Resources departments as the only Dept Column fields, the filtered PivotTable no 
longer displays salary summaries for all the company’s locations. (Santa Rosa, 
Seattle, and Atlanta locations are missing.) The table is missing these locations 
because there are no women employees in the three selected departments and not 
as a result of filtering the Location Row Labels field because its drop-down button 
still uses the standard icon and not the cone filter icon now shown to the right of 
the Gender Filter Report and Dept Column Labels fields.

Slicing the PivotTable data
Excel supports slicers, a graphic tool for filtering the data in your PivotTable. 
Instead of having to filter the data using the check boxes attached to an item list on 
the drop-down menus on a field’s AutoFilter button, you can use slicers instead. 
Slicers, which float as graphic objects over the worksheet, not only enable you 
to quickly filter the data in particular fields of a PivotTable, but also enable you  
to  connect slicers to multiple PivotTables or to a PivotTable and a PivotChart 
you’ve created.

To use slicers on a PivotTable, click one of the table’s cells and then choose Pivot-
Table Analyze ➪  Insert Slicer (or press Alt+JTSF). Excel displays the Insert Slicers 
dialog box containing a list of all the fields in the current PivotTable. Select the 
check boxes for all the fields you want to filter the PivotTable, and then click OK.

Excel displays a slicer for each field you select in the Insert Slicers dialog box. Each 
slicer appears as a rectangular graphic object that contains buttons for each entry 
in that PivotTable field. You can then filter the data in the PivotTable by clicking 
the individual entries in the slicer for all the values you still want displayed in the 
table. To display values for multiple entries in a particular field, either click the 
Multi-Select icon (the checklist icon to the right of the field name) or hold down 
the Ctrl key as you select the entries in the slicer. To display multiple consecutive 
values, click the first entry in its slicer, hold the Shift key, and then click the last 
entry you want included.

Figure 2-9 (sample workbook: Employee Table.xlsx) shows you the PivotTable for 
the employee table after I used three slicers to filter it. The first slicer is for the 
Gender field, where I selected M so that only the records for the men are displayed 
in the PivotTable. The second slicer is for the Dept field, where I clicked the Engi-
neering item to display only the men’s salaries in Engineering. The third and final 
slicer is for the Location field, where I selected the Chicago, San Francisco, and 
Seattle locations (by holding down Ctrl as I clicked their buttons in the Location 
slicer). As a result, the employee data PivotTable is now filtered so that you see 
only the salary totals for the men in the Engineering departments at the Chicago, 
San Francisco, and Seattle offices.
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Because slicers are graphic objects, when you add them to your worksheet, the 
program automatically adds a Slicer contextual tab to the Ribbon. This Slicer tab 
contains many of the same graphic controls that you’re used to when dealing with 
standard graphic objects such as shapes and text boxes, including a Slicer Styles 
drop-down gallery and Bring Forward, Send Back, and Selection Pane buttons that 
you can use to format the currently selected slicer. You can also use the Height 
and Width options in the Buttons and Size groups to modify the dimensions of 
the slicer and the buttons it contains. Finally, you can use the Report Connections 
command button to open the Report Connections dialog box, where you can con-
nect additional PivotTables to the currently selected slicer.

To move a slicer, you click it to select it and then drag it from somewhere on its 
border using the black-cross pointer with an arrowhead. To deselect the items 
you’ve selected in a slicer, click the button in the upper-right corner of the slicer 
with a red x through the filter icon. To get rid of a slicer (and automatically 
redisplay the PivotTable Fields task pane), select the slicer and then press the 
Delete key.

Using timeline filters
Excel also enables you to filter your data with its timeline feature. You can think 
of timelines as slicers designed specifically for date fields that enable you to filter 
data out of your PivotTable that doesn’t fall within a particular period, thereby 
allowing you to see timing of trends in your data.

FIGURE 2-9:  
Employee  

PivotTable  
showing the 

men’s salaries in 
the  Engineering 

department in 
Chicago, San 

Francisco, and 
Seattle. (Sample 

workbook: 
Employee  

Table.xlsx)
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To create a timeline for your PivotTable, select a cell in your PivotTable and then 
choose PivotTable Analyze ➪  Insert Timeline. Excel displays the Insert Timelines 
dialog box displaying a list of PivotTable fields that you can use in creating the 
new timeline. After selecting the check box for the date field you want to use in 
this dialog box, click OK.

Figure  2-10 (sample workbook: Employee Table.xlsx) shows you the timeline 
I created for the sample Employee Table by selecting its Date Hired field in the 
Insert Timelines dialog box. As you can see, Excel created a floating Date Hired 
timeline with the years and months demarcated and a bar that indicates the time 
period selected. By default, the timeline uses months as its units, but you can 
change this to years, quarters, or even days by clicking the time units’ drop-down 
button immediately below the filter icon in the upper-right corner of the timeline 
and then selecting the desired time unit.

For Figure 2-10, I selected the Years option as the timeline’s unit and then selected 
the period 1995 through 1999 so that the PivotTable shows the salaries by depart-
ment and location for only employees hired during this four-year period. I did this 
by dragging the timeline bar in the Date Hired timeline graphic so that it begins at 
1995 and extends just up to 2000. And should I need to filter the PivotTable salary 
data for other hiring periods, I would modify the start and stop times by dragging 
the timeline bar in the Date Hired timeline.

FIGURE 2-10:  
Employee  

PivotTable using 
a timeline filter to 
show the salaries 

for employees 
hired during 

the period 1995 
through 1999. 

(Sample  
workbook: 
Employee  

Table.xlsx)
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Sorting the PivotTable
You can instantly reorder the summary values in a PivotTable by sorting the table 
on one or more of its Column or Row fields. To re-sort a PivotTable, click the 
AutoFilter button for the Column or Row field you want to use in the sort and then 
click either the Sort A to Z option or the Sort Z to A option at the top of the field’s 
drop-down list.

Click the Sort A to Z option when you want the table reordered by sorting the 
labels in the selected field alphabetically, or, in the case of values, from the small-
est to largest value, or, in the case of dates, from the oldest to newest date. Click 
the Sort Z to A option when you want the table reordered by sorting the labels in 
reverse alphabetical order (Z to A), values from the highest to smallest, and dates 
from the newest to oldest.

Modifying the PivotTable
As the term pivot implies, the fun of PivotTables is being able to rotate the data 
fields by using the rows and columns of the table, as well as to change what fields 
are used on the fly. For example, suppose that after making the table’s Location 
field the PivotTable’s Rows Labels Field, and its Dept field the Columns Labels 
Field, you now want to see what the table looks like with the Dept field as the 
Rows Labels Field and the Location field as the Columns Labels Field.

No problem: All you have to do is open the PivotTable Fields task pane (Alt+JTL) 
and then drag Location from the Rows area to the Columns area and then drag 
Dept from the Columns to Rows. Voilà  — Excel rearranges the totaled salaries 
so that the rows of the PivotTable show the location grand totals, and the col-
umns now show the departmental grand totals. Figure 2-11 (sample workbook: 
Employee Table.xlsx) shows this new arrangement for the PivotTable.

In fact, when pivoting a PivotTable, not only can you rotate existing fields, but 
you can also add new fields to the PivotTable or assign more fields to the table’s 
Columns and Rows areas.

Figure  2-12 (sample workbook: Employee Table.xlsx) illustrates this situation. 
This figure shows the same PivotTable after making a couple of key changes to the 
table structure. First, I added the Profit Sharing field as a second Report Filter field 
by dragging it to the Filters area in the PivotTable Fields task pane. Then, I made 
Location a second Row Labels Field by dragging it from the Columns area to the 
Rows area. Finally, for this figure, I changed the setting in the Gender Report Fil-
ter from the default of All to M and changed the Profit Sharing Report Filter to Yes.
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As a result, the modified PivotTable shown in Figure 2-12 now shows the salary 
totals for all the men in the corporation arranged first by their department and 
then by their location. Because I added Profit Sharing as a second Report Filter, 
I can see the totals for just the men or just the women who are or aren’t cur-
rently enrolled in the profit sharing plan by selecting the appropriate Report Filter 
settings.

Changing the summary functions
By default, Excel uses the good old SUM function to total the values in the numeric 
field(s) that you add to the Values area, thereby assigning them to the data cells in 
the body of the PivotTable. Some data summaries require the use of another sum-
mary function, such as the AVERAGE or COUNT function.

FIGURE 2-11:  
Pivoting the table 

so that Dept is 
now the Column 

Labels Field  
and Location the 

Row Labels  
Field. (Sample 

workbook: 
Employee  

Table.xlsx)

FIGURE 2-12:  
The PivotTable 

after adding 
Profit Sharing as 

another Report 
Filter and making 

both the Dept 
and Location Row 

Fields. (Sample 
workbook: 
Employee  

Table.xlsx)
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To change the summary function that Excel uses, you open the Field Settings 
dialog box for one of the fields that you use as the data items in the PivotTable. 
You can do this either by clicking the Value Field Settings option on the field’s 
drop-down menu in the Values area in the PivotTable Fields task pane (Alt+JTL) 
or by right-clicking the field’s label and then selecting Value Field Settings on its 
shortcut menu.

After you open the Value Field Settings dialog box for the field, you can change 
its summary function from the default Sum to any of the following functions by 
selecting it on the Summarize By tab:

 » Count: to show the count of the records for a particular category (note that 
COUNT is the default setting for any text fields that you use as Data Items in a 
PivotTable).

 » Average: Calculates the average (that is, the arithmetic mean) for the values 
in the field for the current category and page filter.

 » Max: Calculates the largest numeric value in that field for the current category 
and page filter.

 » Min: Calculates the smallest numeric value in that field for the current 
category and page filter.

 » Product: Calculates the product of the numeric values in that field for the 
current category and page filter (all nonnumeric entries are ignored).

 » Count Numbers: Calculates the number of numeric values in that field for 
the current category and page filter (all nonnumeric entries are ignored).

 » StdDev: Calculates the standard deviation for the sample in that field for the 
current category and page filter.

 » StdDevp: Calculates the standard deviation for the population in that field for 
the current category and page filter.

 » Var: Calculates the variance for the sample in that field for the current 
category and page filter.

 » Varp: Calculates the variance for the population in that field for the current 
category and page filter.

After you select the new summary function to use on the Summarize By tab of 
the Value Field Settings dialog box, click OK to apply the new function to the data 
presented in the body of the PivotTable.
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Adding Calculated Fields
Besides using various summary functions on the data presented in your PivotTa-
ble, you can create your own Calculated Fields for the PivotTable. Calculated Fields 
are computed by a formula that you create by using existing numeric fields in the 
data source. To create a Calculated Field for your PivotTable, follow these steps:

1. Click any of the cells in the PivotTable and then choose PivotTable 
Analyze ➪  Fields, Items, & Sets ➪  Calculated Field (or press Alt+JTJF).

The Fields, Items, & Sets command button is found in the Calculations group 
on the PivotTable Analyze contextual tab.

Excel opens the Insert Calculated Field dialog box similar to the one shown in 
Figure 2-13.

2. Enter the name for the new field in the Name text box.

3. Click the Formula text box and then delete the zero (0) after the equal 
sign and position the insertion point immediately following the equal 
sign (=).

4. Enter the formula to perform the new field’s calculation in the Formula 
text box, inserting whatever fields you need by clicking the name in the 
Fields list box and then clicking the Insert Field button.

To do this, insert numeric fields from the Fields list box and indicate the 
operation to perform on them with the appropriate arithmetic operators  
(+, -, *, or /).

For example, in Figure 2-13, I created a formula for the new calculated field 
called Bonus that multiplies the values in the Salary Field by 2.5 percent  
(0.025) to compute the total amount of annual bonuses to be paid. To do this, 
I selected the Salary field in the Fields list box and then clicked the Insert Field 
button to add Salary to the formula in the Formula text box (as in =Salary). 
Then, I typed *0.025 to complete the formula (=Salary*0.025).

5. When you finish entering the formula for your calculated field, you can 
add the calculated field to the PivotTable Fields task pane by clicking the 
Add button.

After you click the Add button, it changes to a grayed-out Modify button. If you 
start editing the formula in the Formula text box, the Modify button becomes 
active so that you can click it to update the definition.

6. Click OK in the Insert Calculated Field dialog box.

The Insert Calculated Field dialog box closes and adds the summary of the data 
in the calculated field to your PivotTable.
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After you finish defining a calculated field to a PivotTable, Excel automatically 
adds its name to the field list in the PivotTable Fields task pane and to the Values 
area, thereby assigning the calculated field as another Data item in the body of 
the PivotTable.

If you want to temporarily hide a calculated field from the body of the PivotTable, 
deselect the name of the calculated field in the field list in the PivotTable Fields 
task pane (Alt+JTL). Then, when you’re ready to redisplay the calculated field, you 
can do so by selecting its check box in the field list in the PivotTable Fields task 
pane again.

Changing the PivotTable options
You can use the PivotTable Options dialog box (shown in Figure 2-14) to change 
the settings applied to the PivotTables that you create in a workbook. You open this 
dialog box by choosing PivotTable Analyze ➪  Options (or by pressing Alt+JTTT).

The PivotTable Options dialog box contains the following six tabs:

 » Layout & Format: Options for controlling the various aspects of the layout 
and formatting of the cells in the PivotTable

 » Totals & Filters: Options for controlling the display of the subtotals and grand 
totals in the report, and filtering and sorting the table’s fields

 » Display: Options for controlling the display items in the table and the sorting 
of the fields in the PivotTable

 » Printing: Options for controlling print expand and collapse buttons when 
displayed in the PivotTable, and print titles with the row and column labels on 
each page of the printout

FIGURE 2-13:  
Creating a  

calculated field 
for a PivotTable.
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 » Data: Options for controlling how the data that supports the PivotTable is 
stored and refreshed

 » Alt Text: Options for adding alternate, text-based titles and descriptions of 
the information in the PivotTable for those with vision impairments who then 
hear the title and description read aloud

Perhaps the most important PivotTable option is the Classic PivotTable Layout 
(Enables Dragging of Fields in the Grid) check box option on the Display tab. When 
you select this check box, Excel lets you rearrange the fields within the PivotTable 
by dragging their icons onto the desired part of the table (Table Filter, Column 
Labels, or Row Labels). The program also lets you add fields to the PivotTable by 
dragging them from the field list in the PivotTable Fields task pane and dropping 
them on the part of the table to which they are to be added.

Creating PivotCharts
Instead of generating just a PivotTable, you can spice up your data summaries 
by generating a PivotChart to go along with a supporting PivotTable. To create a 
PivotChart from your PivotTable, follow these two steps:

FIGURE 2-14:  
Modifying the  

PivotTable 
options in the  

PivotTable 
Options  

dialog box.
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1. Select a cell in the PivotTable and then choose PivotTable Analyze ➪   

PivotChart (or press Alt+JTC).

Excel opens the Insert Chart dialog box where you can select the type and 
subtype of the PivotChart you want to create. (See Book 5, Chapter 1.)

2. Click the thumbnail of the subtype of chart you want to create in the 
Insert Chart dialog box and then click OK.

Excel inserts an embedded PivotChart into the worksheet containing the original 
PivotTable. This new PivotChart contains drop-down buttons for each of the four 
different types of fields used in the PivotChart (Report Filter, Legend Fields, Axis 
Fields, and Values). You can use these drop-down buttons to sort and filter the 
data represented in the chart. (See “Filtering a PivotChart” later in this chapter 
for details.)

When the PivotChart is selected, Excel augments the Ribbon with three contextual 
tabs: PivotChart Analyze, Design, and Format, which is automatically selected.

Moving a PivotChart to its own sheet
Although Excel automatically creates all new PivotCharts on the same worksheet 
as the PivotTable, you may find customizing and working with the PivotChart 
easier if you move the chart to its own chart sheet in the workbook. To move a new 
PivotChart to its own chart sheet in the workbook, follow these steps:

1. Choose PivotChart Analyze ➪  Move Chart (or press Alt+JTV).

Excel opens the Move Chart dialog box.

2. Click the New Sheet option button in the Move Chart dialog box.

3. (Optional) Rename the generic Chart1 sheet name in the accompanying 
text box by entering a more descriptive name there.

4. Click OK to close the Move Chart dialog box and open the new chart sheet 
with your PivotChart.

Figure 2-15 (sample workbook: Employee Table.xlsx) shows a clustered column 
PivotChart after moving the chart to its own chart sheet in the workbook.

Filtering a PivotChart
When you graph the data in a PivotTable using a typical chart type such as col-
umn, bar, or line that uses both an x- and y-axis, the Row labels in the PivotTable 
appear along the x- or category-axis at the bottom of the chart and the Column 
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labels in the PivotTable become the data series that are delineated in the chart’s 
legend. The numbers in the Values field are represented on the y- or value-axis 
that goes up the left side of the chart.

When you generate a new PivotChart, Excel adds drop-down list buttons to each 
of the types of fields represented. You can then use these drop-down buttons in 
the PivotChart itself to filter the charted data represented in this fashion like you 
do the values in the PivotTable. Remove the check mark from the (Select All) or 
(All) option and then add a check mark to each of the fields you still want repre-
sented in the filtered PivotChart.

Click the following drop-down buttons to filter a different part of the PivotChart:

 » Report Filter: Filter which data series are represented in the PivotChart

 » Axis Fields (Categories): Filter the categories that are charted along the x-axis 
at the bottom of the chart

 » Legend Fields (Series): Filter the data series shown in columns, bars, or lines 
in the chart body and identified by the chart’s legend

Formatting a PivotChart
When a PivotChart is active, the buttons on the Design and Format contextual tabs 
make it easy to further format and customize your PivotChart. Use the Design tab 
buttons to select a new chart style for your PivotChart or even a brand-new chart 
type and further refine your PivotChart by adding chart titles, text boxes, and 

FIGURE 2-15:  
Clustered column 

PivotChart  
moved to its  

own PivotChart 
sheet. (Sample  

workbook: 
Employee  

Table.xlsx)
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gridlines. Use the Format tab’s buttons to refine the look of any graphics you’ve 
added to the chart as well as select a new background color for your chart.

To get specific information on using the buttons on these tabs, see Book 5, 
 Chapter 1, which covers creating charts from regular worksheet data. The Chart 
Design and Format contextual tabs that appear when you select a chart contain 
buttons that are comparable to those on an active PivotChart’s Design and Format 
contextual tabs.

Using the Power Pivot Add-in
The Power Pivot add-in, which enables you to efficiently work with and ana-
lyze large datasets (such as those with hundreds of thousands or even mil-
lions of records), has been made a much more integral part of Excel. In fact, the 
Power Pivot technology that makes it possible for Excel to easily manage massive 
amounts of data from many related data tables is now part and parcel of Excel in 
the form of its Data Model feature. This means that you don’t even have to trot out 
and use the Power Pivot add-in to be able to create Excel PivotTables that utilize 
tons of data records stored in multiple, related data tables. (See Book 6, Chapter 2 
for details.)

If you do decide that you want to use Power Pivot in managing large datasets and 
doing advanced data modeling in your Excel PivotTables, instead of having to 
download the add-in from the Microsoft Office website, you can start using Power 
Pivot by activating the add-in as follows:

1. Choose File ➪  Options ➪  Add-Ins or press Alt+FTAA.

Excel opens the Add-Ins tab of the Excel Options dialog box with Excel Add-Ins 
selected in the Manage drop-down list.

2. Click the Manage drop-down list button and then select COM Add-Ins 
from the drop-down list before you select the Go button.

Excel displays the COM Add-Ins dialog box that contains (as of this writing) the 
following COM (Component Object Model) add-ins: Microsoft Data Streamer 
for Excel, Microsoft Power Map for Excel, and Microsoft Power Pivot for Excel.

3. Select the Microsoft Office Power Pivot for Excel check box and then 
click OK.

Excel closes the COM Add-Ins dialog box and returns you to the Excel work-
sheet window that now contains a Power Pivot tab at the end of the Ribbon.
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If the Power Pivot tab doesn’t appear at the end of the Excel Ribbon, open the 
Customize Ribbon tab of the Options dialog box (Alt+FTC). Chances are that the 
Power Pivot check box under the Main tabs list box on the right-hand side is not 
checked, and all you have to do is select this check box. After you do this and click 
OK to close the Options dialog box, you should see the Power Pivot tab immedi-
ately to the right of the Help tab on the Ribbon.

Data modeling with Power Pivot
Power Pivot makes it easy to perform sophisticated modeling with the data in 
your Excel PivotTables. To open the Power Pivot for Excel window, choose Power 
Pivot ➪  Manage.

If your workbook already contains a PivotTable that uses a Data Model created 
with external data already imported in the worksheet (see Book 6, Chapter 2 for 
details) when you click the Manage button, Excel opens a Power Pivot for Excel 
window similar to the one shown in Figure 2-16 (sample workbook: Contoso Sales 
PivotTable.xlsx). This window contains tabs at the bottom for all the data tables 
that you imported for use in the PivotTable. You can then review, filter, and sort 
the records in the data in these tables by selecting their respective tabs followed 
by the appropriate AutoFilter or Sort command button. (See Book 6, Chapter 1 for 
details.)

FIGURE 2-16:  
The Power Pivot 

window with tabs 
for all the data 

tables imported 
into Excel when 

creating the 
workbook’s  
PivotTable. 

(Sample  
workbook: 

Contoso Sales 
PivotTable.xlsx)
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If you open the Power Pivot for Excel window before importing the external data 
and creating your PivotTable in the current Excel workbook, the Power Pivot  
window is empty of everything except the Ribbon with its three tabs: Home, 
Design, and Advanced. You can then use the From Database, From Data Service, 
or From Other Services buttons in the Get External Data group on the Home tab to 
import the data tables that make your Data Model:

 » From Database to import data tables from a SQL Server, Access, or Analysis 
Services database to which you have access

 » From Data Service to import data tables from a database via an OData (Open 
Data) Feed to which you have access

 » From Other Sources to open the Table Import Wizard that enables you to 
import data tables from databases saved in a wide variety of popular data-
base file formats, including Microsoft SQL Azure, Oracle, Teradata, Sybase, 
Informx, and IBM DB2, as well as data saved in flat files, such as another Excel 
workbook file or even a text file

 » Existing Connections to import the data tables specified by a data query that 
you’ve already set up with an existing connection to an external data source 
(see Book 6, Chapter 2 for details)

After you select the source of your external data using one of the command button 
options available from the Power Pivot window in the Get External Data group, 
Excel opens a Table Import Wizard with options appropriate for defining the 
database file or server (or both) that contains the tables you want imported. Be 
aware that, when creating a connection to import data from most external sources 
(except for other Excel workbooks and text files), you’re required to provide both 
a recognized username and password.

If you don’t have a username and password but know you have access to the data-
base containing the data you want to use in your new PivotTable, import the tables 
and create the PivotTable in the Excel window using the Get Data button’s drop-
down menu found on the Data tab of its Ribbon and then open the Power Pivot 
window to use its features in doing your advanced data modeling.

You cannot import data tables from the Windows Azure Marketplace or using an 
OData data feed using the Get External Data command button in the Power Pivot 
window if Microsoft.NET Full Framework 4.0 or higher is not already installed 
on the device running Excel. If you don’t want to or can’t install this very large 
library of software code describing network communications on your device, you 
must import the data for your PivotTables from these two sources in the Excel 
program window, using the appropriate options on its Get Data button’s drop-
down menu found on the Data tab of its Ribbon.



672      BOOK 7  Data Analysis

Switching between the Data  
View and Diagram View
Diagram View is among the most useful features for data modeling offered by the 
Excel PowerPivot add-in. When you switch from the default Data View to Diagram 
View either by clicking the Home tab’s Diagram View button or the Diagram but-
ton in the lower-right corner to the right of the Display button, all the data tables 
used in the Data Model are graphically displayed in the PowerPivot window, as 
shown in Figure 2-17 (sample workbook: Contoso Sales PivotTable.xlsx).

Each data table graphic object is labeled by name on its title bar and displays 
within it a list of all its fields. To see all the fields within a particular table, you 
may have to resize it by dragging the mouse or Touch pointer at its corners or 
midpoints. To avoid obscuring a data table below when enlarging a table located 
above it to display more of its fields, you can move either the upper or lower data 
table out of the way by dragging it by its title bar.

FIGURE 2-17:  
Switching from 

Data View to 
Diagram View in 

the Power  
Pivot for Excel 

window. (Sample 
workbook: 

Contoso Sales 
PivotTable.xlsx)
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In addition to graphic representations of all data tables in the current Data Model, 
the Diagram View shows all existing relationships between them. It does this by 
drawing connecting lines between each of the related tables. The data table con-
taining the primary key field is indicated by a dot at the end of its connecting line 
and the table containing the foreign key by an arrowhead at the end of its line. To 
see the name of the key field in each related table, click the connecting line: Power 
Pivot then selects the fields in both tables indicated by surrounding them with 
blue outlines.

Not only can you easily review the relationships between data tables in Diagram 
View, but you can also modify them. The most usual way is to create relation-
ships between unrelated tables by locating their key fields and then literally draw-
ing a line between the tables. To locate fields shared by two data tables in the 
Power Pivot diagram in either a one-to-one or one-to-many relationship, you 
can expand the data table graphics to display the entire list of their fields as well 
as use the Zoom slider at the top of the window beneath the Ribbon to zoom in 
and out on the tables. (To see all the tables at once, click the Fit to Screen button 
to the immediate left of the Zoom slider.)

In addition to visually locating shared fields, you can also use PowerPivot’s search 
feature (by clicking the Find button on the Home tab) to search for particular field 
names. When you locate two tables that share a field that may work as a key field, 
you can relate them by dragging a line from the potential key field in one table 
to the key field in the other. When you release the mouse button or remove your 
finger or stylus on a touchscreen device, Excel draws a blue outline between the 
tables indicating the new relationship based on the two shared fields.

If the shared fields don’t represent a one-to-one or one-to-many relation-
ship (see Book 6, Chapter 2 for details) because the values in one or both are not 
unique, Excel displays an alert dialog box indicating that the PowerPivot is not 
able to establish a relationship between your tables. In such a case, you are forced 
to find another data table in the Data Model that contains the same field, but this 
time with unique values (that is, no duplicates). If no such field exists, you’re 
unable to add to the table in question to the Data Model and, as a result, your Excel 
PivotTable won’t be able to summarize its data.

To make it easier to draw the line that creates the relationship between two data 
tables with a shared key field, you should position the tables near one another in 
the Diagram View. Remember that you can move the data table graphic objects 
around in the Power Pivot for Excel window by dragging them by their title bars.
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Adding calculated columns courtesy of DAX
DAX stands for Data Analysis Expression and is the name of the language that 
Power Pivot for Excel uses to create calculations between the columns (fields) in 
your Excel Data Model. Fortunately, creating a calculation with DAX is more like 
creating an Excel formula that uses a built-in function than it is like using a pro-
gramming language such as VBA or HTML.

This similarity is underscored by the fact that all DAX expressions start with an 
equal sign just like all standard Excel formulas and that as soon as you start typ-
ing the first letters of the name of a DAX function you want to use in the expres-
sion you’re building, an Insert Function–like drop-down menu with all the DAX 
functions whose names start with those same letters appears. And as soon as you 
select the DAX function you want to use from this menu, PowerPivot not only 
inserts the name of the DAX function on the PowerPivot Formula bar (which has 
the same Cancel, Enter, and Insert Function buttons as the Excel Formula bar), 
but also displays the complete syntax of the function, showing all the required and 
optional arguments of that function immediately below the Formula bar.

In addition to using DAX functions in the expressions you create for calculated 
columns in your Data Model, you can also create simpler expressions using the 
good old arithmetic operators that you know so well from your Excel formulas 
(+ for addition, – for subtraction, * for multiplication, / for division, and so on).

To create a calculated column for your Data Model, PowerPivot must be in Data 
View. (If you’re in Diagram View, you can switch back by clicking the Data View 
command button on the Power Pivot window’s Home tab or by clicking the Grid 
button in the lower right corner of the PowerPivot window.) When Power Pivot 
for Excel is in Data View, you can create a new calculated field by following these 
steps:

FOR MORE ON DATA MODELING WITH 
POWER PIVOT FOR EXCEL
Being able to establish relationships between data tables in Diagram View represents 
just a small part of Power Pivot’s data modeling capabilities. To find out more about 
data modeling with Power Pivot for Excel, be sure to check out Microsoft Excel Power 
Pivot & Power Query For Dummies, 2nd Edition by Michael Alexander.
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1. Click the tab of the data table in the Power Pivot window to which you 
want to add the calculated column.

2. Click the Add button on the Design tab of the Power Pivot Ribbon.

Power Pivot adds a new column at the end of the current data table with the 
generic field name, Add Column.

3. Type = (equal sign) to begin building your DAX expression.

PowerPivot activates its Formula bar where it inserts the equal to sign.

4. Build your DAX expression on the Power Pivot Formula bar more or less 
as you build an Excel formula in a cell of one of its worksheets.

To use a DAX function in the expression, click the Insert Function button on the 
Power Pivot Formula bar and select the function to use in the Insert Function 
dialog box (which is very similar to the standard Excel Insert Function dialog 
box except that it contains only DAX functions). To define an arithmetic or text 
calculation between columns in the current data table, you select the columns 
to use by clicking them in the data table interspersed with the appropriate 
operator. (See Table 1-1 in Book 3, Chapter 1 for a complete list of operators.)

To select a field to use in a calculation or as an argument in a DAX function, 
click its field name at the top of its column to add it to the expression on the 
Power Pivot Formula bar. Note that Power Pivot automatically encloses all field 
names used in DAX expressions in a pair of square brackets as in

=[UnitPrice]*[Quantity]

where you’re building an expression in an extended price calculated column 
that multiplies the values in the UnitPrice field by those in the Quantity field of 
the active data table.

5. Click the Enter button on the Power Pivot Formula bar to complete the 
expression and have it calculated.

As soon as you click the Enter button, Power Pivot performs the calculations spec-
ified by the expression you just created, returning the results to the new column. 
(This may take several moments depending upon the number of records in the 
data table.) As soon as Power Pivot completes the calculations, the results appear 
in the cells of the Add Column field. You can then rename the column by double-
clicking its Calculated Column N generic name, typing the new field name, and 
pressing Enter.

After creating a calculated column to your data table, you can view its DAX expres-
sion by clicking its field name at the top of its column in the Power Pivot Data View. 
If you ever need to edit its expression, you can do so by clicking the field name to 
select the entire column and then click the insertion point in the DAX expression 
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displayed on the PowerPivot Formula bar. If you no longer need the calculated 
column in the PivotTable for its Data Model, you can remove it by right-clicking 
the column and then selecting Delete Columns on its shortcut menu. If you want 
to hide the column from the Data View, you select the Hide from Client Tools item 
on this shortcut menu.

DAX expressions using arithmetic and logical operators follow the same order of 
operator precedence as in regular Excel formulas. If you ever need to alter this 
natural order, you must use nested parentheses in the DAX expression to alter 
the order as you do in Excel formulas. (See Book 3, Chapter 1 for details.) Just be 
careful when adding these parentheses that you don’t disturb any of the square 
brackets that always enclose the name of any data table field referred to in the 
DAX expression.

Using the 3D Maps Feature
3D Maps is the name of an exciting visual analysis feature formerly known as 
Power Map in Excel 2016. 3D Maps enables you to use geographical, financial, and 
other types of data along with date and time fields in your Excel data model to 
create animated 3-D map tours.

To create a new animation for a tour in 3D Maps, follow these general steps:

1. Open the worksheet that contains the data for which you want to create 
the 3D Maps animation.

2. Position the cell cursor in one of the cells in the table and then choose 
Insert ➪  3D Map ➪  Open 3D Maps (Alt+NSMO) on the Excel Ribbon.

Excel opens a 3D Maps window with a new Tour (named Tour 1) with its own 
Ribbon with a single Home tab similar to the one shown in Figure 2-18 (sample 
workbook: Northwind Orders with 3D Map.xlsx). This window is divided into 
three panes. The Layer pane on the right contains an outline of the default 
Layer 1 with three areas: Data, Filters, and Layer Options. The Data area in the 
Layer Pane is automatically expanded to display a Location, Height, Category, 
and Time list box. The central pane contains a 3-D globe on which your data 
will be mapped. A floating Field List containing fields in the selected Excel data 
model initially appears over this 3-D globe. The left Tour Editor pane contains 
thumbnails of all the tours and their scenes animated for your data model in 
3D Maps (by default, there is just one scene marked Scene 1 when you create 
your first tour).
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3. Drag fields from the floating Field List to the Location, Height, Category, 
and Time list boxes in the Layer Pane to build your map.

Drag the geographical fields whose location data are to be represented visually 
on the globe map and drop them into the Location list box in the Layer Pane. 
3D Maps displays data points for each location field for your animation on the 
3-D globe as you drop it into the Location list box. The program associates the 
selected location field with a geographical type in the drop-down list box to 
the right of the field name in the Location list box in the Layer pane. You can 
modify the type by selecting its drop-down button, if necessary. Just keep in 
mind that each location field needs to have a unique geographical type.

You also add fields from the floating Field List that you want depicted in the 
animation to the Height, Size, or Value list boxes (depending upon the type of 
visualization selected) as follows:

• Add values you want represented in the type of chart displayed on the 
3-D map to the Height list box. By default, Excel uses the Sum function for 
value fields, but you can change this function to Average, Count, Maximum, 
Minimum, or No Aggregation by clicking its drop-down button in the Height 
list box.

• Add data fields that you want to appear as categories in the legend for  
the 3D Maps animation to Category list box. The items in this field are 
automatically added to a floating legend in the 3-D map if your chart type 
has a legend.

FIGURE 2-18:  
3D Maps window 

with new  
Clustered Column 

3-D animation 
for visualizing 
the quantities 

ordered of  
various  

Northwind items 
between July 

1996 and May 
1998 at various 

locations in  
western Canada 

and United 
States. (Sample 

workbook:  
Northwind 

Orders with  
3D Map.xlsx)
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• Add date and time fields to the Time list box to set the time element for 
your 3D Maps animation. By default, 3D Maps does not associate the fields 
you add here to any time unit. You can specify the time unit by selecting 
Second, Minute, Hour, Day, Month, Quarter, or Year from the field’s 
drop-down list button in the Time list box.

4. Select the type of visualization by clicking its icon under the Data heading 
in the Layer Pane: Stacked Column (default), Clustered Column, Bubble, 
Heat Map, or Region.

3D Maps now displays data points for your Height, Size, or Value data on the 
3-D globe appropriate to the type of visualization selected along with a floating 
legend for the data values (organized by any fields used as categories) in the 
center pane of the 3D Maps window. At the bottom of the map, you see a 
Time Line control with a play button that enables you to play and control the 
animation. (See Figure 2-19.)

5. (Optional) Click the Map Labels button on the Ribbon to add country and 
city names to the maps on your 3-D globe.

6. (Optional) Click the Close the Layer Pane button and Close the Tour Editor 
button to hide the display of Layer and Tour Editor panes, respectively.

Now, your 3-D globe with the Layer 1 legend on the right side and animation 
timeline below fill the entire window below the 3D Maps Ribbon. Note that you 
can redisplay the Layer pane and the Tour Editor pane in the 3D Maps window 
at any time by clicking the Layer Pane or Tour Editor Ribbon buttons, 
respectively.

7. (Optional) Drag the Layer 1 legend so that it’s not obstructing your 3-D 
globe. You can also resize the legend by selecting it and then dragging its 
sizing handles. If the Time Line animation control is obstructing key areas 
of the globe, you can hide it by clicking its Close button.

You can redisplay the Time Line control at any time by clicking the Time Line 
button in the Time group on the 3D Maps Ribbon. Note that you can’t reposi-
tion or resize the Time Line control when it is displayed and that you can play 
your animation by clicking the Play Tour button on the Ribbon when the Time 
Line control is hidden.

8. (Optional) Drag the globe to display the area of the world with the 
locations you want to watch when you play your animation or use the 
Rotate Left (Shift+←), Rotate Right (Shift+→), Tilt Up (Shift+↑), or Tilt 
Down (Shift+↓) buttons to bring this area into view. Then, click the Zoom 
In (Shift+ +) or Zoom Out (Shift + -) to bring the area closer into view or 
further away.

Once you have the viewing window beneath the 3D Maps Ribbon positioned 
the way you want it when viewing your animation, you are ready to play the 
3-D map tour you’ve created.
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9. Click the Play Tour button on the Ribbon or the Play button on the Time 
Line control (if it’s still visible).

When you click the Play Tour button on the Ribbon, 3D Maps automatically 
hides the Tour Editor and Layer pane along with the Time Line control if they 
are still visible at that time. You can pause the animation by clicking the Pause 
button that appears in a cluster of controllers in a bar at the bottom of the 
screen or by pressing the spacebar on your keyboard. When you’re finished 
watching the animation, return to the regular Editing view of 3D Maps by 
clicking the Go Back to Edit View button (the one with the arrow pointing left at 
the very beginning of the bar at the bottom of the screen) or pressing the Esc 
key on your keyboard.

10. Click the Close button in the far-right corner of the 3D Maps title bar to 
close 3D Maps and return to your Excel worksheet and then save the 
workbook (Ctrl+S) to save your 3D Maps tour as part of the workbook file.

After you create your initial animation tour for the data model in your Excel work-
book, you can always replay it by reopening it in 3D Maps and clicking Play Tour 
on its Ribbon. To reopen the tour when the workbook with the data model is open 
in Excel, choose Insert ➪  3D Map ➪  Open 3D Maps on the Excel Ribbon (Alt+NSMO) 
and then click the Tour 1 button at the top of the Launch 3D Maps dialog box.

Once the tour is open in 3D Map, you can also edit it. You can change the appear-
ance of the 3-D globe in your animation by selecting a new theme by clicking the 
Themes button in the Scene group of the 3D Maps Ribbon and then selecting a 
thumbnail on this button’s drop-down palette. You can flatten the 3-D globe to 
make it two-dimensional by clicking the Flat Map button in the Map group of the 
Ribbon.

You can also add new layers to your original scene that animate a different data set 
over the same or a different set of date and time values. To add a new layer, click 
the Add Layer button at the top of the Layer task pane and then define the type 
of visualization and the fields to use in your data model for the location, analysis, 
and time (following the same steps as outlined earlier for creating the initial layer 
of the first scene of a new tour). After you add a new layer (automatically named 
Layer 1) to your original scene, 3D Maps shows the legends for both Layer 1 and 2 
(which often overlap and need to be separated manually). 3D Maps also shows the 
data points for each layer’s location, analysis, category, and time fields when you 
play the animation.

If you want to see the animation for just one of the layers in your scene, you can 
hide all the other layers before you play the animation. In the Layer task pane 
(click the Layer Pane button if you don’t see this task pane), click the Show or Hide 
Layer In this Scene icon (the eyeball) to the right of the name of each layer you 
don’t want to view in the animation.
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In addition to adding new layers to a scene, you can also add entirely new scenes 
to your tour that use a copy of the active scene, a new 3-D globe world, or a custom 
map with an entirely new background. To create a new scene, click the New Scene 
button in the Scene group of the 3D Maps Ribbon and then select Copy Scene, 
World Map, or New Custom Map options on its drop-down menu. After you select 
the type of scene, you then define the animation for the new scene using the steps 
you followed earlier in creating the opening animation for the first layer in the 
first scene of the tour. To play the animations you add to the layers of any new 
scene you add to your 3D Maps tour, you click the Scene thumbnail in the Tour 
Editor pane before you click the Play Tour button on the Ribbon or the Play button 
on its Time Line controller.

Use the Create Video and Capture Screen buttons in the Tour group of the  
3D Maps Ribbon to share completed animations with your colleagues and clients. 
Click Capture Screen to take a static picture of the visualization displayed on your 
3-D globe that Excel saves in the Office Clipboard. Once in the Clipboard, you can 
use the Paste feature (Ctrl+V) to paste the graphic into a worksheet after you close 
3D Maps and return to Excel.

Click the Create Video button to create a video of the animation for the currently 
selected scene and layer(s) in your tour. When you click this button, 3D Maps 
opens a Create Video dialog box where you choose the quality of the video select-
ing one of the following option buttons: Presentations & HD Displays (largest 
size and best quality at 1080 pixels), Computers and Tablets (medium size and 
quality at 720 pixels), or Quick Export & Mobile (lowest quality and smallest size 
at 360 pixels). If you want an existing music or narration file to accompany the 

USING POWER BI WITH EXCEL 
WORKSHEET DATA
If the individual maps provided by the 3D Maps add-in do not provide sufficient info-
graphics for your worksheet data, try using Microsoft Power BI (Business Intelligence), 
a suite of data visualization and analytics software that works seamlessly with Excel 
worksheet data. You can download Power BI Desktop that enables you to load data sets 
and models saved in your Excel worksheets (as well as the other standard external data 
sources). In Power BI Desktop (which works a lot like Power Pivot), you can quickly build 
business dashboards containing clusters of tables, charts, and maps that visually iden-
tify key performance indicators inherent in your worksheet data, giving you a rundown 
on the relative health and well-being of your business at a glance. See https://www.
powerbi.com for more on how to download, install, and use Power BI with Excel.

https://www.powerbi.com
https://www.powerbi.com
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animation, click the Soundtrack Options button and then select the sound file and 
the playback options followed by Apply before you click the Create button to make 
the video. 3D Maps then generates a video of the currently selected animation 
saved as .mp4 video file in your device’s default Video folder. You can then save 
this video file to a folder on your OneDrive or Dropbox to share with colleagues or 
clients. You can also play the video on your device using its default video player.

Creating Forecast Worksheets
The Forecast Sheet feature in Excel makes it super easy to turn a worksheet con-
taining historical financial data into a remarkable visual forecast worksheet. All 
you do is open the worksheet with your historical data, position the cell cursor in 
one of its cells, and then choose Data ➪  Forecast Sheet (or press Alt+AFC).

Excel then selects all the historical data in the surrounding worksheet table (which 
typically includes a column for dates as well as one for the related financial data) 
while at the same time opening the Create Forecast Worksheet dialog box, similar 
to the one shown in Figure 2-19 (sample workbook: Historical Sales.xlsx).

FIGURE 2-19:  
Defining the 

options for a new 
line chart that 

shows historical 
and projected 

sales in the  
Create a Forecast 
Worksheet dialog 

box. (Sample 
workbook:  

Historical  
Sales.xlsx)
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By default, Excel selects a line chart to visually depict the trends in its forecast, 
but, if you wish, you can have the program use a column chart instead. Click the 
Column Chart icon to the immediate right of the Line Chart icon at the top of the 
Create Forecast Worksheet dialog box.

In addition to selecting the type of chart to be used in the forecast worksheet, you 
can also control the date at which the forecast chart ends. You do this by select-
ing a new date in the Forecast End text box that appears below the preview of the 
embedded line or column chart. For example, in Figure 2-20 (sample workbook: 
Historical Sales.xlsx), my historical data table includes annual sales for the years 
2004 through 2021, and Excel automatically uses this data to extend the forecast 
end date out five years to 2026. If I wanted to extend the forecast beyond this end 
date, I would enter the new year into the Forecast End text box (or select one with 
the spinner buttons).

Beneath the Forecast End text box in the Create Forecast Worksheet dialog box, 
you find an Options button that when clicked (as shown in Figure 2-20) expands 
the dialog box to include the following options:

 » Forecast Start enables you to select a starting date in the historical data later 
than the one Excel automatically selects (which is the first date in the work-
sheet table).

FIGURE 2-20:  
Worksheet with 
embedded line 
chart depicting 

historical and 
forecast sales 

created with the 
Forecast Sheet 

feature. (Sample 
workbook:  

Historical  
Sales.xlsx)
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 » Confidence Interval allows you to select a new degree of confidence that 
Excel uses to set the Lower- and Upper Confidence Bound line in the forecast 
when using the default line chart.

 » Seasonality changes from the Detect Automatically to Set Manually option where 
you can enter or select a new value indicating the number of points in the values 
range of your data table that are part of a recurring seasonal pattern. When Excel 
can’t automatically detect seasonality in your worksheet data, a warning appears 
that so advises you and suggests that you select the Set Manually option button 
(and leave the default setting at zero) to get better results in the forecast.

 » Include Forecast Statistics has Excel include a table of forecast accuracy 
metrics and smoothing factors in the resulting forecast worksheet.

 » Timeline Range modifies the cell range containing the date values in your 
historical data (by default, Excel selects all these values it identifies in the 
current worksheet table).

 » Values Range modifies the cell range containing the financial values in your 
historical data (by default, Excel selects all these values it identifies in the 
current worksheet table).

 » Fill Missing Points Using to have Excel automatically fill in any missing data 
points it finds in the worksheet table in the forecast chart using either 
interpolation or zeros.

 » Aggregate Duplicates Using modifies the statistical function.

After selecting all the desired options in the Create Forecast Worksheet dialog 
box, you have only to click the Create button to have Excel create a new forecast 
worksheet. This new sheet contains a formatted data table that combines your 
historical data with the forecast values as well as an embedded line or column 
chart (depending upon your selection) depicting the trend in both the historical 
and forecast values.

Figure 2-20 shows the new forecast worksheet that the Excel Forecast Sheet fea-
ture created for me using the original historical sales data shown in Figure 2-20 
after I selected Set Manually option button with the setting at zero and selected 
the Include Forecast Statistics check box before clicking Create in the Create Fore-
cast Worksheet dialog box. As you can see, Excel placed this new forecast work-
sheet (named Sheet1) before the worksheet containing my historical data (named 
Annual Sales).

Note that to display all the forecast values in the new formatted data table in  
Figure  2-20, I repositioned and resized the embedded line chart so that it fits 
nicely in the upper-right corner before taking the screenshot. If I wanted, I could 
move this chart to its own chart sheet before saving the new forecast table and 
chart as part of the Historical and Forecast Sales workbook.
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Recording and 
Running Macros

Macros enable you to automate almost any task that you can undertake in 
Excel. By using Excel’s macro recorder to record tasks that you perform 
routinely, you not only complete tasks considerably faster (because Excel 

can play back your keystrokes and mouse actions much faster than you can per-
form them manually), but you are also assured that each step is carried out the 
same way every time you perform the task.

Excel’s macro recorder records all the commands and keystrokes that you make 
in a language called Visual Basic for Applications (VBA), which is a special ver-
sion of the BASIC programming language developed and refined by the good folks 
at Microsoft for use with all their Office application programs. You can then use 
Excel’s Visual Basic Editor to display and make changes to the macro’s VBA code.

In this chapter, you find out how to use Excel’s macro recorder to record, test, and 
play back macros that you use to automate repetitive tasks required when building 
and using your Excel worksheets and charts. In the next chapter, you find out how 

Chapter 1

IN THIS CHAPTER

 » Understanding how macros do what 
they do

 » Recording macros for instant 
playback

 » Using the relative option when 
recording macros

 » Running the macros you’ve recorded

 » Changing the macro security settings

 » Assigning your macros to the Ribbon 
and Quick Access toolbar
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to use Excel’s Visual Basic Editor to debug and edit the macros that you record, as 
well as to create complex macros that run custom functions and set up and run cus-
tom Excel applications, complete with their own pull-down menus and dialog boxes.

Macro Basics
You can create macros in one of two ways:

 » Use Excel’s macro recorder to record your actions as you undertake them  
in a worksheet.

 » Enter the instructions that you want followed in VBA code in the Visual 
Basic Editor.

Either way, Excel creates a special module sheet that holds the actions and instruc-
tions in your macro. The macro instructions in a macro module (whether recorded 
by Excel or written by you) are stored in the Visual Basic for Applications pro-
gramming language.

You can then study the VBA code that the macro recorder creates and edit this code 
in the Visual Basic Editor, which you open by clicking the Visual Basic command 
button on the Developer tab (when this optional tab is displayed on the Ribbon) 
or by pressing Alt+F11.

Getting ready to record
With Excel’s macro recorder, you can create many of the utility-type macros that 
help you to perform the repetitive tasks necessary for creating and editing your 
worksheets and charts. When you turn on the macro recorder, the macro recorder 
records all your actions in the active worksheet or chart sheet as you make them. 
Note that the macro recorder doesn’t record the keystrokes or mouse actions that 
you take to accomplish an action — only the VBA code required to perform the action 
itself. This means that mistakes that you make while taking an action that you  rectify 
won’t be recorded as part of the macro; for example, if you make a typing error and 
then edit it while the macro recorder is on, only the corrected entry shows up in the 
macro without the original mistakes and steps taken to remedy them.

The macros that you create with the macro recorder can be stored either as part 
of the current workbook, in a new workbook, or in a special, globally available 
Personal Macro Workbook named PERSONAL.XLSB that’s stored in a folder called 
XLSTART on your hard disk. When you record a macro as part of your Personal 
Macro Workbook, you can run that macro from any workbook that you have open. 
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(This is because the PERSONAL.XLSB workbook is secretly opened whenever you 
launch Excel, and although it remains hidden, its macros are always available.) 
When you record macros as part of the current workbook or a new workbook, you 
can run those macros only when the workbook in which they were recorded is 
open in Excel. When that workbook is open, its recorded macros are available not 
only to the workbook itself, but also to any other workbook you have open.

When you create a macro with the macro recorder, you decide not only the work-
book in which to store the macro but also what name and shortcut keystroke to 
assign to the macro that you are creating. When assigning a name for your macro, 
use the same guidelines that you use when you assign a standard range name to 
a cell range in your worksheet. When assigning a shortcut keystroke to run the 
macro, note that you can’t use any of Excel’s built-in key combos such as Ctrl+B 
and Ctrl+Shift+F. Outside of that, you can assign two types of keyboard shortcuts:

 » Ctrl plus an unused letter from A to Z, such as Ctrl+Q.

 » Ctrl+Shift plus an unused letter from A to Z, such as Ctrl+Shift+Q.

You can’t, however, assign the Ctrl key plus a punctuation or number key (such as 
Ctrl+1 or Ctrl+/) to your macro.

The Ribbon’s View tab contains a Macros command button to which a drop-down 
menu containing the following three options is attached:

 » View Macros: Opens the Macro dialog box where you can select a macro to 
run or edit (Alt+WMV).

 » Record Macro: Opens the Record Macro dialog box where you define the 
settings for your new macro and then start the macro recorder; this is the 
same as clicking the Record Macro button on the Status bar (Alt+WMR).

 » Use Relative References: Uses relative cell addresses when recording a 
macro, making the macro more versatile by enabling you to run it in areas of a 
worksheet other than the ones originally used in the macro’s recording 
(Alt+WMU).

Excel also enables you to add a Developer tab to the Ribbon. This tab contains a 
Record Macro button and a Use Relative References button that you can use in 
recording your macros. To add the Developer tab to the Ribbon, follow these two 
steps:

1. Choose File ➪   Options and then click the Customize Ribbon tab or press 
Alt+FTC.

Excel opens the Customize the Ribbon pane within the Excel Options dia-
log box.
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2. Click the Developer check box in the Main Tabs list on the right side of 
the Customize the Ribbon pane in the Excel Options dialog box and then 
click OK.

You can then turn on the macro recorder by doing any of the following:

 » Click the Record Macro icon on the Excel Status bar (to the immediate right of 
the Ready indicator). Not seeing the Record Macro icon? Right-click the Status 
bar and then click to activate the Macro Recording command.

 » Choose View ➪  Macros ➪  Record Macro (or press Alt+WMR).

 » Choose Developer ➪  Record Macro (or press Alt+LR).

Once you turn on the macro recorder, it records all your Excel actions as you make 
them.

Recording macros
To get a feel for how you create a macro with the macro recorder, follow along 
with these steps for creating a macro that enters the company name in 12-point, 
bold type and centers the company name across rows A through E with the Merge 
and Center feature:

1. Open the Excel workbook that contains the worksheet data or chart you 
want your macro to work with.

If you’re building a macro that adds new data to a worksheet (as in this 
example), open a worksheet with plenty of blank cells in which to add the data. 
If you’re building a macro that needs to be in a particular cell when its steps are 
played back, put the cell cursor in that cell.

2. Click the Record Macro button on the Status bar or choose 
View ➪  Macros ➪  Record Macro (or press Alt+WMR).

The Record Macro dialog box opens, similar to the one shown in Figure 1-1, 
where you enter the macro name, define any keystroke shortcut, select the 
workbook in which to store the macro, and enter a description of the macro’s 
function.

3. Replace the Macro1 temporary macro name by entering your name for 
the macro in the Macro Name text box.

When naming a macro, you must not use spaces in the macro name and it 
must begin with a letter and not some number or punctuation symbol. For this 
example macro, you replace Macro1 in the Macro Name text box with the 
name CompanyName.
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4. (Optional) Click the Shortcut Key text box and then type the letter that 
you want to assign to the Ctrl key combination that can run the macro. If 
you want to assign a Ctrl+Shift key combo, hold down Shift and then type 
the letter.

For this example macro, press Shift+C to assign Ctrl+Shift+C as the shortcut 
keystroke. (Interestingly, if you don’t hold down Shift when you type C, Excel 
automatically changes the shortcut to Ctrl+Shift+C because the Ctrl+C shortcut 
is built in to Excel and can’t be overwritten).

Alas, you can’t enter just any letter between A and Z for your Ctrl or Ctrl+Shift 
shortcut key. That’s because Excel has already assigned a number of Ctrl+letter 
and Ctrl+Shift+letter keystroke shortcuts for doing common tasks, such as 
Ctrl+C for copying an item to the Clipboard and Ctrl+Shift+F for displaying the 
Format Cells dialog box. These built-in shortcuts are set in stone, so Excel 
doesn’t allow you to override them.

5. Select the Personal Macro Workbook, New Workbook, or This Workbook 
item from the Store Macro In drop-down list to indicate where to store 
the new macro.

Select Personal Macro Workbook from the Store Macro In drop-down list 
box to be able to run the macro anytime you like. Select This Workbook 
(the default) when you need to run the macro only when the current work-
book is open. Select New Workbook if you want to open a new workbook in 
which to record and save the new macro. If you go with the New Workbook 
or This Workbook option, see the “Saving your recorded macros in a macro-
enabled workbook” section, later in this chapter, to learn how to save the 
workbook in a macro-friendly way.

For this example macro, select the Personal Macro Workbook so that you 
can use it to enter the company name in any Excel workbook that you  
create or edit.

FIGURE 1-1:  
Getting ready  
to record the 

CompanyName 
macro in the 

Record Macro 
dialog box.
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6. (Optional) Use the Description text box to type a brief description of the 
macro’s purpose.

Your description appears just above your recorded macro, so it’s always a good 
idea to document the purpose and functioning of your macro in the 
Description text box. Although this step is optional, including a brief description 
every time you record a new macro means that you and your coworkers 
always know what to expect from the macro when you run it.

7. Click OK.

Excel closes the Record Macro dialog box and you’re ready to start recording 
your macro. Click the Use Relative References option on the Macros command 
button on the View tab or the Use Relative References command button on the 
Developer tab (when it’s displayed) when you want the macro recorder to 
record the macro relative to the position of the current cell. Doing this often 
makes a macro more versatile as it enables you to run the macro in areas in 
the worksheet other than the cells used in its original recording.

8. (Optional) Choose View ➪  Macros ➪  Use Relative References (or press 
Alt+WMU) or choose Developer ➪  Use Relative References (or press 
Alt+LU) if you want to be able to play back the macro anywhere in the 
worksheet.

9. Select the cells, enter the data, and click the Excel commands required to 
perform the tasks that you want recorded just as you normally would in 
creating or editing the current worksheet, using either the keyboard or 
the mouse or a combination of the two.

For the example macro, all you do is type the company name and click the 
Enter button on the Formula bar to complete the entry in the current cell. Next, 
click the Bold button and then click 12 on the Font Size drop-down list on the 
Formatting toolbar. Finally, drag through cells A1:E1 to select this range and 
then click the Merge and Center button, again on the Formatting toolbar.

10. When you’re finished taking all the actions, click the Stop Recording 
button on the Excel Status bar or choose either View ➪  Macros ➪  Stop 
Recording or Developer ➪  Stop Recording.

The Record Macro/Stop Recording button on the Status bar (to the immediate 
right of the Ready status indicator) is by far the most direct and easiest way to 
turn the macro recorder on and off. When using it to record a new macro, as soon 
as you click OK in the Record Macro dialog box to start recording your actions, 
this Record Macro button on the Status bar changes to a Stop Recording button, 
and you can click it when you are done recording all the actions to be included in  
the macro.
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Running a macro
Before testing a new macro, you may need to select a new worksheet or at least 
a new cell range within the active worksheet. When recording cell references 
in a macro, the macro recorder always inserts absolute references in the macro 
sheet unless you click the Relative Reference button on the Stop Recording toolbar 
before you start choosing the commands and taking the actions in the worksheet 
that you want recorded as part of the macro. This means that your macro enters 
its data entries or performs its formatting in the same area of the active worksheet 
(unless the code in the macro itself causes the macro to first select a new area or 
select a new sheet in the active workbook).

If you run your macro in a worksheet that already contains data in the cells that 
the macro uses, you run the risk of having existing data and/or formatting over-
written during the macro’s execution. Keep in mind that, although you can use 
the Undo feature to reverse the very last action performed by your macro, most 
macros perform a series of actions, so you may end up using multiple levels of 
Undo before you are able to successfully reconstruct your spreadsheet.

If your recorded macro makes changes to the worksheet, select the starting cell 
you want the macro to use. You usually run the macro from the Macro dialog box, 
which you can coax onto the screen by doing any of the following:

 » Choose View ➪  Macros ➪  View Macros (or press Alt+WMV).

 » Choose Developer ➪  Macros (or press Alt+LPM).

 » Press Alt+F8.

Excel then opens the Macro dialog box, which is similar to the one shown in  
Figure 1-2. As this figure shows, Excel uses the Macro Name list box to display 
the names of all the macros in the current workbook, your Personal Macro Work-
book (provided you’ve created one), and any other open workbook. Here are three 
things to notice about this list:

 » Macros in the active workbook appear as just the macro name (such as 
AddBudgetHeader and InsertDefaultFooter in Figure 1-2).

 » Macros in any other open workbook appear with the name of the workbook, 
followed by an exclamation point (!), and then the macro name (such as 
PERSONAL.XLSB!CompanyName in Figure 2-1).

 » When you select a macro in the Macro Name list, the macro’s description 
(assuming you entered one) appears in the Description section of the Macro 
dialog box.
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Click the name of the macro that you want to use and then click Run to launch 
the macro.

If you assigned a shortcut keystroke to the macro, you don’t have to bother 
opening the Macro dialog box to play the macro: Press Ctrl plus the letter key or 
Ctrl+Shift plus the letter key that you assigned and Excel immediately plays back 
all of the commands that you recorded.

Saving your recorded macros in a  
macro-enabled workbook
For each recorded macro, you have the option of storing the macro in the current 
workbook or a new workbook. You may choose either option rather than the Per-
sonal Macro Workbook if you plan to distribute your workbook to other people, so 
it’s important for your macros to be distributed along with the rest of the work-
book data.

However, Excel macros aren’t compatible with the default Excel Workbook file 
format (.xlsx). If you try to save a workbook that contains recorded macros using 
the Excel Workbook file format, Excel strips out the macros! (Although Excel 
does have the decency to warn you this is going to happen.) To avoid losing your 
recorded macros, you need to save your workbook using the Excel Macro-Enabled 
Workbook file format (.xlsm). Here’s how:

FIGURE 1-2:  
Selecting the 
macro to run  
in the Macro  

dialog box.
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1. With the workbook you used to store your record macros active, choose 
either File ➪  Save (if your workbook is new and unsaved) or File ➪  Save As 
(if your workbook was saved before you recorded your macros).

Either way, Excel displays the Save As screen.

2. Select a location for the workbook.

3. If you’re saving a new workbook, type a filename.

4. In the list of file formats, select Excel Macro-Enabled Workbook (*.xlsm).

5. Click Save.

Excel saves your file in the Excel Macro-Enabled Workbook format with the 
.xlsm file extension.

Assigning Macros to the Ribbon and  
the Quick Access Toolbar

Instead of running a macro by selecting it in the Macro dialog box or by pressing 
shortcut keys you assign to it, you can assign the macro to a custom tab on the 
Ribbon or a custom button on the Quick Access toolbar and then run it by clicking 
that custom button.

Adding your macros to a custom  
tab on the Ribbon
To assign a macro to a custom tab on the Ribbon, follow these steps:

1. Choose File ➪  Options and then click the Customize Ribbon button in the 
Excel Options dialog box (or press Alt+FTC).

Excel displays the Customize the Ribbon pane in the Excel Options dialog box.

2. Click Macros in the Choose Commands From drop-down list box on the 
left.

Excel lists the names of the all the macros created in the current workbook and 
saved in the PERSONAL.XLSB workbook or any other open workbooks in the 
Choose Commands From list box. Note, too, that you may see other macros 
listed here if you’ve enabled certain add-ins, particularly the Analysis ToolPak.
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3. Click the name of the custom group on the custom tab to which you want 
to add the macro in the Main Tabs list box on the right.

If you haven’t already created a custom tab and group for the macro or need 
to create a new one, you then need to follow these steps:

(a) Click the New Tab button at the bottom of the Main Tabs list.

Excel adds both a New Tab (Custom) and New Group (Custom) item to the 
Main Tabs list while at the same time selecting the New Group 
(Custom) item.

(b) Click the New Tab (Custom) item you just added to the Main Tabs.

(c) Click the Rename button at the bottom of the Main Tabs list box and then type a 
display name for the new custom tab before you click OK.

(d) Click the New Group (Custom) item right below the custom tab you just renamed.

(e) Click the Rename button and then type a display name for the new custom 
group before you click OK.

4. In the Choose Commands From list box on the left, click the name of the 
macro you want to add to the custom group now selected in the Main 
Tabs list box on the right.

5. Click the Add button to add the selected macro to the selected custom 
group on your custom tab.

By default, the name that Excel assigns to the command button is the macro 
name preceded by the name of the workbook in which the macro is stored, 
separated by an exclamation point (as in PERSONAL.XLSB!CompanyName). 
Excel also assigns a default “flowchart” icon to every macro command button. 
To make your Ribbon macro easier to differentiate and locate, you can 
customize both the button name and the button icon.

6. With the macro command selected in the Customize the Ribbon list, click 
Rename.

Excel opens the Rename dialog box.

7. Use the Symbol list to click the icon you want to assign to the macro 
command button, use the Display Name text box to rename the macro 
command button (note that you’re just renaming the button, not the 
macro itself), and then click OK to return to the Excel Options dialog box.

8. Click OK.

After you add a macro to the custom group of a custom Ribbon tab, the macro 
button appears in the custom tab on the Ribbon. To run the macro, click its com-
mand button.
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Adding your macros to custom buttons  
on the Quick Access toolbar
If you have the Quick Access toolbar displayed (see Book 1, Chapter 1), you can 
assign a macro to a custom button on the Quick Access toolbar by following these 
steps:

1. Click the Customize Quick Access Toolbar button at the end of the Quick 
Access toolbar and then click More Commands from the drop-down 
menu to open the Quick Access Toolbar tab of the Excel Options dia-
log box.

2. Select Macros from the Choose Commands From drop-down list box.

Excel lists the names of all the macros created in the current workbook and 
saved in the PERSONAL.XLSB workbook or any other open workbooks in the 
Choose Commands From list box. Other macros are listed here if you’ve 
enabled add-ins such as the Analysis ToolPak.

3. Click the name of the macro to add to a custom button on the Quick 
Access toolbar in the Choose Commands From list box and then click the 
Add button.

4. With the macro command selected in the Customize the Quick Access 
Toolbar list, click Modify.

Excel opens the Modify Button dialog box.

5. Use the Symbol list to click the icon you want to assign to the macro 
command button, use the Display Name text box to rename the macro 
command button (note that you’re just renaming the button, not the 
macro itself), and then click OK to return to the Excel Options dialog box.

6. Click OK.

A custom button with a macro name and icon appears on the Quick Access toolbar. 
To run the macro, click the button.

You can also assign macros to the graphic objects you add to your worksheet, 
including shapes you draw, clip art, and pictures you import. To assign a macro 
to a graphic object, right-click it and then click the Assign Macro option from its 
shortcut menu. Then click the name of the recorded macro to run in the list box 
of the Assign Macro dialog box and click OK. Thereafter, when you position the 
mouse pointer over the graphic object, the pointer becomes a hand with a point-
ing index finger (just like when you assign a hyperlink to a graphic — see Book 2, 
Chapter 1), indicating that you can click it to run the macro.
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Macro Security
Excel uses a system called Microsoft Authenticode that enables developers to 
authenticate their macro projects or add-ins created with Visual Basic for Appli-
cations by a process referred to as digital signing. When you run a macro in your 
worksheet that’s not saved in the trusted locations on your computer, such as the 
Templates and XLSTART folder in your user area on the computer, Excel checks 
to see whether the macro is digitally signed and that the signature is both valid 
and current. The macro’s developer must have a certificate issued by a reputable 
authority or a trusted publisher.

If the program cannot verify a macro’s digital signature (perhaps because it 
 doesn’t have one) or the trustworthiness of its macro publisher, the program then 
displays a security alert on the message bar underneath the Excel Ribbon. This 
alert area contains an Enable Content and a Trust Center command button. You 
can then click the Enable Content button to ignore the alert and go ahead and run 
the macro, assuming that you can vouch for the macro’s publisher and are sure 
that running the macro poses no security risk to your computer. You click the Trust 
Center command button in the security alert on the message bar to open the Trust 
Center dialog box, where you can add to the trusted locations on your computer 
system and change the macro security settings.

You can also open the Macro Settings tab of the Trust Center dialog box by choos-
ing Developer ➪  Macro Security (or by pressing Alt+LAS) or clicking the Trust 
Center Settings button on the Trust Center tab of the Excel Options dialog box 
(Alt+FTT).

By default, Excel selects the Disable All Macros with Notification option button 
on the Macro Settings tab of the Trust Center dialog box. When this setting is 
selected, all macros that are not saved in one of the trusted locations are auto-
matically disabled in the worksheet, but you do get a security alert each time you 
try to run one of these macros that enables you to ignore the alert and go ahead 
and run the macro by clicking the Enable Content button.

The Macro Settings tab of the Trust Center dialog box also contains these other 
options you can select:

 » Disable VBA Macros without Notification to disable all macros not saved in 
one of your computer’s trusted locations and all security alerts so that you 
and the other users of the worksheet have no way to ignore the alert and run 
the macro. Select this option when you don’t trust someone else’s macros and 
want to make it impossible to run a macro carrying a computer virus.
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 » Disable VBA Macros with Notification (the default) to control the disabling 
of macros not saved in one of your computer’s trusted locations and security 
alerts. When you select this setting, worksheet users can ignore the alert and 
run the macro. Select this option when you want to maintain control over 
running potentially untrustworthy macros.

 » Disable VBA Macros except Digitally Signed Macros to automatically 
enable digitally signed macros from a publisher that you’ve indicated is 
trustworthy and to disable all macros that are not digitally signed without 
notification. When you select this option and try to run a digitally signed 
macro that’s not from a publisher you’ve indicated is trustworthy, Excel 
displays an alert in the message bar with a Trust All Documents from This 
Publisher button that you can select, thereby adding the publisher to the 
trusted list.

 » Enable VBA Macros (Not Recommended; Potentially Dangerous Code Can 
Run) to throw all caution to the wind and allow all macros to run in any 
worksheet you open. This is one option you never ever want to select, 
because it could cause serious damage to your machine!

 » Enable Excel 4.0 Macros When VBA Macros Are Enabled to allow Excel’s 
pre-VBA macros to run when you’ve selected the Enable VBA Macros option.

 » Trust Access to the VBA Project Object Model to grant access to Visual 
Basic for Applications object model (see Book 8, Chapter 2) from an automa-
tion client.

To change the trusted locations on your computer, you need to click the Trusted 
Locations tab in the Trust Center dialog box. You can then use these options to 
change the location settings:

 » Add New Location: Use this command button to open the Microsoft Office 
Trusted Location dialog box, where you select a new folder on your computer 
as a trusted location either by entering its directory pathname in the Path text 
box or selecting it with the Browse button. Check the Subfolders of This 
Location Are Also Trusted box if you want all subfolders within the designated 
folder to be included as trusted locations.

 » Allow Trusted Locations on My Network (Not Recommended): Check this 
box so that you can designate folders to which you have access on your local 
network as trusted locations using the Add New Location command button 
(as described in the immediately preceding bullet point).

 » Disable All Trusted Locations: Check this box to immediately disable all the 
folders currently designated as trusted locations and allow only macros from 
publishers designated as trustworthy to run in Excel.
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VBA Programming

The subject of this chapter is Visual Basic for Applications (usually shortened 
to VBA), which is the official programming language of Excel (and the other 
main Office apps), and how you can use it to edit the macros that you record 

(as described in Book 8, Chapter 1) as well as to write new macros. The key to 
editing and writing macros in VBA is its editing program, the Visual Basic Editor 
(often abbreviated as VBE). The Visual Basic Editor offers a rich environment for 
coding and debugging VBA code.

VBA is a huge subject, well beyond the scope of this book. In this chapter, I intro-
duce you to the Visual Basic Editor, and I explain how to use it to do basic macro 
editing. I also show you how to use the Visual Basic Editor to create custom Excel 
functions that you can then use when building formulas in your Excel worksheets. 
Custom functions (also known as user-defined functions or UDFs) work just like 
built-in functions except that they perform only the calculations that you define, 
by using just the arguments that you specify.

Chapter 2

IN THIS CHAPTER

 » Getting familiar with Visual Basic for 
Applications and the Visual Basic 
Editor

 » Editing and running a macro in the 
Visual Basic Editor

 » Creating a dialog box that prompts 
you for input for your macro

 » Writing new macros in the Visual 
Basic Editor

 » Using VBA to create user-defined 
functions

 » Using your user-defined functions in 
your worksheets

 » Saving user-defined functions as 
Excel Add-ins



702      BOOK 8  Macros and VBA

If this basic introduction to Visual Basic for Applications and using the Visual Basic 
Editor inspires you to go on and try your hand at real VBA project  development in 
Excel, I recommend Excel VBA Programming For Dummies, 5th Edition by Michael 
Alexander as an excellent next step. This book gives you the lowdown on all the 
ins and outs of VBA programming in that old, familiar, down-home For Dummies 
style that you’ve come to know and love.

Using the Visual Basic Editor
The first question that you may have is where the heck did they stick this Visual 
Basic Editor that you’ve heard so much about? Actually, the Visual Basic  Editor is 
always ready to step forward whenever you press Alt+F11 or choose  Developer ➪   

Visual Basic (or press Alt+LV) when the Developer tab is displayed on the Ribbon.

The Developer tab is not one of the default tabs on the Ribbon. If your Ribbon 
doesn’t have a Developer tab, this just means that you haven’t yet added it to the 
Ribbon, something you definitely want to do when working with macros. To add 
the Developer tab, choose File ➪  Options ➪   Customize Ribbon, select the Developer 
check box in the Main Tabs list box, and then click OK.

Figure 2-1 shows the arrangement of the typical components in the Visual Basic 
Editor after you first open its window and open a new module sheet. As you can 
see, this window contains its own menu bar. Beneath the menu bar, you find a 
Visual Basic Editor Standard toolbar. This toolbar, shown in Figure 2-2, contains 
several buttons that you may use when creating and editing VBA code.

Beneath the Standard toolbar in the Visual Basic Editor, you find several tiled 
windows of various sizes and shapes. Keep in mind that these are the default 
windows. They aren’t the only windows that you can have open in the Visual Basic 
Editor (as though it weren’t crowded and confusing enough), nor is this the only 
way that they can be arranged.

The two most important windows (at least, when you’re first starting out using 
the Visual Basic Editor) are the Project Explorer window and the Code window. The 
Project Explorer window, which is located near the upper-left corner of the Visual 
Basic Editor window, just under the toolbar, shows you all the projects that you 
have open in the Visual Basic Editor and enables you to easily navigate their var-
ious parts. Note that in VBA, a project consists of all the code and user forms that 
belong to a particular workbook along with the sheets of the workbook itself.
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The macros that you record in the workbook, as well as any that you write for it 
in the Visual Basic Editor, are recorded on module sheets to which generic names 
are assigned, such as Module1, Module2, and so forth. The actual lines of VBA pro-
gramming code for the macro that are stored on a particular module sheet appear 
in the Code window when you select its module in the Project Explorer window. 
(The Code window appears to the immediate right of the Project Explorer window.)

To open a module in the Code window, double-click its module icon in the Proj-
ect Explorer or right-click the module icon and select View Code at the top of its 
shortcut menu.

FIGURE 2-1:  
The Visual Basic 

Editor window 
as it normally 

appears when 
editing a macro.

FIGURE 2-2:  
The buttons on 
the Visual Basic 

Editor’s Standard 
toolbar.
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If you want to rename a module in your VBA project to something a little more 
descriptive than Module1, Module2, and so on, you can do this in the Proper-
ties window that appears immediately below the Project Explorer. Click and drag 
through the name (such as Module1 or Module2) that appears after the label 
(Name) on the Alphabetic tab in the Properties window and replace it with a more 
descriptive name before you press Enter. When renaming a module, remember 
that you must use the same naming guidelines as when naming a range name in a 
worksheet: Begin the module name with a letter of the alphabet and don’t put any 
spaces between words. (Use underlines instead.)

Editing recorded macros
After you’ve created a macro, you don’t necessarily have to re-record it to change 
the way it behaves. In many cases, you will find it more expedient to change its 
behavior by editing its contents in the Visual Basic Editor. Note that if the macro 
you want to edit is stored in your Personal Macro Workbook (the PERSONAL.XLSB 
file in the XLSTART folder — see Book 8, Chapter 1 for details), you must unhide 
this workbook before you edit it in the Visual Basic Editor.

To unhide the Personal Macro Workbook, follow these steps:

1. Choose View ➪  Unhide Window (or press Alt+WU).

Excel opens the Unhide dialog box, which includes PERSONAL.XLSB in its 
Unhide Workbook list box.

2. Click PERSONAL.XLSB in the Unhide Workbook list box and then click OK.

Excel makes the Personal Macro Workbook visible and activates it so that you 
can now edit its macros in the Visual Basic Editor.

To open a macro for editing in the Visual Basic Editor, follow these steps:

1. Choose either Developer ➪  Macros (or press Alt+LPM) or View ➪   

Macros ➪  View Macros (or press Alt+WMV). Alternatively,  
press Alt+F8.

Excel opens the Macro dialog box showing all the names of the macros that 
you’ve defined in the active workbook, any other open workbooks, and in your 
Personal Macro Workbook.

2. Click the name of the macro that you want to edit in the Macro Name 
list box and then click the Edit button.

Excel opens the Visual Basic Editor with the code for your macro displayed in 
the Code window unless you select the name of a macro saved in the Personal 
Macro Workbook and this workbook is still hidden. In that case, Excel displays 
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an Alert dialog box telling you that you can’t edit a hidden macro and informing 
you that you need to unhide this workbook. You then need to click OK in the 
Alert dialog box, press Escape to close the Macro dialog box, and then follow 
the steps for unhiding the Personal Macro Workbook immediately preceding 
these steps before you repeat these first two macro editing steps.

After you have the lines of code for the macro displayed in the Code window in 
the Visual Basic Editor, you can edit any of its statements as needed.

When editing the macro’s commands, remember that you can undo any 
deletion that you make by mistake (Edit ➪  Undo; Ctrl+Z).

3. Edit the statements in the Code window of the Visual Basic Editor as 
needed.

After you finish editing the macro, you’re ready to return to your worksheet, 
where you can test the modified macro and make sure that you haven’t added 
some wacky, unwanted command to the macro or, even worse, crippled it so 
that it no longer runs at all.

4. Click the View Microsoft Excel button at the beginning of the Standard 
toolbar (see Figure 2-2) or click the workbook’s minimized button on the 
Windows taskbar.

Select an appropriate or safe place in which to test your modified macro and 
then run it, either by pressing its shortcut keys or by pressing Alt+F8, clicking it 
in the Macro list box, and then clicking the Run button.

If something doesn’t work as intended or if the macro doesn’t work at all, you 
need to return to the Visual Basic Editor and find and correct your error(s). 
Choose Developer ➪  Visual Basic (or press Alt+LV) to return to the Visual Basic 
Editor and have a try at editing the code one more time.

If everything checks out and runs as planned, you need to save your changes 
as outlined in Step 5.

5. Click the Save button on the Standard toolbar (see Figure 2-2) to save  
the changes to the modified macro if it’s stored as part of the current 
workbook.

Finding and replacing code in the macro
You can use the Find feature in the Visual Basic Editor to quickly locate the state-
ments or properties that need editing in your macro. You open the Find dialog 
box, shown in Figure 2-3, by choosing Edit ➪  Find on the menu bar, clicking the 
Find button on the Standard toolbar, or by pressing Ctrl+F. This dialog box is very 
similar to the one you use when finding entries in your Excel worksheet. The 
main difference is that the Find dialog box gives you different choices for what to 
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search for (in addition to the familiar options for finding whole words only and 
matching case):

 » Current Procedure: Search only the current macro in the Code window.  
In VBA, a procedure is a chunk of code between the Sub and End Sub 
 statements, such as a recorded macro or some code that you write your-
self. (A procedure is also sometimes called a subprocedure, hence the  
“Sub” short form in these statements.)

 » Current Module: Search only the macros in the current module (the default).

 » Current Project: Search all the macros in all modules within the current 
project.

 » Selected Text: Search only the text that you’ve selected in the Code  
window (this option is only available when you’ve selected a block of 
text in the current code).

After you enter the Visual Basic property or statement as your search string in 
the Find What text box, select the search options, and click the Find Next button, 
Excel attempts to locate its first occurrence in the code. When it does, the pro-
gram highlights that occurrence in the current procedure, module, VBA project, or 

FIGURE 2-3:  
Using the Find 

feature to locate 
the code to edit 

in the Code 
window.
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selected text block (depending on which Search option you use). To find the next 
occurrence, you can click the Find Next button in the Find dialog box again or, if 
you close this dialog box, press F3.

If you have several occurrences throughout the macro that require the same type 
of updating, you can use the Replace feature to both find and replace them in the 
macro code. This is particularly useful when you decide to change a particular 
value throughout a macro (such as selecting the cell range named “income 2021” 
for processing instead of the range “income 2022”), and you want to make sure 
that you don’t miss any occurrences.

To open the Replace dialog box, choose Edit ➪  Replace on the Visual Basic Editor 
menu bar or press Ctrl+H. Note that you can open the Replace dialog box from 
within the Find dialog box by clicking its Replace button.

The Replace dialog box that appears is just like the Find dialog box, except that 
it contains a Replace With text box along with the Find What text box and has 
Replace and Replace All buttons in addition to the Find Next button. After enter-
ing the property or statement to find in the Find What text box and the one to 
replace it with in the Replace With text box, click the Find Next button to locate 
the first occurrence in the current procedure, module, VBA project, or selected 
text block (depending on which Search option you use). After this occurrence is 
selected in the Code window, you can replace it with the replacement text by click-
ing the Replace button. Excel then locates the next occurrence, which you can then 
replace by clicking the Replace button or pass over to find the next occurrence by 
clicking the Find Next button.

Don’t use the Replace All button to replace all the occurrences in your macro 
unless you’re 100 percent sure that you won’t be globally replacing something 
that shouldn’t be replaced and possibly screwing up your macro big time. I once 
typed "selection.font.bold = ture" into the Replace With text box when I 
intended to enter "selection.font.bold = true" as the replacement text when 
searching for the property "Selection.Font.Bold = False" in the macro. I then 
clicked the Replace All button only to discover to my dismay that I introduced 
this error throughout the code! Of course, I then had to turn around and use the 
Replace feature to find all the instances of “selection.font.bold = ture” and 
replace them with “Selection.Font.Bold = true”.

Changing settings for VBA properties
Even when you don’t know anything about programming in VBA (and even if you 
aim to keep it that way), you can still get the gist of some of the more obvious 
properties in a macro that change certain settings, such as number format or font 
attribute, by experimenting with assigning them new values.
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In the CompanyName macro shown previously in Figure 2-3, for example, you can 
tell that the section of VBA commands between the line

With Selection.Font

and the line

End With

contains the procedure for assigning various font attributes for the current cell 
selection.

Going a step further, you probably can figure out that most of these attributes are 
being reset by making the attribute equal to a new entry or value, such as

.Name = "Calibri"

or

.Size = 12

or an attribute is being reset by turning it on or off by setting it equal to True or 
False, such as

Selection.Font.Bold = True

to make the text in the current cell selection bold.

Now, it doesn’t require a programming degree (at least, not the last time I checked) 
to get the bright idea that you can make your macro behave differently just by —  
carefully — editing these settings. For example, suppose that you want the final 
font size to be 24 points instead of 12. All you have to do is change

.Size = 12

to

.Size = 24

Likewise, you can have the macro apply single underlining to the cell selection by 
changing

.Underline = xlUnderlineStyleNone
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to

.Underline = xlUnderlineStyleSingle

Getting macro input by adding a dialog box
One of the biggest problems with recording macros is that any text or values that 
you have the macro enter for you in a worksheet or chart sheet can never vary 
thereafter. If you create a macro that enters the heading “Bob’s Barbecue Pit” in 
the current cell of your worksheet, this heading is the only one you’ll ever get out 
of that macro. However, you can get around this inflexibility by using the Input-
Box function. When you run the macro, this Visual Basic function causes Excel to 
display an Input dialog box where you can enter whatever title makes sense for the 
new worksheet. The macro then puts that text into the current cell and formats 
this text, if that’s what you’ve trained your macro to do next.

To see how to use the InputBox function to add interactivity to an otherwise staid 
macro, follow the steps for converting the CompanyName macro that currently 
inputs the text “Logophilia Limited” to one that prompts you for the name that 
you want entered. The InputBox function uses the following syntax:

InputBox(prompt[, title][, default][, xpos][, ypos][, helpfile, 
context])

In this function, only the prompt argument is required with the rest of the argu-
ments being optional. The prompt argument specifies the message that appears 
inside the Input dialog box, prompting the user to enter a new value (or in this 
case, a new company name). The prompt argument can be up to a maximum of 
1,024 characters. If you want different parts of the prompt message to appear on 
different lines inside the dialog box, you include the VBA constant vbCrLf in the 
text (to insert a carriage return and a linefeed in the message), as in this example:

InputBox("Welcome to my Input Box!" & vbCrLf & "Input your 
text here:")

The optional title argument specifies what text to display in the title bar of the 
Input dialog box. If you don’t specify a title argument, Excel displays the name of 
the application on the title bar. The optional default argument specifies the default 
response that automatically appears in the text box at the bottom of the Input 
dialog box. If you don’t specify a default argument, the text box is empty in the 
Input dialog box.

The xpos and ypos optional arguments specify the horizontal distance from the left 
edge of the screen to the left edge of the dialog box and the vertical distance from 
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the top edge of the screen to the top edge of the dialog box. If you don’t specify 
these arguments, Excel centers the input dialog box horizontally and positions it 
approximately one-third of the way down the screen vertically.

The helpfile and context optional arguments specify the name of the custom Help 
file that you make available to the user to explain the workings of the Input dialog 
box as well as the type of data that it accepts. As part of the process of creating a 
custom help file for use in the Excel Help system, you assign the topic a context 
number appropriate to its content, which is then specified as the context argument 
for the InputBox function. When you specify a help file and context argument for 
this function, Excel adds a Help button to the custom Input dialog box that users 
can click to access the custom help file in the Help window.

Before you can add the line of code to the macro with the InputBox function, you 
need to find the place in the Visual Basic commands where the line should go. To 
enter the Logophilia Limited text into the active cell, the CompanyName macro 
uses the following Visual Basic command on Line 8:

ActiveCell.FormulaR1C1 = "Logophilia Limited"

To add interactivity to the macro, you need to insert the InputBox function on a 
line in the Code window right above this ActiveCell.FormulaR1C1 statement, as 
follows:

1. Position the insertion point in the Code window at the beginning of the 
ActiveCell.FormulaR1C1 statement and press Enter to insert a new line.

Now that you’ve added a new line, you need to move the insertion point up 
to it.

2. Press the ↑ key to position the insertion point at the beginning of the new 
line.

On this line, you want to create a variable that supplies the prompt argument 
to the InputBox function. To do this, you state the name of the variable 
(strPrompt in this case) followed by its current entry. Be sure to enclose the 
message text on the right side of the equal sign in a closed pair of double 
quotation marks.

3. Type the following code to create the strPrompt variable on line 8 and 
then press the Enter key to start a new line 9:

strPrompt = "Enter the company name or title for this 
worksheet in the text box below and then click OK:"
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By convention, VBA variable names always start with a lowercase letter and 
subsequent “words” in the variable name begin with an uppercase letter. It’s 
also a convention to start a variable name with text that defines the variable 
type, such as “str” for a string variable.

Next, you create a variable named strTitle that supplies the optional title 
argument for the InputBox function. This variable makes the text “Worksheet 
Title” appear as the title of the Input dialog box. Again, be sure to enclose the 
name for the dialog box title bar in quotation marks.

4. Type the following code to create the strTitle variable on line 9 and then 
press Enter to insert a new line 10:

strTitle = "Worksheet Title"

Next, you create a variable name strDefault that supplies the optional default 
argument to the InputBox function. This variable makes the text, “Logophilia 
Limited” appear as the default entry in the text box at the bottom of the 
custom Company Name Input dialog box. Customize this text to suit your 
situation.

5. Type the following code to create the strDefault variable on line 10 and 
then press Enter to insert a new line 11:

strDefault = "Logophilia Limited"

Next, you create a final variable named strWorksheetTitle that specifies the 
InputBox function as its entry (using the strPrompt, strTitle, and strDefault 
variables that you just created) and stores the results of this function.

6. Type the following code to create the strWorksheetTitle variable that 
uses the InputBox function on line 11:

strWorksheetTitle = InputBox(strPrompt, strTitle, 
strDefault)

Finally, you replace the value, “Logophilia Limited”, in the ActiveCell.
FormulaR1C1 property with the strWorksheetTitle variable (whose value is 
determined by whatever is input into the Worksheet Title dialog box), thus 
effectively replacing this constant in the macro with the means for making this 
input truly interactive.

7. Select “Logophilia Limited” on line 12 and replace it with strWorksheetTitle 
(with no quotation marks).

8. Save the edited macro by clicking the Save button on the Visual Basic 
toolbar and then return to the worksheet by clicking the View Microsoft 
Excel button or pressing Alt+F11. Then, click the Hide button in the 
Window group of the VIEW tab.

Now, you’re ready to open a new workbook (choose File ➪  New or press Ctrl+N) 
and run the edited macro.
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Figure 2-4 shows the Code window with the edited CompanyName macro after 
adding the statements that make it interactive. Figure 2-5 shows the Worksheet 
Title dialog box in action in the worksheet. This input dialog box now automati-
cally appears and prompts you for input whenever you run the edited and now 
fully interactive version of the CompanyName macro.

To go ahead and enter the default text into the current cell and then format it by 
using the rest of the macro commands, you just click OK in this custom dialog 
box. To enter and format the name of another company, you type the name of the 
company (which automatically replaces the default text) before you click OK.

FIGURE 2-4:  
The  

CompanyName 
Code window 

after adding 
variables and 
the InputBox 

function.

WHY NOT TYPE IN THE ARGUMENTS  
OF THE INPUTBOX FUNCTION?
The biggest reason for using the variables strPrompt, strTitle, and strDefault to supply 
the prompt, title, and default arguments of the InputBox function — rather than just typ-
ing them into the function — is their length. If you typed all three pieces of text within 
the parentheses of the InputBox function, you would end up with long and difficult to 
decipher lines of code. When you use variables to do the job, as in the example shown 
previously, you end up with lines of code that fit on one screen, thus making the lines of 
code easier to read. If you use the variables on other procedures in the macro, declaring 
them all together at the beginning of the code also makes it easy to update their values.

FIGURE 2-5:  
The Worksheet 
Title dialog box 

that appears 
when you run the 

CompanyName 
macro.
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Writing new macros in the  
Visual Basic Editor
After you learn the basics of the VBA language, you can write new macros from 
scratch in the Visual Basic Editor instead of just editing ones that you’ve previ-
ously recorded in your worksheet by using Excel’s macro recorder. When creating 
a macro from scratch in the Visual Basic Editor, you need to follow these general 
steps:

1. Click the name of the VBA project in the Project Explorer window  
where you want to add the new macro.

If you want to write a macro just for the current workbook, click the 
VBAProject function that contains its filename in parentheses, as in 
VBAProject (My Worksheet). If you want to write a global macro in the 
Personal Macro Workbook, click VBAProject (PERSONAL.XLSB) in the 
Project Explorer window.

2. Choose Insert ➪  Module on the Visual Basic Editor menu bar.

Excel responds by opening a new, blank Code window in the Visual Basic Editor 
window and by adding another Module icon (named with the next available 
number) in the outline in the Project Explorer window under the appropriate 
VBA Project.

3. To begin your macro, type sub (short for subprocedure) and then press 
the spacebar.

4. Type the name of your macro and then press the Enter key.

Remember that in naming your new macro, you follow the same rules as when 
naming a range name (begin with a letter and no spaces).

As soon as you press the Enter key, the Visual Basic Editor inserts a closed pair 
of parentheses after the macro’s name, a blank line, and an End Sub statement 
on its own line below that. It then positions the insertion point at the beginning 
of the blank line between the lines with the Sub and End Sub statements. It’s 
here that you enter the lines of code for the macro that you’re writing.

5. Enter the lines of VBA code for the macro in between the Sub and End 
Sub statements.

Before you begin writing the VBA statements that your macro is to execute, you 
should first document the purpose and function of this macro. To do this, type 
an apostrophe (’) at the beginning of each line of this text to enter it as a 
comment. (Excel knows not to execute any line of code that’s prefaced with an 
apostrophe.) When you press the Enter key to start a new line that begins with 
an apostrophe, the line of text turns green, indicating that the Visual Basic Editor 
considers it to be a comment that’s not to be executed when the macro runs.
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After you document the purpose of the macro with your comments, you begin 
entering the statements that you want the macro to execute (which must not 
be prefaced by apostrophes). To indent lines of code to make them easier to 
read, press Tab. If you need to outdent the line, press Shift+Tab. For help on 
writing VBA code, refer to the VBA online help. When you finish writing the 
code for your macro, you need to save it before you test it.

6. Choose File ➪  Save on the Visual Basic Editor menu bar or press Ctrl+S.

After you save your new macro, you can click the View Microsoft Excel button 
on the Standard toolbar to return to your worksheet where you can try it. To run 
the new macro that you’ve written, choose either Developer ➪  Macros or View ➪   

Macros (or press Alt+F8) to open the Macro dialog box, and then click the name of 
the macro that you just wrote before you click OK.

If Excel encounters an error when running the macro, it returns you to the Visual 
Basic Editor, and an Alert Microsoft Visual Basic dialog box appears, indicating  
(in very cryptic form) the nature of the error. Click the Debug button in this dialog 
box to have the Visual Basic Editor highlight the line of code that it can’t execute. 
You can then attempt to find the mistake and edit it in the line of code. If you do 
eliminate the cause of the error, the Visual Basic Editor removes the highlighting 
from that line of code, and you can then click the Continue button (which auto-
matically replaces the Run button when the Editor goes into debug mode) with 
the blue triangle pointing to the right on the Standard toolbar to continue running 
the macro.

Running macros in the Visual Basic Editor
Although it’s usually best to run your macros from the Macro dialog box in Excel, 
it’s also possible to run any macro from within the Visual Basic Editor. Here’s how:

1. If need be, switch to the worksheet in which you want your macro to 
make its changes and select the starting cell.

2. Switch back to the Visual Basic Editor.

3. Click anywhere inside the macro you want to run.

4. Use either of the following techniques to run the macro:

• To run the entire macro, choose Run ➪  Run Sub/UserForm. You can also 
either click the Standard toolbar’s Run Sub/UserForm button (pointed out 
earlier in Figure 2-2) or press F5.



VB
A

 P
ro

gr
am

m
in

g

CHAPTER 2  VBA Programming      715

• To step through the macro one line at a time (useful for testing your macro 
to see what effect each line has on your worksheet), choose Debug ➪  Step 
Into (or press F8). Repeat this command (you’ll probably want to use the  
F8 shortcut for this) to execute one line at a time. If at any point you want 
to run the rest of the macro without stopping, press F5; to stop the macro 
at any time, choose Run ➪  Reset or click the Standard toolbar’s Reset 
button.

Creating Custom Excel Functions
One of the best uses of VBA in Excel is to create custom worksheet functions also 
known as user-defined functions (UDFs for short). User-defined functions are great 
because you don’t have to access the Macro dialog box to run them. In fact, you 
enter them into your worksheets just like you do any of Excel’s built-in worksheet 
functions, either with the Insert Function button on the Formula bar or by typing 
them directly into a cell.

To create a user-defined function, you must do four little things:

 » Create a new module sheet where the custom function is to be defined in the 
Visual Basic Editor by selecting its project in the Project Explorer window and 
then choosing Insert ➪  Module on the Visual Basic Editor menu bar.

 » Enter the name of the custom function and specify the names of the argu-
ments that this function takes on in the first line in the Code window — note 
that you can’t duplicate any built-in function names, such as SUM or AVERAGE 
functions, and so on, and you must list argument names in the order in which 
they are processed and enclosed in parentheses.

 » Enter the formula, or set of formulas, that tells Excel how to calculate the 
custom function’s result by using the argument names listed in the Function 
command with whatever arithmetic operators or built-in functions are 
required to get the calculation made on the line or lines below.

 » Indicate that you’ve finished defining the user-defined function by entering 
the End Function command on the last line.

To see how this procedure works in action, consider this scenario: Suppose that 
you want to create a custom function that calculates the sales commissions for 
your salespeople based on the number of sales they make in a month as well as 
the total amount of their monthly sales. (They sell big-ticket items, such as RVs.) 
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Your custom Commission function will then have two arguments  — totalSales  
and itemsSold — so that the first line of code on the module sheet in the Code 
window is

Function Commission(totalSales, itemsSold)

In determining how the commissions are calculated, suppose that you base the 
commission percentage on the number of sales made during the month. For five 
sales or fewer in a month, you pay a commission rate of 4.5 percent of the sales-
person’s total monthly sales; for sales of six or more, you pay a commission rate 
of 5 percent.

To define the formula section of the Commission custom function, you need to 
set up an If construction. This If construction is similar to the If function that 
you enter into a worksheet cell except that you use different lines in the macro 
code for the construction in the custom function. An Else command separates the 
command that is performed if the expression is True from the command that is 
performed if the expression is False. The macro code is terminated by an End If 
command. To set the custom function so that your salespeople get 4.5 percent of 
total sales for five or fewer items sold and 5 percent of total sales for more than 
five items sold, you enter the following lines of code underneath the line with the 
Function command:

If itemsSold <= 5 Then
Commission = totalSales * 0.045

Else
Commission = totalSales * 0.05

End If

Figure 2-6 shows you how the code for this user-defined function appears in the 
Code window for its module sheets. The indents for the If...End If statements 
are made with the Tab key and make differentiating the parts of the If construc-
tion easy. The first formula, Commission = totalSales * 0.045 is used when the 
If expression itemsSold <= 5 is found to be True. Otherwise, the second formula 
underneath the Else command, Commission = totalSales * 0.05 is used.

After entering the definition for your user-defined function, you are ready to 
save it by choosing File ➪  Save on the Visual Basic Editor menu bar or by pressing 
Ctrl+S. Then, you can click the View Microsoft Excel button on the Standard tool-
bar to return to the worksheet where you can try out your new custom function.

If you want to be able to use your user-defined function in any worksheet you 
create, be sure that you select VBAProject (PERSONAL.XLSB) in the Project Explorer 
window before you open a new module and define the custom function there.
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Adding a description to a  
user-defined function
To help your user understand the purpose of your custom function, you can add 
a description that appears in the Insert Function and Function Arguments dialog 
boxes that helps explain what the function does. To add this kind of description to 
your user-defined function, you use the Object Browser, a special window in the 
Visual Basic Editor that enables you to get information about particular objects 
available to the project that you have open.

To add a description for your user-defined function, follow these steps:

1. Open the Visual Basic Editor from Excel by choosing Developer ➪  Visual 
Basic (or pressing Alt+LV or Alt+F11).

Now, you need to open the Object Browser.

2. Choose View ➪  Object Browser from the Visual Basic Editor menu bar or 
press F2.

This action opens the Object Browser window, which obscures the Code window.

3. Click the drop-down list box that currently contains the value <All 
Libraries> and then select VBAProject from the drop-down list.

When you select VBAProject from this drop-down list, the Object Browser then 
displays your user-defined function as one of the objects in one of the Classes 
in the pane on the left.

4. Right-click the name of your user-defined function.

This action selects the function and displays it in the Members pane on the 
right, while at the same time displaying the object’s shortcut menu.

FIGURE 2-6:  
Entering the 
Commission  
user-defined 

function in the 
Personal Macro 

Workbook.
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5. Click Properties on the shortcut menu.

This action opens the Member Options dialog box for your user-defined 
function, where you can enter your description of this function, as shown in 
Figure 2-7.

6. Type the text that you want to appear in the Insert Function and 
Function Arguments dialog box for the user-defined function in the 
Description text box and then click OK.

Now, you can close the Object Browser and save your changes.

7. Click the Close Window button to close the Object Browser and then 
choose File ➪  Save.

Using a custom function in your worksheet
The great thing about custom functions is that they can be inserted into your 
worksheets with the Insert Function button on the Formula bar. Figures 2-8, 2-9, 
and 2–10 (sample workbook: RV Sales.xlsx for all three) illustrate how easy it is to 
enter the custom Commission function in a worksheet with this button.

Figure 2-8 shows a worksheet that contains a table with the RV sales for three 
salespeople: Fred, Holly, and Joe. As you can see, the Automatic Subtotals feature 
(covered in Book 6, Chapter 1) has been used to compute both the monthly total 
sales (with the SUM function) and the number of sales (with the COUNT function) 
for each of these three salespeople.

To calculate the monthly commissions for each salesperson in this table, you 
select the cell where you want the first commission to be calculated (Fred’s com-
mission in cell E6). Click the Insert Function button on the Formula bar and then 
click User Defined at the very bottom of the Or Select a Category drop-down list. 
Doing this displays the PERSONAL.XLSB!Commission custom function in the 
Select a Function list box.

FIGURE 2-7:  
Adding a  

description for 
the Commission 

user-defined 
function.
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When you click OK after selecting the PERSONAL.XLSB!Commission function in 
the Insert Function dialog box, the Function Arguments dialog box appears, as 
shown in Figure 2-9. Here, you select cell C4 with Fred’s total sales amount for 
April as the TotalSales argument and cell C5 with the number of sales made in that 
month as the ItemsSold argument.

When you click OK in the Function Arguments dialog box, Excel calculates Fred’s 
commission by using the 4.5 percent commission rate because his two sales made 
in April are well below the five sales necessary to bump him up to the 5 percent 
commission rate used by the custom Commission function. Figure 2-10 shows the 
completed April sales table after calculating the monthly commissions for Fred, 
Holly, and Joe. In using the custom Commission function, both Fred and Holly fall 
into the 4.5 percent commission rate. Only Joe, the April RV sales king, gets paid 
the higher 5 percent commission rate for his six sales during this month.

Saving custom functions in add-in files
The only limitation to the user-defined functions that you save as part of a regular 
workbook file or the Personal Macro Workbook file is that when you enter them 
directly into a cell (without the use of the Insert Function dialog box), you must 
preface their function names with their filenames. For example, if you want to 
type the custom Commission function that’s saved in the Personal Macro Work-
book, you enter the following formula:

=Commission(C9,C10)

FIGURE 2-8:  
Selecting a cell 
in the RV Sales 
worksheet into 
which to enter 

the Commission 
function. (Sample 

workbook:  
RV Sales.xlsx)
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Assuming that cell C9 contains the total sales and cell C10 contains the number of 
items sold, Excel returns the #NAME? error value to the cell. If you then edit the 
function to include the Personal Macro Workbook’s filename as follows

=PERSONAL.XLSB!Commission(C9,C10)

FIGURE 2-9:  
Specifying the 

TotalSales and 
ItemsSold  

arguments in  
the RV Sales 
worksheet.  

(Sample  
workbook:  

RV Sales.xlsx)

FIGURE 2-10:  
Completed 

worksheet for 
all salespeople 
computed with 

the Commissions 
function. (Sample 

workbook:  
RV Sales.xlsx)



VB
A

 P
ro

gr
am

m
in

g

CHAPTER 2  VBA Programming      721

Excel calculates the sales commission based on the TotalSales in C9 and the Items-
Sold in C10, returning this calculated value to the cell containing this user-defined 
function.

To be able to omit the filename from the custom functions that you create when 
you enter them directly into a cell, you need to save the workbook file that con-
tains them as a special add-in file. (For details on using add-ins in Excel, see 
Book 1, Chapter 2.) Then, after you’ve saved the workbook with your user-defined 
functions as an add-in file, you can start entering them into any worksheet sans 
their filename qualifier by activating the add-in in the Add-Ins dialog box. (Press 
Alt+FTAA and then click the Go command button when Excel Add-Ins is displayed 
on the Manage drop-down list button.)

To convert a workbook containing the user-defined functions that you want to be 
able to enter into worksheets without their filenames, follow these steps:

1. Unhide the PERSONAL workbook in which you’ve saved your user-defined 
functions in Excel by clicking the Unhide button on the View tab and then 
selecting PERSONAL followed by OK.

2. Choose Developer ➪  Visual Basic (or press either Alt+LV or Alt+F11).

3. If the PERSONAL workbook isn’t selected in the Project Explorer, click VBA 
Project (PERSONAL.XLSB) to select that project.

Now, you want to set up protection for this workbook so that only you can 
modify its contents.

4. Choose Tools ➪  VBAProject Properties from the Visual Basic Editor’s 
menu bar.

This action opens the VBAProject — Project Properties dialog box with a 
General and a Protection tab, shown in Figure 2-11.

5. Click the Protection tab and then click the Lock Project for Viewing 
check box.

Putting a check mark in this check box prevents other users from viewing the 
custom functions so that they can’t make any changes to them.

6. Click the Password text box, enter the password there, and then click the 
Confirm Password text box and re-enter the password exactly as you 
entered it in the text box above before you click OK.

A password prevents users from removing the view protection status.
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7. Click the View Microsoft Excel button at the beginning of the Standard 
toolbar.

This action returns you to the worksheet in Excel. Before saving the workbook 
as an add-in, you should add a title for the user-defined functions that it 
contains. (This information then appears in the Add-Ins dialog box whenever 
you select the add-in file.)

8. Choose File ➪  Info.

Excel displays the Info screen about the workbook in the Backstage view.

9. Click the Title text box and enter a descriptive title for the add-in, and 
then click the Save As option on the menu in the Backstage view.

This action opens the Save As screen where the XLSTART folder is currently 
selected.

10. Click More Options.

Excel opens the Save As dialog box, where you need to change the file type to 
Excel Add-In (*.xlam) and then specify the filename (to which Excel automati-
cally appends the .xlam filename extension) under which to save it.

11. Click the Save as Type pop-up button and then select Excel Add-In 
(*.xlam) as the type.

12. Click the File Name combo box and make any necessary changes to the 
filename (without changing the .xlam filename extension) before you 
click the Save button.

After saving your workbook as an add-in file, you’re ready to activate the add-in 
so that you can enter its user-defined functions in any worksheet.

FIGURE 2-11:  
Protecting  

the VBA project 
so that its  

user-defined 
functions can’t  

be changed.
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13. Restart Excel.

14. Choose File ➪  Options ➪  Add-Ins or press Alt+FTAA.

15. Click the Go button near the bottom of the Add-Ins tab after checking to 
make sure that Excel Add-Ins is displayed on the Manage drop-down list 
button.

This action opens the Add-Ins dialog box showing the names of all the available 
add-ins. You must now add the name of your new add-in to this list.

16. Select the name of your new add-in file in the Browse list box and then 
click OK.

This action closes the Browse dialog box and returns you to the Add-Ins dialog 
box that now lists your new add-in file. Now, all you have to do is make sure 
that the check box in front of the name of the new add-in (which displays the 
title and description you gave the add-in at the bottom of the Add-Ins dialog 
box) is selected before you click OK. (See Figure 2-12.)

17. Select the check box in front of the name of the new add-in and then 
click OK.

FIGURE 2-12:  
Activating the 

new add-in file  
in the Add-Ins 

dialog box.
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As soon as you click OK, Excel closes the Add-Ins dialog box and returns you to 
the VBA Editor window. You can then click the Save button (Ctrl+S) followed by the 
View Microsoft Excel button (Alt+F11) on the VBA standard toolbar. When you’re 
back in the PERSONAL workbook, you can then hide it again by clicking the Hide 
button on the View tab (Alt+WH).

After that, you can start entering the custom functions that this add-in file con-
tains directly into the cells of any worksheet without having to open the Insert 
Function dialog box.
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Symbols and 
Numerics
’ (apostrophe), 88
* (asterisk) character, 592, 595
@ symbol, 88
{} (braces), 317
, (comma), 317
$ (dollar sign) symbol, 158
= (equal sign), 88, 294
= (equal to) operator, 596
> (greater than) operator, 596
>= (greater than or equal to) 

operator, 596
< (less than) operator, 596
<= (less than or equal to) 

operator, 596
<> (not equal to) operator, 596
##### (pound signs), 141
# symbol, 158
% (percent sign) symbol, 158
? (question mark) character, 

158, 592, 595
; (semicolon), 317
2-D online images, inserting, 

542–543
3-M model images, 

formatting, 548
3D Model tab, 548
3D Model Views group (3D 

Model tab), 548
3-D online image, 

inserting, 544

A
Above Average option 

(AutoFilter), 589

absolute cell references, 
copying formulas with, 
312–315

Access database tables, 
retrieving data from, 
605–608

Accessibility Checker, running, 
492–493

Accessibility option
Format tab, 517
3D Model tab, 548

accessibility options
about, 57–58
of shared workbooks, 

489–493
Account screen, 16–17
Accounting Number Format 

button (Home tab), 152
ACCRINT function, 389
ACCRINTM function, 389
Activate dialog box, 30
Active Directory, 614
Active Field group (PivotTable 

Analyze tab), 650
Add Constraint dialog box, 636
Add option (Paste Special 

dialog box), 216
Add Scenario dialog box, 

627–628
Add This Data to the Date 

Model option (Import 
Data dialog box), 606

adding
alternative text to graphics, 

491–492
array formulas, 316–322
arrows to text boxes, 

553–554
calculated columns with DAX, 

674–676

calculated fields to 
PivotTables, 664–665

commands to Quick Access 
toolbar, 40

custom tabs to Ribbon, 
66–67

data labels to series in 
charts, 518–519

data tables to charts, 
519–520

descriptions to user-defined 
functions, 717–718

Developer tab to Ribbon, 20
dialog boxes, 709–712
Form button, 568
hidden rows/columns to 

charts, 515
images to SmartArt 

pictures, 557
infographics to worksheets, 

529–532
inline notes to templates, 84
linking formulas, 332–333

add-ins
Component Object Model 

(COM), 70–73
Excel, 70–73
Office, 68–70
saving custom functions in, 

719–724
Add-Ins dialog box, 634, 721
Add-Ins.com, 73
ADDRESS function, 424
Adjust group

Picture Format tab, 547
3D Model tab, 548

adjusting
alignment using Format Cells 

dialog box, 162–166

Index
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adjusting (continued)

columns/rows
about, 141
AutoFit, 141–142
hiding columns, 143–144
manually, 142–143, 

144–145
setting new standard 

width, 143
common calculation options 

on Formula tab, 47–50
date locale, 364
default file location for saves, 

127–128
graphic objects

about, 546
editing pictures, 546
formatting 3-D model 

images, 548
formatting photos and line 

art pictures, 547–548
layout and style of 

charts, 512
Locked/Hidden Protection 

formatting of cells, 
448–449

margins, 275–276, 552
Office language preferences, 

56–57
options

on Advanced tab, 58–63
for spell checker, 225–226

outline levels manually, 
241–243

passwords, 446–447
PivotTables

about, 661–662
adding calculated fields, 

664–665
changing options, 665–666
changing summary 

functions, 662–663
options for, 665–666

save options on Save tab, 
53–56

settings
on General tab, 44–47
for VBA properties, 707–709

Solver options, 637–639
summary functions in 

PivotTables, 662–663
table structure, 567
worksheets, 248–249

Adobe Reader, 494
Advanced Filter dialog box, 

593–595
Advanced Filter feature, 

filtering table data using, 
593–600

advanced financial functions, 
388–391

Advanced tab, changing 
options on, 58–63

Advanced Text Import Settings 
dialog box, 612

After option (AutoFilter), 587
Aggregate Duplicates Using 

option (Create Forecast 
Worksheet dialog 
box), 683

Alexander, Michael (author)
Microsoft Excel Power Pivot & 

Power Query For Dummies, 
2nd Edition, 674

Align Left button (Home 
tab), 151

Align Right button (Home 
tab), 151

Align Text Left button (Home 
tab), 551

Align Text Right button (Home 
tab), 551

Align tool, 517
alignment

adjusting using Format Cells 
dialog box, 162–166

of graphic objects, 538–539

Alignment group (Home tab), 
550–551

All Dates in the Period option 
(AutoFilter), 588

All Except Borders option 
(Paste Special dialog 
box), 216

All Merging Conditional 
Formats option (Paste 
Special dialog box), 216

All option (Paste Special dialog 
box), 215

All Using Source Theme option 
(Paste Special dialog 
box), 215

Alt key, 98
Alt Text tab (PivotTable 

Options dialog box), 666
Alt Text tool, 517
alternative text, adding to 

graphics, 491–492
Alt+JTWA, 654
Alt+JTWL, 655
Alt+JTWT, 655
Alt+JTWV, 654
AMORDEGRC function, 389
AMORLINC function, 389
Analysis Services, 613
Analysis ToolPak, 72, 410
Analysis ToolPak - VBA, 72
analyzing data with 

conditional formatting
about, 178–179
conditional formatting 

with Quick Analysis tool, 
180–181

creating conditional 
formatting rules, 184–185

graphical conditional 
formatting, 179–180

highlighting duplicate values 
in cell ranges, 184

identifying values/text 
entries in cell ranges, 
181–184
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managing conditional 
formatting rules, 186

AND condition, 596–598
AND function, 340, 600
Angle Clockwise option, 165
Angle Counterclockwise 

option, 165
annotating workbooks

about, 468
adding notes, 469
displaying notes, 469–471
hiding notes, 469–471
marking up worksheets with 

digital ink, 471–473
Answer report (Solver), 640
apostrophe (’), 88
Apply Names dialog box, 

330–331
applying

names to existing formulas, 
330–332

number formats to data 
cells, 655–656

outline styles, 238–239
AREAS function, 424
arithmetic operators, 301
Arrange option

Format tab, 517
3D Model tab, 548

Arrange Windows dialog box, 
253–254

arranging windows, 253–254
array formulas

adding, 316–322
creating, 318–320, 320–321
editing, 320, 321–322

arrows, adding to text boxes, 
553–554

Artistic Effects button (Picture 
Format tab), 547

assigning
graphic images as worksheet 

backgrounds, 246–247

macros
to Quick Access 

toolbar, 697
to Ribbon, 695–696

non-Ribbon commands to 
Quick Access toolbar, 
42–43

notes, 469
number formats using 

Format Cells dialog box, 
154–162

numbers
with AutoSum, 298–300
with Quick Analysis tool, 

300–301
passwords to open from Info 

screen, 444–445
passwords to unprotect 

sheets, 451
properties, 463
ready-made headers/footers, 

282–284
records to tables

about, 568
eliminating duplicate 

records, 573–574
using data form, 568–573

Ribbon commands to Quick 
Access toolbar, 41–42

screenshots of Windows 
desktop, 558

Sparkline graphics to 
worksheets, 527–529

text boxes, 550–554
Touch/Mouse Mode button 

to Quick Access toolbar, 
40–41

words to custom dictionary, 
226–227

worksheets to workbooks, 
247–248

asterisk (*) character, 592, 595
at (@) symbol, 88
auditing formulas

about, 349–351
changing Error Checking 

options, 357–358
error checking, 355–357
error tracing, 358–360
evaluating formulas, 360–361
tracing dependents, 354–355
tracing precedents, 351–354

authenticity, digital signatures 
and, 464

AutoCalculate results (Status 
bar), 30

AutoComplete, 99–100
AutoCorrect, 100–101
AutoCorrect Options group 

(Proofing tab), 52
AutoFill, 103–110
AutoFilter, filtering table data 

using, 584–593
AutoFilter button, 575, 579, 

656, 661
AutoFilter dialog box, 589–590
AutoFit, adjusting columns/

rows with, 141–142
AutoRecover Exception For 

group (Save tab), 56
AutoRecover feature

about, 129–130
disabling, 55

AutoSelect, selecting cells with, 
136–138

AutoSum, adding numbers 
with, 298–300

AVERAGE function, 404–405, 
581, 598–599, 662–663

axes
about, 505
formatting on charts with 

Format Axes task pane, 
523–526

Axis Fields button, 668
Axis Position option (Format 

Axis task pane), 525
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Axis Type option (Format Axis 
task pane), 525

B
Back button, 14
Background button (Page 

Setup group), 274
Backspace key, 96–97
Backstage view

about, 10, 13–17
accessing, 13–14
choosing margins from, 275
Info screen, 14–15
opening workbooks in, 

188–192
preparing workbooks for 

distribution, 462–468
printing from

about, 266–267
previewing printout, 

269–272
selecting printers, 268

Banded Columns (PivotStyle 
Options group), 652

Banded Rows (PivotStyle 
Options group), 652

Before option (AutoFilter), 587
Begins With option

AutoFilter, 586
Custom AutoFilter dialog 

box, 592
Below Average option 

(AutoFilter), 589
Between option (AutoFilter), 

587, 589
Bing Maps, 530
Black and White option (Page 

Setup dialog box), 281
Blank Query, 614
Blank Rows button (Layout 

group), 652
Bold button (Home tab), 

150, 550

borders, Format Cells dialog 
box and, 169–171

Borders button (Home 
tab), 150

Bottom Align button  
(Home tab), 151, 551

Bottom alignment, 164
Bounds option (Format Axis 

task pane), 524
Box & Whisker charts, 509
braces ({}), 317
Breaks button (Page Setup 

group), 274
Bring Forward tool, 517
Browser View Options button 

(Info screen), 15
Browser View Options dialog 

box, 462
buttons

AutoFilter, 575, 579, 656, 661
Axis Fields, 668
Back, 14
Capture Screen, 680
Chart Elements, 515
Check for Issues, 462
Colors command, 56
command, 18
Community, 34
Contact Support, 33
Create Video, 680
Criteria, 572
Delete, 231
Excel Blog, 34
Feedback, 33
File menu, 12, 13–14
Fill, 106
Form, 568
Format, 257
Format Chart Title task pane

Text Fill & Outline, 523
Textbox, 523

Formatting (R), 213

Formula bar
about, 24
Insert Function, 160, 

306–307, 718–719
Formulas (F), 211
Formulas & Number 

Formatting (O), 211
Get External Data, 671
Go, 721
Group, 242
Header & Footer Elements 

group
Current Date, 284
Current Time, 285
File Name, 285
File Path, 285
Format Picture, 285
Number of Pages, 284
Page Number, 284
Picture, 285
Sheet Name, 285

Home tab
Align Left, 151
Align Right, 151
Align Text Left, 551
Align Text Right, 551
Bold, 150, 550
Borders, 150
Bottom Align, 151, 551
Center, 151, 551
Comma Style, 152
Decrease Decimal, 152
Decrease Font Size, 

150, 550
Decrease Indent, 151, 551
Fill Color, 150
Font, 150, 550
Font Color, 151, 551
Font Size, 150, 550
Increase Decimal, 152
Increase Font Size, 150, 550
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Increase Indent, 151, 551
Italic, 150, 550
Merge & Center, 151
Middle Align, 151, 551
Number Format, 152
Orientation, 151, 551
Percent Style, 152
Top Align, 151, 551
Underline, 150, 550
Wrap Text, 151

Indicators and Notes, and 
Comments on Hover 
option, 62

Info screen
Browser View Options, 15
Inspect Workbook, 15
Manage Workbook, 15
Protect Workbook, 14, 445
Version History, 15

Keep Source Column Widths 
(W), 212

Keep Source Formatting 
(K), 212

Keyboard Settings, 98
Layout group

Blank Rows, 652
Grand Totals, 652
Report Layout, 652
Subtotals, 652

Legend Fields, 668
Linked Picture (I), 213
Macros, 689
Merge Conditional 

Formatting (G), 212
Next Sheet, 29
No Borders (B), 212
Nothing (Hide Objects) 

option, 62
Page Layout tab

Colors, 559
Effects, 559
Fonts, 559

Page Setup group
Background, 274
Breaks, 274
Margins, 273
Orientation, 273
Print Area, 274
Print Titles, 274
Size, 274

Paste (P), 211
Paste Link (N), 213
Picture (U), 213
Picture Format tab

Artistic Effects, 547
Change Picture, 547
Color, 547
Compress Pictures, 547
Corrections, 547
Remove Background, 547
Reset Picture, 547
Transparency, 547

PivotTable(s), 642, 645–646
Previous Sheet, 29
Record Macro/Stop 

Recording, 692
Recover Unsaved 

Workbooks, 190, 462
Replace All, 707
Report Filter, 668
repositioning on Quick 

Access toolbar, 41
Reset All, 640
Reset Window Position, 253
Save Model, 639
Show Formulas, 62, 350
Show Training, 34
Sort & Filter, 574
Suggest a Feature, 34
Synchronous Scrolling, 253
Touch/Mouse Mode, 40–41
Transpose (T), 212
Ungroup, 242

Ungroup command, 242
using in Page Setup group, 

273–280
using in Scale to Fit group, 

280–281
Values (V), 212
Values & Number Formatting 

(A), 213
Values & Source Formatting 

(E), 213
What’s New, 34
Zoom, 201
Zoom to Selection, 203

C
#CALC!, 339
calculating

future value, 381–382
net present value, 380–381
payments, 382–385
present value, 379–380

Calculation Options group 
(Formula tab), 48–49, 
333–334

calculator, using Excel as 
a, 297

Caps key, 98
Capture Screen button, 680
Cascade arrangement, for 

windows, 254
Categories In Reverse Order 

option (Format Axis task 
pane), 525

category, consolidating 
worksheets by, 262–263

CEILING.MATH function, 
397–398

cell address, 25
Cell contents section  

(Formula bar), 24
Cell Errors As option (Page 

Setup dialog box), 281
CELL function, 427–430
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cell names, defining, 323–325
cell pointer

about, 25
keystroke shortcuts for 

moving, 26–27
keystrokes for moving, 26

cell ranges
constraining data entry 

to, 102
enabling editing of, 452–456
formatting with mini-toolbar, 

152–154
cell styles

creating, 176–177
defining custom, 176
formatting with

about, 174
creating new cell styles, 

176–177
defining custom cell 

styles, 176
merging cell styles, 177–178
Number Format section, 

174–175
merging, 177–178
removing, 177

cells
clearing, 197–199
copying with drag-and- 

drop, 210
counting, 405–410
counting occupied, 407–408
editing

about, 194
in cells vs. Formula bar, 196
clearing cells, 197–199
inserting cells, 199–201
Redo command, 195–197
Undo command, 195–197

formatting from Ribbon, 
150–152

inserting, 199–201

moving with drag-and-drop, 
209–210

naming, 322–332
selecting

about, 132–133
with AutoSelect, 136–138
with Go To, 138–139
with keyboards, 135–136
with a mouse, 133–134
by touch, 135

Center Across Selection 
option, for alignment, 163

Center alignment, 162, 163
Center button (Home tab), 

151, 551
Change Picture button (Picture 

Format tab), 547
Change Shape tool, 516
chart area, 505
chart data series, 505
Chart Design tab

about, 511–512
editing source of data in 

charts, 514–515
modifying layout and 

style, 512
switching rows/columns, 513

Chart Elements button, 515
Chart Elements tool, 516
Chart Layouts group (Chart 

Design tab), 511
Chart Style gallery, 513
Chart Styles group (Chart 

Design tab), 511
chart text, 505
charts

about, 503–504
adding

hidden rows/columns, 515
infographics to worksheets, 

529–532
Sparkline graphics to 

worksheets, 527–529

Chart Style gallery, 513
components, 504–505
creating on separate 

worksheets, 510–511
customizing elements

about, 515–518
adding data labels to series, 

518–519
adding data tables to, 

519–520
editing titles, 520–521
from Format tab, 515, 

516–517
embedded vs. separate 

worksheets, 505–506
formatting elements

about, 521–522
chart axes with Format 

Axes task pane, 523–526
chart titles with Format 

Chart Title task pane, 
522–523

inserting
with Quick Analysis tool, 

509–510
recommended, 506–507
specific types from Ribbon, 

507–509
printing, 532
refining from Chart 

Design tab
about, 511–512
editing source of data in 

charts, 514–515
modifying layout and 

style, 512
switching rows/

columns, 513
saving customized  

charts as templates, 
526–527

Charts group (Insert tab), 
507–508

Cheat Sheet (website), 5
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Check Accessibility option 
(Check for Issues 
button), 462

Check Compatibility option 
(Check for Issues 
button), 462

Check for Issues button, 462
checking

paging in Page Layout view, 
269–270

product information, 16–17
user information, 16–17

circular references, 335–336
Clear All option, 197
Clear Comments option, 197
Clear Contents option, 197
Clear Formats option, 197
Clear Hyperlinks option, 197
Clear Rules option, 179
clearing

cells, 197–199
Print Area, 274–275
print titles from reports, 279

Clipboard task pane, 213–214
Close command, 16
Code window (Visual Basic 

Editor), 702, 703
col_index_num argument, 418, 

419–420
collaborating, with comments, 

498–500
collapse button (-), 656
Collapse dialog box, 310
col_num argument, 422, 423
Color button (Picture Format 

tab), 547
Color Scales option, 179
coloring sheet tabs, 245–247
colors

selecting from Ribbon, 
167–168

selecting in Format Cells 
dialog box, 168–169

using Format Cells dialog 
box, 166–169

Colors button (Page Layout 
tab), 559

Colors command button, 56
Column charts, 528
COLUMN function, 424
Column Headers (PivotStyle 

Options group), 652
column letter, 25
Column Width dialog box, 143
Column Widths option (Paste 

Special dialog box), 216
columns

adjusting
about, 141
AutoFit, 141–142
hiding columns, 143–144
manually, 142–143, 

144–145
setting new standard 

width, 143
deleting, 230–232
filtering fields in PivotTables, 

657–658
hiding, 143–144
inserting, 230–231, 232
labeling, 24

COLUMNS function, 405–406, 
424, 425

Columns section (PivotTable 
Fields task pane), 649, 650

Combine Queries option 
(Get & Transform Data 
group), 604

comma (,), 317
Comma Style button (Home 

tab), 152
command buttons, 18
commands

adding to Quick Access 
toolbar, 40

Close, 16

Copy, 249
Create from Selection, 

327–328
Delete Cells, 199
from earlier Excel 

versions, 43
Error Checking, 350, 355–358
Evaluate Formulas, 351, 

360–361
File menu, 15–16
Find, 218–221
Goal Seek, 631–633
Info, 15–16
Ink Replay, 473
Insert, 199–201
Move, 249
non-Ribbon, 42–43
Print, 16
Publish, 16
Redo, 195–197
Refresh All (Data tab), 609
Remove Arrows, 350
Replace, 221–223
Save, 16
Save As, 16
Screenshot, 558
Trace Dependents, 350, 

354–355, 358–360
Trace Precedents, 350, 

351–354, 358–360
Undo, 195–197
View Side by Side, 253
Watch Window, 351

comments
collaborating with,  

498–500
deleting, 500
displaying, 499
editing, 499
hiding, 499
inserting, 498–499
replying to, 500
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Comments and Notes option
Page Setup dialog box, 281
Paste Special dialog box, 215

Community button, 34
Comodo, 464
comparative operators, 596
comparing worksheet 

windows, 251–253, 255
comparison operators, 301
Component Object Model 

(COM) add-ins, 70–73
Compress Pictures button 

(Picture Format tab), 547
computational operators, 

building formulas with, 
301–304

concatenating text, 437–438
conditional counting, 408–410
conditional formatting

about, 590
analyzing data with

about, 178–179
conditional formatting 

with Quick Analysis tool, 
180–181

creating conditional 
formatting rules, 184–185

graphical conditional 
formatting, 179–180

highlighting duplicate 
values in cell ranges, 184

identifying values/text 
entries in cell ranges, 
181–184

managing conditional 
formatting rules, 186

whiting-out errors with, 
348–349

Conditional Formatting Rules 
Manager dialog box, 186

conditional summing, 400–403
Confidence Interval option 

(Create Forecast 
Worksheet dialog 
box), 683

consolidating worksheets
about, 258–259
by category, 262–263
linking consolidated 

data, 263
by position, 259–262

constants, naming, 325–326
constraining data entry to cell 

ranges, 102
constraint cell, 634
Constraint Precision option 

(Solver), 638
Contact Support button, 33
Contains option

AutoFilter, 586
Custom AutoFilter dialog 

box, 592
Convert Text to Columns 

Wizard, 611–613
converting ranges to/from 

tables, 566
copy, cut, and paste, copying 

and moving with, 210–218
Copy command, 249
Copy dialog box, 249
copying

with copy, cut, and paste, 
210–218

with drag-and-drop, 209–210
formulas

about, 310
with absolute references, 

312–315
with mixed cell references, 

315–316
with relative cell references, 

311–312
sharing links, 479–480
worksheets, 248–249
worksheets between 

workbooks, 256–257
correction options, changing 

on Proofing tab, 51–53

Corrections button (Picture 
Format tab), 547

Cortana, launching from, 36
cost

add-ins, 73
defined, 386

COUNT function, 406, 581, 
662–663

COUNT NUMBERS 
function, 663

COUNTA function, 406, 
407–408

COUNTBLANK function, 406
COUNTIF function, 408–410
counting

cells, 405–410
conditional, 408–410
occupied cells, 407–408

COUPDAYBS function, 389
COUPDAYS function, 389
COUPDAYSNC function, 389
COUPNCD function, 389
COUPNUM function, 389
COUPPCD function, 389
Create Forecast Worksheet 

dialog box, 682–683
Create from Selection 

command, 327–328
Create PivotTable dialog 

box, 647
Create Table dialog box, 

147, 566
Create Video button, 680
creating

array formulas, 318–320, 
320–321

calculated fields in tables, 
566–567

cell styles, 176–177
charts on separate 

worksheets, 510–511
counting formulas, 405–407
custom AutoFill lists, 108–110
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custom Excel functions
about, 715–717
adding descriptions to 

user-defined functions, 
717–718

saving custom functions in 
add-in files, 719–724

using custom functions in 
worksheets, 718–719

custom headers/footers, 
284–288

custom views of outlines, 243
formulas

with computational 
operators, 301–304

that calculate elapsed 
dates, 364–365

that calculate elapsed 
times, 365–366

macros, 688
names from column/row 

headings, 327–328
one-variable data tables, 

621–623
outlines, 237–238
PivotCharts

about, 666–667
filtering, 667–668
formatting, 668–669
moving to own 

worksheet, 667
PivotTables

about, 642
customizing PivotTable 

Fields task pane, 651
manually, 646–650
with Quick Analysis tool, 

643–645
recommended, 645–646

scenarios, 626–630
series that uses custom 

increments, 108
Solver reports, 640

summary reports, 630–631
two-variables data tables, 

624–626
workbook templates, 83–84
worksheets

about, 78
from scratch, 84–86
from templates, 78–84

criteria, 601
Criteria button, 572
CSV files, 610
Ctrl key, 97, 134, 689
CUMIPMT function, 389
CUMPRINC function, 389
Current Date button  

(Header & Footer 
Elements group), 284

Current Module option (Find 
dialog box), 706

Current Procedure option 
(Find dialog box), 706

Current Project option (Find 
dialog box), 706

Current Selection option 
(Format tab), 516

Current Time button  
(Header & Footer 
Elements group), 285

Custom AutoFilter dialog box, 
588, 591–593

Custom Filter option 
(AutoFilter), 586, 588, 589

customizing
about, 39
chart elements

about, 515–518
adding data labels to series, 

518–519
adding data tables to, 

519–520
editing titles, 520–521
from Format tab, 515, 

516–517

Excel add-ins, 70–73
Excel Ribbon, 63–67
Office add-ins, 68–70
options, 43–67
PivotTable Fields task pane, 

646–650, 651
Quick Access toolbar, 40–43
Status bar, 30

D
data

marking invalid, 227–228
transferring between open 

windows, 256
Data Analysis dialog box, 410
Data Bars option, 179
data entry

limiting, 112–115
in unlocked cells of protected 

worksheets, 456–458
in worksheets

about, 93–94
AutoComplete, 99–100
AutoCorrect, 100–101
AutoFill, 103–110
constraining to cell 

ranges, 102
decimal points, 103
Flash Fill, 110–115
keyboard style, 94–96
Touch keyboard, 96–99

data form, using, 568–573
Data Form dialog box, 570
Data group (Chart Design 

tab), 511
data labels

adding to series in charts, 
518–519

removing from charts, 519
data marker, 505
data modeling, 670–671
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Data Source Settings option 
(Get & Transform Data 
group), 604

Data tab (Ribbon)
about, 19
options on, 50–51
PivotTable Options dialog 

box, 666
Refresh All command, 609

Data Table dialog box, 
621, 622

data tables
about, 620–621
adding to charts, 519–520
one-variable, 621–623
two-variable, 624–626

Data Type Detection option 
(Import Data dialog 
box), 611

data types, in worksheets
about, 86–87
labels, 87–89
values, 89–93

Data Validation feature, 
marking invalid data, 
227–228

Data view, switching between 
Diagram view and, 
672–674

database, 600
database functions, 600–602
date and time formulas

about, 363
date functions

about, 366
DATE, 367–368
DATEVALUE, 367–368
DAY, 368–369
DAYS360, 369–370
EDATE, 370–371
EOMONTH, 371
MONTH, 368–369
NETWORKDAYS, 371–372

TODAY, 366
WEEKDAY, 368–369
WEEKNUM, 372–373
WORKDAY, 373
YEAR, 368–369
YEARFRAC, 373–374

dates
about, 363–364
building formulas that 

calculate elapsed, 
364–365

changing date locale, 364
time functions

about, 374
HOUR, 376
MINUTE, 376
NOW, 374–375
SECOND, 376
TIME, 375–376
TIMEVALUE, 375–376

times
about, 363–364
building formulas that 

calculate elapsed, 
365–366

date data type, 612
Date Filters options 

(AutoFilter), 587–588
DATE function, 367–368
date functions

about, 366
DATE, 367–368
DATEVALUE, 367–368
DAY, 368–369
DAYS360, 369–370
EDATE, 370–371
EOMONTH, 371
MONTH, 368–369
NETWORKDAYS, 371–372
TODAY, 366
WEEKDAY, 368–369
WEEKNUM, 372–373

WORKDAY, 373
YEAR, 368–369
YEARFRAC, 373–374

dates
about, 363–364
building formulas that 

calculate elapsed, 
364–365

changing date locale, 364
inputting, 91–92
two-digit years, 92–93

DATEVALUE function, 367–368
DAVERAGE function, 583, 

600–602
DAX, adding calculated 

columns with, 674–676
DAY function, 368–369
DAYS360 function, 369–370
DB function, 385–388
DCOUNT function, 583, 

600–602
DCOUNTA function,  

583, 601
DDB function, 385–388
decimal points, 103
Decrease Decimal button 

(Home tab), 152
Decrease Font Size button 

(Home tab), 150, 550
Decrease Indent button 

(Home tab), 151, 551
defining

cell names, 323–325
custom cell styles, 176
range names, 323–325

Del key, 98
Delete All Unsaved 

Workbooks, 462
Delete button, 231
Delete Cells command, 199
Delete Columns (Protect Sheet 

dialog box), 450
Delete key, 199, 231
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Delete Rows (Protect Sheet 
dialog box), 450

deleting. See also removing
columns, 230–232
comments, 500
fields from tables, 567
notes, 471
passwords, 446–447
records with data form, 573
rows, 230–232
text boxes, 552
worksheets, 248

delimited files, 610
Delimiter option (Import Data 

dialog box), 611
depreciation functions, 

385–388
Design tab

about, 581
PivotCharts and, 668
PivotTables and, 651–653

designing
number formats, 159–162
tables

about, 564–566
converting ranges to/from 

tables, 566
creating calculated fields, 

566–567
modifying structure, 567

workbooks, 84–86
Developer tab, 20, 689–

690, 702
DGET function, 601
Diagram view, switching 

between Data view and, 
672–674

Dialog box launcher, 18
dialog boxes

Activate, 30
Add Constraint, 636
Add Scenario, 627–628
adding, 709–712

Add-Ins, 634, 721
Advanced Filter, 593–595
Advanced Text Import 

Settings, 612
Apply Names, 330–331
Arrange Windows, 253–254
AutoFilter, 589–590
Browser View Options, 462
Collapse, 310
Column Width, 143
Conditional Formatting Rules 

Manager, 186
Copy, 249
Create Forecast Worksheet, 

682–683
Create PivotTable, 647
Create Table, 147, 566
Custom AutoFilter, 588, 

591–593
Data Analysis, 410
Data Form, 570
Data Table, 621, 622
Encrypt Document, 446–447
Evaluate Formula, 361
Excel Compatibility 

Checker, 128
Excel Options, 34, 192, 

225–226, 248, 348, 410
Existing Connections, 

608, 647
Field Settings, 650
Find, 705–707
Format Cells

about, 154
adjusting alignment, 

162–166
assigning number formats, 

154–162
borders, 169–171
fills, 171–173
fonts and colors, 166–169
gradients, 171–173
patterns, 171–173

Function Arguments, 310, 
717, 719

General Options, 444, 447
Go To, 139
Goal Seek, 632–633
Goal Seek Status, 632–633
Import Data, 605–606, 

609–610
Input, 709–710
Insert, 200–201, 214
Insert Chart, 506–507, 508
Insert Function, 340, 717, 

719, 724
Insert Picture, 544–545
Insert Slicers, 658
Insert Timelines, 660
Load Model, 639–640
Macro, 693–694, 715
Manage Relationships, 603
Move, 249
Name Manager, 329
Navigator, 605–606, 614
New Name, 324, 326
Online 3D Models, 544
Open, 191, 192
Options, 638, 670
Page Layout, 275
Page Setup, 281–282, 532
Paste Special, 214–218
PivotTable from External 

Data Source, 647–648
PivotTable from Table or 

Range, 647
PivotTable Options,  

665–666
Protect Sheet, 449, 455
Protect Structure and 

Windows, 458–459
Replace, 707
Row Height, 145
Save As, 125–126, 128, 

192, 442
Save Current Theme, 559



736      Excel All-in-One For Dummies

dialog boxes (continued)

Scenario Summary, 630–631
Select Data Source, 514–515
Send Link, 479–480
Series, 106
Settings, 238
Show Trial Solution, 636
Solver Options, 639
Solver Parameters, 636, 

638, 640
Solver Results, 637, 640
Sort, 577, 580
Subtotal, 582
Trust Center, 698–699
Value Field Settings, 663
From Web, 608–609
Worksheet Title, 712

dictating, 99
dictionary, adding words to, 

226–227
digital ink, marking up 

worksheets with, 471–473
digital signature, 463–468, 698
disabling AutoRecover 

feature, 55
DISC function, 389
display options, 61–63
Display tab (PivotTable 

Options dialog box), 665
displaying

Activate dialog box, 30
Chart Design tab, 513
comments, 499
contextual tab groups, 65
Help taskbar, 32–33
hot keys, 67
mini-toolbar, 153–154
notes, 469–471
outline levels, 239–241
Quick Access toolbar above 

Ribbon, 23
Selection task pane, 537, 538

Distributed option, for 
alignment, 163, 164

distribution
about, 461
annotating workbooks

about, 468
adding notes, 469
displaying notes, 469–471
hiding notes, 469–471
marking up worksheets 

with digital ink, 471–473
preparing workbooks for 

review
about, 462–463
adding properties, 463
digitally signing documents, 

463–468
#DIV/0!, 339, 345–347
Divide option (Paste Special 

dialog box), 216
DMAX function, 601
DMIN function, 601
Document Recovery, 

worksheets and, 129–130
documents, digitally signing, 

463–468
Does Not Begin With option 

(Custom AutoFilter dialog 
box), 592

Does Not Contain option
AutoFilter, 586
Custom AutoFilter dialog 

box, 592
Does Not End With option 

(Custom AutoFilter dialog 
box), 592

Does Not Equal option
AutoFilter, 586, 588
Custom AutoFilter dialog 

box, 591
DOLLAR function, 432–434
dollar sign ($) symbol, 158
DOLLARDE function, 389
DOLLARFR function, 389

Down key, 98
downloading

selecting images for, 543
templates, 80–81

DPRODUCT function, 601
Draft Quality option (Page 

Setup dialog box), 281
drag-and-drop

copying and moving with, 
209–210

moving worksheets between 
open windows using, 256

drawing graphic objects
about, 549
adding text boxes, 550–554
inserting

SmartArt graphics, 555–557
WordArt, 554–555

predefined shapes, 549
DSTDEV function, 601
DSTDEVP function, 601
DSUM function, 583, 600–602
duplicate values, highlighting 

in cell ranges, 184
DURATION function, 390
DVAR function, 601
DVARP function, 601

E
Ease of Access tab, 57–58
economy, planning for, 85
EDATE function, 370–371
Edit Objects (Protect Sheet 

dialog box), 450
Edit Scenarios (Protect Sheet 

dialog box), 450
Edit Shape option (Shape 

Format tab), 551
editing

array formulas, 320,  
321–322

cells
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about, 194
in cells vs. Formula bar, 196
clearing cells, 197–199
inserting cells, 199–201
Redo command, 195–197
Undo command, 195–197

chart titles, 520–521
comments, 499
embedded data, 486
formulas, 297
linked data, 487–488
links, 120–121
multiple worksheets, 

249–250
notes, 470–471
opening macros for, 704–705
pictures, 546
recorded macros, 704–712
records in data form, 571
source of data in charts, 

514–515
text in text boxes, 552

EFFECT function, 390
Effects button (Page Layout 

tab), 559
Eliminate Duplicates feature, 

573–574
eliminating duplicate records 

in tables, 573–574
email, sharing workbooks via, 

480–481
embedded charts, 505–506
embedding

about, 482
editing embedded data, 486
worksheet data, 484–486

Emoticons key, 97
enabling

cell range editing, 452–456
Power Pivot add-in, 669
Undo feature, 50–51

Encrypt Document dialog box, 
446–447

Ends With option
AutoFilter, 586
Custom AutoFilter dialog 

box, 592
Enter key, 97
entering

function arguments, 308–310
functions manually, 305
passwords to gain 

access, 445
passwords to make changes, 

445–446
EOMONTH function, 371
equal sign (=), 88, 294
equal to (=) operator, 596
Equals option

AutoFilter, 586, 587, 588
Custom AutoFilter dialog 

box, 591
Error Checking and Error 

Checking Rules group 
(Formula tab), 50

Error Checking command, 350, 
355–358

error trapping
about, 337–338
formulas

about, 345
with IF function, 346–347
with ISERROR function, 

347–348
removing errors from 

printouts, 361–362
whiting-out errors with 

conditional formatting, 
348–349

error values, 338–339
Esc key, 98
Euro Currency Tools, 72
European method, 370

Evaluate Formula dialog 
box, 361

Evaluate Formulas command, 
351, 360–361

evaluating formulas, 360–361
EVEN function, 397
Excel (Microsoft). See also 

specific topics
about, 9
add-ins, 70–73
components of, 10
help, 31–34
launching, 34–37
quitting, 37
sharing data

between PowerPoint and, 
488–489

between Word and, 
483–488

Start screen, 10–11
user interface, 12–31
using as a calculator, 297

Excel 97-2003 Workbook file 
format, 126

Excel Blog button, 34
Excel Compatibility Checker 

dialog box, 128
Excel Macro-Enabled 

Workbook file format, 126
Excel Macro-Enabled 

Workbook Template file 
format, 127

Excel Options dialog box, 
34, 192, 225–226, 248, 
348, 410

Excel Template file format, 126
Excel Workbook file 

format, 126
Existing Connections dialog 

box, 608, 647
Existing Worksheet option 

(Import Data dialog 
box), 606
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expand button (+), 656
exporting

workbooks, 493–498
worksheets as PDF files, 

494–495
extending a selection, 135–136
external data, creating 

PivotTables from, 647–648

F
FALSE logical value, 340, 

598–599
Feedback button, 33
#FIELD!, 339
Field Settings dialog box, 650
fields

creating calculated fields in 
tables, 566–567

defined, 600–601
deleting from tables, 567
inserting in tables, 567
sorting

on multiple, 575–578
on single, 575

file formats
common, 126–127
saving in old, 128–129

File menu button, 12, 13–14
File menu commands, 15–16
File Name button  

(Header & Footer 
Elements group), 285

File Origin option (Import Data 
dialog box), 611

File Path button  
(Header & Footer 
Elements group), 285

filename extensions, 129
files

adding images to SmartArt 
graphics from, 557

CSV, 610

delimited, 610
HTML

exporting workbooks 
to, 494

saving worksheets as, 
496–498

ODS
exporting workbooks 

to, 494
saving worksheets as, 496

PDF
about, 127
emailing workbooks as, 481
exporting workbooks 

to, 493
exporting worksheets as, 

494–495
saving worksheets as, 

494–495
saving, 442–444
text, 609–613
XPS

exporting workbooks 
to, 493

saving worksheets as, 495
Fill button, AutoFill via, 106
Fill Color button (Home 

tab), 150
Fill Missing Points Using 

option (Create Forecast 
Worksheet dialog 
box), 683

Fill option, for alignment, 163
fills

in text for SmartArt 
graphics, 556

using Format Cells dialog 
box, 171–173

filtering
PivotCharts, 667–668
PivotTable data

about, 656
column/row fields, 657–658

report, 656
slicing, 658–659
timeline filters, 659–660

table data
about, 583–584
using Advanced Filter 

feature, 593–600
using AutoFilter, 584–593

Filters section (PivotTable 
Fields task pane), 649

financial formulas
about, 377
advanced financial functions, 

388–391
depreciation functions, 

385–388
financial function basics, 378
FV function, 381–382
NPV function, 380–381
PMT function, 382–385
PV function, 379–380

Find command, 218–221
Find dialog box, 705–707
Find feature, 705–707
finding

misplaced workbooks, 
192–193

records with data form, 
571–572

finding and replacing
code in macros, 705–707
worksheet data, 218–223

Flash Fill, 110–115
Fn key, 98
following links, 120
Font button (Home tab), 

150, 550
Font Color button (Home tab), 

151, 551
Font group (Home tab), 

550–551
Font Size button (Home tab), 

150, 550
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fonts
selecting

in Format Cells dialog box, 
168–169

from Ribbon, 167–168
using Format Cells dialog 

box, 166–169
Fonts button (Page Layout 

tab), 559
footers

about, 282
adding ready-made, 282–284
creating custom, 284–288

Forecast Sheet feature, 
681–683

Forecast Start option (Create 
Forecast Worksheet dialog 
box), 682

Form button, 568
Format as Table feature, 

145–148
Format Axes task pane, 

formatting chart axes 
with, 523–526

Format button, moving 
worksheets between open 
windows using, 257

Format Cell Alignment 
option, 165

Format Cells (Protect Sheet 
dialog box), 450

Format Cells dialog box
about, 154
adjusting alignment, 162–166
assigning number formats, 

154–162
borders, 169–171
fills, 171–173
fonts and colors, 166–169
gradients, 171–173
patterns, 171–173

Format Chart Title task pane, 
formatting chart titles 
with, 522–523

Format Columns (Protect 
Sheet dialog box), 450

Format Painter, 173–174
Format Picture button  

(Header & Footer 
Elements group), 285

Format Rows (Protect Sheet 
dialog box), 450

Format Selection tool, 516
Format tab

customizing chart elements 
from, 515, 516–517

PivotCharts and, 669
Formats option (Paste Special 

dialog box), 215
formatting

cell ranges with mini-toolbar, 
152–154

with cell styles
about, 174
creating new cell styles, 

176–177
defining custom cell 

styles, 176
merging cell styles,  

177–178
Number Format section, 

174–175
cells from Ribbon, 150–152
chart elements

about, 521–522
chart axes with Format 

Axes task pane, 523–526
chart titles with Format 

Chart Title task pane, 
522–523

formulas and, 296
line art, 547–548
multiple worksheets, 

249–250
notes, 470–471
photos, 547–548
PivotCharts, 668–669
PivotTables

about, 651–652
parts of, 653–656
refining layout and style, 

652–653
SmartArt graphics, 557
tables

with Quick Analysis 
tool, 149

from Ribbon, 145–148
text boxes, 550–552
3-D model images, 548
worksheets, 131–186

Formatting (R) button, 213
Formula Auditing group, 

350–351
Formula bar

about, 13
buttons, 24
editing in, 196
working with, 23–24

formulas. See also date and 
time formulas

about, 293–295
adding linking, 332–333
applying names to existing, 

330–332
array

about, 316–317
adding, 316–322
creating, 318–321
editing, 320, 321–322

auditing
about, 349–351
changing Error Checking 

options, 357–358
error checking, 355–357
error tracing, 358–360
evaluating formulas, 

360–361
tracing dependents, 

354–355
tracing precedents, 

351–354
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formulas (continued)

augmenting with worksheet 
functions

about, 305
entering function 

arguments, 308–310
inserting functions, 

305–307
circular references, 335–336
controlling formula 

recalculation, 333–334
copying

about, 310
with absolute references, 

312–315
with mixed cell references, 

315–316
with relative cell references, 

311–312
creating

with computational 
operators, 301–304

that calculate elapsed 
dates, 364–365

that calculate elapsed 
times, 365–366

editing, 297
error-trapping, 345–348
evaluating, 360–361
financial

about, 377
advanced financial 

functions, 388–391
depreciation functions, 

385–388
financial function 

basics, 378
FV function, 381–382
NPV function, 380–381
PMT function, 382–385
PV function, 379–380

formatting, 296
naming, 325–326
naming cells/ranges

about, 322–323
applying names to existing 

formulas, 330–332
creating names from 

column/row headings, 
327–328

defining cell and range 
names, 323–325

managing names, 329
naming constants and 

formulas, 325–326
using names in building 

formulas, 326–327
numeric, 93
pointing at formula cells, 

296–297
printing in reports, 290
using AutoSum, 298–300
using Quick Analysis, 

300–301
Formulas and Number 

Formats option (Paste 
Special dialog box), 216

Formulas (F) button, 211
Formulas group, 63
Formulas & Number 

Formatting (O) 
button, 211

Formulas option (Paste Special 
dialog box), 215

Formulas tab
about, 19, 307
Calculation Options section, 

333–334
changing common 

calculation options on, 
47–50

Formula Auditing group, 
350–351

FORMULATEXT function, 424
freezing window panes, 

204–206, 235
From Azure option  

(Get & Transform 
Data group), 604

From Database option 
(Get & Transform Data 
group), 604

From File option  
(Get & Transform  
Data group), 604

From Online Services option 
(Get & Transform Data 
group), 604

From Other Sources option 
(Get & Transform Data 
group), 604

From Power BI dataset option 
(Get & Transform Data 
group), 604

From Web dialog box, 608–609
function arguments, entering, 

308–310
Function Arguments dialog 

box, 310, 717, 719
functionality, planning for, 

85–86
functions

AND, 340, 600
ACCRINT, 389
ACCRINTM, 389
ADDRESS, 424
advanced financial, 388–391
AMORDEGRC, 389
AMORLINC, 389
AREAS, 424
augmenting formulas with, 

305–310
AVERAGE, 404–405, 581, 

598–599, 662–663
CEILING.MATH, 397–398
CELL, 427–430
COLUMN, 424
COLUMNS, 405–406, 

424, 425
COUNT, 406, 581, 662–663
COUNT NUMBERS, 663
COUNTA, 406, 407–408
COUNTBLANK, 406
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COUNTIF, 408–410
COUPDAYBS, 389
COUPDAYS, 389
COUPDAYSNC, 389
COUPNCD, 389
COUPNUM, 389
COUPPCD, 389
CUMIPMT, 389
CUMPRINC, 389
database, 600–602
date, 366–374
DATE, 367–368
DATEVALUE, 367–368
DAVERAGE, 583, 600–602
DAY, 368–369
DAYS360, 369–370
DB, 385–388
DCOUNT, 583, 600–602
DCOUNTA, 583, 601
DDB, 385–388
depreciation, 385–388
DGET, 601
DISC, 389
DMAX, 601
DMIN, 601
DOLLAR, 432–434
DOLLARDE, 389
DOLLARFR, 389
DPRODUCT, 601
DSTDEV, 601
DSTDEVP, 601
DSUM, 583, 600–602
DURATION, 390
DVAR, 601
DVARP, 601
EDATE, 370–371
EFFECT, 390
EOMONTH, 371
EVEN, 397
FORMULATEXT, 424
FV, 378, 381–382

FVSCHEDULE, 390
GETPIVOTDATA, 424
HLOOKUP, 417–420
HOUR, 376
HYPERLINK, 121–123, 425
IF, 340, 341–342, 346–347
IFERROR, 340
IFNA, 340
IFS, 342–343
=IFS, 340
INDEX, 421–424
INDIRECT, 425
information, 427–430
InputBox, 709–712
inserting, 305–307
INT, 395–397
INTRATE, 390
IPMT, 390
IRR, 390
IS, 431
ISBLANK, 431
ISERR, 431
ISERROR, 347–348, 431
ISEVEN, 431
ISFORMULA, 431
ISLOGICAL, 431
ISMPT, 390
ISNA, 431
ISNONTEXT, 407, 431
ISNUMBER, 431
ISODD, 431
ISREF, 431
ISTEXT, 407, 431
logical, 337–338, 340–345
lookup, 412–424
LOOKUP, 425
LOWER, 432–434
MATCH, 421–424
MAX, 404–405, 663
MAXIMUM, 581
MDURATION, 390

MEDIAN, 404–405
MIN, 404–405, 663
MINIMUM, 581
MINUTE, 376
MIRR, 390
MONTH, 368–369
NETWORKDAYS, 371–372
NOMINAL, 390
NOT, 340, 600
NOW, 374–375
NPER, 378
NPV, 380–381
ODD, 397
ODDFPRICE, 390
ODDFYIELD, 390
ODDLPRICE, 390
ODDLYIELD, 390
OFFSET, 425
OR, 341, 600
PDURATION, 390
PMT, 378, 382–385
POWER, 398–399
PRICE, 390
PRICEDISC, 391
PRICEMAT, 391
PRODUCT, 581, 663
PROPER, 432–434
PV, 378, 379–380
RATE, 378
RECEIVED, 391
reference, 424–427
ROUND, 394–398
ROUNDDOWN, 394–398
ROUNDUP, 394–398
ROW, 425
ROWS, 405–406, 425
RRI, 391
RTD, 425
SECOND, 376
SLN, 385–388
specialized statistical, 410
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functions (continued)

SQRT, 398–399
statistical, 403–410
STDDEV, 663
STDDEVP, 663
STOCKHISTORY, 391
SUM, 305, 400, 581, 642, 

662–663
SUMIF, 400–403
SUMIFS, 400–403
SWITCH, 341, 344–345
SYD, 385–388
T, 435
TABLE, 623
TBILLEQ, 391
TBILLPRICE, 391
TBILLYIELD, 391
text, 431–438
TEXT, 432–434
TEXTJOIN, 435–436
time, 374–376
TIME, 375–376
TIMEVALUE, 375–376
TODAY, 366, 567
TRANSPOSE, 425, 426–427
TRUNC, 395–397
TYPE, 430
UPPER, 432–434
VALUE, 432–434
VAR, 663
VARP, 663
VDB, 391
VLOOKUP, 417–420
WEEKDAY, 344–345, 368–369
WEEKNUM, 372–373
WORKDAY, 373
XIRR, 391
XLOOKUP, 412–417
XNPV, 391
XOR, 341
YEAR, 368–369, 567

YEARFRAC, 373–374
YIELD, 391
YIELDDISC, 391
YIELDMAT, 391

Funnel charts, 509
future value, calculating, 

381–382
FV function, 378, 381–382
FVSCHEDULE function, 390

G
Gallery tool, 516
General alignment, 162
general data type, 612
General group, 63
General number format, 

overriding, 155
General Options dialog box, 

444, 447
General tab, changing settings 

on, 44–47
Get External Data button, 671
Get & Transform Data group 

(Data tab), 604
GETPIVOTDATA function, 424
GlobalSign, 464
Go button, 721
Go To, selecting cells with, 

138–139
Go To dialog box, 139
Goal Seek command, 631–633
Goal Seek dialog box, 632–633
Goal Seek Status dialog box, 

632–633
gradients, using Format Cells 

dialog box, 171–173
Grand Totals button (Layout 

group), 652
graphic objects

about, 533–534
adding screenshots of 

Windows desktop, 558

adjusting
about, 546
editing pictures, 546
formatting 3-D model 

images, 548
formatting photos and line 

art pictures, 547–548
drawing

about, 549
adding text boxes, 550–554
inserting SmartArt graphics, 

555–557
inserting WordArt, 554–555
predefined shapes, 549

inserting
about, 542
icons, 545–546
local pictures, 544–545
ready-made graphics, 

545–546
stock images, 545–546
3-D online images, 544
2-D online images, 542–543

using themes, 558–559
working with

about, 534–535
aligning, 538–539
grouping, 539–541
managing in Selection task 

pane, 541
manipulating graphics, 

535–536
moving to new layers, 

536–538
graphical conditional 

formatting, 179–180
graphics, adding alternative 

text to, 491–492
greater than (>) operator, 596
Greater Than option 

(AutoFilter), 588
Greater Than or Equal option 

(AutoFilter), 589
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greater than or equal to (>=) 
operator, 596

Gridline Color drop-down 
list, 63

gridlines, 505
Gridlines option (Page Setup 

dialog box), 281
Group command button, 242
Group tool, 517
groups

about, 18
of graphic objects, 539–541

H
Hadoop File (HDFS), 613
headers

about, 282
adding ready-made, 282–284
creating custom, 284–288

Height option (Scale to Fit 
group), 280

help
about, 31
Help tab (Ribbon), 32–34
Search feature, 31–32

Help tab (Ribbon), 20, 32–34
hiding

calculated fields, 665
columns, 143–144
comments, 499
notes, 469–471
outline levels, 239–241
Ribbon tabs, 64
rows, 145
worksheets, 250–251

Highlight Cells Rules 
option, 178

highlighting duplicate values 
in cell ranges, 184

HLOOKUP function, 417–420

Home icon, 10–11, 550–551
Home tab (Ribbon)

about, 19, 150–152
Alignment group, 550–551

Horizontal arrangement, for 
windows, 253

Horizontal Axis Crosses 
option (Format Axis task 
pane), 524

hot keys, PivotTables and, 
654–655

hot-key letters, 67
HOUR function, 376
HTML files

exporting workbooks  
to, 494

saving worksheets as, 
496–498

HYPERLINK function,  
121–123, 425

hyperlinks, 116–117

I
Icon Sets option, 179
icons

adding images to SmartArt 
graphics from, 557

explained, 5
inserting, 545–546

identifying values/text entries 
in cell ranges, 181–184

IdenTrust, 464
IF function, 340, 341–342, 

346–347
IFERROR function, 340
IFNA function, 340
if_not_found argument, 413
IFS function, 342–343
=IFS function, 340
Ignore Integer Constraints 

option (Solver), 638

images
adding to SmartArt 

pictures, 557
editing, 546
formatting, 547–548
selecting for 

downloading, 543
Import Data dialog box, 

605–606, 609–610
Include Forecast Statistics 

option (Create Forecast 
Worksheet dialog 
box), 683

Increase Decimal button 
(Home tab), 152

Increase Font Size button 
(Home tab), 150, 550

Increase Indent button (Home 
tab), 151, 551

increments, AutoFill series 
with custom, 107–108

INDEX function, 421–424
Indicators and Notes, and 

Comments on Hover 
option button, 62

INDIRECT function, 425
Info command, 15–16
Info screen (Backstage view)

about, 14–15
assigning passwords to open 

from, 444–445
infographics, adding to 

worksheets, 529–532
information functions

about, 427
CELL, 427–430
IS, 431
TYPE, 430

info_type argument, 427–428, 
428–430

Ink Replay command, 473
inline notes, adding to 

templates, 84
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Input dialog box, 709–710
InputBox function, 709–712
inputting

dates, 91–92
numbers, 90–91
times, 91–92

Insert Chart dialog box, 
506–507, 508

Insert Columns (Protect Sheet 
dialog box), 450

Insert command, 199–201
Insert dialog box, 200–

201, 214
Insert Function button 

(Formula bar), 160, 
306–307, 718–719

Insert Function dialog box, 
340, 717, 719, 724

Insert Hyperlinks (Protect 
Sheet dialog box), 450

Insert Picture dialog box, 
544–545

Insert Rows (Protect Sheet 
dialog box), 450

Insert Shapes option (Format 
tab), 516

Insert Slicers dialog box, 658
Insert tab (Ribbon)

about, 19
Charts group, 507–508
Shapes gallery, 549

Insert Timelines dialog 
box, 660

inserting
about, 542
cells, 199–201
charts with Quick Analysis 

tool, 509–510
columns/rows, 230–231, 232
comments, 498–499
fields in tables, 567
functions, 305–307
icons, 545–546

links, 117–120
local pictures, 544–545
ready-made graphics, 

545–546
recommended charts, 

506–507
SmartArt graphics, 555–557
specific chart types from 

Ribbon, 507–509
stock images, 545–546
3-D online images, 544
2-D online images, 542–543
WordArt, 554–555

Inspect Document option 
(Check for Issues 
button), 462

Inspect Workbook button (Info 
screen), 15

installing Office Add-ins, 68–69
INT function, 395–397
Integer Optimality option 

(Solver), 638
integrity, digital signatures 

and, 464
INTRATE function, 390
IPMT function, 390
IRR function, 390
Is After option (Custom 

AutoFilter dialog box), 591
Is After or Equal To option 

(Custom AutoFilter dialog 
box), 591

Is Before option (Custom 
AutoFilter dialog box), 591

Is Before or Equal To option 
(Custom AutoFilter dialog 
box), 592

IS function, 431
Is Greater Than option 

(Custom AutoFilter dialog 
box), 592

is Greater Than or Equal To 
option (Custom AutoFilter 
dialog box), 592

Is Less Than option (Custom 
AutoFilter dialog box), 592

Is Less Than or Equal To 
option (Custom AutoFilter 
dialog box), 592

ISBLANK function, 431
ISERR function, 431
ISERROR function,  

347–348, 431
ISEVEN function, 431
ISFORMULA function, 431
ISLOGICAL function, 431
ISMPT function, 390
ISNA function, 431
ISNONTEXT function, 407, 431
ISNUMBER function, 431
ISODD function, 431
ISREF function, 431
ISTEXT function, 407, 431
Italic button (Home tab), 

150, 550
Iterations option (Solver), 638

J
Justify option, for alignment, 

163, 164

K
Keep Source Column Widths 

(W) button, 212
Keep Source Formatting (K) 

button, 212
Keyboard Settings button, 98
keyboards

navigating, 94–96
selecting

cells with, 135–136
Ribbon commands with, 

20–21
style of, 94–96

keystrokes
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for moving cell pointer, 
26–27

for moving within 
selections, 102

KeyTip, 21

L
labels

about, 87–89
for columns, 24

Landscape option (Page Setup 
group), 276–277

languages, changing 
preferences, 56–57

large-scale data analysis
about, 641
creating PivotCharts

about, 666–667
filtering, 667–668
formatting, 668–669
moving to own 

worksheet, 667
creating PivotTables

about, 642
customizing PivotTable 

Fields task pane, 651
manually, 646–650
with Quick Analysis tool, 

643–645
recommended, 645–646

filtering PivotTable data
about, 656
column/row fields, 657–658
report, 656
slicing, 658–659
timeline filters, 659–660

Forecast Sheet feature, 
681–683

formatting PivotTables
about, 651–652
parts of, 653–656
refining layout and style, 

652–653

modifying PivotTables
about, 661–662
adding calculated fields, 

664–665
changing options, 665–666
changing summary 

functions, 662–663
sorting PivotTable data, 

656, 661
using 3D Maps feature, 

676–681
using Power BI, 680
using Power Pivot add-in

about, 669–670
adding calculated columns 

with DAX, 674–676
data modeling, 670–671
switching between Data 

view and Diagram view, 
672–674

Last Month option 
(AutoFilter), 587

Last Quarter option 
(AutoFilter), 588

Last Week option 
(AutoFilter), 587

Last Year option 
(AutoFilter), 588

Launch Power Query Editor 
option (Get & Transform 
Data group), 604

layers, moving graphic objects 
to new, 536–538

Layout & Format tab 
(PivotTable Options dialog 
box), 665

Layout group (Design tab), 
651, 652

Left alignment, 162
Left key, 97
legend, 505
Legend Fields button, 668
less than (<) operator, 596
Less Than option 

(AutoFilter), 589

Less Than or Equal option 
(AutoFilter), 589

less than or equal to (<=) 
operator, 596

life, 386
limiting data entry, 112–115
Limits report (Solver), 640
Line charts, 527
Linked Picture (I) button, 213
LinkedIn Features group 

(General tab), 47
linking

about, 482
consolidated data, 263
editing linked data, 487–488
Excel data to Word 

documents, 486–487
formulas, 332–333
removing links, 120–121
selecting links, 121
worksheets

about, 116
editing links, 120–121
following links, 120
HYPERLINK function, 

121–123
hyperlinks, 116–117
inserting links, 117–120

Live Preview, 558, 655
Load Model dialog box, 

639–640
Load option

Import Data dialog box, 610
Navigator dialog box, 605
From Web dialog box, 609

Load To option
Import Data dialog box, 610
Navigator dialog box, 605
From Web dialog box, 609

loading model problems, 
639–640

local data, creating PivotTables 
with, 646–647
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local pictures, inserting, 
544–545

Location group (Chart Design 
tab), 512

Locked/Hidden Protection 
formatting of cells, 
changing, 448–449

Logarithmic Scale option 
(Format Axis task 
pane), 525

logical arguments, 341
logical functions

about, 337–338, 340–341
IF, 341–342
IFS, 342–343
SWITCH, 344–345

logical operators, 572
LOOKUP function, 425
lookup functions

about, 412
HLOOKUP, 417–420
INDEX, 421–424
MATCH, 421–424
VLOOKUP, 417–420
XLOOKUP, 412–417

lookup_array argument, 
413, 421

lookup_value argument, 413, 
417, 418, 421

LOWER function, 432–434

M
Macro dialog box,  

693–694, 715
Macro Settings tab (Trust 

Center dialog box), 
698–699

macros
about, 687–688
adding to Ribbon, 695–696
assigning to Quick Access 

toolbar, 697
creating, 688

editing recorded, 704–712
finding and replacing code 

in, 705–707
preparing for recording, 

688–690
recording, 690–692
running, 693–694, 714–715
saving recorded macros 

in macro-enabled 
workbooks, 694–695

security of, 698–699
writing, 713–714

Macros command button 
(View tab), 689

Major Type option (Format 
Axis task pane), 525

Manage Relationships dialog 
box, 603

Manage Rules option, 179
Manage Workbook button 

(Info screen), 15
managing

conditional formatting 
rules, 186

Excel COM add-ins, 72–73
formula recalculation, 

333–334
graphic objects in Selection 

task pane, 541
names, 329
standard Excel Add-ins, 72
worksheets, 229–263

manipulating graphics, 
535–536

margins, adjusting,  
275–276, 552

Margins button (Page Setup 
group), 273

marking
invalid data, 227–228
worksheets with digital ink, 

471–473
MATCH function, 421–424
match_mode argument, 413

match_type argument, 
421–422

math and statistical formulas
about, 393
math and trigonometry 

functions
about, 394
CEILING.MATH, 397–398
EVEN, 397
INT, 395–397
ODD, 397
POWER, 398–399
ROUND, 394–398
ROUNDDOWN, 394–398
ROUNDUP, 394–398
SQRT, 398–399
SUM, 400
SUMIF, 400–403
SUMIFS, 400–403
TRUNC, 395–397

statistical functions
about, 403–404
AVERAGE, 404–405
COLUMNS, 405–406
COUNT, 406
COUNTA, 406, 407–408
COUNTBLANK, 406
COUNTIF, 408–410
ISNONTEXT, 407
ISTEXT, 407
MAX, 404–405
MEDIAN, 404–405
MIN, 404–405
ROWS, 405–406
specialized, 410

math and trigonometry 
functions

about, 394
CEILING.MATH, 397–398
EVEN, 397
INT, 395–397
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ODD, 397
POWER, 398–399
ROUND, 394–398
ROUNDDOWN, 394–398
ROUNDUP, 394–398
SQRT, 398–399
SUM, 400
SUMIF, 400–403
SUMIFS, 400–403
TRUNC, 395–397

Max Feasible Solutions option 
(Solver), 638

MAX function, 404–405, 663
Max Subproblems option 

(Solver), 638
Max Time option (Solver), 638
maximizing Ribbon, 18
MAXIMUM function, 581
MDURATION function, 390
MEDIAN function, 404–405
Merge & Center button (Home 

tab), 151
Merge Conditional Formatting 

(G) button, 212
merging

cell styles, 177–178
scenarios, 629–630

Microsoft Data Streamer for 
Excel, 72

Microsoft Excel. See Excel 
(Microsoft)

Microsoft Excel Power  
Pivot & Power Query For 
Dummies, 2nd Edition 
(Alexander), 674

Microsoft Exchange, 614
Microsoft Office, 84
Microsoft Power Map for 

Excel, 72
Microsoft Power Pivot for 

Excel, 72
Microsoft Query, 613
Middle Align button  

(Home tab), 151, 551

MIN function, 404–405, 663
minimizing Ribbon, 18
MINIMUM function, 581
mini-toolbar, formatting cell 

ranges with, 152–154
Minor Type option (Format 

Axis task pane), 525
MINUTE function, 376
MIRR function, 390
mixed cell references, copying 

formulas with, 315–316
Mode Indicator (Status bar), 30
MONTH function, 368–369
mouse

adjusting row height with, 
144–145

manually adjusting column 
width with, 142

selecting
cells with a, 133–134
Ribbon commands with, 

20–21
mouse wheel, 28, 202
Move command, 249
moving

with copy, cut, and paste, 
210–218

with drag-and-drop, 209–210
graphic objects to new 

layers, 536–538
PivotCharts to own 

worksheet, 667
slicers, 659
worksheets between 

workbooks, 256–257
Multiply option (Paste Special 

dialog box), 216

N
#N/A, 339, 347–348, 349
#NAME?, 339
Name box (Formula bar), 24
Name Manager dialog 

box, 329

names
applying to existing formulas, 

330–332
creating from column/row 

headings, 327–328
managing, 329
using in building formulas, 

326–327
naming

cells, 322–332
constants, 325–326
formulas, 325–326
ranges, 139–140,  

322–332
Narrow margin settings, 275
navigating

data forms, 570
keyboards, 94–96
worksheets, 25–26, 29–30

Navigator dialog box,  
605–606, 614

negative values, 158–159
nesting parentheses, 304
net present value, calculating, 

380–381
NETWORKDAYS function, 

371–372
New Name dialog box, 

324, 326
New Rule option, 179
New Worksheet option 

(Import Data dialog 
box), 606

Next Month option 
(AutoFilter), 587

Next Quarter option 
(AutoFilter), 587

Next Sheet button, 29
Next Week option 

(AutoFilter), 587
Next Year option 

(AutoFilter), 588
No Borders (B) button, 212
NOMINAL function, 390
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None option (Paste Special 
dialog box), 216

nonrepudiation, digital 
signatures and, 464

Normal margin settings, 275
not equal to (<>) operator, 596
NOT function, 340, 600
notes

adding, 469
deleting, 471
displaying, 469–471
editing, 470–471
formatting, 470–471
hiding, 469–471

Nothing (Hide Objects) option 
button, 62

NOW function, 374–375
NPER function, 378
NPV, 380–381
#NULL!, 339
#NUM!, 339
Number Filters options 

(AutoFilter), 588–589
Number Format button  

(Home tab), 152
Number Format section, 

174–175
number formats

assigning using Format Cells 
dialog box, 154–162

custom, 156–159
designing, 159–162

Number of Pages button 
(Header & Footer 
Elements group), 284

numbers
adding with AutoSum, 

298–300
adding with Quick Analysis 

tool, 300–301
defined, 88
inputting, 90–91

rounding, 394–398
whole, 395–397

numeric formulas, 93
Numeric key, 97

O
objective cell, 634
OData Feed, 613
ODBC, 614
ODD function, 397
ODDFPRICE function, 390
ODDFYIELD function, 390
ODDLPRICE function, 390
ODDLYIELD function, 390
ODS files

exporting workbooks to, 494
saving worksheets as, 496

Office, changing language 
preferences, 56–57

Office Add-ins, 68–70
Office Authoring Languages 

and Proofing group, 57
Office Display Language 

group, 56–57
Office programs, sharing Excel 

data with, 482–489
OFFSET function, 425
OLEDB, 614
OneDrive

about, 124
sharing workbooks saved to, 

476–479
one-to-many relationship, 603
one-to-one relationship, 603
one-variable data tables, 

creating, 621–623
Online 3D Models dialog 

box, 544
online pictures, adding images 

to SmartArt graphics 
from, 557

online sharing, 476–480
Only Create Connection 

option (Import Data dialog 
box), 606

Open and Repair option, 193
Open as Copy option, 193
Open dialog box, 191, 192
Open in Browser option, 193
Open In Protected View 

option, 193
Open options, for 

workbooks, 193
Open Read-Only option, 193
Open screen (Backstage view), 

188–192
OpenDocument Spreadsheet 

file format, 127
opening

Backstage view, 13–14
blank workbooks, 86
macros for editing, 704–705
modules in Code 

window, 703
Replace dialog box, 707
from Windows Metro view in 

Tablet mode, 36–37
windows on different 

worksheets, 251–254
from Windows Search text 

box, 35
from Windows Start menu, 

34–35
workbooks

about, 11, 188
in Backstage view, 188–192
finding misplaced, 192–193
multiple, 192
Open options, 193

operands, 295
operators

about, 295
computational, 301–304
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order of precedence, 
302–304

types, 301
Optional function 

arguments, 308
options

about, 43
accessibility, 57–58
changing

on Advanced tab, 58–63
common calculation 

options on Formula tab, 
47–50

correction options on 
Proofing tab, 51–53

Office language 
preferences, 56–57

save options on Save tab, 
53–56

settings on General tab, 
44–47

for spell checker, 225–226
on Data tab, 50–51
display, 61–63

Options dialog box, 638, 670
OR condition, 596–598
OR function, 341, 600
order of operator precedence, 

302–304
Orientation button

Home tab, 151, 551
Page Setup group, 273

Outline feature
about, 235–236
applying outline styles, 

238–239
creating

custom views of 
outlines, 243

outlines, 237–238
displaying outline levels, 

239–241

hiding outline levels, 239–241
manually adjusting outline 

levels, 241–243
removing outlines, 243

outlining, in worksheets, 
235–243

overriding General number 
format, 155

P
Page Break Preview feature, 

288–290
page breaks, troubleshooting, 

288–290
Page Layout dialog box, 

choosing margins 
from, 275

Page Layout tab (Ribbon),  
19, 275, 559

Page Layout view
about, 10
checking paging in, 269–270

Page Number button  
(Header & Footer 
Elements group), 284

Page Setup dialog box, 
281–282, 532

Page Setup options
about, 273
using buttons in, 273–280
using buttons in Page Setup 

group, 273–280
using buttons in Scale to Fit 

group, 280–281
using Print options on Sheet 

tab of Page Setup dialog 
box, 281–282

panes, splitting worksheets 
into, 233–235

parentheses, nesting, 304
password-protection, of 

workbooks, 442–447

passwords
assigning

to open from Info screen, 
444–445

to unprotect sheets, 451
changing, 446–447
deleting, 446–447
entering

to gain access, 445
to make changes, 445–446

Paste (P) button, 211
Paste Link (N) button, 213
Paste Link option (Paste 

Special dialog box), 216
Paste Special dialog box, 

214–218
patterns, using Format Cells 

dialog box, 171–173
payments, calculating, 

382–385
PDF files

about, 127
emailing workbooks as, 481
exporting workbooks to, 493
exporting worksheets as, 

494–495
saving worksheets as, 

494–495
PDURATION function, 390
per (period), 386
percent sign (%) symbol, 158
Percent Style button (Home 

tab), 152
Personalize Your Copy of 

Microsoft Office group 
(General tab), 46

Picture button  
(Header & Footer 
Elements group), 285

Picture (U) button, 213
Picture Format tab, 547
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pinning Excel to Windows Start 
menu, 35

PivotChart option (Import 
Data dialog box), 606

PivotCharts, creating
about, 666–667
filtering, 667–668
formatting, 668–669
moving to own 

worksheet, 667
PivotTable Analyze tab, 650
PivotTable Fields task pane, 

648–649, 651
PivotTable from External 

Data Source dialog box, 
647–648

PivotTable from Table or 
Range dialog box, 647

PivotTable Options dialog box, 
665–666

PivotTable Report option 
(Import Data dialog 
box), 605

PivotTable Style Options group 
(Design tab), 652–653

PivotTable Styles group 
(Design tab), 652

PivotTables
creating

about, 642
customizing PivotTable 

Fields task pane, 651
manually, 646–650
with Quick Analysis tool, 

643–645
recommended, 645–646

filtering data
about, 656
column/row fields, 657–658
report, 656
slicing, 658–659
timeline filters, 659–660

formatting

about, 651–652
parts of, 653–656
refining layout and style, 

652–653
modifying

about, 661–662
adding calculated fields, 

664–665
changing options, 665–666
changing summary 

functions, 662–663
sorting data, 656, 661

PivotTable(s) button, 642, 
645–646

planning workbooks, 84–85
Play 3D group (3D Model 

tab), 548
plot area, 505
PMT function, 378, 382–385
pointing, at formula cells, 

296–297
Portrait option (Page Setup 

group), 276
position, consolidating 

worksheets by, 259–262
pound signs (#####), 141
pound (#) symbol, 158
Power BI, 680
POWER function, 398–399
Power Pivot add-in

about, 641, 669–670
adding calculated columns 

with DAX, 674–676
data modeling, 670–671
switching between Data 

view and Diagram view, 
672–674

Power Query Editor, 
transforming data queries 
in, 614–616

PowerPoint, sharing data 
between Excel and, 
488–489

predefined number formats, 
155–156

predefined shapes, 549
present value, calculating, 

379–380
previewing printouts, 269–272
Previous Sheet button, 29
PRICE function, 390
PRICEDISC function, 391
PRICEMAT function, 391
Print Area, 274–275
Print Area button (Page Setup 

group), 274
Print command, 16
Print options, on Sheet tab of 

Page Setup dialog box, 
281–282

Print Titles button (Page Setup 
group), 274

Print Titles feature, 277–280
printers, selecting, 268
printing

about, 265–266
from Backstage view

about, 266–267
previewing printout, 

269–272
selecting printers, 268

charts, 532
footers

about, 282
adding ready-made, 

282–284
creating custom, 284–288

formulas in reports, 290
headers

about, 282
adding ready-made, 

282–284
creating custom, 284–288

Page Setup options, 273
quick, 272–273
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solving page break problems, 
288–290

using buttons in Page Setup 
group, 273–280

using buttons in Scale to Fit 
group, 280–281

using Print options on Sheet 
tab of Page Setup dialog 
box, 281–282

worksheets, 265–290
Printing tab (PivotTable 

Options dialog box), 665
printouts

previewing, 269–272
removing errors from, 

361–362
Privacy Settings group 

(General tab), 46
PRODUCT function, 581, 663
product information, checking, 

16–17
Project Explorer window 

(Visual Basic Editor), 
702, 704

Proofing tab
changing correction options 

on, 51–53
Excel Options dialog box, 

225–226
PROPER function, 432–434
Properties (Info screen), 15
properties, adding, 463
Properties option (Import Data 

dialog box), 606
Protect Sheet dialog box, 

449, 455
Protect Structure and 

Windows dialog box, 
458–459

Protect Workbook button (Info 
screen), 14, 445

protecting worksheets, 
449–452

Publish command, 16
purchasing third-party  

add-ins, 73
PV function, 378, 379–380

Q
Queries & Connections task 

pane, 607
Query Options (Get & 

Transform Data 
group), 604

querying table data
about, 583–584, 602–604
from other data sources, 

613–614
retrieving data

from Access database 
tables, 605–608

from text files, 609–613
from the web, 608–609

transforming data queries 
in Power Query Editor, 
614–616

question mark (?) character, 
158, 592, 595

Quick Access toolbar
about, 10, 40–41
adding

non-Ribbon commands, 
42–43

Ribbon commands,  
41–42

assigning macros to, 697
customizing, 40–43
working with, 22–23

Quick Analysis tool
conditional formatting with, 

180–181
creating PivotTables with, 

643–645
formatting tables with, 149

inserting charts with, 
509–510

using to add numbers, 
300–301

quick printing worksheets, 
272–273

Quick Styles tool, 516
quitting Excel, 37

R
range names, defining, 

323–325
ranges

converting to/from 
tables, 566

naming, 139–140, 322–332
selecting

about, 132–133
naming ranges, 139–140

RATE function, 378
ready-made graphics, 

inserting, 545–546
RECEIVED function, 391
Record Macro option (View 

tab), 689
Record Macro/Stop Recording 

button (Status bar), 692
recording macros, 688–692
records

adding to tables
about, 568
eliminating duplicate 

records, 573–574
using data form, 568–573

deleting with data form, 573
editing in data form, 571
finding with data form, 

571–572
Recover Unsaved Workbooks 

button, 190, 462
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redisplaying hidden 
worksheets, 250–251

Redo command, 195–197
#REF! error value, 232, 339
reference functions

about, 424–425
COLUMNS, 425
ROWS, 425
TRANSPOSE, 426–427

reference operators, 301
refining

charts from Chart Design tab
about, 511–512
editing source of data in 

charts, 514–515
modifying layout and 

style, 512
switching rows/

columns, 513
layout and style in 

PivotTables, 652–653
Refresh All command (Data 

tab), 609
Related Dates (Info screen), 15
Related People (Info 

screen), 15
relative cell references, 

copying formulas with, 
311–312

Remember icon, 5
Remove Arrows 

command, 350
Remove Background button 

(Picture Format tab), 547
Remove Hyperlinks 

option, 197
removing. See also deleting

background images from 
worksheets, 247

cell styles, 177
color-coding from worksheet 

tabs, 246
data labels from charts, 519

Data Validation settings, 115
errors from printouts, 

361–362
groups from contextual 

tabs, 65
groups from Ribbon tabs, 64
links, 120–121
outlines, 243
panes from windows, 235
protection from worksheets, 

451–452
side-by-side windows, 253

renaming
tables, 567
worksheets, 245

reorganizing
workbooks

about, 244
adding worksheets, 

247–248
changing worksheets, 

248–249
coloring sheet tabs, 

245–247
deleting worksheets, 248
editing multiple 

worksheets, 249–250
formatting multiple 

worksheets, 249–250
hiding worksheets, 250–251
opening windows on 

different worksheets, 
251–254

renaming worksheets, 245
viewing stats, 254–255

worksheets
about, 230
deleting columns/rows, 

230–232
inserting columns/rows, 

230–231, 232
outlining, 235–243

splitting into panes, 
233–235

reorienting text, 165–166
Replace All button, 707
Replace command, 221–223
Replace dialog box, 707
replying, to comments, 500
Report Filter button, 668
reports, printing formulas 

in, 290
repositioning

buttons on Quick Access 
toolbar, 41

chart legends, 518
groups

within contextual tabs, 65
within Ribbon tabs, 64

Ribbon tabs, 64
Required function 

arguments, 308
Reset All button, 640
Reset Picture button (Picture 

Format tab), 547
Reset to Match Style tool, 516
Reset Window Position 

button, 253
resizing

scroll bars, 28
tables, 567

restoring
groups to tabs/contextual 

tabs, 65
groups/tabs to Ribbon, 66
hidden columns, 144

retrieving
data from Access database 

tables, 605–608
data from text files, 609–613
data from the web, 608–609

return_array argument, 413
Review tab (Ribbon), 19, 227
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Ribbon
about, 13, 17–19
adding

commands to Quick Access 
toolbar, 41–42

custom tabs, 66–67
Developer tab, 20, 689–690

assigning macros to, 695–696
AutoFill via Fill button on, 106
customizing, 63–67
Data tab

about, 19
options on, 50–51
PivotTable Options dialog 

box, 666
Refresh All command, 609

displaying Quick Access 
toolbar above, 23

formatting
cells from, 150–152
tables from, 145–148

Formulas tab, 307
Help tab, 32–34
Home tab, 150–152
inserting specific chart types 

from, 507–509
maximizing, 18
minimizing, 18
Picture Format tab, 547
restoring groups/tabs to, 66
Review tab, 227
selecting

commands by touch, 21–22
commands with mouse/

keyboard, 20–21
fonts/colors from,  

167–168
tabs, 64–66

Ribbon Display Options, 13
Right alignment, 163
Right key, 97
Rotate Text Down option, 165
Rotate Text Up option, 165

Rotate tool, 517
ROUND function, 394–398
ROUNDDOWN function, 

394–398
rounding numbers, 394–398
ROUNDUP function, 394–398
Row and Column Headings 

option (Page Setup dialog 
box), 281

row fields, filtering in 
PivotTables, 657–658

ROW function, 425
Row Headers (PivotStyle 

Options group), 652
Row Height dialog box, 145
row letter, 25
row_index_num argument, 

418, 420
row_num argument, 422, 423
rows

adjusting
about, 141
AutoFit, 141–142
hiding columns, 143–144
manually, 142–143, 

144–145
setting new standard 

width, 143
deleting, 230–232
hiding, 145
inserting, 230–231, 232

ROWS function, 405–406, 425
Rows section (PivotTable 

Fields task pan)e, 649, 650
RRI function, 391
RTD function, 425
Ruler Units drop-down  

list, 62
rules

creating for conditional 
formatting, 184–185

managing for conditional 
formatting, 186

running

Accessibility Checker, 
492–493

macros, 693–694, 714–715

S
salvage, 386
Save As command, 16
Save As dialog box, 125–126, 

128, 192, 442
Save command, 16
Save Current Theme dialog 

box, 559
Save Model button, 639
save options, changing on 

Save tab, 53–56
Save tab, changing save 

options on, 53–56
Save Workbooks group (Save 

tab), 53–56
saving

changes to templates, 81–83
custom functions in add-in 

files, 719–724
custom views, 206–208
customized charts as 

templates, 526–527
data in worksheets

about, 123–126
changing default file 

location, 127–128
common file formats for, 

126–127
in old file format, 128–129
OneDrive, 124

files, 442–444
model problems, 639–640
recorded macros in macro-

enabled workbooks, 
694–695

worksheets
as HTML files, 496–498
as ODS files, 496
as PDF files, 494–495
as XPS files, 495
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Scale option (Scale to Fit 
group), 280

Scale to Fit group, using 
buttons in, 280–281

Scenario Manager feature, 
626–631

Scenario Summary dialog box, 
630–631

scenarios
about, 626
creating, 626–630
creating summary reports, 

630–631
Schmuller, Joseph (author)

Statistical Analysis with 
Excel For Dummies, 5th 
Edition, 410

Screenshot command, 558
screenshots, adding of 

Windows desktop, 558
scroll bars, using, 27–28
Search feature, 31–32
search_mode argument, 

413–414
Seasonality option  

(Create Forecast 
Worksheet dialog 
box), 683

SECOND function, 376
security

about, 441
of macros, 698–699
password-protection of 

workbooks, 442–447
setting up worksheet data 

protection
about, 447–448
changing Locked/Hidden 

Protection formatting of 
cells, 448–449

data entry in unlocked cells 
of protected worksheets, 
456–458

enabling cell range editing, 
452–456

protecting worksheets, 
449–452

of workbook structure, 
458–459

Select Data Source dialog box, 
514–515

Selected Text option (Find 
dialog box), 706

selecting
actions allowed in protected 

sheets, 450
all worksheets in a 

workbooks, 250
cells

about, 132–133
with AutoSelect, 136–138
with Go To, 138–139
with keyboards, 135–136
with a mouse, 133–134
by touch, 135

colors
in Format Cells dialog box, 

168–169
from Ribbon, 167–168

fonts
in Format Cells dialog box, 

168–169
from Ribbon, 167–168

images for downloading, 543
links, 121
printers, 268
ranges

about, 132–133
naming ranges, 139–140

Ribbon commands
with mouse/keyboard, 

20–21
by touch, 21–22

Selection Pane tool, 517
Selection task pane

displaying, 537, 538
managing graphic objects 

in, 541

semicolon (;), 317
Send Backward tool, 517
Send Link dialog box, 479–480
Sensitivity report (Solver), 640
Series dialog box, 106
series formula, 505
setting(s)

changing for VBA properties, 
707–709

changing on General tab, 
44–47

column width, 143
Print Area, 274–275

Settings dialog box, 238
setup

of Solver problems, 634–636
worksheet data protection

about, 447–448
changing Locked/Hidden 

Protection formatting of 
cells, 448–449

data entry in unlocked cells 
of protected worksheets, 
456–458

enabling cell range editing, 
452–456

protecting worksheets, 
449–452

Shape Effects option (Shape 
Format tab), 551

Shape Effects tool, 516
Shape Fill option (Shape 

Format tab), 551
Shape Fill tool, 516
Shape Format tab, 551–552
Shape Height tool, 517
Shape Outline option (Shape 

Format tab), 551
Shape Outline tool, 516
Shape Styles option

Format tab, 516
Shape Format tab, 551

Shape Width tool, 517
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shapes, predefined, 549
Shapes gallery, 549
SharePoint List, 613
sharing

about, 475–476
collaborating with 

comments, 498–500
exporting to other usable file 

formats, 493–498
making accessible, 489–493
with Office programs, 

482–489
online, 476–480
via email, 480–481

sharing links, copying, 
479–480

Sheet Name button  
(Header & Footer 
Elements group), 285

Sheet tab (Page Setup dialog 
box), 281–282

Shift key, 97
shortcut keys

for bold, 152
for italics, 152
prior to Excel 2007, 21
for selecting worksheets, 29
for underline, 152

Show All Properties link (Info 
screen), 15

Show Formulas button, 
62, 350

Show Iteration Results option 
(Solver), 638

Show Page Breaks check 
box, 62

Show Previous Versions 
option, 193

Show Training button, 34
Show/Hide group (View 

tab), 62

Shrink to Fit group, 280–281
Size button (Page Setup 

group), 274
Size group (3D Model tab), 548
Size option (Format tab), 517
Size & Properties tab, 552
Skip Blanks option (Paste 

Special dialog box), 216
slicing PivotTable data, 

658–659
SLN function, 385–388
Smart Lookup feature, 227
SmartArt graphics, inserting, 

555–557
Snap to Grid feature, 536
Solver

about, 633–634
changing options, 637–639
creating reports, 640
loading model problems, 

639–640
saving model problems, 

639–640
setting up and defining 

problems, 634–636
solving problems, 636–637

Solver Add-In, 72
Solver Options dialog box, 639
Solver Parameters dialog box, 

636, 638, 640
Solver Results dialog box, 

637, 640
solving

page break problems, 
288–290

problems, 636–637
Sort (Protect Sheet dialog 

box), 450
Sort dialog box, 577, 580
Sort & Filter button, 574
sort order, 574–575

sorting
PivotTable data, 656, 661
table data

about, 574
on font and fill colors and 

cell icons, 578–580
on multiple fields, 575–578
on single fields, 575
sort order, 574–575

source rows. See records
Sparkline graphics, adding to 

worksheets, 527–529
specialized statistical 

functions, 410
specifying comparison criteria, 

595–596
spell checking

about, 101, 223–225
adding words to custom 

dictionary, 226–227
changing options, 225–226

#SPILL!, 339
splitting worksheets into 

panes, 233–235
SQL Server Analysis Services 

Database, 613
SQL Server Database, 613
SQRT function, 398–399
Start screen, 10–11
Start Up Options group 

(General tab), 47
Statistical Analysis with Excel 

For Dummies, 5th Edition 
(Schmuller), 410

statistical functions
about, 403–404
AVERAGE, 404–405
COLUMNS, 405–406
COUNT, 406
COUNTA, 406, 407–408
COUNTBLANK, 406
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statistical functions (continued)

COUNTIF, 408–410
ISNONTEXT, 407
ISTEXT, 407
MAX, 404–405
MEDIAN, 404–405
MIN, 404–405
ROWS, 405–406
specialized, 410

Status bar, 13, 30–31
STDDEV function, 663
STDDEVP function, 663
stock images

adding images to SmartArt 
graphics from, 557

inserting, 545–546
STOCKHISTORY function, 391
structure

modifying of tables, 567
of workbooks, 458–459

subscription information, 17
Subtotal dialog box, 582
subtotaling table data, 

580–582
Subtotals button (Layout 

group), 652
Subtotals feature, 580–582
Subtract option (Paste Special 

dialog box), 216
Suggest a Feature button, 34
SUM function, 305, 400, 581, 

642, 662–663
SUMIF function, 400–403
SUMIFS function, 400–403
Summarize By tab, 663
summary reports, creating, 

630–631
SWITCH function, 341, 

344–345
switching

between Data view and 
Diagram view, 672–674

rows/columns in charts, 513

SYD function, 385–388
Synchronous Scrolling 

button, 253

T
T function, 435
Tab key, 98
Table feature (Word), 483
TABLE function, 623
Table option (Import Data 

dialog box), 605
Table Tools tab, 581
table_array argument, 

417, 420
tables

about, 563–564
adding records

about, 568
eliminating duplicate 

records, 573–574
using data form, 568–573

database functions,  
600–602

designing
about, 564–566
converting ranges to/from 

tables, 566
creating calculated fields, 

566–567
modifying structure, 567

filtering data
about, 583–584
using Advanced Filter 

feature, 593–600
using AutoFilter, 584–593

formatting
with Quick Analysis 

tool, 149
from Ribbon, 145–148

querying data
about, 583–584, 602–604
from other data sources, 

613–614

retrieving data from Access 
database tables, 605–608

retrieving data from text 
files, 609–613

retrieving data from the 
web, 608–609

transforming data queries 
in Power Query Editor, 
614–616

renaming, 567
resizing, 567
sorting data

about, 574
on font and fill colors and 

cell icons, 578–580
on multiple fields, 575–578
on single fields, 575
sort order, 574–575

subtotaling data, 580–582
Tablet mode, launching from 

Windows Metro view in, 
36–37

tabs. See also specific tabs
about, 18
custom, 66–67
found on Ribbon, 19–20
Ribbon, 64–66

TBILLEQ function, 391
TBILLPRICE function, 391
TBILLYIELD function, 391
Technical Stuff icon, 5
templates

adding inline notes  
to, 84

creating worksheets from, 
78–84

downloading, 80–81
saving

changes to, 81–83
customized charts,  

526–527
viewing, 11
workbook, 83–84
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text
concatenating, 437–438
defined, 88
editing in text boxes, 552
filling in for SmartArt 

graphics, 556
reorienting, 165–166
wrapping, 164–165

text boxes
adding, 550–554
adding arrows to, 553–554
deleting, 552
editing text in, 552
formatting, 550–552

text data type, 612
Text Effects option

Format Chart Title task 
pane, 523

Shape Format tab, 552
Text Effects tool, 517
text files, retrieving data from, 

609–613
Text Fill option (Shape Format 

tab), 551
Text Fill & Outline button 

(Format Chart Title task 
pane), 523

Text Fill tool, 516
Text Filters options 

(AutoFilter), 586
TEXT function, 432–434
text functions

about, 431–434
concatenating text, 437–438
T, 435
TEXTJOIN, 435–436

text operators, 301
Text Outline option (Shape 

Format tab), 552
Text Outline tool, 516
Textbox button (Format Chart 

Title task pane), 523
TEXTJOIN function, 435–436

themes, graphic objects and, 
558–559

Themes group (Page Layout 
tab), 559

Thesaurus feature, 227
third-party add-ins, 

purchasing, 73
This Month option 

(AutoFilter), 587
This Quarter option 

(AutoFilter), 587
This Week option 

(AutoFilter), 587
This Year option 

(AutoFilter), 588
3D Maps feature, 676–681
3-D model images, 

formatting, 548
3D Model tab, 548
3D Model Views group (3D 

Model tab), 548
3-D online images, 

inserting, 544
tick mark, 505
Tiled arrangement, for 

windows, 253
TIME function, 375–376
time functions

about, 374
HOUR, 376
MINUTE, 376
NOW, 374–375
SECOND, 376
TIME, 375–376
TIMEVALUE, 375–376

timeline filters, 659–660
Timeline Range option (Create 

Forecast Worksheet dialog 
box), 683

times
about, 363–364
building formulas that 

calculate elapsed, 
365–366

inputting, 91–92
TIMEVALUE function, 375–376
Tip icon, 5
titles, formatting on charts 

with Format Chart Title 
task pane, 522–523

TODAY function, 366, 567
Today option (AutoFilter), 587
Tomorrow option 

(AutoFilter), 587
Top 10 option (AutoFilter), 

589–590
Top Align button (Home tab), 

151, 551
Top alignment, 163
Top/Bottom Rules option, 178
Totals & Filters tab (PivotTable 

Options dialog box), 665
touch

adjusting
column width by, 142–143
row height by, 145

selecting
cells by, 135
Ribbon commands by, 

21–22
Touch keyboard, data entry 

with, 96–99
Touch/Mouse Mode button, 

adding to Quick Access 
toolbar, 40–41

touchscreen devices
about, 13
adding Touch/Mouse Mode 

button to Quick Access 
toolbar, 40–41

AutoFill on, 105–106
naming ranges on, 140
quitting Excel on, 37
removing panes from 

worksheets on, 235
scrolling worksheets on, 28
zooming in/out on, 202
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Trace Dependents command, 
350, 354–355, 358–360

Trace Precedents command, 
350, 351–354, 358–360

transferring data between 
open windows, 256

Transform Data option
Import Data dialog box, 611
Navigator dialog box, 605
From Web dialog box, 609

transforming data queries 
in Power Query Editor, 
614–616

Translate feature, 227
Transparency button (Picture 

Format tab), 547
Transpose (T) button, 212
TRANSPOSE function, 425, 

426–427
Transpose option (Paste 

Special dialog box), 216
Treemap charts, 508–509
trigonometry and math 

functions
about, 394
CEILING.MATH, 397–398
EVEN, 397
INT, 395–397
ODD, 397
POWER, 398–399
ROUND, 394–398
ROUNDDOWN, 394–398
ROUNDUP, 394–398
SQRT, 398–399
SUM, 400
SUMIF, 400–403
SUMIFS, 400–403
TRUNC, 395–397

troubleshooting
AutoSum, 299
Office Add-ins, 70
page breaks, 288–290

TRUE logical value, 340, 341, 
598–599

TRUNC function, 395–397
Trust Center dialog box, 

698–699
2-D online images, inserting, 

542–543
two-digit years, 92–93
two-variable data tables, 

creating, 624–626
TYPE function, 430
Type group (Chart Design 

tab), 512
typeface, 166

U
UNC address, URL address 

vs., 122
Underline button (Home tab), 

150, 550
Undo command, 195–197
Undo feature, enabling, 50–51
unfreezing window panes, 206
Ungroup command 

button, 242
Units option (Format Axis task 

pane), 524
#UNKNOWN!, 339
Up key, 98
UPPER function, 432–434
URL address, UNC address 

vs., 122
U.S. (NASD) method, 370
Use AutoFilter (Protect Sheet 

dialog box), 450
Use Automatic Scaling option 

(Solver), 638
Use PivotTable & PivotChart 

(Protect Sheet dialog 
box), 450

Use Relative References 
option (View tab), 689

user information, checking, 
16–17

user interface
about, 12–13
Backstage view, 13–17
Formula bar, 23–24
Quick Access toolbar, 22–23
Ribbon, 17–22
Status bar, 30–31
Worksheet area, 25–30

User Interface Options group 
(General tab), 44–45

user-defined functions, adding 
descriptions to, 717–718

V
Validation option (Paste 

Special dialog box), 215
#VALUE!, 339
Value Field Settings dialog 

box, 663
VALUE function, 432–434
value_if_false argument, 427
value_if_true argument, 427
values

about, 89–93
types, 89–93

Values and Number Formats 
option (Paste Special 
dialog box), 216

Values (V) button, 212
Values In Reverse Order 

option (Format Axis task 
pane), 525

Values & Number Formatting 
(A) button, 213

Values option (Paste Special 
dialog box), 215

Values Range option (Create 
Forecast Worksheet dialog 
box), 683

Values section (PivotTable 
Fields task pane), 649, 650

Values & Source Formatting (E) 
button, 213
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values/text entries, identifying 
in cell ranges, 181–184

VAR function, 663
variable cell, 634
VARP function, 663
VBA programming

about, 701–702
creating custom Excel 

functions
about, 715–717
adding descriptions to 

user-defined functions, 
717–718

saving custom functions in 
add-in files, 719–724

using custom functions in 
worksheets, 718–719

using Visual Basic Editor
about, 702–704
editing recorded macros, 

704–712
running macros,  

714–715
writing macros, 713–714

VDB function, 391
Version History button  

(Info screen), 15
Vertical arrangement, for 

windows, 254
Vertical Axis Crosses option 

(Format Axis task 
pane), 525

Vertical Text option, 165
View Macros option (View 

tab), 689
View Side by Side 

command, 253
View tab (Ribbon), 20, 689
viewing

templates, 11
workbook stats, 254–255

views
outline, 243
worksheet

about, 201
freezing window panes, 

204–206
saving custom views, 

206–208
zooming in/out, 201–203

Visual Basic Editor
about, 702–704
editing recorded macros, 

704–712
running macros, 714–715
writing macros, 713–714

VLOOKUP function, 417–420

W
Warning icon, 5
Watch Window command, 351
Waterfall charts, 509
web, retrieving data from the, 

608–609
Web Page file format, 126
websites

Add-Ins.com, 73
Adobe Reader, 494
Cheat Sheet, 5
examples, 5
Microsoft Office, 84

WEEKDAY function, 344–345, 
368–369

WEEKNUM function, 372–373
what-if analysis

about, 619–620
Goal Seek command, 

631–633
scenarios

about, 626
creating, 626–630
creating summary reports, 

630–631
Solver

about, 633–634
changing options, 637–639

creating reports, 640
loading model problems, 

639–640
saving model problems, 

639–640
setting up and defining 

problems, 634–636
solving problems,  

636–637
using data tables

about, 620–621
creating one-variable data 

tables, 621–623
creating two-variables data 

tables, 624–626
What’s New button, 34
When Calculating This 

Workbook group, 63
When Correcting Spelling in 

Microsoft Office Programs 
group (Proofing tab), 53

When Creating New 
Workbooks group 
(General tab), 45–46

whole numbers, 395–397
Wide margin settings, 275
Width option (Scale to Fit 

group), 280
window panes

freezing, 204–206
unfreezing, 206

windows
arranging, 253–254
comparing, 255
opening on different 

worksheets, 251–254
transferring data between 

open, 256
Windows desktop, adding 

screenshots of, 558
Windows key, 98
Windows Metro view, 

launching from, in 
Tablet mode, 36–37
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Windows Search text box, 
launching Excel from, 35

Windows Start menu, 
launching Excel from, 
34–35

Win/Loss charts, 528
Word, sharing data between 

Excel and, 483–488
WordArt, inserting, 554–555
WordArt Styles option

Format tab, 516–517
Shape Format tab, 551

words, adding to custom 
dictionary, 226–227

Workbook views (Status 
bar), 30

workbooks
about, 10
adding worksheets to, 29
annotating

about, 468
adding notes, 469
displaying notes, 469–471
hiding notes, 469–471
marking up worksheets 

with digital ink, 471–473
creating templates for, 83–84
designing, 84–86
exporting, 493–498
opening

about, 11, 188
in Backstage view, 188–192
finding misplaced, 192–193
multiple, 192
Open options, 193

opening blank, 86
password-protection of, 

442–447
planning, 84–85
preparing for review

about, 462–463

adding properties, 463
digitally signing documents, 

463–468
reorganizing

about, 244
adding worksheets, 

247–248
changing worksheets, 

248–249
coloring sheet tabs, 

245–247
deleting worksheets, 248
editing multiple 

worksheets, 249–250
formatting multiple 

worksheets, 249–250
hiding worksheets, 250–251
opening windows on 

different worksheets, 
251–254

renaming worksheets, 245
viewing stats, 254–255

saving macros in macro-
enabled, 694–695

sharing
about, 475–476
collaborating with 

comments, 498–500
exporting to other usable 

file formats, 493–498
making accessible, 489–493
with Office programs, 

482–489
online, 476–480
via email, 480–481

structure of, 458–459
working with multiple

about, 255
comparing windows, 255
copying worksheets 

between workbooks, 
256–257

moving worksheets 
between workbooks, 
256–257

transferring data between 
open windows, 256

WORKDAY function, 373
Working with Formulas 

options group (Formula 
tab), 49

Worksheet area
about, 25
keystroke shortcuts for 

moving cell pointer, 26–27
navigating worksheets, 

25–26, 29–30
scroll bars, 27–28

Worksheet Title dialog 
box, 712

worksheets
about, 10, 13, 77, 131–132, 

187–188, 229, 265–266
adding

infographics, 529–532
Sparkline graphics, 527–529
to workbooks, 29, 247–248

adjusting, 248–249
adjusting columns/rows

about, 141
AutoFit, 141–142
hiding columns, 143–144
manually, 142–143, 

144–145
setting new standard 

width, 143
analyzing data with 

conditional formatting
about, 178–179
conditional formatting 

with Quick Analysis tool, 
180–181

creating conditional 
formatting rules,  
184–185



Index      761

graphical conditional 
formatting, 179–180

highlighting duplicate 
values in cell ranges, 184

identifying values/text 
entries in cell ranges, 
181–184

managing conditional 
formatting rules, 186

assigning passwords to 
unprotect, 451

building, 77–130
coloring tabs, 245–247
consolidating

about, 258–259
by category, 262–263
linking consolidated 

data, 263
by position, 259–262

copying and moving items
about, 208
with copy, cut, and paste, 

210–218
with drag-and-drop, 

209–210
copying between workbooks, 

256–257
creating

about, 78
charts on separate, 

510–511
from scratch, 84–86
from templates, 78–84

data entry
about, 93–94
AutoComplete, 99–100
AutoCorrect, 100–101
AutoFill, 103–110
constraining to cell 

ranges, 102
decimal points, 103
Flash Fill, 110–115

keyboard style, 94–96
Touch keyboard, 96–99
in unlocked cells of, 

456–458
data protection

about, 447–448
changing Locked/Hidden 

Protection formatting of 
cells, 448–449

data entry in unlocked cells 
of protected worksheets, 
456–458

enabling cell range editing, 
452–456

protecting worksheets, 
449–452

data types
about, 86–87
labels, 87–89
values, 89–93

deleting, 248
Document Recovery, 

129–130
editing cells

about, 194
in cells vs. Formula bar, 196
clearing cells, 197–199
inserting cells, 199–201
Redo command, 195–197
Undo command, 195–197

editing multiple, 249–250
editing options for, 60–61
exporting as PDF files, 

494–495
finding and replacing data, 

218–223
footers

about, 282
adding ready-made, 

282–284
creating custom, 284–288

Format Painter, 173–174
formatting

cell ranges with mini-
toolbar, 152–154

cells from Ribbon, 150–152
multiple, 249–250
tables from Ribbon, 

145–148
tables with Quick Analysis 

tool, 149
formatting with cell styles

about, 174
creating new cell styles, 

176–177
defining custom cell 

styles, 176
merging cell styles, 177–178
Number Format section, 

174–175
headers

about, 282
adding ready-made, 

282–284
creating custom, 284–288

hiding, 250–251
linking to other documents

about, 116
editing links, 120–121
following links, 120
HYPERLINK function, 

121–123
hyperlinks, 116–117
inserting links, 117–120

managing, 229–263
marking invalid data, 

227–228
marking up with digital ink, 

471–473
moving between workbooks, 

256–257
moving PivotCharts to 

own, 667
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worksheets (continued)

navigating, 25–26, 29–30
opening windows on 

different, 251–254
opening workbooks

about, 188
in Backstage view, 188–192
finding misplaced, 192–193
multiple, 192
Open options, 193

Page Setup options
about, 273
using buttons in Page Setup 

group, 273–280
using buttons in Scale to Fit 

group, 280–281
using Print options on 

Sheet tab of Page Setup 
dialog box, 281–282

printing, 265–290
printing formulas in 

reports, 290
printing from Backstage view

about, 266–267
previewing printout, 

269–272
selecting printer, 268

Proofing, Insights, and 
Language groups, 227

protecting, 449–452
quick printing, 272–273
removing protection from, 

451–452
renaming, 245
reorganizing

about, 230
deleting columns/rows, 

230–232
inserting columns/rows, 

230–231, 232

outlining, 235–243
splitting into panes, 

233–235
saving

as HTML files, 496–498
as ODS files, 496
as PDF files, 494–495
as XPS files, 495

saving data
about, 123–126
changing default file 

location, 127–128
common file formats for, 

126–127
in old file format, 128–129
OneDrive, 124

selecting actions allowed in 
protected, 450

selecting cells
about, 132–133
with AutoSelect, 136–138
with Go To, 138–139
with keyboards, 135–136
with a mouse, 133–134
by touch, 135

selecting ranges
about, 132–133
naming ranges, 139–140

sharing data
about, 475–476
collaborating with 

comments, 498–500
exporting to other usable 

file formats, 493–498
making accessible, 489–493
with Office programs, 

482–489
online, 476–480
via email, 480–481

solving page break problems, 
288–290

spell checking
about, 223–225
adding words to custom 

dictionary, 226–227
changing options, 225–226

UNC address vs. URL 
address, 122

using custom functions in, 
718–719

using Format Cells dialog box
about, 154
adjusting alignment, 

162–166
assigning number formats, 

154–162
borders, 169–171
fills, 171–173
fonts and colors, 166–169
gradients, 171–173
patterns, 171–173

views
about, 201
freezing window panes, 

204–206
saving custom views, 

206–208
zooming in/out, 201–203

Wrap Text button (Home 
tab), 151

wrapping text entries, 164–165
writing macros, 713–714

X
XIRR function, 391
XLOOKUP function, 412–417
XML Data file format, 126
XNPV function, 391
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XOR function, 341
XPS files

exporting workbooks to, 493
saving worksheets as, 495

Y
YEAR function, 368–369, 567
Year to Date option 

(AutoFilter), 588

YEARFRAC function,  
373–374

Yesterday option 
(AutoFilter), 587

YIELD function, 391
YIELDDISC function, 391
YIELDMAT function, 391

Z
Zoom (Status bar), 30
Zoom slider button, 201
Zoom to Selection command 

button, 203
zooming in/out, 201–203
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